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Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard
commercial license.

Copyright Notice
© Copyright 2002 - 2015 Hewlett-Packard Development Company, L.P.

Trademark Notices
Adobe™ is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

This product includes an interface of the 'zlib' general purpose compression library, which is Copyright ©
1995-2002 Jean-loup Gailly and Mark Adler.

Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:
https://softwaresupport.hp.com.

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to
https://softwaresupport.hp.com and click Register.

Support
Visit the HP Software Support Online web site at: https://softwaresupport.hp.com

This web site provides contact information and details about the products, services, and support that HP
Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to
access interactive technical support tools needed to manage your business. As a valued support customer,
you can benefit by using the support web site to:
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l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Download software patches
l Manage support contracts
l Look up HP support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract. To register for an HP Passport ID, go to: https://softwaresupport.hp.com and click Register.

To find more information about access levels, go to:
https://softwaresupport.hp.com/web/softwaresupport/access-levels.

HP Software Solutions & Integrations and Best Practices
Visit HP Software Solutions Now at https://h20230.www2.hp.com/sc/solutions/index.jsp to explore how the
products in the HP Software catalog work together, exchange information, and solve business needs.

Visit the Cross Portfolio Best Practices Library at https://hpln.hp.com/group/best-practices-hpsw to access
a wide variety of best practice documents and materials.
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Chapter 1: ALM Introduction
This chapter includes:

• HP ALMOverview 20
• ALM Basic Flow 22
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HP ALMOverview
HP Application Lifecycle Management (ALM) empowers organizations tomanage the core application
lifecycle, from requirements through deployment, granting application teams the crucial visibility and
collaboration needed for predictable, repeatable, and adaptable delivery of modern applications.

Application lifecycle management is a complex process. Whether your organization is predominantly
Agile or you are using both iterative and sequential methods, the aim of effective lifecycle management
is greater predictability, heightened repeatability, improved quality, and a ready accommodation of
change. Understanding project milestones, deliverables, and resource and budget requirements and
keeping track of project health, standards and quality indicators, allow delivery managers to achieve
these objectives.

ALM simplifies and organizes applicationmanagement by providing you systematic control over the
process. It helps you create a framework and foundation for your application lifecycle management
workflow in a central repository.

Release Tracking
ALM features a system for organizing and tracking application releases, enabling you to align your
business priorities and quality expectations with your project requirements, tests, and defects. ALM
helps youmakemore informed release decisions with real-time key performance indicators (KPIs).

Requirements and Tests
ALM helps you define andmaintain a repository of requirements and tests. Requirements help ensure
that business and testing needs are covered. Tests can then be automatically generated from these
requirements to ensure the correct aspects of the application are being tested. Tomeet the various
goals of a project, you can organize the tests in your project into unique groups. ALM provides amethod
for scheduling and executing tests, collecting test results, and analyzing the data.

Defect Tracking
Analyzing defects and defect trends helps youmake effective "go/no-go" decisions. ALM features a
system for tracking defects, enabling you tomonitor defects from initial detection until resolution. It
also allows you to share defects across projects, reducing risk by helping developers find, prioritize,
and resolve defects sooner. A centralized defect repository also enables reporting of aggregated defect
status and trends across projects.

Analysis Tools
The ability to track progress throughout the application lifecycle process is vital to predictability. ALM
provides tools for analyzing each phase of the process including specific instrumentation for Agile
projects (for example, burn-up and burn-down charts). You can generate interactive graphs that
demonstrate a wide variety of business performance perspectives, or define reports with any cross-
section of data. You can alsomonitor multiple business metrics, by arrangingmultiple graphs alongside
each other in a single view.
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Asset Libraries
ALM supports sharing and reuse of asset libraries across projects. Sharable libraries help youmanage
initiatives with multiple applications to verify that changes to one application do not negatively impact
another application. They also help to drive greater consistency and repeatability, by empowering asset
reuse. Specific changes can be applied to the shared assets for each project while allowing the library
to maintain its integrity.

ALM Integrations
ALM offers integration with HP tools (for example, Unified Functional Testing and LoadRunner) as well
as third-party and custom testing tools, and requirement and configurationmanagement tools. ALM
communicates with the testing tool of your choice, providing you with a complete solution to fully
automated application testing.

Note: HP Unified Functional Testing (UFT) comprises the product formerly known as HP
QuickTest Professional and the product known as HP Service Test.

l Functionality provided by QuickTest is now known as GUI testing in UFT.
l Functionality provided by Service Test is also known as API testing in UFT.

The HP Project and Portfolio Management (PPM) Center software offers your executives and PMOs a
dashboard view into your portfolio, demand, in-flight projects, and programs across the organization
enabling smart portfolio investment decisions. For detailed information about the PPMCenter-HP ALM
integration solutions and configuration instructions, refer to theHP Solution Integration Guide for PPM
Center version 9.20. To retrieve this document, see HP Software Product Manuals.

Performance Center Functionality
ALM includes functionality enabling you tomanage all aspects of a large-scale performance testing
project, including resource allocation and scheduling, from a centralized location accessible through the
Web. ALM helps streamline the testing process, reduce resource costs, and increase operating
efficiency. For details, see theHP ALM Performance Center Guide.

Lab Management Functionality
ALM includes functionality enabling you tomanage resources which you can use to execute tests on
remote hosts. ALM helps automate the deployment and testing process, improving reliability and
convenience. For details, see theHP ALM LabManagement Guide.
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ALM Editions
ALM is available in various editions. For details on the availability of ALM functionality according to
editions, see "ALM Editions" on page 115.

HP ALM
Edition

Description

HP ALM A unified platform for managing and automating processes, activities, and assets for
building, testing, delivering, andmaintaining applications. It includes modules for
requirements, test, defect, and development management, and overall release and
project planning. HP ALM helps organizations drive consistent processes, shared
best-practices, and asset sharing across projects.

HP Quality
Center
Enterprise
Edition

Resides on the same unified platform as HP ALM. It delivers core functionality for
quality management. It supports building a quality center of excellence through tight
integrations with HP Unified Functional Testing, HP Business Process Testing, and
HP Sprinter.

HP ALM
Performance
Center
Edition

Functionality for the completemanagement, scheduling, running, andmonitoring of
performance test scripts. It resides on the same platform as HP ALM and integrates
directly with HP ALM andHP LoadRunner.

HP Quality
Center
Express
Edition

Provides a subset of HP ALM product functionality, and is designed to introduce
new customers to HP ALM. It provides core functionality for test management and
defect management.

HP Quality
Center
Community
Edition

Provides a subset of HP ALM product functionality, and is designed to introduce
new customers to HP ALM. It provides core functionality for test management and
defect management.

Summary
ALM supports you through all phases of managing the application lifecycle. By integrating the tasks
involved in applicationmanagement, ALM enables you to better align with your business needs, and
optimize efficiency. For details on the application lifecycle management phases, see "ALM Basic
Flow" below.

ALMBasic Flow
The ALM basic flow includes the following phases:
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Phase Description

Release
Specifications

Develop a release-cycle management plan to help youmanage application
releases and cycles more efficiently. You can track the progress of an application
release against your plan to determine whether your release is on track.

For task details, see "How to Use Releases and Cycles in ALM" on page 126.

Requirement
Specifications

Define requirements tomeet your business and testing needs. You canmanage
the requirements and conduct multi-dimensional traceability between
requirements, tests, and defects, across multiple releases and cycles. ALM
provides real-time visibility of requirements coverage and associated defects to
evaluate quality and business risk.

For task details, see "How to Use Requirements in ALM" on page 220.

Test Planning Based on the project requirements, you can build test plans and design tests. ALM
provides a repository for bothmanual and automated tests.

For task details on test planning, see "How to Plan Tests in ALM" on page 344.

Performance Center: For task details, see theHP ALM Performance Center
Guide.

Test
Execution

Create a subset of the tests in your project designed to achieve specific test goals.
ALM supports sanity, functional, regression, and advanced testing. Execute
scheduled tests to diagnose and resolve problems.

For task details, see "How to Run Tests in ALM" on page 490 .

Performance Center: For task details, see theHP ALM Performance Center
Guide.

Lab Management: You can run server-side execution Functional test sets that
can be run immediately or scheduled for the future. Functional test sets are run
without user intervention and can be run as a part of build verification suite in order
to automate and streamline the deployment and testing process. For task details,
see "Deploying and Testing your Application in ALM" on page 492.
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Phase Description

Defect
Tracking

Submit defects and track their repair progress. Analyzing defects and defect
trends helps youmake effective "go/no-go" decisions. ALM supports the entire
defect lifecycle - from initial problem detection through fixing the defect and
verifying the fix.

For task details, see "How to Track Defects in ALM" on page 693.

Throughout the application lifecycle, you canmonitor and control strategic points by generating reports
and graphs. For task details, see "How to Analyze Data in ALM" on page 718.

For an overview of ALM, see "HP ALMOverview" on page 20.
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ALMProjects
When you create an ALM project, you need to store andmanage the data that was generated and
collected by ALM. Each project is supported by a database that stores project information.

For more information on creating andmanaging ALM projects, refer to theHP Application Lifecycle
Management Administrator Guide.

User Privileges
ALM enables you tomanage user access to a project. By creating a list of authorized users and
assigning each user a password and user group, you control the kinds of additions andmodifications
that each user makes to the project. The user group determines the privileges that the user has within a
project. ALM includes a privileges and permissions mechanism that enables you to create rules for
specific fields in a project.

For detailed information on the user groups available in ALM, and on assigning passwords and
privileges, refer to theHP Application Lifecycle Management Administrator Guide.

Project History Management
When you customize your project, you can instruct ALM to preserve a log of values for the system and
user fields in your project. For more information on enabling history for a field, refer to theHP
Application Lifecycle Management Administrator Guide.

When the history data is no longer needed, you can choose to delete this data from your ALM project.
For example, if you have successfully run the test sets you created, youmay want to clear the test
history from your project.

You can choose to clear all history data, or you can select a specific entity or field whose history you
want to clear. In addition, you can choose to delete history data up to and including a specific date.
ALM clears the data displayed in the History tab of the correspondingmodules.

For user interface details, see "Clear History Dialog Box" on page 40.

Data Import fromMicrosoft Word and Microsoft Excel
You can import data from aWord document or an Excel worksheet to an ALM project.

Data Import fromWord
You can import requirement or test plan data from aWord document to an ALM project. To import from
Word, youmust install theMicrosoft Word Add-in on your client machine. To install theMicrosoft Word
Add-in, select Help > Add-ins to open the Add-ins page, and click the appropriate add-in link.

For more details, see the information on theMicrosoft Word Add-in page.
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Data Import fromExcel
You can import requirement, test plan, or defect data from an Excel worksheet to an ALM project. To
import from Excel, youmust install theMicrosoft Excel Add-in on your client machine. To install the
Microsoft Excel Add-in, select Help > Add-ins to open the Add-ins page, and click the appropriate
add-in link.

For more details, see the information on theMicrosoft Excel Add-in page.

How to Start ALM
This task describes how to launch ALM on your machine from yourWeb browser. You can work with
multiple versions of ALM side-by-side on a client machine. This includes multiple ALM clients of
version 12.00 or later connecting to different ALM servers, and a single Quality Center 10.00 or 9.2
client.

Note: To enable ALM to work with HP testing tools as well as third-party and custom testing tools,
youmust log in to the client machine with administrator privileges and register ALM on client
machines. For more information, refer to theHP Application Lifecycle Management Installation
and UpgradeGuide.

To start ALM:

1. Open yourWeb browser and type your ALM URL
http://<ALM server name/IP address>[<:port number>]/qcbin. Contact your system
administrator if you do not have the correct URL.
The HP Application Lifecycle Management Options window opens.

2. Click theALM Desktop Client link. Each time ALM is run, it carries out a version check. If it
detects a newer version, it downloads the necessary files to your machine.

User Guide
Chapter 2: ALM at a Glance

HP ALM (12.50) Page 27



l Windows 7/8/2008R2/2012: If you do not have administrator privileges on your machine,
and a Security Warning displays, click Don't Install. You are redirected to the Install
screen.

l If file downloads are prohibited through your browser, you can install these files by using
the HP ALM Client MSI Generator add-in, available from the HP Application Lifecycle
Management Add-ins page (Help > Add-ins).

l If you run ALM over a virtual environment, such as Citrix or VMware, only the system
administrator can install a new version.

l Click theOpen in Full Screen mode icon to open ALM in Full Screenmode. Full
Screenmode enables you to take advantage of the entire screen when using ALM.

l The client can take about threeminutes to start when there is no internet access. To avoid
this, you can distribute local CRL files or run the OCSP cache server.

3. Follow the on-screen instructions.

Note: If files are downloaded, but the Login window does not display, youmust install a
Microsoft Hotfix on your machine. For more information, see HP Software Self-solve
knowledge base article KM905289
(http://h20230.www2.hp.com/selfsolve/document/KM905289).

After the ALM version has been checked and files have been updated if necessary, the ALM Login
window opens.

Note: If ALM was configured for external authentication, the Name and Password fields do
not appear in this window. Continue with step 9.

4. In theName box, type your user name.
5. In thePassword box, type the password assigned to you by your site administrator. If you cannot

remember your password, click the Forgot Password link. For more details, see "How to Reset
Your Password" on page 30.

6. Select theAutomatically log in to my last domain and project on this machine check box if
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you want ALM to automatically log in to the last project in which you were working.
7. Click theAuthenticate button. ALM verifies your user name and password and determines which

domains and projects you can access. If you specified automatic login, ALM opens.
8. If authentication fails, check that your user name and password are correct and try again.

If authentication fails multiple times, you can be locked out of ALM. The number of authentication
attempts you are allowed is determined by your site administrator. For more information, refer to
theHP Application Lifecycle Management Administrator Guide.

9. In theDomain list, select a domain. By default, the last domain in which you were working is
displayed.

10. In theProject list, select a project. By default, the last project in which you were working is
displayed.
If the demonstration project was installed on the ALM server, you can select theALM_Demo
project (make sure that you select DEFAULT in theDomain list). The project includes sample
data to help introduce you to ALM. For more information, refer to theHP Application Lifecycle
Management Tutorial.

11. Click the Login button. ALM opens and displays themodule in which you last worked during your
previous session.
The first time you run ALM, theWelcome page opens.

From theWelcome page, you can directly access the ALM documentation. If you do not want to
display theWelcome page each time you log in to ALM, select Don't show this again.

12. To exit and return to the ALM Login window, click the Logout button located in the upper-right
corner of the window.
Alternatively, on the ALMmasthead, click <Domain, Project> and select Select to log in to a
different project.

Note:When an ALM user session is inactive for a period of time, the session expires. This
releases the license in use, making it available for other users.

When a session expires, you are prompted to reconnect. Logging in from the ALM login
window includes loading project customization. However, if a project administrator has not
made any significant changes to project customization, the customization does not reload
when you reconnect. This enables you to reconnect quickly and continue working where you
left off.
You can edit reconnect options by modifying the FAST_RECONNECT_MODE parameter in
the Site Configuration tab.This parameter is not valid for external authentication, since the
user must always be certified when reconnecting. For more information, refer to theHP
Application Lifecycle Management Administrator Guide.
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How to Reset Your Password
When logging in to ALM, if you cannot remember your password, you can reset it and create a new one.

Note: The Forgot Password link is unavailable in either of the following situations:

l It is deactivated by thePASSWORD_RESET_DISABLE Site Configuration parameter. For
more information, refer to theHP Application Lifecycle Management Administrator Guide.

l LDAP authentication is enabled. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

For more information, refer to theHP Application Lifecycle Management Administrator Guide.

To reset your password:

1. In the ALM Login window, click the Forgot Password link. The Forgot Password dialog box
opens.

2. In the Login Name box, type your user name. By default, the name entered in the ALM Login
window is displayed.

3. Click OK. ALM sends amessage to the email address assigned to your ALM user name. Click the
link to set a new password.
After you set a new password, the ALM Login window opens, enabling you to log in using your new
password.

Note: Use the FROM_EMAIL_ADDRESS Site Configuration parameter to change the email
address that sends the password. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

How to View Administrator Messages
The site administrator can sendmessages to users connected to ALM projects informing them about
important maintenance or other issues. For example, the site administrator may send amessage
warning that a project you are connected to will be disconnected.

For more details on sendingmessages from Site Administration, refer to theHP Application Lifecycle
Management Administrator Guide.

To view administrator messages:

1. When the site administrator sends you amessage, a pop-up window automatically opens on your
machine displaying themessage text.

2. If there is more than onemessage, use thePrevious Message andNext Message buttons to
view other messages.
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ALM Common User Interface
This section includes:

• ALM Common Areas 32
• ALMOptions 36
• ALM Fields 37
• ALM Icons 38
• User Properties Page 38
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• Task Manager Dialog Box 41
• Send Error Details Dialog Box 43
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ALM Common Areas
The ALMmasthead, sidebar, and Pinned Items panel are common to all ALM views.

To access The common areas are available from all ALM views.

Relevant tasks "How to Start ALM" on page 27

Masthead
Displays the current domain, project, and user name and provides buttons for accessing other projects,
common tools, and documentation.

User interface elements are described below:

UI Element Description

<Domain,

Project>

Displays details of the current domain and project.

Click to switch to another open project on the samemachine, or to select a
different project from the Login window.

<User> Displays details of the current user.

Provides commands that you can run from each of the ALMmodules. For
details, see " ALMOptions" on page 36.

Tip: To customize the Toolsmenu, refer to theHP Application Lifecycle
Management Installation and UpgradeGuide.

Displays help for the current page.

Logout Logs you out of your current project and returns you to the ALM Login window.

Sidebar
This area contains buttons for navigating between ALM views, switching between ALMmodules, and
accessing various online resources.
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Important
information

ALM Editions:ALM is also available in several editions which provide subsets of ALM
functionality: Quality Center Enterprise Edition, Performance Center Edition, Quality
Center Express Edition, andQuality Center Community Edition. For more information
about ALM editions and their functionality, see "ALM Editions" on page 115. To find
out what edition of ALM you are using, ask your ALM site administrator.

If the sidebar is hidden, click the expand button.

User interface elements are described below:

UI Element Description

Enables you to navigate to your previous/next view in ALM.

Tip: Use the Forward button after you navigate to a previous view.

Dashboard Includes the followingmodules:

l Analysis View. Enables you to create graphs, reports, and Excel reports.
l Dashboard View. Enables you to create dashboard pages, in which you can
view multiple graphs in a single display.

Management Includes the followingmodules:

l Releases. Enables you to define releases and cycles for the application
management process.

l Libraries. Enables you to define libraries to track changes in your project, reuse
entities in a project, or share entities across multiple projects.
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UI Element Description

Requirements Includes the followingmodules:

l Requirements. Enables you tomanage requirements in a hierarchical tree-
structure. Requirements can be linked to other requirements, tests, or defects.

l Business Models. Enables you to import business process models, and test
the quality of themodels and their components. Access to this module is
dependent on your ALM license.

Cloud
Settings

Includes the followingmodules:

l Cloud Accounts. Enables you to add your external cloud accounts to ALM.
These cloud accounts can then be used to provision cloud testing hosts.

l Host Templates. Enables you to create andmodify the templates used to
provision cloud hosts.

Testing Includes the followingmodules:

l Test Resources. Enables you tomanage test resources in a hierarchical tree-
structure. Test resources can be associated with tests.

l Business Components. Depending on your ALM license, youmay also have
access to theBusiness Componentsmodule. This module enables subject
matter experts to drive the quality optimization process using Business Process
Testing. For details, refer to theHP Business Process Testing User Guide .

l Test Plan. Enables you to develop andmanage tests in a hierarchical tree-
structure. Tests can be linked to requirements and defects.

l Test Lab. Enables you tomanage and run tests.
l Lab Management: Build Verification.Enables you to define a suite of
automated functional test sets bundled together with a single performance test
(called a build verification suite) to provide an end-to-end deployment and testing
solution.
Available for: ALM Edition only

l Lab Management: Timeslots. Enables you to reserve testing resources for the
purposes of running a performance test or for performingmaintenance tasks on
them.
Available for: Performance Center Edition and ALM Edition only

l Test Runs. Enables you to analyze the results of test executions.

Lab
Resources

Includes the followingmodules:

l Testing Hosts. Enables you tomanage the allocation and availability of hosts
for performance and functional testing. For detrails, refer to the HP ALM Lab
Management Guide.

l AUT Environments. Enables you tomanage AUT environment parameters
which can be used for performance and functional testing.

Available for: Performance Center Edition and ALM Edition only
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UI Element Description

Defects Enables you to add defects, determine repair priorities, repair open defects, and
analyze the data.

Performance
Center

Includes the followingmodules:

l Usage Reports. Enables you to analyze Performance Center site users and
resource usage.

l Performance Lifecycle. Enables you to access trending and performance
application lifecycle (PAL) reports. For details, refer to theHP ALM
Performance Center Guide.

l AUT Hosts. Enables you tomanage the host machines that make up the
Application Under Test (AUT). For details, refer to theHP ALM Lab
Management Guide.

l Topologies. Enables you to create topologies that graphically display the
logical components that make up the Application Under Test (AUT) and the
relationships between them. For details, refer to theHP ALM Performance
Center Guide.

Help Enables you to open additional online HP Application Lifecycle Management
resources.

Displays version information for each ALM client component.

Note: For details on understanding version information, see the Obsolescence
Policy on the HP Support Site:  www.hp.com/go/hpsoftwaresupport.

If an error occurs, ALM collects detailed system and usage information, which you
can send as an email attachment. This feature is useful for when you contact ALM
support. To send an error report, select Help > Send Error Details. For more
details, see "Send Error Details Dialog Box" on page 43.

Tip: To rename, rearrange or delete items in theHelpmenu, refer to theHP
Application Lifecycle Management Installation and UpgradeGuide.

Pinned Items Panel
When you hover overPinned Items, a panel opens to display the ALM items you have pinned. You can
click a pinned requirement, test, or defect to jump to it quickly.

l To pin a requirement, test, or defect, select it and click thePin/Unpin button. The item is added
to thePinned Items tab.

l To unpin a pinned requirement, test, or defect, select it and click thePin/Unpin button, or in the
tab, click in the item you want to unpin.

For user interface details, see "Pinned Items Panel" on page 98.

User Guide
Chapter 2: ALM at a Glance

HP ALM (12.50) Page 35

http://www.hp.com/go/hpsoftwaresupport


ALM Options

To access
Click on themasthead.

See also "ALM Common Areas" on page 32

User interface elements are described below:

UI Element Description

Customize Opens the Project Customization window, enabling you to customize your project.
For details, refer to theHP Application Lifecycle Management Administrator Guide.

Tip: You can change your ALM password and user details in the Project
Customization window. For user interface details, see "User Properties Page"
on page 38.

Clear
History

Opens the Clear History dialog box, enabling you to delete history data from your
project. Clearing history requires the appropriate user permissions. For details, see
"Clear History Dialog Box" on page 40.

Task
Manager

Opens the Task Manager dialog box, enabling you to view the status and progress
of asynchronous tasks run in your project. For details, see "Task Manager Dialog
Box" on page 41.

Spelling and
Grammar

Spelling Options. Opens the Spelling Options dialog box, enabling you to
configure the way ALM checks spelling.

Thesaurus. Opens the Thesaurus dialog box and displays a synonym, antonym, or
related word for the selected word. You can replace the selected word or look up
new words.

Check Spelling. Checks the spelling for the selected text or text box. If there are
no errors, a confirmationmessage opens. If errors are found, the Spelling dialog box
opens and displays the word together with replacement suggestions.

New Defect Opens the New Defect dialog box, enabling you to add a new defect. For details,
see "Defect Details Dialog Box" on page 707.

Event Log Performance Center: Displays information about all events that occur during a
performance test run. For details, refer to theHP ALM LabManagement Guide.

Download
Standalone
Applications

Performance Center:Opens the Application Download window, enabling you to
download standalone applications needed for Performance Center.
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UI Element Description

Lab Settings Opens the Project Settings Details dialog box, enabling you to configure Lab
Management settings for your project. For details, refer to theHP ALM Lab
Management Guide.

Available for: Performance Center Edition and ALM Edition.

Performance
Center
Controller
Options

Performance Center:Opens the Performance Center Controller Options dialog
box, enabling you to configure global Controller options for your Performance Center
project. For details, refer to theHP ALM LabManagement Guide.

My
Performance
Center

Performance Center:Opens theMy Performance Center dialog box, allowing you
to facilitate execution of day to day performance testing activities. For details, refer
to theHP ALM Performance Center Guide.

ALM Fields
This section lists the fields available in ALM.

Module Name Description

Business
Components

See theHP Business Process Testing User Guide

Business Models "Business Models Module Fields" on page 302

Build Verification "Build VerificationModule Fields" on page 611

Available for: ALM Edition only

Defects "Defects Module Fields" on page 703

Management "Releases Module Fields" on page 134

"Libraries Module Fields" on page 189

Lab Resources See theHP ALM LabManagement Guide

"AUT Environments Module Fields" on page 332

Available for: Performance Center Edition and ALM Edition only

Requirements "Requirements Module Fields" on page 237

Test Plan "Test PlanModule Fields" on page 366

Business Process Testing:See theHP Business Process Testing User
Guide
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Module Name Description

Test Resource "Test Resources Module Fields" on page 456

Business Process Testing:See theHP Business Process Testing User
Guide.

Test Runs "Test Runs Module Fields" on page 678

Timeslots "Timeslots Module Fields" on page 643

Available for: Performance Center Edition and ALM Edition only

ALM Icons
This section lists the icons available in ALM.

Module Name Description

Business Components See the HP Business Process Testing User Guide

Dashboard "Dashboard Icons" on page 728

Management "Releases Module Icons" on page 133

"Libraries Module Icons" on page 188

Requirements "Requirements Module Icons" on page 235

Test Resource "Test Resources Module Icons" on page 454

Test Plan "Test PlanModule Icons" on page 365

Test Lab "Test LabModule Icons" on page 511

Timeslots "Timeslots Module Icons" on page 646

Available for: Performance Center Edition and ALM Edition only

Build Verification "Build VerificationModule Icons" on page 610

Available for: ALM Edition only

Defects "Defects Module Icons" on page 702

User Properties Page
This page enables you to change your user properties, including full name, password, email address,
phone number, and description.

Note: For additional details on the Project Customization window, refer to theHP Application
Lifecycle Management Administrator Guide.
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To access 1. In the common toolbar, select Tools > Customize.
2. In the Project Customization window, click theUser Properties link.

Important
information

l Email information is important because it enables you to receive email notifications
and alerts directly to your mailbox.

l The site administrator can change and override a user's properties or password.
For more information, refer to theHP Application Lifecycle Management
Administrator Guide.

User interface elements are described below:

UI Element Description

Return Closes the Project Customization window, and returns to the ALM window.

Saves changes to your user properties.

Opens the Change Password for [user name] dialog box, enabling you to
change your login password.

Note: Themaximum length of the password is twenty characters.

This field is not available for LDAP or external authentication users.
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UI Element Description

User Name Your ALM login name.

Note: This field is read-only.

Full Name/
Description

User details.

E-mail Determines the email address to which notifications and alerts are delivered.

Phone Number Your phone number.

Status User status is displayed as Active. Only active users can log in to ALM
projects.

Deactivation Date The date on which the user is scheduled to be deactivated. A deactivated
user cannot log in to an ALM project.

Note: This field is set by the site administrator and is read-only.

Clear History Dialog Box
This dialog box enables you to delete history data.

To access
On themasthead, click and select Clear History.

Important information Youmust have the appropriate user permissions to clear history.

See also "Project History Management " on page 26

User interface elements are described below:

UI Element Description

Entity The entity whose history you want to delete.

Note: To delete history data from all entities, select All.

Field The field whose history you want to delete.

Note: To delete history data from all fields in the selected entity,
select All.

Until Date All data up to and including the selected date is deleted.
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Task Manager Dialog Box
This dialog box enables you to view the status and progress of asynchronous tasks run in your project.
For example, when you create a baseline, ALM runs the task in a background process. You can view
the progress of this task in the Task Manager.

To access
On themasthead, click and select Task Manager.

Important information ALM clears completed tasks from the Task Manager after two days.

User interface elements are described below:

UI Element Description

Pause. Pauses the currently selected tasks.

Note:

You can only pause running tasks.
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UI Element Description

Resume. Resumes the currently selected tasks.

Note:

You can only resume paused tasks.

Abort. Aborts the currently selected tasks.

Note:

You can only abort running tasks.

Delete. Clears the currently selected tasks from the grid.

Note:

l You can clear only completed tasks.
l A task can be cleared only by the user that ran the task, or by a project
administrator.

Refresh All. Refreshes the grid so that it displays themost up-to-date task
information.

If Auto Refresh is enabled, this button is disabled.

Set Auto Refresh On/Off.When enabled, automatically refreshes the grid every 5
seconds so that it displays themost up-to-date task information.

Filter/Sort. Opens the Filter dialog box, enabling you to filter and sort the tasks
displayed in the grid. For more details, see "Filter Dialog Box" on page 51.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For more details, see "Select
Columns/Select Fields Dialog Box" on page 77.

Filter Displays the filter currently applied to the grid. Located directly above the grid.

Start Time The time the task started.

Created By The name of the user who ran the task.

Type The task type. For example, ImportBaseline.

Description A description of the task.

Task
Progress

The percentage of the task that is complete. When the task completes, displays the
final result: Succeeded or Failed.

End Time The time the task completed.
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UI Element Description

Task
Details

Displays details of the selected task.

Click theShow/Hide arrows to display or hide this pane.

Task Id A unique numeric ID for the task, assigned automatically by ALM.

Task State Includes the following options:

l Running. The task is in progress.
l Paused. The task was paused by a user.
l Finished. The task has completed.

Note: If a task is aborted by the user, the Task State value is Finished, and the
Task Progress value is Failed.

Send Error Details Dialog Box
This dialog box enables you to send an error report as amail attachment. This can be helpful when
contacting ALM support, or your local system administrator.
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To access Select Help > Send Error Details.

Important
information

l TheSend Error Details command is enabled by setting theSEND_
EXCEPTION_ENABLED parameter in the Site Configuration tab in Site
Administration. For details, see theHP Application Lifecycle Management
Administrator Guide.

l Themail message is sent using your ALM user account information.
l The information collected is sent as mail attachments. Before sending, you can
review the attachments and remove any that you do not want to send.

User interface elements are described below:

UI Element Description

To Enter a valid email address.

Attachments Attachments include details of your system, a snapshot of your machine at the time
of the error, and any generated log files.

Double-click an attachment to view its contents. Clear the check box for
attachments that you do not want to send.

Subject The date and time that you send the report.

Description A description of the error.
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Chapter 3: ALM Common Functionality
This chapter includes:

• ALM Common Functionality Overview 46
• How to Display ALM Data 46
• How toModify Attachments 49
• How to Search and Replace ALM Data and to UpdateMultiple Records 50
• ALM Common Functionality User Interface 50
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ALM Common Functionality Overview
HP Application Lifecycle Management (ALM) organizes and displays data in grids and trees. You can
manipulate the data in various ways, such as rearranging columns, filtering, sorting, and grouping. You
can also attach files to records, search for specific text in records, and view history of various entities.

Note: As ALM grids and trees vary in the type of content they display, the tasks and references
described in this chapter do not always apply to all grids and trees.

For task details, see "How to Display ALM Data" below, "How toModify Attachments" on page 49, and
"How to Search and Replace ALM Data and to UpdateMultiple Records" on page 50.

How to Display ALMData
This task describes how tomanipulate ALM data.

l "Filter Records" below
l "Sort Records" on the next page
l "Group Records" on the next page
l "Arrange and Resize Columns" on the next page
l "Display ALM History" on the next page

Filter Records
l To filter ALM data to display only those records that meet your criteria, click theSet Filter/Sort

button . The Filter dialog box opens. In the Filter tab, assign a single condition or multiple
conditions. For user interface details, see "Filter Dialog Box" on page 51.

Example

In the Test Labmodule, you can define the Status filter as "Failed" and the Tester filter as
"David OrMark". Only failed test runs performed by David or Mark are displayed.

l To further drill down your data, define a cross filter. In the Filter dialog box, click theCross Filter
tab. For user interface details, see "Filter Dialog Box" on page 51.

Example

In the test plan tree, you can define the cross filter for associated test sets as "Open". This
ensures that only tests that belong to an open test set are displayed. Alternatively, you can
define the associated test set filter to find tests that are not in any test set.

For a use-case scenario on building filters, see "Work with Complex Filters - Use-Case Scenario" on
the next page.

To watch amovie on how to build a filter, refer to this section in the ALMOnline Help.
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Sort Records
You set sorting priorities of records displayed in the ALM trees and grids. By default, records appear in
ALM according to the order in which they were added. In the Filter dialog box, click theView Order tab.
For user interface details, see "Filter Dialog Box" on page 51.

Example

In the Test Grid, if theDesigner column is assigned the highest sort priority, records are sorted in
the ASCII sort order according to the names appearing in the Designer column. If Test Name is
assigned the next highest priority, test records assigned the same name in theDesigner column
are then sorted in the ASCII sort order according to their test name.

Group Records
You separate grid data into groups according to specified criteria. In the Filter dialog box, click the
Group tab. For user interface details, see "Filter Dialog Box" on page 51.

Example

In the Defects Grid, if you select theAssigned To column as the highest group by priority, records
are grouped according to the names appearing in theAssigned To column. If you select Status
andSeverity as the next highest priorities respectively, defects assigned the same name in the
Assigned To column are next grouped according to their status, and then their severity.

Arrange and Resize Columns
Arrange and Select Columns:You determine which columns are displayed in ALM and the order in
which they appear. Select View > Select Columns. The Select Columns dialog box opens. For user
interface details, see "Select Columns/Select Fields Dialog Box" on page 77.

Resize Columns: You resize columns by double-clicking on the right edge of a column heading.
Alternatively, you can click on the right edge of a column heading and drag to adjust the width.

Display ALM History
You can view a list of changes made to ALM entities. In addition, you can view previous versions of
entities stored in a particular baseline.

Click theHistory tab or button. For user interface details, see "History Tab" on page 68.

Work with Complex Filters - Use-Case Scenario
This use-case scenario describes how to build and distribute complex filters.

Note: For a task related to this scenario, see "How to Display ALM Data" on the previous page.
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This scenario includes the following steps:

l "Create a basic filter" below
l "Add criteria with wildcards" below
l "Drill-down using cross filters and Boolean operators" below
l "Group and sort the test instances" on the next page
l "Distribute the filter to others" on the next page

1. Create a basic filter
The following is an example of filtering theExecution Grid of test instances in the Test Lab
module. To access theExecution Grid, see "Execution Grid Tab" on page 528.

You would like to view manual test instances that failed. These failed test instances must be
addressed immediately because the developers for correcting those areas are available.
l In the Filter Test Instances dialog box, specify Manual in the Type field.
l In theStatus field's Select Filter Condition dialog box, select the status Failed.
The filter settings, displayed at the top of the Fitler Test Instances dialog box, appear as follows:

2. Add criteria with wildcards
You begin to see a pattern. Many of the failed test instances are related to logging in to or out of the
flight reservation system. You want to filter out test instances that do not relate to logging in and
logging out.
In the Test: Test Name field's Select Filter Condition dialog box, enter the string *log*. Any test
instance based on a test whose name does not contain the string log is filtered out.
The filter settings appear as follows:

3. Drill-down using cross filters and Boolean operators
At this point, it is confirmed that work needs to be done on the login and logout procedures. To
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prioritize that work, you want to see the failed test instances that are covered by requirements with
high priority.
Because priorities are stored in a different module, you define a cross filter.
a. In the Filter Test Instances dialog box, click theCross Filter tab.
b. In the Requirements section, select the radio button next to <no filter defined>.
c. Click the Browse button, and set thePriority field value. You want any requirement with your

two highest priorities, 4-Very High or 5-Urgent, to be included in the filter, so you insert the
Or operator between them.

The filter settings appear as follows:

4. Group and sort the test instances
In the Filter Test Instances dialog box, click the Sort Order andGroup tabs to define the order in
which you want the remaining test instances to be displayed in the execution grid.
For example, if you want the test instances to be grouped by each test designer, and sorted by
test instance name, the filter settings would appear as follows:

5. Distribute the filter to others
After creating a complex filter, you decide to save it and provide it to others.

In the Filter Test Instances dialog box, click theCopy Filter Settings button. The filter
settings are copied, as text, into your clipboard. You can paste the contents of your clipboard into
an email, and send.
Recipients can then open the Filter Test Instances dialog box in their own ALM client, and click

thePaste Filter Settings button to use the same complex filter.

How to Modify Attachments
This task describes how tomodify an ALM attachment.

When you open an attachment, ALM downloads the attachment to a local directory on your client
machine and opens it in the associated application. After making changes to the attachment, youmust
save the attachment twice. First, save the local copy of your attachment in the application. Then
upload the attachment to your ALM project.
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To modify an attachment:

1. Navigate to the Attachments page for the selected ALM record. For user interface details, see
"Attachments Page" on page 72.

2. Double-click the selected attachment. A local copy opens in the associated application.
3. Modify the attachment.
4. Save the changes in the application. This saves the local copy of your attachment.
5. Close the attachment.
6. In ALM, click theUpload button to upload the local copy to your ALM project.

How to Search and Replace ALMData and to Update
Multiple Records
The following steps describe how to search and replace ALM data, and to updatemultiple records.

l "Search Records" below
l "Replace or Update Records" below

Search Records
Using the Find dialog box, you can search records based on the value of a particular field in a tree or
grid. You can also search a folder for a particular subfolder or record. For user interface details, see
"Find Dialog Box" on page 63.

If available, you can search for keywords and variations of keywords using Text Search. Select Edit >
Text Search. The Text Search pane opens in the lower part window. For user interface details, see
"Text Search Pane" on page 66.

Replace or Update Records
You can replace a field value for a selected record, or for all records in the tree or grid using the Replace
dialog box. For user interface details, see "Replace Dialog Box" on page 65.

You can also update a field value for multiple records in a grid or a tree using the Update Selected dialog
box. For user interface details, see "Update Selected Dialog Box" on page 79.

ALM Common Functionality User Interface
This section includes:

• Filter Dialog Box 51
• Select Filter Condition Dialog Box 61
• Users List Dialog Box 62
• Find Dialog Box 63
• Replace Dialog Box 65
• Text Search Pane 66
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• History Tab 68
• Send E-mail Dialog Box 69
• Attachments Page 72
• Select Image Dialog Box 74
• Snapshot Dialog Box 75
• Select Columns/Select Fields Dialog Box 77
• Update Selected Dialog Box 79
• Set Default Values Dialog Box 80

Filter Dialog Box
This dialog box enables you to filter, sort, and group ALM data to display only those records that meet
the criteria that you define.
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To access
Click the appropriateSet Filter/Sort button .

Important
information

Tip: You can save filtering and sorting settings as a favorite view and then load it
as needed. To save as a favorite view, choose Favorites > Add to Favorites.
The Add Favorite dialog box opens. For user interface details, see "Add Favorite
Dialog Box" on page 94.

Relevant
tasks

"How to Display ALM Data" on page 46

See also "ALM Common Functionality Overview" on page 46

"Work with Complex Filters - Use-Case Scenario" on page 47

Filter Dialog Box Common Elements
Common user interface elements are described below:

UI Element Description

Clear Filter. Clears the filter, sort, and group by settings defined in the Filter dialog
box.

Copy Filter Settings. Copies the filter, sort, and group by settings to the
Clipboard.

Paste Filter Settings. Pastes the filter, sort, and group by settings from the
Clipboard to another project. You can also share the settings with another user by
pasting them to an email or a text file.

l To paste to another project, log in to the project to which you want to paste
the settings, display the appropriate module, and open the Filter dialog box.
Click thePaste Filter Settings button.

l To paste to an email or a text file, click the paste button of the target
application.

Type

Requirement
Type (for
requirements)

Subtype ID
(for
components)

Defines the filter by a selected entity type.

In the Type box, click the browse button. The Select Filter Condition dialog box
opens. Select a type and click OK. The Filter Condition tab displays the relevant
field names.

Note: Only available in certain modules.
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UI Element Description

Hide <entity
fields>

Hides entity fields. Only fields for which no filter condition is set are hidden.

Note: Only available in certain modules.

Requirements module > Requirements. You can hide fields related to risk-
based quality management.

Test Lab module > Execution Grid > Test instances. You can hide Test fields
and/or Test Configuration fields.

Filter Tab
This tab enables you to filter ALM data to display only those records that meet the criteria that you
define.

Important
information

l Requirements Tree: If you are filtering in the requirements tree, parents of filtered
entities that do not correspond to the filter are displayed in the tree with the
icon.

l Test Plan Tree/Test Set Tree: If you are filtering in the test plan or test set tree,
folders in the tree that do not correspond to the filter are not displayed in the tree.
Empty folders will not be displayed after a filter is applied.

l Version Control: For details on filtering data based on version control fields, see
"How to Filter by Version Control Fields" on page 105.

l Data-hiding: For additional details when filtering in the Project Customization
Data-hiding tab, see theHP Application Lifecycle Management Administrator
Guide.

Relevant
tasks

"How to Display ALM Data" on page 46

See also "ALM Common Functionality Overview" on page 46
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User interface elements are described below:

UI
Element

Description

Field
Name

Lists the fields available for filtering.

Tip: To search for a field in the Field Name column, click a box in the Field Name
column and type the first character of the field name. ALM highlights the first
occurrence.

For more details on fields see:

l "Requirements Module Fields" on page 237
l HP ALM LabManagement Guide
l "AUT Environments Module Fields" on page 332
l "Test PlanModule Fields" on page 366
l "Test Resources Module Fields" on page 456
l "Test LabModule Fields" on page 513
l "Timeslots Module Fields" on page 643
l "Build VerificationModule Fields" on page 611
l "Defects Module Fields" on page 703
l Business Process Testing:

l Business Component Module Fields in theHP Business Process Testing User
Guide.

l Test PlanModule Fields for Business Process Testing in theHP Business
Process Testing User Guide.
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UI
Element

Description

Field
Condition

Defines a filter condition for a field.

Click the corresponding Filter Condition box. Click the browse button. The Select Filter
Condition dialog box opens. For more details, see "Select Filter Condition Dialog Box"
on page 61.

Alternatively, you can type directly into the Filter Condition box.

Note:

l If you enter an item with more than one word, it must be enclosed in quotes. For
example, to search for the test Login Boundary, in theCondition box, type
the following: "login boundary"

l If you want to enter only part of the item, use an asterisk (*). For example, to
search for all tests with the word Login, in the Condition box, type the following:
*login*. To search for all tests that begin with the words Insert New in the
Condition box, type the following: "insert new*"

l To specify an empty field, type the following: ""
l To specify a non-empty field, type the following: not ""

l You can use Boolean operators (And, Or, Not) and relational operators in your
filter conditions.

l If you want a logical operator or relational operator to be interpreted literally, you
must enclose it in quotes. For example, to search for a test named <MyTest>,
type the following: "<MyTest>".

Cross Filter Tab
This tab enables you to define a second filter on an associated item such as requirements, tests, test
sets, or defects.

Important
information

The existence of the Cross Filter tab and its user interface elements, may
change, depending on the ALMmodule.

Relevant tasks "How to Display ALM Data" on page 46

See also "ALM Common Functionality Overview" on page 46
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User interface elements are described below:

UI Element
(A - Z)

Description

Alerts An alert can be one of the following:

l Show defects with alerts. Filters the defects by alerts that have been
triggered. This option is only available in the Defects module.

l Show models with alerts. Filters the business process model entities by
alerts that have been triggered. This option is only available in the Business
Models module.

l Show requirements with alerts. Filters the requirements by alerts that have
been triggered. This option is only available in the Requirements module.

l Show test instances with alerts. Filters the test instances by alerts that have
been triggered. This option is only available in the Execution Grid of the Test
Labmodule.

l Show tests with alerts. Filters the tests by alerts that have been triggered.
This option is only available in the Test Planmodule.

Defects Performs one of the following:

l Filters the requirements by defects that have been directly or indirectly linked
to the requirements. Available in the Requirements module.

l Filters the business process model entities by linked defects. Available in the
Business Models module.

l Filters the tests by defects that have been directly or indirectly linked to the
tests. Available in the Test Planmodule.

l Filters the test sets by defects that have been directly or indirectly linked to the
tests. Available in the Test Set Tree of the Test Labmodule.

Select <no filter defined> to define a filter. The Filter dialog box opens. For more
details, see "Filter Tab" on page 53.

Model
Activities

Filters models by activities that they include.

Select <no filter defined> to define a filter. The Filter dialog box opens. For more
details, see "Filter Tab" on page 53.

Model Paths Filters models by paths that they include.

Select <no filter defined> to define a filter. The Filter dialog box opens. For more
details, see "Filter Tab" on page 53.
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UI Element
(A - Z)

Description

Requirements Performs one of the following:

l Filters the business process model entities by linked requirements. Available in
the Business Models module.

l Filters the tests by covered requirements. Available in the Test Planmodule.
l Filters the test instances by tests that cover selected requirements. Available
in the Execution Grid of the Test Labmodule.

l Filters the defects by linked requirements. Available in the Defects module.
Select <no filter defined> to define a filter. The Filter dialog box opens. For more
details, see "Filter Tab" on page 53.

Select Tests with no requirement coverage to filter tests that do not cover any
requirements. For example, this can help you identify redundant tests or tests
with missing requirement coverage links. This option is only available in the Test
Planmodule.

Requirements:
Trace from

Filters the requirements by traced from requirements. Available in the
Requirements module.

Select <no filter defined> to define a filter. The Filter dialog box opens. For more
details, see "Filter Tab" on page 53.

Requirements:
Trace to

Filters the requirements by traced to requirements. Available in the Requirements
module.

Select <no filter defined> to define a filter. The Filter dialog box opens. For more
details, see "Filter Tab" on page 53.

Runs Performs one of the following:

l Filters the tests by test runs. Available in the Test Planmodule.
l Filters the test instances by test runs. Available in the Execution Grid of the
Test Labmodule.

Select <no filter defined> to define a filter. The Filter dialog box opens. For more
details, see "Filter Tab" on page 53.

Test
Configurations

Performs one of the following:

l Filters the requirements by test configurations. Available in the Requirements
module.

l Filters the tests by test configurations. Available in the Test Planmodule.
l Filters the test sets by test configurations. Available in the Test Labmodule.
Select <no filter defined> to define a filter. The Filter dialog box opens. For more
details, see "Filter Tab" on page 53.
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UI Element
(A - Z)

Description

Test Criteria Filters the requirements by test criteria. Available in the Requirements module.

Select <no filter defined> to define a filter. The Filter dialog box opens. For more
details, see "Filter Tab" on page 53.

Business Process Testing: Functionality related to test criteria is available only
for business process tests. For details, see theHP Business Process Testing
User Guide.

Test Instances Filters the test sets by test instance details. Available in the Test Sets Tree of the
Test Labmodule.

The filter applied to the Test Sets Tree can also be applied to the Execution Grid.

Select <no filter defined> to define a filter. The Filter dialog box opens. For more
details, see "Filter Tab" on page 53.

Test Sets Performs one of the following:

l Filters the tests by test sets that contain the tests. Available in the Test Plan
module.

l Filters the test instances by test sets that contain the test instances. Available
in the Execution Grid of the Test Labmodule.

Select <no filter defined> to define a filter. The Filter dialog box opens. For more
details, see "Filter Tab" on page 53.

Select Tests not in any test set to filter tests that are not part of any test set. For
example, this can help you identify tests that have not been run. This option is
only available in the Test Planmodule.

Tests Performs one of the following:

l Filters the requirements by covered tests. Available in the Requirements
module.

l Filters the business process model entities by linked tests. Available in the
Business Models module.

l Filters the test sets by contained tests. Available in the Test Set Tree of the
Test Labmodule.

l Filters the defects by linked tests. Available in the Defects module.
Select <no filter defined> to define a filter. The Filter dialog box opens. For more
details, see "Filter Tab" on page 53.
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View Order Tab
This tab enables you to sort records according to the ASCII sort order.

Important
information

l The existence of the View Order tab, and its user interface elements, may change
depending on the ALMmodule.

l The View Order tab considers records beginning with a space or character before
considering those beginning with numbers. It then considers uppercase letters
and, finally, lowercase letters.

Relevant
tasks

"How to Display ALM Data" on page 46

See also "ALM Common Functionality Overview" on page 46

User interface elements are described below:

UI Element Description

Available
Fields

Displays the names of all the fields you can display.

Sorted
Fields

Displays the names of the fields currently assigned a sorting priority.

Sets the sort priority in the Sorted Fields pane.

Tip: You can also drag the field names up or down.

Moves selected fields betweenAvailable Fields andSorted Fields.

Tip: You can also drag the field names between panes or double-click a field
name tomove it across to the other pane.

Moves all fields betweenAvailable Fields andSorted Fields.

Sorts a selected field in theSorted Fields pane in an ascending or descending order.
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Group Tab
This tab enables you to separate grid data into groups according to specified criteria. You can
determine the information by which ALM groups records, and set the hierarchical order in which they
are displayed (up to three levels). This enables you to navigate through large sets of datamore easily.

Important
information

l The existence of the Group tab, and its user interface elements, may change
depending on the ALMmodule.

l TheGroup tab is only available in grid views.
l You cannot select a group header and perform ALM actions on an entire group. To
perform actions onmultiple records, use CTRL or SHIFT to select records.

l If you group records by a field containingmultiple values, the information in each
value is grouped as its entire value. This value is the category for grouping. For
example, a value with English and Frenchwill be grouped once as
English;French, and not as part of separate English and French categories. For
more information on allowingmultiple values, see theALLOW_MULTIPLE_
VALUES site configuration parameter. For details, refer to theHP Application
Lifecycle Management Administrator Guide.

l The group by list displays only system and user-defined fields associated with a
User List or Lookup List type field. For more information on field types, refer to the
HP Application Lifecycle Management Administrator Guide.

Relevant
tasks

"How to Display ALM Data" on page 46

See also "ALM Common Functionality Overview" on page 46

User interface elements are described below:

UI
Element

Description

Group
items
by

Groups records according to the selected field.

Then by Groups records by additional fields.

Note: If you group records by more than one field, select fields in the hierarchical
order that you want them to be displayed. You cannot select a field that has already
been selected.

Clears the grouping selection and changes it to none.

Note: If you clear a grouping that has child groupings defined on it, the child
groupings move up one level and the last group changes to none.
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Select Filter Condition Dialog Box
This dialog box enables you to set a filter condition for a field.

To access Use one of the following:

l Open the Filter dialog box. In the Filter tab, click a Filter Condition box. Click the
drop-down arrow.

l In a grid view, click a grid filter box under a column name. Click the browse button.

Important
information

In the Requirements module, if you select theReq Parent field, the Select Filter
Condition dialog box displays the requirements tree, sorted by requirement name. If
you select a requirement from the requirements tree, its full path is displayed in the
Condition box. Only requirements which are descendents of this requirement are
displayed when you apply the filter.

See also l "Filter Dialog Box" on page 51
l "Users List Dialog Box" on the next page

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Condition Indicates the filter condition for the current field.

Note:

l If you enter an item with more than one word, it must be enclosed in quotes.
For example, to search for the test Login Boundary, in theCondition box,
type the following: "login boundary"

l If you want to enter only part of the item, use an asterisk (*). For example, to
search for all tests with the word Login, in the Condition box, type the
following: *login*. To search for all tests that begin with the words Insert
New in the Condition box, type the following: "insert new*"

l To specify an empty field, type the following: ""
l To specify a non-empty field, type the following: not ""

l If you want a logical operator or relational operator to be interpreted literally,
youmust enclose it in quotes. For example, to search for a test named
<MyTest>, type the following: "<MyTest>".

Clears the filter condition.
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UI Element Description

<field value
pane>

Displays the values that are available for defining a filter condition for the current
field. Select a value to add to theCondition box.

If you select a field with a user name value, the <condition pane> displays a user list
that enables you to sort users, search for users, group users by user groups, and
select users from the list or from a group tree. For details, see "Users List Dialog
Box" below.

If you select a field with value that must be selected from a tree, the <field value
pane> displays a search field and a refresh button.

Note: Some items that appear in hierarchical lists contain sub-lists. These
items are preceded by a folder icon. To choose an item from a sub-list, double-
click the folder and click the item.

<logical
expression
pane>

Displays the Boolean and relational operators that are available for defining logical
expressions.

l And. Retrieve all items containing all of the criteria this operator separates.
l Or. Retrieve all items containing any of the criteria this operator separates.
l Not. Retrieve all items that do not contain the criterion following this operator.
l ( and ). Group criteria when combining Boolean phrases and to show the order in
which relationships should be considered.

l < Less than. Retrieve items less than the criterion following this operator.
l > Greater than. Retrieve items greater than the criterion following this operator.
l <= Less than or equal. Retrieve items less than or equal to the criterion
following this operator.

l >= Greater than or equal. Retrieve items greater than or equal to the criterion
following this operator.

l = Equal. Retrieve items equal to the criterion following this operator.

Users List Dialog Box
This dialog box enables you to choose a user name from a user list. You can sort the users list, search
for users, group users by user groups, and select users from the list or from a group tree.

To access In an ALM grid or tree, select a columnwith a user name value, and click the drop-
down arrow. The Users List dialog box opens.

Important
information

l To sort the Users List in ascending or descending order by user name or full name,
click theName or Full Name column heading. Click the column heading again to
reverse the sort order.

l When defining a condition for a user, you can specify the current user (select
[CurrentUser]), or an entire user group (for example, [Developer]).

See also "Select Filter Condition Dialog Box" on the previous page
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User interface elements are described below:

UI
Element

Description

Find. Searches users by user name or full name. Type the name of a user (or part of the
name) in the Find box and click the Find button. ALM highlights the first record that
contains the search string. Press F3 to find subsequent occurrences of the search string.

Tip: You can also search incrementally by typing the first character of the user name
under theName column. You can type additional characters to narrow down the
search. ALM begins searching as soon as you type the first character of the search
string, and highlights the record with the first occurrence of all the characters in the
search string.

Name The ALM login name.

Full
Name

The full name of the user.

View by
Group

Displays users by user group.

Find Dialog Box
This dialog box enables you to search for a particular record in a tree or grid. You can search records
based on the value of a particular field. You can also search a folder for a particular subfolder or record.

To access Use one of the following:

l Select Edit > Find.
l In the Execution Grid, select Tests > Find.
l In the test sets tree, select Edit > Find Folder/Test Set.
Available from the following modules:Requirements, Business Components,
Test Plan, Test Resources, Test Lab, and Defects.

Important
information

l If a filter is applied to a tree or grid, the search is restricted to the records currently
displayed.

Tip: If available, Text Search is a more powerful tool that enables you to
search for keywords and variations of keywords. For more details, see "Text
Search Pane" on page 66.

Relevant
tasks

"How to Search and Replace ALM Data and to UpdateMultiple Records" on page 50

See also "Replace Dialog Box" on page 65
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User interface elements are described below:

UI Element Description

Find in
Folder

Displays the name of the folder selected in the tree.

Available from:Component Tree, Test Plan Tree, Test Resource Tree, and Test
Sets Tree.

Find in Field Indicates the field for ALM to search in.

Available from:Requirements module, all module grid views.

Value to Find The field value for which ALM searches. The search is not case sensitive.

Search for Instructs ALM to search for folders only, individual records only, or both folders and
individual records.

Available from:Component Tree, Test Plan Tree, Test Resource Tree, and Test
Sets Tree.

Exact Match Finds records with values that exactly match the specified search string.

Note: Not enabled when the Find in Field element is set to a numeric field, for
exampleDefect ID, or to a text field that contains rich text, for example
Description.

Use Wildcard Enables you to use asterisk (*) characters in your search string in order to type only
part of the item.

Note: Not enabled when the Find in Field element is set to a numeric field, for
exampleDefect ID, or to a text field that contains rich text, for example
Description.

Case
Sensitive

Instructs ALM to distinguish between uppercase and lowercase characters.

Note: Not enabled when the Find in Field element is set to a numeric field, for
example Defect ID.

Searches for the specified value in a tree view. If the search is successful, the
Search Results dialog box opens and displays a list of possible matches. Select a
result from the list and click Go To to highlight the record in the tree. If the search is
unsuccessful, an information box opens.

Searches for the next record in the grid that matches the specified value. If the
search is successful, thematching record is highlighted in the grid. If the search is
unsuccessful, an information box opens.

Name to Find The value in theName field for which ALM searches. The search is not case
sensitive. Results include records where the search stringmatches the value, or
part of the value, of theName field.
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Replace Dialog Box
This dialog box enables you to find and replace field values in a tree or grid. You can replace a field
value for a selected record, or for all records in the tree or grid.

To access Use one of the following:

l In a grid view, select Edit > Replace.
l In the Execution Grid, select Tests > Replace.

Important
information

If a filter is applied to a tree or grid, the search and replace is restricted to the
records currently displayed.

Relevant tasks "How to Search and Replace ALM Data and to UpdateMultiple Records" on
page 50

See also l "Find Dialog Box" on page 63
l "Update Selected Dialog Box" on page 79

User interface elements are described below:

UI
Element

Description

Find in
Field

Indicates the field for ALM to search.

Version Control: If the field is non-versioned (meaning, the field's data are not saved
with each version), an asterisk (*) is displayed as a prefix to the field name in the Find in
Field list. The checkout operation is bypassed when performing aReplace operation on
non-versioned entities. For details on setting a field as a versioned/non-versioned, see
theHP Application Lifecycle Management Administrator Guide.

Value to
Find

The field value for which ALM searches.

Replace
with

Indicates the replacement field value.

Exact
Match

Finds records with values that exactly match the specified search string.

Note: Not enabled when the Find in Field element is set to a numeric field, for
exampleDefect ID, or to a text field that contains rich text, for example
Description.

Use
Wildcard

Enables you to use asterisk (*) characters in your search string in order to type only part
of the item.

Note: Not enabled when the Find in Field element is set to a numeric field, for
exampleDefect ID, or to a text field that contains rich text, for example
Description.
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UI
Element

Description

Find in
Field

Indicates the field for ALM to search.

Version Control: If the field is non-versioned (meaning, the field's data are not saved
with each version), an asterisk (*) is displayed as a prefix to the field name in the Find in
Field list. The checkout operation is bypassed when performing aReplace operation on
non-versioned entities. For details on setting a field as a versioned/non-versioned, see
theHP Application Lifecycle Management Administrator Guide.

Value to
Find

The field value for which ALM searches.

Case
Sensitive

Instructs ALM to distinguish between uppercase and lowercase characters.

Note: Not enabled when the Find in Field element is set to a numeric field, for
exampleDefect ID.

Replace Replaces the specified field value for the selected record.

Replace
All

Searches for and replaces the specified field value in all records displayed in the grid.

Find
Next

Searches for the next record in the grid that matches the specified value. If the search is
successful, thematching record is highlighted in the grid. If the search is unsuccessful,
an information box opens.

Text Search Pane
This pane enables you to search for records in predefined fields.

To access Select Edit > Text Search. The Text Search pane opens in the lower part window.

Available from the following modules: Requirements, Business Components,
Test Plan, and Defects.

Important
information

l Text search is only available if it has been enabled for the project. Contact your
ALM site administrator if the search option is unavailable.

l Searchable text fields are predefined in Project Customization. For more details,
see theHP Application Lifecycle Management Administrator Guide.

l Version Control: ALM searches only checked in versions.

Relevant
tasks

"How to Search and Replace ALM Data and to UpdateMultiple Records" on page 50

See also "Find Dialog Box" on page 63
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

Search
for

Indicates the keywords you want to find.

Syntax exceptions:

l Text search ignores the following: articles (a, an, the); coordinate conjunctions (and,
but, for, nor, or); boolean operators (and, or, not, if, or, then).

l The search is not case sensitive.

Note:

l When you enter a keyword, ALM searches the predefined fields for the keyword
or variations of the keyword. For example, if you type log, the search will find
fields containing log, logs, logging, and logged. The search will not find login
or logical because these are not variations of the word.

l If you enter more than one keyword, the results will include all records that
contain at least one of the keywords.

In Enables searching for text in Tests orDesign Steps.

Available from: Test Planmodule.

Restrict
to
current
filter

Indicates whether to search all records in themodule or restrict the search to the filtered
records.

Search Performs the text search on the predefined fields and displays the search results in order
of relevance.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
column appearance and order. For more details, see "Select Columns/Select Fields
Dialog Box" on page 77.

Searchable Fields. Displays the list of predefined search fields set in Project
Customization.

Details. Opens the corresponding Details dialog box, enabling you to view and update
details of the selected entity.

Go to Entity. Select a record and click the button to display record details.

Tip: Alternatively, select a record and click the <record ID> or <record Name> link.

Load Selected Results. Loads the selected results to the grid or tree and clears the
current filter.

Tip:Press the CTRL key to select multiple results.
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UI
Element

Description

<module
fields>

Requirements. For details on the fields available in the Requirements module, see
"Requirements Module Fields" on page 237.

Test Plan. For details on the fields available in the Test Planmodule, see "Test Plan
Module Fields" on page 366.

Defects. For details on the fields available in the Defects module, see "Defects Module
Fields" on page 703.

Business Process Testing: For details on the fields available in the Business
Components module, see Business Component Module Details Fields in theHP
Business Process Testing User Guide.

Item Number of the item selected in the search results and the total number of items found.

History Tab
This tab enables you to view a list of changes made to the currently selected entity. In addition, this tab
displays a history of baselines in which the entity appears.

To access Click theHistory tab or button.

Important
information

For details on preserving the history of changes made to a field, see theHP
Application Lifecycle Management Administrator Guide.

Relevant
tasks

"How to Display ALM Data" on page 46
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Baselines Tab
This tab displays previous versions of entities stored in a particular baseline. For more details, see
"Baselines Tab" on page 198.

Versions Tab
Version Control: This tab is displayed when version control is enabled for a project. For details, see
"Versions Tab" on page 113.

Audit Log Tab
This tab displays the date and time of the change and the name of the user whomade the change to the
entity.

Note: In the Requirements module, the history of the Target Release and Target Cycle fields for
a requirement is not recorded.

User interface elements are described below:

UI Element Description

Field Specifies which field changes are displayed in the grid. To view changes made to
all fields, select <All>.

Expands or collapses all changes displayed in the grid.

Field Name The field modified during the change.

Old Value The prior field value.

New Value The current field value.

Send E-mail Dialog Box
This dialog box enables you to send an email about an entity to other users. A link is included in the
email message that enables the recipient to go directly to the entity.

To access
Select one or more entities. Click theSend by E-mail arrow and choose one of
the following options:

l Send by E-mail. Sends email to recipients selected from a list.
l Send by E-mail to <specific recipient >. Sends email to a specific recipient. For
example, in the Requirements module, chooseSend by E-mail to Author to
send the email to the user who wrote the requirement.
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Important
information

l The following are automatically included in the email:
l Link to the entity
l Summary of the entity
l Sender comments (specified using the "Additional Comments" user interface
element)

l Details
To include additional items, see the "Include" UI element.

l By default, after clickingSend, the email is queued to be sent (asynchronously)
and you can continue working. If the send operation fails, you receive an email
indicating undeliverable mail.
To sendmail synchronously (meaning, the send operation is attempted
immediately and, when completed, you can continue working), edit theASYNC_
MAIL_ENABLED parameter in the Site Configuration tab in Site Administration.
For more details, see theHP Application Lifecycle Management Administrator
Guide.

l By default, ALM sends emails in HTML format. To send emails as plain text
instead, edit theMAIL_FORMAT parameter in the Site Configuration tab in Site
Administration. For more details, see theHP Application Lifecycle Management
Administrator Guide.

l By default, the link to the entity that is included in the email message contains the
path using the default mail server host name and port number. Tomodify the link's
path to a different mail server, edit theENTITY_LINK_HOST andENTITY_LINK_
PORT parameters in the Site Configuration tab in Site Administration. For more
details, see theHP Application Lifecycle Management Administrator Guide.

l By default, themaximum email attachment size is limited. If the attachment size is
greater than the specified value, the email is sent without the attachment. To
modify the attachment size limit, edit theATTACH_MAX_SIZE parameter in the
Site Configuration tab in Site Administration. For details, see theHP Application
Lifecycle Management Administrator Guide.

User interface elements are described below:

UI
Element

Description

Check Spelling. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Custom. Opens the Select Fields dialog box, enabling you to determine which fields
to display in the email. For more details, see "Select Columns/Select Fields Dialog
Box" on page 77.
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UI
Element

Description

To/CC Indicates a valid email address or user name. Alternatively, click the To button orCC
button to select users. The Select Recipients dialog box opens. Select the users or
user groups to which you want to send the email.

Subject The subject for the email.

Default value: The domain, project, entity ID (if applicable), and entity name are
displayed.

Send me a
copy

Enables you to send yourself a copy of the email.

Add to
comments

Adds a comment to whom the entity was sent in the Comments field of the entity.
Text added in the "Additional Comments" on the next page section is also included.

Item The entity name.

Include Enables you to include the following:

l Activities. Only available from the Business Models module.
l Attachments.
l Design Steps. Only available from the Test Planmodule.
l History.
l Linkage. Only available from the Business Models module.
l Paths. Only available from the Business Models module.
l Snapshot. Only available from the Business Components module.
l Test Coverage. Only available from the Requirements module.
l Traced Requirements. Only available from the Requirements module.
l Run Steps. Only available from:

l The Test Labmodule.
l If the run is linked to a defect, the Linked Entities tab in the Defects module.

l Runs. Only available from:
l The Test Labmodule for test instances.
l If the test instance is linked to a defect, the Linked Entities tab in the Defects
module.

Note:

l As soon as one of the above items is selected for inclusion, Parameters are
also included in the email, provided that parameters exist for the entity and the
parameters have values.

l The Include option is not available from the Test Resources module.
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UI
Element

Description

Additional
Comments

Enables you to add comments about the email.

Click in the text box to display a toolbar for formatting and spell checking the text.

Send Sends the email to the specified distribution list.

Attachments Page
This page enables you to add andmanage attachments to ALM records. You can attach a file, URL,
snapshot of your application, items from the Clipboard, or system information.

To access Use one of the following:

l Click theAttachments button in a toolbar.
l Click theAttachments button in a dialog box sidebar.
l Click theAttachments tab.

Important
information

When you add an attachment, ALM adds the attachment icon to the record. You
can click the icon to see a list of attachments.

Tip: Add an attachment by dragging and dropping the file fromWindows
Explorer onto theAttachments page.

Relevant
tasks

"How toModify Attachments" on page 49
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User interface elements are described below:

UI Element Description

File. Opens theOpen dialog box, enabling you to add a file attachment to an ALM
record.

Tip: To add an email as an attachment to a record, save the email on your
desktop and then use theOpen dialog box to add it.

URL. Opens the Attach Uniform Resource Locator (URL) dialog box, enabling you
to add a URL attachment to an ALM record. This can be any valid URL scheme
such as HTTP, FTP, Gopher, News, Mailto, or File.

Snapshot. Opens the Snapshot dialog box, enabling you to add an image of your
application to an ALM record. For more details, see "Snapshot Dialog Box" on
page 75.

Snapshot attachments are assigned a .jpg extension.

System Info. Opens the System Information dialog box, enabling you to attach
system information about your machine to an ALM record.

System information attachments are assigned a .tsi extension.

Clipboard. Attaches the Clipboard content to an ALM record.

Copy a text string or an image to the Clipboard and click theClipboard button. A
text string is assigned a .txt extension. An image is assigned a .jpg extension.

Download and Open. Opens the selected attachment by downloading it to a local
directory on your client machine and opening it in the associated application. You
can view ormodify an open attachment.

The attachment is saved on the client machine, under the following directory:

%Temp%\TD_80\<ALM_PATH>\<Project_id>\Attach\BUG\

Upload Selected. Uploads themodified attachment to your ALM project. For more
details, see "How toModify Attachments" on page 49.

Save Attachment. Saves the copy of a selected attachment to your client
machine.

Note: Not available when adding attachments to a new entity.

Delete Selected. Deletes the selected attachment. To select more than one
attachment, use the CTRL key.

Refresh All. Refreshes the list of attachments on the page.
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UI Element Description

Name The attachment name. An icon for the application associated with the attachment
appears next to the name. To rename the attachment, right-click and select
Rename.

Size The size of the attachment.

Modified The date that the attachment was last modified.

Description Describes the attachment.

Click in the text box to display a toolbar for formatting and spell checking the text.

Select Image Dialog Box
This dialog box enables you to add images to ALM records. You can attach an image, a snapshot of
your application, or items from the Clipboard.

To access Click theAttachments button in a toolbar.

Important
information

TheAttachments button is found in the toolbar for any memo field of an entity that
support attachments, such as theDescription andComments sections of a defect.

User Guide
Chapter 3: ALM Common Functionality

HP ALM (12.50) Page 74



User interface elements are described below:

UI Element Description

Uploads a selected image to your ALM record.

Note: .ico and .tif image formats are not supported.

Snapshot. Opens the Snapshot dialog box, enabling you to add an image to an
ALM record. You can capture a selected area, a selected window, or the entire
screen.

Snapshot images are assigned a .png extension.

Clipboard. Attaches the Clipboard content to your ALM record.

Copy an image to the Clipboard and click theClipboard button. An image is
assigned a .png extension.

Image Size
(%)

Increase or decrease the image size.

Insert as Link Select this to make the image a link in your ALM record.

Name The image name.

Size The size of the image.

Note: Your site administrator can limit the image size.

Modified The date that the image was last modified.

Preview Shows the image.

If you select Insert as Link, the preview shows the link, not the image.

Snapshot Dialog Box
This dialog box enables you to capture and attach images of your application to an ALM record.
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To
access

Use one of the following:

l In the Attachments page, click theSnapshot button .
l In the Business Components module, click the Snapshot tab and then click the

Snapshot button .

l In the Select Image dialog box, click theSnapshot button .

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Capture the current window.

Capture an area that you define.

Capture the entire screen.

After capturing the image, the annotation window opens. Use the annotation tools to edit the image or
to capture a new image.
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Select Columns/Select Fields Dialog Box
The Select Columns dialog box enables you to specify which columns are displayed in ALM and the
order in which they appear.

The Select Fields dialog box enables you to specify which fields are displayed when sending emails
about entities to other users.

To access Select Columns dialog box:

Use one of the following:

l Select View > Select Columns.
l In the Execution Grid, select Tests > Select
Columns.

Select Fields dialog box:

In the Send E-mail dialog box, click theCustom button.

Relevant tasks "How to Display ALM Data" on page 46

User Guide
Chapter 3: ALM Common Functionality

HP ALM (12.50) Page 77



User interface elements are described below:

UI Element Description

Type Displays the test fields related to a selected test type in the
Available Columns list.

Note: Available only in the Test Plan and Test Labmodules.

Requirement Type Displays the requirement fields related to a selected requirement
type in theAvailable Columns list.

Note: Available only in the Requirements module.

Hide Risk-Based Quality
Management Columns

Hides the requirement fields related to risk-based quality
management from theAvailable Columns list.

Note: Available only in the Requirements module.

Available Columns Lists columns that are not currently displayed.

Moves selected fields betweenAvailable Columns andVisible
Columns.

Tip: You can also drag the field names between panes or
double-click a field name tomove it across to the other pane.

Moves all fields betweenAvailable Columns andVisible
Columns.

Visible Columns Lists columns that are currently displayed.

Note: Columns displayed with the icon cannot be removed
from theVisible Columns list.

Moves the selected field to the top or bottom of the Visible
Columns list.

Sets the order in which column names appear inVisible Columns.

Tip: You can also drag the column names up or down.
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Update Selected Dialog Box
This dialog box enables you to update a field value for multiple records in a grid or a tree.

To
access

Right-click selectedmultiple records and select Update Selected.

Available from the following modules:Requirements, Test Plan (Test Grid only),
Test Lab (Execution Grid tab), Build Verification, and Defects.

Relevant
tasks

"How to Search and Replace ALM Data and to UpdateMultiple Records" on page 50

See also "Replace Dialog Box" on page 65

User interface elements are described below:

UI
Element

Description

Update
Field

Identifies the field to be updated.

Version Control: If the field is non-versioned (meaning, the field's data are not saved
with each version), an asterisk (*) is displayed as a prefix to the field name in the Update
Field list. The checkout operation is bypassed when performing an Updated
Selected operation on non-versioned entities. For details on setting a field as a
versioned/non-versioned, see theHP Application Lifecycle Management Administrator
Guide.

Value The replacement value for the selected field.

Update Indicates the number of values that were updated, and the number of instances where the
values were not updated.
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Set Default Values Dialog Box
This dialog box enables you to set default values for certain fields when defining new tests, test
configurations, and defects.

To access
Click  from the following dialog boxes:

l New Test dialog box
l New Test Configuration dialog box
l New Defect Dialog box
Available from the following modules: Test Plan and Defects

Important
Information

l Each user sets his/her own default values for each entity.
The default values are set for the entity regardless of module. For example, the
same default values are used for defects created in the Defects module and the
defects created in the Test Planmodule.

l To clear default values, chooseEdit > Clear Default Values.
l The size of default field values per module per user is limited to 5K.
l Your project may contain a workflow that enables you to specify that a different
field list be used for a (secondary) field depending on the value of another (primary)
field. In this case, the order in which you add fields to the list in the Set Default
Values dialog box is important. First add the primary field to the list, and then add
the secondary field. (You can also reorder the fields as necessary.) This ensures
that the list of possible default values displayed for the secondary field are viable
according to the selected primary field value and defined workflow rules.
For details about workflow and dependencies between field values and lists, see
theHP Application Lifecycle Management Administrator Guide.
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User interface elements are described below:

UI Element Description

Field Identifies the field for which to set a default value.

Click the down arrow to see a drop-down list of the fields for which you can specify
a default value.

Tip: ALM does not support the setting of default values for all fields.
Additionally, workflow rules based on events (such as fieldChange or
fieldCanChange) can be defined to set certain fields to read-only or invisible.
Fields whose default values cannot be set, read-only fields, and invisible fields
are not displayed in the drop-down list.

Value The default value for the selected field.

For memo fields, date fields, and fields with user-defined lists, click the down arrow
to open up a window that enables you to type text or select values from a list.

Add Adds the Field andValue values to the grid.

Tip: Tomodify the default value for a field that was already added to the list,
add it again. You are prompted to override the original one.

Remove Removes the selected fields and their values from the grid.

Up / Down Moves the selected fields and their values up or down in the grid.

Note: Reordering the fields in the list helps ensure that the list of possible
default values displayed for each field are available and viable according to
defined workflow rules.

Selected
values

Grid listing fields whose default values are set.

Reordering the fields in the grid helps ensure that the list of possible default values
displayed for each field are available and viable according to defined workflow
rules. For details, see "Important Information" on the previous page.

When
creating a
new entity,
use these
defaults
automatically

If checked, indicates that when you create a new entity, the default values for that
entity's fields are automatically filled in.

If unchecked, default values are not filled in automatically. To use default values,
click theUse Default Values button when creating the entity. For user interface
details, see "New Test Dialog Box" on page 371, "New Test Configuration/Test
Configuration Details Dialog Box" on page 430, or "New Defect Dialog Box" on
page 705.
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Alerts Overview
When a requirement, test, or defect changes, HP Application Lifecycle Management (ALM) can alert
the associated entities and notify those responsible for any associated entities. Your project
administrator can activate alert rules based on associations youmake between requirements, tests,
and defects. The alert rules are based on the following associations you can create:

l You can associate a test in the test plan tree with a requirement. This is accomplished by creating
requirements coverage in the Test Planmodule, or by creating tests coverage in the
Requirements module. For more information, see "Requirement and Test CoverageOverview" on
page 376.

l You can associate a test instance with a defect. This is performed by creating Linked Defects in the
Test Planmodule, or by adding a defect during amanual test run. For more information, see "Defect
Linkage" on page 692.

l You can create traceability links between requirements in the Requirements module. For more
information, see "Requirements Traceability Overview" on page 252.

After you establish associations in your project, you can track changes using these associations.
When an entity in your project changes, ALM alerts any associated entities that may be impacted by
the change. The alert can be seen by all users, and also notifies the person responsible for the entity at
the time of the change of any associated entities that may be impacted by the change.

In the Alerts column in a tree or grid view, the Alerts flag indicates the following:

l A red alert flag indicates that the alert is new.

l A gray alert flag indicates that the alert has already been read.
Version Control: ALM alerts associated entities only when a new version is checked in. The alert
states that the version status has changed toChecked In. It does not indicate which fields have been
modified. You can then compare the new version with the previous version. For more information on
comparing versions, see "Versions Tab" on page 113.

Note:While the entity is checked out, changes made to non-versioned fields continue to generate
regular alerts, indicating which field was changed. For more information on non-versioned fields,
see "Non-versioned Fields" on page 106.
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Your ALM project administrator can activate four alert rules:

Rule Description Entities Flagged

User
Notified by
Email

1 When a requirement is modified, alert the associated
tests.

Note: A change to the requirement can be any
modification, excluding changes to theDirect
Cover Status field and the risk-based quality
management fields.

Tests covering the
requirement.

Test
designer.

2 When a defect status changes to "Fixed", alert the
associated test instances.

Test instances
associated with the
defect.

Responsible
tester for the
test
instance.

3 When a test runs successfully (status changes to
"Passed"), alert the linked defects.

Defects linked to the
test run.

User
assigned
the defect.

4 When a requirement is modified or deleted, alert
traced to requirements and child requirements.

The requirement's
child requirements
and traced to
requirements.

Author of
the
requirement.

For details on activating alert rules in Project Customization, refer to theHP Application Lifecycle
Management Administrator Guide.

For more details on working with Alerts, see "How to Use Alerts" on the next page.

Follow Up Flags Overview

You can add a follow up flag to a specific requirement, test, test instance, or defect to remind
yourself to follow up on an issue. For example, you can set a follow up flag on a defect to remind
yourself to check the status in a week.

When you add a follow up flag, ALM adds a gray flag icon to the record. When the follow up date
arrives, ALM sends you email and changes the flag icon to red.

A follow up flag is specific to the user namewith which you logged on. You can open the follow up flag
at any time to view ormodify the details.

For user interface details, see "Flag For Follow UpDialog Box" on page 89.
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How to Use Alerts
This task describes how to work with automatic notification alerts to keep track of changes made to
your requirements, tests, and defects.

To learnmore about alerts, see "Alerts Overview" on page 84.

This task includes the following steps:

l "Prerequisites" below
l "View alerts" below
l "Clear alerts" below

1. Prerequisites
Verify that alert rules are activated for your project. Alert rules, activated by the project
administrator, instruct ALM to send email to notify those responsible when changes occur in your
project. For details, refer to theHP Application Lifecycle Management Administrator Guide.

2. View alerts
View alerts for a single record, or for all records in amodule.

l View Alerts for a Record. In a tree or grid view, click theAlert flag in the Alerts column. If
this column is not visible, select View > Indicator Columns. For user interface details on the
Alerts dialog box, see "Alerts Dialog Box" on page 88.

l View Alerts for a Module. To view a list of all alerts for a selectedmodule, in the Filter dialog
box > Cross Filter tab, select theShow <entity> with alerts option. For user interface details
on the Filter dialog box, see "Filter Dialog Box" on page 51.

3. Clear alerts
Clear alerts for a single record, or for all records in amodule.
l Clear Alerts for a Record. For a selected record, you can clear an individual alert or all alerts
in the Alerts dialog box.

o To clear a single alert, click Clear Alert for the alert.
o To clear all alerts for the record, click theClear All button.
For user interface details on the Alerts dialog box, see "Alerts Dialog Box" on page 88.

l Clear Alerts for a Module. You can clear all the alerts associated with all the records in an
ALMmodule.
o In the Requirement, Test Plan, or Defects module, select Edit > Clear Alerts.
o In the Test Labmodule, select Tests > Clear Alerts.
Only alerts associated with records that match the current filter are cleared. In addition, you
can only clear alerts that are assigned to you, or that are not assigned to any user. The user to
whom an alert is assigned is the user who receives email notification when the alert is
triggered. This user is listed in the Alerts dialog box for the alert. For details on alert rules and
the users that are sent email notification, see "Alerts Overview" on page 84.
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Alerts and Flags User Interface
This section includes:

• Alerts Dialog Box 88
• Flag For Follow UpDialog Box 89
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Alerts Dialog Box
This dialog box enables you to view a list of alerts for a selected record.

To access Use one of the following:

l In a tree or grid view, click theAlerts flag in the Alerts column. If this column is
not visible, select View > Indicator Columns.

l Right-click the entity and select Alerts.
Available for:

l Requirements
l Tests in the Test Planmodule
l Test instances in the Execution Grid
l Defects

Important
information

You can only clear alerts that are assigned to you, or that are not assigned to any
user. The user to which an alert is assigned is the user that is sent email notification
when the alert is triggered. For more details, see "Alerts Overview" on page 84.

Relevant
tasks

"How to Use Alerts" on page 86

See also "Alerts Overview" on page 84
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Clear all Deletes all alerts for the record.

Clear Alert. Deletes the specific alert.

<Alert details
pane>

Displays a list of alerts for the selected record.

Expand an alert to view details of the change that triggered the alert.

Click a link to highlight the item in the tree or grid.

<Selected
record>

Displays the type and name of the selected record. For example, "Alerts for
Requirement <Travel Guides>".

Flag For Follow Up Dialog Box
This dialog box enables you to create, view, andmodify follow up flags to remind yourself to follow up
on an issue.

To
access

Use one of the following:

l Right-click a record and select Flag for Follow Up.

l To view ormodify an existing flag: In a tree or grid view, click the flag icon in the
Follow Up Flag column. If this column is not visible, select View > Indicator Columns.

Available for:

l Requirements
l Tests in the Test Planmodule
l Test instances in the Execution Grid
l Defects
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See
also

"Follow Up Flags Overview" on page 85

User interface elements are described below:

UI Element Description

Follow up by The date on which ALM sends you a follow up email.

Description The reminder text in the follow up email ALM sends you.

Clear Removes the follow up flag.
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Chapter 5: Favorite Views
This chapter includes:

• Favorite Views Overview 92
• How to Use Favorite Views 92
• Favorite Views User Interface 93
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Favorite Views Overview
You determine the way an HP Application Lifecycle Management (ALM) window looks by selecting
certain settings for it. For example, these settings may include applying a filter to grid columns, or
sorting fields in a grid. You can save this view as a favorite view to be reloaded and used in the future.

You decide if others have accessibility to the favorite views by saving them to either a public folder or a
private folder. Views in a public folder are accessible to all users. Views in a private folder are
accessible only to the user who created them.

You can create subfolders to help you organize your favorite views. For example, you can create
folders for different products, releases, or teams.

Consider the following when working with favorite views:

l A favorite view is unique to themodule in which the view is created. For example, the Favorites
menu in the Defects module contains only favorite views created for the Defects module.

l A favorite view includes themodule view setting in which you create it, such as grid or tree view. For
example, if you create a favorite view in the test plan tree view, and then load that favorite from the
test grid view, ALM switches back to the test plan tree view.
In contrast, all Requirements module views except for the Requirements Grid view share favorite
views. For example, if you create a favorite view in the Requirement Details view, loading the
favorite from the Coverage Analysis view does not switch back to the Requirement Details view.

Some favorite view commands are accessible only to certain user groups. For more information on user
group privileges, refer to theHP Application Lifecycle Management Administrator Guide.

For details on working with favorite views, see "How to Use Favorite Views" below.

How to Use Favorite Views
This task describes how to work with favorite views in an ALM project.

To learnmore about favorite views, see "Favorite Views Overview" above.

To watch amovie on how to use favorite views, refer to this section in the ALMOnline Help.

This task includes the following steps:

l "Add a Favorite View" below
l "Load a Favorite View" on the next page
l "Update a Favorite View" on the next page
l "Organize Favorite Views" on the next page

Add a Favorite View
Arrange an ALM window tomeet your needs and save it as a favorite view.
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1. Determine the way an ALM window looks by selecting certain settings for it. For example, this can
include applying a filter, or sorting fields in a grid. For task details on displaying ALM data, see
"How to Display ALM Data" on page 46.

2. Select Favorites > Add to Favorites. For user interface details on the Add Favorite dialog box,
see "Add Favorite Dialog Box" on the next page.

Load a Favorite View
Load an existing view in an ALM window by selecting a recently used favorite view, or by selecting a
view from a private or public folder.

l Load a recently used favorite view. Open the Favorites menu and select a view.

Note: By default, ALM displays the four most recently used views on the Favoritesmenu. You
can define the number of views displayed on themenu by setting the FAVORITES_DEPTH
parameter in the Site Configuration tab in Site Administration. For more information, refer to the
HP Application Lifecycle Management Administrator Guide.

l Load a favorite view. Select Favorites > Private or Favorites > Public and select a view.

Update a Favorite View
You can update the settings of an existing favorite view.

1. Load a favorite view from the Favorites menu.
2. Make changes to the view.
3. Select Favorites > Add to Favorites. The Add Favorite dialog box opens.
4. In the Favorites list, select the view name and click OK.
5. Click OK to overwrite the previous settings.

Organize Favorite Views
Organize your favorite views in private or public folders, or delete views no longer in use. From the
menu bar, select Favorites > Organize Favorites. For user interface details on the Organize Favorites
dialog box, see "Organize Favorites Dialog Box" on page 95.

Favorite Views User Interface
This section includes:

• Add Favorite Dialog Box 94
• Organize Favorites Dialog Box 95
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Add Favorite Dialog Box
This dialog box enables you to add a favorite view to your private folder or to a public folder.

To access From amenu bar, select Favorites > Add to Favorites.

Available from the followingmodules: Requirements, Test Plan, Test Lab, and
Defects

Relevant
tasks

"How to Use Favorite Views" on page 92

See also "Favorite Views Overview" on page 92

User interface elements are described below:

UI
Element

Description

Name The name of the favorite view.

New Folder. Opens the New Favorite Folder dialog box, enabling you to add a folder
under a selected folder.

Delete. Deletes the selected favorite or folder. Deleting a favorite folder also deletes its
subfolders and favorite views.
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UI
Element

Description

Private Favorite views in this folder can only be accessed by you. You cannot delete thePrivate
folder.

Public Favorite views in this folder can be accessed by all users of the project. You cannot
delete thePublic folder.

Organize Favorites Dialog Box
This dialog box enables you to organize the list of favorite views in private and public folders.

To access From amenu bar, select Favorites > Organize Favorites.

Available from the followingmodules: Requirements, Test Plan, Test Lab,
and Defects

Important
information

Drag and drop favorite views tomove them between folders.

Note: You cannot drag and drop favorite views between private and
public folders.

Relevant tasks "How to Use Favorite Views" on page 92

See also "Favorite Views Overview" on page 92
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User interface elements are described below:

UI
Element

Description

New Folder. Opens the New Favorite Folder dialog box, enabling you to add a folder
under a selected folder.

Delete. Deletes the selected favorite or folder. Deleting a favorite folder also deletes its
favorite views and subfolders.

Private Favorite views in this folder can only be accessed by you. You cannot delete thePrivate
folder.

Public Favorite views in this folder can be accessed by all users of the project. You cannot
delete thePublic folder.

Rename Right-click a favorite view or folder and select Rename. You cannot rename thePrivate
folder or thePublic folder.
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Chapter 6: Pinned Items
This chapter includes:

• Pinned Items Overview 98
• Pinned Items Panel 98
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Pinned Items Overview
You can pin a requirement, test plan, or defect to enable you to jump to that item quickly, nomatter
whichmodule you are in.

Example

Assume you are a programmanager and want to monitor the implementation of a specific
requirement. By pinning it, you can quickly access it from any module in ALM, without having to
open the Requirements Module and search for it.

ALM lets you pin up to 10 items for any project.

When an item has been pinned:

l It appears in thePinned Items panel.

l ThePin/Unpin button in the toolbar appears "pressed" when the item is selected in the grid or
tree view.

Note: A pinned item is specific to the user namewith which you logged on.

For user interface details, see "Pinned Items Panel" below.

Pinned Items Panel
This panel enables you to view pinned ALM items.

To access Hover overPinned Items on the right side of the ALM window.
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Important
information

The pinned items are visible, irrespective of themodule you are in. For example, you
can see defects, even when you are in the Tests module.

See also "Pinned Items Overview" on the previous page

User interface elements are described below:

UI Element Description

Pinned Items Contains pinned items. You can jump to an item by clicking the link to it.

Enables you to pin the panel.
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Chapter 7: Version Control
This chapter includes:

• Version Control Overview 102
• How to Use Version Control 103
• How to Filter by Version Control Fields 105
• Non-versioned Fields 106
• Moving, Copying, and Deleting Checked-out Entities 106
• Version Control User Interface 107
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Version Control Overview
In a version control enabled project, you can create andmanage HP Application Lifecycle Management
(ALM) entities while maintaining previous versions of these entities. This includes requirements, tests,
test resources, business process models, and business components.

Tomake changes to an entity in a version control enabled project, youmust first check out the entity.
When you check out an entity, ALM locks the entity, preventing other users from overwriting any
changes youmake. The checked out version of the entity is not visible to other users.

When you finishmaking changes, you check in the entity. The new version of the entity is then
available to other users.

You can view all previous versions of an entity, or check out an earlier version. You can also compare
two versions of an entity to view the changes between versions.

Note: Version control applies to single entities only. Tomaintain usability and data integrity, ALM
stores previous versions of an entity without data related to relationships between entities. When
an entity is checked in, only data of the individual entity is stored. The following data is not stored
for versions: requirements and tests coverage, requirements traceability, and defect linkage. In
addition, risk data is also not stored for previous versions of an entity.

Baselines provide a snapshot of a set of entities and the relationships between them. For more
details, see "Baselines Overview" on page 178.

You can create andmanage entities in a version control enabled project. An entity checked out by the
current user is displayed with an open green lock icon . An entity checked out by another user is
displayed with a red lock icon . Grid views contain additional version control fields, such as Version
Status, indicating whether the entity is checked in or checked out.

For details on ALM fields not stored under version control, see "Non-versioned Fields" on page 106.

For more details on working with version control, see "How to Use Version Control" on the next page.

Examples
The following examples demonstrate when you can use version control.

l Monitor changes and compare versions.
Kelly, the product manager, finds that product development is being implemented differently
than she had expected. She reviews the requirements for the product and discovers that some
have changed. She compares the current requirements with the versions of the requirements
that were agreed upon at the start of the release.

l Restore an earlier version.
Michael, a QA tester, receives a new build of the banking application currently being developed.
He starts to update the relevant tests to meet the needs of the new release. Then the
development team sends out notification of a significant problem with the build. Development
rolls back to the previous build. Michael decides to check out and revert back to the versions of
tests that were used for the previous build and continue testing from there.
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l Lock entities for editing.
Robert, a business analyst, wants to update certain functionality for an application. To do this,
he needs to update a set of requirements. He requires several days to update the requirements,
and does not want anyone else tomake any changes to the requirements while he is editing
them. Robert checks out the relevant requirements, and starts to edit.

How to Use Version Control
This task describes how to work with version control in an ALM project. Version control enables you to
create andmanage ALM entities while maintaining previous versions of these entities.

To learnmore about version control, see "Version Control Overview" on the previous page.

Note: Version control functionality is available in the followingmodules: Requirements, Business
Models, Test Plan, Business Components, and Test Resources.

This task includes the following steps:

l "Prerequisites" below
l "Check out an entity" below
l "Undo a checkout - optional" below
l "Check in an entity" on the next page
l "View all checked out entities - optional" on the next page
l "Access version history" on the next page
l "Copy, move, or delete checked-out entities" on page 105

1. Prerequisites
Verify that version control is enabled for your project. For details on enabling version control, refer
to theHP Application Lifecycle Management Administrator Guide.

2. Check out an entity
Tomake changes to an entity in a version control enabled project, the entity must be checked out.
Use one of the following:
l Automatic checkout.When you start editing an entity, ALM displays the Check Out dialog
box, enabling you to check out the entity.
To instruct ALM to automatically check out entities that you start editing, without displaying the
Check Out dialog box, click Don't show this again in the Check Out dialog box.

l Manual check out. Select one or more entities. On themodule toolbar, click Check Out .
For user interface details on the Check Out dialog box, see "Check Out Dialog Box" on page 111.

3. Undo a checkout - optional
When an entity is checked out, you can undo the checkout to cancel your changes. Right-click the
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entity and select Versions > Undo Check Out. For more details on the Undo Check Out
command, see "Versions Menu and Buttons" on page 108.

4. Check in an entity
When you finishmaking changes, check in the entity to create a new, updated version available to
other users.
Use one of the following:
l Check in a single entity. Right-click the entity and select Versions > Check In.
l Check in multiple entities. Select the entities. On themodule toolbar, click theCheck In

button.
For user interface details on the Check In dialog box, see "Check In Dialog Box" on page 110.

5. View all checked out entities - optional
You can view all entities in the current module that you have checked out, and check in or undo the
checkout for selected entities.

Click theCheck In button in the top right corner of the ALM window. For user interface
details on the Pending Check In dialog box, see "Pending Check In Dialog Box" on page 112.

Example

6. Access version history
To view, compare, and check out previous versions of an entity, select the entity and click the
History tab > Versions tab. For user interface details, see "Versions Tab" on page 113.
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Example

7. Copy, move, or delete checked-out entities
Some restrictions apply whenmoving, copying, and deleting checked-out entities. For details, see
"Moving, Copying, and Deleting Checked-out Entities" on the next page.

How to Filter by Version Control Fields
This task describes how to filter ALM data to display only checked-out entities in the Requirements,
Business Models, Test Plan, Test Resources, and Test Labmodules. The following table describes
how to set the filter conditions:

Filter Description
Filter Conditions for the Test Plan
Module

Filter Conditions for All
Other Modules

Display all entities that
you have checked out

Version Status=Checked Out and
Version Owner=<your user name>

Version Checked Out
By=<your user name>

Display all entities
checked out by another
user

Version Status=Checked Out and
Version Owner=<other user's user
name>

Version Checked Out
By=<other user's user
name>

For details on defining filters, see "Filter Dialog Box" on page 51.
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Non-versioned Fields
When you are working with version control, changes made to the following fields are not stored in
previous versions of the entities:

Entity Fields

Requirements l Reviewed
l Direct Cover Status
l Target Release
l Target Cycle
l All RBQM fields.

Tests Execution Status

Consider the following when working with non-versioned fields in a version control enabled project:

Action Result

Undo a
checkout

Any changes youmade to non-versioned fields while the entity was checked out
are not cancelled and the new values remain.

Checkout a
previous
version

The value of a non-versioned field is the value in the currently checked in version.

View and
compare
previous
versions

Non-versioned fields are displayed with the valueNon-versioned Field.

When viewing and comparing previous versions, pages specific to data for which
version control data is not stored , such as the Linked Entities page or the
Requirement Traceability page, are not displayed.

Moving, Copying, and Deleting Checked-out Entities
Consider the following guidelines whenmoving, copying, or deleting entities that are checked out.

For a single entity

Description Cut/Paste or
Move

Copy/Paste Delete

Entity checked out by current
user

User Guide
Chapter 7: Version Control

HP ALM (12.50) Page 106



Description Cut/Paste or
Move

Copy/Paste Delete

Entity checked out by another
user

The current, checked-in version is
pasted.

For a folder that contains several entities

Cut/Paste
or Move

Copy/Paste Delete

All entities in folder must
be checked in.

All entities in the folder must be either checked in, or
checked out by current user.

For several entities (multi-select)

Cut/Paste or Move Copy/Paste Delete

All selected entities must be either
checked in, or checked out by current
user.

All selected
entities must be
checked in.

All selected entities must be either
checked in, or checked out by current
user.

Version Control User Interface
This section includes:

• Versions Menu and Buttons 108
• Version Control Fields 109
• Check In Dialog Box 110
• Check Out Dialog Box 111
• Pending Check In Dialog Box 112
• Versions Tab 113
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Versions Menu and Buttons
The Versions menu and version control toolbar buttons are available in a version control enabled
project.

To
access

Available from themenu bar or toolbar of the followingmodules: Requirements,
Business Models, Business Components, Test Plan, and Test Resources.

Relevant
tasks

"How to Use Version Control" on page 103

See also "Version Control Overview" on page 102

User interface elements are described below:

UI
Element

Description

Check In Opens the Check In dialog box, enabling you to check in selected entities. For details,
see "Check In Dialog Box" on page 110.

Check

Out

Opens the Check Out dialog box, enabling you to check out selected entities. For
details, see "Check Out Dialog Box" on page 111.

Pending
Check In

Opens the Pending Check In dialog box, enabling you to view a list of all entities in the
current module that you have checked out. For details, see "Pending Check In Dialog
Box" on page 112.

Undo
Check
Out

Cancels the check out of selected entities and discards changes.

To undo checkouts for entities checked out by other users, youmust have the
appropriate user permissions. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

When you undo a checkout, any changes youmade to non-versioned fields while the
entity was checked out are not canceled and the new values remain. For details, see
"Non-versioned Fields" on page 106.

Warn
Before
Check
Out

Instructs ALM to display a confirmationmessage before automatically checking out an
entity. For details, see "Check Out Dialog Box" on page 111.
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Version Control Fields
This section describes the version control fields available in the ALMmodules.

To
access

On the ALM sidebar, select Requirements, Business Models, Business
Components, Test Plan, or Test Resources.

Relevant
tasks

"How to Use Version Control" on page 103

See also "Version Control Overview" on page 102

Requirements Module
The Requirements module displays the following additional fields if version control is enabled:

UI Element (A - Z) Description

Version Check Out Date The date the version was checked out.

Version Check Out Time The time the version was checked out.

Version Checked Out By The name of the user who checked out the version.

Version Number The version number.

Version Status The status of the version (Checked Out orChecked In).

Business Models Module
The Business Models module displays the following additional fields if version control is enabled:

UI Element (A - Z) Description

Version Check Out Date The date the version was checked out.

Version Check Out Time The time the version was checked out.

Version Checked Out By The name of the user who checked out the version.

Version Number The version number.

Version Status The status of the version (Checked Out orChecked In).

Business Components Module
The Business Components module displays the following additional fields if version control is enabled:
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UI Element (A - Z) Description

Version Check Out Date The date the version was checked out.

Version Check Out Time The time the version was checked out.

Version Checked Out By The name of the user who checked out the version.

Version Number The version number.

Version Status The status of the version (Checked Out orChecked In).

Test Plan Module
The Test Planmodule displays the following additional fields if version control is enabled:

UI Element (A - Z) Description

Version Date The date of the last action (check in or check out) performed for the version.

Version Number The version number.

Version Owner The name of the user who performed the last action (check in or check out).

Version Status The status of the version (Checked Out orChecked In).

Version Time The time of the last action (check in or check out) performed for the version.

Test Resources Module
The Test Resources module displays the following additional field if version control is enabled:

UI Element Description

Version Number The version number of the resource.

Check In Dialog Box
This dialog box enables you to check in one or more checked out entities in a version control enabled
project. The new version is then available to other users.

To access Right-click an entity and select Versions > Check In.

Available from the followingmodules: Requirements, Business Models, Business
Components, Test Plan, and Test Resources.

Important
information

The version number assigned to a new entity is 1. When an entity is checked in, the
version number is increased by one.

Relevant
tasks

"How to Use Version Control" on page 103

See also "Version Control Overview" on page 102
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User interface elements are described below:

UI Element (A -
 Z)

Description

Change
comments

Describes the changes that weremade to this version.

Keep checked
out

Stores your changes with the new version number while keeping the entity
checked out.

Check Out Dialog Box
This dialog box enables you to check out one or more entities in a version control enabled project to
make changes to the entities.

To access Use one of the following:

l Select an entity and start to edit. The Check Out dialog box opens automatically.
l Right-click an entity and select Versions > Check Out.
l Select an entity and click theHistory tab > Versions tab. Select a version and
click Check Out.

Available from the followingmodules: Requirements, Business Models, Business
Components, Test Plan, and Test Resources.

Important
information

Checked out entities are indicated by the following icons:

l An entity checked out by the current user is displayed with an open green lock
icon .

l An entity checked out by another user is displayed with a red lock icon .

Relevant
tasks

"How to Use Version Control" on page 103

See also "Version Control Overview" on page 102

User interface elements are described below:

UI Element (A -
 Z)

Description

Change
comments

Describes the reason for the checkout.

Don't show this
again

Instructs ALM to automatically check out entities that you start editing, without
requesting confirmation.

This option is available when an entity is checked out automatically.
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Pending Check In Dialog Box
This dialog box enables you to view all entities in the current module that you have checked out, and
check in or undo the check out for selected entities.

To
access

Use one of the following:

l Click theCheck In button in the top right corner of the ALM window.
l From amodulemenu bar, select Versions > Pending Check In.
Available from the followingmodules: Requirements, Business Models, Business
Components, Test Plan, and Test Resources.

Relevant
tasks

"How to Use Version Control" on page 103

See also "Version Control Overview" on page 102

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A -
 Z)

Description

Opens the Check In dialog box, enabling you to check in selected entities. For
details, see "Check In Dialog Box" on page 110.

Cancels the check out of selected entities and discards changes.

When you undo a checkout, any changes youmade to non-versioned fields
while the entity was checked out are not cancelled and the new values remain.
For details, see "Non-versioned Fields" on page 106.

Details. Opens a Details dialog box, displaying details for the selected entity.
Click a button on the sidebar to view additional details, such as Design Steps,
Test Script and Attachments. The buttons available depend on the data
available for the particular entity type.

<grid> Displays a list of entities that you have checked out in the current module.

You can perform the following actions on the grid:

l To select multiple entities, press the CTRL key and select the entities.
l To select all entities, right-click and select Select All.
l To rearrange columns, drag the column headers.

Check Out Date The date the version was checked out.

Check Out Time The time the version was checked out.

ID The unique numeric ID for the entity, assigned automatically by ALM.

Name The name of the checked out entity.
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UI Element (A -
 Z)

Description

Parent The name of the entity one hierarchical level above the selected entity in the
tree structure.

Version The version number of the checked out entity.

The version number assigned to a new entity is 1. When an entity is checked
in, the version number is increased by one.

Versions Tab
This view displays version history for a selected entity in a version control enabled project.

To access Select an entity in the tree or grid, and click theHistory tab > Versions tab.

Available from the followingmodules: Requirements, Business Models, Business
Components, Test Plan, and Test Resources.

Important
information

l Tomaintain usability and data integrity, ALM stores previous versions of an entity
without most data related to relationships between entities. The following data is
not stored for previous versions: requirements and tests coverage, requirements
traceability, and defect linkage. In addition, risk data is also not stored for previous
versions of an entity.

l Changes to some fields are not stored under version control. For details, see "Non-
versioned Fields" on page 106.

Relevant
tasks

"How to Use Version Control" on page 103

See also l "Version Control Overview" on page 102
l "Baselines Tab" on page 198

User interface elements are described below:

UI
Element
(A - Z)

Description

View Opens a Details dialog box, displaying read-only details for the selected version. Click
a button on the sidebar to view additional details for the version, such as the Design
Steps, Test Script and Attachments. The buttons available depend on the data stored
under version control for the particular entity type.

Compare Opens the Compare Entities dialog box, enabling you to compare two selected
versions. For details, see "Compare Entities Dialog Box" on page 196.

To compare two versions, press the CTRL key and select the versions. Then click the
Compare button.
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UI
Element
(A - Z)

Description

Check
Out

Opens the Check Out dialog box, enabling you to check out the selected version. For
details, see "Check Out Dialog Box" on page 111.

Baseline The baseline in which the version appears.

Comment
for
selected
version

The comments typed by the user when checking in the version.

Date The date the version was created.

Modified
By

The user who created the version.

Version The version number. If the entity is currently checked out, the Version column for the
checked out version displays Checked out. If the entity is checked out by the current
user, an arrow icon indicates the version that was checked out.

The default version number for a new entity is 1.
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Chapter 8: ALM Editions
HP Application Lifecycle Management is also available in several editions which provide subsets of
ALM functionality.

HP ALM
Edition

Description

HP ALM A unified platform for managing and automating processes, activities, and assets for
building, testing, delivering, andmaintaining applications. It includes modules for
requirements, test, defect, and development management, and overall release and
project planning. HP ALM helps organizations drive consistent processes, shared
best-practices, and asset sharing across projects.

HP Quality
Center
Enterprise
Edition

Quality Center resides on the same unified platform as HP ALM. It delivers core
functionality for quality management. It supports building a quality center of
excellence through tight integrations with HP Unified Functional Testing, HP
Business Process Testing, and HP Sprinter.

HP ALM
Performance
Center
Edition

Functionality for the completemanagement, scheduling, running, andmonitoring of
performance test scripts. It resides on the same platform as HP ALM and integrates
directly with HP ALM andHP LoadRunner.

HP Quality
Center
Express
Edition

Provides a subset of HP ALM product functionality, and is designed to introduce
new customers to HP ALM. It provides core functionality for test management,
includingmanual and automatic tests, and defect management. This license is
limited to 20 named or concurrent users.

HP Quality
Center
Community
Edition

Provides a subset of HP ALM product functionality, and is designed to introduce
new customers to HP ALM. It provides core functionality for test management and
defect management. This license is free, and is limited to five named users.

Note: Before using HP Quality Center Community Edition, youmust assign
named licenses to your users. Only then can the users successfully log in to
ALM and see the appropriate modules. For more information on assigning
named licenses, see theHP Application Lifecycle Management Administrator
Guide.

The following table indicates the availability of ALM functionality according to edition. Further
information on each function is provided below.

Functionality
HP
ALM
Edition

HP Quality
Center

Enterprise
Edition

HP
ALMPerformance
Center Edition

HP Quality
Center
Express
Edition

HP Quality
Center
Community
Edition

"Licensing" on
page 117
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Functionality
HP
ALM
Edition

HP Quality
Center

Enterprise
Edition

HP
ALMPerformance
Center Edition

HP Quality
Center
Express
Edition

HP Quality
Center
Community
Edition

"Release
Management" on the
next page

"Project Planning
and Tracking (PPT)
Releases" on
page 118

"Multiple
Requirement Types"
on page 118

"Requirement to
Requirement
Traceability" on
page 118

"Risk-Based Quality
Management" on
page 118

"Business Models
Module" on page 118

"Test Authoring and
Execution" on
page 118

(partial) (partial)

"Test Resources" on
page 118

"Test
Configurations" on
page 119

"HP Sprinter" on
page 119

"Lab Management"
on page 119

"Automatic
Provisioning of
Cloud Test Hosts" on
page 119
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Functionality
HP
ALM
Edition

HP Quality
Center

Enterprise
Edition

HP
ALMPerformance
Center Edition

HP Quality
Center
Express
Edition

HP Quality
Center
Community
Edition

"Versioning" on
page 119

"Baselining" on
page 119

"Sharing
Requirements and
Tests" on page 119

"Sharing Defects" on
page 120

"Cross Project
Customization" on
page 120

"Cross Project
Reporting" on
page 120

"Export Data to
Excel" on page 120

"Business Process
Testing" on page 120

"Extensions" on
page 121 (partial) (partial) (partial)

"Upgrading Editions"
on page 121 --

Licensing
ALM licensing is determined according to your purchase agreement. The site administrator canmanage
andmonitor the license usage from Site Administration. For more details, see theHP Application
Lifecycle Management Administrator Guide.

Release Management
You organize and track your upcoming releases in the Releases module. Performance Center Edition
does not support releasemanagement. If you are working with Performance Center Edition, fields and
commands related to cycles and releases are not available. For example, Target Cycle and Target
Release are not available.

For more details on the Releases module, see "Releases and Cycles Overview" on page 126.
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Project Planning and Tracking (PPT) Releases
ALM project planning and tracking (PPT) functionality enables quality assurancemanagers to track
application readiness by defining goals for activities of an application release. PPT is available for ALM
Edition only.

For more details on PPT releases, see "PPT Releases Overview" on page 146.

Multiple Requirement Types
You can assign each requirement in the Requirements module to a default ALM requirement type. In
addition, you can customize the default types and create your own requirement types. The
Requirements module is not available in Quality Center Community Edition or Quality Center Express
Edition.

For more details on requirement types, see "Requirements Module Fields" on page 237.

Requirement to Requirement Traceability
Requirements traceability defines a relationship between two or more requirements, assisting you
when analyzing the impact of a change proposed in a specific requirement. The Requirements module
is not available in Quality Center Community Edition or Quality Center Express Edition.

For more details on requirements traceability, see "Requirements Traceability" on page 251.

Risk-Based Quality Management
The risk-based quality management feature enables you to calculate at which level to test each
requirement, based on the nature of the requirement and the resources you have available. The
Requirements module is not available in Quality Center Community Edition or Quality Center Express
Edition.

For more details on risk-based quality management, see "Risk-BasedQuality Management" on
page 269.

Business Models Module
The Business Models module enables you to import business process models from standardmodeling
tools, and test their quality in ALM. The Business Models module is available in ALM Edition and
Quality Center Enterprise Edition only.

For more details on the Business Models module, see "Business Process Models" on page 283.

Test Authoring and Execution
You can build test plans and design tests based on your project requirements, and then execute those
tests to diagnose and resolve problems. ALM Performance Center Edition supports performance
testing only. Quality Center Community Edition supports manual testing only.

For more details, see "Test Plan Overview" on page 344 and "Test Execution Overview" on page 488.

Test Resources
The Test Resources module enables you tomanage resources used by your tests.
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Formore details, see "Test Resources" on page 447.

Test Configurations
Test configurations enable testing of various use-cases, each time with a different set of data.

For more details, see "Test Configuration Overview" on page 418.

HP Sprinter
HP Sprinter provides enhancedmanual testing functionality and a variety of tools to assist in the
manual testing process. Sprinter is available for ALM Edition, Quality Center Enterprise Edition, and
Quality Center Express Edition.

For more details on Sprinter, see "HP Sprinter Overview" on page 575.

Lab Management
LabManagement allows users tomanage the lab resources and systems they use for functional and
performance testing in ALM. LabManagement is available for functional and performance testing with
ALM Edition and for performance testing with Performance Center Edition.

For more details, refer to theHP ALM LabManagement Guide.

Automatic Provisioning of Cloud Test Hosts
Cloud provisioning is currently available only for provisioning of load generators.

For more details, refer to theHP ALM LabManagement Guide.

Versioning
Version control enables you to create andmanage ALM entities while maintaining previous versions of
those entities. Quality Center Community Edition andQuality Center Express Edition do not support
single entity versioning of your ALM projects.

For more details on versioning, see "Version Control" on page 101.

Baselining
You can create a baseline to store a snapshot of multiple entities in your project, at a specific point in
time. ALM Essentials Edition, Quality Center Community Edition, andQuality Center Express Edition
do not support baselining.

For more details, see "Libraries and Baselines" on page 177.

Sharing Requirements and Tests
The Libraries module enables you to create and compare baselines of requirements, tests, test
resources, and business components. You can also reuse an existing set of entities by importing,
synchronizing and comparing libraries across multiple projects.

Quality Center Enterprise Edition: You can use the Libraries module to create and compare baselines in
a project. Quality Center Enterprise Edition does not include importing, synchronizing and comparing
libraries across multiple projects. ALM Essentials Edition, Quality Center Community Edition, and
Quality Center Express Edition do not support sharing requirements and tests.

User Guide
Chapter 8: ALM Editions

HP ALM (12.50) Page 119



Formore details on the Libraries module, see "Libraries ModuleWindow" on page 185.

Sharing Defects
You can share and synchronize defects across multiple ALM projects using theHP ALM Synchronizer.
Defect sharing is available for ALM Edition only.

For more details, see theHP ALM Synchronizer User Guide, available from the HP Application
Lifecycle Management Adds-ins page.

Cross Project Customization
Cross project customization enables you to work with template projects to standardize policies and
procedures across projects in your organization. Cross project customization is not available for
Quality Center Enterprise Edition, Quality Center Community Edition, or Quality Center Express
Edition.

For more details, see theHP Application Lifecycle Management Administrator Guide.

Cross Project Reporting
When you create graphs in ALM, you can combine and compare data frommultiple projects. Cross
project reporting is unavailable for some entities. Cross project reporting is not available for Quality
Center Enterprise Edition, Quality Center Community Edition, or Quality Center Express Edition.

For more details on the ALM reports and graphs, see "Analysis View Window" on page 720.

Export Data to Excel
All editions enable exporting ALM data to Excel for reporting. Exporting functionality is unavailable for
some entities.

For more details, see "Excel Reports" on page 793.

Business Process Testing
Business Process Testing enables non-technical subject matter experts to build and work with
business components in a script-free environment and to create application-quality business process
tests. Business Process Testing is not available for ALM Essentials Edition, Performance Center
Edition, Quality Center Community Edition, or Quality Center Express Edition.

Each user with the proper permissions who logs into an ALM server with a Business Process Testing
license uses up both a Business Process Testing license and an ALM license.

Note: You can run test sets containing business process tests in the Test Labmodule and you can
also edit automated components in Unified Functional Testing, even if no Business Process
Testing license is available in ALM.

Available in ALM 12.21: The BPT Packaged Apps Kit is also fully integrated with ALM. It is enabled
only if your ALM is licensed for Business Process Testing and BPT Packaged Apps Kit is enabled. Like
Business Process Testing, BPT Packaged Apps Kit is not available for the ALM Essentials Edition,
Performance Center Edition, Quality Center Community Edition, or Quality Center Express Edition.
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Formore information on Business Process Testing, refer to theHP Business Process Testing User
Guide.

Extensions
ALM extensions provide added functionality to ALM. Various extensions are available, depending on
the edition with which you are working. If you have a license for an ALM extension, you can utilize the
added functionality by enabling the extension on a per project basis. For more details on enabling
extensions, refer to theHP Application Lifecycle Management Administrator Guide. Extensions are not
available in Quality Center Community Edition.

To view the list of extensions available with ALM or to download documentation for the extensions,
access the HP ALM Add-ins Page. You can access the Add-ins page in ALM from Help > Add-ins.

Upgrading Editions
You can upgrade your current edition to another edition. For example, you can upgrade from HP ALM
Essentials Edition12.50 to HP ALM Edition12.50.

For more information on upgrading, refer to theHP Application Lifecycle Management Installation and
UpgradeGuide.
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Part 2: Management

ALM Editions:

l Functionality related to PPT is available for ALM Edition only.
l Quality Center Enterprise Edition does not include all Libraries module functionality.
For more information about ALM editions and their functionality, see "ALM Editions" on page 115.
To find out what edition of ALM you are using, ask your ALM Site Administrator.
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Chapter 9: Releases and Cycles
This chapter includes:

• Releases and Cycles Overview 126
• How to Use Releases and Cycles in ALM 126
• Releases and Cycles User Interface 128
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Releases and Cycles Overview
The issue of application releases is often challenging. It requires aligning your business priorities and
quality expectations with your project requirements, tests, and defects. Most applications require
testing onmultiple hardware platforms, multiple configurations (computers, operating systems, and
browsers), andmultiple application versions. Managing all aspects of an application release can be
time-consuming and difficult. You begin the applicationmanagement process by defining releases.

HP Application Lifecycle Management (ALM) enables you to organize and track your upcoming
releases by defining releases and cycles. A release represents a group of changes in one or more
applications that will be available for distribution at the same time. Each release can contain a number
of cycles. A cycle is a set of development and quality assurance efforts performed to achieve a
common goal based on the release timeline. Both releases and cycles have defined start and end
dates.

After defining releases and cycles, you define and review requirements and assign them to releases
and cycles. Requirements describe in detail your application needs, and are used as a basis for
creating a test plan. The tests you create during the test plan phase should cover these requirements.

After assigning requirements to releases and cycles, you create test set folders and assign them to
cycles. A test set is a group of test instances in an ALM project designed to achieve specific test
goals. After assigning test set folders to a cycle, you run the test sets under these test set folders.

If an application flaw is detected while running a test set, you can submit a defect. ALM automatically
creates a link between the test run, associated release and cycle, and the new defect.

A defect can be submitted to an ALM project from any module at any stage of the application
management process. While reviewing and deciding which new defects need to be fixed, the defects
can be assigned to the appropriate release and cycle.

Following test runs, you can review the test progress to determine how well it meets the release goals.
You can also determine how many defects were resolved, and how many still remain open. The results
can be analyzed at a release or cycle level.

You can track the progress of the applicationmanagement process in real time by analyzing the
Releases tree and ensuring that it matches the release goals.

For related task details, see "How to Use Releases and Cycles in ALM" below.

How to Use Releases and Cycles in ALM
This task describes how to create and track releases and cycles. To learnmore about releases and
cycles, see "Releases and Cycles Overview" above.

You can also use Project Planning and Tracking (PPT) to track your application releases. PPT helps
youmakemore informed release decisions using real-time key performance indicators (KPIs). For task
details on working with PPT, see "How toWork with PPT" on page 146.
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Note:

Higher-level task: This task is part of a higher-level task. For details, see "ALM Basic Flow" on
page 22.

This task includes the following steps:

l "Define releases and cycles" below
l "Assign requirements" below
l "Assign and run test sets" below
l "Assign defects" below
l "Analyze releases and cycles" below

1. Define releases and cycles
Define releases and cycles in a hierarchical releases tree.
a. Open the Releases module. On the ALM sidebar, underManagement, select Releases.
b. Create folders. Right-click theReleases root folder and select New Release Folder. To

create a sub-folder, right-click a folder and select New Release Folder.
c. Add releases to folders. Right-click a folder or sub-folder and select New Release. Fill in

fields in the New Release dialog box. For user interface details, see "New Release/Release
Details Dialog Box" on page 135.

d. Add cycles to a release. Right-click a release and select New Cycle. Fill in fields in the New
Cycle dialog box. For user interface details, see "New Cycle/Cycle Details Dialog Box" on
page 136.

2. Assign requirements
In the Requirements module, assign requirements to releases and cycles.
l Assign to release. Right-click a requirement and select Assign to Release. For user
interface details on the Select Releases dialog box, see "Select Releases Dialog Box" on
page 142.

l Assign to cycle. Right-click a requirement and select Assign to Cycle. For user interface
details on the Select Cycles dialog box, see "Select Cycles Dialog Box" on page 141.

3. Assign and run test sets
In the Test Labmodule, assign test sets folders to cycles, and then run the test sets.
a. Assign to cycles. Right-click a test set folder and select Assign to Cycle. For user interface

details on the Select Cycles dialog box, see "Select Cycles Dialog Box" on page 141.
b. Run tests. For task details on running tests, see "How to Run Tests in ALM" on page 490.

4. Assign defects
Assign defects to a target release and a target cycle. For task details, see "How to Track Defects
in ALM" on page 693.

5. Analyze releases and cycles
View statistics and graphs to track the progress of your releases and cycles.
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l View assigned requirements and test set folders.
To view statistics on the requirements and test set folders assigned to your releases and
cycles, in the Releases module, select a release or cycle and click theDetails tab. In the
Statistics area, view statistics on assigned requirements and test set folders. For user
interface details on the Releases module window, see "Releases ModuleWindow" on the next
page.

l View coverage progress.
View statistics and graphs which provide visual indications of the current progress of your
release or cycle.
o For a release:Select a release in the releases tree, click theStatus tab, and then click the

Progress tab.
o For a cycle:Expand a release in the releases tree, select a cycle, and click theProgress

tab.
For user interface details, see "Progress Tab" on page 138.

l View defects.
View graphs in the Releases module displaying the number of defects submitted over the
course of a release or cycle.
o For a release:Select a release in the releases tree, click theStatus tab, and then click the

Quality tab.
o For a cycle:Expand a release in the releases tree, select a cycle, and click theQuality

tab.
For user interface details, see "Quality Tab" on page 139.

Releases and Cycles User Interface
This section includes:

• Releases ModuleWindow 129
• Releases ModuleMenus and Buttons 130
• Releases Module Icons 133
• Releases Module Fields 134
• New Release/Release Details Dialog Box 135
• New Cycle/Cycle Details Dialog Box 136
• Progress Tab 138
• Quality Tab 139
• Configure Outstanding Defects Dialog Box 140
• Select Cycles Dialog Box 141
• Select Releases Dialog Box 142
• Reschedule Release/Cycle/Milestone Dialog Box 143
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Releases ModuleWindow
This window enables you to define and track releases and cycles.

To access On the ALM sidebar, under Management, select Releases.

Relevant tasks "How to Use Releases and Cycles in ALM" on page 126

See also "Releases and Cycles Overview" on page 126

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Releases
module
common UI
elements>

l Release fields. For field definitions, see "Releases Module Fields" on
page 134.

l Release menus and buttons. For command and button descriptions, see
"Releases ModuleMenus and Buttons" on the next page.

l Release icons. For icon descriptions, see "Releases Module Icons" on
page 133.

l ALM masthead, menus, and sidebar. For details, see "ALM Common Areas"
on page 32.

<Releases
tree>

A graphical representation of your releases.

Details tab Displays details of the currently selected folder, release, or cycle. TheStatistics
area displays the requirements and test set folders associated with the release or
cycle. For more details, see "Releases Module Fields" on page 134.

Release
Scope tab

Shows the release scope items of the currently selected release. For more details,
see "Release Scope Tab" on page 151.

ALM Editions: This tab is available for ALM Edition only. For more information
about ALM editions and their functionality, see "ALM Editions" on page 115. To
find out what edition of ALM you are using, ask your ALM site administrator.

Master Plan
tab

Shows the progress of a release in a Gantt chart. For more details, see "Master
Plan Tab" on page 165.

ALM Editions: This tab is available for ALM Edition only. For more information
about ALM editions and their functionality, see "ALM Editions" on page 115. To
find out what edition of ALM you are using, ask your ALM site administrator.
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UI Element Description

Scorecard tab Shows a KPI scorecard of the status of the currently selected release. For more
details, see "Scorecard Tab" on page 167.

ALM Editions: This tab is available for ALM Edition only. For more information
about ALM editions and their functionality, see "ALM Editions" on page 115. To
find out what edition of ALM you are using, ask your ALM site administrator.

Status tab Includes the following tabs:

l Progress tab. Shows a high-level overview of the progress of the currently
selected release or cycle. For more details, see "Progress Tab" on page 138.

l Quality tab. Shows the number of defects opened over the course of the
currently selected release or cycle. It also shows the number of outstanding
defects. For more details, see "Quality Tab" on page 139.

Attachments
tab

Lists attachments that provide additional information about the currently selected
folder, release, or cycle. For more details, see "Attachments Page" on page 72.

Description
tab

Describes the currently selected folder, release, or cycle.

Click in the text box to display a toolbar for formatting and spell checking the text.

Releases Module Menus and Buttons
This section describes themenus and buttons available in the Releases module.

To access On the ALM sidebar, under Management, select Releases.

Important
information

Tip: You can access themenu bar from the Releases module by pressing
the shortcut key ALT.

Relevant tasks "How to Use Releases and Cycles in ALM" on page 126

See also l "Releases Module Icons" on page 133
l "Releases ModuleWindow" on the previous page
l "Releases and Cycles Overview" on page 126

User interface elements are described below:

UI Element Menu Description

New Release

Folder

Releases Opens the New Release Folder dialog box, enabling you to add a folder
under a selected folder.
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UI Element Menu Description

New Release/
New Empty

Release

Releases Opens the New Release dialog box, enabling you to add a release to a
selected release folder. For more details, see "New Release/Release
Details Dialog Box" on page 135.

Note:Whenworking with a project that is linked to a template
project, theNew Empty Release option is available instead of the
New Release option.

ALM Editions: New Empty Release is available for ALM Edition
only. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what
edition of ALM you are using, ask your ALM site administrator.

New
Milestone

Releases Opens the New Milestone dialog box, enabling you to add amilestone
to a selected release. For more details, see "New Milestone Dialog
Box" on page 155.

ALM Editions: This feature is available for ALM Edition only. For
more information about ALM editions and their functionality, see
"ALM Editions" on page 115. To find out what edition of ALM you
are using, ask your ALM site administrator.

New Cycle Releases Opens the New Cycle dialog box, enabling you to add a cycle to a
selected release. For more details, see "New Cycle/Cycle Details
Dialog Box" on page 136.

Details
Releases Opens the corresponding Details dialog box, enabling you to view and

update details of the selected release, cycle, or milestone.

For more details, see:

l "New Release/Release Details Dialog Box" on page 135
l "New Cycle/Cycle Details Dialog Box" on page 136
l "Milestone Details Dialog Box" on page 166

ALM Editions:Milestones are available for ALM Edition only. For
more information about ALM editions and their functionality, see
"ALM Editions" on page 115. To find out what edition of ALM you
are using, ask your ALM site administrator.
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UI Element Menu Description

Reschedule Releases Opens the Reschedule dialog box, enabling you to reschedule the start
and end date of a release, cycle, or milestone. For more details, see
"Reschedule Release/Cycle/Milestone Dialog Box" on page 143.

ALM Editions: The capability to reschedulemilestones is available
for ALM Edition only. For more information about ALM editions and
their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site
administrator.

Cut/Paste Edit Moves a selected release folder or release to a different location in the
releases tree.

Note: Moving a release folder alsomoves its releases and cycles.
Moving a release alsomoves its cycles. The root folder cannot be
moved.

Tip: You can alsomove a release folder or a release to a new
location in the releases tree by dragging it.

Duplicate

Cycle

Edit Creates a copy of the selected cycle within the same release.

To duplicate more than one cycle, press the CTRL key and select the
cycles you want to duplicate. You can select only cycles that belong to
the same release.

Duplicate
Milestone

Edit Creates a copy of the selectedmilestone within the same release.

To duplicate more than onemilestone, press the CTRL key and select
themilestones you want to duplicate. You can select only milestones
that belong to the same release.

ALM Editions: This feature is available for ALM Edition only. For
more information about ALM editions and their functionality, see
"ALM Editions" on page 115. To find out what edition of ALM you
are using, ask your ALM site administrator.

Delete
Edit Deletes selected release folders, releases, or cycles. Deleting a folder

also deletes its releases and cycles. Deleting a release also deletes its
cycles.

Note: Deleting a release folder, release, or cycle also un-assigns
the associated requirements, test set folders, and defects.

Rename Edit Renames a selected release folder, release, or cycle. You cannot
rename the root folder.

User Guide
Chapter 9: Releases and Cycles

HP ALM (12.50) Page 132



UI Element Menu Description

Expand All View Expands all branches in the releases tree.

Collapse View Collapses all branches in the releases tree.

Refresh All View Refreshes the releases tree so that it displays themost up-to-date
information.

New Release
From
Template

Releases Opens the New Release from Template dialog box, enabling you
create a release based on a release from a template project. For more
details, see "New Release From Template Dialog Box" on page 174.

ALM Editions: This option is available for ALM Edition only. For
more information about ALM editions and their functionality, see
"ALM Editions" on page 115. To find out what edition of ALM you
are using, ask your ALM site administrator.

Note: This option is available in a project that is linked and
synchronized with a template project.

Show
Requirements

<right-
click
menu>

Goes to the Requirements module and displays the requirements
assigned to the selected release or cycle.

Show Test
Set Folders

<right-
click
menu>

Goes to the Test Labmodule and displays the test set folders assigned
to the selected cycle.

Releases Module Icons
This section describes the icons available in the Releases module.

To access On the ALM sidebar, under Management, select Releases.

Relevant tasks "How to Use Releases and Cycles in ALM" on page 126

See also l "Releases ModuleMenus and Buttons" on page 130
l "Releases ModuleWindow" on page 129
l "Releases and Cycles Overview" on page 126

User interface elements are described below:

UI
Element

Description

<green asterisk>. The tab is populated.
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UI
Element

Description

Milestone. A milestone of a release in the releases tree.

ALM Editions: This icon is available for ALM Edition only. For more information about
ALM editions and their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site administrator.

Release Folder. A folder for organizing releases.

Release. A release in the releases tree.

Cycle. A cycle of a release in the releases tree.

Releases Module Fields
The Releases module Details tab displays the following fields for a release or a cycle.

To access On the ALM sidebar, under Management, select Releases.

Important
information

l The dates for the cycles must be contained within the dates for the releases.
l You can add user-defined fields and change the label of any of the fields in the
Releases module. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

l You can use the Script Editor to restrict and dynamically change the fields and
values in the Releases module. For more information, refer to theHP Application
Lifecycle Management Administrator Guide.

l For project planning and tracking (PPT) fields, see "PPT Fields" on page 150.

Relevant
tasks

"How to Use Releases and Cycles in ALM" on page 126

See also l "Releases ModuleWindow" on page 129
l "Releases and Cycles Overview" on page 126

The fields are described below:

UI Element Description

Cycle ID A unique numeric ID for the cycle, assigned automatically by ALM. The
Cycle ID is read-only.

Release ID A unique numeric ID for the release, assigned automatically by ALM. The
Release ID is read-only.

Name The folder, release, or cycle name.
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UI Element Description

Start Date The date on which the release or cycle starts.

End Date The date on which the release or cycle ends.

Release Start Date The date on which the release starts.

Release End Date The date on which the release ends.

Requirements
assigned to cycle

The number of requirements associated with the selected cycle.

To view the requirements assigned to the cycle in the Requirements module,
click the link displaying the number of requirements.

Requirements
assigned to release

The number of requirements associated with the selected release.

To view the requirements assigned to the release in the Requirements
module, click the link displaying the number of requirements.

Test set folders
assigned to cycle

The number of test set folders associated with the selected cycle.

To view the test set folders assigned to the cycle in the Test Labmodule,
click the link displaying the number of test set folders.

New Release/Release Details Dialog Box
The New Release dialog box enables you to define a new release.

The Release Details dialog box enables you to view and update the details of the selected release.

To access l New Release dialog box: In the Releases module, right-click a release folder and
select New Release.
From a template based project: In the Releases module, right-click a release
folder and select New Empty Release.

l Release Details dialog box: In the Releases module, right-click a release and
select Details.

Important
information ALM Editions: The New Release dialog box is available for ALM Edition only. For

more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Note: TheNew Empty Release option is available in a project that is linked and
synchronized with a template project. For more details on linking and
synchronizing template projects, refer to theHP Application Lifecycle
Management Administrator Guide.

Relevant
tasks

"How to Use Releases and Cycles in ALM" on page 126
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See also "Releases and Cycles Overview" on page 126

User interface elements are described below:

UI Element Description

Clear All Fields. Clears the data.

Available from:New Release dialog box

Save. Saves the details.

Check Spelling. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Name Type a name for the new release.

Details Lists release fields. Required fields are displayed in red. For details on the available
release fields, see "Releases Module Fields" on page 134.

Tip: Clicking in theDescription field on this page displays a toolbar for
formatting and spell checking the text.

Release
Scope

Shows the release scope items of the currently selected release. For more details,
see "Release Scope Tab" on page 151.

ALM Editions: This tab is available for ALM Edition only. For more information
about ALM editions and their functionality, see "ALM Editions" on page 115. To
find out what edition of ALM you are using, ask your ALM site administrator.

Available from:Release Details dialog box

Attachments Enables you to add attachments that provide additional information about the new
release. For more details, see "Attachments Page" on page 72.

New Cycle/Cycle Details Dialog Box
The New Cycle dialog box enables you to define a new cycle.

The Cycle Details dialog box enables you to view and update the details of the selected cycle.
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To access New Cycle dialog box: In the Releases module, right-click a release and select
New Cycle.

Cycle Details dialog box: In the Releases module, expand a release, right-click a
cycle and select Details.

Important
information ALM Editions: Functionality related to PPT is available for ALM Edition only. For

more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

l "How to Use Releases and Cycles in ALM" on page 126
l "How toWork with PPT" on page 146

See also l "Releases and Cycles Overview" on page 126
l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129

User interface elements are described below:

UI Element Description

Clear All Fields. Clears the data.

Available from: New Cycle dialog box

Save. Saves the details.

Check Spelling. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Name The name of the cycle.

Details Lists cycle fields. Required fields are displayed in red. For details on the available
cycle fields, see "Releases Module Fields" on page 134.

Tip: Clicking in theDescription field on this page displays a toolbar for
formatting and spell checking the text.

Attachments Enables you to add attachments that provide additional information about the cycle.
For more details, see "Attachments Page" on page 72.
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Progress Tab
This tab displays statistics and graphs to provide visual indications of the current progress of your
release or cycle. You can view information such as elapsed and remaining days, completed and
remaining test instances to run, and actual and required execution rate.

To access In the Releases module:

l For a release: Select a release in the releases tree, click theStatus tab, and
then click theProgress tab.

l For a cycle: Expand a release, select a cycle and click theProgress tab.

Important
information Click theRefresh All button in the Releases module toolbar to display the

most up-to-date data.

Relevant tasks "How to Use Releases and Cycles in ALM" on page 126

See also l "Releases and Cycles Overview" on page 126
l "Releases ModuleWindow" on page 129

User interface elements are described below:

UI Element Description

Total days in
release/cycle

The total number of days in a selected release or cycle (end date - start
date).

Remaining days in
release/cycle

The total number of days remaining in a selected release or cycle.

Total test instances
for release/cycle

The total number of test instances included in the test set folders assigned
to a selected release or cycle.

Remaining test
instances to run

The total number of test instances included in the assigned test set folders
of a selected release or cycle that have not yet run.

Required execution
rate (test
instances/day)

The average number of test runs required per day for the remaining days in a
selected release or cycle.

Days (progress bar) The percentage of days elapsed in a selected release or cycle.

Test Instance Runs
(progress bar)

The percentage of test runs completed in a selected release or cycle.

Note: A test instance is counted as executed if it was run and results of
the run were saved, even if it is currently in aNot Completed or
Blocked state.
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UI Element Description

Coverage Progress
graph

Displays coverage progress for a selected release or cycle.

Display options include:

l Assigned requirements. The accumulated percentage of requirements
assigned to all cycles within the selected release. This option available
for releases only.

l Planned coverage. The accumulated percentage of tests planned for a
selected cycle, or for all cycles within a selected release.

l Executed coverage. The accumulated percentage of tests executed for
a selected cycle, or for all cycles within a selected release.

l Passed coverage. The accumulated percentage of tests that ran
successfully in a selected cycle, or for all cycles within a selected
release.

Note: To see the coverage progress relationships, youmust define
links between requirements and tests, and assign requirements and
test sets to a cycle.

Quality Tab
This tab displays the number of defects submitted over the course of a release or cycle in graphical
format. You can view the graphs at any stage of the applicationmanagement process to check the
progress of your release.

To access In the Releases module:

l For a release: Select a release in the releases tree, click theStatus tab, and
then click theQuality tab.

l For a cycle: Expand a release, select a cycle and click theQuality tab.

Important
information Click theRefresh All button in the Releases module toolbar to display the

most up-to-date data.

Relevant tasks "How to Use Releases and Cycles in ALM" on page 126

See also "Releases and Cycles Overview" on page 126

"Releases ModuleWindow" on page 129
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Defect
Opening
Rate graph

Displays the number of defects opened over the course of the selected release or
cycle.

The graph displays defects whoseDetected in Release orDetected in Cycle value
matches the selected release or cycle. The defects are grouped according to their
level of Severity. The x-axis displays the number of defects according to their
severity on the last day of each cycle.

<Defect
severity
level
display
options>

Determine which defects are displayed in the graph based on defect severity level.
The severity levels ranges from Low-1 toUrgent-5.

Outstanding
Defects
graph

Displays the number of outstanding defects for the selected release or cycle.

The graph displays defects whose Target Release or Target Cycle valuematches
the selected release or cycle, or is empty. The defects are grouped according to their
level of Severity. The x-axis displays the number of outstanding defects according to
their severity on the last day of each cycle. By default, New, Open, andReopened
defects are considered outstanding.

Configure
Outstanding
Defects

Opens the Configure Outstanding Defects dialog box, enabling you to determine
which defects are displayed in the graph by filtering them by their status.

For user interface details, see "Configure Outstanding Defects Dialog Box" below.

Configure Outstanding Defects Dialog Box
The Configure Outstanding Defects dialog box enables you to determine which defects are displayed in
the Quality tab graph. This graph displays the number of defects submitted over the course of a release
or cycle. Outstanding defects are configured by filtering them by their status.

To access 1. In the Releases module, select a cycle.
2. From theQuality tab, click theConfigure Outstanding

Defects link.

Relevant tasks "How to Use Releases and Cycles in ALM" on page 126

User interface elements are described below:

UI Element Description

Available Defect
Status

Lists statuses that are not currently used for configuring outstanding defects.
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UI Element Description

Moves selected statuses betweenAvailable Defect Status andVisible
Defects Status.

Tip: You can also drag the statuses between panes or double-click a status
tomove it across to the other pane.

Moves all statuses betweenAvailable Defect Status andVisible Defects
Status.

Visible Defects
Status

Lists statuses that are currently used for configuring outstanding defects.

Only Targeted
Defects

When selected, includes in the graph only the defects that match both of the
following criteria: 

l Defects whose statuses are listed in theVisible Defects Status column
l Defects that are targeted to be fixed in this cycle

Select Cycles Dialog Box
This dialog box enables you to assign requirements and test set folders to cycles defined in the
releases tree.

To access Right-click a requirement in the Requirements module, or a test set folder in the Test
Labmodule, and select Assign to Cycle.

Important
information

l When you assign a requirement to a cycle, the value is entered in the
requirement's Target Cycle field. In addition, the cycle's release is entered in the
Target Release field.

l When you assign a test set folder to a cycle, the test set's subfolders are
automatically assigned to the same cycle.

Relevant
tasks

l "How to Use Requirements in ALM" on page 220
l "How to Create Test Sets" on page 524
l "How to Use Releases and Cycles in ALM" on page 126

See also "Releases and Cycles Overview" on page 126

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Show Cycle Details. Opens the Details dialog box for the selected cycle in read-only
mode.

Refresh. Refreshes the releases tree so that it displays themost up-to-date
information.
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UI Element Description

Filter/Sort. Enables you to filter the data according to the criteria that you choose. For
more details, see "Filter Dialog Box" on page 51.

<Find
box>

Enter the name of the cycle you want to search for and click the Find button.

Find. Searches the releases tree for the value you specify in the Find box.

Go to Entity by ID. Opens theGo to Cycle dialog box, enabling you to locate the
cycle in the tree according to Cycle ID.

<Releases
tree>

Displays the releases tree in the Releases module.

Expand the tree and select a cycle. You can assign requirements tomore than one
cycle.

Clears the assigned cycle from the requirement.

Available from:Requirements module

Select Releases Dialog Box
This dialog box enables you to assign requirements to releases defined in the releases tree.

To access In the Requirements module, right-click a requirement and select Assign to
Release.

Important
information

When you assign a requirement to a release, the value is entered in the
requirement's Target Release field.

Relevant tasks "How to Use Releases and Cycles in ALM" on page 126

See also "Releases and Cycles Overview" on page 126

User interface elements are described below:

UI Element Description

Show Release Details. Opens the Details dialog box for the selected release in read-
only mode.

Refresh. Refreshes the releases tree so that it displays themost up-to-date
information.

Filter/Sort. Enables you to filter the data according to the criteria that you choose. For
more details, see "Filter Dialog Box" on page 51.

<Find
box>

Enter the name of the release you want to search for and click the Find button.
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UI Element Description

Find. Searches the releases tree for the value you specify in the Find box.

Go to Entity by ID. Opens theGo to Release dialog box, enabling you to locate the
release in the tree according to Release ID.

<Releases
tree>

Displays the releases tree in the Releases module.

Expand the tree and select one or more releases.

Clears the assigned release from the requirement.

Reschedule Release/Cycle/Milestone Dialog Box
This dialog box enables you to reschedule the start and end date of a release, cycle, or milestone.

To access In the Releases module, right-click a release, cycle, or milestone. Select
Reschedule.

Important
information

l When rescheduling a release, the related cycles, milestones, and KPI
thresholds are rescheduled accordingly.

l When rescheduling amilestone, the related KPI thresholds are rescheduled
accordingly.

Relevant tasks l "How to Use Releases and Cycles in ALM" on page 126
l "How toWork with PPT" on page 146

See also l "Releases and Cycles Overview" on page 126
l "PPT Releases Overview" on page 146

User interface elements are described below:

UI Element Description

Start Date The date on which the release, cycle, or milestone starts.

End Date The date on which the release or cycle ends.

Available from:Reschedule Release/Cycle dialog box

Due Date The date on which themilestone ends.

Available from:RescheduleMilestone dialog box
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Chapter 10: Project Planning and Tracking
(PPT) Releases
This chapter includes:

• PPT Releases Overview 146
• How toWork with PPT 146
• KPI Types 148
• Defect Content Included in PPT Release Scope Items 149
• PPT User Interface 149
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PPT Releases Overview
Project planning and tracking (PPT) enables quality assurancemanagers to track application readiness
by defining goals for activities of an application release.

For each release, you define release scope items. A release scope item refers to a subdivided section
of a release, such as a new feature, a change to an existing feature, or a new theme. For each scope
item you define the related requirements, tests, test sets, and defects. Tomeasure the progress of the
release scope items, you associate them with milestones. A milestone is a point in the timeline of a
release that signifies the completion of a deliverable. It enables you to track and validate the progress
of the release. A milestone can be associated with one or more release scope items.

PPT collects and analyzes the data from the definedmilestones using key performance indicators
(KPIs). A KPI is a quantifiable measure designed to track a critical performance variable over time, and
measure the essential outcome of quality assurance activities. For each KPI, you define threshold
levels to set warning limits.

PPT uses the KPIs to analyze amilestone's readiness data, and to show the overall health and
deployment readiness of a release in the form of a scorecard. The scorecardmonitors and tracks how
well eachmilestone is beingmet on a daily basis. To further analyze your output, you can generate
dashboard reports and graphs.

ALM Editions: Functionality related to PPT is available for ALM Edition only. For more information
about ALM editions and their functionality, see "ALM Editions" on page 115. To find out what
edition of ALM you are using, ask your ALM site administrator.

For task details, see "How toWork with PPT" below.

How to Workwith PPT
This task describes how to define releases, release scopes andmilestones, and how to track release
scope status in the Releases module. To learnmore about PPT, see "PPT Releases Overview" above.

l ALM Editions: Functionality related to PPT is available for ALM Edition only. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find
out what edition of ALM you are using, ask your ALM site administrator.

l Product Feature Movie: To view amovie that demonstrates PPT, chooseHelp > Movies in
the ALMmain window.

This task includes the following steps:

l "Define releases" on the next page
l "Define release scope items" on the next page
l "Definemilestones" on the next page
l "Analyze progress" on the next page
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1. Define releases
a. Open the Releases module. On the ALM sidebar, underManagement, select Releases.

For user interface details on the Releases module, see "Releases ModuleWindow" on
page 129.

b. Create folders. Right-click theReleases root folder and select New Release Folder. To
create a sub-folder, right-click a folder and select New Release Folder.

c. Add releases. Right-click a release folder and select New Release. For user interface
details, see "New Release/Release Details Dialog Box" on page 135.
Alternatively, if you are working with a project that is linked to a template project, you can
create a release by copying from the template project. Right-click a release folder and select
New Release from Template. For user interface details, see "New Release From Template
Dialog Box" on page 174.

2. Define release scope items
In the releases tree, select a release. Click theRelease Scope tab. Add release scope items and
define the related requirements, tests, test sets, and defects. For user interface details, see
"Release Scope Tab" on page 151.

3. Define milestones
a. Add milestones. In the releases tree, right-click a release and select New Milestone. The

New Milestone dialog box opens. Define timelines for your milestone. For user interface
details, see "New Milestone Dialog Box" on page 155.

b. Associate release scope items. In the releases tree, select amilestone. Click the
Milestone Scope tab. Associate themilestone with release scope items. For user interface
details, see "Milestone Scope Tab" on page 156.

c. Associate KPIs. Click theKPIs tab. Configure related KPIs and set boundaries for
performance against those KPIs. For user interface details, see "KPI Types" on the next
page.

4. Analyze progress
l View scorecard. In the releases tree, select a release. Click theScorecard tab. View the
status and progress of your definedmilestones. For user interface details on the Scorecard tab,
see "Scorecard Tab" on page 167.

l View Gantt chart. In the releases tree, select a release. Click theMaster Plan tab. For user
interface details, see "Master Plan Tab" on page 165.

l Create PPT graphs. For task details on how to generate graphs, see "How to Generate a PPT
Graph" on page 768.

User Guide
Chapter 10: Project Planning and Tracking (PPT) Releases

HP ALM (12.50) Page 147



KPI Types
This section describes the system defined KPI types.

Important
information

You canmodify system defined KPIs and add additional user-defined KPIs to your
project. For more details, refer to theHP Application Lifecycle Management
Administrator Guide.

ALM Editions: Functionality related to PPT is available for ALM Edition only. For
more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

KPI types are described below:

KPI Type (A -
 Z) Description

Authored
Tests

Calculates the number of tests whose planning status is set toReady.

Automated
Tests

Calculates the percentage of automated tests.

Covered
Requirements

Calculates the percentage of requirements covered by at least one test.

Defects Fixed
per Day

Calculates the number of defects fixed per day.

Passed
Requirements

Calculates the percentage of requirements whose covered tests have an
execution status of Passed.

Passed Tests Calculates the percentage of tests whose last run has an execution status of
Passed.

Rejected
Defects

Calculates the percentage of rejected defects.

Reviewed
Requirements

Calculates the percentage of business or functional requirements that have been
reviewed.

Severe
Defects

Calculates the number of defects with the status of New, Open orReopened
assigned a severity level of 5-Urgent or 4-Very High.

Test Instances
Executed

Calculates the percentage of executed test instances.

Tests
Executed

Calculates the percentage of executed tests.
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Defect Content Included in PPT Release Scope Items
Whenworking with PPT releases, you can add requirements, tests, test sets, and defects to the
content of release scope items. Based on this content, ALM calculates scorecards, which indicate the
readiness of a PPT release. You add content to release scope items in the Releases module > 
Release Scope tab > content tab. For user interface details, see "Release Scope Tab" on page 151.

The tests and test sets that you include can affect the defect content available for inclusion.

This following table describes how ALM determines the associated entities to include with defect
content for release scope items, based on the content selected for tests and test sets.

Test
Selection
Option

Test Set
Selection
Option

Defect content Included when Selecting the
"Defects linked to selected requirements, tests, and test
sets (and their associated entities)" Option

Tests in
selected
folders, with or
without a filter

Test sets in
selected
folders, with or
without a filter

Defects linked to selected requirements, tests, and test sets
(and their associated test instances, runs, and run steps)

Tests in
selected
folders, with or
without a filter

Test sets
containing the
selected tests

Defects linked to selected requirements

Defects linked to selected tests, or defects linked to test sets
that have test instances for those selected tests, or defects
linked to those test instances’ associated runs and run steps

Tests
covering
selected
requirements

Test sets in
selected
folders, with or
without a filter

Defects linked to selected requirements, or defects linked to
tests covering those selected requirements

Defects linked to selected test sets (and their associated test
instances, runs, and run steps)

Tests
covering
selected
requirements

Test sets
containing the
selected tests

Defects linked to selected requirements, or defects linked to
tests covering those selected requirements

Defects linked to test sets that have test instances for those
selected requirements’ linked tests or defects linked to those
test instances’ associated runs and run steps

PPT User Interface
This section includes:

• PPT Fields 150
• Release Scope Tab 151
• New Scope Item/Scope Item Details Dialog Box 153
• New Milestone Dialog Box 155
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• Milestone Scope Tab 156
• KPIs Tab 158
• New KPI/KPI Details Dialog Box 160
• Thresholds Page 162
• New Threshold Value Dialog Box 164
• Master Plan Tab 165
• Milestone Details Dialog Box 166
• Scorecard Tab 167
• KPI Drill DownGraph 168
• KPI Drill DownResults Dialog Box 170
• BreakdownOver TimeGraph 171
• Scorecard Layout Dialog Box 173
• New Release From Template Dialog Box 174

PPT Fields
This section describes the PPT fields in the Releases module.

Important
information

l You can add user-defined fields and change the label of any of the fields in the
Releases module. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

l You can use the Script Editor to restrict and dynamically change the fields and
values in the Releases module. For more information, refer to theHP Application
Lifecycle Management Administrator Guide.

ALM Editions: Functionality related to PPT is available for ALM Edition only.
For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your
ALM site administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "Release Scope Tab" on the next page
l "Master Plan Tab" on page 165
l "Scorecard Tab" on page 167
l "PPT Releases Overview" on page 146
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The fields are described below:

UI Element
(A - Z)

Description

Due Date The date on which themilestone ends.

KPI Type The type of KPI. For more details, see "KPI Types" on page 148.

Label The release scope item name as it is displayed in the chart of theMaster Plan tab.

Milestone ID A unique numeric ID for themilestone, assigned automatically by ALM. The
Milestone ID is read-only.

Modified The date and time the release scope item ormilestone was last changed.

Default value: The database server date and time.

Name The release scope item ormilestone name.

Owner The user name of the person who owns the release scope item.

Priority The priority of the release scope item, ranging from low priority (level 1) to high
priority (level 3).

Release End
Date

The date on which the release ends.

Release ID A unique numeric ID for the release, assigned automatically by ALM. The Release
ID is read-only.

Release Start
Date

The date on which the release starts.

Scope Item
ID

A unique alphanumeric ID for the release scope item that is assigned
automatically. This field cannot bemodified.

Start
Tracking
Date

The date on which themilestone starts.

Release Scope Tab
This tab enables you to define and update release scope items.

To access In the Releases module, select a release and click theRelease Scope tab.

Important
information ALM Editions: Functionality related to PPT is available for ALM Edition only. For

more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.
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Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129

User interface elements are described below:

UI Element Description

New Scope Item. Opens the New Scope Item dialog box, enabling you to define a
release scope item. For more details, see "New Scope Item/Scope Item Details
Dialog Box" on the next page.

Delete. Deletes selected release scope item.

Refresh. Refreshes the release scope grid so that it displays themost up-to-date
information.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the release scope grid and their order. For more details, see
"Select Columns/Select Fields Dialog Box" on page 77.

Filter/Sort. Enables you to filter the data according to the criteria that you choose.
For more details, see "Filter Dialog Box" on page 51.

Scope Item Details. Opens the Scope Item Details dialog box, enabling you to
display the details of the selected release scope item. For more details, see "New
Scope Item/Scope Item Details Dialog Box" on the next page.

Show/Hide. Shows/hides the Description and content tabs.
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UI Element Description

content tab Enables you to select content to be included in the release scope item. It includes the
following tabs:

l Requirements. Displays the requirements tree.
Expand the tree and select the folders/requirements to include in the release scope
item.

l Tests. Displays the test plan tree.
Expand the tree and select the folders/tests to include in the release scope item.
To only include tests covered by the requirements selected in the Requirements
tab, select Tests covering selected requirements.

l Test Sets. Displays the test set tree.
Expand the tree and select the test set folders to include in the release scope item.
To only include test sets that contain tests selected in the Test tab, select Test
sets containing the selected tests.

l Defects. Do one of the following:
l To define a filter to determine the defects to be included in the release scope
item, select Defects selected by defined filter.

l To include only defects that link to selected requirements, tests, and tests sets,
select Defects linked to selected requirements, tests, and test sets (and
their associated entities).

Note: Links between defects and test sets also include indirect links to:

o Test instances
o Runs
o Steps
For information about how ALM determines which defects and associated
entities to include, see "Defect Content Included in PPT Release Scope
Items" on page 149.

Description
tab

Describes the release scope item.

Click in the text box to display a toolbar for formatting and spell checking the text.

New Scope Item/Scope ItemDetails Dialog Box
This dialog box enables you to define and update the release scope items.

To access Use one of the following:

l In theRelease Scope tab, right-click the release scope grid and select New
Scope Item. The New Scope Item dialog box opens.

l In theRelease Scope tab, right-click a release scope item and select Scope Item
Details. The Scope Item Details dialog box opens.
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Important
information ALM Editions: Functionality related to PPT is available for ALM Edition only. For

more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129

User interface elements are described below:

UI Element Description

Save. Saves the details.

First/Previous/Next/Last Entity. Allows you to browse through the release
scope items.

Available from: Scope Item Details dialog box

Clear All Fields. Clears all the fields in the dialog box.

Available from: New Scope Item dialog box

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Name The release scope item name.

Details Displays details of a release scope item. For details on the available fields,
see "PPT Fields" on page 150.
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UI Element Description

content Displays the content to be included in the release scope item. It includes the
following tabs:

l Requirements. Displays the requirements tree.
Expand the tree and select the folders/requirements to include in the
release scope item.

l Tests. Displays the test plan tree.
Expand the tree and select the folders/tests to include in the release scope
item.
To only include tests covered by the requirements selected in the
Requirements tab, select Tests covering selected requirements.

l Test Sets. Displays the test set tree.
Expand the tree and select the test set folders to include in the release
scope item.
To only include test sets that contain tests selected in the Test tab, select
Test sets containing the selected tests.

l Defects. Displays the defects grid.
Define a filter to determine the defects to be included in the release scope
item.

Description Describes the release scope item.

Click in the text box to display a toolbar for formatting and spell checking the
text.

NewMilestone Dialog Box
This dialog box enables you to definemilestones.

To access In the Releases module, right-click a release and chooseNew Milestone.

Important
information

You can limit the number of milestones that can be defined per release using the
MAX_MILESTONES_PER_RELEASE parameter in the Site Configuration tab in
Site Administration. For more information, refer to theHP Application Lifecycle
Management Administrator Guide

ALM Editions: Functionality related to PPT is available for ALM Edition only. For
more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

"How toWork with PPT" on page 146
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See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129

User interface elements are described below:

UI Element Description

Clear All Fields. Clears all the fields in the dialog box.

Available from: New Milestone dialog box

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Name Themilestone name.

Details Displays milestone details. For details on the available fields, see "PPT Fields" on
page 150.

Description The description of themilestone.

Milestone Scope Tab
This tab enables you to associate milestones with release scope items.

To access Select amilestone. Click theMilestone Scope tab.

Important
information

You can limit the number of scope items that can be defined per release using the
MAX_SCOPE_ITEMS_PER_RELEASE parameter in the Site Configuration tab in
Site Administration. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

ALM Editions: Functionality related to PPT is available for ALM Edition only. For
more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129
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Milestone Scope Grid
User interface elements are described below:

UI
Element

Description

Select Scope Items. Opens the Scope pane, enabling you to select release scope
items.

Remove Scope Items. Removes selected scope items from the grid.

Refresh. Refreshes themilestone scope grid so that it displays themost up-to-date
information.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in themilestone scope grid and their order. For more details, see
"Select Columns/Select Fields Dialog Box" on page 77.

Filter/Sort. Enables you to filter data according to the criteria that you choose. For
more details, see "Filter Dialog Box" on page 51.

Scope Pane
User interface elements are described below:

UI
Element

Description

Add Scope Item. Adds selected release scope items to themilestone scope grid.

Tip: You can also add release scope items by dragging them from the scope item
grid to themilestone scope grid.

Show Scope Item Details. Opens the Details dialog box for the selected scope item in
read-only mode.

Refresh All. Refreshes the scope item grid.

Find. Searches for a specific release scope item in the scope item grid.

Type the name (or part of the name) of the release scope item in the Find box and click
Find. If the search is successful, the release scope item is highlighted in the scope item
grid.

Filter/Sort. Filters and sorts the release scope items in the scope item grid. For more
details, see "Filter Dialog Box" on page 51.
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UI
Element

Description

Select Columns. Opens the Select Columns dialog box, enabling you to determine
column appearance and order. For more details, see "Select Columns/Select Fields
Dialog Box" on page 77.

Go to Scope Item by ID. Opens theGo To Scope Item dialog box, enabling you to find a
specific test by Scope Item ID.

Note: You can only go to release scope items that are in the current filter.

KPIs Tab
This tab enables you to define the KPIs for tracking themilestone scope, and setting the KPI
thresholds.

To access Select amilestone. Click theKPIs tab.

Important
information

l You can customize the default KPIs and create your own KPIs. For more details,
refer to theHP Application Lifecycle Management Administrator Guide.

l You can limit the number of KPIs that can be defined per milestone using the
MAX_KPIS_PER_MILESTONE parameter in the Site Configuration tab in Site
Administration. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

l You can limit the number of threshold values that can be defined per KPI using the
MAX_THRESHOLD_VALUES_PER_KPI parameter in the Site Configuration tab
in Site Administration. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

ALM Editions: Functionality related to PPT is available for ALM Edition only.
For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your
ALM site administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129
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Main Area
User interface elements are described below:

UI Element Description

Opens the KPI pane, enabling you to select KPIs.

Delete KPI. Removes the selected KPI from the new milestone grid.

Show KPI Details. Opens the KPI Details dialog box, enabling you to update
KPIs and thresholds. For more details, see "New KPI/KPI Details Dialog Box"
on the next page.

Refresh. Refreshes the grid so that it displays themost up-to-date information.

Displays thresholds for a selected KPI column.

This option is enabled by selecting a single cell.

Includes the selected KPI in the definedmilestone scope.

Excludes the selected KPI from the definedmilestone scope.

Opens the New KPI dialog box, enabling you to create a KPI based on a
selected KPI. For more details, see "New KPI/KPI Details Dialog Box" on the
next page.

Show/Hide. Shows/hides the Thresholds pane.

Thresholds pane Enables you tomanage threshold values for selected KPIs. For more details,
see "Thresholds Page" on page 162.

KPIs Pane
User interface elements are described below:

UI
Element

Description

Add KPI. Adds the selected KPI to themain area in the KPI tab.

Show KPI Definition Details. Opens the KPI Definition Details dialog box for the
selected KPI in read-only mode.
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UI
Element

Description

Find. Searches for a specific KPI in the KPI grid.

Type the name (or part of the name) of the KPI in the Find box and click Find. If the
search is successful, the KPI is highlighted in the KPI grid.

Filter/Sort. Filters and sorts the KPIs in the KPI grid. For more details, see "Filter Dialog
Box" on page 51.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
column appearance and order. For more details, see "Select Columns/Select Fields
Dialog Box" on page 77.

New KPI/KPI Details Dialog Box
This dialog box enables you to define and update KPIs.

To access Use one of the following:

l Select amilestone. Click theKPIs tab. Click Create As KPI. The New KPI dialog
box opens.

l Select amilestone. Click theKPIs tab. Click Show KPI Details . The KPI
Details dialog box opens.

Important
information

l You can limit the number of KPIs that can be defined per milestone using the
MAX_KPIS_PER_MILESTONE parameter in the Site Configuration tab in Site
Administration. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

l You can limit the number of threshold values that can be defined per KPI using the
MAX_THRESHOLD_VALUES_PER_KPI parameter in the Site Configuration tab
in Site Administration. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

ALM Editions: Functionality related to PPT is available for ALM Edition only.
For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your
ALM site administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "KPI Types" on page 148
l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129
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Common Elements
User interface elements are described below:

UI
Element

Description

Clear all Fields. Clears all fields in the dialog box.

Available from: New KPI dialog box

Save. Saves the details.

Show KPI Type Definition. Opens the KPI Type Definition dialog box, enabling you to
view additional information on a selected KPI.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

KPI ID A unique alphanumeric ID for the KPI that is assigned automatically. The KPI ID field
cannot bemodified.

Name The KPI name.

Details View
User interface elements are described below:

UI Element Description

KPI Type The type of KPI. For details on the available KPI, see "KPI Types" on
page 148.

View KPI Type
Details

Displays details on the selected KPI.

Description A description of the selected KPI.
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Optional Filter View
This view enables you to narrow down the entities population in eachmilestone scope item.

User interface elements are described below:

UI Element Description

Set Filter/Sort. Enables you to limit the KPI data according to your chosen criteria.
For more details on filtering, see "Filter Dialog Box" on page 51.

Clear Filter. Clears the defined filter.

View KPI
Type
Details

Displays details on the selected KPI.

Thresholds View
This view enables you tomanage threshold values for a selected KPI. For more details, see
"Thresholds Page" below.

Thresholds Page
This pane enables you tomanage threshold values for selected KPIs.

To access Use one of the following:

l Select amilestone. Click theKPIs tab. Click Create As KPI. The New KPI dialog
box opens. Click Thresholds.

l Select amilestone. Click theKPIs tab. Click Show KPI Details . The KPI
Details dialog box opens. Click Thresholds.

l Select amilestone. Click theKPIs tab. The Thresholds pane is displayed on the
bottom.

Important
information

l You canmodify the default threshold values of a KPI. For more details, refer to the
HP Application Lifecycle Management Administrator Guide.

l You can limit the number of threshold values that can be defined per KPI using the
MAX_THRESHOLD_VALUES_PER_KPI parameter in the Site Configuration tab
in Site Administration. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

ALM Editions: Functionality related to PPT is available for ALM Edition only.
For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your
ALM site administrator.
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Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129

User interface elements are described below:

UI Element Description

Opens the New Threshold Value dialog box, enabling you to define
the threshold values for a selected KPI. For more details, see "New
Threshold Value Dialog Box" on the next page.

Removes selected threshold value from the thresholds grid.

Restores default KPI threshold.

Refresh All. Refreshes the new thresholds grid so that it displays
themost up-to-date information.

Date The threshold value date.

OK Above A value lower thanOK Above and higher than the warning limit,
indicates a warning KPI state.

A value lower than the warning limit indicates a critical KPI state.

OK Below A value higher thanOK Below and lower than the warning limit,
indicates a warning KPI state.

A value higher than the warning limit indicates a critical KPI state.

% Warning Range Determines the KPI's warning range.

A value lower thanOK Above and higher than the warning limit,
indicates a warning KPI state.

A value higher thanOK Below and lower than the warning limit,
indicates a warning KPI state.

Threshold Preview Provides a visual indicator of the thresholds of the selected KPI over
the duration of themilestone.

Includes the following color-coded thresholds:

l Green. Indicates a good KPI state.
l Yellow. Indicates an acceptable or a warning KPI state.
l Red. Indicates a bad KPI state.
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New Threshold Value Dialog Box
This dialog box enables you to set threshold values for selected KPIs.

To access Use one of the following:

l Select amilestone. Click theKPIs tab. Click Create As KPI. The New KPI dialog
box opens. Click Thresholds. Click Add Threshold Value .

l Select amilestone. Click theKPIs tab. Click Show KPI Details . The KPI
Details dialog box opens. Click Thresholds. Click Add Threshold Value.

l Select amilestone. Click theKPIs tab. The Thresholds pane is displayed on the
bottom. Click Add Threshold Value.

Important
information ALM Editions: Functionality related to PPT is available for ALM Edition only. For

more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129

User interface elements are described below:

UI Element Description

Date The threshold value date.

OK Above A value lower thanOK Above and higher than the warning limit, indicates a
warning KPI state.

A value lower than the warning limit indicates a critical KPI state.

OK Below A value higher thanOK Below and lower than the warning limit indicates a
warning KPI state.

A value higher than the warning limit indicates a critical KPI state.

% Warning
Range

Determines the KPI's warning range.

A value lower thanOK Above and higher than the warning limit indicates a
warning KPI state.

A value higher thanOK Below and lower than the warning limit indicates a
warning KPI state.
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Master Plan Tab
This tab displays the progress of a release in a Gantt chart.

To access In the Releases module, select a release and click theMaster Plan tab.

Important
information ALM Editions: Functionality related to PPT is available for ALM Edition only. For

more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129

User interface elements are described below:

UI
Element

Description

Show Details. Opens the appropriate Details dialog box, depending on the selected
entity. You can select the following entities: cycles, milestones, and release scope
items.

For more details on cycle details, see "New Cycle/Cycle Details Dialog Box" on
page 136.

For more details onmilestone details, see "Milestone Details Dialog Box" on the next
page.

For more details on release scope item details, see "New Scope Item/Scope Item
Details Dialog Box" on page 153.

Tip: You can also double-click an entity on the chart. The appropriate Details dialog
box opens.

Refresh. Refreshes the chart.

Reschedule. Reschedules the start and end date of a release, cycle or milestone. For
more details, see "Reschedule Release/Cycle/Milestone Dialog Box" on page 143.

Zoom In/Out. Changes themagnification of the chart.

Display Entire Release. Restores the chart to its normal size. This button is enabled
when the Zoom In and ZoomOut buttons are in use.
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UI
Element

Description

Full Screen View. Opens the chart in a new window andmaximizes its display.

Milestone Details Dialog Box
This dialog box enables you to view and update themilestones.

To access Use one of the following:

l In the Releases module, select a release and click theMaster Plan tab. Double-
click amilestone on the chart.

l In the Releases module, right-click amilestone and chooseDetails.

Important
information ALM Editions: Functionality related to PPT is available for ALM Edition only. For

more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129

User interface elements are described below:

UI Element Description

Save. Saves the details.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Milestone ID A unique numeric ID for themilestone, assigned automatically by ALM. The
Milestone ID is read-only.
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UI Element Description

Name Themilestone name.

Details Displays milestone details. For details on the available fields, see "PPT Fields" on
page 150.

Milestone
Scope

Enables you to view and update a release scope item. For more details, see
"Milestone Scope Tab" on page 156.

KPIs Enables you to define KPIs and set thresholds. For more details, see "KPIs Tab" on
page 158.

Attachments Enables you to add attachments that provide additional information about the new
milestone. For more details, see "Attachments Page" on page 72.

History Enables you to view the fields modified during the change. For more details, see
"History Tab" on page 68.

Description A description of themilestone.

Scorecard Tab
This tab displays KPI calculations that enable you to determine the status of your release. You can
view a detailed analysis of each KPI cell and display the calculation as a graph. You can also view
details of the entities that contributed to the KPI data.

To access In the Releases module, select a release and click theScorecard tab.

Important
information

To view progress in theScorecard tab, youmust run calculations for your project.
You can schedule to run calculations automatically or manually. For more details,
refer to theHP Application Lifecycle Management Administrator Guide.

ALM Editions: Functionality related to PPT is available for ALM Edition only. For
more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129
l "View Tab - PPT Graphs" on page 772
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Refreshes the scorecard table, so that it displays themost up-to-date
information.

For details on the scorecard table, see "View Tab - PPT Graphs" on
page 772.

Note: KPIs are calculated at predefined hours on a daily basis.
Milestones are calculated once they reach their due date.

Scorecard Layout. Opens the Scorecard Layout dialog box enabling you
to configure the scorecard table. For more details, see "Scorecard Layout
Dialog Box" on page 173.

Save Graph Image. Saves the scorecard table as an image.

Full Screen. Displays the scorecard table in full-screenmode.

Opens the KPI analysis of the selected cell as defined in project
customzation. For more details, see "KPI Drill DownGraph" below.

Opens the Drill DownResults dialog box which displays details of the
entities that contributed to the KPI value. For more details see "KPI Drill
DownResults Dialog Box" on page 170.

Example: If your release scope item contains 50 defects, of which
10 have been rejected, then the value for the Rejected Defects KPI
will be 20%. To view details of the rejected defects only, click KPI
Numerator. To view details of all the defects, click KPI
Denominator.

Note: KPI Denominator is only available for percentage KPI types.

<KPI cell> Hover over a KPI cell to view a tooltip containing the KPI's threshold
values.

KPI Drill Down Graph
This graph shows calculations of a KPI cell. The top area shows changes in the KPI calculations over
time. The bottom area shows KPI breakdown calculations.

To access 1. In the Releases module, select a release and click theScorecard tab.
2. Select a KPI cell.
3. On the Scorecard tab toolbar, click Show KPI Analysis.
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Important
information

The graph page can contain up to two additional graphs. You can customize this page
and determine whether or not to display these additional graphs. For more details,
refer to theHP Application Lifecycle Management Administrator Guide.

ALM Editions: Functionality related to PPT is available for ALM Edition only. For
more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Export to PDF. The Save As dialog box opens enabling you to save the graph as a
PDF.

Generate All Graphs in Page/Generate Graph. Refreshes all the graphs on the
page, or the selected graph, so that they display themost up-to-date information.

View Page in Full Screen. Displays the dashboard page in full-screenmode.

View Graph in Full Screen. Displays the graph in full-screenmode.

Milestone The name of the selectedmilestone.

Milestone
Scope Item

The name of the selectedmilestone scope item.

Last KPI
Date

Indicates when the KPI was last calculated.

<graph
area>

Hover over a graph segment to view a tooltip containing additional information.

Breakdown
Over Time
link

Click to drill down to the graph's data and show specific points during a period of time.
Opens a breakdown over time graph. For more details, see "BreakdownOver Time
Graph" on page 171.

Available from: graph area on the bottom of the page.
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KPI Drill Down Results Dialog Box
This dialog box displays themost up to date details of entities that contributed to the KPI value. The
information displayed represents either the numerator or the denominator value contributing to the KPI
percentage result, or the value contributing to the KPI count result.

To access 1. In the Releases module, select a release and click theScorecard tab.
2. Select a KPI cell and on the Scorecard toolbar and click eitherKPI Numerator

orKPI Denominator (if the KPI is a percentage type).

Important
information

l The dialog box displays themost up to date information for each entity, even if it
has changed since the original KPI calculation. Therefore it is possible that the
information displayedmay contradict the KPI value.

l Entities that have been deleted from the system are not displayed.

ALM Editions: Functionality related to PPT is available for ALM Edition only.
For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your
ALM site administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A - Z)

Description

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the data grid, and their order. For more details, see "Select
Columns/Select Fields Dialog Box" on page 77.

Export. Opens the Export Grid Data dialog box, enabling you to export the records
as a text file, Microsoft Excel worksheet, Microsoft Word document, or HTML
document.

Select one of the following options:

l All. Exports all records in the grid.
l Selected. Exports selected records in the grid.

<Segment
parameters>

Located above the data grid, displays the drill down type and the number of records
displayed.
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UI Element
(A - Z)

Description

<Data grid> A list of the numerator or denominator records that are included in the selected KPI
value.

To open a particular record, double-click a record. The <Module> Details dialog box
opens, enabling you to view or edit the record. Use the navigation buttons to browse
through the drill down results.

Breakdown Over Time Graph
This graph displays specific points during a period of time.

To access From the Releases module:

1. In the Releases module, select a release and click theScorecard tab.
2. Select a KPI cell.
3. On the Scorecard tab toolbar, click Show KPI Analysis. The KPI Drill Down

Graph opens.
4. On the bottom of the KPI Drill DownGraph page, click theBreakdown Over

Time link.
From the Dashboard module:

1. Select Analysis View.
2. Expand the analysis tree, and select one of the following graphs: KPI

Breakdown orRelease Scorecard.
3. Click theView tab.
4. For a KPI Breakdown graph, click theBreakdown Over Time link.

For a Release Scorecard, click a KPI cell. On the bottom of the KPI graph page,
click theBreakdown Over Time link.

Important
information ALM Editions: Functionality related to PPT is available for ALM Edition only. For

more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129
l "KPI Drill DownGraph" on page 168

User Guide
Chapter 10: Project Planning and Tracking (PPT) Releases

HP ALM (12.50) Page 171



User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Refreshes the graph so that it displays themost up-to-date information.

Line Chart. Switches the chart format to a line chart.

Data Grid. The grid creates amatrix of the graph's x-axis andGrouped By
categories. A Total row is added that displays the total of eachGrouped By
category.

Show/Hide Total Values. Shows/hides a <total> category to the graph,
representing the sum of all the other Grouped By categories.

Tip: After showing the <total> category, click its label in the legend to hide the
category.

Scroll to the Left/Right. Scrolls the graph to the left or right. These buttons are
enabled when the Zoom In and ZoomOut buttons are in use.

Show All. Restores the graph to its normal size. This button is enabled when the
Zoom In and ZoomOut buttons are in use.

Zoom In/Out. Changes themagnification of the graph.

Save Graph Image. When viewing a graph as a bar, pie chart, or line chart, saves
the graph image. You can select from a variety of graphic file formats.

Save Graph Data. When viewing a data grid, saves the graph data. You can save
the data as an Excel spreadsheet, aWord file, an HTML document, or a text file.

Set Graph Appearance. Opens theGraph Appearance dialog box, enabling you to
customize the graph title, graph color, and graph display. For more details, see
"Graph Appearance Dialog Box" on page 765.

Copy Graph to Clipboard. Includes the following options:

l Copy Graph (Color). Copies the graph in color to the Clipboard.
l Copy Graph (Monochrome). Copies the graph inmonochrome to the Clipboard.
l Copy Full Screen Graph (Color). Copies the graph in color to the Clipboard,
enlarged to fit full screen.

l Copy Full Screen Graph (Monochrome). Copies the graph inmonochrome to
the Clipboard, enlarged to fit full screen.
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UI Element Description

Print Graph. Includes the following options:

l Print Graph (Color). Prints the graph in color. This is the default button option.
l Print Graph (Monochrome). Prints the graph inmonochrome.
l Print Graph and Details (Color). Prints the graph and its description in color.
l Print Graph and Details (Monochrome). Prints the graph and its description in
monochrome.

<graph
area>

Hover over a graph segment to view a tooltip containing additional information.

<legend> Displays the chart categories and their corresponding color. Click a category to
show or hide the category in the graph.

Scorecard Layout Dialog Box
This dialog box enables you to configure the scorecard table settings.

To access In the Releases module, select a release and click theScorecard tab. Click the
Scorecard Layout button.

Important
information ALM Editions: Functionality related to PPT is available for ALM Edition only. For

more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129

User interface elements are described below:

UI Element Description

Rows Lists rows that are currently displayed in the scorecard table.

Sets the order in which row or column names appear in scorecard
table.

Moves selected names betweenRows andColumns.

Columns Lists columns that are currently displayed in the scorecard table.
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UI Element Description

Rows Lists rows that are currently displayed in the scorecard table.

Group Scope Items by
Field

Groups according to a specified scope item field.

Display Planned KPI
Target

Displays the OK value of a KPI's threshold in thePlanned column of
the scorecard table.

Note: ThePlanned column is displayed only when this option is
enabled.

Enables you to narrow and sort theMilestone, Scope Item, orKPI
data according to your chosen criteria. For more details on filtering,
see "Filter Dialog Box" on page 51.

Clears the defined filter.

Restores default filter definitions.

New Release FromTemplate Dialog Box
This dialog box enables you to create a new release by copying from an existing release in a template
project.

To access In the Releases module, right-click a release folder and select New Release from
Template > New Release from Template.

Important
information

l The following release properties are copied from the template project:
description, start/end dates, cycles, milestones, KPIs, KPI thresholds,
attachments, and user-defined fields.

l The following release properties are not copied from the template project:
release scope, milestone scope, and links to ALM entities in other modules.

l After creating the new release, youmust update the copied dates.
l The New Release from Template option is available in a project that is linked and
synchronized with a template project. For more details on linking and
synchronizing template projects, refer to theHP Application Lifecycle
Management Administrator Guide.

ALM Editions: Functionality related to PPT is available for ALM Edition only.
For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your
ALM site administrator.
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Relevant
tasks

"How toWork with PPT" on page 146

See also l "PPT Releases Overview" on page 146
l "Releases ModuleWindow" on page 129

User interface elements are described below:

UI Element Description

Template
Release

Displays the releases available from the template project.

Expand the tree and select a release.

Release
Name

The name of the new release.

Note: If the release name already exists in the Releases module, the suffix _
Copywill be added to the release name.
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Libraries Overview
In the Libraries module, you define a hierarchical libraries tree to create andmanage your libraries. A
library represents a set of entities in a project and the relationships between them. The entities in a
library can include requirements, tests, test resources, and business components.

After you create a library, you can create a baseline to keep track of changes made to your project over
time. A baseline is a snapshot of the library at a specific point in time. You can compare baselines at
all stages of the application development lifecycle.

Viewing baseline history enables you to track changes made to individual entities in your library over
time. As development continues, you can view and compare all versions of an entity that are stored in a
baseline.

You can also import a library. Importing a library enables you to reuse and share an existing set of
entities. As development continues, you can compare and synchronize libraries. For details, see
"Imported Libraries Overview" on page 202.

ALM Editions: Imported library functionality is available for ALM Edition and Performance Center
Edition only. For more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site administrator.

Creating andmanaging libraries and baselines requires appropriate user permissions. For more
information, refer to theHP Application Lifecycle Management Administrator Guide.

This section also includes:

l "Baselines Overview" below
l "Pinned Test Sets" on the next page
For task details, see "How to Use Libraries and Baselines in ALM" on page 181.

Baselines Overview
After you create a library, you can create a baseline. A baseline is a snapshot of your library at a
specific point in time. You can use a baseline tomark any significant milestone in the application
development lifecycle. A baseline includes all the entities defined in the library, including requirements,
tests, and test resources. Baselines also include:

l the relationships between the entities in the library, such as traceability and coverage
l any related entities outside of the library that the tests in the library need in order to run, such as
called tests and test resources

Baselines enable you to keep track of changes made to your project over time. You can use baselines
in the following ways:

l Compare baselines at all stages of the application development lifecycle. For example, you can
compare two baselines in a library to assess the impact of changes made to requirements over time.
You can then update the relevant tests in your project accordingly. You can also compare a baseline
to the current entities in the library.

l Pin a test set to a baseline. This ensures that when you run the test set, the versions of the tests
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stored in a baseline you specify are run. For more details, see "Pinned Test Sets" below.
l Use a baseline to share the entities in a library. This enables you to reuse the library's entities within
your project, or in a different project. You share or reuse entities by importing a library. The library
must contain a baseline. For details and limitations on importing libraries, see "Imported Libraries
Overview" on page 202.

ALM Editions: Imported library functionality is available for ALM Edition and Performance
Center Edition only. For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Baseline Examples
The following examples demonstrate how you can use baselines:

l Establish content of a release - stakeholder sign off
Your organization is starting development of a new version of an application. Robert, a business
analyst, presents a group of requirements to the stakeholders to review. After the requirements
are reviewed and approved, he creates a baseline. Stakeholders can then sign off on the agreed
upon release content.

l Monitor change
Kelly, a product manager, finds that product development is being implemented differently than
she expected. She reviews the requirements for the product and discovers that some have
changed. She compares the current requirements with the requirements in the baseline created
and agreed upon at the start of the release.

l Evaluate the impact of changes
Michael, a QA tester, is responsible for a large group of tests that are part of the latest
application release. He is updating some of the tests in accordance with the requirements for
the release. Following the latest requirements review meeting, he is notified that some of the
requirements have been changed. Michael compares the current requirements with the
requirements in the baseline created at the start of the release. He identifies which changes
affect tests he is working on, and updates the tests to reflect the changes.

Pinned Test Sets
Pinning a test set to a baseline associates the tests in that set with the versions stored in the baseline.

When you pin a test set to a baseline:

l Only the versions of the tests stored in the specified baseline are run
l Tests that are not a part of the baseline are removed from the pinned test set
l All test runs are deleted from the pinned test set
l Only tests that are included in the baseline can be selected when adding tests to the pinned test set
When you clear a pinned test set:
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l The tests in the test set are then associated with the latest version of the tests in the Test Plan
module

l All test runs in that test set are deleted

Why is this useful?

Pinning test sets to a baseline is useful in a testing environment where there is a time lag between the
development of tests for a particular version, and the running of these tests. While one team is running
tests on the current stable version, another teammay already be updating the Test Planmodule with
tests for future versions. Pinning a test set to a baseline helps to ensure that the correct versions of the
tests are run during test set execution.

The team running tests creates test sets in the Test Labmodule by selecting and adding tests from the
Test Plan tree. However, due to the time lag between the development and execution of tests, the Test
Plan treemay already include tests that relate to future versions of the application - new tests or
updated tests with new steps. If the latest versions of the tests are run, the tests will fail. By pinning a
test set to a baseline associated with a particular version, testers can ensure that tests or test steps
that are not part of the version being tested are removed from the test set.

Pinning is particularly useful for automated functional testing, where function libraries are used. If a
specific function library is included inmany tests (for example Test 3 through to Test 100) but the
function is still in development, running non-pinned versions of tests 3 through to 100 causes all these
tests to fail.

Example

Jack, a test engineer, is designing tests to check the flight booking feature of theMercury Tours
website. In the Test Planmodule, he creates theBookFlight test consisting of two steps (step 1
and step 2).

As part of the next stage, the development team begins addingmore functionality to the flight
booking feature. To test this new functionality, Jack must update theBookFlight test with two
more steps (step 3 and step 4.) Before updating the test, Jack creates a baseline (Baseline 1). In
Baseline 1, BookFlight consists only of steps 1 and 2. Jack then proceeds to update the test with
the two additional steps. The test with 4 steps will be saved in Baseline 2.

At the same time Alice, a QA tester, is testing the earlier version of the website that does not
include the new functionality, as the development team is still working on this. The test set that
she has created in the Test Labmodule includes theBookFlight test that Jack has been updating.
If she runs the latest Bookflight test with steps 3 and 4 included, the test will fail. Tomake sure that
she runs the correct version of the test, Alice pins Bookflight to Baseline 1 before running the test.
This removes steps 3 and 4 from the test.
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For user interface details, see "Select Baselines Dialog Box" on page 199.

How to Use Libraries and Baselines in ALM
This task describes how to work with libraries and baselines.

To learnmore about libraries and baselines, see "Libraries Overview" on page 178.

l ALM Editions:Quality Center Enterprise Edition does not include all Libraries module
functionality. For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

l Product Feature Movie: To view amovie that demonstrates versioning and baselining
capabilities, chooseHelp > Movies in the ALMmain window.

This task includes the following steps:

l "Create a library" on the next page
l "Create a baseline" on the next page
l "Monitor library tasks - optional" on page 183
l "Compare baselines" on page 183
l "Pin a test set to a baseline" on page 184
l "View baseline history" on page 184
l "Share a library" on page 184
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1. Create a library
Define a hierarchical framework for your libraries by creating a libraries tree that can contain
folders and subfolders.
a. Open the Libraries module. On the ALM sidebar, underManagement, select Libraries.
b. Create folders. Right-click the Libraries root folder and select New Folder. To create a sub-

folder, right-click a folder and select New Folder.
c. Add libraries to folders. Right-click a folder and select Create Library. In the New Library

dialog box, fill in fields on the Details page. For user interface details, see "New Library/Library
Details Dialog Box" on page 190.
On the content page, select entities to include in the library. For user interface details, see
"Content Tab" on page 191.
You can define a filter to help you select the entities that you want to include. This can be
useful, for example, if you want to create a library that is not based solely on the hierarchical
structure of your project.

Example

Jim, the project manager, has a new project with amajor security impact. The test plan
tree in his project is organized hierarchically based on products and versions. Jim creates
a library that includes the relevant test folders, and defines a filter for the library to include
only security-related tests in those folders.

Note: In order to maintain optimal performance, the number of entities that a library can
contain is limited. You can change the default values by setting the LIBRARY_FUSE and
REQUIREMENTS_LIBRARY_FUSE parameters in the Site Configuration tab in Site
Administration. For details, refer to theHP Application Lifecycle Management
Administrator Guide.

2. Create a baseline
Create a baseline for a library to track changes made to entities in your project over time.
a. In the Libraries module, right-click a library and select Create Baseline. For user interface

details, see "Create BaselineWizard" on page 193.
b. Click theView Log button in the Details tab. The Log: Create Baseline dialog box opens and

displays progress.

Note:When the process is complete, view the log before refreshing the display. If you
refresh the display after the baseline is created, theView Log button is no longer
displayed, and you cannot view the log.

For user interface details on the Libraries module window, see "Libraries ModuleWindow" on
page 185.

c. Click theRefresh button on themodule toolbar to refresh the display. The baseline details are
displayed in the Details tab. For details on the available fields in the Details tab, see "Libraries
Module Fields" on page 189.
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3. Monitor library tasks - optional
When you create a baseline, ALM performs the task in the background, enabling you to continue
working in ALM while the process is running. You can view the status and progress of all
asynchronous tasks run for the project using the Task Manager.

On the ALMmasthead, click and select Task Manager. For user interface details, see "Task
Manager Dialog Box" on page 41.

4. Compare baselines
Compare two baselines in a library, or compare a baseline to the current entities in the library.
a. In the Libraries module, right-click a baseline, click Compare To, and choose one of the

following:
o Select Baseline. Compares the baseline you selected with another baseline in the library.

Opens the Select Baseline dialog box. Click the browse button to select a baseline from
the list.

o Current Entities. Compares the baseline you selected with the current entities in the
library.

For user interface details on the Compare Baselines Tool, see "Compare Baselines Tool
Dialog Box" on page 194.

b. To save the baseline comparison results in .csv file format, click theExport Comparison

Results button . After saving, the file opens in the default application defined for opening
.csv files on your computer, such as Microsoft Excel.

Example

Comparing two baselines that were created at different stages of development shows the
following results:
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5. Pin a test set to a baseline
You can pin a test set to a baseline to associate the test set with the versions of the tests stored in
the baseline you select.
l In the Test Labmodule, right-click a test set and select Pin to Baseline. For user interface
details on the Select Baseline dialog box, see "Select Baselines Dialog Box" on page 199.

l To clear a pinned baseline, right-click a test set and select Clear Pinned Baseline.
For concept details on pinned test sets, see "Pinned Test Sets" on page 179.

6. View baseline history
View and compare all versions of an entity that are stored in a baseline.

Note: Available from the followingmodules: Requirements, Business Components, Test
Plan, Test Resources.

Select an entity in the tree or grid, and click History tab > Baselines tab.
For user interface details on the Baselines tab, see "Baselines Tab" on page 198.

7. Share a library
Import a library to reuse an existing set of entities within a project or across multiple projects. As
development continues, compare and synchronize libraries. For task details, see "How to Share
Libraries" on page 204.

Libraries and Baselines User Interface
This section includes:

• Libraries ModuleWindow 185
• Libraries ModuleMenus and Buttons 186
• Libraries Module Icons 188
• Libraries Module Fields 189
• New Library/Library Details Dialog Box 190
• Content Tab 191
• Create BaselineWizard 193
• Compare Baselines Tool Dialog Box 194
• Compare Entities Dialog Box 196
• Comparison Settings Dialog Box 197
• Baselines Tab 198
• Select Baselines Dialog Box 199
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Libraries ModuleWindow
The Libraries module window enables you to create andmanage libraries and baselines.

To access On the ALM sidebar, under Management, select Libraries.

Important
information ALM Editions:Quality Center Enterprise Edition does not include all Libraries

module functionality. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

Relevant
tasks

l "How to Use Libraries and Baselines in ALM" on page 181
l "How to Share Libraries" on page 204

See also "Libraries Overview" on page 178

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Libraries
module
common UI
elements>

l Library fields. For field definitions, see "Libraries Module Fields" on page 189.
l Library menus and buttons. For command and button descriptions, see
"Libraries ModuleMenus and Buttons" on the next page.

l Library icons. For icon descriptions, see "Libraries Module Icons" on page 188.
l ALM masthead, menus, and sidebar. For details, see "ALM Common Areas"
on page 32.

<Libraries
tree>

A graphical representation of your libraries.

<Filter
status bar>

Describes the filter currently applied to the tree. Located directly above the libraries
tree.

Details tab Describes the library folder, library, or baseline selected in the libraries tree.

content tab Displays the entities included in the selected library. For details, see "Content Tab"
on page 191.

Imported By
tab

Displays a list of projects that have imported the selected library. For more details,
see "Imported By Tab" on page 210.

ALM Editions: Available only for ALM Edition and Performance Center Edition.
For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your
ALM site administrator.
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UI Element Description

Imported
From tab

Displays details about the library from which the currently selected library was
imported. This tab is visible only when the selected library is imported. For more
details, see "Imported From Tab" on page 211.

ALM Editions: Available only for ALM Edition and Performance Center Edition.
For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your
ALM site administrator.

Description
tab

A description of the currently selected library folder, library, or baseline.

Click in the text box to display a toolbar for formatting and spell checking the text.

Libraries Module Menus and Buttons
This section describes themenus and buttons available in the Libraries module.

To access On the ALM sidebar, under Management, select Libraries.

Important
information

Tip: You can access themenu bar from the Libraries module by pressing the
shortcut key ALT.

ALM Editions:Quality Center Enterprise Edition does not include all Libraries
module functionality. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

Relevant
tasks

"How to Use Libraries and Baselines in ALM" on page 181

See also l "Libraries Module Icons" on page 188
l "Libraries Overview" on page 178

User interface elements are described below:

UI
Element

Menu Description

New
Folder

Libraries Opens the New Library Folder dialog box, enabling you to add a folder under
a selected folder.
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UI
Element

Menu Description

Create
Library

Libraries Opens the Create Library dialog box, enabling you to add a library to a
selected library folder. For more details, see "New Library/Library Details
Dialog Box" on page 190.

Import
Library

Libraries Opens the Import Library Wizard, enabling you to import a library under a
selected library folder. For more details, see "Import Library Wizard" on
page 208.

ALM Editions:Available only with ALM Edition and Performance Center
Edition. For more information about ALM editions and their functionality,
see "ALM Editions" on page 115. To find out what edition of ALM you are
using, ask your ALM site administrator.

Create
Baseline

Libraries Enables you to create a baseline for a selected library. For more details, see
"Create BaselineWizard" on page 193.

Compare

To

Libraries Compares the currently selected library or baseline with other libraries or
baselines. Includes the following options:

For a selected library:

l Latest Baseline Created. Compares the selected library with themost
recent baseline created in the other library.

l Select Baseline. Opens the Select Baseline dialog box, enabling you to
select a baseline in another library with which to compare.

For a selected baseline:

l Current Entities. Compares the selected baseline with the current
entities in the library.

l Select Baseline. Opens the Select Baseline dialog box, enabling you to
select a baseline in the library with which to compare.

Library
Details

Libraries Opens the Library Details dialog box, enabling you to view and edit the
details of the selected library. For details, see "Libraries ModuleWindow" on
page 185.
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UI
Element

Menu Description

Cut/Paste Edit Moves a selected library folder or library to a different location in the libraries
tree.

Note: Moving a library folder alsomoves its libraries and baselines.
Moving a library alsomoves its baselines. You cannot move a baseline
or the root folder.

Tip: You can alsomove a library folder or a library to a new location in
the libraries tree by dragging it.

Delete Edit Deletes selected library folders, libraries, or baselines.

Note:

l You cannot delete a library folder that contains libraries, or delete a
library that contains baselines.

l Deleting a library or baseline does not delete the library's entities from
your project.

l If you delete a baseline, you can no longer compare between the
baseline's library and another library that was imported from or
synchronized with the baseline.

l Deleting a baseline also deletes test sets pinned to the baseline.

Rename Edit Renames a selected library folder, library, or baseline. You cannot rename
the root folder.

Refresh View Refreshes the libraries tree and tabs so that they display themost up-to-date
information.

Filter View Enables you to filter the libraries in the libraries tree. For more details, see
"Filter Dialog Box" on page 51.

Libraries Module Icons
This section describes the icons available in the Libraries module.

To access On the ALM sidebar, under Management, select Libraries.
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Important
information

ALM Editions:Quality Center Enterprise Edition does not include all Libraries
module functionality. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

See also l "Libraries ModuleMenus and Buttons" on page 186
l "Libraries ModuleWindow" on page 185

User interface elements are described below:

UI
Element

Description

<green asterisk>. The applicable tab is populated.

Baseline. A baseline for a library in the libraries tree.

Imported Library. A library that was imported from the same project or from a different
project.

Library Folder. A folder for organizing libraries.

Library. A library in the libraries tree.

Libraries Module Fields
This section describes the Libraries module fields.

To access On the ALM sidebar, under Management, select Libraries.

Important
information

l You can add user-defined fields and change the label of any of the fields in the
Details tab. You can also customize project lists. For more information, refer to the
HP Application Lifecycle Management Administrator Guide.

l You can use the Script Editor to restrict and dynamically change the fields and
values in the Libraries module. For more information, refer to theHP Application
Lifecycle Management Administrator Guide.

ALM Editions:Quality Center Enterprise Edition does not include all Libraries
module functionality. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

Relevant
tasks

"How to Use Libraries and Baselines in ALM" on page 181

See also "Libraries Overview" on page 178
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The fields are described below:

UI Element Description

Name The folder, library, or baseline name.

Baseline ID A unique numeric ID for the baseline that ALM assigns automatically.

Created By The user name of the person who created the library or baseline.

Creation
Date

The date on which the library or baseline was created.

Modified The date and time on which the baseline was last renamed or the description was
changed.

Library ID A unique numeric ID for the library that ALM assigns automatically.

Description A description of the library folder, library, or baseline.

Click in the text box to display a toolbar for formatting and spell checking the text.

New Library/Library Details Dialog Box
The New Library dialog box enables you to add a library to a library folder.

The Library Details dialog box enables you to view and update the details and content of a library.

To access New Library dialog box: In the Libraries module, right-click a library folder and
select Create Library.

Library Details dialog box: In the Libraries module, right-click a library and select
Library Details.

Relevant
tasks

"How to Use Libraries and Baselines in ALM" on page 181

See also "Libraries Overview" on page 178

User interface elements are described below:

UI Element Description

Clear All Fields. Clears the data.

Available from:New Library dialog box

Save. Saves the details.

Check Spelling. Checks the spelling for the selected word or text box.
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UI Element Description

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Name The name you assign to the library.

Syntax exceptions:A library name cannot include the following characters: \ / : * ? "
< > |

Details Lists library fields. Required fields are displayed in red. For details on the available
library fields, see "Libraries Module Fields" on page 189.

content Enables you to select entities in your project to include in the library. For details, see
"Content Tab" below.

Description A description of the library. Clicking inside the Description field displays a toolbar for
formatting and spell checking the text.

Library ID A unique numeric ID for the library that ALM assigns automatically.

Content Tab
This tab enables you to select or view the entities included in a library.

To access Use one of the following:

l In the Libraries module, select a library and click the content tab.
l In the New Library dialog box or the Library Details dialog box, click content on the
sidebar.

Important
information

When you select tests to include in a library, you do not need to select related entities
that a test needs to run, such as its called tests and test resources. When you create
a baseline for the library, ALM automatically includes those related entities in the
baseline.

Relevant
tasks

"How to Use Libraries and Baselines in ALM" on page 181

See also "Libraries Overview" on page 178
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User interface elements are described below:

UI Element Description

Requirements Requirements module content for the library.

Resources Test Resources module content for the library.

Components Business Components module content for the library.

Tests Test Planmodule content for the library.

Select an option for including tests in the library:

l Tests in selected folders. Enables you to select folders in the tree to include in
the library.

l Tests covering selected requirements. Includes only the tests that cover the
requirements that are selected for the library.

Note: Selecting this option clears any previous selection or filter defined in
this tab.

Refresh. Refreshes the tab so that it displays themost up-to-date information.

Filter. Enables you to filter the entities in the tree.

The filter determines the following:

l the folders and records that are displayed and available for selection in the
content tab

l the entities that are included when you create a baseline or import the library

Note: Creating a relative filter for a library, such as filtering by the Test Plan
Path field, is not supported. If the library is then imported to create a new
library, the baseline that is created automatically after import, which is the
basis for future comparison and synchronization, is based on the relative filter
and does not function properly within the imported library.

<Filter status
bar>

Describes the filter currently applied to the tree. Located directly above the libraries
tree.

<Left pane> The entity tree for the selectedmodule. Displays the folders that are available for
selection.

Select a folder to include it in the library. contents of the selected folder are
displayed in the right pane.

Note: In the Requirements tab, you can also select individual requirements.

<Right pane> Displays the child entities of the selected folder. The contents displayedmay
change over time, according to changes made in themodule.

This pane is not displayed in the Requirements tab. All requirements are displayed
in the tree in the left pane.
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Create BaselineWizard
This wizard enables you to create a baseline for a library.

To access In the Libraries module, right-click a library and select Create Baseline.

Wizard map This wizard contains:

"Baseline Verification Page" below > "New Baseline Page" on the next page

Relevant tasks "How to Use Libraries and Baselines in ALM" on page 181

See also "Baselines Overview" on page 178

Baseline Verification Page

This wizard page enables you to view and save results of the baseline verification process.

Important
information

General information about this wizard is available here: "Create Baseline
Wizard" above.

Wizard map The "Create BaselineWizard" above contains:

"Baseline Verification Page" above > "New Baseline Page" on the next page

See also "Baselines Overview" on page 178

User interface elements are described below:

UI Element Description

Saves the Baseline Verification log in a text file.

Review the log and resolve any issues, if necessary, before continuing to create
the baseline.

Verification
results

Displays the results of the library size verification. The process checks that the
size of the library does not exceed the limit defined in Site Administration. For
more information, see the LIBRARY_FUSE parameter in the Site Configuration
tab. See theHP Application Lifecycle Management Administrator Guide for
details.
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New Baseline Page

This wizard page enables you to assign a name to the baseline.

Important
information

l General information about this wizard is available here: "Create BaselineWizard"
on the previous page.

l When you create a baseline for a library that includes tests, related entities that the
tests need to run, such as their called tests and test resources, are also included in
the baseline. These related entities do not need to be defined in the library.

l The baseline is created in a background process, andmay take some time. You
can continue working in ALM during baseline creation.

Wizard
map

The "Create BaselineWizard" on the previous page contains:

"Baseline Verification Page" on the previous page > "New Baseline Page" above

See also "Baselines Overview" on page 178

User interface elements are described below:

UI Element Description

Baseline Name The name you assign to the baseline.

Compare Baselines Tool Dialog Box
This dialog box enables you to compare two baselines in a library, or compare a baseline to the current
entities in the library. For example, you can compare baselines at different stages of development to
review and assess the impact of changes made to requirements in your project.

To access In the Libraries module, right-click a baseline, click Compare To, and choose one of
the following:

l Select Baseline. Compares the baseline you selected with another baseline in the
library. Opens the Select Baseline dialog box. Click the browse button to select a
baseline from the list.

l Current Entities. Compares the baseline you selected with the current entities in
the library.

Important
information

l ALM does not consider changes made to Target Release and Target Cycle fields
when determining whether an entity has beenmodified.

l If coverage or traceability between two entities was deleted and then added again,
those entities are consideredmodified.

l Coverage of tests or requirements in the library by entities outside of the library is
not considered when comparing baselines.

Relevant
tasks

"How to Use Libraries and Baselines in ALM" on page 181
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See also "Baselines Overview" on page 178

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Sidebar> Enables you to view comparison results for entities by module. For example, select
Tests to view comparison results for the Test Planmodule.

The sidebar displays only themodules that are included in the library.

Comparison Settings. Opens the Comparison Settings dialog box, enabling you to
define settings for comparing baselines. For more details, see "Comparison
Settings Dialog Box" on page 197.

Compare Entities. Opens a Compare Entities dialog box, enabling you to view
details of the entity in each baseline. For details, see "Compare Entities Dialog Box"
on the next page.

Export Comparison Results. Enables you to save the baseline comparison
results in .csv file format. After saving, the file opens in the default application
defined for opening .csv files on your computer, such as Microsoft Excel.

<Baseline
identification
bar>

Located at the top of each baseline pane, indicates the name of the baseline
displayed in the pane below.

Details. Opens a Details dialog box, enabling you to view details of the selected
entity stored in the baseline.

Select an entity and click theDetails button.

For example, select a requirement in one of the panes. The Requirement Details
dialog box opens and displays details of the requirement in the baseline.

Go to Next/Previous Change.Moves to the next/previous change for the selected
module.

<Counter
bar>

Located above each baseline pane, displays the number of entities that were added,
modified, deleted, or moved, according to change status.

<Left pane> Displays entities stored in the older baseline.

<Right
pane>

Displays entities stored in themore recently created baseline or current entities.

Entities Displays the library's entities in the same hierarchical structure as defined in the
selectedmodule.
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UI Element Description

Changes Indicates differences between the two baselines. Possible values include the
following:

l Added. The entity did not exist in the older baseline.
l Modified. There is a difference in the entity between the baselines.
l Absent. The entity does not exist in the newer baseline.
l Moved. The entity is in a different location in the tree structure in the newer
baseline.

l Moved and Modified. The entity has changed and has beenmoved to a different
location in the tree.

A deleted or moved entity is displayed in its original location in the tree, indicated by
a placeholder. This maintains the hierarchical structure, enabling you to compare
changes between baselines.

Compare Entities Dialog Box
This page enables you to compare an entity between two baselines in a library, or between two
libraries. In a version control enabled project, you can compare two versions of an entity.

To access Use one of the following:

l In the Compare Baselines Tool or Compare Libraries Tool dialog box, select a
modified entity and click theCompare Entities button.

l In theHistory tab > Baselines tab, select two versions and click theCompare
button.

l Version Control: In theHistory tab > Versions tab, select two versions and
click theCompare button.

Available from the followingmodules: Requirements, Business Components, Test
Plan, Test Resources

Important
information

l Changes made to Target Release and Target Cycle fields do not cause the fields
to bemarked as modified.

l Version Control:
l Compare two versions of an entity in a version control enabled project.
l Not all data and sidebar buttons are displayed. The data available depends on
the information stored under version control. For more details, see "Version
Control Overview" on page 102 and "Non-versioned Fields" on page 106.

Relevant
tasks

l "How to Use Libraries and Baselines in ALM" on page 181
l "How to Use Version Control" on page 103

See also "Baselines Overview" on page 178
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

View Enables you to select a display option for results.

<Sidebar> Enables you to view additional comparison results.

The buttons displayed depend on the type of entity you are comparing.

Note: If you are comparing a UFT entity, theQTP Comparison button is
displayed, enabling you to open theQuickTest Asset Comparison Tool. For
more information on working with UFT, refer to theHP Unified Functional
Testing User Guide.

Changes Indicates amodified field.

Note:

l Version Control: Changes to some fields are not stored under version
control. For more details, see "Non-versioned Fields" on page 106.

l For traceability and coverage, if a linked entity is marked as bothDeleted
andAdded, or is displayed as Missing on both sides, this can indicate that
the link between the entities was deleted and then added.

<Results
grid>

Displays fields and the field value stored in each version of the entity. Indicates each
field whose value has changed.

Comments
tab

Enables you to compare the contents of the Comments field stored in each version.

Rich Text
tab

Enables you to compare rich text. Each pane in the Rich Text tab indicates if rich
text has been added, deleted, or modified for the relevant entity version. You can
open or save the rich text as a file to view and compare changes.

Attachments
tab

Enables you to compare attachments stored in each version. TheChanges column
indicates if an attachment has been added, deleted, or modified. You can open or
save an attachment to view and compare changes.

Comparison Settings Dialog Box
This page enables you to define settings for comparing libraries or baselines. You can select which
fields ALM considers when determining whether an entity has beenmodified.

To access In the Compare Baselines Tool or Compare Libraries Tool, click theComparison

Settings button .

Important
information

ALM does not consider changes made to Target Release and Target Cycle fields
when determining whether an entity has beenmodified.
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Relevant
tasks

"How to Use Libraries and Baselines in ALM" on page 181

See also l "Compare Baselines Tool Dialog Box" on page 194
l "Compare Libraries Tool Dialog Box" on page 212

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Module tabs> Enable you to configure comparison settings per module.

The Comparison Settings dialog box displays tabs for modules included in the
library.

Ignored Fields ALM does not display the entity as modified based on changes made to fields
in this box.

Moves selected fields between Ignored Fields andConsidered Fields.

Tip: You can also drag the field names between panes or double-click a
field name tomove it across to the other pane.

Moves all fields between Ignored Fields andConsidered Fields.

Considered fields ALM displays the entity as modified based on changes made to fields in this
box.

Additional
considered fields

Instructs ALM to consider the entity as modified based on changes made to
the selected fields.

Note: To instruct ALM to ignore coverage, youmust clear theCoverage
check box in the Requirements tab.

Baselines Tab
This view displays baseline history for a selected entity. You can view and compare all versions of the
entity that are stored in a baseline.

To access Select an entity in the tree or grid, and click History tab > Baselines tab.

Available from the followingmodules: Requirements, Business Components, Test
Plan, Test Resources.

Relevant
tasks

"How to Use Libraries and Baselines in ALM" on page 181

See also "Baselines Overview" on page 178
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User interface elements are described below:

UI Element Description

Baseline The name of the baseline in which the entity is stored.

Library The library for which the baseline was created.

Date The date the baseline was created.

Created By The name of the user who created the baseline.

Version The version number of the entity stored in the selected baseline.

Available in version control enabled projects only.

Opens a Details dialog box, displaying read-only details for the version of the entity
stored in the selected baseline. Select an option on the sidebar to view additional
information, such as Test Coverage and Attachments. The buttons displayed depend
on the type of entity selected in the tree or grid.

Note: If you are viewing information for a UFT GUI test, clicking the Test Script
button opens the test in a UFT viewer, enabling you to view the test or open the
test in UFT. For more information, refer to theHP Unified Functional Testing
User Guide.

Opens the Compare Entities dialog box, enabling you to compare two selected
baseline versions. For details, see "Compare Entities Dialog Box" on page 196.

To compare two baseline versions, press the CTRL key and select the versions. Then
click theCompare button.

Description
for selected
baseline

The description typed by the user when creating the baseline.

Select Baselines Dialog Box
This dialog box enables you to pin a test set to a baseline. This associates the tests in the test set with
the tests stored in a baseline that you specify. When you run a test set that is pinned to a baseline,
ALM runs the versions of the tests that are stored in the specified baseline.

To access In the Test Labmodule, right-click a test set and select Pin to Baseline.

Important
information

l A pinned test set can include only tests that are included in the baseline. When you
pin a test set, ALM removes tests that are not included in the baseline from the test
set.

l A pinned test set is displayed with the pinned test set icon in the test set tree.
l When you pin a test set, ALM deletes all test runs from the test set.
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Relevant
tasks

"How to Use Libraries and Baselines in ALM" on page 181

See also "Pinned Test Sets" on page 179

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

Show Baseline Details. Opens the Baseline Details dialog box for the selected
baseline in read-only mode.

Refresh. Refreshes the libraries tree so that it displays themost up-to-date
information.

Filter/Sort. Enables you to filter the data according to the criteria that you choose. For
more details, see "Filter Dialog Box" on page 51.

<Find
box>

Enter the name of the library you want to search for and click the Find button.

Find. Searches the libraries tree for the value you specify in the Find box.

Go to Baseline by ID. Opens theGo to Baseline dialog box, enabling you to locate the
baseline in the tree according to Baseline ID.

<Libraries
tree>

Enables you to select a baseline from the libraries tree.
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Chapter 12: Imported Libraries
This chapter includes:

• Imported Libraries Overview 202
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• Troubleshooting and Limitations 215
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Imported Libraries Overview

ALM Editions: Imported libraries functionality is available for ALM Edition and Performance Center
Edition. For more information about ALM editions and their functionality, see "ALM Editions" on
page 115. To find out what edition of ALM you are using, ask your ALM site administrator.

Importing a library enables you to share or reuse an existing set of entities in projects across your
enterprise. You import a library by selecting a baseline in another library from which to import. You can
import a library from the same project, or from a different project.

When you import a library, the library is added to your libraries tree, and the library's entities are copied
to the correspondingmodules in your project. If the library includes associated entities, such as
requirements that have test coverage, this relationship is also copied. In addition, any related entities
outside of the library that the tests in the library need in order to run are also imported, such as called
tests and test resources.

Notes:

l You cannot import a library from aUnicode project to an ASCII project.
l Business Process Testing:After importing a library, do not change the content of either the
existing source library from which a baseline is synchronized, or the target library to which a
baseline is synchronized. This could result in a failure when synchronizing a baseline that
includes Business Process Testing entities.

You can compare associated libraries at all stages of the application development lifecycle. For
example, you can compare an imported library with the source library from which it was imported.
When changes aremade to entities in a library, you can synchronize libraries to update the entities in
an associated library.

Importing and synchronizing libraries requires appropriate user permissions. For details, see "How to
Share Libraries" on page 204.

Note: You can also share defects across multiple ALM projects. You share and synchronize
defects using the HP ALM Synchronizer. For more information, see theHP ALM Synchronizer
User Guide, available from the HP Application Lifecycle Management Adds-ins Page.

This section also includes:

l "Library Synchronization Overview" on the next page
l "Library Verification" on page 204
For related task details, see "How to Share Libraries" on page 204.

Imported Library Examples
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The following examples demonstrate how you can use libraries.

l Reuse requirements and tests for a new release.
While developing a new application, you create a library that includes all the entities in your
project that are relevant to the application. After work is complete, you release the new
application. As you are about to begin work on the next version, you can import the library, and
start making adjustments to requirements and tests to meet the needs of the new version.

l Create a set of requirements, tests, and resources for use by multiple applications.
Your project contains requirements in the Requirements module that are relevant to an
application you are developing. The project also contains tests in the test planmodule that you
developed to test those requirements. In addition, you have created relationships between the
requirements and tests, such as traceability and coverage. You can create a library that
represents the application. Then import this library as a self-contained component of other
applications.

l Update imported libraries with changes made in the source library.
A library in your project includes requirements and tests for a calculator application. Multiple
other projects have imported the library, and are using the application's requirements and tests
in other applications they are developing. The business analyst has revised some requirements
for the calculator application. To update the imported libraries with these changes, you can
synchronize the imported libraries with the source library.

l Update a source library with developments in an imported library.
A tester works with an imported library that contains a set of regression tests for the banking
application currently in development. During testing, she develops new tests to test the added
functionality in the new version of the banking application. When testing is complete, the tester
wants to update the regression tests in the source library. The source library can be
synchronized with the imported library to update the tests for future testing needs.

Library Synchronization Overview
You can synchronize two associated libraries to update one library with changes made in another
library. You can update an imported library with changes made in the source library. You can also
update a source library with changes made in the imported library.

Note: You cannot synchronize a library in a Unicode project with a library in an ASCII project.

During synchronization, data from the other library's baseline is copied to your library. The following
table summarizes how the entities in your library are updated:

Event in
Source
Library Event in Your Library

An entity
was
added

The entity is added.
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Event in
Source
Library Event in Your Library

An entity
was
modified

The entity is updated.

If the entity was modified in both libraries, the entity in your library is overwritten.

Version Control:A new version is created.

An entity
was
deleted

A new folder is created and the deleted entity is moved to the new folder. The new folder
is named SYNC_OBSOLETE_<library_id>_<current_date> and is located under the
module's root folder.

An entity
was
moved

The entity and its children aremoved.

Entities in a library must not be edited during synchronization. If entities in your library are being edited
by another user during the synchronization process, synchronization cannot complete successfully.

Version Control:All entities in your library must be checked in before synchronization. If an entity in
your library is checked out, synchronization cannot complete successfully.

After you synchronize libraries, a baseline is automatically created for the updated library. This baseline
is the basis for comparing the libraries at any point in time and should not be deleted.

For related task details, see "How to Share Libraries" below.

Library Verification
When you import a library, or synchronize libraries, the library is first verified. The verification process
includes the following checks:

l Requirement type check. Checks that your project contains the necessary requirement types. If
the source library contains customized requirement types, your project must contain the same
requirement types. For more information on customized requirement types, seeHP Application
Lifecycle Management Administrator Guide.

l Entities compatibility check. Checks that your project has the necessary extensions enabled. If
the source project has an extension enabled, and the source library includes entities for that
extension, your project must also have that extension enabled. For more information on extensions,
seeHP Application Lifecycle Management Administrator Guide.

l Library size check. Checks that the number of entities in the library does not exceed themaximum
defined by the LIBRARY_FUSE configuration parameter in Site Administration. For more
information, see theHP Application Lifecycle Management Administrator Guide.

How to Share Libraries
This task describes how to share libraries between projects or within a project.

To learnmore about sharing libraries, see "Imported Libraries Overview" on page 202.
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ALM Editions: Imported libraries functionality is available for ALM Edition and Performance Center
Edition. For more information about ALM editions and their functionality, see "ALM Editions" on
page 115. To find out what edition of ALM you are using, ask your ALM site administrator.

This task includes the following steps:

l "Prerequisites" below
l "Import a library" below
l "Compare libraries" on the next page
l "Synchronize libraries" on the next page
l "Monitor library tasks" on page 207

1. Prerequisites
l To import and synchronize libraries, youmust have the appropriate Library module user
permissions, as well as Create andUpdate permissions for the entity types you are importing.
In addition to these permissions, synchronizing libraries requires Delete permissions for the
entity types in the library. For more information on Library module permissions, refer to theHP
Application Lifecycle Management Administrator Guide.

l Verify that a baseline has been created for the library you want to import. For task details, see
"How to Use Libraries and Baselines in ALM" on page 181.

l Business Process Testing:Before importing a project with application areas to another
project, make sure you have connected to the destination project at least one time from within
Unified Functional Testing. For instructions, see theHP Unified Functional Testing User
Guide.

2. Import a library
Import an existing library to your libraries tree to reuse a set of entities in your project or from a
different project.

Business Process Testing:After importing a library, do not change the content of either the
existing source library from which a baseline is synchronized, or the target library to which a
baseline is synchronized. This could result in a failure when synchronizing a baseline that
includes Business Process Testing entities.

a. In the Libraries module, right-click a library folder and select Import Library. For user
interface details on the Import Library wizard, see "Import Library Wizard" on page 208.

Note: Business Process Testing:When importing libraries, components in the
Obsolete andComponent Requests folders are not included in the process.

b. Click theView Log button in the Details tab. The Log: Import Library dialog box opens and
displays progress.

Note:When the process is complete, view the log before refreshing the display. If you
refresh the display after the library is imported, theView Log button is no longer
displayed, and you cannot view the log.
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For user interface details on the Libraries module window, see "Libraries ModuleWindow" on
page 185.

c. Click theRefresh button on themodule toolbar to refresh the display. The library details are
displayed in the Details tab. For details on the available fields in the Details tab, see "Libraries
Module Fields" on page 189.

3. Compare libraries
Compare libraries to review changes made to entities in your projects over time.
a. In the libraries tree, right-click a library and select Compare To. Select a library with which to

compare, and choose one of the following:
o Latest Baseline Created. Compare the library with themost recent baseline created in

the other library.
o Select Baseline. Select a baseline in the other library with which to compare. Opens the

Select Baseline dialog box. Click the browse button to select a baseline from the list.
Available for:A source library or an imported library.
For user interface details on the Compare Libraries Tool, see "Compare Libraries Tool Dialog
Box" on page 212.

b. Click theExport Comparison Results button to save the library comparison results in
.csv file format. After saving, the file opens in the default application defined for opening .csv
files on your computer, such as Microsoft Excel.

4. Synchronize libraries
Synchronize libraries to update your library with changes made in another associated library. You
can update an imported library with changes made in the source library. You can also update a
source library with changes made in the imported library.
a. In the libraries tree, select the library that you want to update. Using the Compare Libraries

Tool, compare the library by selecting a baseline in the other library with which to synchronize.
For user interface details on the Compare Libraries Tool, see "Compare Libraries Tool Dialog
Box" on page 212.

b. In the Compare Libraries Tool, click theSynchronize button . The Library Verification
dialog box opens, displaying the verification results.
For user interface details on the Library Verification dialog box, see "Library Verification Dialog
Box" on page 214.
For concept details on library verification, see "Library Verification" on page 204.

c. Click Continue to start the synchronization. The data is copied from the other library's
baseline to your library.
If the baseline includes an entity type that it did not contain at the time of import, a parent folder
is created in your project. For example, you imported a library containing only tests, and
defined a target root folder for the Test Planmodule only. Later, requirements were added to
the source library. During synchronization, a new folder is created in the Requirements module
in your project, under the Requirements root folder, to store the newly imported requirements.

d. Close the Compare Libraries Tool dialog box. Synchronization continues in a background
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process, andmay take some time. You can continue working in your project during the
synchronization process.

e. Click theView Log button in the Details tab. The Log: Synchronize Libraries dialog box opens
and displays progress.
For user interface details on the Libraries module window, see "Libraries ModuleWindow" on
page 185.

f. Click theRefresh button on themodule toolbar to refresh the display. When the process
completes, the Last Synchronization date is updated in the Imported By or Imported From
tab.

5. Monitor library tasks
When you import or synchronize libraries, these tasks are performed in the background, enabling
you to continue working in your project while the processes are running. You can view the status
and progress of all asynchronous tasks for the project using the Task Manager.

On the ALMmasthead, click and select Task Manager. For user interface details, see "Task
Manager Dialog Box" on page 41.

Imported Libraries User Interface
This section includes:

• Import Library Wizard 208
• Imported By Tab 210
• Imported From Tab 211
• Compare Libraries Tool Dialog Box 212
• Library Verification Dialog Box 214
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Import LibraryWizard
This wizard enables you to import a library to share and reuse an existing set of entities. You import a
library by selecting a baseline in another library from which to import. You can import a library from the
same project or from a different project.

To access In the Libraries module, right-click a library folder and select Import Library.

Important
information

l Importing libraries requires appropriate user permissions, including: Import
library, Capture baseline, andCreate andUpdate permissions for the entity
types you are importing. For more information on user permissions, refer to theHP
Application Lifecycle Management Administrator Guide.

l After you import a library, a baseline is automatically created for the new library in
your project. This baseline is the basis for comparing the libraries at any point in
time and should not be deleted.

ALM Editions: Imported libraries functionality is available for ALM Edition and
Performance Center Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

Relevant
tasks

"How to Share Libraries" on page 204

Wizard
map

This wizard contains:

"Select a Baseline Page" below > "Library Verification Page " on the next page >
"Select Target Root Folders Page" on page 210

See also l "Imported Libraries Overview" on page 202
l "Libraries Overview" on page 178
l "Troubleshooting and Limitations" on page 215

Select a Baseline Page

This wizard page enables you to select a baseline in the library you are importing.

Important
information

General information about this wizard is available here: "Import Library Wizard"
above.

Wizard map The "Import Library Wizard" above contains:

"Select a Baseline Page" above > "Library Verification Page " on the next page >
"Select Target Root Folders Page" on page 210

See also "Baselines Overview" on page 178
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User interface elements are described below:

UI Element
(A - Z)

Description

Description A description of the library you are importing.

Domain The domain in which the library you are importing is located.

From
Current
Project

Enables you to import a library from the project in which you are working.

From
Project

Enables you to select a domain and project from which to import a library.

Note: ASCII projects can only import libraries from ASCII projects.

Project The project in which the library you are importing is located.

Select a
Baseline

Enables you to select a baseline from which to import the library. Click the browse
button to display the libraries tree in the selected project. Only libraries that can be
imported are displayed. You cannot import an imported library.

Library Verification Page

This wizard page enables you to view results of the library verification process.

Important
information

l General information about this wizard is available here: "Import Library Wizard"
on the previous page.

l If any of the verification checks have the status Failed, you cannot proceed with
the import process. Click Cancel.

Wizard map The "Import Library Wizard" on the previous page contains:

"Select a Baseline Page" on the previous page > "Library Verification Page " above
> "Select Target Root Folders Page" on the next page

See also "Library Verification" on page 204

User interface elements are described below:

UI Element Description

Verification
Results

Displays the verification results and the list of fields to be imported. The import
process can continue if all verification checks have the status Passed.
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Select Target Root Folders Page

This wizard page enables you to select a location in your project for each of the root folders you are
importing.

Important
information

l General information about this wizard is available here: "Import Library Wizard" on
page 208.

l You cannot import a library under the same previously imported library. For more
details, see "Troubleshooting and Limitations" on page 215.

l The library is imported in a background process, andmay take some time. You
can continue working in your project during the import process.

Wizard map The "Import Library Wizard" on page 208 contains:

"Select a Baseline Page" on page 208 > "Library Verification Page " on the previous
page > "Select Target Root Folders Page" above

User interface elements are described below:

UI Element
(A - Z)

Description

Description A description for the library. By default, if the source library and baseline contain
descriptions, the descriptions are displayed.

Name The name of the library. By default, the name of the library from which you are
importing is displayed with the suffix _Imported.

Select
Target
Root
Folders

The location in your project for each of the imported folders. For example, in the
Requirement Root Folder box, specify a location for the imported requirements. All
of the requirement folders defined in the library are imported under the requirement
folder you specify. Click the browse button to display the requirements tree in your
project. Select a folder or create a new folder for the imported requirements.

Note: If the library you are importing contains tests, the baseline automatically
includes related entities that the tests need to run, such as test resources. In this
case, the Resource Root Folder box is also displayed, enabling you to select a
target folder for the imported test resources.

Imported By Tab
This tab displays a list of projects that imported a selected library.

To access Select a library in the libraries tree and click the Imported By tab.
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Important
information

You can rearrange columns in the grid by dragging the column headers.

ALM Editions: Imported libraries functionality is available for ALM Edition and
Performance Center Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

Relevant
tasks

"How to Share Libraries" on page 204

User interface elements are described below:

UI Element Description

Refresh. Refreshes the tab so that it displays themost up-to-date information.

Send mail. Sends an email with details about the selected library. For more
details, see "Send E-mail Dialog Box" on page 69.

Compare To. Compares the source library selected in the libraries tree with a
library that imported the source library.

Select an imported library in the grid and click Compare To. Select a baseline in
the imported library with which to compare.

Domain The domain in which the imported library is located.

Project The name of the project that imported the library.

Library Name The name of the imported library.

Source Baseline
Name

The initial value indicates the name of the baseline in the source project from
which the selected library was imported. After synchronization, indicates the
name of the baseline in the source project with which the selected library was
synchronized.

Import Date The date the library was imported.

Last
Synchronization

The date of themost recent synchronization of the imported and source libraries.

Library Owner The user name of the person who imported the library.

Imported FromTab
This tab displays details of the source library from which a selected library is imported.

To access Select an imported library in the libraries tree and click the Imported From tab. This
tab is visible only when the selected library is imported.
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Important
information ALM Editions:Imported libraries functionality is available for ALM Edition and

Performance Center Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

Relevant
tasks

"How to Share Libraries" on page 204

User interface elements are described below:

UI Element Description

Send Mail to Owner. Sends an email to the source library owner. For more
details, see "Send E-mail Dialog Box" on page 69.

Compare To Source. Compares the selected library with the library from which
it was imported. Select a baseline in the source library with which to compare.

Domain The domain in which the source project is located.

Project The name of the source project.

Library Name The name of the library in the source project.

Baseline Name The name of the baseline in the source project from which the project was
imported.

Last
Synchronization

The date of themost recent synchronization of the imported and source libraries.
When the library is first imported, the value of this field is N/A.

Source Library
Owner

The user name of the person who created the library in the source project.

Compare Libraries Tool Dialog Box
This dialog box enables you to compare two associated libraries. You can compare an imported library
with the source library from which it was imported.

To access In the libraries tree, right-click a library and select Compare To. Select a library with
which to compare, and choose one of the following:

l Latest Baseline Created. Compare the library with themost recent baseline
created in the other library.

l Select Baseline. Select a baseline in the other library with which to compare.
Opens the Select Baseline dialog box. Click the browse button to select a baseline
from the list.

Available for: a source library or an imported library
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Important
information

l Changes made to Target Release and Target Cycle fields are not considered
when determining whether an entity has beenmodified.

l If coverage or traceability between two entities was deleted and then added again,
those entities are consideredmodified.

l Coverage of tests or requirements in the library by entities outside of the library is
not considered when comparing libraries.

ALM Editions:Imported libraries functionality is available for ALM Edition and
Performance Center Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

Relevant
tasks

"How to Share Libraries" on page 204

See also "Library Synchronization Overview" on page 203

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Sidebar
buttons>

Enable you to view comparison results for entities by module. For example, click
the Tests button to view comparison results for the Test Planmodule.

The sidebar displays only themodules that are included in the library.

Comparison Settings. Opens the Comparison Settings dialog box, enabling you
to define settings for comparing libraries. For more details, see "Comparison
Settings Dialog Box" on page 197.

Compare Entities. Opens a Compare Entities dialog box, enabling you to view
details of the entity in each library. For details, see "Compare Entities Dialog Box"
on page 196.

Synchronize. Updates your library, displayed in the left pane, with changes
indicated in the baseline displayed in the right pane.

For more details, see "Library Synchronization Overview" on page 203.

Note: Synchronizing libraries requires the appropriate user permissions. For
details, see "How to Share Libraries" on page 204.

Export Comparison Results. Enables you to save the library comparison results
in .csv file format. After saving, the file opens in the default application defined for
opening .csv files on your computer, such as Microsoft Excel.

<Identification
bar>

Located at the top of each pane, indicates the name of the library or baseline
displayed in the pane below.

Go to Next/Previous Change.Moves to the next/previous change for the
selectedmodule.

User Guide
Chapter 12: Imported Libraries

HP ALM (12.50) Page 213



UI Element Description

<Sidebar
buttons>

Enable you to view comparison results for entities by module. For example, click
the Tests button to view comparison results for the Test Planmodule.

The sidebar displays only themodules that are included in the library.

Details. Opens a Details dialog box, enabling you to view details of the selected
entity.

Select an entity and click theDetails button.

For example, select a requirement in one of the panes. The Requirement Details
dialog box opens and displays details of the requirement in the selected library or
baseline.

<Counter
bar>

Located above each pane, displays the number of entities that were added,
modified, deleted, or moved, according to change status.

<Left pane> Displays the library you selected in the libraries tree.

Entities Displays the library's entities in the same hierarchical structure as defined in the
selectedmodule.

Changes Indicates differences between the two libraries. Possible values include the
following:

l Added. The entity does not exist in the other library.
l Modified. The entity has beenmodified in the library.
l Absent. The entity does not exist in the library.
l Moved. The entity is in a different location in the tree structure in the library.
l Moved and Modified. The entity has changed and has beenmoved to a
different location in the tree.

A deleted or moved entity is displayed in its original location in the tree, indicated
by a placeholder. In addition, a placeholder is displayed in the tree where an entity
was added in the other library. This maintains the hierarchical structure, enabling
you to compare changes between the libraries.

<Right pane> Displays the baseline in the library with which you are comparing.

Library Verification Dialog Box
This dialog box enables you to view results of the library verification process when synchronizing
libraries.

To access In the Compare Libraries Tool dialog box, click theSynchronize button.
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Important
information

If any of the verification checks have the status Failed, you cannot proceed with the
synchronization. Click Cancel.

ALM Editions: Imported libraries functionality is available for ALM Edition and
Performance Center Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

Relevant
tasks

"How to Share Libraries" on page 204

See also "Library Verification" on page 204

User interface elements are described below:

UI Element Description

Verification
Results

Displays the verification results and the list of fields to be imported. The
synchronization process can continue only if all verification checks have the status
Passed.

Continue Starts the synchronization process. The data is copied from the other library's
baseline to your library.

Synchronization continues in a background process, andmay take some time. To
continue working in your project during the synchronization process, close the
Compare Libraries Tool dialog box.

Troubleshooting and Limitations
You cannot import a library under the same previously imported library. This applies in the
requirements, test plan, or test resources tree.

For example, in the requirements tree, the Travel Application folder is an imported library. If you want to
import the Travel Application library again, you cannot define the Travel Application folder or any of its
child folders as the root folder for the requirements in the library.
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Chapter 13: Introducing Requirements
This chapter includes:

• Requirements Overview 220
• How to Use Requirements in ALM 220
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Requirements Overview
Requirements describe in detail what needs to be solved or achieved tomeet the objectives of your
application under development. Clearly and correctly defining requirements at the front end of a project
provides the following advantages:

l Provides guidelines of what the priorities are to stakeholders
l Sets clear expectations among stakeholders
l Cuts waste and eliminates unnecessary expenditure
The Requirements module enables you to define, manage and track requirements at all stages of the
application lifecycle management.

For task details, see "How to Use Requirements in ALM" below.

How to Use Requirements in ALM
This task describes how to create andmanage requirements in ALM.

To learnmore about requirements, see "Requirements Overview" above.

Note: This task is part of a higher-level task. For details, see "ALM Basic Flow" on page 22.

This task includes the following steps:

l "Prerequisites" below
l "Create requirements" on the next page
l "Import business process models" on the next page
l "Trace requirements" on the next page
l "Calculate risk" on the next page
l "Create coverage" on the next page
l "Link to defects" on page 222
l "Assign to releases" on page 222
l "Analyze requirements" on page 222
l "Establish baseline" on page 222

1. Prerequisites
Determine the requirements scope by gathering information such as functional and technical
specifications, marketing and business requirements documents, and stakeholders goals.

Example

Some questions youmay want to ask are:
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l What is themain purpose and direction of the application?
l What are the critical constraints of the application?
l What are themajor features of the application?
l What is the relative importance of each element in the application functionality?
l What are the critical or high-risk functions of the application?
l What are your business or testing priorities?
l Do your customers/end-users agree with your priorities?
l What are your overall quality goals?

2. Create requirements
Define a hierarchical framework for your requirements scope by creating a requirements tree.
Define different groups of requirements in the requirements tree. For each requirement group, you
create a list of detailed requirements in the requirements tree. Each requirement in the tree can
include any relevant attachments and rich text documents.
You then assign the requirement a priority level which can be taken into consideration when
creating the test plan.
For task details, see "How to Create Requirements" on page 224.

3. Import business process models
If you work with business process models, you can create a framework of requirements by
importingmodels created with standardmodeling tools. The Business Models module enables you
to analyze the quality of your business process models and business flows. For task details, see
"How toWork with Business Process Models" on page 286.

4. Trace requirements
You can add traceability between the requirements. When analyzing the impact of a change
proposed in a specific requirement, traceability shows the other requirements that the change
might affect. For task details, see "How to Trace Requirements" on page 252.
To determine the completeness of the relationships between your requirements, you can generate
a traceability matrix. For task details, see "How to Use the Traceability Matrix" on page 260.

5. Calculate risk
Use risk-based quality management to calculate at which level to test each requirement, based on
the nature of the requirement and the resources you have available. For task details, see "How to
Assess Risk" on page 270.

6. Create coverage
Create coverage between your requirements and tests to ensure that all requirements are
implemented in the project. For task details, see "How to Create Coverage" on page 376.
You can also create coverage by converting requirements to tests in the test plan tree. Coverage
is automatically created between the requirements and their corresponding tests. For task details,
see "How to Create Requirements" on page 224.
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7. Link to defects
You can link a requirement to specific defects. This is useful, for example, when coverage is
created between requirements and tests. Linking defects can help you ensure compliance with
your requirements and testing needs. If a requirement changes, you can immediately identify
which tests and defects are affected, and who is responsible.
For user interface details, see "Linked Defects/Entities Page" on page 710.

8. Assign to releases
Assign requirements to releases or cycles defined in the releases tree in the Releases module.
l Assign to release. Right-click a requirement and select Assign to Release. For user
interface details, see "Select Releases Dialog Box" on page 142.

l Assign to cycle. Right-click a requirement and select Assign to Cycle. For user interface
details, see "Select Cycles Dialog Box" on page 141.

9. Analyze requirements
Review your requirements to ensure that they meet the defined requirements scope. After a
requirement is approved, you change the status of a requirement from Not Reviewed to
Reviewed.
To help review the requirements, you can generate reports and graphs. For task details, see "How
to Analyze Data in ALM" on page 718.

10. Establish baseline
Create a baseline to sign off on or compare significant milestones in your application lifecycle. For
task details, see "How to Use Libraries and Baselines in ALM" on page 181.
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Chapter 14: Requirements Specification
This chapter includes:

• Requirements Specification Overview 224
• How to Create Requirements 224
• Requirements User Interface 225
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Requirements Specification Overview
Requirements are recorded in the Requirements module by creating a requirements tree. The
requirements tree is a graphical representation of your requirements specification, displaying the
hierarchical relationship between different requirements. The tree includes different groups of
requirements based either on requirement type or functional area.

For each requirement group, you create a list of detailed requirements in the requirements tree. Each
requirement in the tree is described in detail and can include any relevant links and attachments.

After creating a requirements tree, the requirements can be used as a basis for defining tests in your
test plan tree.

For task details, see "How to Create Requirements" below.

How to Create Requirements
This task describes how to define and update your requirements in the Requirements module. After you
have created a requirements tree, you can use the requirements as a basis for defining the tests in your
test plan tree.

To learnmore about creating requirements, see "Requirements Specification Overview" above.

Note: Higher-level task: This task is part of a higher-level task. For details, see "How to Use
Requirements in ALM" on page 220.

This task includes the following steps:

l "Create requirements" below
l "Import requirements - optional" below
l "Update requirements" on the next page
l "Convert requirements to tests - optional" on the next page

1. Create requirements
a. Open the Requirements module. On the ALM sidebar, underRequirements, select

Requirements. In theViewmenu, select Requirements Tree.
For user interface details on the Requirements module, see "Requirements ModuleWindow"
on page 226.

b. Create folders. Click theRequirements root folder and select New Folder. To create a sub-
folder, click a folder and select New Folder. In the New Requirement Folder dialog box, type
a folder name.

c. Add requirements. Right-click a requirement folder and select New Requirement. To create
a sub-requirement, right-click a requirement and select New Requirement. For user interface
details, see "New Requirement Dialog Box" on page 244.

2. Import requirements - optional
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In addition to creating requirements directly in ALM, you can also import requirements to your ALM
project fromMicrosoft Word or Microsoft Excel. To import requirements, youmust first install the
appropriate add-in. For more information, see "Data Import fromMicrosoft Word andMicrosoft
Excel " on page 26.

3. Update requirements
For each requirement, you can update its details, attachments, and rich text documents. Right-
click a requirement and select Requirement Details. The Requirement Details dialog box opens.
For user interface details, see "Requirement Details Page" on page 243.

4. Convert requirements to tests - optional
To assist you in establishing a test plan tree in the Test Planmodule, you can use your
requirements as a basis for defining your tests. You can reuse your requirements and convert
them to the following entities in your test plan tree: test subjects, tests, test steps, or step
descriptions.
To convert requirements to test subjects, tests, test steps, or step descriptions, right click a
requirement or folder and select Convert to Tests. The Convert to Tests wizard opens. For user
interface details, see "Convert to Tests Wizard" on page 246.

Requirements User Interface
This section includes:

• Requirements ModuleWindow 226
• Requirements ModuleMenus and Buttons 228
• Requirements Module Icons 235
• Requirements Module Fields 237
• Requirement Details Page 243
• New Requirement Dialog Box 244
• Convert to Tests Wizard 246
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Requirements ModuleWindow
This window enables you to define andmaintain ALM requirements.

To access On the ALM sidebar, underRequirements, select Requirements. Select a
requirements view from theViewmenu.

Relevant
tasks

"How to Create Requirements" on page 224

See also "Requirements Specification Overview" on page 224

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

View l Requirements Tree. Enables you to view your requirements hierarchically in
a tree.

l Requirement Details. Enables you to create links between requirements
and other entities. It also enables you to calculate and analyze requirement
risks. For more details, see "Requirement Details Page" on page 243.

l Requirements Grid. Enables you to view requirements in a flat non-
hierarchical view. Each line in the grid displays a separate requirement.

l Coverage Analysis. Enables you to analyze the breakdown of child
requirements according to test coverage status. For more details, see
"Coverage Analysis View" on page 378.

l Traceability Matrix. Enables you to view traceability relationships between
requirements and other requirements or tests in amatrix. For more details,
see "Traceability Matrix View" on page 262.

<Requirements
module
common UI
elements>

l Requirement fields. For field definitions, see "Requirements Module Fields"
on page 237.

l Requirement menus and buttons. For command and button descriptions,
see "Requirements ModuleMenus and Buttons" on page 228.

l Requirement icons. For icon descriptions, see "Requirements Module
Icons" on page 235.

l ALM masthead, menus, and sidebar. For details, see "ALM Common
Areas" on page 32.

<Requirements
tree>

Located on the left side of the window, organizes and displays your
requirements hierarchically.

Available from: Requirements Tree, Requirement Details, and Coverage
Analysis
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UI Element Description

<Filter status
bar>

Describes the filter currently applied to the grid or tree. Located directly above
the grid filter boxes or tree.

In grid views:

l Showing <x> results. Indicates the number of records currently displayed
out of the total records.

l Retrieve all <x> results. Click to display all records.

Attachments tab Lists attachments that provide additional information about the currently
selected requirement. For more details, see "Attachments Page" on page 72.

Business
Models Linkage
tab

Lists the business model entities linked to the currently selected requirement.
For more details, see "Business Models Linkage Tab" on page 384.

Comments tab Comments about the currently selected requirement.

Click in the text box to display a toolbar for formatting and spell checking the
text.

Description tab Describes the currently selected requirement.

Click in the text box to display a toolbar for formatting and spell checking the
text.

Details tab Details the currently selected requirement.

History tab Lists changes made to the currently selected requirement. For more details, see
"History Tab" on page 68.

Linked Defects
tab

Lists the defects linked to the currently selected requirement. For more details,
see "Linked Defects/Entities Page" on page 710.

Represented
Items

Lists the business process model entities represented by the selected
requirement.

Available from:Business Model requirements

Requirements
Traceability tab

Lists the requirements linked to the currently selected requirement. For more
details, see "Relationships Tab" on page 254 and "Impact Analysis Tab" on
page 256.
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UI Element Description

Rich Text tab Enables you to add, view, and edit rich text using an HTML editor from within
ALM.

Note:

l Changes youmake to the rich text for a requirement are saved
automatically when youmove to a different requirement or a different
module.

l If your project was upgraded from a previous version of Quality Center,
rich text that existed before the upgrade is saved as an attachment to the
requirement, accessible from the requirement's Attachments tab.

For details on defining rich text templates, see theHP Application Lifecycle
Management Administrator Guide.

Risk
Analysis/Risk
Assessment tab

Calculates and analyzes risk for the currently selected requirement. For more
details, see "Risk Assessment Tab" on page 273 and "Risk Analysis Tab" on
page 277.

Test Coverage
tab

Lists the tests associated with the currently selected requirement. For more
details, see "Test Coverage Page" on page 385.

Requirements Module Menus and Buttons
This section describes themenus and buttons available in the Requirements module.

To access On the ALM sidebar, underRequirements, select Requirements.

Important
information

l Somemenu commands and buttons are not available in all requirement views.
l Tip: You can access themenu bar from the Requirements module by

pressing the shortcut key ALT.

l Version Control:Additional menu commands and buttons are available in a
version control enabled project. For details, see "Versions Menu and Buttons" on
page 108.

Relevant
tasks

"How to Create Requirements" on page 224

See also "Requirements Module Icons" on page 235

"Requirements Specification Overview" on page 224
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A - Z)

Menu Description

<list of
recently used
favorite
views>

Favorites Displays the four most recently used favorite views in the
Requirements module.

You can define the number of views displayed on themenu by
setting the FAVORITES_DEPTH parameter in the
Site Configuration tab in Site Administration. For details, see the
HP Application Lifecycle Management Administrator Guide.

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite
view to your private or the public folder. For details, see "Add
Favorite Dialog Box" on page 94.

Alerts Edit Opens the Alerts dialog box, enabling you to display alerts for the
requirements. For details, see "Alerts Dialog Box" on page 88.

Assign to
Cycle

Requirements Opens the Select Cycles dialog box, enabling you to assign
selected requirements to cycles. For more details, see "Select
Cycles Dialog Box" on page 141.

Assign to
Release

Requirements Opens the Select Releases dialog box, enabling you to assign
selected requirements to releases. For more details, see "Select
Releases Dialog Box" on page 142.

Attachments <right-click
menu>

Opens the Attachments page, enabling you to add attachments to
the selected requirement. For details, see "Attachments Page" on
page 72.

Clear Alerts Edit Clears displayed alerts for themodule. For more details, see "How
to Use Alerts" on page 86.

Clear Follow
Up Flag

Edit Clears a follow up flag of a selected requirement. For details on
follow up flags, see "Follow Up Flags Overview" on page 85.

Collapse View Collapses all branches in the requirements tree.

Configure
Traceability
Matrix

Edit Opens the Configure Traceability Matrix wizard, enabling you to
set the entities displayed thematrix. For more details, see
"Configure Traceability Matrix Wizard" on page 265.

Available from: Traceability Matrix

Convert to
Tests

Requirements Opens the Convert to Tests wizard, enabling you to convert
selected requirements to tests in a specified subject in the test
plan tree. For more details, see "Convert to Tests Wizard" on
page 246.
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UI Element
(A - Z)

Menu Description

Copy
URL/Paste

Edit Copies a selected requirement and pastes its URL as a link. The
requirement itself is not copied. Instead, you can paste the
address into another location, such as an email or a document.
Clicking the link opens ALM and takes you to the requirement. If
you are not already logged in, ALM first prompts for login details.

Copy/Paste Edit Copies selected requirements within the same project or across
projects. When you copy a requirement, any children of the
requirement are also copied.

Note:

l Test coverage, defect linkage, and risk-based quality
management data for the requirement are not copied.

l To copy a requirement with traceability, youmust also
copy its associated traced requirements.

l The root folder cannot be copied within the same project.
l If you paste a requirement that has the same name as an
existing requirement, the suffix _Copy is added
automatically to the end of the requirement's name.

l Not available in all views.

Coverage
Analysis

View Displays the Coverage Analysis view, enabling you to analyze the
breakdown of child requirements according to test coverage
status. For details, see "Coverage Analysis View" on page 378.

Cut/Paste Edit Moves selected requirements to a different location in the
requirements tree.

Note: Moving a requirement to a different location in the
requirements tree alsomoves its child requirements, tests
coverage, requirement traceability links, and defects linkage.
The root folder cannot bemoved.

Tip: You can alsomove a requirement to a new location by
dragging it. In the requirements tree, click a requirement and
drag it under a folder or a requirement.

Delete
Edit Deletes selected requirements. Deleting a requirement also

deletes its child requirements, tests coverage, requirement
traceability links, and defects linkage. You cannot delete the root
folder.

Version Control:Deleting a requirement deletes all previous
versions of the requirement.
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UI Element
(A - Z)

Menu Description

Expand All View Expands all branches in the requirements tree.

Export Requirements Opens the Export Coverage Analysis dialog box, enabling you to
save the Coverage Analysis view to aMicrosoft Word document.
The document displays a bar graph for each parent requirement in
the requirements tree.

Available from: Coverage Analysis

Export <right-click
menu>

Opens the Export All Grid Data dialog box, enabling you to export
the requirements in a grid as a text file, Microsoft Excel
worksheet, Microsoft Word document, or HTML document.

Choose one of the following options:

l All. Exports all requirements in the grid.
l Selected. Exports selected requirements in the grid.
Available from: Requirements Grid

Export
Traceability
Matrix

Analysis Opens the Export Traceability Matrix dialog box, enabling you to
save the Traceability Matrix view to aMicrosoft Excel worksheet.

Available from: Traceability Matrix

Filter/Sort View Enables you to filter and sort the requirements in the requirements
tree or grid. For more details, see "Filter Dialog Box" on page 51.

Find Edit Searches for a requirement in the Requirements module. For more
details, see "Find Dialog Box" on page 63.

Find Next Edit Searches for the next item in the requirements grid that meets the
previously defined search criteria.

Available from: Requirements Grid

Flag for
Follow Up

Edit Opens the Flag For Follow Up dialog box, enabling you to define a
follow up flag for a selected requirement. For more details, see
"Flag For Follow UpDialog Box" on page 89.

Go to
Requirement

Requirements Opens the Go ToRequirement dialog box, enabling you to find a
specific requirement by ReqID. To display the requirement in the
requirements tree, click Show in Tree. To display the requirement
in the Requirement Details dialog box, click Open Details. You
can only go to requirements that are in the current filter.
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UI Element
(A - Z)

Menu Description

Go To
Requirement
in
Requirements

Tree

<right-click
menu>

Goes to the Requirements Tree view and highlights the selected
requirement.

Available from: Requirements Grid and Traceability Matrix

Graphs Analysis Lists the graphs you can generate for requirements data. Select a
predefined graph, or launch the graph wizard.

For details on the predefined graph types, see "Entity Graph
Types" on page 739.

Grid Filters View Displays a grid filter box under each column name, enabling you to
define a filter condition for a column.

Type directly into the box, or click the box to display the browse
button, which opens the Select Filter Condition dialog box. For
more details, see "Select Filter Condition Dialog Box" on page 61.

Available from: Requirements Grid

Indicator
Columns

View Displays the columns on the left-side of the
requirements window.

For more details, see "Requirements Module Icons" on page 235.

Information
Panel

View Displays information panel tabs on the bottom of the requirement
view. For more details, see "Requirements ModuleWindow" on
page 226.

Available from: Coverage Analysis, Requirements Grid, and
Requirements Tree

Invert
Selection

Edit Unselects all previously selected requirements in the grid and
selects all previously unselected requirements.

Available from: Requirements Grid

Most
Recently
used

Analysis Lists themost recently viewed reports and graphs in ALM.
Displays up to ten items.
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UI Element
(A - Z)

Menu Description

Move Down

Move Up

Enables you tomove selected requirements in the requirements
tree up or down to set their order.

Note: TheMove Up andMove Down buttons are not
available if the requirements in the requirements tree are
already sorted using the View Order tab in the Filter dialog
box. For more details on the View Order tab, see "Filter Dialog
Box" on page 51.

Available from: Requirements Tree, Requirement Details, and
Coverage Analysis

New Folder Requirements Opens the Create New Requirement Folder dialog box, enabling
you to add a folder under a selected folder.

Available from: Requirements Tree, Requirement Details, and
Coverage Analysis

New
Requirement

Requirements Opens the New Requirement dialog box, enabling you to add a
requirement under a selected requirement. For more details, see
"New Requirement Dialog Box" on page 244.

Available from: Requirements Tree, Requirement Details, and
Coverage Analysis

Organize
Favorites

Favorites Opens the Organize Favorites dialog box, enabling you to organize
the list of favorite views by changing properties or deleting views.
For details, see "Organize Favorites Dialog Box" on page 95.

Pin/Unpin Pins or unpins the requirement.

Available from: Requirements Tree, Requirement Details, and
Requirements Grid.

For details, see "Pinned Items Overview" on page 98.

Private Favorites Lists the favorite views that are accessible only to the user who
created them.

Project
Report

Analysis Lists the predefined project reports you can produce on
requirements data. For details on the report types, see "Predefined
Project Reports" on page 779.

Selecting a report from the list generates a preview of the report.
The preview displays up to five entities per report section. To
generate the full report, in the upper left corner of the preview, click
the downward arrow adjacent to theGenerate button and select
the report format to generate.

Public Favorites Lists the favorite views that are accessible to all users.
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UI Element
(A - Z)

Menu Description

Refresh All View Refreshes the requirements tree or grid so that it displays the
most up-to-date requirements.

Rename Edit Renames a selected requirement. You cannot rename the root
folder.

Syntax exceptions:A requirement name cannot include the
following characters: \ ^ *

Replace Edit Replaces a requirement field value in the tree or grid. For more
details, see "Replace Dialog Box" on page 65.

Requirement
Details

View Displays the Requirement Details view, enabling you to create
links between requirements and other entities. It also enables you
to calculate and analyze requirement risks. For more details, see
"Requirement Details Page" on page 243.

Requirement

Details

Requirements Opens the Requirement Details dialog box, enabling you to
display the details of the selected requirement. For more details,
see "Requirement Details Page" on page 243.

Requirements
Grid

View Displays the Requirements Grid view, enabling you to view
requirements in a flat non-hierarchical view. Each line in the grid
displays a separate requirement.

Requirements
Tree

View Displays the Requirements Tree view, enabling you to view your
requirements hierarchically in a tree.

Select All Edit Selects all requirements in the grid.

Available from: Requirements Grid

Select

Columns

View Opens the Select Columns dialog box, enabling you to determine
which fields to display in the requirements tree or grid and their
order. For more details, see "Select Columns/Select Fields Dialog
Box" on page 77.

Send by E-

mail

Requirements Opens the Send E-mail dialog box, enabling you to send
requirement email to recipients selected from a list or to the author
of the requirement. For more details, see "Send E-mail Dialog
Box" on page 69.

Show Full
Path

View Displays the path of the requirements in the requirements tree.

Available from: Traceability Matrix
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UI Element
(A - Z)

Menu Description

Test
Coverage >
Show Add
Criteria to
Coverage

View Enables the Add Criterion Coverage dialog box. For more details,
see "Add Criterion Coverage Dialog Box" on page 391.

Available from: Requirements Tree, Requirement Details, and
Coverage Analysis

Text Search Edit Opens the text search pane in the lower part of the Requirements
module window, enabling you to search for records in predefined
fields. For more details, see "Text Search Pane" on page 66.

Traceability
Matrix

View Displays the Traceability Matrix view, enabling you to view
traceability relationships between requirements and other
requirements or tests in amatrix.

Update
Selected

Edit Opens the Update Selected dialog box, enabling you to update a
field value for multiple selected requirements in the tree or grid. For
more details, see "Update Selected Dialog Box" on page 79.

Zoom
View Changes the level of detail in the requirements tree. Includes the

following options:

Zoom In. Displays the selected requirement and includes a
heading with the hierarchical path of the requirement.

Zoom Out One Level. Undoes the previous zoom in command.

Zoom Out To Root. Enlarges to the highest hierarchical level
and display the entire requirements tree.

Global
Search

<toolbar> A global search engine enabling you to search across all or a
specific ALMmodule. It includes the followingmodules: Defects,
Requirements, Tests, Test Sets, and Analysis. For more details
on how to install and enable Global Search, see
https://hpln.hp.com/contentoffering/alm-global-search.

Requirements Module Icons
This section describes the icons available in the Requirements module.

To access On the ALM sidebar, underRequirements, select Requirements.

See also l "Requirements ModuleMenus and Buttons" on page 228
l "Requirements ModuleWindow" on page 226

The icons are described below:
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UI
Element

Description

<green asterisk>. The applicable tab is populated.

Alerts. Click to view alerts for the requirement.

l Red alert. The alert is new.
l Gray alert. The alert has already been read.
For more details, see "Alerts Dialog Box" on page 88.

Attachments. Click to view attachments for the specified requirement.

Open an attachment by selecting it from the list. If there aremore than ten attachments,
click themore attachments link to view the list in theAttachments Page. For details,
see "Attachments Page" on page 72.

Business Model Requirement. A requirement representing a business process model
entity.

Note:

l Business model requirements are created automatically for eachmodel entity
added to the Business Models module.

l You cannot change the requirement type of business model requirements.

Business Requirement. A business process requirement.

Child. A child requirement affected by a change to a selected requirement. For more
details, see "Impact Analysis Tab" on page 256.

Folder Requirement. A folder for organizing requirements.

Follow Up Flags. Click to view follow up flags for the requirement.

l Gray flag. The follow up flag is new.
l Red flag. The follow up date has arrived.
For more details, see "Flag For Follow UpDialog Box" on page 89.

Functional Requirement. A system behavioral requirement.

Group Requirement. A collection of related requirements.

Linked Defects. Click to view linked defects for the requirement. For more details, see
"Linked Defects/Entities Page" on page 710.

Parent. A parent requirement that affects a selected requirement. For more details, see
"Impact Analysis Tab" on page 256.

Recursive Relationship. The same requirement participates more than once in the
relationship. For more details, see "Impact Analysis Tab" on page 256.

User Guide
Chapter 14: Requirements Specification

HP ALM (12.50) Page 236



UI
Element

Description

Testing Requirement. A testing type requirement.

Trace From. A requirement that affects a selected requirement. For more details, see
"Impact Analysis Tab" on page 256.

Trace To. A requirement that is affected by a selected requirement. For more details, see
"Impact Analysis Tab" on page 256.

Undefined Requirement. A requirement with an undefined type.

Version Control. The requirement is checked out.

l Green lock. The requirement is checked out by the current user.
l Red lock. The requirement is checked out by another user.

Requirements Module Fields
This section describes the Requirements module fields.

To access On the ALM sidebar, underRequirements, select Requirements.

Important
information

l You can add user-defined fields and change the label of any of the fields in the
Requirements module. You can also customize project lists. For more details,
refer to theHP Application Lifecycle Management Administrator Guide.

l You can use the Script Editor to restrict and dynamically change the fields and
values in the Requirements module. For more details, refer to theHP Application
Lifecycle Management Administrator Guide.

l When you select a requirement columnwith a user name value (including user-
defined fields), ALM displays a list with the name and full name of each user. You
can search for users, sort users, group users by user group, and select users from
the users list or a group tree. For more details, see "Users List Dialog Box" on
page 62.

l Some fields are not available in all requirement views.
l Version Control:Additional fields are available in a version control enabled
project. For details, see "Version Control Fields" on page 109.

See also "Requirements ModuleWindow" on page 226

The fields are described below:

UI Element
(A - Z)

Description

Author The user name of the person who created the requirement.

Default value: Login user name.
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UI Element
(A - Z)

Description

Comments Comments about the requirement.

Click in the text box to display a toolbar for formatting and spell checking the text.

Coverage
Analysis

Graphically displays the direct cover status of the requirement and its children.
Requirements which do not match the current filter, or requirements with direct
cover status "N/A" are not counted in the analysis.

Note: If you set the coverage by cycle, ALM does not use theDirect Cover
Status field in its calculations. Instead, it uses calculated direct cover status
values based on the tests that have instances belonging to test set folders that
are assigned to cycles included in the filter. In this case, requirements that do
not have test coverage for any of the cycles in the filter are not counted in the
analysis. For more details on setting coverage by cycle, see "Analysis Settings
Dialog Box" on page 389.

Created By The user name of the person who created the requirement link.

Default value: The login user name.

Creation
Date

The date on which the requirement or requirement link was created.

Default value:Current database server date.

Creation
Time

The time at which the requirement was created.

Default value:Current database server time.

Description A description of the requirement.

Click in the text box to display a toolbar for formatting and spell checking the text.
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UI Element
(A - Z)

Description

Direct Cover
Status

The current status of the requirement, determined according to the status of the
tests associated with the requirement.

A requirement status can be one of the following:

l Blocked. One ormore tests covered by the requirement have an execution
status of Blocked.

l Not Covered. The requirement has not been linked to a test.
l Failed. One ormore tests covered by the requirement have an execution status
of Failed, and none has an execution status of Blocked.

l Not Completed. One ormore tests covered by the requirement have an
execution status of Not Completed, and none has an execution status of
Blocked or Failed. Alternatively, tests covered by the requirement have
execution statuses of Passed andNo Run, Passed andN/A.

l Passed. All the tests covered by the requirement have an execution status of
Passed.

l No Run. All the tests covered by the requirement have an execution status of No
Run.

l N/A. The current status of the requirement is not applicable.
l -----. The requirement does not have a direct cover status as it belongs to a
requirement type that does not support coverage.

Default value: The status is Not Covered.

Modified The date and time on which the requirement or requirement link was modified.

Default value: The current database server date and time.

Name The requirement name.

Old Type
(obsolete)
(formerly
Type)

The type of requirement (obsolete). In previous versions of ALM, the type could be
any value configured in the project, with typical values Change, Functional,
Guideline, Quality, Standard, and System.

This field is only available for requirements of undefined type.

Priority The priority of the requirement, ranging from low priority (level 1) to urgent priority
(level 5).

Product The component of the application on which the requirement is based.

RBQM
Business
Impact

The calculated Business Criticality for the requirement. Possible values areA
(High), B (Medium), andC (Low). This field is only in use for assessment
requirements.
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UI Element
(A - Z)

Description

RBQM
Custom
Business
Impact

The user-defined custom Business Criticality for the requirement. Possible values
areA (High), B (Medium), andC (Low). This field is only in use for assessment
requirements.

RBQM
Custom
Failure
Probability

The user-defined custom Failure Probability for the requirement. Possible values are
1 (High), 2 (Medium), and 3 (Low). This field is only in use for assessment
requirements.

RBQM
Custom
Functional
Complexity

The user-defined custom Functional Complexity for the requirement. Possible
values are 1 (High), 2 (Medium), and 3 (Low). This field is only in use for
assessment requirements.

RBQM
Custom
Risk

The user-defined custom Risk for the requirement. Possible values areA (High), B
(Medium), andC (Low). This field is only in use for assessment requirements.

RBQM
Custom
Testing
Hours

The user-defined effort required to test the requirement, measured in units defined in
Project Customization. This field is only in use for assessment requirements.

RBQM
Custom
Testing
Level

The user defined level at which to test the requirement. Possible values are 1-Full,
2-Partial, 3-Sanity, and 4-None. This field is only in use for assessment
requirements.

RBQM Date
of Last
Analysis

The date a risk-based quality management analysis was last performed on the
requirement. This field is only in use for analysis requirements.

RBQM
Effective
Business
Impact

The effective Business Criticality for the requirement. Possible values areA (High),
B (Medium), andC (Low). This field is only in use for assessment requirements.

RBQM
Effective
Failure
Probability

The effective Failure Probability for the requirement. Possible values are 1 (High), 2
(Medium), and 3 (Low). This field is only in use for assessment requirements.

RBQM
Effective
Functional
Complexity

The effective Functional Complexity for the requirement. Possible values are 1
(High), 2 (Medium), and 3 (Low). This field is only in use for assessment
requirements.
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(A - Z)

Description

RBQM
Effective
Risk

The effective Risk for the requirement. Possible values areA (High), B (Medium),
andC (Low). This field is only in use for assessment requirements.

RBQM
Estimated
RnD Effort

The user-defined estimate of the effort required to develop the requirement. This
field is only in use for assessment requirements.

RBQM
Exclude
from
Analysis

Indicates whether to exclude the requirement from risk analysis. A requirement may
be excluded from risk analysis if it belongs to a type for which risk assessments are
not available, or if you specifically exclude it from analysis.

RBQM
Failure
Probability

The calculated Failure Probability for the requirement. Possible values are 1 (High),
2 (Medium), and 3 (Low). This field is only in use for assessment requirements.

RBQM
Functional
Complexity

The calculated Functional Complexity for the requirement. Possible values are 1
(High), 2 (Medium), and 3 (Low). This field is only in use for assessment
requirements.

RBQM Risk The calculated Risk for the requirement. Possible values areA (High), B
(Medium), andC (Low). This field is only in use for assessment requirements.

RBQM
Testing
Hours

The calculated effort required to test the requirement, measured in units defined in
Project Customization. This field is only in use for assessment requirements.

RBQM
Testing
Level

The calculated level at which to test the requirement. Possible values are 1-Full, 2-
Partial, 3-Sanity, and 4-None. This field is only in use for assessment
requirements.

RBQM Use
Custom
Business
Impact

Indicates whether to use the user-defined Business Criticality, instead of the
Business Criticality calculated by ALM. This field is only in use for assessment
requirements.

RBQM Use
Custom
Failure
Probability

Indicates whether to use the user-defined Failure Probability, instead of the Failure
Probability calculated by ALM. This field is only in use for assessment
requirements.

RBQM Use
Custom
Functional
Complexity

Indicates whether to use the user-defined Functional Complexity, instead of the
Functional Complexity calculated by ALM. This field is only in use for assessment
requirements.
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UI Element
(A - Z)

Description

RBQM Use
Custom
Results

Indicates whether to use the user-defined testing effort and testing level, instead of
the values calculated by ALM. This field is only in use for assessment requirements.

RBQM Use
Custom
Risk

Indicates whether to use the user-defined Risk, instead of the Risk calculated by
ALM. This field is only in use for assessment requirements.

Req ID A unique alphanumeric ID for the requirement that is assigned automatically. The
Req ID field cannot bemodified.

Req Parent The name of the parent requirement.

Requirement
Trace ID

A unique alphanumeric ID for the requirement link that is assigned automatically.

Requirement
Type

The type of requirement.

Default values:

l Business. A business process requirement. By default, you cannot add
coverage to this requirement.

l Folder. A folder for organizing requirements. By default, you cannot add
coverage to this requirement.

l Functional. A system behavioral requirement.

l Group. A collection of related requirements.

l Testing. A system performance requirement.

l Business Model. A requirement representing a business process model
entity.

l Undefined. An undefined requirement.

Note: You can customize the default types and create your own requirement
types. For more details on customizing requirement types, refer to theHP
Application Lifecycle Management Administrator Guide.

Reviewed Indicates whether the requirement has been reviewed and approved by the person
responsible.

Target Cycle Indicates the cycle to which the requirement is assigned.

Target
Release

Indicates the release to which the requirement is assigned.

Trace
Comment

Displays comments about the requirement link.
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Requirement Details Page
This page enables you to update the details, attachments, tests coverage, requirement traceability
links, risk-based quality management settings, and defect links for any requirement. You can also view
a list of changes made to any requirement.

To
access

Use one of the following:

l In theRequirementsmodule, right-click a requirement and select Requirement
Details. The Requirement Details dialog box opens.

l Select View > Requirement Details. The Requirement Details view opens.

Relevant
tasks

"How to Create Requirements" on page 224

See also "Requirements Specification Overview" on page 224

User interface elements are described below:

UI Element Description

Save. Saves the details.

First/Previous/Next/Last Entity. Allows you to browse through the
requirements.

Available from: Requirement Details dialog box

Flag for Follow Up. Opens the Flag For Follow Up dialog box, enabling you
to define a follow up flag for the requirement. For details, see "Flag For Follow
UpDialog Box" on page 89.

Send by Email. Sends an email with the requirement details. For more
details, see "Send E-mail Dialog Box" on page 69.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Details Details the currently selected requirement. For details on the available fields,
see "Requirements Module Fields" on page 237.
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UI Element Description

Rich Text Enables you to add, view, and edit rich text using an editor from within ALM.

Note: Changes youmake to the rich text for a requirement are saved
automatically when youmove to a different requirement or a different
module.

Attachments Lists attachments that provide additional information about the currently
selected requirement. For more details, see "Attachments Page" on page 72.

Linked Defects Lists the defects linked to the currently selected requirement. For more
details, see "Linked Defects/Entities Page" on page 710.

Requirements
Traceability

Lists the requirements linked to the currently selected requirement. For more
details, see "Impact Analysis Tab" on page 256 and "Relationships Tab" on
page 254.

Test Coverage Lists the tests associated with the currently selected requirement. For more
details, see "Test Coverage Page" on page 385.

Business Models
Linkage

Lists the business model entities linked to the currently selected requirement.
For more details, see "Business Models Linkage Tab" on page 384.

Risk
Analysis/Risk
Assessment

Calculates and analyzes risk for the currently selected requirement. For more
details, see "Risk Assessment Tab" on page 273 and "Risk Analysis Tab" on
page 277.

History Displays a list of changes made to the currently selected requirement. For
more details, see "History Tab" on page 68.

In addition, this tab displays a history of baselines in which the requirement
appears. For more details, see "History Tab" on page 68.

New Requirement Dialog Box
This dialog box enables you to add a new requirement to the Requirements module.

To access In theRequirementsmodule, right-click a requirement and select New
Requirement.

Available from: Requirements Tree, Requirement Details, and Coverage
Analysis

Relevant
tasks

"How to Create Requirements" on page 224

See also "Requirements Specification Overview" on page 224
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User interface elements are described below:

UI Element Description

Clears the data.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Name Type a name for the new requirement.

Syntax exceptions:A requirement name cannot include the following characters: \
^ *

Requirement
Type

Select a requirement type. For more details on requirement types, see "Requirement
Type" on page 242.

Details Required fields are displayed in red. For details on the available requirement fields,
see "Requirements Module Fields" on page 237.

Rich Text Enables you to add, view, and edit rich text using an HTML editor from within ALM.

Note: Changes youmake to the rich text for a requirement are saved
automatically when youmove to a different requirement or a different module.

Attachments Enables you to add attachments for the currently selected requirement. For more
details, see "Attachments Page" on page 72.

Adds the new requirement to the requirements tree. The New Requirement page
remains open.

Closes the New Requirement page.
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Convert to Tests Wizard
This wizard enables you to convert requirements to tests in a specified subject in the test plan tree.
Coverage is automatically created between the requirements and their corresponding tests. You can
convert selected requirements or all requirements in the requirements tree.

To access In theRequirementsmodule, right-click a requirement in the requirements tree and
select Convert to Tests. To convert all requirements, right-click the root requirement
folder in the requirements tree and select Convert to Tests.

Important
information

l Youmust have the necessary permissions to create tests.
l The following requirement types are set so that, by default, you cannot convert
them to tests: Business, Folder, andGroup.
To enable you to convert, youmust enable test coverage for these requirement
types. For more details, see theHP Application Lifecycle Management
Administrator Guide.

Wizard
map

This wizard contains:

"Select Automatic ConversionMethod Page" below > "Manual Change Conversion
Page" on the next page > "Select Destination Path Page" on page 248

Relevant
tasks

"How to Create Requirements" on page 224

See also "Requirements Specification Overview" on page 224

Select Automatic Conversion Method Page

This wizard page enables you to choose an automatic conversionmethod. You can convert
requirements to design steps, tests, or subjects.

Important
information

General information about this wizard is available here: "Convert to Tests Wizard"
above.

Wizard
map

The "Convert to Tests Wizard" above contains:

"Select Automatic Conversion Method Page" above > "Manual Change
Conversion Page" on the next page > "Select Destination Path Page" on page 248

User interface elements are described below:

UI Element Description

Convert lowest child
requirements to design
steps

Converts all lowest level child requirements to design steps, the next
level up to tests, and all levels above to subjects.
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UI Element Description

Convert lowest child
requirements to tests

Converts all lowest level child requirements to tests and all levels
above to subjects.

Convert all
requirements to
subjects

Converts all selected requirements to subjects in the Test Planmodule.

Generate Single Test Converts requirements to tests in specified subjects in the test plan
tree.

Add Test to Test Set This option is activated whenGenerate Single Test is selected. Adds
the tests to specified test sets in the Test Labmodule.

Keep current
Requirements filter

This option is activated when the requirements are filtered. Keeps the
current filter for the requirements. Only filtered requirements are
converted.

Next Starts the conversion process. The results are displayed in the "Manual
Change Conversion Page" below.

Cancel If you are canceling before starting the conversion process, the wizard
closes.

If you are canceling after starting the conversion process, Click the
Stop button in the progress bar.

Manual Change Conversion Page

This wizard page enables you tomanually set requirements to subjects in the test plan tree, tests, test
steps, or step descriptions. You can also choose to exclude requirements from the conversion process.

Important
information

l General information about this wizard is available here: "Convert to Tests Wizard"
on the previous page.

l If you are converting a single requirement, the wizard skips this page.

Wizard
map

The "Convert to Tests Wizard" on the previous page contains:

"Select Automatic ConversionMethod Page" on the previous page > "Manual
Change Conversion Page" above > "Select Destination Path Page" on the next
page

User interface elements are described below:

UI
Element

Description

Auto
Complete
Children

Changes the level of the children of the selected parent. For example, if you change the
level of a parent from a subject to a test, the wizard changes the level of all the children
from tests to test steps.
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UI
Element

Description

Legend Provides a legend for this wizard page.

Convert to Subject. Changes the selected item to a subject in the test plan tree.
Children can then be either subjects or tests. Subject names must be unique.

Convert to Test. Changes the selected item to a test in the test plan tree. Children are
then converted to steps. Test names must be unique.

Convert to Step. Changes the selected item to a step in the test plan tree. Children are
then converted to step descriptions.

Convert to Description. Changes the selected item to a step description in the test
plan tree. Children are then converted to indented description text.

Exclude from Conversion. Excludes the selected item from the test plan tree.
Children are also excluded.

Verify Children. Changes the type of the child node according to the type of the parent
node. For example, if the parent is a test, the children are converted to steps.

Cancel If you are canceling before starting the conversion process, the wizard closes.

If you are canceling after starting the conversion process, Click theStop button in the
progress bar.

Select Destination Path Page

This wizard page enables you to define the destination subject path in the test plan tree.

Important
information

l General information about this wizard is available here: "Convert to Tests Wizard"
on page 246.

l If you are converting a single requirement, the wizard skips this page.

Wizard
map

The "Convert to Tests Wizard" on page 246 contains:

"Select Automatic ConversionMethod Page" on page 246 > "Manual Change
Conversion Page" on the previous page > "Select Destination Path Page" above

User interface elements are described below:

UI Element Description

Destination
Subject
Path

Sets the destination subject path in the Test Planmodule.

Default value: The subject folder and tests are placed in the Subject folder of the
Test Planmodule.
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UI Element Description

Test Status This field is visible whenGenerate Single Test is selected in the "Select Automatic
ConversionMethod Page" on page 246. Sets the test status for the generated test.

Default value: Design

Add to
Test Set

This field is visible whenAdd Test to Test Set is selected in the "Select Automatic
ConversionMethod Page" on page 246. Adds the test to a test set in the Test Lab
module.

Test Set. Select the test set in the Test Labmodule.

Finish Starts the conversion process. When the conversion process ends, click OK. The
page displays errors generated while converting the requirements.

Note: If you stop the conversion process, any requirements already converted
are not deleted from the test plan tree. Youmust delete themmanually.
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Chapter 15: Requirements Traceability
This chapter includes:

• Requirements Traceability Overview 252
• How to Trace Requirements 252
• Requirements Traceability User Interface 253
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Requirements Traceability Overview
Requirements traceability defines a relationship between two or more requirements. When analyzing
the impact of a change proposed in a specific requirement, the traceability links indicate the other
requirements that the changemight affect.

You can add traceability links to and from a selected requirement.

l Trace from links indicate requirements that affect a selected requirement.
l Trace to links indicate requirements that are affected by a selected requirement.
When a requirement changes, HP Application Lifecycle Management (ALM) can alert the affected
requirements. For more details on alerts, see "Alerts Overview" on page 84.

For task details, see "How to Trace Requirements" below.

How to Trace Requirements
This task describes how to define traceability links between requirements, and how to view the
associations and dependencies that exist between the requirements.

To learnmore about tracing requirements, see "Requirements Traceability Overview" above.

This task includes the following steps:

l "Define traceability links" below
l "View traceability impact" below
l "Generate a traceability matrix - Optional" below

1. Define traceability links
a. In the Requirements module, select theRequirement Details view. Click theRequirements

Traceability tab.
b. To define a traceability link, select a requirement from the requirements tree.
c. In theRelationships tab, click theAdd Requirement Traceability button to display the

requirements tree in the right pane. Add traceability links. For user interface details, see
"Relationships Tab" on page 254.

2. View traceability impact
Click the Impact Analysis tab. Review the associations and dependencies that exist between
the requirements. For user interface details, see "Impact Analysis Tab" on page 256.

3. Generate a traceability matrix - Optional
You can generate a traceability matrix to determine the completeness of the relationships between
your requirements.
In the Requirements module, select View > Traceability Matrix. Configure the traceability
matrix. For task details, see "How to Use the Traceability Matrix" on page 260.
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Requirements Traceability User Interface
This section includes:

• Relationships Tab 254
• Impact Analysis Tab 256
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Relationships Tab
This tab enables you to define relationships between requirements. It helps you understand
associations and dependencies that exist between the requirements by displaying them in a grid
structure.

To access In the Requirements module, select View > Requirement Details. Click the
Requirements Traceability tab.

Important
information

The Relationships tab shows the affected requirements excluding their child
requirements.

Relevant tasks "How to Trace Requirements" on page 252

See also "Requirements Traceability Overview" on page 252

"Impact Analysis Tab" on page 256

Trace From/Trace To Grid
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Defines traceability relationships between the requirements.

Includes the following options:

l Add Requirement Traceability or From Requirements
Tree. Displays the requirements tree in the right pane, enabling
you to add traceability links from the requirements tree to the
selected requirement. For more details, see below.

l By ID (Trace From). Opens the Trace Existing Requirement
dialog box, enabling you to add a traceability link to the Trace
From grid by typing a requirement ID.

l By ID (Trace To). Opens the Trace Existing Requirement
dialog box, enabling you to add a traceability link to the Trace
To grid by typing a requirement ID.

Remove from Traceability. Removes a traceability relationship
link from the Trace From or Trace To grid.

Tip: Press the CTRL key to select multiple links.

Refresh All. Refreshes the grids.
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UI Element Description

Select Columns. Sets column appearance and order.

Includes the following options:

l Select Column (Trace From). Opens the Select Columns
dialog box, enabling you to determine which fields to display in
the Trace From grid and their order.

l Select Column (Trace To). Opens the Select Columns dialog
box, enabling you to determine which fields to display in the
Trace To grid and their order.

For more details, see "Select Columns/Select Fields Dialog Box"
on page 77.

Go To Requirement. Displays a traced requirement in the
requirements tree.

Requirement Details. Opens the Requirement Details dialog
box, enabling you to display the details of the selected
requirement. For more details, see "Requirement Details Page"
on page 243.

Trace From pane Displays requirements that affect a selected requirement.

<requirement fields> For details on the requirement fields available from the grids, see
"Requirements Module Fields" on page 237.

Show/Hide. Shows/hides the Trace From or the Trace To pane.

Trace To pane Displays requirements that are affected by a selected
requirement.

Requirements Tree Pane
This pane enables you to add traceability links from the requirements tree to the selected requirement.

To
access

In the Requirements module, select theRequirement Details view. Click the
Requirements Traceability tab. Click theAdd Requirement Traceability button.
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User interface elements are described below:

UI
Element

Description

Add to Traceability. Adds traceability links from the requirements tree.

Includes the following options:

l Add to Traceability (Trace From). Adds selected requirements to the Trace From
grid.

l Add to Traceability (Trace To). Adds selected requirements to the Trace To grid.

Tip: You can also add traceability links by dragging a requirement in the tree to the
appropriate grid.

Show Requirement Details. Opens the Details dialog box for the selected requirement
in read-only mode.

Go to Requirement in Requirements Tree. Navigates to the selected requirements
location in the tree in the Requirements module, and highlights the requirement.

Refresh All. Refreshes the requirements tree.

Find. Searches for a specific requirement in the tree.

Type the name (or part of the name) of the requirement in the Find box and click Find. If
the search is successful, the requirement is highlighted in the tree.

Set Filter/Sort. Filters and sorts the requirements in the requirements tree. For more
details, see "Filter Dialog Box" on page 51.

Go to Requirement by ID. Opens theGo ToRequirement dialog box, enabling you to
find a specific requirement by ReqID.

Note: You can only go to requirements that are in the current filter.

Close. Hides the requirements tree in the right pane.

Impact Analysis Tab
This tab enables you to analyze the impact of requirement changes by reviewing the relationships. It
helps you understand associations and dependencies that exist between the requirements by
displaying them in a hierarchical tree structure.

To access In the Requirements module, select View > Requirement Details. Click the
Requirements Traceability tab and then the Impact Analysis tab.

Important
information

The Impact Analysis tab shows the affected parent and child requirements.
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Relevant
tasks

"How to Trace Requirements" on page 252

See also "Requirements Traceability Overview" on page 252

"Relationships Tab" on page 254

User interface elements are described below:

UI
Element

Description

Refresh All. Refreshes the tree.

Go To Requirement. Displays a traced requirement in the requirements tree.

Requirement Details. Opens the Requirement Details dialog box, enabling you to
display the details of the selected requirement. For more details, see "Requirement
Details Page" on page 243.

Legend Describes the relationships between the requirements. For more details on the
traceability icons, see "Requirements Module Icons" on page 235.

Trace
From
pane

Displays requirements that affect a selected requirement.

Show/Hide. Shows/hides the Trace From or the Trace To pane.

Trace
To pane

Displays requirements that are affected by a selected requirement.
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Chapter 16: Traceability Matrix
This chapter includes:

• Traceability Matrix Overview 260
• How to Use the Traceability Matrix 260
• Traceability Matrix User Interface 261
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Traceability Matrix Overview
The traceability matrix enables you to determine the extent of relationships between requirements and
other requirements and between requirements and tests. It helps you verify that all requirements are
met and identify changes to the scope of your requirements when they occur.

The traceability matrix lists source requirements and their associated requirements and tests. The total
number of relationships is listed for each source requirement. A low valuemay imply that the source
requirement is not associated with enough requirements or tests. A high valuemay imply that the
source requirement is too complex and can perhaps be simplified. A zero value indicates that no
relationship exists.

For task details, see "How to Use the Traceability Matrix" below.

How to Use the Traceability Matrix
This task describes how to configure and display the traceability matrix.

To learnmore about the traceability matrix, see "Traceability Matrix Overview" above.

Note: Product Feature Movie: To view amovie that demonstrates how to create a traceability
matrix, chooseHelp > Movies in the ALMmain window.

This task includes the following steps:

l "Prerequisites" below
l "Configure the traceability matrix" below
l "View the traceability matrix" below

1. Prerequisites
a. Define requirement traceability links. In the Requirements module, select View >

Requirement Details. Click theRequirements Traceability tab. Define traceability links
between requirements. For task details on how to trace requirements, see "How to Trace
Requirements" on page 252.

b. Define requirement and test coverage. Create coverage by linking requirements to tests.
You can create coverage from the Requirements or the Test Planmodule. For task details,
see "How to Create Coverage" on page 376.

2. Configure the traceability matrix
a. In the Requirements module, select View > Traceability Matrix.
b. Click theConfigure Traceability Matrix button. The Configure Traceability Matrix wizard

opens. Define thematrix. For user interface details, see "Configure Traceability Matrix
Wizard" on page 265.

3. View the traceability matrix
In the Traceability Matrix view, analyze and review the traceability links between requirements,
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and the links between requirements and tests. For user interface details, see "Traceability Matrix
View" on the next page.

Traceability Matrix User Interface
This section includes:

• Traceability Matrix View 262
• Configure Traceability Matrix Wizard 265
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Traceability Matrix View
This view enables you to analyze the traceability matrix.

To access In the Requirements module, select View > Traceability Matrix.

Important information The data displayed in the traceability matrix grid is not editable.

Relevant tasks "How to Use the Traceability Matrix" on page 260

See also "Traceability Matrix Overview" on page 260

"Configure Traceability Matrix Wizard" on page 265

Traceability Matrix Grid
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A - Z) Description

Opens the Configure Traceability Matrix wizard, enabling you to
define thematrix. For more details, see "Configure Traceability
Matrix Wizard" on page 265.

Refresh All. Refreshes thematrix so that it displays themost up-
to-date data.

Select Columns. Opens the Select Columns dialog box, enabling
you to determine which fields to display in thematrix and their
order. For more details, see "Select Columns/Select Fields Dialog
Box" on page 77.

Requirement Details. Opens the Requirement Details dialog box,
enabling you to display the details of the selected requirement. For
more details, see "Requirement Details Page" on page 243.

Go To Requirement in Requirements Tree. Goes to the
Requirements Tree view and highlights the selected requirement.

Send E-mail. Opens the Send E-mail dialog box, enabling you to
send requirement email to recipients selected from a list or to the
author of the requirement. For more details, see "Send E-mail
Dialog Box" on page 69.

Opens the Generate Traceability Matrix dialog box, enabling you to
save the Traceability Matrix view to aMicrosoft Excel worksheet.

Show/Hide. Shows/hides the lower pane of the Traceability Matrix
view.
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UI Element (A - Z) Description

<grid fields> For details on the requirement fields available from the grid, see
"Requirements Module Fields" on page 237.

Name The requirement name.

Number of linked tests The number of tests associated with a selected requirement.

Number of traced from
requirements

The number of requirements that affect a selected requirement.

Number of traced to
requirements

The number of requirements that are affected by a selected
requirement.

Show Full Path Displays the path of the requirements in the requirements tree.

Traced From Requirements Tab
This tab displays requirements that affect a selected requirement.

Important
information

This tab is available when the following options are set in the Filter By Linked
Requirements page of the Configure Traceability Matrix wizard: Include source
requirements affected by or Include source requirements not affected by. For
more details on the Filter By Linked Requirements page, see "Configure Traceability
Matrix Wizard" on page 265.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A - Z)

Description

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in thematrix and their order. For more details, see "Select
Columns/Select Fields Dialog Box" on page 77.

Requirement Details. Opens the Requirement Details dialog box, enabling you to
display the details of the selected requirement. For more details, see "Requirement
Details Page" on page 243.

<grid
fields>

For details on the requirement fields available from the grid, see "Requirements Module
Fields" on page 237.

Show
Full
Path

Displays the path of the requirements in the requirements tree.
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Traced To Requirements Tab
This tab displays requirements that are affected by a selected requirement.

Important
information

This tab is available when the following options are set in the Filter By Linked
Requirements page of the Configure Traceability Matrix wizard: Include source
requirements affecting or Include source requirements not affecting. For more
details on the Filter By Linked Requirements page, see "Configure Traceability Matrix
Wizard" on the next page.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A - Z)

Description

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in thematrix and their order. For more details, see "Select
Columns/Select Fields Dialog Box" on page 77.

Requirement Details. Opens the Requirement Details dialog box, enabling you to
display the details of the selected requirement. For more details, see "Requirement
Details Page" on page 243.

<grid
fields>

For details on the requirement fields available from the grid, see "Requirements Module
Fields" on page 237.

Show
Full
Path

Displays the path of the requirements in the requirements tree.

Linked Tests Tab
This tab displays tests that are linked to a selected requirement.

Important
information

This tab is available when the following options are set in the Filter By Linked Tests
page of the Configure Traceability Matrix wizard: Include source requirements
linked to or Include source requirements not linked to. For more details on the
Filter By Linked Tests page, see "Configure Traceability Matrix Wizard" on the next
page.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element
(A - Z)

Description

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in thematrix and their order. For more details, see "Select
Columns/Select Fields Dialog Box" on page 77.

Test Details. Opens the Test Details dialog box, enabling you to display the details of the
selected test. For more details, see "Test Details Dialog Box" on page 369.

<grid
fields>

For details on the test fields available from the grid, see "Test PlanModule Fields" on
page 366.

Show
Full
Path

Displays the path of the tests in the test plan tree.

Configure Traceability MatrixWizard
This wizard enables you configure the traceability matrix.

To
access

In the Requirements module, select View > Traceability Matrix. Click theConfigure
Traceability Matrix button or the create a configuration link, if no configuration has
been created.

Wizard
map

The wizard contains:

"Define Source Requirements Page" below > "Filter By Linked Requirements Page" on
the next page > "Filter By Linked Tests Page" on page 267

Relevant
tasks

"How to Use the Traceability Matrix" on page 260

See also "Traceability Matrix Overview" on page 260

"Traceability Matrix View" on page 262

Define Source Requirements Page

This wizard page enables you to define the source requirements.

Important
information

General information about this wizard is available here: "Configure Traceability
Matrix Wizard" above.

Wizard map The "Configure Traceability Matrix Wizard" above contains:

"Define Source Requirements Page" above > "Filter By Linked Requirements Page"
on the next page > "Filter By Linked Tests Page" on page 267
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User interface elements are described below:

UI Element Description

Clears the defined configuration.

Set Filter/Sort. Filters and sorts the source requirements in the
Requirements module. For more details on filtering, see "Filter Dialog Box"
on page 51.

Note: Filter settings are not applied to child requirements.

Clear Filter. Clears the defined filter.

Filter By Linked Requirements Page

This wizard page enables you to define the requirements linked to and from the source requirements.

Important
information

General information about this wizard is available here: "Configure Traceability Matrix
Wizard" on the previous page.

Wizard
map

The "Configure Traceability Matrix Wizard" on the previous page contains:

"Define Source Requirements Page" on the previous page > "Filter By Linked
Requirements Page" above > "Filter By Linked Tests Page" on the next page

User interface elements are described below:

UI Element Description

Clears the defined configuration.

Set Filter/Sort. Filters and sorts the linked requirements.
For more details on filtering, see "Filter Dialog Box" on
page 51.

Clear Filter. Clears the defined filter.

Filter by linked requirements Filters the source requirements by linked requirements.

Include source requirements
affected by traced from
requirements

Shows the source requirements that are impacted by the
selected requirements.

Include source requirements not
affected by traced from
requirements

Shows the source requirements that are not impacted by the
selected requirements.
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UI Element Description

Include source requirements
affecting direct children and
traced to requirements

Shows the source requirements that impact their child
requirements and their traced to requirements.

Include source requirements
affecting direct children

Shows the source requirements that impact their child
requirements.

Include source requirements
affecting traced to requirements

Shows the source requirements that impact their traced to
requirements.

Include source requirements not
affecting direct children and
traced to requirements

Shows the source requirements that do not impact their child
requirements and their traced to requirements.

Include source requirements not
affecting direct children

Shows the source requirements that do not impact their child
requirements.

Include source requirements not
affecting traced to requirements

Shows the source requirements that do not impact their
traced to requirements.

Show source requirements linked
to more than <number> of the
requirements specified above

Shows the source requirements that are linked tomore than
the specified number of requirements.

Note: This option is available when one of the following
options is selected: Include source requirements
affected by or Include source requirements
affecting.

Show source requirements linked
to less than <number> of the
requirements specified above

Shows the source requirements that are linked to less than
the specified number of requirements.

Note: This option is available when one of the following
options is selected: Include source requirements
affected by or Include source requirements
affecting.

Filter By Linked Tests Page

This wizard page enables you to define the associated tests.

Important
information

General information about this wizard is available here: "Configure Traceability Matrix
Wizard" on page 265.

Wizard
map

The "Configure Traceability Matrix Wizard" on page 265 contains:

"Define Source Requirements Page" on page 265 > "Filter By Linked Requirements
Page" on the previous page > "Filter By Linked Tests Page" above
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User interface elements are described below:

UI Element Description

Clears the defined configuration.

Set Filter/Sort. Filters and sorts the linked tests. For
more details on filtering, see "Filter Dialog Box" on
page 51.

Clear Filter. Clears the defined filter.

Filter by linked tests Filters the source requirements by linked tests.

Include source requirements linked to
the following tests

Shows the source requirements that are linked to the
specified tests.

Include source requirements not linked
to the following tests

Shows the source requirements that are not linked to
the specified tests.

Show source requirements linked to
less than <number> of the tests
specified above

Shows the source requirements that are linked to less
than the specified number of tests.

Note: This option is available when the Include
source requirements linked to the following
tests is selected.

Show source requirements linked to
more than <number> of the tests
specified above

Shows the source requirements that are linked to
more than the specified number of tests.

Note: This option is available when the Include
source requirements linked to the following
tests is selected.
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Risk-Based Quality Management Overview
When planning how to test your requirements, you generally do not have unlimited resources available,
and are not able to fully test every requirement. Youmust make compromises and only partially test
requirements that have low criticality to the business, or those that have only aminor risk associated
with their implementation. The risk-based quality management feature enables you to calculate at
which level to test each requirement, based on the nature of the requirement and the resources you
have available. You can then plan your testing process based on these recommendations.

Each requirement type with risk-based quality management enabled can support either risk analysis
that is referred to as an analysis requirement, or an individual risk assessment that is referred to as an
assessment requirement.

l An analysis requirement is a requirement belonging to a type that represents higher levels in the
requirements tree hierarchy, such as the Folder type. You perform risk analysis on an analysis
requirement based on the assessment requirements under it in the requirements tree.
The risk results of multiple assessment requirements are aggregated to give an overall risk analysis
which can then be used to determine testing effort and test strategy.

l An assessment requirement is a requirement belonging to a type that represents requirements that
are children of analysis requirements and at a lower level in the requirements tree hierarchy.
Assessment requirements under a particular analysis requirement form the basis for risk analysis on
that analysis requirement.
For each assessment requirement under the analysis requirement, you can assign or calculate the
Risk and Functional Complexity.
Risk is composed of its Business Criticality and Failure Probability. Business Criticality
measures how crucial a requirement is for the business. Failure Probability indicates how likely a
test based on the requirement is to fail.
Functional Complexity indicates the complexity of the requirement's implementation.

You can enable each requirement type for risk-based quality management. For more information, see
theHP Application Lifecycle Management Administrator Guide.

You can customize default settings for risk-based quality management. For more information, see the
HP Application Lifecycle Management Administrator Guide.

For task details, see "How to Assess Risk" below.

How to Assess Risk
This task describes how to assess risk in ALM.

To learnmore about assessing risk, see "Risk-BasedQuality Management Overview" above.

This task includes the following steps:

l "Assess requirements" on the next page
l "Define testing policy settings" on the next page
l "Finalize the testing policy" on the next page
l "Analyze the testing strategy" on the next page
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1. Assess requirements
a. Display the Risk Assessment tab. In the Requirements module, chooseView >

Requirement Details. In the requirements tree, under an analysis requirement, select an
assessment requirement. Click theRisk Assessment tab. For user interface details, see
"Risk Assessment Tab" on page 273.

b. Determine Risk and Functional Complexity. Click the Assessment Questions tab. The
following sub-tabs are displayed: Business Criticality, Failure Probability, and Functional
Complexity. In each sub-tab, assign values to the set of criteria. For user interface details on
the Assessment Questions tab, see "Risk Assessment Tab" on page 273.
Instead of assigning values to each set of criteria in the Assessment Questions tab, you can
assign custom values directly to each category in theAssessment Results tab. For user
interface details on the Assessment Results tab, see "Risk Assessment Tab" on page 273.

c. For each assessment requirement under the analysis requirement, assign or calculate the
Risk and Functional Complexity.

2. Define testing policy settings
a. In the requirements tree, select the analysis requirement. Click theRisk Analysis tab. For

user interface details, see "Risk Analysis Tab" on page 277.
b. UnderAnalysis Constants, define the initial settings for testing the analysis requirement and

the assessment requirements under it. These settings include how much time to assign to a
requirement of a specific Functional Complexity were you to test it fully and how long it would
take you to perform partial or basic testing on a requirement. You also decide which level of
testing you want to perform on requirements for each Risk and Functional Complexity.
For user interface details on the Analysis Constants pane, see "Risk Analysis Tab" on
page 277.

3. Finalize the testing policy
a. Calculate the Testing Policy. In the Risk Analysis tab, click theAnalyze button to calculate

the Testing Level and Testing Time for each assessment requirement under the analysis
requirement. The Total required test time, Total allocated testing time, and Total
required development time are updated.
For user interface details on the Risk Analysis tab, see "Risk Analysis Tab" on page 277.

b. Adjust the Testing Policy. UnderAnalysis Constants, you canmake adjustments to the
testing policy to ensure that you have enough time to perform all the testing, and that no
resources are wasted.
For user interface details on the Analysis Constants pane, see "Risk Analysis Tab" on
page 277.

c. Apply results for each assessment requirement. Click theAnalysis and Apply to
Children button. The analysis is applied to all assessment requirements under the analysis
requirement that match the current filter.

4. Analyze the testing strategy
l To generate a report detailing the testing strategy of the analysis requirement, in the Risk
Analysis tab, click theReport button. TheGenerate Report dialog box opens. For user
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interface details, see "Generate Report Dialog Box" on page 281.
l To analyze the testing strategy for an assessment requirement, select an assessment
requirement from the requirements tree and click theRisk Assessment tab. The results are
displayed in the Assessment Results sub-tab. For user interface details, see "Risk
Assessment Tab" on the next page.

Risk-Based Quality Management User Interface
This section includes:

• Risk Assessment Tab 273
• Risk Analysis Tab 277
• Generate Report Dialog Box 281
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Risk Assessment Tab
This tab enables you to determine the Business Criticality, Failure Probability, and Functional
Complexity of a requirement by assigning them values directly or by assigning values to a set of
criteria.

To access Use one of the following:

l In theRequirementsmodule, select theRequirement Details view. Select an
assessment requirement and click theRisk Assessment tab.

l In theRequirementsmodule, right-click an assessment requirement and select
Requirement Details. The Requirement Details dialog box opens. Click theRisk
Assessment button.

Important
information

l If you do not determine the Business Criticality, Failure Probability, and Functional
Complexity for a requirement, ALM does not include the requirement in the risk
analysis.

l You can customize the criteria, their possible values, and how these values
determine the Business Criticality, Failure Probability, and Functional Complexity.
You can also customize how the Business Criticality and Failure Probability are
used to calculate the Risk. For more information, see theHP Application Lifecycle
Management Administrator Guide.

Relevant
tasks

"How to Assess Risk" on page 270

See also "Risk Analysis Tab" on page 277

"Risk-BasedQuality Management Overview" on page 270

Risk Assessment Tab Common Elements
Common user interface elements are described below:

UI Element Description

Assessment
Status

The current status of the assessment requirement. An assessment status can be
one of the following: Not Started, In Progress, andCompleted.

Exclude
from
Analysis

Ignores the selected assessment requirement when performing risk analysis.

Assessment Results Tab - Assessments Summary Area
This area displays the assigned or calculated values of the Risk and Functional Complexity of an
assessment requirement.
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Important
information

The Assessments Summary area shows the Risk and Functional Complexity values
calculated in the Assessment Questions tab. You can ignore these values and use
instead custom values.

Relevant
tasks

"How to Assess Risk" on page 270

See also "Assessment Questions Tab" on page 276

User interface elements are described below:

UI Element Description

Risk Calculates the risk based on the Business Criticality and Failure Probability for the
requirement.

Select Use custom to ignore the calculated value and use instead a custom value.
Possible values areA - High, B - Medium, andC - Low.

Business
Criticality

Measures how important the requirement is to your business.

Select Use custom to ignore the calculated value and use instead a custom value.
Possible values areA - Critical, B - Important, andC - Nice to Have.

Example:A requirement affecting aminor feature that is likely to be used rarely
might be assigned a Nice to Have Business Criticality, whereas a requirement
that is essential to your application's functionality would probably be assigned a
Critical Business Criticality.

Failure
Probability

Measures how likely a test on the requirement is to fail.

Select Use custom to ignore the calculated value and use instead a custom value.
Possible values are 1 - High, 2 - Medium, and 3 - Low.

Example:A requirement whose implementation involves making significant
changes across most areas of your application would probability be assigned a
High Failure Probability. In contrast, a requirement that involves changing an icon
in your application would probably not havemany associated risks, and so is
likely to be assigned a Low Failure Probability.
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UI Element Description

Functional
Complexity

Indicates the complexity of the requirement's implementation.

Select Use custom to ignore the calculated value and use instead a custom value.
Possible values are 1 - High, 2 - Medium, and 3 - Low.

Example:A requirement whose implementation involves making significant
changes to your application to enable it to communicate with other systems
probably has a high complexity and would be assigned a High Functional
Complexity. In contrast, a requirement that involves no significant changes to
enable your application to communicate with other systems would probably not
havemany associated risks, and so is likely to be assigned a Low Functional
Complexity.

Assessment Results Tab - Testing Policy Area
This area displays the conclusions of the last analysis you performed on an analysis requirement that is
the parent of the assessment requirement.

Important
information

To view and edit the testing policy of an assessment requirement in the Testing
Policy area, youmust first perform analysis on relevant analysis requirements (parent
requirements) and apply results to all assessment requirements (children
requirements) in the Risk Analysis tab.

Relevant
tasks

"How to Assess Risk" on page 270

See also "Risk Analysis Tab" on page 277

User interface elements are described below:

UI Element
(A - Z)

Description

Based on
analysis
requirement

Displays the analysis requirement on which the last analysis that included the
current requirement was performed. You can click the analysis requirement's name
to go to the analysis requirement in the requirements tree.

Calculated
Testing
Level

The level at which to test the requirement, as calculated in the last analysis that
included the current requirement.

Calculated
Testing
Time

The time allocated to test the requirement, as calculated in the last analysis that
included the current requirement.
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UI Element
(A - Z)

Description

Estimated
development
time
(optional)

The estimated time needed to develop the requirement. ALM can then calculate the
total estimated development time for an analysis requirement and its children as the
sum of the estimated development times of the children. Assigning the estimated
development time is optional, and does not affect the risk analysis.

Last
analyzed on
date

The date on which the last analysis that included the current requirement was
performed.

Use these
for the next
calculation

Overrides the calculated values in the next calculation, and instead uses custom
values.

In the Testing Level box, select the Testing Level to use for the next calculation. In
the Testing Time box, type the Testing Effort to use for the next calculation. When
you next perform an analysis that includes the current requirement, these values are
used instead of the calculated values.

Assessment Questions Tab
This tab displays lists of criteria used to determine Business Criticality, Failure Probability, and
Functional Complexity.

Relevant tasks "How to Assess Risk" on page 270

See also "Risk Analysis Tab" on the next page

User interface elements are described below:

UI Element Description

Business
Criticality/Failure
Probability/Functional
Complexity tab

Each tab lists criteria to consider when assessing each category.

criteria Lists the criteria to use for assessing a selected category.

Value Lists the possible values that can be assigned to each criterion.

Description of
Criterion

Explains the selected criterion.
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UI Element Description

Calculated Business
Criticality/
Calculated Failure
Probability/Calculated
Functional
Complexity

Updates according to the values you assigned to the criteria of the
selected category.

Note: You can ignore the value calculated on the basis of the values
for the criteria, and use instead a custom value when performing risk
analysis. In the Assessment Summary area of the Assessment
Results tab, select Use custom.

Risk Analysis Tab
This tab enables you to define the testing policy settings and to determine the total estimated testing
time for the analysis requirement and the assessment requirements under it.

To access Use one of the following:

l In theRequirementsmodule, select theRequirement Details view. Select an
analysis requirement and click theRisk Analysis tab.

l In theRequirementsmodule, right-click an analysis requirement and select
Requirement Details. The Requirement Details dialog box opens. Click theRisk
Analysis button.

Important
information

l Make sure that you have determined the Risk and Functional Complexity
categories of all assessment requirements that are located under the analysis
requirement for which you want to finalize the testing policy, and that you want to
include in the risk analysis. For more details, see "Risk Assessment Tab" on
page 273.

l You can filter the requirements tree to include only the assessment requirements
you want to include in the risk analysis. For more details on filtering, see "Filter
Dialog Box" on page 51.

l You can customize each requirement type for risk-based quality management. For
more information, see theHP Application Lifecycle Management Administrator
Guide.

l You can customize the testing policy used by default. For more details, see theHP
Application Lifecycle Management Administrator Guide.

Relevant
tasks

"How to Assess Risk" on page 270

See also "Risk Assessment Tab" on page 273

"Risk-BasedQuality Management Overview" on page 270

User Guide
Chapter 17: Risk-BasedQuality Management

HP ALM (12.50) Page 277



Risk Analysis - main area
This tab enables you to calculate the total estimated testing time for the analysis requirement and the
assessment requirements under it. The calculation is based on the testing policy defined in the
Analysis Constants pane.

Important
information

l If you do not want to use the default Testing Effort and Testing Level values when
calculating the testing policy in this main area, make sure that you have defined
custom values in the Analysis Constants pane.

l After calculating the testing policy in this main area, compare the total calculated
testing time with the resources you have available. If the resources you have
available are not sufficient to test the requirement according to the current settings,
you can change the settings in the Analysis Constants pane, and perform the
calculation again.

User interface elements are described below:

UI Element Description

Calculates the Testing Level and Testing Time for each
assessment requirement under the analysis requirement that
matches the current filter.

This calculation is based on the assessment requirements' Risk
Category, Testing Level, and Testing Time values you defined for
the analysis requirement.

Propagates the analysis results to all assessment requirements
under the analysis requirement that match the current filter.

Opens the Generate Report dialog box. For more details, see
"Generate Report Dialog Box" on page 281.

Last analyzed on The date on which the risk analysis was last performed.

Filter Determines which requirements were included in the risk analysis.
For more details on filtering, see "Filter Dialog Box" on page 51.
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UI Element Description

Scope The number of requirements included in the risk analysis. Also
provides a breakdown of which requirements were assessed,
which weremissing assessment, and which were not assessable.

To display a list of requirements not included in the analysis, click
themissing assessment or not assessable links. The Drill
DownResults dialog box opens and displays a grid with a list of
requirements in the category. For more details, see "Drill Down
Results Dialog Box" on page 766.

Tip: Themissing assessment link displays the
requirements for which you did not determine a category or
which you excluded explicitly from the analysis. Verify that
there are no requirements that should be assigned a category.
If you do not want to include a requirement in the analysis,
then exclude it from the analysis explicitly.

Total required testing time Displays the total calculated time required to test all the
assessment requirements under the analysis requirement
matching the current filter and included in the risk analysis.

Total allocated testing time The total time allocated to test the requirements included in the
risk analysis.

Total required development
time

Displays the total time required to develop all the assessment
requirements under the analysis requirement, based on the
required development time you optionally estimated for each
assessment requirement.

No. of Requirements Displays the number of sub-requirements of the analysis
requirement of each Risk Category.

To display a list of requirements included in the analysis, click a
segment in the graph. The Drill DownResults dialog box opens
and displays a grid with a list of requirements in the category. For
more details, see "Drill DownResults Dialog Box" on page 766.

Total Testing Time Displays the total calculated testing time required to test all the
requirements of each Risk Category.

To display a list of requirements included in the analysis, click a
segment in the graph. The Drill DownResults dialog box opens
and displays a grid with a list of requirements in the category. For
more details, see "Drill DownResults Dialog Box" on page 766.

Functional Complexity A legend of the Functional Complexity values displayed in the
graphs.
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Analysis Constants Pane
User interface elements are described below:

UI Element Description

Show/Hide. Shows/hides the Analysis Constants pane.

Opens the Risk-BasedQuality Management Constants Defaults dialog box,
enabling you to view the default constants in use.

Assigns default values to the constants used for the current requirement.

Testing Time (full)
per Functional
Complexity

The time needed to fully test a requirement with that Functional Complexity.
For each Functional Complexity value, type the estimated testing time.

Example:A requirement with a high Functional Complexity generally
requires more testing time as it is more likely that the requirement's
implementation contains defects.

Testing Level (Full
= 100%, None =
0%)

Defines how much Testing Time is required for a requirement as a percentage
of full testing.

In thePartial andBasic boxes, type the default Testing Time required for
partial testing and basic testing of a requirement. Express this as a
percentage of the effort required for full testing.

A requirement whose Testing Level is set toNone is not tested at all, and the
testing effort is zero.

Example: If 20 hours are required to perform full testing on a requirement
and partial testing is defined as 75% of full testing, ALM calculates that 15
hours are required to perform partial testing on the requirement.

Testing Policy (in
Hours) grid

Defines the level at which to test a requirement of each Risk and Functional
Complexity category.

To define these levels, click the arrow next to the cell in the grid. Select a
Testing Level from the available Testing Levels. The available Testing Levels
are Full, Partial, Basic, andNone. Next to each Testing Level, you can see
the estimated time needed to test a requirement at that level, based on the
Testing Efforts and Testing Levels you defined.
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Generate Report Dialog Box
This dialog box enables you to generate a report for analyzing the testing strategy for the analysis
requirement and for the assessment requirements under it.

To access Use one of the following:

l In theRequirementsmodule, select theRequirement Details view. Select an
analysis requirement and click theRisk Analysis tab. Click theReport button.

l In theRequirementsmodule, right-click an analysis requirement and select
Requirement Details. The Requirement Details dialog box opens. Click theRisk
Analysis button. Click theReport button.

Important
information

l To generate a report, youmust first save the analysis and apply it to all
assessment requirements under the analysis requirement. For more details, see
"Risk Analysis Tab" on page 277.

l To generate a report, Microsoft Wordmust be installed on your machine.
l The analysis results are only valid for the requirements at the time the analysis
was last performed. If you subsequently modify the Risk or Functional Complexity
Categories of the requirements, or the testing policy, you should re-perform the
analysis.

Relevant
tasks

"How to Assess Risk" on page 270

See also "Risk Analysis Tab" on page 277

"Risk-BasedQuality Management Overview" on page 270

User interface elements are described below:

UI Element Description

Default location The location and name of theMicrosoft Word file to which you want the data to
be exported. You can click the browse button to select a location from the
Save As dialog box.

Add report as an
attachment

Adds the report as an attachment to the analysis requirement.

Include list of
requirements in
the report

Includes a list of the requirements in the report.

Generates the report as aMicrosoft Word document.
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Chapter 18: Business Process Models
This chapter includes:

• Business Process Models Overview 284
• How toWork with Business Process Models 286
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Business Process Models Overview

ALM Editions: The ALM Business Models module is available for ALM Edition andQuality Center
Enterprise Edition. For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

The HP Application Lifecycle Management (ALM) Business Models module addresses the need for a
stronger connection between business process modeling, quality assurancemanagement, and
requirement definitions. Themodule integrates business process models into the application lifecycle.

This integration fosters collaboration between the various roles involved in the business process
modeling and testing lifecycles, thereby facilitating communication between business users and people
in more technical departments. This collaboration facilitates better business outcomes by identifying
high level activities, thus guiding the QA manager in determining the high level test requirements.

Integrating business process models into ALM involves importing business process models into ALM,
and linking requirements and tests to models, activities, and end-to-end business flows. After
executing tests, you can display quality status views on the business process model level.

To work with business process models in ALM, youmust first designmodels with standardmodeling
tools, and import themodels to ALM. For more details, see "Business Process Models File Import"
below.

In addition to the standard business process model entities, ALM enables you to perform quality testing
on end-to-end business flows ("paths"). For more details, see "Business Process Model Paths" on the
next page.

For details on working with business process models, see "How toWork with Business Process
Models" on page 286.

Business Process Models File Import
Towork with business process models in ALM, youmust first createmodels in standard BPMN or
EPC modeling tools, and export them to files.

ALM supports the followingmodel and file formats:

l BPMN 1.1 models exported toXPDL 2.0/2.1 files
l BPMN 2.0 models exported toXPDL 2.2 files
l EPC 7.1 models exported toAML files (.xml extension)
During the import process, you canmapmodel and activity attributes to ALMmemo or string fields.
This enables you to edit attribute values in ALM.

For eachmodel that you import to ALM, business process model entities are created under the selected
folder: an entity for themodel as a whole, and an entity for each of themodel's activities.

Note:
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l As XPDL2.2 focuses on process modeling, it does not include all elements of theBPMN 2.0
specification. Choreography and conversation diagrams are not defined inXPDL 2.2, and
collaboration diagrams are covered only to the extent required to support modelingmessage
flow between pools. Exportingmodels with these elements intoXPDL 2.2 files will cause gaps
in themodel.

l If you useMetastorm ProVision, you should export models using the Independent Sub-
Process option.

In addition, representative requirements are created automatically for themodel and for each of its
activities in the Requirements module.

l Representative requirements for models are created under theBusiness Models requirement
folder.

l Representative requirements for activities are created under theActivities sub-folder. If the same
activity is included in several models, the same requirement is used to represent the activity.

Representative requirements are assigned theBusiness Model requirement type.

Re-importing models

If changes aremade to amodel in themodel authoring tool, you can apply the changes to themodel in
ALM by re-importing themodel. ALM automatically updates themodel entities, as follows:

l Activities added or deleted in the re-importedmodel are added or deleted in themodel in ALM.

Note: Activities are identified by the GUID assigned to them by the authoring tool. A re-
imported activity with a different GUID than the original activity is re-imported as a separate
activity.

l Paths are automatically updated in ALM, provided that alternative paths are found. If alternative
paths cannot be found, youmust assign a new path to the path entity, or delete the path entity.

Business Process Model Paths
The quality of a business process model is determined not only by its activities, but also by the
business flows within themodel, or paths. A path is an end-to-end sequence of transitions between
activities in amodel.

A business process model that you create with standardmodeling tools does not include path
definitions. As paths are important for verifying the quality of a business process, ALM enables you to
define paths in your importedmodels.

ALM automatically analyzes all possible end-to-end paths in amodel, and allows you to select those
paths that are important to test.

Note: Recursive paths that repeat the same activity are not supported.

For each path you create, a representative requirement is created automatically under thePaths group
requirement, a child of themodel representative requirement.
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How to Workwith Business Process Models
This task describes how to specify business process models in ALM.

To learnmore about business process modeling in ALM, see "Business Process Models Overview" on
page 284.

Product Feature Movie: To view amovie that demonstrates how to integrate business process
models into the application lifecycle, chooseHelp > Movies in the ALMmain window.

This task includes the following steps:

l "Prerequisites" below
l "Import or re-import business process models" below
l "Create paths" on the next page
l "Develop requirements and tests" on the next page
l "Link requirements and tests to model entities" on the next page
l "Analyze the quality of business process models" on the next page
l "Generate a report of business process models" on page 288

1. Prerequisites
l With standardmodeling tools, create business process models, and export the business
process models to files.
o BPMN 1.1 models exported toXPDL 2.0/2.1 files
o BPMN 2.0 models exported toXPDL 2.2 files
o EPC 7.1 models exported toAML files (.xml extension)

l To enablemapping of model and activity attributes to ALM entities, add string or memo fields to
the following entities:
o Business Process Models
o Business Process Model Elements
Formore details on adding user-defined fields, refer to theHP Application Lifecycle
Management Administrator Guide.

2. Import or re-import business process models
For concept details, see "Business Process Models File Import" on page 284.
a. Open the Business Models module. On the ALM sidebar, underRequirements, select

Business Models. In theViewmenu, selectModel Tree.
b. Create a folder. Right-click theModels root folder and select New Folder. To create a sub-

folder, right-click a folder and select New Folder.
c. Open the Import Models dialog box. Right-click a folder and select Import Model. For

user interface details, see "Import Models Dialog Box" on page 304.
d. Select a file and models. In the Import Models dialog box, select a file to import. After the
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file is analyzed, select themodels you want to import from the file.
e. Map model and activity attributes to ALM fields. In the Import Models dialog box, click

Import Attributes. For user interface details, see "Map Imported Attributes to User Fields
Dialog Box" on page 305.

f. Track import status. Track the import status in the Import Models dialog box. When import is
complete, click OK to close the ImportingModels dialog box.

3. Create paths
For concept details, see "Business Process Model Paths" on page 285.
a. In the Business Models module, select View >Model Tree.
b. Open the New Path dialog box. Right-click a business process model and select New

Path. For user interface details, see "New Model Path/Model Path Details Dialog Box" on
page 308.

c. Select a path. In the Path drop-down list, select a path that is important to test. The activities
along the path are highlighted in themodel diagram, and a description of the path is displayed
in the Path Description tab.

4. Develop requirements and tests
To determine the quality of business process models in ALM, youmust develop requirements and
tests that cover all the critical aspects of themodel.
To assist you in this, ALM automatically creates a structure of business model requirements that
represent themodels and activities that you import, and the paths that you create.
a. Use one of the following:

o Use the representative requirements as a basis for developing a detailed requirements tree
and adding test coverage.

o If you have existing requirements, not related to the representative requirements, you can
continue developing them. Later, link themmanually to the relevant model entities.

b. Depending on your testing strategy, create test coverage for the requirements.
For task details, see "How to Use Requirements in ALM" on page 220.

5. Link requirements and tests to model entities
For requirements and tests to be included in the quality analysis, youmust link them to their
respectivemodel entities. For task details, see "Link Requirements and Tests to Model Entities"
on the next page.

6. Analyze the quality of business process models
After you run tests on your model entities, generate graphs that analyze the quality of amodel
entity.
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a. Open the Model Analysis view. In the Business Models module, select View >Model
Analysis. For user interface details, see "Model Analysis View" on page 292.

b. Select a model entity for the root of the analysis. Use one of the following:
o In theModels Map tab, select amodel. The correspondingmodel node is highlighted in the

business models tree.
o In the business models tree, select amodel entity.

c. Click theQuality Analysis tab.
d. In theDepth drop-down list, select the number of levels to include in the analysis.
e. Depending on your requirements strategy, choose whether to include representative or child

requirements in the analysis.
f. Click on graph bars to drill down to records represented by the bars. For task details, see

"How to Generate a Graph" on page 736.

7. Generate a report of business process models
Include business process model entities in project reports. For task details, see "How to Create
Project Reports" on page 776.

Link Requirements and Tests to Model Entities
The following steps describe how to link requirements and tests to their respectivemodel entities.

Note: This task is part of a higher-level task. For details, see "How toWork with Business
Process Models" on page 286.

This task includes the following steps:

l "Prerequisites" below
l "Link requirements and tests directly to model entities" on the next page
l "Link model entities to tests" on the next page
l "Link model entities to requirements" on the next page

Prerequisites
When creatingmodel linkage, consider the following:

l If you developed your requirements under the representative requirements, the requirements and
their covering tests are automatically linked to their respectivemodel entities.

l If your requirements are not related to the representative requirements, youmust link the
requirements manually to their respectivemodel entities.

l Tests that cover linked requirements are automatically linked to the samemodel entities. You can
alsomanually link other tests directly to model entities.

l You cannot manually link representative requirements tomodel entities.
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Link requirements and tests directly to model entities
1. In the Business Models module, select View >Model Tree.
2. Select amodel entity, and click the Linkage tab. For user interface details, see "Linkage Tab" on

page 309.
3. Click either theRequirements or Tests tab.
4. Click Select Requirements or Select Tests, respectively.
5. In theRequirements Tree/Test Plan Tree pane, right-click requirements or tests and select Add

to Linkage. For user interface details, see "Requirements Tree and Test Plan Tree Pane" on
page 311.

6. Alternatively, create linkage to any model entity by dragging requirements and tests to entities in
themodel diagram.

Link model entities to tests
1. In Test Plan > Test Plan Tree view, select a test and click theBusiness Models Linkage tab.

2. Click Add to Linkage to display the business models tree in the right pane.
3. Link model entities to tests. For user interface details, see "Business Models Linkage Tab" on

page 384.

Link model entities to requirements
1. InRequirements > Requirement Details view, select a requirement and click theBusiness

Models Linkage tab.

2. Click Add to Linkage to display the business models tree in the right pane.
3. Link model entities to requirements. For user interface details, see "Business Models Linkage

Tab" on page 384.

Business Models Module User Interface
This section includes:

• Business Models ModuleWindow 290
• Model Analysis View 292
• Business Models ModuleMenus and Buttons 296
• Business Models Module Icons 301
• Business Models Module Fields 302
• Import Models Dialog Box 304
• Map Imported Attributes to User Fields Dialog Box 305
• Model Details/Model Activity Details Dialog Box 306
• New Model Path/Model Path Details Dialog Box 308
• Linkage Tab 309
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• Requirements Tree and Test Plan Tree Pane 311
• Represented Items Tab 313

Business Models ModuleWindow
This window enables you to define andmaintain business process models in ALM.

To access On the ALM sidebar, underRequirements, select Business Models.

Important
information

The Business Models module includes the following views:

l Model Tree. Displays business process models and their elements in a
hierarchical tree.

l Model Grid. Displays a flat list of models, activities or paths.
l Model Analysis. Displays an analysis of amodel's testing coverage and quality.
For user interface details, see "Model Analysis View" on page 292.

Relevant
tasks

"How toWork with Business Process Models" on page 286

Learn more "Business Process Models Overview" on page 284

"Business Models Module Fields" on page 302

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Business
Models
module
common UI
elements>

l Business Model fields. For field definitions, see "Business Models Module
Fields" on page 302.

l Business Model menus and buttons. For command and button
descriptions, see "Business Models ModuleMenus and Buttons" on page 296.

l Business Model icons. For icon descriptions, see "Business Models Module
Icons" on page 301.

l ALM masthead, menus, and sidebar. For details, see "ALM Common
Areas" on page 32.

Hides or shows themodel diagram and diagram overview.

Available from: Model Tree view

<business
models tree>

A hierarchical representation of business process models, activities, and paths.
Activities and paths are displayed as children of their respectivemodels.

Note: The position of business process models in the tree does not
necessarily reflect connections betweenmodels. Connections between
models are displayed in theModel Analysis view. For user interface details,
see "Model Analysis View" on page 292.
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UI Element Description

<business
process model
diagram pane>

Located in the upper-right side of the window, a diagram of the currently selected
business process model. An activity or a path that you select in the business
models tree is highlighted in the diagram.

Tip:

l Hold down the CTRL key and use themouse wheel to zoom in and out. Or,
hold down the CTRL key and use the + and - keys to zoom in and out.

l Select an activity in the diagram to view its details in themain window.
l Double-click an activity to view its details in a separate window.

<business
process model
overview>

Located in the lower-left side of the window, a reduced diagram of the currently
selected business process model. The framed area of themodel in the overview
is magnified in the diagram pane.

Tip:

l Select an area in the overview to focus on the selected area in the diagram
pane.

l Drag or resize the frame to change the focus of themodel in the diagram
pane.

<filter status
bar>

Describes the filter currently applied to the grid or tree. Located directly above the
grid filter boxes or tree.

<grid filters> Displays a grid filter box under each column name, enabling you to define a filter
condition for a column.

Type directly into the box, or click the box to display the browse button, which
opens the Select Filter Condition dialog box. For user interface details, see
"Select Filter Condition Dialog Box" on page 61.

Available from:Model Grid view

Activities Displays a list of activities across multiple business process models.

Tip: To group activities by business process model, select Group By
Owner Model.

Available from: Model Grid view

Attachments Lists attachments that provide additional information about the currently selected
business process model, activity or path. For more details, see "Attachments
Page" on page 72.

Comments Comments about the currently selectedmodel entity.

Click in the text box to display a toolbar for formatting and spell checking the text.
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UI Element Description

Description Describes the currently selectedmodel entity.

Click in the text box to display a toolbar for formatting and spell checking the text.

Details Details the currently selectedmodel entity.

Group By
Owner Model

If selected in combination withActivities orPaths, groups the activities or paths
according to themodel in which they are defined.

If this option is not selected, the activities or paths are displayed in a flat list.

Available from: Model Grid view

History Lists changes made to the currently selected business process model. For more
details, see "History Tab" on page 68.

Imported
Attributes

Lists field labels and values relevant to the business process model or activity, as
defined in themodel authoring tool.

Note: This tab is read-only.

Linkage Contains the Requirements and Tests tabs that list entities linked to the business
process model, activity, or path. For more details, see "Linkage Tab" on page 309.

Models Displays a list of business process models.

Available from: Model Grid view

Paths Displays a list of paths across multiple business process models.

Tip: To group activities by business process model, select Group By
Owner Model.

Available from: Model Grid view

Text Text displayed in an activity entity. The field is read-only.

Available from:Model activities

Model Analysis View
This view enables you to analyze the quality of business process models, activities, and paths.

To access 1. In the Business Models module, select View >Model Analysis.
2. Use one of the following:

l In theModels Map tab, select amodel. The correspondingmodel entity is
highlighted in the business models tree.

l In the business models tree, select amodel entity.
3. Click theQuality Analysis tab.
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Important
information

TheModel Analysis view includes the following tabs:

l Models Map. Displays relationships between business process models
imported into ALM.

l Quality Analysis. Analyzes the quality of a business process model entity.

Relevant tasks "How toWork with Business Process Models" on page 286

Learn more "Business Process Models Overview" on page 284

Models Map Tab
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

A business process model.

Tip: Double-click amodel to view model details in a separate window. For user
interface details, see "Model Details/Model Activity Details Dialog Box" on
page 306.

Indicates that themodel at the tip of the arrow is a sub-process of themodel at the tail of
the arrow.

A bi-directional link, indicating that themodel at one end of the line is a continuation of the
model at the other end of the line.

<map
area>

Displays all the business process models imported to ALM, and the hierarchical
connections between themodels.

Select amodel in themap area that you want to analyze, and then click theQuality
Analysis tab.

Tip: Hold down the CTRL key and use themouse wheel to zoom in and out of the
map image.
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Quality Analysis Tab Toolbar
User interface elements are described below:

UI Element Description

Depth Defines the number of hierarchical levels, from the root entity down, displayed in
the entities pane. Entities displayed in the entities pane are analyzed in the
analysis graphs.

Standalone Entity. Displays the root entity alone.

One Nested Level. Displays the root entity, and entities one level down from the
current entity.

All Nested Levels. Displays and analyzes the root entity, and all entities
leading off from the root entity on all levels.

Include
requirement
children

Instructs ALM to include in the analysis all child requirements of the
requirements linked to themodel entities in the entities pane.

Include
representative
requirements

Instructs ALM to include in the analysis the representative requirements linked to
themodel entities in the entities pane.

Tip: Use this option if representative requirements are linked to tests.

Refreshes the analysis graphs to include themost up-to-date information.

Quality Analysis Tab Entities Pane
This pane displays the business process model entities that are analyzed in the graphs pane.

User Guide
Chapter 18: Business Process Models

HP ALM (12.50) Page 294



User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

<entities
pane>

Displays business process models, activities, and paths that are analyzed in the graphs
pane, and hierarchical connections between them.

Note:

l The number of hierarchical levels displayed is determined by the value in the
Depth field.

l An activity that is included inmore than onemodel or path is displayed in the
entities pane once.

Tip:

l To change the root entity displayed in the entities pane, select amodel in the
Models Map tab, or select an entity in the business models tree.

l Hold down the CTRL key and use themouse wheel to zoom in and out.
l Double-click an entity to display entity details.

A business process model entity.

A path entity.

An activity entity.

Quality Analysis Tab Graphs Pane
This pane displays graphs that analyze the quality of the entities displayed in the entities pane.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<graph title> Click a graph title to change the graph's titles and appearance. For user interface
details, see "Graph Appearance Dialog Box" on page 765.
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UI Element Description

Requirements
graph

Displays the coverage status of requirements linked to themodel entities
displayed in the entities pane.

Note: The scope of requirements included in the graph is determined by the
Include requirement children and Include representative requirements
options.

Tests graph Displays the execution status of tests linked to themodel entities displayed in the
entities pane.

Note: The tests graph includes tests that are linked to the requirements
included in the Requirements graph, and tests that are linked directly to the
entities displayed in the entities pane.

<legend> Displays the graph categories and their corresponding color.

Tip: Right-click a category to change its color.

Defects graph Displays the severity of defects linked to themodel entities displayed in the
entities pane.

Note: The defects graph includes defects linked to the requirements in the
Requirements graph, and to the tests in the Tests graph.

Last
Generated

The date and time that the graph data was last refreshed. Click Generate to refresh
the data.

View Graph in Full Screen. Opens the graph in a new window andmaximizes its
display. In the new window you can customize the graph view and save the graph
data. For user interface details, see "View Tab - Graphs/GraphWindow" on
page 749.

<graph area> You can perform the following actions in the graph area:

l Drill down to the graph's data by clicking on a segment in the graph. For task
details, see "How to Generate a Graph" on page 736.

l Right-click an area in the graph to change its color.
l Hover over a bar to view a tooltip containing the area's category, x-axis, and y-
axis values.

Business Models Module Menus and Buttons
This section describes themenus and buttons available in the Business Models module.

To access On the ALM sidebar, underRequirements, select Business Models.
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Important
information

l Somemenu commands and buttons are not available in all model views.
l Tip: You can access themenu bar from the Business Models module by

pressing the shortcut key ALT.

l Version Control:Additional menu commands and buttons are available in a
version control enabled project. For details, see "Versions Menu and Buttons" on
page 108.

Relevant
tasks

"How toWork with Business Process Models" on page 286

Learn more "Business Models Module Icons" on page 301

User interface elements are described below:

UI Element Menu Description

Copy URL/Paste Edit Copies amodel entity or folder and pastes its URL as a link. The
item itself is not copied. Instead, you can paste the address into
another location, such as an email or a document. Clicking the
link opens ALM and takes you to the item. If you are not already
logged in, ALM first prompts for login details.

Cut/Paste
Edit Moves a business process model or folder to a different location

in the tree. Activities and paths aremoved together with their
model.

Tip: You can alsomove a business process model or folder
by dragging it to a new location in the tree.

Delete
Edit Deletes selectedmodel entities or folders. You cannot delete the

root folder.

Note: Deleting a folder deletes all the items included in it.

Details Models Opens the Details dialog box for the selectedmodel entity. For
more details, see "Model Details/Model Activity Details Dialog
Box" on page 306.

Expand All/Collapse View Expands/collapses all the nodes under the selected folder.

Filter/Sort
View Enables you to filter and sort themodels in the business models

tree or grid. Any currently applied filters or sorting orders are
displayed below the toolbar. For more details, see "Filter Dialog
Box" on page 51.

Find Edit Opens the Find dialog box, enabling you to search for amodel
entity under the selected folder. For more details, see "Find
Dialog Box" on page 63.
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UI Element Menu Description

Fit Overview to
Window

right-
click
menu

Adjusts the zoom level of the diagram overview so that the entire
model is visible in the overview pane.

Fit to Window right-
click
menu

Adjusts the zoom level of themodel diagram so that the entire
model is visible in the diagram pane.

Flag for Follow Up Edit Opens the Flag For Follow Up dialog box, enabling you to define a
follow up flag for a selectedmodel entity. For more details, see
"Flag For Follow UpDialog Box" on page 89.

Go to Model Models Opens the Go ToModel dialog box, enabling you to find a specific
model by Model ID. You can only go tomodels that are in the
current filter.

Go to
Representative
Requirement

Models Opens the requirements tree in the Requirements module, and
highlights the representative requirement of the selectedmodel
entity.

Go to Requirement
in Requirements
Tree

right-
click
menu

Opens the requirements tree in the Requirements module, and
highlights the selected requirement.

Available from: Linkage tab > Requirements tab

Go To Sub-Model right-
click
menu

Navigates to the sub-model in the business models tree that is
represented by the selected activity.

Go to Test in Test
Set

right-
click
menu

Enables you to view instances of a test in test sets in the Test
Labmodule.

If there is only one instance of the selected test, the Test Lab
module opens with the instance highlighted.

If there is more than one instance of the selected test, the Select
Test Set dialog box opens, and you select a test set and instance.

Available from: Linkage tab > Tests tab

Go to Test in Test
Tree

right-
click
menu

Opens the test plan tree in the Test Planmodule, and highlights
the selected test.

Available from: Linkage tab > Tests tab

Import Model
Models Opens the Import Models dialog box, enabling you to import or re-

import business process models from a source file. For more
details, see "Import Models Dialog Box" on page 304.

Available from: Model Tree view

User Guide
Chapter 18: Business Process Models

HP ALM (12.50) Page 298



UI Element Menu Description

Indicator Columns View Displays indicators on the left-side of the business process model
window. For more details, see "Business Models Module Icons"
on page 301.

Model Analysis View Displays theModel Analysis view, enabling you to analyze the
quality of selected business process models. For more details,
see "Model Analysis View" on page 292.

Model Grid View Displays theModel Grid view, enabling you to view business
process models, activities, or paths in a flat, non-hierarchical
view.

Model Tree View Displays theModel Tree view, enabling you to view your
business process models and elements hierarchically in a tree,
and to view a diagram of the selectedmodel.

New Folder
Models Opens the New Folder dialog box, enabling you to add a folder

under a selected folder in the business models tree.

Syntax exceptions: The folder name cannot include the following
characters: \ ^ *

Available from: Model Tree view

New Path
Models Opens the New Business Model Path dialog box, enabling you to

define a sequence of transitions between activities in amodel.
For more details, see "New Model Path/Model Path Details
Dialog Box" on page 308.

Available from: Model Tree view

Refresh
View Refreshes the business process model view so that it displays

themost up-to-date information.

Remove From
Linkage

right-
click
menu

Removes the selected requirement or test from the linkage grid.

Available from: Linkage tab > Tests and Requirements tabs

Rename Edit Enables you to rename the selected business process model
folder.

Available from: Model Tree view

Select All Edit Selects all records displayed in grid.

Available from:Model Grid view and Linkage tab > Tests and
Requirements tabs
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UI Element Menu Description

Select Columns
Opens the Select Columns dialog box, enabling you to determine
which fields are displayed in the business models grid and their
order. For more details, see "Select Columns/Select Fields
Dialog Box" on page 77.

Available from:Model Grid view

Select
Requirements/Select
Tests

right-
click
menu

Opens a panel displaying the following tabs:

l Requirements Tree
l Test Plan Tree
The panel enables you to link requirements and tests to model
entities.

Send by E-mail Models Opens the Send E-mail dialog box, enabling you to send business
process models by email to recipients selected from a list. For
more details, see "Send E-mail Dialog Box" on page 69.

Show Full Path right-
click
menu

Displays the full path of linked requirements or tests. The path is
displayed in the Name column of linked requirements, and in the
Test Name column of linked tests.

Available from: Linkage tab > Tests and Requirements tabs

Text Search
Edit Opens the text search pane in the lower part of the Business

Model module window, enabling you to search for records in
predefined fields. For more details, see "Text Search Pane" on
page 66.

Available from:Model entities

Zoom In right-
click
menu

Increases the zoom level of themodel diagram.

Zoom Overview In right-
click
menu

Increases the zoom level of the diagram overview.

Zoom Out right-
click
menu

Decreases the zoom level of themodel diagram.

Zoom Overview Out right-
click
menu

Decreases the zoom level of the diagram overview.
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Business Models Module Icons
This section describes the icons available in the Business Models module.

To access On the ALM sidebar, underRequirements, select Business Models.

Relevant tasks "How toWork with Business Process Models" on page 286

Learn more "Business Models ModuleMenus and Buttons" on page 296

"Business Models ModuleWindow" on page 290

The icons are described below:

UI
Element

Description

<green asterisk>. The applicable tab is populated.

Activity that expands to a sub-model

Alerts. Click to view alerts for themodel entity.

l Red alert. The alert is new.
l Gray alert. The alert has already been read.
For more details, see "Alerts Dialog Box" on page 88.

Attachments. Click to view attachments for the specifiedmodel entity.

Open an attachment by selecting it from the list. If there aremore than ten attachments,
click themore attachments link to view the list in theAttachments Page. For details,
see "Attachments Page" on page 72.

Business process model

Business process model activity

Business process model folder

Business process model path

Follow Up Flags. Click to view follow up flags for themodel entity.

l Gray flag. The follow up flag is new.
l Red flag. The follow up date has arrived.
For more details, see "Flag For Follow UpDialog Box" on page 89.

Re-imported business process model

Available from: Import Models dialog box
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UI
Element

Description

Unresolved path

Version Control. Themodel entity is checked out.

l Green lock. Themodel entity is checked out by the current user.
l Red lock. Themodel entity is checked out by another user.

Business Models Module Fields
This section describes the Business Models module fields.

To access On the ALM sidebar, underRequirements, select Business Models.

Important
information

l You can add user-defined fields and change the label of any of the fields in the
Business Models module. You can also customize project lists. For more details,
refer to theHP Application Lifecycle Management Administrator Guide

l You can use the Script Editor to restrict and dynamically change the fields and
values in the Business Models module. For more details, refer to theHP
Application Lifecycle Management Administrator Guide.

l When you select a business process model columnwith a user name value
(including user-defined fields), ALM displays a list with the name and full name of
each user. You can search for users, sort users, group users by user group, and
select users from the users list or a group tree. For more details, see "Users List
Dialog Box" on page 62.

l Version Control:Additional fields are available in a version control enabled
project. For details, see "Version Control Fields" on page 109.

l Some fields are not available in all business process model views.

Relevant
tasks

"How toWork with Business Process Models" on page 286

Learn more "Business Models ModuleWindow" on page 290

User interface elements are described below:

UI Element (A - Z) Description

Activity ID/Folder ID/Path
ID/Model ID

A unique numeric ID for the entity that is assigned automatically. The
ID field cannot bemodified.

Comments Comments on the entity.

Click in the text box to display a toolbar for formatting and spell
checking the text.
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UI Element (A - Z) Description

Created By Models/Activities: The user who first imported the entity.

Paths: The user who created the path.

Creation Date Models/Activities: The date and time on which the entity was first
imported.

Paths: The date and time on which the path was created.

Description A description of the entity.

Click in the text box to display a toolbar for formatting and spell
checking the text.

Guid A unique code identifying themodel. The code helps identify the
model in case of re-import.

Guid of referenced
element

If an activity references a business process model, the unique code
identifying themodel.

Import Date The date and time on which the entity was last imported.

Imported By The user who last imported the entity.

Imported File Name The name of the source file from which themodel was last imported.

Lane The location of an activity within amodel.

Model Author The user who created themodel in themodel authoring tool.

Name The entity name.

Notation The notation that is used to implement themodel in the source file.
Possible values areEPC orBPMN.

Notation Version The version of the notation (EPC or BPMN) that is used to implement
themodel in the source file.

Path Description Lists the activities included in the path.

Pool The location of an activity within amodel.

Priority The priority of the entity.

Prototype Possible values areAs-Is or To-Be.

Status The status of the entity.

Text Text displayed in the activity diagram, as defined in themodeling tool.

Type The activity type.

Vendor Themodeling tool used to create the business process model.
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Import Models Dialog Box
This dialog box enables you to import business process models from a source file.

To access In the Business Models module, in theModel Tree view, right-click a folder, and
select Import Model.

Important
information

Characters in names of importedmodels and activities that are illegal in ALM (for
example, \ ^ *), are replaced with underscores.

Relevant
tasks

"How toWork with Business Process Models" on page 286

Learn more "Business Models ModuleWindow" on page 290

User interface elements are described below:

UI Element Description

From file The source file from which business process models are imported.

Tip: Click the browse button to locate a file in a folder.

Scans the source file for business process models. Themodels in the file are
displayed in the file content area.

Opens theMap Imported Attributes to User Fields dialog box. For user interface
details, see "Map Imported Attributes to User Fields Dialog Box" on the next
page.

Select models to
import

Displays the business process models contained in the source file.

If you selected a file with ARIS notation, structuredmodels are displayed
hierarchically.

Destination The folder in the business models tree under which the importedmodel will be
added.

Note:

l You cannot import models under the rootModels folder.
l Re-importedmodels remain in the original folder.

Tip: Click the drop-down button to select a folder in the business models
tree.

Shows/hides options for defining representative requirements.
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UI Element Description

Imports themodels selected in the Select models to import pane.

The ImportingModels dialog box opens, displaying the progress and status of
the file import.

Rename
requirements

Instructs ALM to rename representative requirements of re-importedmodels.
The requirements are renamed according to the new names given to the
business process model and its activities.

Available if theDetails pane is expanded.

Requirement
Destination

The folder in the requirements tree under which representative requirements of
the imported business process model are added.

Note:

l You cannot select theRequirements root folder.
l Representative requirements of re-importedmodels remain in the
original folder.

Tip: Click the drop-down button to select a folder in the requirements tree.

Available if theDetails pane is expanded.

Map Imported Attributes to User Fields Dialog Box
This dialog box enables you tomapmodel and activity attributes to ALM fields.

To access In the Import Models dialog box, select a file to import, and click Map Attributes.

Important
information

l To enable attributemapping, youmust add string or memo fields to the Business
Process Models and Business Process Model Elements entities. For more details
on adding user-defined fields, refer to theHP Application Lifecycle Management
Administrator Guide.

l If user fields are not defined, imported attributes are not displayed in the
appropriate grid.

l If the selectedmodels include attributes that were previously mapped, the existing
mappings are displayed.

Relevant
tasks

"How toWork with Business Process Models" on page 286

Learn more "Business Models ModuleWindow" on page 290
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User interface elements are described below:

UI Element Description

Model attribute
mappings

Displays the importedmodel attributes, and the ALM fields to which they are
mapped.

Note: Toggle theShow non-mapped attributes only option to show or
hidemapped attributes.

Activity
attribute
mappings

Displays the imported activity attributes, and the ALM fields to which they are
mapped.

Note: Toggle theShow non-mapped attributes only option to show or
hidemapped attributes.

Imported
Attribute

Lists themodel or activity attributes imported from the source file.

User Field Lists the user-defined fields that aremapped to the corresponding attributes.

Note:

l The drop-down list includes only user fields that are not already mapped
to attributes in the selectedmodels.

l If user fields aremapped to attributes in importedmodels, you can
reassign them to other attributes in the selectedmodels. This will
override the previous mapping.

Show non-
mapped
attributes only

Enables you to hide attributes that are already mapped to ALM fields.

Model Details/Model Activity Details Dialog Box
TheModel Details dialog box enables you to view and update details of a business process model.

TheModel Activity Details dialog box enables you to view and update details of a business process
model activity.

To access In the Business Model module, right-click a business process model or activity, and
select Details.

Relevant
tasks

"How toWork with Business Process Models" on page 286

Learn more "Business Process Models Overview" on page 284
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Save. Saves the details.

Send by E-mail. Opens the Send E-mail dialog box, enabling you to send a
business process model by email to recipients selected from a list. For more
details, see "Send E-mail Dialog Box" on page 69.

Available from:Business Process Model Details dialog box

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

<Business
Models
module
fields>

For details on the fields available in the Business Models module, see "Business
Models Module Fields" on page 302.

Details Lists the relevant fields for the selected business entity. For details, see "Business
Models Module Fields" on page 302.

Model
Diagram

Business Process Model Details dialog box: Displays a diagram of the current
business process model.

Model Activity Details dialog box: Displays a diagram of the business process
model in which the current activity is embedded. The current activity is highlighted
in themodel diagram.

Tip: Right-click an area in the diagram, and select one of the zoom options.

Imported
Attributes

Lists field labels and values relevant to the business entity, as defined in the
modeling tool.

Attachments Lists attachments that provide additional information about the currently selected
model entity. For more details, see "Attachments Page" on page 72.

Linkage Contains the Requirements and Tests tabs that list entities linked to the business
entity. For more details, see "Linkage Tab" on page 309.
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UI Element Description

History Lists changes made to the currently selected business process model. For more
details, see "History Tab" on page 68.

Available from:Business Process Model Details dialog box

NewModel Path/Model Path Details Dialog Box
The New Model Path dialog box enables you to define a path of transitions between activities in a
business process model.

TheModel Path Details dialog box enables you to view and update details of a business process model
path.

To access New Model Path dialog box:

1. In the Business Models module, select theModel Tree view.
2. Right-click a business process model and select New Path.
Model Path Details dialog box:

In the Business Models module, right-click a path and select Details.

Important
information

l Paths are created in the business models tree as a sub-entities of the
business process model.

l Recursive paths that repeat the same activity are not supported.

Relevant tasks "How toWork with Business Process Models" on page 286

Learn more "Business Process Model Paths" on page 285

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Save. Saves the details.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb
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UI Element Description

<Business
Models module
fields>

For details on the fields available in the Business Models module, see
"Business Models Module Fields" on page 302.

Details Lists the relevant fields for the selected path. For details, see "Business Models
Module Fields" on page 302.

Attachments Lists attachments that provide additional information about the currently
selected path. For more details, see "Attachments Page" on page 72.

Linkage Contains the Requirements and Tests tabs that list entities linked to the path.

Available from:Model Path Details dialog box

Path New Business Model Path dialog box: A drop-down list of possible end-to-
end paths in the business process model. Select a path that is important to test.

Business Model Path Details dialog box: A notation of the current end-to-
end path. The activities in the path are represented by numbers.

Note: If the path is unresolved, select a new path from the drop-down list.

Tip: Click thePath Description tab to view a full description of the path,
including the full names of the activities in the path.

<model
diagram>

A diagram of the business process model. When you select paths in thePaths
drop-down list, the activities and nodes along the path are highlighted.

Description Describes the currently selected path.

Click in the text box to display a toolbar for formatting and spell checking the
text.

Comments Comments about the currently selected path.

Click in the text box to display a toolbar for formatting and spell checking the
text.

Path
Description

A full description of the path, including the full names of the activities in the path.

Linkage Tab
This tab enables you to link requirements and tests to amodel entity.

To access Select a business process model entity, and click the Linkage tab or button.

Important
information

Requirement linkage is created automatically when you convert a representative
requirement to a test. Therefore, even if you have not yet added requirements linkage,
it may already exist.
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Relevant
tasks

"How toWork with Business Process Models" on page 286

Requirements Tab
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Opens a panel displaying the following tabs:

l Requirements Tree
l Test Plan Tree
The panel enables you to link requirements and tests to model entities.

For more details, see "Requirements Tree and Test Plan Tree Pane" on
the next page.

Remove From Linkage. Removes selected requirements from the
linkage grid.

Refresh All. Refreshes the linkage grid.

Select Columns. Opens the Select Columns dialog box, enabling you to
determine which fields to display in the linkage grid and their order. For
more details, see "Select Columns/Select Fields Dialog Box" on page 77.

Copy/Paste. Copies linked requirements to another model entity. To
paste the copied requirements, select amodel entity, click the Linkage >
Requirements tab, and click Paste.

<linkage grid> For field definitions, see "Requirements Module Fields" on page 237.

Tests Tab
User interface elements are described below:

UI Element Description

Opens a panel displaying the following tabs:

l Requirements Tree
l Test Plan Tree
The panel enables you to link requirements and tests to model entities.

For more details, see "Requirements Tree and Test Plan Tree Pane" on the
next page.
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UI Element Description

Remove From Linkage. Removes selected tests from the linkage grid.

Note: You cannot remove tests covering linked requirements.

Refresh All. Refreshes the linkage grid.

Select Columns. Opens the Select Columns dialog box, enabling you to
determine which fields to display in the linkage grid and their order. For more
details, see "Select Columns/Select Fields Dialog Box" on page 77.

Copy/Paste. Copies linked tests to another model entity. To paste the
copied tests, select amodel entity, click the Linkage > Tests tab, and click
Paste.

Set Filter/Sort. Includes the following options:

l Set Filter/Sort. Opens the Filter dialog box, enabling you to filter and sort
tests.

l Clear Filter/Sort. Clears any filters or sorting that you have applied.
For more details, see "Filter Dialog Box" on page 51.

Select the type of linked tests displayed in the grid.

l Direct Coverage. Displays tests linked directly to themodel entity, or to
the representative requirement. This option is always selected.

l Linked Requirement Coverage. Displays tests linked to requirements
that are linked to themodel entity.

l Children Requirement Coverage. Displays tests that are linked to child
requirements of requirements that are linked to themodel entity.

Enables you to create a test set containing the tests in the linkage grid.

In the Select Test Set Folder dialog box, select the folder in the test sets tree
under which the test set is created.

<linkage grid> For field definitions, see "Test PlanModule Fields" on page 366.

Requirements Tree and Test Plan Tree Pane
This pane enables you to link requirements and tests to a business process model entity.

To access 1. Select a business process model, activity, or path, and click the Linkage tab or
button.

2. Click theRequirements or Tests tab.
3. Click theSelect Requirements orSelect Tests button.
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Important
information

In the Business Models module window, you can create linkage by dragging and
dropping requirements and tests to any entity in themodel diagram.

Relevant
tasks

"How toWork with Business Process Models" on page 286

User interface elements are described below:

UI
Element

Description

Add to Linkage. Adds a selected requirement, test or folder to the linkage grid.

Tip: Alternatively, create linkage to any model entity by dragging requirements and
tests directly to entities in themodel diagram.

Show Entity Details. Opens the Details dialog box for the selected entity in read-only
mode.

Go to Entity in Module Tree. Navigates to the selected entity's location in that entity's
module, and highlights the entity.

Refresh. Refreshes the tree to display themost up-to-date information.

Find. Searches for a specific requirement or test in the tree.

Type the name (or part of the name) of the requirement or test in the Find box and click
Find. If the search is successful, the requirement or test is highlighted in the tree.

Filter/Sort. Includes the following options:

l Set Filter/Sort. Opens the Filter dialog box, enabling you to filter and sort tests.
l Clear Filter/Sort. Clears any filters or sorting that you have applied.
For more details, see "Filter Dialog Box" on page 51.

Go to Requirement by ID. Opens theGo ToRequirement dialog box, enabling you to
find a specific requirement by ReqID.

Go to Test by ID. Opens theGo To Test dialog box, enabling you to find a specific test
by Test ID.

Note: You can only go to requirements and tests that are in the current filter.

Hides the Requirement Tree and Test Plan tree pane.
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Represented Items Tab
This tab lists business process model entities represented by the selected requirement.

To
access

In theRequirementsmodule, open the Requirement Details view, select a Business
Model requirement, and click theRepresented Items tab.

Relevant
tasks

"How to Create Requirements" on page 224

"How toWork with Business Process Models" on page 286

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

Refresh. Refreshes the grid to display themost up-to-date information.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the requirements tree or grid and their order. For more details,
see "Select Columns/Select Fields Dialog Box" on page 77.

<business
model
entities
grid>

Click a link in the grid to go to the represented business process model entity in the
business models tree.

For field definitions, see "Business Models Module Fields" on page 302.
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Part 4: Cloud Settings
ALM allows you to provision cloud hosts for use in performance testing. This involves adding your
cloud accounts to ALM, creating host templates, and provisioning hosts.

This section contains only a brief overview of Cloud Settings. For more information, see theHP ALM
LabManagement Guide.

Cloud Settings contains the followingmodules:

l Cloud Accounts
Allows you to add cloud accounts to ALM. Youmust have an existing account with a cloud provider
before you can add it to ALM. For more information, see theHP ALM LabManagement Guide.

l Host Templates
Allows you to create templates that are used to provision cloud hosts. For more information, see the
HP ALM LabManagement Guide.
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Chapter 19: Introducing Lab Resources
This chapter includes:

• Lab Resources Overview 320
• How to Use Lab Resources in ALM 320
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Lab Resources Overview
HP ALM LabManagement allows you tomanage resources used for server-side Functional and
Performance testing. The Lab Resources modules in ALM are used to view andmanage testing
resources and to automate deployment schemas.

ALM Editions: The Lab Resources modules are available only for ALM Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site administrator.

For task details, see "How to Use Lab Resources in ALM" below.

Many of the administrative tasks you use tomanage lab resources are only available from within Lab
Management. From within the ALM project, you can view andmanage only the resources that are
allocated to your project.

To learnmore about LabManagement and Lab Resources, see theHP ALM LabManagement Guide.

How to Use Lab Resources in ALM
In ALM, you can view and use the lab resources allocated to your project.

l Using the Testing Hosts module, you can view andmodify testing hosts. For task details, refer to
theHP ALM LabManagement Guide. For information about Testing Hosts, see "Testing Hosts
Overview" on page 322.

l Using the AUT Environments module, you can view andmodify the environment parameters used
by AUT hosts. If you are using an environment connected to CDA servers (HP Continuous Delivery
Automation), you can also link your environment configurations to CDA to automate your
deployment schemas. For details, see "How toWork with AUT Environments" on page 325.

ALM Editions: The Lab Resources modules are available only for ALM Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site administrator.

For details about Lab Resourcemanagement, refer to theHP ALM LabManagement Guide.

To learnmore about Lab Resources in ALM, see "Lab Resources Overview" above.
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Chapter 20: Testing Hosts
This chapter includes:

• Testing Hosts Overview 322
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Testing Hosts Overview
The Testing Hosts module in ALM enables you to view andmodify the properties of testing hosts. The
testing hosts from the host pool of your project are displayed in the Testing Hosts module grid.

ALM Editions: The Testing Hosts module is available only for ALM Edition. For more information
about ALM editions and their functionality, see "ALM Editions" on page 115. To find out what
edition of ALM you are using, ask your ALM site administrator.

You can use testing hosts for server-side functional and performance testing. Instead of launching a
test from your computer's console, tests can be controlled by the ALM server. Server-side execution is
available for both functional and performance test sets.

Each testing host is assigned a location, purpose, and attributes. Testing hosts can be located in your
testing lab or can be provisioned on the cloud on an as-needed basis.

You can create public testing hosts only in LabManagement. Each testing host can be placed in a host
pool and assigned to a project. You can also create private testing hosts for your project from within
ALM. The private hosts you create in ALM are automatically added to your project's host pool in Lab
Management.

To add a testing host to ALM, youmust first create the host in the Testing Hosts module, and then
register it using HP ALM Lab Service. For an overview about HP ALM Lab Service, see theHP ALM
LabManagement Guide.

For details about testing hosts, see theHP ALM LabManagement Guide.

For details on creating andmanaging hosts and host pools, see theHP ALM LabManagement Guide.

For details about provisioning cloud hosts for performance testing, see theHP ALM LabManagement
Guide.

For details about how to use remote testing hosts for running functional test sets in ALM, see "How to
Run Functional Tests" on page 560.
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Chapter 21: AUT Environments
This chapter includes:

• AUT Environments Overview 324
• How toWork with AUT Environments 325
• AUT Environments User Interface 327
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AUT Environments Overview
AUT Environments allows users tomake LabManagement test executionmore dynamic by
parameterizing the environment data used for testing.

An AUT environment is a container for a set of AUT environment parameters. You can provide a default
value for each AUT environment parameter.

Within an AUT environment, you create a set of AUT environment configurations. Each
AUT environment configuration contains a set of the AUT environment parameters, which can all be
overridden. Instead of defining and running several different tests that use the same logic but need
different AUT environment parameters, you can simply provide a specific AUT environment
configuration that ALM inserts into your test at run-time. ALM then uses the parameter values you
defined in the AUT environment configuration when deploying the environment and executing the test.

ALM Editions: The AUT Environments module only available in ALM Edition. For more information
about ALM editions and their functionality, see "ALM Editions" on page 115. To find out what
edition of ALM you are using, ask your ALM site administrator.

Tomake your environment parameter value definitions dynamic, you can link your AUT environment
configurations to CDA. For more information, see "Link AUT Environments to CDA" below.

AUT environment configurations are a key component in ALM's Continuous Delivery solution. They
facilitate an automated, end-to-end deployment and testing framework that makes application
development more efficient, reliable, and quick. For more information about how AUT environment
configurations can be used as part of this process, see "Deploying and Testing your Application in
ALM" on page 492.

Note: Implementation of AUT environment configurations is currently available only for
Performance Center Tests, Service Test, UFT GUI and API testing, and VAPI-XP.

For task details, see "How toWork with AUT Environments" on the next page.

Link AUT Environments to CDA
Linking your project to HP Continuous Delivery Automation (CDA) enables you to dynamically
provision and deploy your testing environments. You use LabManagement to configure CDA servers in
ALM.

Note: For information about setting up CDA Servers in LabManagement, see theHP ALM Lab
Management Guide.

ALM Editions: The AUT Environments module is available only for ALM Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site administrator.

To take advantage of dynamic provisioning and deployment, you first link your AUT environment
configuration to CDA. Then, when you run a test set or build verification suite, instead of supplying
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specific environment parameters, you implement the linked AUT environment configuration. CDA then
automatically allocates an available set of the required resources from the cloud. When using an AUT
environment configuration linked to CDA, you do not need to keep track of the values of multiple
environment parameters, and you do not have to check the availability of environment resources before
running a test.

For task information, see "How toWork with AUT Environments" below.

How to Workwith AUT Environments
This task describes how to work with AUT Environments.

ALM Editions: The AUT Environments module is available only for ALM Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site administrator.

l "Prerequisites " below
l "Create AUT environments " below
l "Link AUT environment configurations to CDA (optional) " on the next page
l "Run tests using AUT environments " on the next page
l "Select a deployment and provisioning option (CDA only)" on page 327

1. Prerequisites
l Which AUT environments do you need to configure?
l What are the applications you intend to test? 
l How many different environments will you have for each application?
l What details do you need for each environment? For example, do you have specific URLs,
user names, and passwords for each environment?

2. Create AUT environments
a. Open the AUT Environments module. On the ALM sidebar, under Lab Resources, select

AUT Environments.
b. Create folders. Select the root AUT Environments folder or a sub-folder, and click theNew

AUT Environment Folder button.
c. Add AUT Environments to folders. Select a folder and click theNew AUT Environment

button. Add an AUT environment for each of the applications you need to test.
For user interface details, see "New AUT Environment Dialog Box" on page 334.

d. Add AUT Parameters. Select an AUT environment and click theNew AUT Parameter
button in the right pane. Add a parameter for each environment parameter you need for the
application you are testing. Enter the parameter name and a value in the New AUT Parameter
dialog box. The value you enter in the AUT parameter dialog box will be the default value for
that parameter in the selected AUT environment.
For user interface details, see "New AUT Parameter Dialog Box" on page 336.

e. Add AUT Environment Configurations. Select an AUT environment and click theNew
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AUT Environment Configuration button. Add an AUT environment configuration for each
environment youmight use while testing the selected application.
For user interface details, see "New AUT Environment Configuration Dialog Box" on
page 336.

f. Modify AUT Environment Configurations. Select an AUT environment configuration and
override any of the default parameter values you need to adjust for this specific
AUT environment configuration. You canmodify the values in the right pane.
For user interface details, see "AUT Environments ModuleWindow" on page 328.

3. Link AUT environment configurations to CDA (optional)
You can link your AUT environment configurations to HP Continuous Delivery Automation (CDA)
to arrange for your tests to be provisioned and deployed dynamically. For more information, see
"Link AUT Environments to CDA" on page 324.

Note: To use CDA, youmust configure a CDA server in LabManagement. For more details,
see theHP ALM LabManagement Guide.

To link an AUT environment configuration to CDA, do the following:
a. In theAUT Environmentsmodule, select an AUT environment configuration.

b. Click the Link to CDA button.
c. In the Link to CDA dialog box, use the drop-downs to select a CDA topology. For user

interface details, see "Link to CDA Dialog Box" on page 338.
d. In theAUT Environmentsmodule, in the right pane, select a parameter in theValues tab.

Select the CDA parameter to link to the selected AUT environment parameter.

4. Run tests using AUT environments
When running a functional or performance test, you can provide an AUT environment configuration
to execute your test using specific environment parameters.

Note: AUT Environments are available only for Performance Center Tests, Service Test,
API testing in UFT, and VAPI-XP tests.

Use one of the followingmethods to execute your test using an AUT environment configuration:
l Schedule a timeslot.
In the Timeslotsmodule, create a new timeslot. Select a test set to run and then select an
AUT environment configuration. For user interface details, see " Timeslot Reservation Dialog
Box" on page 647.

l As part of a functional test set or performance test execution.
In the Test Labmodule, go to theExecution Grid tab. Select a functional test set and click
Run Test Set, or select a performance test set, then a performance test, and click Run Test.
In the Run <Entity> dialog box, select an AUT environment configuration. For user interface
details, see "" on page 563.
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l In a build verification suite.
In theBuild Verificationmodule, select a build verification suite and click Run. In the Run
Build Verification Suite dialog box, select an AUT environment configuration. For user interface
details, see "" on page 563.

5. Select a deployment and provisioning option (CDA only)
Deployment: When your system is integrated with CDA, you can select deployment and
provisioning actions for the application under test. ALM provides the following options in the
Timeslot Reservation dialog box and the Run <Entity> dialog box for this purpose:
l Provision and deploy. Allocates machines on which to deploy an environment for the
application under test, and prepares the required image so that the application can be installed.
That is, the operating system, database server and all required software are installed based on
CDA parameters. Following provisioning, the application under test itself is installed.

l Redeploy. Deploys and runs the application under test environment onmachines that have
already been provisioned.

l Use deployed. Uses an existing installation to run the test.

Note:

l When deciding which option to select, bear in mind that the provisioning and deployment
actions can be very time consuming. For routine testing, it is advisable to select Use
Deployed.

l You can arrange for an environment to be deployed and available for your run. Schedule a
build verification suite or test set to run for the entire day, and select the environment you
want to use.

Available for:All options are available for Build Verification Suite timeslots. For Functional test
set timeslots, Use Deployed is selected by default. You cannot change this selection.
Provisioning: ALM also allows you to select the action to be taken after an environment has been
deployed. ALM provides the following options:
l Leave environment deployed. Leaves the AUT environment deployed indefinitely. The
deployed environment can be used for future tests.

l Deprovision at end. After the tests have completed running, the environment is undeployed
and themachines are deprovisioned, freeing them up for other use.

Available for:Build Verification and Functional test set timeslots.
For user interface details, see " Timeslot Reservation Dialog Box" on page 647 and the "" on
page 563.

AUT Environments User Interface
This section includes:

• AUT Environments ModuleWindow 328
• AUT Environments ModuleMenus and Buttons 329
• AUT Environments Module Fields 332
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• AUT Environments Module Icons 333
• AUT Environment Details Dialog Box 333
• New AUT Environment Dialog Box 334
• AUT Environment Configuration Details Dialog Box 335
• New AUT Environment Configuration Dialog Box 336
• New AUT Parameter Dialog Box 336
• AUT Parameter Details Dialog Box 337
• Link to CDA Dialog Box 338

AUT Environments ModuleWindow

To access On the ALM sidebar, under Lab Resources, select AUT Environments.

Important
information ALM Editions: The AUT Environments module is available only in ALM Edition.

For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your
ALM site administrator.

Relevant
tasks

"How toWork with AUT Environments" on page 325

See also "AUT Environments Module Fields" on page 332

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<AUT Environments
module common UI
elements>

l AUT Environments fields. For field definitions, see
"AUT Environments Module Fields" on page 332.

l AUT Environments menus and buttons. For command and button
descriptions, see "AUT Environments ModuleMenus and Buttons" on
the next page.

l AUT Environments icons. For icon descriptions, see "AUT
Environments Module Icons" on page 333.

l ALM masthead, menus, and sidebar. For details, see "ALM Common
Areas" on page 32.

<filter status bar> Describes the filter currently applied to the tree. Located directly above the
tree.

<AUT Environments
tree>

Located on the left side of the window, organizes and displays your
AUT environments hierarchically.

Note: You cannot move AUT environments within a folder. When you
refresh the tree view, AUT Environments in a folder are alphabetized.
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UI Element Description

Details tab Located on the right side of the window. Lists the AUT environment fields.
For details on the fields, see "Test PlanModule Fields" on page 366.

Parameters tab Located on the right side of the window. Contains a grid of the parameters
and default values for the selected AUT Environment object.

If you do not override the AUT environment parameter in an
AUT environment configuration then the default value is used during
execution.

Note: Only visible when an AUT environment object is selected.

Values tab Located on the right side of the window. Contains a grid of parameters and
values for the selected AUT environment configuration object.

You can select a parameter in the values tab and override the default value
derived from the AUT environment level. If you do not override a parameter
value, the default value is used during execution.

Note: You cannot modify the parameters in the automatically
generated Default AUT environment configuration.

If the AUT environment configuration is linked to CDA, you can select a
dynamic value from a drop-down list in the CDA parameter list.

For more information on CDA, see "Link AUT Environments to CDA" on
page 324.

Note: Only visible when an AUT environment configuration object is
selected.

AUT Environments Module Menus and Buttons
This section describes themenus and buttons available in the AUT Environments module.

To access On the ALM sidebar, under Lab Resources, select AUT Environments.

Relevant tasks "How toWork with AUT Environments" on page 325

See also l "AUT Environments Overview" on page 324
l "AUT Environments Module Fields" on page 332
l "AUT Environments ModuleWindow" on the previous page
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User interface elements are described below:

UI Element (A - Z) Menu Description

AUT Environment
Configuration

Details

AUT Environments Opens the AUT Environment Configuration Details
dialog box, enabling you to view and update details of the
selected AUT Environment Configuration. For details,
see "AUT Environment Configuration Details Dialog
Box" on page 335.

AUT Environment

Details

AUT Environments Opens the AUT Environment Details dialog box,
enabling you to view and update details of the selected
AUT Environment. For details, see "AUT Environment
Details Dialog Box" on page 333.

Collapse View Collapses all branches in the tree.

Copy URL/Paste AUT Environments Copies a selected AUT environment, AUT environment
folder, or AUT environment configuration and pastes its
URL as a link. The AUT environment or
AUT environment configuration itself is not copied.
Instead, you can paste the address into another location,
such as an email or a document. Clicking on the link
opens ALM and takes you to the AUT Environment or
AUT environment configuration . If you are not already
logged in, ALM first prompts for login details.

Cut/Paste Edit Cuts selected AUT environments and configurations
within the same project or across projects.

Delete
Edit From the toolbar, deletes a selected AUT environment,

AUT environment folder, or AUT environment
configuration. You cannot delete the root
AUT Environments folder.

From the Parameters tab toolbar, deletes the selected
parameter folder or parameter.

Expand All View Expands all folders in the AUT Environments tree below
the selected folder.

Go to
AUT Environment

AUT Environments Opens the Go to AUT Environment dialog box, enabling
you to type an AUT environment ID to find a specific
AUT environment in the AUT Environments tree.

Link
AUT Environment
Configuration to

CDA

Opens the Link to CDA tab, enabling you to link the
selected AUT environment configuration to a
CDA topology.
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UI Element (A - Z) Menu Description

New
AUT Environment

AUT Environments Opens the New AUT Environment dialog box, enabling
you to add an AUT environment to a selected folder. For
details, see "New AUT Environment Dialog Box" on
page 334.

New
AUT Environment
Configuration

AUT Environments Opens the New AUT Environment Configuration dialog
box, enabling you to add an AUT environment
configuration to a selected folder. For details, see "New
AUT Environment Configuration Dialog Box" on
page 336.

New
AUT Environment

Folder

AUT Environments Opens the New AUT Environment Folder dialog box,
enabling you to add a folder under a selected folder.

Syntax exceptions:An AUT environment folder name
cannot include the following characters: \ ˆ *

New
AUT Parameter

Opens the New AUT Parameter dialog box, enabling you
to add an AUT parameter and parameter value to an
AUT environment.

Located in the Parameters tab toolbar.

For details, see "New AUT Parameter Dialog Box" on
page 336.

Open
Applications
Page in CDA

Opens the CDA applications page. For details, see the
documentation for CDA.

Refresh All
View Refreshes the view to display themost up-to-date

information.

Rename Edit Enables you to rename an AUT environment, an
AUT environment folder, or an AUT environment
configuration. You cannot rename the root
AUT Environment folder.

Restore Default
Parameter Value

Restores the value of the selected AUT environment
configuration parameter to the default AUT environment
value.
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UI Element (A - Z) Menu Description

Set Filter/Sort View Enables you to set filter and sort options for the
AUT Environments tree.

Includes the following options:

l Set Filter/Sort. Opens the Filter dialog box, enabling
you to filter and sort AUT Environments.

l Clear Filter/Sort. Clears any filters or sorting that
you have applied.

For more details, see "Filter Dialog Box" on page 51.

Update Selected Edit Opens the Update Selected dialog box, enabling you to
update a field value for multiple selected environments,
configurations, and folders in the tree. For more details,
see "Update Selected Dialog Box" on page 79.

AUT Environments Module Fields
This section describes the AUT Environments module fields.

To access On the ALM sidebar, in Lab Resources, select AUT Environments.

Important
information

The AUT Environments module displays the environment configuration data
fields for functional testing in ALM.

Relevant tasks "How toWork with AUT Environments" on page 325

See also l "AUT Environments Overview" on page 324
l "AUT Environments ModuleMenus and Buttons" on page 329
l "AUT Environments ModuleWindow" on page 328

User interface elements are described below:

UI Element (A - Z) Description

AUT Environments
ID

The ID of the AUT environment to which the selected AUT environment
configuration belongs.

AUT Environments
Folder ID

The ID of the folder of the AUT environment.

Default Value The default value of the selected AUT parameter for the selected
AUT environment.

Name The name of the AUT environment, AUT environment configuration,
AUT environment folder, or AUT parameter.

Value The value of the selected AUT parameter. The value can be default or
overridden in an AUT environment configuration.
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AUT Environments Module Icons
This section describes the icons available in the AUT Environments module.

To access On the ALM sidebar, select AUT Environments.

Relevant tasks "How toWork with AUT Environments" on page 325

See also l "AUT Environments ModuleWindow" on page 328
l "AUT Environments Module Fields" on the previous
page

The icons are described below:

UI Element Description

AUT environment folder

AUT environment

AUT environment configuration

AUT environment parameter

AUT Environment Details Dialog Box

To access On the ALM sidebar, under Lab Resources, select AUT Environments. Select an

AUT environment and click .

Relevant
tasks

"How toWork with AUT Environments" on page 325

See also "AUT Environments Module Fields" on the previous page

User interface elements are described below:

UI Element Description

Save. Saves the details.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.
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UI Element Description

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Name The name associated with the selected AUT environment.

Details Lists the AUT environment fields. For details on AUT environment fields, see
"AUT Environments Module Fields" on page 332.

Parameters Lists parameters associated with the currently selected AUT environment. You can
add AUT parameters or modify the default value of AUT parameters associated with
the selected AUT environment. For user interface details, see "New AUT Parameter
Dialog Box" on page 336 and "AUT Parameter Details Dialog Box" on page 337.

New AUT Environment Dialog Box

To access On the ALM sidebar, under Lab Resources, select AUT Environments. Click

.

Relevant
tasks

"How toWork with AUT Environments" on page 325

See also l "AUT Environments Module Fields" on page 332
l "AUT Environments Overview" on page 324

User interface elements are described below:

UI
Element

Description

Clear All Fields. Clears the data.

Check Spelling. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Name The name associated with the new AUT environment.
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UI
Element

Description

Details Lists the AUT environment fields. For details on AUT environment fields, see
"AUT Environments Module Fields" on page 332.

AUT Environment Configuration Details Dialog Box

To
access

On the ALM sidebar, under Lab Resources, select AUT Environments. Select an

AUT environment configuration and click .

Relevant
tasks

"How toWork with AUT Environments" on page 325

See also l "AUT Environments Module Fields" on page 332
l "AUT Environments Overview" on page 324

User interface elements are described below:

UI
Element

Description

Clear All Fields. Clears the data.

Check Spelling. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Details Lists the AUT environment fields. For details on AUT environment fields, see
"AUT Environments Module Fields" on page 332.

Link to
CDA

Enables you to link the selected AUT environment configuration to CDA. For more
information, see "Link to CDA Dialog Box" on page 338.
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New AUT Environment Configuration Dialog Box

To access On the ALM sidebar, under Lab Resources, select AUT Environments. Select an

AUT environment, and click .

Relevant
tasks

"How toWork with AUT Environments" on page 325

See also l "AUT Environments Module Fields" on page 332
l "AUT Environments Overview" on page 324

User interface elements are described below:

UI
Element

Description

Clear All Fields. Clears the data.

Check Spelling. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Name The name associated with the new AUT environment configuration.

Details Lists the AUT environment configuration fields. For details on AUT environments fields,
see "AUT Environments Module Fields" on page 332.

Link to
CDA

Enables you to link the selected AUT environment configuration to CDA. For more
information, see "Link to CDA Dialog Box" on page 338.

New AUT Parameter Dialog Box

To
access

On the ALM sidebar, under Lab Resources, select AUT Environments. Select an

AUT environment, and click on the right pane.

Relevant
tasks

"How toWork with AUT Environments" on page 325
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See also l "AUT Environments Module Fields" on page 332
l "AUT Environments Overview" on page 324

User interface elements are described below:

UI
Element

Description

Clear All Fields. Clears the data.

Check Spelling. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Name The name associated with the new AUT parameter.

Details Lists the AUT parameter fields. For details on AUT environment fields, see
"AUT Environments Module Fields" on page 332.

AUT Parameter Details Dialog Box

To
access

On the ALM sidebar, under Lab Resources, select AUT Environments. Select an
AUT environment and then select an AUT parameter on the right pane.

Relevant
tasks

"How toWork with AUT Environments" on page 325

See also l "AUT Environments Module Fields" on page 332
l "AUT Environments Overview" on page 324

User interface elements are described below:

UI
Element

Description

Clear All Fields. Clears the data.

Save. Saves the details.
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UI
Element

Description

Check Spelling. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Name The name of the selected AUT parameter.

Details Lists the AUT environment fields. For details on AUT environment fields, see
"AUT Environments Module Fields" on page 332.

Link to CDADialog Box

To
access

Select an AUT Environment Configuration from the AUT Environments module. Then do
one of the following:

l Click the Link to CDA button.

l Click the AUT Environment Configuration Details button. On the
AUT Environment Configuration Details dialog box sidebar, select Link to CDA.

Relevant
tasks

"How toWork with AUT Environments" on page 325

See also l "AUT Environments Module Fields" on page 332
l "AUT Environments Overview" on page 324

User interface elements are described below:

UI Element Description

Check Spelling. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.
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UI Element Description

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Name The name of the selected AUT environment configuration.

Clear Link to

CDA

Removes the linkage between the selected AUT environment configuration and
the CDA topology.

Reload
CDA entities
from the server

Reloads the list of available CDA entities. Any changes that occurred on the
CDA server side will be updated in the lists in the dialog box.

Caution: Reloading the list of CDA entities will remove all your linkages.

Open <Page>

in CDA

Opens a CDA page.

If you have not yet selected a Deployment Topology, the Applications Page in
CDA opens. If you have selected a Deployment Topology, the Linked Topology
Page in CDA opens.

<CDA topology
link section>

Enables you to configure the linkage between the selected AUT environment
configuration and a CDA topology.

If your project is defined to work with CDA domainA, but you selected an
application linked to a platform in CDA domainB, you will be able to see stored
configurations from domainB even though domainB is not linked to the project.

By default, there is no linkage between CDA and the AUT environment
configuration. To link, click none and select a CDA parameter.

Select the following CDA topology levels:

l Application
l Application Version
l ApplicationModel
l Deployment Topology
l Topology Stored Parameters
l Platform Stored Parameters
l Software Package Definition

Note: If you do not complete all of the selections, you are not able to link
your AUT environment configuration to a CDA topology.

User Guide
Chapter 21: AUT Environments

HP ALM (12.50) Page 339



Page 340HP ALM (12.50)

User Guide
Chapter 21: AUT Environments



HP ALM (12.50) Page 341

Part 6: Test Plan



HP ALM (12.50) Page 342



Chapter 22: Introducing Test Planning
This chapter includes:

• Test Plan Overview 344
• How to Plan Tests in ALM 344
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Test Plan Overview
Developing a clear and concise test plan is fundamental to successful application testing. A good test
plan enables you to assess the quality of your application at any point in the applicationmanagement
process.

Outline a strategy for achieving your requirements, as defined in the Requirements module. Ask
yourself two basic questions:

How should you test your application?
l Which testing techniques will you use (stress tests, security tests, performance and load tests,
etc.)?

l How will you handle defects (severity classification, authorization to open and close defects, etc.)?

What resources do you require?
l What resources do you require to test (personnel, hardware, etc.)?
l Whenwill the various tasks be completed?

Example

Consider a flight reservation application that lets youmanage flight scheduling, passenger
bookings, and ticket sales. Testing will require designing bothmanual and automated tests. You
could assign testing personnel with programming experience the task of designing automated
tests, while non-programmers could designmanual tests.

How to Plan Tests in ALM
This task describes how to work with tests in HP Application Lifecycle Management (ALM).

Note: This task is part of a higher-level task. For details, see "ALM Basic Flow" on page 22.

This task includes the following steps:

l "Prerequisites" on the next page
l "Create a test plan tree" on the next page
l "Create dependencies with test resources – optional" on the next page
l "Define test parameters" on the next page
l "Define test configurations" on the next page
l "Create test steps" on the next page
l "Automate tests" on the next page
l "Create requirements coverage" on page 346
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l "Link a test to a defect" on the next page
l "Analyze test plan data" on the next page
l "Establish a baseline" on the next page

1. Prerequisites
A set of requirements is defined in the Requirements tree.
For task details, see "How to Use Requirements in ALM" on page 220.

Tip: You can automatically create tests based directly on your requirements in the
Requirements module. For more details, see the step for converting requirements to tests in
the "How to Create Requirements" on page 224 task.

2. Create a test plan tree
Create a test plan tree of test subject folders and tests. For task details, see "How to Create
Tests" on page 348.

3. Create dependencies with test resources – optional
You can associate tests with a set of resources that you upload to the ALM repository.
You can then view these dependencies and determine the resources that are in use. For task
details, see "How to Use Test Resources" on page 449.
Business Process Testing:You can associate component design steps with application area
resources that you upload.

4. Define test parameters
Tomake tests more flexible, you can include parameters in test steps. This enables you to run the
same test repeatedly and assign different values to the parameters. For task details, see "How to
Use Test Parameters" on page 394.

5. Define test configurations
To run tests for different use-cases, you can define test configurations. This enables you to run the
same test under different scenarios. For task details, see "How toWork with Test Configurations"
on page 420.

6. Create test steps
Create test steps describing the operations to perform and their expected results. After you define
the test steps, decide whether to perform the test manually or to automate it. For task details, see
"How to Design Test Steps" on page 405.

7. Automate tests
After designing test steps, decide which tests to automate. Factors influencing test automation
include frequency of execution, volume of data input, length of execution time, and complexity.
For task details, see "How to Design Test Steps" on page 405.
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System Tests. You can also create automated system tests that provide system information for a
machine, capture a desktop image, or restart a machine. For task details, see "How to Create
System Tests" on page 444.

8. Create requirements coverage
Link each test in the test plan tree with a requirement or requirements in the requirements tree. By
defining requirements coverage for a test, you keep track of the relationship between the tests in
your test plan and your original requirements. For task details, see "How to Create Coverage" on
page 376.

9. Link a test to a defect
Link a test to specific defects. This is useful, for example, when a new test is created specifically
for a known defect. By creating a link, you can determine if the test should be run based on the
status of the defect. For user interface details, see "Linked Defects/Entities Page" on page 710.

10. Analyze test plan data
Analyze the test plan by generating reports and graphs.
Use one of the following:
l View dynamic graphs of test subjects. In the test plan tree, select a test subject, and click
the Live Analysis tab. For task details on generating live analysis graphs, see "How to
Generate Live Analysis Graphs" on page 832.

l View test plan data in a graph. On the Test Planmodulemenu, select Analysis > Graphs.
For task details on generating graphs, see "How to Generate a Graph" on page 736.

l Create a report of test plan data. On the Test Planmodulemenu, select Analysis > Project
Report. For task details on creating reports, see "How to Create Project Reports" on page 776.

For details on additional analysis tools in ALM, see "How to Analyze Data in ALM" on page 718.

11. Establish a baseline
After your test plan has been reviewed and approved, you can create a baseline. A baseline
provides you with a snapshot of your test plan at a specific point in time. Use a baseline tomark
any significant milestone in the application lifecycle. The baseline then serves as a point of
reference against which changes can be compared. For task details, see "How to Use Libraries
and Baselines in ALM" on page 181.
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Chapter 23: Test Plan Specification
This chapter includes:

• Test Plan Specification Overview 348
• How to Create Tests 348
• Test Types 351
• Test Plan User Interface 353
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Test Plan Specification Overview
The typical application is too large to test as a whole. The Test Planmodule enables you to divide your
application according to functionality. You divide your application into units, or subjects, by creating
folders in a test plan tree. This is a graphical representation of your test plan, displaying your tests
according to the hierarchical relationship of their functions.

After you define subjects in the tree, you decide which tests to create for each subject and add them to
the tree. At this stage, you define basic information about the test, such as its name, status, and the
designer. You can also attach a file, URL, application snapshot or system information to illustrate a
test. Afterwards, you define the test steps. Test steps contain detailed instructions on how to execute
a test and evaluate the results.

ALM enables you to use the same test to test different use-cases, each with its own test
configuration. Each test configuration uses a different set of data. You define the data by adding test
parameter values for each test configuration. A test parameter is a variable that can be assigned a
value.

During the applicationmanagement process, youmay need tomodify your test plan. You can update
the test plan tree at any time.

There are a number of methods for organizing your test plan by subject. For example, you could define
subjects according to:

l Application functionality—such as editing, file operations, and reporting
l Type of testing—such as functional, user interface, performance, and load

Note: Developing and editing a test plan tree requires appropriate user permissions. For more
information, refer to theHP Application Lifecycle Management Administrator Guide.

For details on specifying tests, see "How to Create Tests" below.

How to Create Tests
This task describes how to create folders of test subjects in the test plan tree, and add tests to the test
subjects.

Note: This task is part of a higher-level task. For details, see "How to Plan Tests in ALM" on
page 344.

To learnmore about test specification, see "Test Plan Specification Overview" above.

This task includes the following steps:

l "Create test subjects" on the next page
l "Create tests in the test plan tree" on the next page
l "Create tests from a testing tool – optional" on page 350
l "Import tests – optional" on page 350
l "Create amanual template test – optional" on page 350
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l "Create a UFT template GUI test – optional" on page 351
l "Add steps to tests" on page 351

1. Create test subjects
Create folders in the test plan tree. Each folder represents a test subject – a testing area in your
application.
To create a test subject:
a. On the ALM sidebar, under Testing, select Test Plan.
b. Select View > Test Plan Tree.

c. Select theSubject root folder or an existing test subject, and click New Folder .

Example

To test a flight reservation application that lets youmanage flight scheduling, passenger
bookings, and ticket sales, youmight define the following subjects for the test plan tree:

Notice how the Itinerary subject contains additional subject folders. These folders further
categorize the tests in the test plan tree by creating additional levels of subjects. For the
complete example, refer to theALM_Demo project.

2. Create tests in the test plan tree
Create tests under test subject folders.
To create tests:
a. In the Test Plan tree, right-click the folder, and select New Test.
b. Fill in the fields in the New Test dialog box. For user interface details, see "New Test Dialog

Box" on page 371.
Each test should have a distinct objective, such as verifying a specific function or system
requirement. The tests you define should be based on the goals you set at the beginning of the
applicationmanagement process.
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Example

In the test plan tree shown in the previous step, youmight assign tests to the Itinerary
subject folders as follows:

Tip: For test types that support test configurations, a test configuration is automatically
created when you create the test. For details, see "How toWork with Test
Configurations" on page 420.

Note: To create and edit Unified Functional Testing tests from within ALM, youmust install
the UFT add-in from the Add-ins page. You can access the Add-ins page in ALM from Help >
Add-ins.

3. Create tests from a testing tool – optional
You can add tests to the ALM Test Plan tree from supported testing software such as Unified
Functional Testing. For more information, see the user guide for the appropriate testing tool.

Note: UFT tests can be added to ALM from within UFT without needing to install the UFT
add-in. These tests can then be run normally from ALM.

4. Import tests – optional
In addition to creating a test plan tree in the ALM Test Planmodule, you can also import test plan
data fromMicrosoft Word or Microsoft Excel to your ALM project. To import test plan data, you
must first install the appropriate add-in. For more information, see "Data Import fromMicrosoft
Word andMicrosoft Excel " on page 26.

5. Create a manual template test – optional
If there are common instructions that will be repeated in several tests, for example Log in to
the application, you can create amanual template test of common instructions, that is then
called by other manual tests.

Note: It is not essential to mark a test as a template test to be able to call it.
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To create a manual template test:
a. Create amanual test, as described in the step above for creating tests in the test plan tree.
b. Right-click the new test in the test plan tree, and selectMark as Template Test. The test

icon changes from gray to white, indicating that it is now a template test.

6. Create a UFT template GUI test – optional
HP Unified Functional Testing (UFT) comprises the product formerly known as HP QuickTest
Professional and the product known as HP Service Test.
l Functionality provided by QuickTest is now known as GUI testing in UFT.
l Functionality provided by Service Test is also known as API testing in UFT.
The template test defines which UFT add-ins ALM associates with a new UFT GUI test. For
details,see the Unified Functional Testing documentation and the relevant Unified Functional
Testing add-in documentation.
In addition to the default UFT template GUI test that is provided with the ALM client, you can
create other UFT template tests.
To create a UFT template test:
a. Create a UFT GUI test, as described above in the step for creating tests in the test plan tree.
b. Right-click the new test in the test plan tree, and selectMark as Template Test. The test

icon changes from gray to white, indicating that it is now a template test.

7. Add steps to tests
Add steps to tests, describing the actions a tester should perform to complete the tests.
For task details, see "How to Design Test Steps" on page 405.

Test Types
The following test types are available in the Test Planmodule.

ALM Editions:Not all test types are available with each edition. For more information about ALM
editions and their functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

Test
Icon Test Type Description

BUSINESS-
PROCESS

A business process test. For details, refer to theHP Business Process
Testing User Guide.

EXTERNAL-
TEST

A test entity that references a test saved in an external repository. For
more details, see "Integrating External Tests Overview" on page 594.
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Test
Icon Test Type Description

FLOW A test comprising a collection of business components in a fixed
sequence that performs a specific task. For more details, refer to the
HP Business Process Testing User Guide.

LR-SCENARIO A scenario that is executed by LoadRunner, the HP load testing tool.

MANUAL A test that is runmanually.

PERFORMANCE-
TEST

A performance test. For details, refer to theHP ALM Performance
Center Guide.

QAINSPECT_
TEST

A test that is executed by QAInspect, the HP security testing tool.

QUICKTEST_
TEST

A GUI test that is executed by Unified Functional Testing, the HP
functional enterprise testing tool.

This test type is only available if you have installed the appropriate add-
in from the HP Application Lifecycle Management Add-ins page. You
can access the Add-ins page in ALM from Help > Add-ins.

SERVICE-TEST An API test, created in Unified Functional Testing or HP Service Test,
HP's tool for creating tests for GUI-less applications such as Web and
REST services. For details on API tests, see theHP Service Test User
Guide or the information about API testing in theHP Unified Functional
Testing User Guide.

This test type is only available if you have installed the appropriate add-
in from the HP Application Lifecycle Management Add-ins page. For
details on installing add-ins, refer to theHP Application Lifecycle
Management Installation and UpgradeGuide.

Note: API tests can be viewed in, and launched from, ALM. You
can create API tests in Unified Functional Testing or HP Service
Test. Alternatively, you can create a business process test or flow
that is automated as an API test.

SYSTEM-TEST A test that instructs ALM to provide system information, capture a
desktop image, or restart a machine.

VAPI-XP-TEST A test that is created by Visual API-XP, the ALM open test architecture
API testing tool. For more information on VAPI-XP tests, see "VAPI-XP
Tests" on page 463.

VuGenScript A VuGen script that is executed by LoadRunner, the HP load testing
tool.
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Test Plan User Interface
This section includes:

• Test PlanModuleWindow 354
• Test PlanModuleMenus and Buttons 356
• Test PlanModule Icons 365
• Test PlanModule Fields 366
• Test Details Dialog Box 369
• New Test Dialog Box 371
• Sort Folders in Test Plan Tree Dialog Box 373
• Paste Tests/Folders to Target Project Dialog Box 374
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Test Plan ModuleWindow
The test plan window enables you to define andmaintain ALM tests, either in a Test Plan Tree, or a
Test Plan Grid.

To access 1. On the ALM sidebar, under Testing, select Test Plan.
2. In theViewmenu, select Test Grid or Test Plan Tree.

Important
information

The Test Plan window includes the following views.

l Test Plan Tree. Displays test subjects and tests hierarchically in a tree.
l Test Grid. Displays tests in a flat, non-hierarchical view. Each line in the grid
displays a separate test.

Tip: To enable scrolling in the Test Grid view after editing a field, click the
Escape key, then scroll using themouse wheel or the up/down arrow keys.

Business Process Testing:Different tabs are displayed in this module if you are
working with a business process test. For details, refer to theHP Business Process
Testing User Guide.

Relevant
tasks

"How to Plan Tests in ALM" on page 344

"How to Create Tests" on page 348

See also "Test PlanModule Fields" on page 366

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Test Plan
module
common UI
elements>

l Test Plan fields. For field definitions, see "Test PlanModule Fields" on
page 366.

l Test Plan menus and buttons. For command and button descriptions, see
"Test PlanModuleMenus and Buttons" on page 356.

l Test Plan icons. For icon descriptions, see "Test PlanModule Icons" on
page 365.

l ALM masthead, menus, and sidebar. For details, see "ALM Common
Areas" on page 32.

<filter status
bar>

Describes the filter currently applied to the grid or tree. Located directly above the
grid filter boxes or tree.

In grid views:

l Showing <x> results. Indicates the number of records currently displayed out
of the total records.

l Retrieve all <x> results. Click to display all records.
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UI Element Description

<test plan
tree>

Located on the left side of the window, organizes and displays your tests
hierarchically.

Note: You cannot move tests within a folder. When you refresh the tree view,
tests in a folder are alphabetized.

<grid filters> Displays a grid filter box under each column name, enabling you to define a filter
condition for a column.

Type directly into the box, or click the box to display the browse button, which
opens the Select Filter Condition dialog box. For user interface details, see
"Select Filter Condition Dialog Box" on page 61.

Available from: Test Grid view

Details tab Lists the test fields. For details on test fields, see "Test PlanModule Fields" on
page 366.

Tip: Clicking in theDescription orComments field in this tab displays a
toolbar for formatting and spell checking the text.

Test Script tab l For automated tests: The test script that is run by the testing tool for the
currently selected test. For user interface details, see "Test Script Tab" on
page 412.

l For business process tests and flows: The components and flows that are
run for the currently selected test (or the components that are run for the
currently selected flow). For user interface details, see see theHP Business
Process Testing User Guide.

Design Steps
tab

Lists the instructions on how to execute the selected test. For more details, see
"Design Steps Tab/Design Step Details Dialog Box" on page 408.

Parameters tab Lists parameters associated with the currently selected test. Parameters can be
incorporated in the test's design steps. For more details, see "Parameters
Tab/Parameters Dialog Box" on page 396.

Test
Configurations
tab

Displays the test configurations of the selected test. For more details, see "Test
Configurations Tab" on page 429.

Attachments
tab

Lists attachments that provide additional information about the currently selected
test. For more details, see "Attachments Page" on page 72.

Req Coverage
tab

Lists the requirements that aremet by the currently selected test. For more
details, see "Req Coverage Tab" on page 379.

Linked Defects
tab

Lists the defects linked to the currently selected test. For more details, see
"Linked Defects/Entities Page" on page 710.
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UI Element Description

Dependencies
tab

Displays dependency relationships that exist between entities such as test
resources and tests. For more information, see "Dependencies Tab" on page 459.

Business
Models
Linkage

Lists the business model entities linked to the currently selected test. For more
details, see "Business Models Linkage Tab" on page 384.

Criteria tab Displays criteria of the selected business process test. For user interface details,
see "Criteria Tab" on page 415.

Business Process Testing:Functionality related to test criteria is available only
for business process tests. For task details, see theHP Business Process
Testing User Guide.

History tab Lists changes made to the currently selected test. For more details, see "History
Tab" on page 68.

Live Analysis
tab

Displays a graphical representation of test data related to the selected test
subject folder. For more details, see "Live Analysis Tab" on page 834.

Available from: Test Plan Tree view

Test Design
tab

Performance Center:Displays a detailed summary of the selected performance
test. For more details, refer to theHP ALM Performance Center Guide.

Test Plan Module Menus and Buttons
This section describes themenus and buttons available in the Test Planmodule.

To access On the ALM sidebar, under Testing, select Test Plan.

Important
information

l Somemenu commands and buttons are not available in all test plan views.
l Tip: You can access themenu bar from the Test Planmodule by pressing the

shortcut key ALT.

l Version Control:Additional menu commands and buttons are available in a
version control enabled project. For details, see "Versions Menu and Buttons" on
page 108.

l Business Process Testing: Additional menu commands and buttons are
available for Business Process Testing. For details, see theHP Business Process
Testing User Guide.

l Available in ALM 12.21:Additional menu commands and buttons are available
for BPT Packaged Apps Kit. For details, see theHP Business Process Testing
User Guide.

Relevant
tasks

"How to Create Tests" on page 348
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See also l "Test PlanModuleWindow" on page 354
l "Test PlanModule Icons" on page 365

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A - Z)

Menu Description

<list of
recently used
favorite
views>

Favorites Displays the four most recently used favorite views in the Test Plan
module.

You can define the number of views displayed on themenu by setting
the FAVORITES_DEPTH parameter in the Site Configuration tab in
Site Administration. For details, see theHP Application Lifecycle
Management Administrator Guide.

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view
to your private or the public folder. For details, see "Add Favorite Dialog
Box" on page 94.

Alerts Edit Opens the Alerts dialog box, enabling you to display alerts for the test.
For details, see "Alerts Dialog Box" on page 88.

Attachments <toolbar> Opens the Attachments page, enabling you to add attachments to the
selected test. For details, see "Attachments Page" on page 72.

Clear Alerts Edit Clears displayed alerts for themodule. For more details, see "How to
Use Alerts" on page 86.

Clear Default
Values

Edit Removes default values set using the Set Default Values dialog box.
No defaults are available when creating new tests or test
configurations.

Clear Follow
Up Flag

Edit Clears a follow up flag of a selected test. For more details, see "Follow
Up Flags Overview" on page 85.

Available from: Test Grid

Collapse View Collapses all branches in the test plan tree.

Convert to
Component

Tests Creates components from a test or a flow. For user interface details,
refer to theHP Business Process Testing User Guide

Copy
URL/Paste

Edit Copies a selected test and pastes its URL as a link. The test itself is
not copied. Instead, you can paste the address into another location,
such as an email or a document. Clicking the link opens ALM and
takes you to the test. If you are not already logged in, ALM first
prompts for login details.
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UI Element
(A - Z)

Menu Description

Copy/Paste Edit Copies selected tests within the same project or across projects.
When you copy a test subject, any subfolders and tests of the test
subject are also copied.

Note:

l When you copy a test from one project to another, if the test
contains calls to other tests, or if the tests are dependent on
test resources or other entities, you can instruct ALM to copy
them using one of threemethods. For more details, see "Paste
Tests/Folders to Target Project Dialog Box" on page 374.

l To copy tests across projects, both projects must use the same
ALM version and patch level.

l ThePaste option is only available from the Test Plan Tree.

Cut/Paste Edit Moves selected tests to a different location in the test plan tree.

Note:

l Whenmoving a test subject, any subfolders and tests of the
test subject aremoved with it. The root folder cannot bemoved.

l ThePaste option is only available from the Test Plan Tree.

Tip: You can alsomove a test or test subject to a new location in
the test plan tree by dragging it.
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UI Element
(A - Z)

Menu Description

Delete
Edit Deletes the selected test or folder in the test plan tree.

When deleting a folder, select one of the following options:

l Delete folders only. Deletes folders andmoves all related tests to
theUnattached folder.

l Delete folder and tests. Deletes folders, tests, and test scripts.
Version Control:Deleting a test deletes all previous versions of the
test.

When deleting a test, if dependencies are defined for the test, the
Delete Test dialog box opens. To view theUsed By entities, click
Details.

Caution:

l You cannot delete the root Subject folder.
l If you choose to delete a folder and tests, all subfolders and
tests under the selected folder are deleted permanently.

l If you delete a test, the test and test script are deleted
permanently. In addition, all test runs associated with the
deleted test are deleted.

l If dependencies are defined for a test, deleting the test may
impact the dependent entities. To view the dependencies
before you delete, click the Dependencies tab. For more details
on related entities, see "Dependencies Tab" on page 459.

l Performance Testing:Deleting a performance test that is
linked to a timeslot will affect the timeslot.

Description
Page

<right-
click
menu>

Opens the Description tab.

Available from: Test Grid

Edit Test
Tests Performance Center:Opens the Performance Test Designer,

enabling you to design a performance test. For details, refer to theHP
ALM Performance Center Guide

Expand All View Expands all branches in the test plan tree.
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UI Element
(A - Z)

Menu Description

Export <right-
click
menu>

Opens the Export Grid Data dialog box, enabling you to export the tests
in a grid as a text file, Microsoft Excel worksheet, Microsoft Word
document, or HTML document.

Choose one of the following options:

l All. Exports all tests in the grid.
l Selected. Exports selected tests in the grid.
Available from: Test Grid

Filter/Sort View Enables you to filter and sort the tests in the test tree or grid. Any
currently applied filters or sorting orders are displayed below the
toolbar. For more details, see "Filter Dialog Box" on page 51.

Note: A filter that is defined in one test plan view does not apply to
the other view.

Find Edit Opens the Find dialog box, enabling you to search for a test in the Test
Planmodule. For more details, see "Find Dialog Box" on page 63.

Find Next Edit Searches for the next item in the test grid that meets the previously
defined search criteria.

Flag for
Follow Up

Edit Opens the Flag For Follow Up dialog box, enabling you to define a
follow up flag for a selected test. For more details, see "Flag For Follow
UpDialog Box" on page 89.

Generate
from Test
Report

Tests Opens the Generate Tests from External Test Results dialog box,
enabling you to import your tests from an external file to your Test Plan
Tree. For more details, see "Generate Tests from External Test
Results Dialog Box" on page 600.

Global
Search

<toolbar> A global search engine enabling you to search across all or a specific
ALMmodule. It includes the followingmodules: Defects,
Requirements, Tests, Test Sets, and Analysis. For more details on
how to install and enable Global Search, see
https://hpln.hp.com/contentoffering/alm-global-search.

Go to Test Tests Opens the Go To Test dialog box, enabling you to find a specific test by
Test ID. You can only go to tests that are in the current filter.

User Guide
Chapter 23: Test Plan Specification

HP ALM (12.50) Page 360

https://hpln.hp.com/contentoffering/alm-global-search


UI Element
(A - Z)

Menu Description

Go to
Entity in
Module Tree

<toolbar> Navigates to the location of the selected entity in that entity's module,
and highlights the selected entity.

Available from:

l Select Components and Flows pane, for business process tests
l Business Models Linkage > Business Models Tree pane
l ReqCoverage > Requirement Tree pane

Go to Test in
Test Plan

Tree

<toolbar> Goes to the Test Plan Tree view and highlights the selected test.

Available from: Test Grid

Go to Test in

Test Set

Tests Enables you to view instances of a test in test sets in the Test Lab
module.

If there is only one instance of the selected test, the Test Labmodule
opens with the instance highlighted.

If there is more than one instance of the selected test, the Select Test
Set dialog box opens, and you select a test set and instance.

Go to Test
Configuration
in Test Set

Tests Goes to the test set associated with the selected test configuration in
the Execution Grid tab in the Test Labmodule.

Available from: Test Configurations tab

Graphs Analysis Lists the graphs you can generate for test plan data. Select a
predefined graph, or launch the graph wizard.

For details on the predefined graph types, see "Entity Graph Types" on
page 739.

History Page <right-
click
menu>

Opens the History tab. For more details, see "History Tab" on page 68.

Available from: Test Grid

Indicator
Columns

View Displays indicators on the left-side of the test window. For more
details, see "Test PlanModule Icons" on page 365.

Invert
Selection

Edit Unselects all previously selected tests in the grid and selects all
previously unselected tests.

Available from: Test Grid
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UI Element
(A - Z)

Menu Description

Live Analysis Analysis Lists options for displaying graphs in the Live Analysis tab. Add or
delete a graph, or configure its appearance.

For details on live analysis, see "Live Analysis Graphs Overview" on
page 832.

Available from: Live Analysis tab

Mark as
Template
Test

Tests For manual tests.Marks a test as a template test that you can then
call from another test.

After youmark a template test, themanual test icon changes from gray
to white .

For GUI tests.Marks a test as a template test that you will then be
able to use to create other UFT GUI tests.

Most
Recently
Used

Analysis Lists themost recently viewed reports and graphs in ALM. Displays up
to ten items.

New Folder Tests Opens the New Test Folder dialog box, enabling you to add a test
subject under a selected folder.

Syntax exceptions:A folder name cannot include the following
characters: \ ^ *

Available from: Test Plan Tree

New Test Tests Opens the Create New Test dialog box, enabling you to add a test
under a selected folder. For more details, see "New Test Dialog Box"
on page 371.

Available from: Test Plan and Test Plan Tree

Organize
Favorites

Favorites Organizes your favorite views. For details, "Organize Favorites Dialog
Box" on page 95.

Private Favorites Lists the favorite views that are accessible only to the user who
created them.

Pin/Unpin <toolbar> Pins or unpins the test plan.

Available from: Test Grid and Test Plan Tree.

For details, see "Pinned Items Overview" on page 98.
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UI Element
(A - Z)

Menu Description

Project
Reports

Analysis Lists the predefined project reports you can produce on test plan data.
For details on the report types, see "Predefined Project Reports" on
page 779.

Selecting a report from the list generates a preview of the report. The
preview displays up to five entities per report section. To generate the
full report, in the upper left corner of the preview, click the downward
arrow adjacent to theGenerate button and select the report format to
generate.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All View Refreshes the test plan tree or grid so that it displays themost up-to-
date tests.

Rename Edit Renames a selected test or folder. You cannot rename the root folder.

Syntax exceptions:A test name cannot include the following
characters: \ / : " ? < > | * % '

Replace Edit In the test grid, opens the Replace dialog box, enabling you to replace a
test field value. For more details, see "Replace Dialog Box" on
page 65.

Report
Selected

<right-
click
menu>

Displays a report of the selected tests.

Req
Coverage

View Enables the Advanced Coverage dialog box. For more details, see
"Add Advanced Coverage Dialog Box" on page 383.

Run Test
Tests Performance Center:Enables you to run the selected performance

test from the Test Planmodule. For more details on running
performance tests, refer to theHP ALM Performance Center Guide.

Select All Edit Selects all tests in the grid.

Available from: Test Grid

Select
Columns

View Opens the Select Columns dialog box, enabling you to determine
which fields to display in the test grid and their order. For more details,
see "Select Columns/Select Fields Dialog Box" on page 77.

Send by E-

mail

Tests Opens the Send E-mail dialog box, enabling you to send a test by email
to recipients selected from a list, or to the test designer. For more
details, see "Send E-mail Dialog Box" on page 69.
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UI Element
(A - Z)

Menu Description

Set Default
Values

Edit Opens the Set Default Values dialog box, enabling you to set default
values for certain test fields. For user interface details, see "Set
Default Values Dialog Box" on page 80.

Show Entity

Details

<toolbar> Opens the Details dialog box for the selected entity in read-only mode.

Available from:

l Select Components and Flows pane, for business process tests
l Business Models Linkage > Business Models Tree pane
l ReqCoverage > Requirement Tree pane

Show Details
and History

<right-
click
menu>

Displays information panel tabs on the bottom of the test grid.

Available from: Test Grid

Sort Folders View Opens the Sort Folders in Test Plan Tree dialog box, enabling you to
rearrange subfolders in a test subject folder. For more details, see "Sort
Folders in Test Plan Tree Dialog Box" on page 373.

Test Details Tests Opens the Test Details dialog box, displaying the details of the
selected test.

For user interface details, see "Test PlanModuleWindow" on
page 354.

For user interface details specific for Business Process Testing, refer
to theHP Business Process Testing User Guide.

Test Grid View Displays the Test Grid view, enabling you to view tests in a flat, non-
hierarchical view. Each line in the grid displays a separate test.

Test Plan
Tree

View Displays the Test Plan Tree view, enabling you to view your tests and
test subject hierarchically in a tree.

Text Search Edit Opens the text search pane in the lower part of the Test Planmodule
window, enabling you to search for records in predefined fields. For
more details, see "Text Search Pane" on page 66.

Update
Selected

Edit Opens the Update Selected dialog box, enabling you to update a field
value for multiple selected tests in the grid. For more details, see
"Update Selected Dialog Box" on page 79.

Upload Script Tests Performance Center:Enables you to upload VuGen scripts to ALM.
For more details, refer to theHP ALM Performance Center Guide.
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Test Plan Module Icons
This section describes the icons available in the Test Planmodule.

To access On the ALM sidebar, under Testing, select Test Plan.

Relevant tasks "How to Create Tests" on page 348

See also l "Test PlanModuleMenus and Buttons" on
page 356

l "Test PlanModuleWindow" on page 354

The icons are described below:

UI
Element

Description

<green asterisk>. The applicable tab is populated.

Alerts. Click to view alerts for the test.

l Red alert. The alert is new.
l Gray alert. The alert has already been read.
For details, see "Alerts Dialog Box" on page 88.

Attachments. Click to view attachments for the specified test.

Open an attachment by selecting it from the list. If there aremore than ten attachments,
click themore attachments link to view the list in theAttachments Page. For details,
see "Attachments Page" on page 72.

Business process test

External test

Flow of business components

Follow Up Flags. Click to view follow up flags for the test.

l Gray flag. The follow up flag is new.
l Red flag. The follow up date has arrived.
For details, see "Flag For Follow UpDialog Box" on page 89.

Linked Defects. Click to view linked defects for the test. For details, see "Linked
Defects/Entities Page" on page 710.

LoadRunner scenario

Manual Template test
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UI
Element

Description

Manual Template test that includes test steps

Manual test

Manual test that includes test steps

QAInspect test

Subject folder

System test

UFT GUI test

UFT GUI test that includes test steps

UFT Template GUI test that includes test steps

UFT Template GUI  test

Version Control. The test is checked out.

l Green lock. The test is checked out by the current user.
l Red lock. The test is checked out by another user.

Visual API-XP test

Vuser Script test

Test Plan Module Fields
This section describes the Test Planmodule fields.

To access On the ALM sidebar, under Testing, select Test Plan.
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Important
information

l You can add user-defined fields and change the label of any of the fields in the Test
Planmodule. You can also customize project lists. For more details, refer to the
HP Application Lifecycle Management Administrator Guide.

l You can use the Script Editor to restrict and dynamically change the fields and
values in the Test Planmodule. For more details, refer to theHP Application
Lifecycle Management Administrator Guide.

l When you select a test plan columnwith a user name value (including user-defined
fields), ALM displays a list with the name and full name of each user. You can
search for users, sort users, group users by user group, and select users from the
users list or a group tree. For more details, see "Users List Dialog Box" on page 62.

l Some fields are not available in all test plan views.
l Additional fields are available for business process tests and flows. For details,
see theHP Business Process Testing User Guide.

l Version Control:Additional fields are available in a version control enabled
project. For details, see "Version Control Fields" on page 109.

See also "Test PlanModuleWindow" on page 354

Test Plan Fields

UI Element
(A - Z)

Description

Class The name of the class.

Available for:EXTERNAL-TEST test type

Comments Displays comments about the test.

Click in the text box to display a toolbar for formatting and spell checking the text.

Creation
Date

The date on which the test was created. By default, the creation date is set to the
current ALM server date. Click the down arrow to display a calendar and select a
different creation date.

Description Describes the test.

Click in the text box to display a toolbar for formatting and spell checking the text.

Designer The user name of the person who designed the test.

Estimated
Dev Time

The time estimated to design and develop the test.
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UI Element
(A - Z)

Description

Execution
Status

The execution status of the last run of an instance of the test. Execution status can
be one of the following:

l Blocked. One or more steps cannot run. For example, the test is running on a
remotemachine but cannot continue due to some environmental failure, such as
network problems or hardware failure.

l Failed. One or more steps in the run failed, and none have the status Blocked.
l N/A. The current status of the test is not applicable.
l No Run. No steps have been run.
l Not Completed. One or more steps were not completed or not run, and none have
the status Blocked or Failed.

l Passed. The run was successful.

Method The name of themethod.

Available for:EXTERNAL-TEST test type

Modified The date and time of the last change to the test.

Package The name of the package.

Available for:EXTERNAL-TEST test type

Path The path of this test relative to the Tests directory in the project repository.

Status The planning status of the test. The default status is Design.

Subject The subject folder in the test plan tree in which the test resides.

Template Indicates whether themanual test or UFT GUI test is a test template. The value in
this column is Y if the test is a test template; N or empty otherwise. For task details,
see "How to Create Tests" on page 348.

Test Effort The amount of effort required to design and run the current test.

Test ID A unique numeric ID for the test, assigned automatically by ALM. This is a read-only
field.

Testing
Framework

The testing framework type.

Available for:EXTERNAL-TEST test type

Testing
Tool

The testing tool type.

Available for:EXTERNAL-TEST test type

User Guide
Chapter 23: Test Plan Specification

HP ALM (12.50) Page 368



UI Element
(A - Z)

Description

Test Name The name of the test.

Note: By default, an EXTERNAL-TEST test name is created by the
concatenation of the following fields: Package, Class, andMethod.

Test
Priority

The priority of the current test.

Type The test type of the current test. For more details, see "Test Types" on page 351.

Test Parameter Fields

UI Element
(A - Z)

Description

Default Value A default value for the parameter. The default value helps users assign an actual
value for test runs.

Click in the text box to display a toolbar for formatting and spell checking the text.

Description A description of the parameter.

Click in the text box to display a toolbar for formatting and spell checking the text.

Modified The date and time on which the test parameter was last modified.

Order The position of the parameter in the set of parameters.

Parameter
Name

The parameter name.

Used Indicates whether the parameter is included in a design step.

Test Details Dialog Box
The Test Details dialog box enables you to view and update a single test.

To access 1. On the ALM sidebar, under Testing, select Test
Plan.

2. Right-click a test, and select Test Details.

Relevant tasks "How to Plan Tests in ALM" on page 344

"How to Create Tests" on page 348

See also "Test PlanModule Fields" on page 366
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User interface elements are described below:

UI Element Description

Save. Saves the details.

Pin/Unpin Test. Pins or unpins the test.

Flag for Follow Up. Opens the Flag For Follow Up dialog box, enabling you to
define a follow up flag for the test. For details, see "Flag For Follow UpDialog
Box" on page 89.

Send by Email. Sends an email with the test details. For more details, see "Send
E-mail Dialog Box" on page 69.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Details Lists the test fields. For details on test fields, see "Test PlanModule Fields" on
page 366.

Tip: Clicking in theDescription orComments field in this tab displays a
toolbar for formatting and spell checking the text.

Design Steps Lists the instructions on how to execute the selected test. For more details, see
"Design Steps Tab/Design Step Details Dialog Box" on page 408.

Not available for: Business Process Testing

Test Script For automated tests: The test script that is run by the testing tool for the
currently selected test. For user interface details, see "Test Script Tab" on
page 412.

For business process tests and flows: The components and flows that are run
for the currently selected business process test, or the components that are run
for the currently selected flow. For user interface details, see theHP Business
Process Testing User Guide.

Parameters Lists parameters associated with the currently selected test. Parameters can be
incorporated in the test's design steps. For more details, see "Parameters
Tab/Parameters Dialog Box" on page 396.
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UI Element Description

Test
Configurations

Displays configurations of a selected test. For more details, "Test Configurations
Tab" on page 429.

Attachments Lists attachments that provide additional information about the currently selected
test. For more details, see "Attachments Page" on page 72.

Req Coverage Lists the requirements that aremet by the currently selected test. For more
details, see "Req Coverage Tab" on page 379.

Linked Defects Lists the defects linked to the currently selected test. For more details, see
"Linked Defects/Entities Page" on page 710.

Dependencies Displays dependency relationships that exist between entities such as test
resources and tests. For more information, see "Dependencies Tab" on page 459.

Business
Models
Linkage

Lists the business process model entities that are linked to the selected test. For
more details, see "Business Models Linkage Tab" on page 384.

Criteria Display criteria of a selected business process test. For more details, see
"Criteria Tab" on page 415.

History Lists changes made to the currently selected test. For more details, see "History
Tab" on page 68.

New Test Dialog Box
This dialog box enables you to add a new test to the test plan tree.

To access Select a subject folder in the test plan tree, right-click and select New Test.

Important
information

If you have installed the Unified Functional Testing Add-in on your machine, the
New Test dialog box includes the Template box.

Tip: You can set default values for certain test fields. For user interface
details, see "Set Default Values Dialog Box" on page 80.

Relevant
tasks

"How to Create Tests" on page 348

User interface elements are described below:

UI Element Description

Clear All Fields. Clears all data in the dialog box.

Spell Check. Checks the spelling for the selected word or text box.
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UI Element Description

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Use Default Values. Fills in certain fields with default values, as specified
in the Set Default Values dialog box. For user interface details, see "Set
Default Values Dialog Box" on page 80.

Set Default Values. Enables you to specify default values for certain fields
using the Set Default Values dialog box. For user interface details, see "Set
Default Values Dialog Box" on page 80.

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Test Name Type a name for the new test.

Syntax exceptions:A test name cannot include the following characters: \
/ : " ? < > | * % '

Type Select amanual or automated test type. For considerations on whether or
not to automate a test, see "Test Automation" on page 404.

For details on test types, see "Test Types" on page 351.

Note:

l If you select theMANUAL test type, you can design the test
manually and then convert the test to an automated test type later in
the Design Steps tab.

l If you select an automated test type, you can select a different
automated testing tool later in the Design Steps tab, but you cannot
convert it back to theMANUAL test type.

l If you select the FLOW test type, you cannot convert it to a different
test type.
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UI Element Description

Template Available if you selectedQUICKTEST_TEST from the Test Type list.

Select another GUI test as a template for the new test. The template test is
copied to your new test, without the test results.

To select a template test, click the browse button. The Select Tests dialog
box opens. By default, only UFT template tests are displayed.

Select the template test and click the Add Test button.

Note: To set the UFT add-ins that ALM associates with a new GUI
test, choose a template test that lists the appropriate add-ins.
Alternatively, use the default template test provided on your ALM client.
This test loads theWeb and ActiveX add-ins by default. For more
information, refer to the UFT documentation and the relevant UFT add-
in documentation.

Details Lists test fields. Required fields are displayed in red. For details on the
available test fields, see "Test PlanModule Fields" on page 366.

Tip: Clicking in theDescription orComments field on this page
displays a toolbar for formatting and spell checking the text.

Attachments Enables you to add attachments that provide additional information about
the new test. For more details, see "Attachments Page" on page 72.

Sort Folders in Test Plan Tree Dialog Box
This dialog box enables you to sort folders in the test plan tree and create a custom sort according to
your needs.

To access 1. In the Test Planmodule, chooseView > Test Plan Tree.

2. Select a folder, and click Sort Folders .

Important
information

l Youmust have project administrator permissions to create a custom sort. For
more information on assigning user group permissions, refer to theHP Application
Lifecycle Management Administrator Guide.

l To view the changes in the test plan tree, click Refresh.

User interface elements are described below:

UI
Element

Description

Folder
Name

Sorts the subfolders alphabetically in the selected test subject folder.
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UI
Element

Description

Move Down Item/Move Up Item.Moves the selected subfolder up or downwithin the
parent folder.

Custom
Sort

Enables you to reorder the subfolders in a selected test subject folder.

Select a test subject folder in the left pane, and rearrange the subfolders in the right pane
by dragging or using the vertical arrows.

Paste Tests/Folders to Target Project Dialog Box
This dialog box enables you to choose how ALM copies a test or test subject across projects.

To access 1. In the test plan tree or grid, select a test or subject folder.
2. Right-click and select Copy.
3. Open another instance of ALM and log in to the project to which you want

to paste the tests.
4. Right-click and select Paste.

Important
information

To copy tests across projects, both projects must use the same ALM version
and patch level.

User interface elements are described below:

UI Element Description

Copy
tests/test
folders and
link to
existing
related
entities

ALM copies the tests or subject folders and pastes them into the target project.
The copied tests or subject folders are linked to existing test resources and called
tests with the same name and path. If a related test resource or a test does not
exist in the target project, ALM copies it to the target project.

Copy
tests/test
folders and
related
entities

ALM copies the tests or subject folders along with the related test resources and
called tests, and pastes them into the target project. If a related test resource or a
called test already exists in the target project, the copied related test resource or
called test is renamed to resolve the duplicate name.

Copy
tests/test
folders
without
copying
related
entities

ALM copies the tests or subject folders without copying the related test resources
or called tests, and pastes them into the target project. The copied items are not
linked to any related entities.
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Chapter 24: Requirement and Test Coverage
This chapter includes:

• Requirement and Test CoverageOverview 376
• How to Create Coverage 376
• Requirement and Test Coverage User Interface 377

HP ALM (12.50) Page 375



Requirement and Test Coverage Overview
It is essential that the tests in your test planmeet your original requirements. To keep track of the
relationship between your requirements and tests, you add links between them.

In the Test Planmodule, you create requirement coverage by selecting requirements to link to a test.
Requirement coverage assists you in assessing the impact of a change in the test or requirement. A
test can cover more than one requirement.

Alternatively, in the Requirements module, you create test coverage by linking tests to a requirement.
Test coverage assists you in assessing the impact of a change in the test or requirement. A
requirement can be covered by more than one test.

Instead of covering each requirement only at the level of the test, you can cover a requirement by test
configurations. A test configuration represents a specific use-case of a test. For example, a test
configuration can specify a subset of data or a run-time environment that the test should use. Covering
test configurations with requirements provides finer granularity for requirement coverage by enabling
coverage by different use-cases of a test. For more details on test configurations, see "Test
Configuration Overview" on page 418.

If you work with theBusiness Modelsmodule, you can link model entities to tests, either in the Test
Planmodule or in the Business Models module.

Business Process Testing:When creating coverage between requirements and business process
tests, instead of covering each requirement only at the level of a test and/or its test configurations, you
can also define coverage by a criterion. HP Application Lifecycle Management (ALM) creates a
criterion for each business component and flow. You decide whether to include the criterion for
calculating coverage. For more details on criteria, see theHP Business Process Testing User Guide.

Note: You can link requirements and tests to defects. This can help you ensure compliance with
your testing needs throughout the applicationmanagement process. If a requirement changes, you
can immediately identify which tests and defects are affected, and who is responsible. For more
details, see "Defect Linkage" on page 692.

For task details, see "How to Create Coverage" below.

How to Create Coverage
The following steps describe how to create coverage by linking requirements to tests. Instead of
covering each requirement only at the level of the test, you can cover a requirement by test
configurations.

You can create coverage from the Requirements or the Test Planmodule. It also describes how to
examine the status of your requirements by understanding the breakdown of child requirements
according to test coverage.

To learnmore about creating coverage, see "Requirement and Test CoverageOverview" above.

Note: This task is part of a higher-level task. For details, see "How to Plan Tests in ALM" on
page 344.

User Guide
Chapter 24: Requirement and Test Coverage

HP ALM (12.50) Page 376



l "Link requirements to tests" below
l "Link tests to requirements" below
l "Analyze coverage" below

Link requirements to tests
1. In the Test Planmodule, select the Test Plan Tree view.
2. Select a test and click theReq Coverage tab. Click theSelect Req button to display the

requirements tree in the right pane. Add coverage to your selected requirements. For user interface
details, see "Req Coverage Tab" on page 379.
To watch amovie on how to create requirement coverage, refer to this section in the ALMOnline
Help.

Link tests to requirements
1. In the Requirements module, select theRequirement Details view.
2. Select a requirement and click the Test Coverage tab. Click theSelect button to display the test

plan tree in the right pane. Add coverage to your selected tests. For user interface details, see
"Test Coverage Page" on page 385.

Tip:
To add coverage tomultiple tests grouped in the same folder, select the folder and click Add
To Coverage.

To associate multiple tests with a requirement when the tests are not grouped in the same
folder, in the Test Coverage tab, filter the test cases (for example by Test Name). Add the
matching tests by selecting the root folder of the filter, and clickingAdd To Coverage.

To watch amovie on how to create test coverage, refer to this section in the ALMOnline Help.

Analyze coverage
In theRequirementsmodule, select Coverage Analysis from theViewmenu. Examine the status of
your requirements and child requirements according to test coverage.

For user interface details, see "Coverage Analysis View" on the next page.

To watch amovie on how to analyze coverage, refer to this section in the ALMOnline Help.

Requirement and Test Coverage User Interface
This section includes:

• Coverage Analysis View 378
• ReqCoverage Tab 379
• AddConfiguration Coverage Dialog Box 382
• Add Advanced Coverage Dialog Box 383
• Business Models Linkage Tab 384
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• Test Coverage Page 385
• Analysis Settings Dialog Box 389
• Coverage Analysis Dialog Box 390
• AddCriterion Coverage Dialog Box 391

Coverage Analysis View
This view enables you to examine the status of your requirements by displaying the breakdown of child
requirements according to test coverage. You can set the coverage analysis by cycle, enabling you to
view in the analysis only the coverage of runs that are assigned to specific cycles.

To access In theRequirements module, select Coverage Analysis from theViewmenu.

Important
information

By default, coverage is available only for the following requirement types:
Functional, Testing, andUndefined.

Relevant tasks "How to Create Coverage" on page 376

See also "Requirements ModuleWindow" on page 226

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Coverage
Analysis view
common UI
elements>

l Coverage Analysis fields. For field definitions, see "Requirements Module
Fields" on page 237.

l Coverage Analysis view menus and buttons. For command and button
descriptions, see "Requirements ModuleMenus and Buttons" on page 228.

l Coverage Analysis icons. For icon descriptions, see "Requirements Module
Icons" on page 235.

Opens the Analysis Settings dialog box, enabling you to define the coverage
analysis settings. For more details, see "Analysis Settings Dialog Box" on
page 389.
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UI Element Description

Legend Displays the color coding used to indicate the direct cover status of the
requirements and their children.

A requirement status can be one of the following:

l Blocked. One ormore tests covered by the requirement have an execution
status of Blocked.

l Failed. One ormore tests covered by the requirement have an execution status
of Failed, and none has an execution status of Blocked.

l No Run. All the tests covered by the requirement have an execution status of
No Run.

l Not Completed. One ormore tests covered by the requirement have an
execution status of Not Completed, and none has an execution status of
Blocked or Failed. Alternatively, tests covered by the requirement have
execution statuses of Passed andNo Run.

l Not Covered. The requirement has not been linked to a test.
l Passed. All the tests covered by the requirement have an execution status of
Passed.

Show. Displays information panel tabs on the bottom of the requirement view. For
more details, see "Requirements ModuleWindow" on page 226.

Req Coverage Tab
This tab enables you to view the requirements that are covered by a selected test in the test plan tree.

To access In the Test Planmodule, select the Test Plan Tree view. Select a test and click the
Req Coverage tab.

Important
information

l Requirement coverage is created automatically when you convert a requirement to
a test. Therefore, even if you have not yet added requirement coverage, it may
already exist. For more details, see "Convert to Tests Wizard" on page 246.

l The following requirement types are set so that, by default, you cannot add
coverage to them: Business, Folder, andGroup.
To enable you to add coverage, youmust enable test coverage for these
requirement types. For more details, see theHP Application Lifecycle
Management Administrator Guide.

Relevant
tasks

"How to Create Coverage" on page 376

"How toWork with Test Configurations" on page 420

See also "Requirement and Test CoverageOverview" on page 376

"Test Configuration Overview" on page 418
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Requirement Coverage Grid
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A - Z)

Description

Displays the requirements tree in the right pane, enabling you to add requirement
coverage to a test. For more details, see "Requirements Tree Pane" on the next
page.

Remove Selected. Removes selected requirements from the coverage grid.

Refresh All. Refreshes the coverage grid.

Select Columns. Opens the Select Columns dialog box, enabling you to
determine which fields to display in the coverage grid and their order. For more
details, see "Select Columns/Select Fields Dialog Box" on page 77.

<coverage
grid>

For field definitions, see "Requirements Module Fields" on page 237.

Coverage
Mode

Indicates whether an entity is covered by selected test configurations or all test
configurations.

Coverage
Type

The type of coverage.

Entity Name The name of the requirement.

Go To
Requirement
in
Requirements
Tree

Right-click a requirement in the coverage grid to go to the requirements tree in the
Requirements module and highlight the selected requirement.

Show Full
Path

Right-click a requirement in the coverage grid to display the location of the
selected requirement in the requirements tree.
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Requirements Tree Pane
User interface elements are described below:

UI
Element

Description

Add to Coverage. Adds requirement coverage to a specified test.

Includes the following options:

l Add to Coverage (Without Children). Adds selected requirement without its child
requirements to the coverage grid. Alternatively, you can double-click or drag the
selected requirement to the coverage grid.
When the specified test contains more than one test configuration, the Add
Configuration Coverage dialog box opens. For more details, see "Add Configuration
Coverage Dialog Box" on the next page.

l Add to Coverage (Include Children). Adds selected requirements, including their
child requirements. The associated test configurations are added to the Test
Configuration Settings pane.

Note: Only child requirements that match the current filter and that belong to a
type that supports test coverage are added to the coverage.

Business Process Testing:When adding requirement coverage to a business process
test, the Add Advanced Coverage dialog box opens. For more details, see "Add
Advanced Coverage Dialog Box" on page 383.

Refresh. Refreshes the requirements tree.

Find. Searches for a specific requirement in the tree.

Type the name (or part of the name) of the requirement in the Find box and click Find. If
the search is successful, the requirement is highlighted in the tree.

Set Filter. Filters and sorts the requirements in the requirements tree. For more details,
see "Filter Dialog Box" on page 51.

Go to Requirement by ID. Opens theGo ToRequirement dialog box, enabling you to
find a specific requirement by ReqID.

Note: You can go only to requirements that are in the current filter.

Close. Hides the requirements tree in the right pane.

Test Configuration Settings Tab
This tab displays the test configurations associated with the requirement coverage. For more details,
see "Test Configuration Settings Tab " on page 435.

User Guide
Chapter 24: Requirement and Test Coverage

HP ALM (12.50) Page 381



Criterion Settings Tab
This tab enables you to add or remove criterion of a selected covered test.

Important
information

Business Process Testing: Functionality related to test criteria is available only for
business process tests. For details, see theHP Business Process Testing User
Guide.

User interface elements are described below:

UI
Element

Description

Add Criteria. Opens the Add Criteria dialog box enabling you to add criteria to the
criterion settings grid. For more details, see "Add Criterion Coverage Dialog Box" on
page 391.

Remove Criteria. Removes selected criteria from the criterion settings grid.

Note: If the last criterion is removed, coverage reverts to test-level.

Refresh. Refreshes the criterion settings grid.

Add Configuration Coverage Dialog Box
This dialog box enables you to add test configurations to coverage.

To access 1. In the Test Plan module, select a test that contains more than one test
configuration from the test plan tree. Click theReq Coverage tab.

2. Click Select Req to display the Requirement Tree pane.

3. Select a requirement. Click Add to coverage (Without Children) . The
Add Configuration Coverage dialog box opens.

Important
information

l This dialog box opens only if the selected test contains more than one test
configuration.

l If the root folder is selected, theAdd to coverage (Without Children) button is
disabled.

l Business Process Testing:When adding requirement coverage to a business
process test, the Add Advanced Coverage dialog box opens. For more details, see
"Add Advanced Coverage Dialog Box" on the next page.

Relevant
tasks

"How to Create Coverage" on page 376

See also "Coverage Analysis View" on page 378
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User interface elements are described below:

UI Element Description

Name The name of the test configuration.

Description The description of the test configuration.

Don't show me this
dialog again

Hides this dialog box.

To reveal this dialog box, select View > Req Coverage > Show
Advanced Coverage dialog.

Add Advanced Coverage Dialog Box
This dialog box enables you to add criteria and test configurations to coverage.

To access 1. In the Test Plan module, select a business process test from the test plan
tree. Click theReq Coverage tab.

2. Click Select Req to display the Requirement Tree pane.

3. Select a requirement. Click Add to coverage . The Add Advanced
Coverage dialog box opens.

Important
information

l Business Process Testing: This dialog box is available only for business
process tests.

l If the root folder is selected, theAdd to coverage button is disabled.
l This dialog box opens only if the selected business process test contains
criteria and test configurations.

Relevant tasks "How to Create Coverage" on page 376

See also "Coverage Analysis View" on page 378

User interface elements are described below:

UI Element Description

Criteria Enables you to select criteria.

Business Process Testing: Functionality related to test criteria is available only
for business process tests. For details, see theHP Business Process Testing
User Guide.

Configurations Enables you to select test configurations. For details, see the "Test Configuration
Overview" on page 418.

Don't show me
this dialog
again

Hides this dialog box.

To reveal this dialog box, select View > Req Coverage > Show Advanced
Coverage dialog.
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Business Models Linkage Tab
Requirements module: This tab enables you to view the business process model entities that are
covered by a selected requirement in the requirements tree.

Test Plan module: This tab enables you to view the business process model entities that are covered
by a selected test in the test plan tree.

To access In the Requirements module:

Select theRequirement Details view, select a requirement, and click the
Business Models Linkage tab.

In the Test Planmodule:

Select the Test Plan Tree view, select a test (or a Business Process Testing
flow), and click theBusiness Models Linkage tab.

Important
information

Business models can be linked to tests automatically by converting representative
requirements of model entities to tests.

Relevant
tasks

"Link Requirements and Tests to Model Entities" on page 288

See also "Business Process Models Overview" on page 284

Business Models Linkage Grid
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

Add to Linkage. Displays the business models tree in the right pane, enabling you to
add business model entities to a test or requirement. For more details, see "Business
Models Tree Pane" on the next page.

Remove from Linkage. Removes selectedmodel entities from the linkage grid.

Refresh. Refreshes the linkage grid to display themost up-to-date information.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the linkage grid and their order. For more details, see "Select
Columns/Select Fields Dialog Box" on page 77.

Activities Lists the business process model activities linked to the selected requirement or test.

Paths Lists the business process model paths linked to the selected requirement or test.

Models Lists the business process models linked to the selected requirement or test.
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UI
Element

Description

<linkage
grid>

Click a link in the grid to go to themodel entity in the business models tree.

For field definitions, see "Business Models Module Fields" on page 302.

Business Models Tree Pane
User interface elements are described below:

UI
Element

Description

Add to Linkage. Links the selectedmodel entity to the current requirement or test.

Tip: You can also link model entities by double-clicking amodel entity, or by
dragging it from the business models tree to the linkage grid.

Show Entity Details. Opens the Details dialog box for the selected entity in read-only
mode.

Go to Entity in Module Tree. Navigates to the selected entity's location in that entity's
module, and highlights the entity.

Refresh. Refreshes the business models tree.

Find. Searches for a specific model entity in the tree.

Type the name (or part of the name) of themodel entity in the Find box and click Find. If
the search is successful, the entity is highlighted in the tree.

Filter/Sort. Filters and sorts the entities in the business models tree. For more details,
see "Filter Dialog Box" on page 51.

Go to Model Folder by ID. Opens theGo ToModel dialog box, enabling you to find a
specific model by Model ID.

Note: You can only go tomodels that are in the current filter.

Close. Hides the business models tree in the right pane.

Test Coverage Page
This page enables you to view the tests that are covering a selected requirement in the requirements
tree.

To access In theRequirements module, select theRequirement Details view. Select a
requirement and click the Test Coverage tab.

User Guide
Chapter 24: Requirement and Test Coverage

HP ALM (12.50) Page 385



Important
information

l Test coverage is created automatically when you generate a test from a
requirement. Therefore, even if you have not yet added test coverage, it may
already exist. For more details, see "Convert to Tests Wizard" on page 246

l The following requirement types are set so that, by default, you cannot add
coverage to them: Business, Folder, andGroup.
To enable you to add coverage, youmust enable test coverage for these
requirement types. For more details, see theHP Application Lifecycle
Management Administrator Guide.

Relevant
tasks

"How to Create Coverage" on page 376

See also "Requirement and Test CoverageOverview" on page 376

Test Coverage Grid
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

Select Tests. Displays the test plan tree in the right pane, enabling you to add test
coverage to a requirement. For more details, see "Test Plan Tree Pane" on the next
page.

Remove From Coverage. Removes selected tests from the coverage grid.

Caution: Deleting coverage in full coveragemodemay also delete coverage from
child requirements.

Status
Filter

Filters the coverage grid by status type.

Refresh All. Refreshes the coverage grid.

Set Filter/Sort. Filters and sorts the tests in the coverage grid. For more details, see
"Filter Dialog Box" on page 51.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the coverage grid and their order. For more details, see
"Select Columns/Select Fields Dialog Box" on page 77.

Full
Coverage

Shows the test coverage of all the children of the selected requirement.

<coverage
grid>

For field definitions, see "Test PlanModule Fields" on page 366.
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UI
Element

Description

Coverage
Type

The type of coverage.

Entity
Name

The name of the test.

Coverage
Status

The current execution status of the test.

Coverage
Mode

Indicates whether the test coverage includes all the test configurations associated
with a selected test, or specific test configurations. The value in this column can be
Selected Configurations orAll Configurations.

Go To
Test in
Test Lab

Right-click a test in the coverage grid to go to the Execution Grid in the Test Lab
module and highlight the selected test.

Go To
Test in
Test Plan

Right-click a test in the coverage grid to go to the test plan tree in the Test Planmodule
and highlight the selected test.

Show/Hide. Shows/hides the lower pane of the Test Coverage page.

Test Plan Tree Pane
This pane enables you to add tests to the requirement's test coverage. When adding tests, ALM also
adds the associated test configurations displayed in the Test Configurations pane.

User interface elements are described below:

UI
Element

Description

Add to Coverage. Adds selected test including its associated test configurations to the
requirement's test coverage. Alternatively, you can double-click or drag the selected test
to the test coverage grid.

Note: If you select a folder, only tests that match your current filter are added to the
test coverage.

Business Process Testing:When adding a business process test, the Add Criterion
Coverage dialog box opens. For more details, see "Add Criterion Coverage Dialog Box"
on page 391.

Tip: To add selected configurations of a test to the requirement's test coverage, add
coverage from the Test Configurations pane.

User Guide
Chapter 24: Requirement and Test Coverage

HP ALM (12.50) Page 387



UI
Element

Description

Show Test Details. Opens the Details dialog box for the selected test in read-only mode.

Go to Test in Module Tree. Navigates to the selected test's location in the Test Plan
module, and highlights the test.

Refresh All. Refreshes the requirements tree.

Set Filter/Sort. Filters and sorts the tests in the tree. For more details, see "Filter Dialog
Box" on page 51.

Find. Searches for a specific test in the tree.

Type the name (or part of the name) of the test in the Find box and click Find. If the
search is successful, the test is highlighted in the tree.

Go to Test by ID. Opens theGo To Test dialog box, enabling you to find a specific test
by Test ID.

Note: You can only go to tests that are in the current filter.

Close. Hides the Test Plan Tree pane.

Show/Hide. Shows/hides the Test Configurations pane.

Test Configurations Pane
This pane enables you to add selected test configurations to the requirement's test coverage. For more
details, see "Test Configurations Pane" on page 436.

Coverage Chart tab
This tab displays a pie chart which graphically shows the run status of the tests in the coverage grid.

Test Configuration Status tab
This tab displays the status of the configurations associated with a covered test. For more details, see
"Test Configuration Status Tab" on page 437.

Criterion Settings tab
This tab enables you to add or remove criterion of a selected covered test.

Important
information

Functionality related to test criteria is available only for business process tests. For
details, see theHP Business Process Testing User Guide.
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User interface elements are described below:

UI
Element

Description

Add Criteria. Opens the Add Criteria dialog box enabling you to add criteria to the
criterion settings grid. For more details, see "Add Criterion Coverage Dialog Box" on
page 391.

Remove Criteria. Removes selected criteria from the criterion settings grid.

Refresh. Refreshes the criterion settings grid.

Analysis Settings Dialog Box
This dialog box displays the coverage status for a requirement and its children according to the current
analysis settings.

To access In theCoverage Analysis view, click theSettings button.

Relevant tasks "How to Create Coverage" on page 376

See also "Coverage Analysis View" on page 378

User interface elements are described below:

UI
Elements Description

Coverage
Analysis

Calculates the current coverage status of the requirements based on theDirect Cover
Status field values. The status is graphically displayed under theCoverage Analysis
field of the Coverage Analysis view.

For more details on the Direct Cover Status field, see "Direct Cover Status" on
page 239.

For more details on the Coverage Analysis field, see "Coverage Analysis" on page 238.
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UI
Elements Description

Execution
Analysis

Calculates the coverage status of the requirements based on the runs of the covering
tests that were run in the selected cycles. The Execution Analysis option does not use
theDirect Cover Status field in its calculations.

Tests that were not assigned to run in any of the selected cycles are assigned the
status No Run. Requirements not covered by any tests are not counted in the analysis.

In theExecution Analysis box, click the arrow button. The releases tree opens.
Expand the tree and select the cycles for which you want to analyze coverage.

The status is graphically displayed under theCoverage Analysis field of the Coverage
Analysis view. For more details on theCoverage Analysis field, see "Coverage
Analysis" on page 238.

Note:When theExecution Analysis option is selected, theDirect Cover Status
field is unavailable in the Coverage Analysis view.

Coverage Analysis Dialog Box
This dialog box displays the coverage status for a requirement and its children according to the current
filter.

To access In theCoverage Analysis view, right-click a requirement and chooseCoverage
Analysis.

Relevant
tasks

"How to Create Coverage" on page 376

See also "Coverage Analysis View" on page 378

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

<graph
area>

Displays the coverage status for a selected requirement and its children.

Click a section in the graph to display a list of child requirements with the selected
status.

From the list, you can select a requirement and click Go To to highlight it in the
requirements tree.

Example:Clicking the Failed area lists the requirements with the status of Failed.
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UI
Element

Description

Copy to
Clipboard

Copies a snapshot of the Coverage Analysis dialog box to the Clipboard.

Add
Tests
Coverage

Extends the dialog box and displays the Test Coverage Chart. This pie chart
graphically displays the full test coverage for the requirement, grouped according to test
status.

Click a section in the chart to view the list of tests with the selected status that cover
the requirement and its children. The Tests Coverage dialog box opens with theStatus
Filter set to the status of the area you selected in the chart. For more details, see "Test
Coverage Page" on page 385.

Note: If a parent requirement has several children all of which cover the same test,
that test is included only once in the parent requirement's Tests Coverage Chart.

Add Criterion Coverage Dialog Box
This dialog box enables you to add criteria for a test.

To access 1. In theRequirementsmodule's Requirement Details view, select a requirement
from the requirements tree. Click the Test Coverage tab. Click Select

to display the Test Plan Tree pane on the right-side of the window.
2. In the Test Plan Tree pane, select a business process test and click Add to

coverage . Alternatively, in the Test Configurations pane, select a test
configuration of a business process test and click Add configurations to

coverage . The Add Criterion Coverage dialog box opens.

Important
information

Business Process Testing: Functionality related to test criteria is available only for
Business Process tests. For details, see theHP Business Process Testing User
Guide.

Relevant
tasks

"How to Create Coverage" on page 376

See also "Coverage Analysis View" on page 378

User interface elements are described below:

UI Element Description

Name The name of the criterion.

Description The description of the criterion.
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UI Element Description

Name The name of the criterion.

Don't show me this
dialog again

Hides this dialog box.

To reveal this dialog box, select View > Test Coverage > Show Add
Criterion Coverage.
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Chapter 25: Test Parameters
This chapter includes:

• Test Parameters Overview 394
• How to Use Test Parameters 394
• Test Parameters User Interface 395
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Test Parameters Overview
You can add parameters to your tests. A test parameter is a variable that can be assigned a value
outside the test from which it is defined. Using parameters can increase the flexibility of your tests by
enabling you to run the same test repeatedly with different data each time.

When working with amanual test, you can add parameters to the design steps from within the test or
you can add parameters by calling them from other tests. This is useful if you have common steps you
often want to perform as part of other tests. For example, you can create a template test Login_
Template that logs a user in when you start the application. You need to call this test at the beginning
of each test. In some cases, you will want to log in as a regular user while in others, you will need to log
in as the project administrator.

For this purpose, you can create two parameters, <<<user name>>> and <<<password>>>, and change
the values according to the type of test that is calling Login_Template. If themost common login is a
regular user, you can set the default values for the parameters to a regular user name and password.
For more information on callingmanual tests, see "How to Design Test Steps" on page 405.

When working with an automated test, you can define parameters for a test script from within the test
or you can load parameters from a shared test resource file. For more information on using test
resources, see "How to Use Test Resources" on page 449.

For task details, see "How to Use Test Parameters" below

How to Use Test Parameters
This task describes how to work with test parameters.

To learnmore about test parameters, see "Test Parameters Overview" above.

Business Process Testing/UFT:Whenworking with a business-process orGUI-Test test type,
different options are available for working with test parameters. For more details, see theHP Business
Process Testing User Guide, and theHP Unified Functional Testing User Guide.

This task includes the following steps:

l "Prerequisites" below
l "Define test parameters" below
l "Add parameters to a design step" on the next page
l "Assign actual values to parameters" on the next page

1. Prerequisites
A manual test is defined in the test plan tree. For more details, see "How to Plan Tests in ALM" on
page 344.

2. Define test parameters
In the Parameters tab, plan and define the test parameters you will use in the test design steps.
For user interface details, see "New Test Parameter/Test Parameter Details Dialog Box" on
page 399.
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3. Add parameters to a design step

While creating design steps, click Insert Parameter to add a parameter to a design step.
The Parameters dialog box opens. For user interface details, see "Parameters Tab/Parameters
Dialog Box" on the next page.
Alternatively, in the description or expected result of a design step, type a new or existing
parameter name, using the syntax <<<parameter name>>>. If you typed a new parameter, it is
automatically added to the test parameter grid.
If you apply formatting to a parameter name in a design step, youmust apply the same formatting
to the entire parameter name, including the <<< and >>> characters. For example, if you want to
italicize the parameter <<<password>>>, youmust italicize the entire string <<<password>>> and
not just the word password.

4. Assign actual values to parameters
Before you run a test, ALM prompts you to assign actual values to the parameters included in the
test. The actual value is the data that is used during the test run. You can take the parameter
default values and use them as actual values.
ALM prompts you to assign actual values at three stages of designing your test. For user interface
details, see "Called Test Parameters/Parameters of Test Dialog Box" on page 401.
According to your testing policy, you can assign actual values at any of these stages:
l When you call a test with parameters. If you assign actual values to parameters when you
call a test, the values are automatically applied to each test instance that you create from the
calling test.

l When you create a test instance. If you assign actual values to parameters when you create
a test instance, the values are automatically applied to each run of the test instance. You can
also assign actual values to test instances in the Execution Settings view of a test instance.
see "Test Instance Details - Execution Settings View" on page 535.

l When you run a test. If you assign actual values to parameters for a test run, the values
apply to that test run only. If you do not assign actual values at this stage, the test will run with
null values.

At each of these stages, you can only assign values to parameters that have not already been
assigned values.

Test Parameters User Interface
This section includes:

• Parameters Tab/Parameters Dialog Box 396
• New Test Parameter/Test Parameter Details Dialog Box 399
• Called Test Parameters/Parameters of Test Dialog Box 401
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Parameters Tab/Parameters Dialog Box
The Parameters tab enables you to create and view test parameters.

The Parameters dialog box enables you to insert test parameters in a test step.

To access Parameters tab:

In the test plan tree, select a test, and click theParameters tab.

Parameters dialog box:

In the test plan tree, select a test (other than a business process test or flow) and
click the Design Steps tab. Double-click a design step and position the cursor in the

Description or Expected Result field. Click Insert Parameter .

Important
information

After you select a parameter in the Parameters dialog box, the parameter is inserted
at the cursor location in the design step, using the syntax <<<parameter name>>>.

Relevant
tasks

l "How to Use Test Parameters" on page 394
l HP Business Process Testing User Guide

See also l "Test Parameters Overview" on page 394
l HP Business Process Testing User Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Go To Resource. Goes to the test resources tree and highlights the selected
resource.

Available for: Automated test types

Resource Preview. Displays the content of the selected test resource.

Available for: Automated test types

Map Parameters. Opens theMap Parameters dialog box, enabling you tomap
the parameter names to the column names in the selected test resource file.

Under theMapped Value column, type the test resource column name for
each parameter name.

Available for: Automated test types

New Parameter. Opens the New Test Parameter dialog box, enabling you to
define a new parameter. For more details, see "New Test Parameter/Test
Parameter Details Dialog Box" on page 399.
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UI Element Description

Delete. Deletes the currently selected parameter. If you delete a parameter
that is included in a design step, the parameter in the design step is replaced
by regular text, using the syntax: <parameter name>.

Refresh. Refreshes the test parameter so that it displays themost up-to-date
information.

Set Filter/Sort. Opens the Filter Test Parameters dialog box, enabling you to
filter and sort the test parameters in the test parameter grid. Any currently
applied filters or sorting orders are displayed below the toolbar. For more
details, see "Filter Dialog Box" on page 51.

Select Columns. Opens the Select Columns dialog box, enabling you to
determine which fields are displayed and their order. For more details, see
"Select Columns/Select Fields Dialog Box" on page 77.

Parameter Details. Opens the Test Parameter Details dialog box, displaying
the details of the selected parameter. For more details, see "New Test
Parameter/Test Parameter Details Dialog Box" on page 399.

Move Up. Moves the selected parameter up in the list.

Tip: In other tabs and dialog boxes, such as the in Business Process
Testing Iteration pages, parameters are displayed according to the order
defined in the Parameters page.

Available for: The BUSINESS-PROCESS, FLOW, MANUAL,
QAINSPECT_TEST, QUICKTEST_TEST, SERVICE-TEST, SYSTEM-
TEST, and VAPI-XP-TEST test types

Move Down. Moves the selected parameter down in the list.

Tip: In other tabs and dialog boxes, such as the in Business Process
Testing Iteration pages, parameters are displayed according to the order
defined in the Parameters page.

Available for: The BUSINESS-PROCESS, FLOW, MANUAL,
QAINSPECT_TEST, QUICKTEST_TEST, SERVICE-TEST, SYSTEM-
TEST, and VAPI-XP-TEST test types
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UI Element Description

Data Resource Specifies the name of an external Microsoft Excel file that contains sets of
parameter values for each configuration of the test. Used only for
configurations defined to access dynamic data. For task information, see
"How to Associate Dynamic Data" on page 422

Available from: Parameters tab from Test Planmodule. This field is not
available when selecting theParameters tab from the Test Script tab in the
Test Planmodule.

Available for: The BUSINESS-PROCESS, FLOW, MANUAL,
QAINSPECT_TEST, QUICKTEST_TEST, SERVICE-TEST, SYSTEM-
TEST, and VAPI-XP-TEST test types

Go To Resource. For use with configurations that access dynamic data.
Opens the resource in the Test Resources module.

Available from: Parameters tab from Test Planmodule. This field is not
available when selecting theParameters tab from the Test Script tab in the
Test Planmodule.

Available for: The BUSINESS-PROCESS, FLOW, MANUAL,
QAINSPECT_TEST, QUICKTEST_TEST, SERVICE-TEST, SYSTEM-
TEST, and VAPI-XP-TEST test types

Resource Preview. For use with configurations that access dynamic data.
Enables you to preview the actual data that will be used with the configuration
when the test runs. The external data table resource is specified inData
Resource in the Resource Preview dialog box.

The Resource Preview dialog box is similar to the Resource Viewer tab in the
Test Resources module. For user interface details, see theHP Application
Lifecycle Management User Guide.

Available from: Parameters tab from Test Planmodule. This field is not
available when selecting theParameters tab from the Test Script tab in the
Test Planmodule.

Available for: The BUSINESS-PROCESS, FLOW, MANUAL,
QAINSPECT_TEST, QUICKTEST_TEST, SERVICE-TEST, SYSTEM-
TEST, and VAPI-XP-TEST test types
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UI Element Description

Map Parameters. For use with configurations that access dynamic data.
Enables you to specify sets of parameter values from an external Microsoft
Excel file by mapping the parameter names in the Excel file to the parameter
names in ALM. For task details, see "How to Associate Dynamic Data" on
page 422.

Available from: Parameters tab from Test Planmodule. This button is not
available when selecting theParameters tab from the Test Script tab in the
Test Planmodule.

Available for: The BUSINESS-PROCESS, FLOW, MANUAL,
QAINSPECT_TEST, QUICKTEST_TEST, SERVICE-TEST, SYSTEM-
TEST, and VAPI-XP-TEST test types

Sort By Specifies the order in which the parameters are listed, as defined in the
Set Filter dialog box. For user interface details, see "Filter Dialog Box" on
page 51.

<test parameter
fields>

For details on the fields available for test parameters, see "Test PlanModule
Fields" on page 366.

Data Resource Enables you to load a test resource file from the test resources tree. For more
details on test resources, see "How to Use Test Resources" on page 449.

Note: This option is available only for automated test types.

Caution: If a test resource was assigned to the parameter but
subsequently deleted, theData Resource field will be read-only and a
broken relation image will be displayed.

Default Value The default value of the parameter.

Description The description of the parameter.

Used Indicates whether the parameter is included in a design step.

New Test Parameter/Test Parameter Details Dialog Box
The New Test Parameter dialog box enables you to define a test parameter.

The Test Parameter Details dialog box enables you to view andmodify test parameter details.
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To access New Test Parameter:

In the test plan tree, select a test and click theParameters tab. Click theNew
Parameter button. The New Test Parameter dialog box opens.

Test Parameter Details:

In the test plan tree, select a test and click theParameters tab. Select a parameter

and click theParameter Details button.

Important
Information

Business Process Testing:Whenworking with a Business Process test type,
different options are available for working with test parameters.

Relevant
tasks

l "How to Use Test Parameters" on page 394
l HP Business Process Testing User Guide

See also "Test Parameters Overview" on page 394

User interface elements are described below:

UI Element Description

Save. Saves the details.

Available from: Test Parameter Details dialog box

First/Previous/Next/Last Entity. Allows you to browse through the test
parameters.

Available from: Test Parameter Details dialog box

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Details tab For details on the fields available for test parameters, see "Test PlanModule
Fields" on page 366.

Default Value The default value of the parameter.

Click in the text box to display a toolbar for formatting and spell checking the
text.
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UI Element Description

Description The description of the parameter.

Click in the text box to display a toolbar for formatting and spell checking the
text.

Called Test Parameters/Parameters of Test Dialog Box
The Called Test Parameters dialog box enables you to view and assign actual values for parameters
included in a called test.

The Parameters of Test dialog box enables you to assign actual values for parameters in test instances
or test runs.

To access Use one of the following:

l In the Test Planmodule, select a test and click theDesign Steps tab. Right-click
a step and select Call to Test. Select a test. If the selected test includes
parameters, the Called Test Parameters dialog box opens.

l In the Test Planmodule, select a test and click theDesign Steps tab. Right-click
a step that contains a call to a test, and select Called Test Parameters. The
Called Test Parameters dialog box opens.

l In the Test Labmodule, run a test with parameters. The Parameters of Test dialog
box prompts you to assign actual values to the parameters.

Important
information

Only parameters for which you have not already assigned actual values are
displayed.

Relevant
tasks

"How to Use Test Parameters" on page 394

See also "Test Parameters Overview" on page 394

User interface elements are described below:

UI Element Description

Select Columns. Opens the Select Columns dialog box, enabling you to
determine which fields are displayed in the dialog box and their order. For
more details, see "Select Columns/Select Fields Dialog Box" on page 77.

Replaces the values in the Actual Value columnwith values in the Default
Value column for the currently selected parameters.

Used Indicates whether the parameter is included in a design step.

Parameter Name The name of the parameter.

Default Value The default value of the parameter.
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UI Element Description

Actual Value The actual value that is used for the parameter during the test run.

Type the actual value in the Actual Value column or tab.

Description The description of the parameter.
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Chapter 26: Test Design
This chapter includes:

• Test Design Overview 404
• Test Automation 404
• How to Design Test Steps 405
• Design Steps User Interface 407
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Test Design Overview
After you add a test to the test plan tree, you build the test by defining design steps. For details, see
"How to Design Test Steps" on the next page.

After you define the test steps, decide whether to perform the test manually or to automate it.

For manual tests you define steps, execute them on your application, and record the results of each
step. Usemanual tests in cases where the test requires a response by the tester, for usability tests,
onetime tests, tests that need to be run immediately, tests requiring knowledge of the application, and
tests without predictable results.

For example, in the flight reservation application, tests that check if a dialog box is user-friendly require
user response. Therefore, you shouldmake these tests manual.

For automated tests, the testing expert can use the design steps as the basis for creating the detailed
test script. Automated tests require that you create automated test scripts using HP testing tools, or
third-party testing tools. For details on automating tests, see "Test Automation" below.

As part of test design, you can include a call to another manual test. When you run the calling test, it
includes the steps from the called test. This is useful if you have common steps you often want to
perform as part of other tests.

For example, suppose you want to include a login step in a number of different tests. You can create a
test Login_Template that logs in a user when you start your application. You can call this test at the
beginning of each test.

Called tests can include test parameters. These are useful if you want to run the called test with
different data according to the type of test that is calling it. For details on using parameters in manual
tests, see "Test Parameters Overview" on page 394.

For task details, see "How to Design Test Steps" on the next page.

Test Automation
Test planning involves deciding which tests to automate. If you choose to automate a test, you can
generate a test script and run the test using Unified Functional Testing, LoadRunner, or Visual API-XP.

Automating a test allows unattended execution of the test at high speed. It alsomakes the test
reusable and repeatable. For example, you automate functional, benchmark, unit, stress and load
tests, as well as tests requiring detailed information about applications.

Consider the following issues when deciding whether to automate a test.

Frequency of Execution
Tests that will run with each new version of your application are good candidates for automation. These
include sanity tests that check basic functionality across an entire application. Each time there is a
new version of the application, you run these tests to check the stability of the new version, before
proceeding tomore in-depth testing.
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Tests that usemultiple data values for the same operation (data-driven tests) are also good candidates
for automation. Running the same test manually—each time with a different set of input data—can be
tedious and ineffective. By creating an automated data-driven test, you can run a single test with
multiple sets of data.

Stress/Load Testing
It is also recommended that you automate tests that are runmany times (stress tests) and tests that
check amulti-user client/server system (load tests). For example, suppose a test must be repeated a
thousand times. Running the test manually would be extremely impractical. In this case, you can
create a test that runs a thousand iterations.

When Not to Automate Tests
Generally, themore user involvement a test requires, the less appropriate it is to automate. The
following describes test cases that should not be automated:

l Usability tests—tests providing usagemodels that check how easy the application is to use.
l Tests that you only have to run once.
l Tests that you need to run immediately.
l Tests based on user intuition and knowledge of the application.
l Tests with no predictable results.

How to Design Test Steps
After adding tests to the test plan tree, describe the detailed, step-by-step instructions the tester should
perform to complete a test. Each test step includes a description of an action.

Note: This task is part of a higher-level task. For details, see "How to Plan Tests in ALM" on
page 344.

To learnmore about test design, see "Test Design Overview" on the previous page.

This task includes the following steps:

l "Prerequisites" below
l "Create test steps" below
l "Call a template test – optional" on the next page
l "Generate an automated test – optional" on page 407
l "Results" on page 407

1. Prerequisites
Tests, and basic test information, are defined in the test plan tree.
For task details on creating tests, see "How to Create Tests" on page 348.

2. Create test steps
Describe the steps a tester must perform to run a test. A test step includes the actions to perform
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on your application, the input to enter, and the expected results.
To create test steps:
a. In the Test Planmodule, select View > Test Plan Tree, and select a test.
b. Click theDesign Steps tab.
c. If there are existing design steps, select the step below which you want to add a new step.

d. Click New Step . Fill in the fields in the Design Step Details dialog box. For user
interface details, see "Design Steps Tab/Design Step Details Dialog Box" on page 408.

e. To add a parameter to a design step, in the Design Step Details dialog box, click Insert

Parameter . For details on working with test parameters, see "How to Use Test
Parameters" on page 394.

Example

To test the Flight Booking feature in theMercury Tours application, youmight create
design steps as follows:

3. Call a template test – optional
To include commonly used instructions in your test, for example Log in to the application,
you can call a template test from within your test that includes common instructions.

Note: For details on creating template tests, see "How to Create Tests" on page 348.

To call a template test:

User Guide
Chapter 26: Test Design

HP ALM (12.50) Page 406



a. Select the test in which you want to include a template test.
b. Click theDesign Steps tab.
c. If there are existing design steps, select the step below which you want to call a template test.

d. Click Call to Test .
e. In the Select Test dialog box, select the test that you want to call. For user interface details,

see "Select Test Dialog Box" on page 413.
A call to the selected template test is inserted below the selected step. When you run the test,
the template test's design steps are listed accordingly.

4. Generate an automated test – optional
After you have created steps for amanual test, you can generate a test script skeleton in which
you can write scripts to run the test as an automated test.

Note:

l You can generate an automated test before designing test steps, or by selecting an
automated test type when you create the test.

l For considerations on whether or not to automate a test, see "Test Automation" on
page 404.

l For a list of automated test types, see "Test Types" on page 351.

To generate an automated test:

In the Design Steps tab, click Generate Script and choose an automated test type to
which to convert.
Any text that appeared in the steps of themanual test is listed as comments in the generated test
script. If themanual test has parameters, they are also listed as comment text.

Example

In the flight reservation application, you can automate a test that checks whether the login
mechanism works. After adding test steps, you create a test script. Then, using Unified
Functional Testing GUI tests, you complete the automated test script.

5. Results
The design steps that you add appear in the Design Steps tab. The first time you add design steps
to a test, a footprint appears in the test plan tree next to the test icon, indicating that steps
were defined for the test.

Design Steps User Interface
This section includes:

• Design Steps Tab/Design Step Details Dialog Box 408
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• Test Script Tab 412
• Select Test Dialog Box 413
• Paste Design Steps to Target Project Dialog Box 414
• Criteria Tab 415

Design Steps Tab/Design Step Details Dialog Box
The Design Steps tab enables you to view and edit design steps for the selected test. The Design Step
Details dialog box enables you to create and edit individual design steps.

To access Design Steps tab: In the Test Planmodule, select a test in the test plan tree, and
click theDesign Steps tab.

Design Step Details dialog box: In the Test Planmodule, select a test in the test
plan tree, and click theDesign Steps tab. Then use one of the following:

l Right-click the design steps grid, or a design step, and select New Step.
l Right-click a design step and select Edit Step.

Important
information

l If you apply formatting to a parameter name in a design step, youmust apply the
same formatting to the entire parameter name, including the <<< and >>>
characters. For example, if you want to italicize the parameter password, youmust
italicize the entire string <<<password>>> and not just the word password.

l Specifying less than 2,500 characters in user-defined fields in this tab or dialog box
can improve performance.

Relevant
tasks

"How to Design Test Steps" on page 405

See also "Test Design Overview" on page 404

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A - Z) Description

Save. Saves the details.

Available from: Design Step Details dialog box

Allows you to browse through design steps.

Available from:Design Step Details dialog box

Check Spelling. Checks the spelling for the selected word or text box.

Available from:Design Step Details dialog box

Spelling Options. Enables you to configure the way ALM checks spelling.

Available from:Design Step Details dialog box
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UI Element (A - Z) Description

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Available from:Design Step Details dialog box

New Step. Creates a new design step in the Design Step Editor dialog box.

The new step is added below the selected step.

Edit Step. Opens the selected design step in the Design Step Editor dialog
box.

Available from:Design Steps tab

Renumber Steps. Renumbers the design steps sequentially. Use this
command after you rearrange steps.

Available from:Design Steps tab

Delete Selected. Deletes the selected design steps.

Copy/Paste Steps. Copies the selected design steps and pastes them to
another test in the same project or in another project. The copied design step
is inserted above the selected step.

When you paste design steps to another project, the Paste Design Steps to
Target Project dialog box opens. For user interface details, see "Paste Design
Steps to Target Project Dialog Box" on page 414.

Note: Parameters included in the design step are copied to the target
test.

Available from: Design Steps tab

Attachments. Opens the Attachments page, enabling you to add
attachments to the selected design step. For user interface details, see
"Attachments Page" on page 72.

After you add an attachment, the icon displays in the Design Steps grid,
next to the appropriate design step.

Note: If you add an attachment to a design step, a copy of the
attachment is made every time the test is run.
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UI Element (A - Z) Description

Call to Test. Opens the Select Test dialog box, enabling you to call another
manual test. For user interface details, see "Select Test Dialog Box" on
page 413. The call to the test is inserted as a new design step below the
selected step.

Tip: To return to the calling test, click in the upper left corner of the
design step grid.

Available from:Design Steps tab

Generate Script. Enables you to convert the test to an automated test type
that is run by the applicable automatic testing tool. For considerations on
whether or not to automate a test, see "Test Automation" on page 404.

For reference details, see "Test Types" on page 351.

ALM generates a test script skeleton based on the current design steps.

The test icon next to the test you automated is replaced with the automated
test icon.

Note:

l After automating a test, you cannot convert it back to theMANUAL
test type.

l For automated test types other than FLOW, you can use this button to
select a different testing tool.

Available from:Design Steps tab

Insert Parameter. Opens the Parameters dialog box, enabling you to insert a
test parameter in theDescription orExpected Result field. The parameter is
inserted at the cursor position. For user interface details, see "Parameters
Tab/Parameters Dialog Box" on page 396.

Find Text. In the Design Steps tab, opens the Find dialog box, enabling you
to find text in specific fields. For user interface details, see "Find Dialog Box"
on page 63.

Find/Replace Text. In the Design Step Details dialog box, opens the Find &
Replace dialog box, enabling you to find or replace a specified string in the
selected field.

Select Columns. Opens the Select Columns dialog box, enabling you to
define which columns appear in the grid, and the order in which they appear.
For user interface details, see "Select Columns/Select Fields Dialog Box" on
page 77.

Available from:Design Steps tab
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UI Element (A - Z) Description

Adjust Rows Height. Adjusts the row size of the steps in a test. This
enables you to view all the text in the Description or Expected Result columns
if the text is long.

Tip: To resize a single step, position themouse in the gray sidebar on the
gridline below the step. The cursor changes to a vertical arrow. Drag the
gridline up or down.

Available from: Design Steps tab

Save Steps. Saves the design steps in the project. If you are typing long text,
use theSave Steps button to prevent data loss.

Move Down/Move Up.Moves the selected design step up or down in the
design steps grid.

Tip: Alternatively, select a design step and drag it to a new position.

Back. Returns to the test that called the currently-open template test. For
task details on inserting calls to template tests, see "Call a template test –
optional" on page 406.

Available from: Design Steps tab

<design steps
grid>

Displays design steps that are included in the selected test.

Available from:Design Steps tab

Attachments Enables you to add attachments that provide additional information about the
design step. For user interface details, see "Attachments Page" on page 72.

Available from:Design Step Details dialog box
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UI Element (A - Z) Description

Description Instructions for the tester to perform.

Note:

l Test parameters included in theDescription field are surrounded by
<<< >>> brackets.

l Design Steps Tab: If a step is a call to another test, theDescription
field displays a link to the called test, and actual values of the
parameters included in the called test. To edit actual values of the
called test parameters, right-click the link, and chooseCalled Test
Parameters.

Tip:

l Clicking in this field displays a toolbar for formatting and spell
checking the text.

l Specifying less than 2,500 characters in this field can improve
performance.

Details Design step details. Required fields are displayed in red.

Available from:Design Step Details dialog box

Expected Result The expected state after the step instructions are performed.

Tip:

l Clicking in this field displays a toolbar for formatting and spell
checking the text.

l Test parameters included in theExpected Result field are surrounded
by <<< >>> brackets.

l Specifying less than 2,500 characters in this field can improve
performance.

Step Name The name of the step.

Default value: The sequential number of the design step. For example, Step
1 if you are adding a step to a test for the first time.

Note: If a step is a call to another test, theStep Name field displays a
link to the called test, and actual values of the parameters included in the
called test. To edit actual values of the called test parameters, right-click
the link, and chooseCalled Test Parameters.

Test Script Tab
This tab contains the script run by the testing tool designated for the selected test.
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To access In the test plan tree, select a test, and click the Test Script tab.

Available from:Automated test types

Important
information

l For details on the user interface for system tests, see "Test Script Tab - System
Tests" on page 446.

l For details on the user interface for business process tests and flows, see theHP
Business Process Testing User Guide.

l The Test Script tab is populated with elements designed by the applicable testing
tool, such as UFT. (When you first create an automated test, only the Launch
button is displayed.) For details, see the documentation for the testing tool.

l You can view API tests only if you have installed the appropriate add-in from the
HP Application Lifecycle Management Add-ins page. For more details on installing
add-ins, refer to theHP Application Lifecycle Management Installation and
UpgradeGuide.

Relevant
tasks

"How to Design Test Steps" on page 405

See also "Test Automation" on page 404

User interface elements are described below:

UI Element Description

Launch Displays the testing script in the applicable testing tool.

Select Test Dialog Box
This dialog box enables you to select amanual test that is called by a design step.

To access 1. In the Test Planmodule, select a test in the test plan tree, and click theDesign
Steps tab.

2. Right-click the design step below which you want to add a call to amanual test,
and select Call to Test.

Important
information

If the called test contains parameters, the Called Test Parameters dialog box opens,
enabling you to set actual parameter values. The actual values are used by default in
test instances created from the current test. For user interface details, see "Called
Test Parameters/Parameters of Test Dialog Box" on page 401.

Relevant
tasks

"How to Design Test Steps" on page 405

See also "Test Design Overview" on page 404

User Guide
Chapter 26: Test Design

HP ALM (12.50) Page 413



User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Show Entity Details. Opens the Details dialog box for the selected entity in read-
only mode.

Refresh. Refreshes the test tree so that it displays themost up-to-date tests.

Filter/Sort. Opens the Filter Tests dialog box, enabling you to filter and sort the tests
in the test plan tree. For details, see "Filter Dialog Box" on page 51.

Find. Searches for a specific test in the test plan tree.

Type the name of the test in the Find box and click the Find button. If the search is
successful, the test is highlighted in the tree. Click the Find button again to highlight
the next match.

Go To Test By ID. Opens theGo To Test dialog box, enabling you to select a test by
its ID.

<test plan
tree>

Displays folders in the test plan tree that contain manual tests. If theShow only
Template Tests check box is selected, only folders that contain template tests are
displayed.

Expand the tree to locate the test that you want to call.

Show Only
Template
Tests

Instructs ALM to display only template tests. To choose a test that is not a template
test, clear the check box.

Paste Design Steps to Target Project Dialog Box
This dialog box enables you to select the way in which design steps are copied from a test in one
project to a test in another project.

To access 1. In the source project, right-click a design step and select Copy.
2. Open the target project in a separate browser window.
3. In the target project, right-click a design step below which you want to insert

the copied step, and select Paste.

Important
information

The source and target projects must use the same ALM version and patch level.
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User interface elements are described below:

UI Element Description

Copy design
steps and link to
existing related
entities

ALM copies the design steps and pastes them into the target project. The
copied design steps are linked to existing tests with the same name. If a called
test does not exist in the target project, ALM copies it to the target project.

Copy design
steps and related
entities

ALM copies the design steps and called tests and pastes them into the target
project. If a called test name already exists in the target project, the copied
called test is renamed to resolve the duplicate test name.

Copy design
steps without
copying related
entities

ALM copies the design steps without copying the called tests, and pastes
them into the target project. The copied design steps are not linked to any
called tests.

Criteria Tab
This tab enables you to view the criteria of the selected business process test.

To access In the test plan tree, select a business process test, and click theCriteria tab.

Important
information

Business Process Testing: Functionality related to test criteria is only available for
business process tests. For details, see theHP Business Process Testing User
Guide.

See also "Requirement and Test CoverageOverview" on page 376

User interface elements are described below:

UI Element Description

Refresh. Refreshes the criteria grid.

Goes to the Test Script tab and highlights the selected component.

Name The name of the criterion.

Execution Status The current execution status of the criterion. Execution status can be one of
the following: Failed, N/A, No Run, Not Completed, Passed.

Created by The user name of the person who created the criterion.

Creation date The date on which the criterion was created. By default, the creation date is
set to the server date on which the criterion was created.

Description The description of the criterion.
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Test Configuration Overview
HP Application Lifecycle Management (ALM) provides data awareness capabilities that enable you to
determine which datasets to use when running your test. One of these data awareness capabilities is
the ability to define test configurations.

Test configurations:

l "Facilitate Test Reuse" below
l "Improve Requirement Coverage" below

Facilitate Test Reuse
Test configurations essentially unbind the data from the test, making the test generic and facilitating
the test's reuse. Using test configurations, you can:

l Share common data sources across different tests.
l Test various use-cases, each time with a different set of data.

Example

A test configuration can specify a subset of data or a run-time environment that the test should
use.
Youmay want to check the same test in aWindows environment and again in a UNIX
environment. In this case, you can define one test with two test configurations. The parameter
values for theWindows configuration would containWindows-specific values (for example,
backslashes in a path name) while the UNIX configuration would contain UNIX-specific values
(for example, forward slashes in a path name).

For conceptual information about the ways you can associate data with a test configuration, see "Data
for Test Configurations" on the next page.

Improve Requirement Coverage
Test configurations provide finer granularity for requirement coverage. Instead of covering each
requirement only at the level of the test, you can link a requirement to a specific test configuration.

Example

You can use a single test to cover multiple requirements by associating different test
configurations in the same test with each requirement.

This topic also includes: "Data for Test Configurations" on the next page.

For task details, see "How toWork with Test Configurations" on page 420.
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Data for Test Configurations
HP Application Lifecycle Management (ALM) enables you to determine which data to use when running
test configurations. You can associate data with test configurations in several ways:

l "Static" below
l "Dynamic" below

Static
Static data are supplied for the test configuration by entering the data in a grid directly from within ALM.

Use static data when the amount of data you intend to associate is small.

For task details on associating static data with test configurations, see "How to Associate Static Data"
on page 421.

Dynamic
Dynamic data are supplied for the test configuration by creating an external Microsoft Excel file,
uploading it as a test resource into ALM, and associating it with the test configuration.

Use dynamic data to specify large amounts of data that are easier to maintain in an external file.

Tip: You can specify a default dynamic data set for all test configurations of a test. You can also
override the default for a specific test configuration.

You can supply ALM with dynamic data resources:

l At the test level. You can supply aMicrosoft Excel file that contains all parameter values at the test
level. TheMicrosoft Excel file is uploaded as a data table in the Test Resources module, and
associated with the test configuration in the Parameters tab of the Test Planmodule.

l At the configuration level (overriding any test-level data resources). You can supply an
alternateMicrosoft Excel file, overriding the default test-level data resources file that is associated
with the test as a whole. TheMicrosoft Excel file is uploaded as a data table in the Test Resources
module, and associated with a specific configuration of the in the Test Configurations tab of the Test
Planmodule.

For task details on associating dynamic data with test configurations, see "How to Associate Dynamic
Data" on page 422.

Test Types and Test Configuration Data Association

Different test types support different methods of test configuration data association.

Test Type Static Dynamic

BUSINESS-PROCESS

FLOW
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Test Type Static Dynamic

LR-SCENARIO

MANUAL

PERFORMANCE-TEST

QAINSPECT_TEST*

QUICKTEST_TEST

SERVICE-TEST

SYSTEM-TEST*

VAPI-XP-TEST*

VuGenScript

* You can associate test configuration data for this test type within ALM. However, to execute this type
of test using its associated configuration data, run the test in other tools, such as the OTA API.

How to Workwith Test Configurations
This task describes how to work with test configurations.

Note: To view amovie that demonstrates how to work with test configurations, chooseHelp >
Movies in the ALMmain window.

This task includes the following steps:

l "Prerequisites" below
l "Define test configurations" on the next page
l "Associate data with each test configuration" on the next page
l "Create coverage - optional" on the next page
l "Define test sets" on the next page
l "View test results" on the next page

1. Prerequisites
l If using test configurations for finer granularity of test coverage, define requirements in the
Requirements module. For task details, see "How to Create Requirements" on page 224.

l Define tests in the Test Planmodule. When you create a test in the Test Planmodule, a test
configuration with the same name as the test is created automatically.
For task details on creating tests, see "How to Create Tests" on page 348.
For task details on test parameters, see "How to Use Test Parameters" on page 394.

User Guide
Chapter 27: Test Configurations

HP ALM (12.50) Page 420



2. Define test configurations
a. In the test plan tree, select a test, and click the Test Configurations tab. For user interface

details, see "Test Configurations Tab" on page 429.

b. Create configurations for the test. Click theNew Test Configuration button and enter
your test configuration details. For user interface details, see the "New Test
Configuration/Test Configuration Details Dialog Box" on page 430.

c. Select a test configuration and click the Test Configuration Details button.
d. In the Test Configuration Details dialog box, click theData tab. The fields displayed in the

Data tab vary depending on the test type.

3. Associate data with each test configuration
Depending on the test type, you can associate static data, dynamic data, or both for your test
configuration. The Data tab accurately reflects your available options. For details, see "Test
Types and Test Configuration Data Association" on page 419.
For task details on associating static data (data entered directly into a grid in ALM), see "How to
Associate Static Data" below.
For task details on associating dynamic data (data saved externally in data table resources), see
"How to Associate Dynamic Data" on the next page.

4. Create coverage - optional
Link requirements to the test or to specific test configurations. For task details, see "How to
Create Coverage" on page 376.

5. Define test sets
You define a test set in the Test Labmodule. A test set can include any or all of the test
configurations defined for a test, or it can include test configurations based on requirement
coverage. When you run a test set, the parameter values are retrieved from the data set according
to the settings defined for each test configuration.
For task details, see "How to Create Test Sets" on page 524.

6. View test results
View the test set run results. For task details, see "How to View Test Runs" on page 668.

How to Associate Static Data
This task describes how to work with static test configurations in ALM.

Defining static data enables you to specify sets of parameter values for the test directly from within
ALM.

You can create configurations that access static data from the Test Planmodule, andmodify the data
from the Test Plan and Test Labmodules.
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Note: This task is part of a higher-level task. For details, see "How toWork with Test
Configurations" on page 420.

This task includes the following steps:

l "Select a static configuration" below
l "Create iterations (Business Process Testing)" below
l "Modify parameter values" below

1. Select a static configuration
In the Test Planmodule > Test Configurations tab, click theData tab. Then, if the test type
supports both static and dynamic data, select Static.
For user interface details on the Data tab for static configurations, see "Data Tab: Static View" on
page 432.

2. Create iterations (Business Process Testing)
Business Process Testing: Existing iterations and the test parameter default values are
displayed in a grid. Add /remove iterations as necessary.
For user interface details on iterations, see theHP Business Process Testing User Guide.

3. Modify parameter values
Existing iterations and the test parameter default values are displayed in a grid. Modify parameter
values as necessary.
Tomodify the value of a static parameter, select a parameter, click theActual Value field, and
enter the desired value of the parameter.

How to Associate Dynamic Data
This task describes how to work with test configurations in ALM that access dynamic data.

Defining dynamic data enables you to specify sets of parameter values for the test from an external
Microsoft Excel file.

Tip: The sameMicrosoft Excel file can be used as a data resource for different tests.

Note:

This task is part of a higher-level task. For details, see "How toWork with Test Configurations" on
page 420.
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This task includes the following steps:

l "Prerequisites" below
l "Create a data table in Microsoft Excel" below
l "Create ALM test resources by uploading the Excel file" on page 426
l "Associate the data table test resource with the test and/or configuration" on page 426
l "Map test parameters to resource parameters " on page 427
l "Filter the data by selecting iteration ranges—optional" on page 427
l "Associate an alternate data table with the test configuration—optional" on page 427

1. Prerequisites
Towork with dynamic data for UFT automated tests, make sure that the Unified Functional
Testing Add-in for Business Process Testing is installed on the client computer. The Unified
Functional Testing Add-in for Business Process Testing available from the HP Application
Lifecycle Management Add-ins page (Help > Add-ins).

2. Create a data table in Microsoft Excel
This data table contains rows of values which become parameter values for each iteration of your
test configuration.
a. Create a spreadsheet:

o In Microsoft Excel.
o If working with business process tests, in Unified Functional Testing, you can export

configuration values to aMicrosoft Excel file, and use this file for your data table. See the
information about exporting test iteration values into an Excel document in theUnified
Functional Testing User Guide.

b. Put test-level parameters in the first sheet. The entire test runs once for each row listed in the
first sheet.

Example

c. Business Process Testing users can use subsequent sheets in the Excel file to override the
business component iterations defined in business process tests and flows, according to the
following guidelines:
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o The next sheets (meaning, all sheets but the first) represent components and their
parameters.

Note: If a component does not contain parameters, the Excel does not contain a
sheet for that component.

o In each sheet, the column headings (first row) containing the parameter names must be in
one of the following formats:
l <COMPONENT NAME>.<COMPONENT PARAMETER NAME>

This format is the general, default format.
l <COMPONENT INSTANCE NAME>.<COMPONENT PARAMETER NAME>

This format is useful for keeping sheet names short.
l <COMPONENT PARAMETER NAME>

This format is useful if the name of the sheet is the same as the name of the
component, and you need to keep the sheet names short.

Notes

l If the same component has been added to the same test multiple times, the
numerical instance of the component in the test is listed between the component
name and the parameter name. The component instances are listed according to
their order in the test script, not necessarily in the order of the original numerical
instance of the component when inserted.

l The sheet name cannot bemore than 32 characters long and cannot contain
special characters. (This is aMicrosoft Excel limitation.)

Tip:When specifying column headings, it is helpful to use one of the last two
formats listed above for parameter names in order to avoid this limitation.

o Specify values for each parameter under the parameter names, each on a different row.
Each row represents an iteration. Add iterations as necessary.

Examples

The first sheet, that corresponds to theOrderingBooks business process test. The test
will run once, because it is designed to run only for one store, BooksOnline.
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The second sheet corresponds to the Login business component. This business
component will iterate only once, because only one user is listed as logging in.

The third sheet corresponds to theOrderBooks business component. This business
component currently iterates only once, because only book is listed.

If we want to iterate the component multiple times, we couldmodify the third sheet (that
corresponds to theOrderBooks business component) so that it more rows are added.
This business component will iterate for every book listed—in this case, six times.
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d. Save the file.

o When editing the spreadsheet in Excel, if no values / iterations are specified for a
particular parameter defined in the component, test, or flow, an exception will occur at
run-time.

o If a component, group, or flow has input parameters that reference the output
parameters of a different business component or flow, differences between the
number of iterations can result in an error. The parameter name in the Iterations dialog
box is displayed in red, indicating an iteration rangemismatch.

3. Create ALM test resources by uploading the Excel file
In ALM, upload theMicrosoft Excel data table as a test resource. For task details, see "How to
Use Test Resources" on page 449.
a. Select the Test Resourcesmodule.
b. Either create or select a test resource folder.

c. Click New Resource to create a new test resource. The New Resource dialog box
opens.

d. EnterData Table as the resource type and click OK.
e. Click theResource Viewer tab.
f. Click theUpload File button.
g. Navigate and select theMicrosoft Excel file you created and click Open.
h. Click OK when prompted that the upload completed successfully. The Resource Viewer lists

the default Microsoft Excel sheets. The data is now available in ALM.
You can double-click the spreadsheet to view the data you created.

Note: The data in theMicrosoft Excel file starts with row number 2. It is assumed that the first
row in theMicrosoft Excel file contains the names for the data columns, which aremapped to
parameter names in ALM.

4. Associate the data table test resource with the test and/or
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configuration
Do one of the following:

Associate the data table with a test:

You can associate the data table with a test. All test configurations for the test will run using the
data in this table (unless overridden in Test Configurations > Data).
To associate the data table with an entire test: 
a. In the Test Planmodule Parameters tab for a test, click the down arrow next to theData

Resource field in the toolbar.
b. Navigate to, and select, the data resource and click OK. TheMicrosoft Excel file is now the

default external data file for the test.

Associate the data table with configurations: 

You can associate the data table with a test configuration. Each test configurations in the test run
using the data table specified for the individual configuration, overriding the data table specified in
the Test Planmodule Parameters tab.
To associate the data table, see "Associate an alternate data table with the test configuration—
optional" below.

5. Map test parameters to resource parameters
The test parameter names in the Excel data table do not have tomatch the parameter names
defined in the test. They can bemapped.

a. In the Parameters tab for the test, click Map Parameters . TheMap Parameters dialog
box is displayed. For user interface details on theMap Parameters dialog box, see "Map
Parameters Dialog Box" on page 439.

b. Do one of the following: 
o For each test parameter, click in the cell for its corresponding resource parameter. Type or

select the corresponding resource parameter and click OK.

o Business Process Testing:Click Automap . ALMmaps each test parameter to the
corresponding resource parameter based on the column headings in the first row of the
data table.

Tip: Themapping of resource parameters to test parameters facilitates reuse of the same
resource file by different tests.

6. Filter the data by selecting iteration ranges—optional
To filter the data so that the test runs only on a subset of the parameter values, either by row or by
value, click Data Resource Settings. The Data Resource Settings dialog box opens. For user
interface details on the Data Resource Settings dialog box, see "Data Resource Settings Dialog
Box" on page 440.

7. Associate an alternate data table with the test configuration—
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optional
You can create configurations that process alternate dynamic data resource files instead of the
dynamic data resource file associated with the business process test.

Tip: The same file can be used as a data resource for different tests.

a. In theData tab, select Dynamic.
b. Select Override test data resource and specify an alternate data resource.
c. Click Data Resource Settings to map the test parameter names to the resource parameter

names in the Data Resource Settings dialog box. For user interface details on the Data
Resource Settings dialog box, see "Data Resource Settings Dialog Box" on page 440.

Tip: You can have one business process test run the same component a different numbers of
times. Do this by defining different numbers of iterations in each sheet of the data table for
that component. 

Test Configuration User Interface
This section includes:

• Test Configurations Tab 429
• New Test Configuration/Test Configuration Details Dialog Box 430
• Data Tab: Static View 432
• Data Tab: Dynamic View 433
• Test Configuration Settings Tab 435
• Test Configurations Pane 436
• Test Configuration Status Tab 437
• Generate Test Configuration Dialog Box 438
• Map Parameters Dialog Box 439
• Data Resource Settings Dialog Box 440
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Test Configurations Tab
This dialog box enables you to define and update test configurations.

To access In the test plan tree, select a test and click the Test Configurations tab.

Important
information

For a list of test types for which you can define test configurations that access
external data table resources, see "Data for Test Configurations" on page 419 .

For additional details on working with QUICKTEST_TEST (UFT GUI Tests) test
configurations that access external data table resources, see the section on working
with ALM in theHP Unified Functional Testing User Guide.

Relevant
tasks

"How toWork with Test Configurations" on page 420

See also "Test Configuration Overview" on page 418

User interface elements are described below:

UI Element Description

New Test Configuration. Opens the New Test Configuration dialog box, enabling
you to define a test configuration. For details, see "New Test Configuration/Test
Configuration Details Dialog Box" on the next page.

Delete Test Configuration. Deletes selected test configuration from the test
configurations grid.

Refresh. Refreshes the test configurations grid so that it displays themost up-to-
date information.

Test Configuration Details. Opens the Test Configuration Details dialog box,
enabling you to display details of the selected test configuration. For details, see
"New Test Configuration/Test Configuration Details Dialog Box" on the next page.

Attachments. Opens the Attachments page in the Test Configuration Details dialog
box, enabling you to view attachments of the currently selected test configuration.
For details, see "Attachments Page" on page 72.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields are displayed and their order. For details, see "Select Columns/Select
Fields Dialog Box" on page 77.

Set Filter. Enables you to filter and sort the test configurations in the test
configurations grid. For details, see "Filter Dialog Box" on page 51.

Name The name of the test configuration.
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UI Element Description

Created By The user name of the person who created the test configuration.

Creation
Date

The date on which the test configuration was created. By default, the creation date is
set to the current ALM server date.

Execution
Status

The execution status of the last run of a test configuration. By default, the execution
status can be one of the following: Blocked, Failed, N/A, No Run, Not
Completed, Passed.

Description Describes the test configuration.

Data tab The data associated with the currently selected test configuration. For details, see
"Data Tab: Static View" on page 432 and "Data Tab: Dynamic View" on page 433.

Attachments
tab

Lists attachments that provide additional information about the currently selected
test configuration. For details, see "Attachments Page" on page 72.

History tab Lists changes made to the currently selected requirement. For details, see "History
Tab" on page 68.

ID A unique numeric ID for the test configuration, assigned automatically by ALM.

Modified The date and time of the last change to the test configuration.

Test ID A unique numeric ID for the test, assigned automatically by ALM.

Test Name The name of the test.

New Test Configuration/Test Configuration Details Dialog Box
This dialog box enables you to define and update test configurations.

To access 1. In the test plan tree, select a test and click the Test Configurations tab.

2. Click theNew Test Configuration button . The New Test Configuration
dialog box opens

Relevant
tasks

"How toWork with Test Configurations" on page 420

See also "Test Configuration Overview" on page 418

User interface elements are described below:

UI Element Description

Save. Saves the details.

Available from: Test Configuration Details dialog box
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UI Element Description

First/Previous/Next/Last Entity. Allows you to browse through the test
configurations.

Available from: Test Configuration Details dialog box

Clear All Fields. Clears all fields.

Available from: New Test Configuration dialog box

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Use Default Values. Fills in certain fields with default values, as specified
in the Set Default Values dialog box. For user interface details, see "Set
Default Values Dialog Box" on page 80.

Set Default Values. Enables you to specify default values for certain fields
using the Set Default Values dialog box. For user interface details, see "Set
Default Values Dialog Box" on page 80.

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Name Displays the name for the new test configuration.

Details tab Details the currently selected test configuration. For details on the available
fields, see "Test Configurations Tab" on page 429.

Data tab The data associated with the currently selected test configuration. For
details, see "Data Tab: Static View" on the next page.

Available from: Test Configuration Details dialog box

Attachments tab Lists attachments that provide additional information about the currently
selected test configuration. For details, see "Attachments Page" on
page 72.

History tab Displays the date and time of the change and the name of the user who
made the change to the test configuration. For details, see "History Tab" on
page 68.

Available from: Test Configuration Details dialog box

Description tab Describes the currently selected test configuration.

Click in the text box to display a toolbar for formatting and spell checking the
text.
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Data Tab: Static View
This dialog box shows the data defined for a selected test configuration directly within ALM.

To access In the Test Planmodule > Test Configurations tab, click theData tab and if available,
select Static.

Important
information

Different options and fields are available in the Data tab depending on the test type.
For details, see "Data for Test Configurations" on page 419.

Relevant
tasks

"How toWork with Test Configurations" on page 420

See also "Test Configuration Overview" on page 418

User interface elements are described below:

UI Element (A-Z) Description

Static Changes the test configuration so it accesses static data defined
within ALM.

Available for: Certain test types. For details, see "Data for Test
Configurations" on page 419.

Dynamic Changes the test configuration so that it access an external
Microsoft Excel data resource file. For user interface details, see
"Data Tab: Dynamic View" on the next page.

Available for: Certain test types. For details, see "Data for Test
Configurations" on page 419.

Select Columns. Opens the Select Columns dialog box,
enabling you to determine which fields are displayed and their
order. For more details, see "Select Columns/Select Fields Dialog
Box" on page 77.

Replaces actual values with default values for the currently
selected parameters.

Enables you to update the actual value of all or selected
parameters across all test instances associated with the selected
test configurations in the Test Labmodule.

Used Indicates whether the parameter is included in a design step.

Parameter Name The name of the parameter.

Default Value The default value of the parameter as defined in the test level.

Actual Value The actual value that is used for the parameter during the test run.
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UI Element (A-Z) Description

Source Test Test in which the parameter was created.

Available for: 

l MANUAL
l QAINSPECT-TEST
l SYSTEM-TEST
l VAPI-XP-TEST

<Iteration page> common
elements

Business Process Testing:Enables you to add iterations, delete
iterations, modify each iteration's parameter values, and select
iteration ranges to run in a business process test. Also enables
you to import and export parameter values. For user interface
details, see the HP Business Process Testing User Guide.

Available for: Business process tests

Data Tab: Dynamic View
This tab enables you tomodify test configurations so that they access dynamic data (data that resides
outside of ALM in an external data resource).

To access Do one of the following: 

l In the Test Planmodule > Test Configurations tab, click theData tab and if
available, select Dynamic.

l In the Test Labmodule > Test Instance Details dialog box > Execution Settings
view for business process test configurations and UFT test configurations that
access dynamic data, click theData tab.

Important
information

l Different options and fields are available in the Data tab depending on the test
type.

l By default, the data resource used is the one specified in the Parameters tab for
the test. This can be overridden by specifying a different data resource in this Data
tab.

l When accessed from the Test Instance Details dialog box Execution Settings
View, the information in this tab is read-only.

Relevant
tasks

"How toWork with Test Configurations" on page 420

See also "Test Configuration Overview" on page 418

"Test Instance Details - Execution Settings View" on page 535

User interface elements are described below:
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UI Element Description

Static Changes the test configuration so it accesses static data defined
within ALM. For user interface details, see "Data Tab: Static
View" on page 432.

Available for: Certain test types. For details, see "Data for Test
Configurations" on page 419.

Dynamic Changes the test configuration so that it access an external
Microsoft Excel data resource file.

Available for: Certain test types. For details, see "Data for Test
Configurations" on page 419.

Override test data resource Indicates that you want to override the dynamic data resource
specified at the test level with a data resource at the configuration
level.

Available from: Test Configurations tab

Data Resource Enables you to enter the name of a data resource that will override
the data resource specified at the test level.

Available from: Test Configurations tab whenOverride test
data resource is selected

Go to data resource. Opens the data resource in the Test
Resources module.

Available when: An alternate data resource is specified in the
Data Resource field.

Resource Preview. Opens the asset viewer's Test Configuration
Resource Preview for the test resource. This enables you to see
the data defined in the external data resource (meaning, all data
available to the test configuration).

Available when: An alternate data resource is specified in the
Data Resource field.
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UI Element Description

Filtered Resource Preview. Opens the Data Viewer for the test
resource. This enables you to see the dynamic data in the external
data resource that match filter criteria (meaning, the data that will
be used when the test configuration runs).

Filter. Name of the filter.

Row Filter: The rows as defined in Data Resource Settings dialog
box (all rows or selected rows). For user interface details, see
"Data Resource Settings Dialog Box" on page 440.

Show mapped columns only. If selected, only data that is
mapped to test parameters are displayed.

<headings>. Column headings for the grid that also display the
parameter mappings.

<grid>. Rows of data that match the filter criteria.

Available from: Test Configurations tab when an alternate data
resource is specified in theData Resource field.

Opens the data resource settings dialog box, which enables you to
set iteration ranges when running the test configuration. For user
interface details, see "Data Resource Settings Dialog Box" on
page 440.

Available when: An alternate data resource is specified in the
Data Resource field.

Test Configuration Settings Tab
This tab displays the test configurations associated with the requirement coverage.

To access 1. In the Test Planmodule, select the Test Plan Tree view.
2. Select a test and click theReq Coverage tab.
3. Click Select Req button.
4. In the Requirements Tree pane, click Add to Coverage to add requirement

coverage to a specified test. Requirement coverage is added to the requirement
coverage grid. The Test Configuration Settings tab is displayed on the bottom of
the Req Coverage tab.

Important
information

This tab is displayed only when coverage has been created.

Relevant
tasks

l "How to Create Coverage" on page 376
l "How toWork with Test Configurations" on page 420

See also l "Req Coverage Tab" on page 379
l "Test Configuration Overview" on page 418
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User interface elements are described below:

UI Element Description

Add Configuration. Opens the Add Configuration Coverage dialog box, enabling
you to add configurations to the list of test configurations covering the selected
requirement.

Remove Configuration. Removes the selected configurations from the list of test
configurations covering the selected requirement.

Refresh. Refreshes the test configuration grid.

Name The name of the test configuration.

Description The description of the test configuration.

Test Configurations Pane
This pane lists the test configurations of a selected test.

To access From the Requirements module:

1. Select View > Requirement Details. Select a requirement and click the Test
Coverage tab.

2. Click theSelect button. The Test Plan Tree and the Test Configurations panes
are displayed.

From the Test Labmodule:

1. Select a test set and click theExecution Grid tab or theExecution Flow tab.
2. Click the Select Tests button. The Test Plan Tree tab and the Test

Configurations pane are displayed.

Relevant
tasks

l "How to Create Coverage" on page 376
l "How toWork with Test Configurations" on page 420

See also l "Test Coverage Page" on page 385
l "Test Configuration Overview" on page 418
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User interface elements are described below:

UI Element Description

Add Test Configuration to Coverage. Adds a test instance that uses the selected
test configuration to the requirement's test coverage.

Add Test Configuration to Test Set. Adds a test instance that uses the selected
test configuration to the test set.

Business Process Testing:When including a test configuration of a business
process test, the Add Criterion Coverage dialog box opens. For more details, see
"Add Criterion Coverage Dialog Box" on page 391.

Refresh All. Refreshes the test configurations grid.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the test configurations grid and their order. For more details,
see "Select Columns/Select Fields Dialog Box" on page 77.

Set Filter/Sort. Filters and sorts the test configurations in the grid. For more details,
see "Filter Dialog Box" on page 51.

Description A description of the test configuration.

ID A unique numeric ID for the test configuration, assigned automatically by ALM.

Test ID A unique numeric ID for the test, assigned automatically by ALM.

Modified The date and time of the last change to the test configuration.

Creation
Date

The date on which the test was created. By default, the creation date is set to the
current ALM server date.

Execution
Status

The execution status of the last run of a test configuration. By default, the execution
status can be one of the following: Blocked, Failed, N/A, No Run, Not
Completed, Passed.

Name The test configuration name.

Test Name The test name.

Created By The user name of the person who created the test configuration.

Test Configuration Status Tab
This tab displays the status of the test configurations associated with a covered requirement.
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To
access

1. In theRequirements module, select theRequirement Details view. Select a
requirement and click the Test Coverage tab.

2. Click theSelect button. The Test Plan Tree and the Test Configurations panes
display on the right-side of the Test Coverage tab.

3. Click Add to Coverage to add test coverage. Test coverage is added to the test
coverage grid. The Test Configuration Status tab is displayed on the bottom of the
Test Coverage tab.

Relevant
tasks

l "How to Create Coverage" on page 376
l "How toWork with Test Configurations" on page 420

See also l "Test Coverage Page" on page 385
l "Test Configuration Overview" on page 418
l "Requirement and Test CoverageOverview" on page 376

User interface elements are described below:

UI Element Description

Remove Configuration. Removes selected configuration from the list of
configurations used to cover the selected requirement.

Refresh All. Refreshes the configuration status grid.

Name The test configuration name.

Description The description of the test configuration.

Status The current test run status of the test configuration. By default, the status can be one
of the following: Blocked, Failed, N/A, No Run, Not Completed, Passed.

Business Process Testing: To view the criteria status of a test configuration, click
its status value. The Criteria Status dialog box opens.

Generate Test Configuration Dialog Box
After upgrading from a previous version of ALM, this dialog box enables you to create a test
configuration from an existing test instance.

To access 1. In the Test Labmodule, select a test set and click theExecution Grid tab.
2. In the grid, right-click a test instance and chooseGenerate Test Configuration.
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Important
information

ALM users generate test configurations once, after an upgrade from a previous
version of Quality Center.

Caution: Only use this option for migrating tests. Do not use this option for new
tests or tests that have already beenmigrated.

l ALM: When generating a test configuration from a test instance, ALM performs the
following actions:
l Associates the test instance with the generated test configuration.
l Associates the test instance's runs with the generated test configuration.
l Associates the test instance's links (for example, tests, requirements) with the
generated test configuration.

l Sets the generated test configuration status to be the same as the status of the
test instance.

l Copies the parameter values of the test instance to the generated test
configuration.

l Business Process Testing: TheGenerate Test Configuration option is enabled
only for business process test configuration instances that have beenmodified and
no longer match the original configurations. (This option is not available for
configurations that access dynamic data.)

Relevant
tasks

l "How to Create Coverage" on page 376
l "How toWork with Test Configurations" on page 420

See also l "Test Coverage Page" on page 385
l "Test Configuration Overview" on page 418

User interface elements are described below:

UI Element Description

New Test Configuration Name The name of the generated test configuration.

Map Parameters Dialog Box
This dialog box enables you to associate data from an external data resource to the parameters for the
test configuration in the test.

To access In the Test Planmodule > Parameters tab for the test, click Map Parameters

.

Important
information

Youmap test parameters to external datamanually.

Business Process Testing: You can alsomap parameters to external data
automatically.

Relevant tasks "How to Associate Dynamic Data" on page 422

User Guide
Chapter 27: Test Configurations

HP ALM (12.50) Page 439



See also "Test Configuration Overview" on page 418

User interface elements are described below:

UI Element Description

Business Process Testing:Automatically maps each non-mapped test parameter
to a parameter (column heading with the same name) in the external data table
resource.

For automatic mapping, the column heading in the external data table resourcemust
match the test parameter name.

Themapping is not case-sensitive.

The order of the parameters in the external data table resource does not have to
match the order of the parameters in the test.

Note: If a parameter has already beenmapped, the automap operation does not
reset themapping.

Test
Parameter
Name

Name of the test parameter as defined in the test.

Resource
Parameter
Name

Name of the column heading as defined in the external data table resource.

Tip: For business process tests, you can select the column headings from a
drop-down list. To clear the resource parameter name, select the blank row in
the drop-down list.

Mapping
Status

Business Process Testing:Status indicating if the test parameter is mapped to a
parameter (column) in the external data table resource.

l Not Assigned. The test parameter is not associated with an external data table
resource parameter.

l Assigned. The test parameter is associated with an external data table resource
parameter.

Data Resource Settings Dialog Box
This dialog box enables you to: 

l Define a subset of the parameter values (an iteration range) to use for running the test when working
with configurations that access dynamic data.

l Map test parameter names to alternate data resource parameter names when overriding the default
data resource associated with the test.
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To access From the Test Configurations tab in the Test Planmodule, select the dynamic
configuration whose data you want to filter. Click theData tab near the bottom of the
window, and then click Data Resource Settings.

Important
information

l You can filter the parameter values by specifying filter conditions and specific
rows. Only values that match both the filter condition and the specified rows are
processed.

l Whenmapping test parameter names to alternate data resource parameter names,
for each parameter listed in the Test Parameter Name column, click the cell in the
Resource Parameter Name column and type the name of the corresponding
resource parameter from theMicrosoft Excel file.

Relevant
tasks

"How to Associate Dynamic Data" on page 422

See also "Test Configuration Overview" on page 418

User interface elements are described below:

UI
Element Description

Business Process Testing: Automatically maps each non-mapped test parameter to
a parameter (column heading with the same name) in the external data table resource.

For automatic mapping, the column heading in the external data table resourcemust
match the test parameter name.

Themapping is not case-sensitive.

The order of the parameters in the external data table resource does not have tomatch
the order of the parameters in the test.

Note: If a parameter has already beenmapped, the automap operation does not
reset themapping.

Business Process Testing: 

Filtered Resource Preview. Opens the Data Viewer for the test resource. This
enables you to see the dynamic data in the external data resource that match filter
criteria (meaning, the data that will be used when the test configuration runs).

Filter. Name of the filter.

Row Filter. All rows or selected rows.

Show mapped columns only. If selected, only data that is mapped to test
parameters are displayed.

<headings>. Column headings for the grid that also display the parameter mappings.

<grid>. Rows of data that match the filter criteria.
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UI
Element Description

Test
Parameter
Name

Name of the test parameter as defined in the test.

Resource
Parameter
Name

Name of the test parameter as defined in the data resource.

Mapping
Status

Business Process Testing:Status indicating if the test parameter is mapped to a
parameter (column) in the external data table resource.

l Not Assigned. The test parameter is not associated with an external data table
resource parameter.

l Assigned. The test parameter is associated with an external data table resource
parameter.

Filter
Condition

Condition for filtering out rows of data in the data resource. The test will not run on the
filtered out rows of data.

Specify a filter according to the following guidelines:

l Only strings can be specified.
l Do not specify quotationmarks or operators.
l Only one value can be specified.
l The filter is case-sensitive.

All Rows To process all rows that meet the specified filter condition, if one exists, in the data
resource file, select All Rows.

Rows To indicate a subset of rows, select Rows and enter the row numbers, separated by
commas. A range of rows can be specified with a hyphen (for example, 3-5means
rows 3, 4, and 5 are processed).
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Chapter 28: System Tests
This chapter includes:

• System Tests Overview 444
• How to Create System Tests 444
• System Test User Interface 445
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SystemTests Overview
You can run a system test to retrieve amachine's system information, view a captured desktop image
of a test run on amachine, or restart a machine. For example, you can run a system cleanup test that
will restart themachine on which an automated test failed. You can also create a system test to
retrieve information about amachine's resource usage before or after a test run.

You create a system test by adding a system test to a test subject folder, defining the test, and adding
the test to a test set.

Note: To run a system test, youmust install the following tool add-ins on themachine where the
test is to be run:

l HP ALM System Test Remote Agent Add-in
l HP ALM Connectivity Add-in
For more information on HP Application Lifecycle Management (ALM) add-ins, refer to the HP
Application Lifecycle Management Installation and UpgradeGuide.

When running a system test, the following steps can be created:

l SysInfo. Collection of system information
l Snapshot. Capture of desktop image
l Reboot Start andReboot Finish. Machine restart
You can view details for each of these steps after your system test has finished running. You can also
view the system information that has been retrieved—such as CPU, memory, and processes running
on themachine—and an image of themachine executing the system test.

For task details, see "How to Create System Tests" below.

How to Create SystemTests
This task describes how to create and run a system test that instructs ALM to provide system
information for amachine, capture a desktop image, or restart a machine.

Note: This task is part of a higher-level task. For details, see "How to Plan Tests in ALM" on
page 344.

This task includes the following steps:

l "Prerequisites" on the next page
l "Create a system test" on the next page
l "Configure a system test" on the next page
l "Run system tests" on the next page
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1. Prerequisites
Test subjects are defined in the test plan tree.
For task details on creating test subjects, see the step on creating test subjects in the "How to
Create Tests" on page 348 task.

2. Create a system test
Create a system test in a subject folder.
a. In the Test Plan Tree view, right-click a test subject, and select New Test.
b. In the New Test dialog box, select SYSTEM-TEST in the Type field.
c. Fill in other fields in the New Test dialog box. For user interface details, see "New Test Dialog

Box" on page 371.

A new test with the system test icon is added to the test plan tree under the subject folder you
selected.

3. Configure a system test
Select the operations a system test should perform.
a. Select a system test in the test plan tree.
b. Click the Test Script tab to configure the system test settings. For user interface details, see

"Test Script Tab - System Tests" on the next page.

4. Run system tests
Run system tests in the Test Labmodule. For details on running tests, see "How to Run Tests in
ALM" on page 490.

SystemTest User Interface
This section includes:

• Test Script Tab - System Tests 446
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Test Script Tab - SystemTests
This tab enables you to define settings for the system test.

To access In the test plan tree, select a system test, and click the Test Script tab.

Relevant tasks "How to Create System Tests" on page 444

See also "System Tests Overview" on page 444

User interface elements are described below:

UI Element Description

Saves the system test settings.

Collect
system
information

Instructs ALM to collect information such as CPU, memory, and processes running
on themachine when the test is run.

Capture
desktop
image

Instructs ALM to add an attachment displaying a snapshot of themachine's desktop
when the test is run.

Restart the
computer

Instructs ALM to restart themachine when the test is run.

Note:

l To use theRestart the computer option, youmust enable auto login on your
machine. ChooseStart > Programs > HP ALM System Test Agent >
System Test Agent (configuration). The Auto Restart Settings dialog box
opens. By default, User Name andDomain are read-only. Type your
password.

l To select a different user name, reopen the Auto Restart Settings dialog box.
User Name andDomain are no longer read-only. Modify the values.
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Chapter 29: Test Resources
This chapter includes:

• Test Resources Overview 448
• How to Use Test Resources 449
• Test Resources User Interface 450
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Test Resources Overview
The Test Resources module enables you tomanage resources used by your tests. You can organize
your resources by defining a hierarchical test resource tree containing resource folders and resources.
For each resource in the tree, you select and upload a set of resource files to the HP Application
Lifecycle Management (ALM) repository. These files can be used by one or more tests.

You can then define dependencies between resources and tests. For more details on dependencies,
see "Entity Dependencies Overview" below.

For task details, see "How to Use Test Resources" on the next page.

Example
Michael, a QA tester, works with an external testing tool that stores its tests in ALM. Each test
uses a shared configuration file that is common to a number of tests. He therefore wants a single
point of maintenance for the configuration file, rather than saving separate copies of the file for
each test.

Michael uses his testing tool to define the configuration file as a resource and define each test that
uses the file as dependent on that resource. As only one copy of the resource exists in ALM,
replacing the configuration file would replace it for all tests that depend on it.

After Michael defines dependencies, if he attempts to delete the resource, ALM will warn him that
this may affect tests that depend on it. In addition, if he copies one of the tests that depend on the
resource between projects, ALM will enable him to choose to copy the resource as well as the test.

Entity Dependencies Overview
Dependencies define relationships between entities such as tests, components, and test resources.
When analyzing the impact of a change proposed to a specific entity, the dependencies indicate the
other entities that the changemight affect. For example, youmay want to view dependencies before
deleting or copying an entity.

Dependency relationships are displayed in the Dependencies tab. This tab is available from the Test
Plan, Business Components, and Test Resources modules. You can view the entities used by a
selected entity, and the entities that are using a selected entity.

You can define dependencies between entities using other HP testing tools, for example, Unified
Functional Testing. For details, refer to theHP Unified Functional Testing User Guide.

You can also define dependencies between entities by writing your own application. For more
information, refer to the ALMOpen Test Architecture API Reference.
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How to Use Test Resources
This task describes how tomanage test resources in the Test Resources module. Create a test
resource tree, upload and download resources, and define dependencies between resources and other
entities, such as tests.

Note: This task is part of a higher-level task. For details, see "How to Plan Tests in ALM" on
page 344.

This task includes the following steps:

l "Prerequisites" below
l "Create resources" below
l "Upload resource files" below
l "Download resource files" below
l "Define dependencies" on the next page
l "View dependencies" on the next page

1. Prerequisites
For details on working with UFT resources, see the section on working with ALM in theHP Unified
Functional Testing User Guide.

2. Create resources
a. Open the Test Resources module. On the ALM sidebar, under Testing, select Test

Resources.
b. Create folders. Right-click theResources root folder and select New Resource Folder. To

create a sub-folder, right-click a folder and select New Resource Folder.
c. Add resources to folders. Right-click a folder or sub-folder and select New Resource. Fill in

the fields in the New Resource dialog box. For user interface details, see "New
Resource/Resource Details Dialog Box" on page 460.

3. Upload resource files
You can upload files for each resource in the test resource tree to the ALM repository.
Select a resource in the test resource tree and click theResource Viewer tab. For user interface
details, see "Resource Viewer Tab" on page 457.
Business Process Testing:Whenworking with application areas, launch the testing tool in the
Application Area Viewer tab to work with the resource. For user interface details, see
"Application Area Viewer Tab" on page 458.

4. Download resource files
To view and edit your test resources, you can download them to a local directory.
Select a resource in the test resource tree and click theResource Viewer tab. For user interface
details, see "Resource Viewer Tab" on page 457.
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5. Define dependencies
You define dependencies between entities from your testing tool, for example, UFT. For more
information, refer to theHP Unified Functional Testing User Guide.
You can also define dependencies between entities by writing your own application. For more
information, refer to theHP ALMOpen Test Architecture API Reference.

6. View dependencies
View the relationships between entities such as tests, components, and test resources. You can
view the entities that depend on a selected entity, and the entities on which a selected entity
depends.
Select a resource (Test Resources module), test (Test Planmodule) or component (Business
Components module) and click theDependencies tab. For user interface details, see
"Dependencies Tab" on page 459.

Test Resources User Interface
This section includes:

• Test Resources ModuleWindow 451
• Test Resources ModuleMenus and Buttons 452
• Test Resources Module Icons 454
• Test Resources Module Fields 456
• Resource Viewer Tab 457
• Application Area Viewer Tab 458
• Dependencies Tab 459
• New Resource/Resource Details Dialog Box 460
• Paste Resources To Target Project Dialog Box 461
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Test Resources ModuleWindow
This window enables you tomanage resources used by your tests.

To access On the ALM sidebar, under Testing, select Test Resources.

Important
information

l UFT: Formore details on working with UFT resources, see the section on working
with ALM in theHP Unified Functional Testing User Guide.

l Business Process Testing:When an ALM project with Business Process
Testing is connected toUFT, aBPT Resources folder is created automatically in
the tree. The BPT Resources folder contains all the UFT resources available for
business components in the project. For details about Business Process Testing
application areas, see theHP Business Process Testing User Guide.

l Performance Center: Formore details on working with Performance Center
resources, see theHP ALM Performance Center Guide.

Relevant
tasks

"How to Use Test Resources" on page 449

See also "Test Resources Overview" on page 448

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Test
Resources
module
common UI
elements>

l Test Resource fields. For field definitions, see "Test Resources Module
Fields" on page 456.

l Test Resource menus and buttons. For command and button descriptions,
see "Test Resources ModuleMenus and Buttons" on the next page.

l Test Resource icons. For icon descriptions, see "Test Resources Module
Icons" on page 454.

l ALM masthead, menus, and sidebar. For details, see "ALM Common Areas"
on page 32.

<test resource
tree>

A graphical representation of your test resources.

Note:When Sprinter is used for manual testing in your project, aSprinter
folder is added to theResources folder. This folder contains a subfolder for
each Sprinter user and is used to store user information. Caution: The
Sprinter folder is managed by Sprinter only. Youmust not make any changes
to the folder or subfolders. For more details, see the HP Sprinter User Guide.

Details tab Displays details of the currently selected resource folder or resource. For more
details, see "Test Resources Module Fields" on page 456.
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UI Element Description

Resource
Viewer tab

Enables you to upload and download test resource files from the ALM repository.
For more information, see "Resource Viewer Tab" on page 457.

Note: Some resources have different viewer tabs, such as the application
area resource. For details on its viewer tab, see "Application Area Viewer Tab"
on page 458.

Dependencies
tab

Displays dependency relationships that exist between entities such as test
resources, components, and tests. For more information, see "Dependencies Tab"
on page 459.

History tab Displays a history of baselines in which the test resource appears. You can also
compare two baseline versions.

Version Control: You can view all previous versions of a test resource.

For more details, see "History Tab" on page 68.

Monitors
Configuration
tab

Performance Center:Enables you to configure Performance Center monitor
profiles. For details, see theHP ALM Performance Center Guide.

Test Resources Module Menus and Buttons
This section describes themenus and buttons available in the Test Resources module.

To access On the ALM sidebar, under Testing, select Test Resources.

Important
information

Tip: You can access themenu bar from the Test Resources module by
pressing the shortcut key ALT.

Relevant tasks "How to Use Test Resources" on page 449

See also l "Test Resources ModuleWindow " on the previous page
l "Test Resources Module Icons" on page 454
l "Test Resources Overview" on page 448

User interface elements are described below:

UI Element Menu Description

Collapse View Collapses all branches in the test resource tree.

Copy
URL/Paste

Edit Copies a selected resource and pastes its URL as a link. The resource
itself is not copied. Instead, you can paste the address into another
location, such as an email or a document. Clicking the link opens ALM
and takes you to the resource file or folder. If you are not already logged
in, ALM first prompts for login details.
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UI Element Menu Description

Copy/Paste Edit Copies selected resources or folders within the same project or across
projects.

Note:

l When you copy a resource from one project to another, if the
resource is dependent on other test resources, you can instruct
ALM to copy using one of threemethods. For more details, see
"Paste Resources To Target Project Dialog Box" on page 461.

l To copy resources across projects, both projects must use the
same ALM version and patch level.

Delete
Edit Deletes selected resources and folders from the test resource tree.

If other entities depend on the resource, the Delete Resource dialog box
opens. The related entities are displayed.

Caution: If other entities depend on the resource, deleting the
resourcemay impact these related entities. You can view related
entities in the Dependencies tab. For more information, see
"Dependencies Tab" on page 459.

Version Control: Deleting a resource deletes all previous versions of the
resource.

Filter
View Enables you to filter the resources in the test resource tree. For more

details, see "Filter Dialog Box" on page 51.

Expand All View Expands all branches in the test resource tree.

Cut/Paste Edit Moves selected resources to a different location in the test resource
tree.

Note: The root folder cannot bemoved.

Tip: You can alsomove a resource to a new location in the test
resource tree by dragging it.

Find Edit Opens the Find dialog box, enabling you to search for a resource in the
test resource tree. For more details, see "Find Dialog Box" on page 63.

New
Resource

Resources Opens the New Resource dialog box, enabling you to add a resource to
a selected folder. For more details, see "New Resource/Resource
Details Dialog Box" on page 460.
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UI Element Menu Description

New
Resource

Folder

Resources Opens the New Resource Folder dialog box, enabling you to add a folder
under a selected folder.

Send by
E-mail

Resources Opens the Send E-mail dialog box, enabling you to send a resource by
email to recipients selected from a list. For more details, see "Send E-
mail Dialog Box" on page 69.

Refresh All View Refreshes the test resource tree so that it displays themost up-to-date
information.

Rename Edit Renames a selected resource or folder.

Test Resources Module Icons
This section describes the icons available in the Test Resources module.

To access On the ALM sidebar, under Testing, select Test Resources.

Important
information ALM Editions:Not all resource types are available with each edition. For more

information about ALM editions and their functionality, see "ALM Editions" on
page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

"How to Use Test Resources" on page 449

See also l "Test Resources ModuleWindow " on page 451
l "Test Resources ModuleMenus and Buttons" on page 452
l "Test Resources Overview" on page 448

User interface elements are described below:

UI
Element

Description

Analysis Template. Contains templates for performance test analysis reports.

For details about analysis templates, see theHP ALM Performance Center Guide.
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UI
Element

Description

Application area. Provides all settings and resources required to create the content of:

l UFT GUI tests
l Business process tests or flows that contain business components with automated
GUI facets

For details about application areas, see theHP Business Process Testing User Guide.

Data Table. Contains data to be used for driving run steps for: 

l Test configurations
l UFT GUI tests and API tests
For details about data tables for UFT, see theHP Unified Functional Testing User Guide.

For task details about using data tables for test configurations, see "How toWork with
Test Configurations" on page 420.

Environment Variables. Contains variables and corresponding values that can be
accessed from:

l UFT GUI tests
l Business process tests or flows that contain business components with automated
GUI facets

For details about environment variables, see theHP Unified Functional Testing User
Guide.

Function Library. Contains Visual Basic script functions, subroutines, andmodules for
use with:

l UFT GUI tests
l Business process tests or flows that contain business components with automated
GUI facets

For details about function libraries, see theHP Unified Functional Testing User Guide.

Recovery Scenario. Contains scenarios which include definitions of unexpected events
and the operations necessary to recover UFT run sessions. For details about recovery
scenarios, see theHP Unified Functional Testing User Guide.

API Test Shared Resources. Contains imported services for use in ALM with:

l API tests, which are created in HP Service Test and UFT
l Business process tests or flows that contain business components that are
automated for API testing

For details about sharing services, see the information about activity sharing in theHP
Service Test User Guide or the information about API testing in theHP Unified
Functional Testing User Guide.
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UI
Element

Description

Shared Object Repository. Contains information that enables UFT to identify the
objects in your application. UFT enables you tomaintain the reusability of your tests by
storing all the information regarding your test objects in shared object repositories. For
details about shared object repositories, see theHP Unified Functional Testing User
Guide.

Test Resource. A generic test resource type for use by all test types.

Monitor Over Firewall. Contains Performance Center monitor settings for servers that
are located over a firewall. For details about monitor over firewall, see theHP
Performance Center Guide.

Monitor Profile. Contains Performance Center monitor settings that can be saved as a
monitor profile to be used by any load test in your project. For details about monitor
profiles, see theHP Performance Center Guide.

Test Resources Module Fields
This section describes the Test Resources module fields.

To access On the ALM sidebar, under Testing, select Test Resources.

Important
information

l You can add user-defined fields and change the label of any of the fields in the Test
Resources module. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

l You can use the Script Editor to restrict and dynamically change the fields and
values in the Test Resources module. For more information, refer to theHP
Application Lifecycle Management Administrator Guide.

Relevant
tasks

"How to Use Test Resources" on page 449

See also l "Test Resources ModuleWindow " on page 451
l "Test Resources Overview" on page 448

The fields are described below:

UI Element
(A-Z)

Description

Comments Displays comments about the resource. To add a new comment, click theAdd
Comment button. A new section is added to theComments box, displaying your
user name and the database's current date.

Created By The user who created the resource.
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UI Element
(A-Z)

Description

Creation
Date

The date on which the resource was created.

Default value: The current database server date.

Description Describes the folder or resource.

Click in the text box to display a toolbar for formatting and spell checking the text.

File Name The file name.

Folder ID A unique numeric ID for the folder that is assigned by ALM. This field cannot be
modified.

Modified The date the resource was modified.

Name The folder or resource name.

Resource
ID

A unique numeric ID for the file that is assigned by ALM. This field cannot be
modified.

Type Indicates the type of resource. For details, see "Test Resources Module Icons" on
page 454.

Version
number

Version Control: The version number of the resource. If version control is enabled
for your project, this field is displayed.

Resource Viewer Tab
This tab enables you to upload files for each resource in the test resource tree to the ALM repository.
You can also download files to a local directory.

To access In the Test Resources module, select a resource in the test resource tree and click
theResource Viewer tab.

Important
information

l To view the resource content, youmust install the relevant add-in or extension. For
more information on the Unified Functional Testing add-in, refer to theHP Unified
Functional Testing User Guide.

l Some resources have different viewer tabs, such as the application area resource.
For details on its viewer tab, see "Application Area Viewer Tab" on the next page.

Relevant
tasks

"How to Use Test Resources" on page 449

See also "Test Resources Overview" on page 448
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User interface elements are described below:

UI Element Description

Upload File. Uploads the file or folder to the ALM repository. Includes the
following options:

l Upload File. Opens the Upload File dialog box, enabling you to select a file.
l Upload Folder. Opens the Browse for Folder dialog box, enabling you to
select a folder.

To replace an uploaded file, upload again.

Download. Opens the Browse for Folder dialog box, enabling you to download
a selected folder.

Refresh. Refreshes the tab.

File name Resource file name.

Application Area Viewer Tab
This tab enables you to launch the testing tool for the application area resource.

To access Business Process Testing: In the Test Resources module, select an application
area resource in the test resource tree and click theApplication Area Viewer tab.

Important
information

l To view the resource content, youmust install the relevant testing tool, add-in, or
extension. For more information on the UFT add-in, refer to theHP Unified
Functional Testing User Guide.

l Launching an ALM application area resource in QuickTest Professional version
10.00 and 11.00 is not supported. Instead, open the application area directly in
QuickTest Professional.

Relevant
tasks

"How to Use Test Resources" on page 449

See also "Test Resources Overview" on page 448

User interface elements are described below:

UI
Element

Description

Launch
<testing
tool>

Launches the relevant testing tool.

Version Control: The Launch button is disabled when attempting to open an
application area from an older version or baseline. Instead, open the application area
directly in QuickTest Professional.
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Dependencies Tab
This tab displays the relationships between entities such as tests, components, and test resources.
You can view the entities that depend on a selected entity (Used By grid), and the entities that a
selected entity depends on (Using grid).

To access Use one of the following:

l Test Resourcesmodule: Select a resource in the test resource tree and click the
Dependencies tab.

l Test Planmodule: Select a test in the test plan tree and click theDependencies
tab.

l Business Componentsmodule: Select a component in the component tree and
click theDependencies tab.

Relevant
tasks

"How to Use Test Resources" on page 449

See also "Entity Dependencies Overview" on page 448

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Go To. Enables you to navigate to a selected entity.

Show Broken Relation. Displays details of the broken relation for the selected
relation in theUsing grid.

Select an entity in theUsing grid that is marked as a broken relation and click the
Show Broken Relation button.

Refresh. Refreshes the tab.

Show/Hide arrow. Displays or hides theUsed By orUsing grid.

Broken Relation. The related entity no longer exists. Click the icon for details.

<Used by
grid>

Displays entities that depend on a selected entity.

<Using
grid>

Displays the related entities that a selected entity depends on.

ID A unique numeric ID for the associated entity. The ID is assigned automatically by
ALM.

Name The name of the associated entity.
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UI Element Description

Type The type of the associated entity.

Description The description of the associated entity.

Owner
name

The name of entity that owns the selected entity.

Owner type The type of entity that owns the selected entity.

New Resource/Resource Details Dialog Box
This dialog box enables you to add and view resources.

To access Use one of the following:

l In the Test Resourcesmodule, right-click a resource folder and select New
Resource. The New Resource dialog box opens.

l In the Test Resourcesmodule, click theHistory tab. Click Baselines or
Versions and Baselines. Click theView button. The Resource Details dialog box
opens.

Important
information

Version Control: The new resource is automatically checked out. For more
information, see "Check Out Dialog Box" on page 111.

Relevant
tasks

"How to Use Test Resources" on page 449

See also "Test Resources Overview" on page 448

User interface elements are described below:

UI Element Description

Rest All Fields. Clears the content in the dialog box.

Available from: New Resource dialog box

Check Spelling. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb
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UI Element Description

Send by Email. Sends an email with the test resource details. For more details,
see "Send E-mail Dialog Box" on page 69.

Available from: Resource Details dialog box

Name The name of the resource.

Type Indicates the type of resource. For details, see "Test Resources Module Icons" on
page 454.

Details Details of the currently selected test resource. For details on the available fields,
see "Test Resources Module Fields" on page 456.

Resource
Viewer

Enables you to upload files for the currently selected test resource to the ALM
repository. You can also download files to a local directory. For more details, see
"Resource Viewer Tab" on page 457.

Dependencies Displays the relationships between the currently selected test resource and other
entities. For more details, see "Dependencies Tab" on page 459.

Paste Resources To Target Project Dialog Box
This dialog box enables you to choose how ALM copies test resources across projects.

To
access

1. In the Testing > Test Resources tree, select the resource or folder that you want to
copy. To copy more than one item, use the CTRL key.

2. Select Edit > Copy. Alternatively, right-click and choose Copy.
3. Log in to the project to which you want to paste the resource or folders and navigate to

the Testing > Test Resources tree.
4. Select the folder to which you want to copy the resources or folders.
5. Select Edit > Paste. Alternatively, right-click and choosePaste.

User interface elements are described below:

UI Element Description

Copy resources
and link to
existing related
entities

ALM copies the test resources and pastes them into the target project. The
copied test resources are linked to existing entities with the same name and
path. If a related entity does not exist in the target project, ALM copies it to the
target project.

Copy resources
and related
entities

ALM copies the test resources along with the related entities, and pastes them
into the target project. If an entity already exists in the target project, the copied
related entity is renamed to resolve the duplicate name.

Copy resources
without
copying related
entities

ALM copies the test resources without copying the related entities, and pastes
them into the target project. The copied items are not linked to any related
entities.
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Chapter 30: VAPI-XP Tests
This chapter includes:

• VAPI-XP Tests Overview 464
• How to Create VAPI-XP Test Scripts 464
• How to Edit VAPI-XP Test Scripts 471
• How to Use AUT Environments with VAPI-XP 475
• How to Use the VAPI-XP API 476
• How to Run VAPI-XP Tests in DebugMode 479
• How to Run VAPI-XP Tests in Test Mode 480
• How to Debug VAPI-XP Tests Scripts Test Mode 481
• VAPI-XP User Interface 482
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VAPI-XP Tests Overview
The VAPI-XP testing tool enables you to create new testing scripts usingMicrosoft VBScript,
Microsoft JavaScript (JScript version), PerlScript, and PythonScript, and integrate these scripts into
your applicationmanagement process. Using VAPI-XP test scripts, you can test COM/DCOM
servers, SOAP-basedWeb services, Java APIs (such as Java classes and EJBs), and console
applications. You can also use VAPI-XP to create a LoadRunner virtual user.

In addition, VAPI-XP is fully integrated with HP Application Lifecycle Management (ALM), enabling you
to design your VAPI-XP test script to call any ALM test or test set, and execute it as part of your own
script. This allows you to build amore advanced test set execution flow, in which you can filter tests in
a test set during execution, based on the status or type of each test.

VAPI-XP is also fully integrated with the ALMOpen Test Architecture API. All open test architecture
API classes andmethods can be referenced from the VAPI-XP user interface so that you can easily
include them in your test script.

Note: The VAPI-XP testing tool is installed on a testing host by performing HP ALM Client
Registration. Instructions for performing client registration can be found in the HP Application
Lifecycle Management Installation and UpgradeGuide.

For task details, see:

l "How to Create VAPI-XP Test Scripts" below
l "How to Edit VAPI-XP Test Scripts " on page 471
l "How to Use AUT Environments with VAPI-XP" on page 475
l "How to Use the VAPI-XP API" on page 476
l "How to Run VAPI-XP Tests in DebugMode " on page 479
l "How to Run VAPI-XP Tests in Test Mode " on page 480
l "How to Debug VAPI-XP Tests Scripts Test Mode " on page 481

How to Create VAPI-XP Test Scripts
You create a VAPI-XP test script from the test plan tree in the Test Planmodule.

To learnmore about VAPI-XP tests, see "VAPI-XP Tests Overview" above.

Note: You can also convert a manual test to a VAPI-XP test. In theDesign Steps tab, click the

Generate Script button and select VAPI-XP-TEST. ALM creates a VAPI-XP test script that
includes code for the steps that you defined. It also includes code for called tests that were part of
the original manual test. For more information onmanual tests, see "Test Design" on page 403.

To create a VAPI-XP test script:
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1. Choose a subject folder in the test plan tree.

2. Click theNew Test button or choose Tests > New Test. The New Test dialog box opens.
3. In the Test Type box, select VAPI-XP-TEST.
4. In the Test Name box, type a name for the test. Note that a test name cannot include the following

characters: \ / : " ? < > | * % `
5. Add test details in the Details tab. Click OK.

Note: If required test fields were defined in the Project Customization window, the Required
Test Fields dialog box opens. Select values for the required fields, and click OK.

The HP VAPI-XP Wizard opens.

6. In theScript Language box, select a script language.

Note:

l To create a VAPI-XP test script using ActiveState's ActivePython or ActivePerl scripts,
youmust install the script language on your machine. From theHelpmenu in the Test
Script tab, select ActivePython Home Page orActivePerl Home Page, and follow the
appropriate installation instructions.

l Microsoft's VBScript and JScript are usually installed with Internet Explorer. If they are not
installed on your machine, select VBScript Home Page or JScript Home Page from the
Helpmenu in the Test Script tab, and follow the appropriate installation instructions.

7. In theScript Name box, type a name for the VAPI-XP test script.
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8. If you selected VBScript or JavaScript as your test scripting language, you can select Create HP
LoadRunner Vuser to create a LoadRunner virtual user script that can be run in the LoadRunner
Controller.

Note: To run this virtual user in the Controller, youmust install the latest version of the HP
ALM Connectivity Add-in on your LoadRunner client machine. This add-in is available from
the HP Application Lifecycle Management Tools add-ins page. For more information, refer to
theHP Application Lifecycle Management Installation and UpgradeGuide.

9. Click Next to continue creating the test script using the HP VAPI-XP Wizard. The following dialog
box opens.

Note: In each dialog box, you can click Finish to close theWizard and continue creating the
test script in the Test Script tab.

10. Select the type of test you want to create.
11. Click Next to continue creating the test script using the HP VAPI-XP Wizard.
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l If you selectedCOM/DCOM Server Test, choose the Program IDs of the COM/DCOM objects
in your machine's registry that you want to test, and click the + button. Each selected
COM/DCOM object and its description is displayed in the box below.

l If you selected Java Class Test, type the full name of the Java class that you want to test in the
Java Class Name box, and click the + button. The Java class name you typed appears in the
text box below.

User Guide
Chapter 30: VAPI-XP Tests

HP ALM (12.50) Page 467



Note: You can only use a Java class that has a public constructor that does not take
arguments.

Under Java Virtual Machine, specify the following:

o JVM Runtime. The Java virtual machine runtime executable file (usually java.exe).
o Java Compiler. The executable file that recompiles the bytecode at the execution platform

(usually javac.exe).
o Classpath. A list of additional (non-standard) Java libraries, separated by semi-colons (;),

required to run the specified Java application. Note that if you do not specify the Java
classpath, ALM uses the environment variableCLASSPATH.

o JVM Parameters. The parameters for the Java virtual machine run-time executable file.
When working with Java virtual machines, add the location of the BSF DLLs to the system path,
as follows: In the Control Panel, chooseSystem > System Properties, and then click the
Advanced tab. Click theEnvironment Variables button, and in theSystem Variables area, edit
thePath parameter by adding the path of the following DLLs:msvcp60.dll,
bsfactivescriptengine.dll, and bsfactivescriptengine_g.dll. Click OK.

l If you selectedWeb Service (SOAP) Test, choose the SOAP client library from theSOAP
Client Library list, and type or select the URL you want to test in theWeb Service Definition
box. Click the + button. The URL you typed appears in the text box below.
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Note: Two SOAP client libraries are supported: Microsoft SOAP SDK and PocketSOAP.
Note that even if you choose to work with PocketSOAP, youmust install Microsoft SOAP
SDK to parseWeb services. If Microsoft SOAP SDK is not already installed on your
machine, run theSoapToolkit30.exe file located in theRedist directory on your ALM
installation DVD.

l If you selectedConsole Application Test, type the name of the application file you want to
test in theApplication Executable File box, and its parameters in theCommand Line
Parameters box.

Clear theUse VAPI-XP Output instead of Standard Output box if you do not want to replace
the standard output with the VAPI-XP output window.

In theApplication Timeout box, type the time, in milliseconds, for ALM to wait for the
application to finish running. Note that if the timeout is set to -1, ALM waits an infinite amount of
time for the application to finish running.
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Click the + button. The data you entered appears in the text box below.

12. Click Next to continue creating the test script using the HP VAPI-XP Wizard. The following dialog
box opens.
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13. In theService list, select the functions you want to add to your test script. Double-click each
function, or drag and drop it, to add it to your script code. The function is added to the box below
the Service list.

14. If required, enter additional parameters or add extra code to the script in the lower pane.
15. Click Finish. The new test appears in the test plan tree under the subject folder you selected.

Note: You can choose to add details and attachments to the VAPI-XP test you created, or
define requirements coverage. For information, see "Test Plan Specification" on page 347.

How to Edit VAPI-XP Test Scripts
After you have created a VAPI-XP test script using the HP VAPI-XP Wizard, you can edit it in the Test
Script tab.

To learnmore about VAPI-XP tests, see "VAPI-XP Tests Overview" on page 464.

Tip: You can display the Test Script tab in a separate window by selectingView > Window

Screen, or clicking theWindow Screen button .

To edit a VAPI-XP test script:
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1. In the test plan tree, select a VAPI-XP test, and click the Test Script tab. The test script is
displayed.

Note: To view or edit the properties of the test script you created, choose Test > Properties.

2. To view a list of object definitions, methods, and properties that you can add to your script, select
one of the following options:
l Test > References > COM Library References. Opens the References dialog box in which
you can choose the COM object definitions, methods, and properties you want to view.

l Test > References > SOAP Web Service References. Opens the AddWeb Service
Reference dialog box in which you can type theWeb service object definition or method you
want to view.

l Test > References > Java Class References. Opens the Add Java Class Reference dialog
box in which you can type the Java class object definition or method you want to view.

3. Select View > Browsers, or click theShow/Hide Browsers button . The following tabs are
displayed.
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l Library tab. Displays a list of VAPI-XP (SRunner), ALM (TDAPIOLELib), and COM/DCOM
object definitions, methods, and properties that you can add to your script. For an explanation of
VAPI-XP object definitions, methods, and properties, see "How to Use the VAPI-XP API" on
page 476. For an explanation of ALM object definitions, methods, and properties, refer to theHP
ALMOpen Test Architecture API Reference.

l Soap tab. Displays a list of Web service object definitions andmethods that you can add to
your script.

l Java tab. Displays a list of Java class object definitions andmethods that you can add to your
script.

l Function tab. Displays a list of functions contained in your script.
l Object tab. Displays a list of objects with defined names that you can add to your script.

Note: For a description of each object definition, method, or property, select View > Output,
and click theHelp tab.

4. To add an object definition, method, or property to the current function in your script, place the
cursor in the appropriate place in your code, and double-click the object definition, method, or
property in the Library, Soap, or Java tabs.

5. To add an object with a defined name, select the object definition, method, or property in the
Library, Soap, or Java tabs, and choose Test > Add Object. In the AddObject dialog box, type
the name you want to assign to the object and click OK. The object is added to the Object tab.
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To add the object to your script, double-click the object, or right-click it and select Insert into
Script.

6. To check the syntax of your code, choose Test > Check Syntax, or click theSyntax Check

button . Select View > Output to view the verification results in theOutput tab.

Additional Editing Functions
You can perform the following editing functions in the Test Script tab:

l To undo a previous action, click theUndo button . To restore an action that was undone, click

theRedo button .
l To remove a section of code from one part of your script, and place it in another part of the script,

select the section and click theCut andPaste buttons.
l To copy a section of code from one part of your script, and place it in another part of the script, select

the section and click theCopy andPaste buttons.

l To delete a section of code, select it and click theDelete button .

l To locate specific text within your script, click the Find in Script button . In the Find Text
dialog box, type the text for which you want to search. Select the options, direction, scope, and
origin for your search, and click OK.
To find another occurrence of the text within the script, chooseSearch > Find Next.

l To locate specific text within your script and replace it with different text, click theReplace button

. In the Find Text dialog box, type the text you want to search for in the Text to find box. Type
the text with which you want to replace this text in theReplace with box. Select the options,
direction, scope, and origin for your search, and click OK. To replace all instances of the text in the
script, click theReplace All button.

l To locate a specific line number within your script, chooseSearch > Go to Line Number. In the Go
to Line Number dialog box, type the line number you want to find, and click OK.
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l To change the editor options, such as themargins, fonts, and screen/text colors, click theEditor

button . Set the properties you want in the Editor, Display, and Colors tabs, and click OK.

After you have finished editing your script, click theSave button to save the changes youmade.

How to Use AUT Environments with VAPI-XP

ALM Editions: AUT Environments and Functional test sets are available only for ALM Edition. For
more information about ALM editions and their functionality, see "ALM Editions" on page 115. To
find out what edition of ALM you are using, ask your ALM site administrator.

VAPI-XP tests can be run using server-side execution when they are part of a Functional test set.
When using server-side execution, you can take advantage of AUT Environments. AUT Environments
allows users tomake test executionmore dynamic by parameterizing the environment data used for
testing. Instead of defining and running several different VAPI-XP tests that use the same logic but
need different environment parameters, you can simply program your VAPI-XP test to use an already
defined AUT environment configuration that ALM inserts into your test at run-time.

For more information about Functional test sets, see "Test Set Specification Overview" on page 522.

For information about setting up AUT environment configurations and environment parameters, see
"How toWork with AUT Environments" on page 325.

To use your AUT environment configuration in a VAPI-XP script, you use the following functions:

Post
Invoke this function before calling functions that access AUT parameters.

currentRun.post()

getRunTimeParameterByName
Returns the environment parameter value based on parameter name.

currentRun.getRunTimeParameterByName(Name)

Name. Environment parameter name.

getRunTimeParameterByGuid
Returns the environment parameter value based on parameter Guid.

currentRun.getRunTimeParameterByGuid(Guid)

Guid. Environment parameter Guid.

isSSE
Returns TRUE if the test is being run as a server-side execution test in a Functional test set.

currentRun.isSSE
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ReservationId
Returns the timeslot ID of the test if the test is being run as a server-side execution test in a Functional
test set.Otherwise, returns NULL.

currentRun.ReservationID

How to Use the VAPI-XP API
The VAPI-XP tool contains a built-in library of VAPI-XP object definitions that you can reference as you
are creating your test script.

To learnmore about VAPI-XP tests, see "VAPI-XP Tests Overview" on page 464.

Using the TDHelper Object
The TDHelper object supplies the following functions that you can use to perform ALM-related tasks.

RunTestSet
Executes the selected test set and returns the accumulated test set execution status.

RunTestSet([Name = "default"], [Filter = ""], [Locally = FALSE], [Host = ""], [HostGroup = ""])

Name. Test set name. Optional. Default = "default"

Filter. Test filter. Defines tests to run. If empty, instructs ALM to run all the tests in a specified test set.
Optional. Default = ""

Locally. If set to TRUE, instructs ALM to run test set locally. Optional. Default = FALSE

Host. Host on which test set will be run. Optional. Default = ""

HostGroup. Host group in which test set will be run. Optional. Default = ""

RunTest
Executes the selected test and returns the test execution status.

RunTest(Name, Instance, TestSet, [Locally = FALSE], [Host = ""], [HostGroup = ""])

Name. Test name.

Instance. Test instance.

TestSet. Test set name.

Locally. If set to TRUE, instructs ALM to run test set locally. Optional. Default = FALSE

Host. Host on which test set will be run. Optional. Default = ""

HostGroup. Host group in which test set will be run. Optional. Default = ""

AddDefect
Adds a new defect to the current test, if the test is being run in debugmode. If the test is being run in
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test mode, a new defect is added to the current run of the test instance in the current test set. Returns a
created defect object.

AddDefect([Fields], [stepKey])

Fields. Two-dimensional array—the first dimension is for the field name, and the second for the field
value. Optional.

stepKey. step ID for step related to new defect. Optional.

AddDefectUI
Adds a new defect to the current test (in debugmode) or the current run (in test mode), using the ALM
New Defect dialog box.

AddDefectUI([stepKey])

stepKey. step ID for step related to new defect. Optional.

AddStepToRun
Adds a new step to the current run. Returns a created step object.

AddStepToRun(Name, [Desc], [Expected], [Actual], [Status])

Name. Step name.

Desc. Step description. Optional.

Expected. Expected step result. Optional.

Actual. Actual step result. Optional.

Status. Step status. Optional.

DownLoadAttachment
Downloads the attachment associated with a test object. Returns the local path to which the download
was performed.

DownLoadAttachment(Name, item)

Name. The attachment name.

item. Reference to the object with the attachment.

UpLoadAttachment
Uploads an attachment and associates it with a test object.

UpLoadAttachment(path, item)

path. The local path (fully specified file name) of the item to upload.

item. Reference to the object to which to associate the attachment.
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Using the TDInput Object
The TDInput object supplies the following function that you can use to obtain an input value from an end
user.

GetInput
Displays the Input dialog box, enabling you to obtain an input value from an end user.

GetInput([Caption],[Name])

Caption. Dialog box caption. Optional.

Name. Name of the input value. Optional.

Using the TDOutput Object
The TDOutput object supplies the following functions that you can use to control the VAPI-XP Output
tab.

Clear Method
Clears the Output tab.

Clear

Print Method
Prints the text message to a new line in the Output tab.

Print(Msg)

HookDebug Property
Sets or removes the hook for the OutputDebugString tab API function.

HookDebug

Text Property
Gets or sets the Output tab text.

String Text

Using the XTools Object
The XTools object supplies the following functions that you can use to perform general tasks.

run
Runs command line with passed attributes.

run(Command, [Args = ""], [Timeout = -1], [UseOutput = TRUE])
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Command. Application executable file.

Args. Application arguments. Optional. Default = ""

Timeout. Timeout in milliseconds. If this is -1, ALM waits an infinite amount of time for the application
to finish running.

UseOutput. If TRUE, ALM replaces the standard output with the VAPI-XP output window.

WrapArray
Creates an array of variants from an array of objects. For example, if a called object returns as a
method result an array of strings, none of the supported script engines is able to read the array. Calling
theWrapArray function and passing the returned array as a function parameter creates an array of
variants that can be understood by the scripting engine.

WrapArray (array)

array. Array to wrap.

Sleep
Suspends script execution for a specified amount of time.

Sleep(interval)

interval. Time (in milliseconds) for script execution suspension

How to Run VAPI-XP Tests in Debug Mode
After you have created and edited your VAPI-XP test script, you can run it in debugmode or test mode.
Running a VAPI-XP test in debugmode enables you to execute the test without including it in a test set
and without creating test run data in the ALM project. It is generally recommended that you use the
debugmode while you are developing your test, and the test mode once you have completed creating
your test.

To learnmore about VAPI-XP tests, see "VAPI-XP Tests Overview" on page 464.

To run a VAPI-XP test in debug mode:

1. In the Test Planmodule, select a VAPI-XP test from the test plan tree, and click the Test Script
tab.

2. Select Test > Execute (Debug Mode), or click theExecute Script button . ALM begins
executing the test script you selected.

3. Select View > Output to view the output generated by the test script.
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l To clear the Output tab, click theClear Output button .
l To copy the output text to the clipboard, select it and click theCopy Selected Text to

Clipboard button .
l To view the test script output in aWeb browser, click theOpen Output Text in Web Browser

button .

l To print the test script output, click thePrint Output button .
4. To stop executing the VAPI-XP test before it finishes running, select Test > Stop, or click the

Stop button .

How to Run VAPI-XP Tests in Test Mode
You can run your VAPI-XP test in test mode once you have added the test to a test set in the Test Lab
module.

When you run a VAPI-XP test in test mode, test run data is created in the ALM project. You can run
your VAPI-XP test in test mode from either the Test Plan or Test Labmodule.

Note: To run VAPI-XP tests remotely, youmust install the HP ALM Client Registration Add-in and
the HP ALM Connectivity Add-in on the host machine on which the tests are executed. For more
information on add-ins, refer to theHP Application Lifecycle Management Installation and Upgrade
Guide.

To learnmore about VAPI-XP tests, see "VAPI-XP Tests Overview" on page 464.

To run a VAPI-XP test in test mode from the Test Plan module:
1. Select a VAPI-XP test from the test plan tree, and click the Test Script tab.
2. Select Test > Execute (Test Mode). The Select Test Set dialog box opens.
3. In the Test Set box, select the test set containing the current VAPI-XP test.
4. In the Instance box, select the test instance that you want to run.
5. In theRun Name box, type the name you want to assign to the test run.
6. Click OK. ALM begins executing the test you selected.
7. To view the output generated by the test script, select View > Output. For an explanation of the

Output tab, see "How to Run VAPI-XP Tests in DebugMode " on the previous page.
8. To stop executing the VAPI-XP test before it finishes running, select Test > Stop, or click the

Stop button .

To run a VAPI-XP test in test mode from the Test Lab module:
1. From the Test Sets tab, select the test set containing the VAPI-XP test you want to run.
2. In theExecution Grid, select the test you want to run, and click theRun button. The Automatic
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Runner dialog box opens, displaying the selected test.
3. In theRun on Host column, select a host machine on which to run the VAPI-XP test, or choose

Run All Tests Locally to run the test on your local machine.
4. Click theRun button. The VAPI-XP Test Script window opens as ALM begins executing the

selected VAPI-XP test. When ALM finishes executing the test, the Automatic Runner dialog box
displays the status of the test run.

How to Debug VAPI-XP Tests Scripts Test Mode
If your test run was not successfully completed, you can use VAPI-XP's Integrated Debugger to assist
you in debugging your VAPI-XP test script.

Note: You cannot use the Integrated Debugger to debug PerlScript or PythonScript test scripts.

To learnmore about VAPI-XP tests, see "VAPI-XP Tests Overview" on page 464.

To debug a VAPI-XP test script:

1. In the Test Script tab of the Test Planmodule, select Debug > Integrated Debugger. Additional
buttons controlling the debugging process are displayed on the toolbar.

2. To set a breakpoint in a script, select the line in the script where you want to set the breakpoint,

and chooseDebug > Toggle Breakpoint or click the Toggle Breakpoint button .
Alternatively, click the gray margin next to the line in the script. The line you selected is highlighted
in red.

3. Click theExecute Script button . ALM begins executing the script, stopping at the defined
breakpoint. TheOutput tab displays the followingmessage.

4. To instruct ALM to enter the script after the breakpoint, chooseDebug > step Into or click the

step Into button . The line in the script that follows the breakpoint is highlighted in blue.

5. To instruct ALM to step over a line in the script, click the step Over button or chooseDebug >
step Over.

User Guide
Chapter 30: VAPI-XP Tests

HP ALM (12.50) Page 481



6. To instruct ALM to execute the script, chooseDebug > step Out or click the step Out button
. The output is displayed in theOutput tab.

7. To view or edit the value of each variable in the script, chooseDebug > Variables or click the

Show Variables button . The Variables dialog box opens, displaying the variables available
in the current script. Select a variable to view its properties.
To change a variable's value, type the new value you want to assign to it in theValue box and
click Update. Click OK to save your changes and close the Variables dialog box.

8. To view information about a specific variable while debugging, chooseDebug > Watch or click

theShow Watch Window button to display theWatch tab.
To add a variable to theWatch tab, click +, type a variable name in thePrompt box, and click OK.
The variable and its values are displayed in theWatch tab.

9. To instruct ALM to resume executing the script, chooseDebug > Resume Execution or click the

Resume Execution button .

10. ChooseDebug > Stop Debugging, or click theStop Debugging button to stop the
Integrated Debugger from debugging your script.

VAPI-XP User Interface
This section includes:

• HP VAPI-XP Wizard 483
• Test Script Tab 483

User Guide
Chapter 30: VAPI-XP Tests

HP ALM (12.50) Page 482



HPVAPI-XPWizard
This wizard enables you to create VAPI-XP test scripts. For more details, see "How to Create VAPI-
XP Test Scripts" on page 464.

Test Script Tab
This tab enables you to view and edit your VAPI-XP test scripts. For more details, see:

l "How to Edit VAPI-XP Test Scripts " on page 471
l "How to Use the VAPI-XP API" on page 476
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Chapter 31: Introducing Test Execution
This chapter includes:

• Test Execution Overview 488
• How to Run Tests in ALM 490
• How toWork with Draft Runs 492
• Deploying and Testing your Application in ALM 492
• The Test LabModule User Interface 494
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Test Execution Overview
You begin test execution by creating test sets and choosing tests to include in each set. A test set
contains a subset of the tests in an HP Application Lifecycle Management (ALM) project designed to
achieve specific test goals. As your application changes, you can run themanual and automated tests
in your project to locate defects and assess quality.

You can run ALM tests in different ways.

l "Run Tests Using Default Test Sets" below
l "Run Tests Using Functional Test Sets" below

Run Tests Using Functional Test Sets

ALM Editions: Functional test sets are available only for users with ALM Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site administrator.

Tests in Functional test sets are run using server-side execution. This means you do not have to be
around to initiate and control the tests. Functional test sets are run via timeslots, so you can schedule a
test set to be run immediately, or you can schedule it to be run at a future time. Once you schedule the
test, ALM ensures that the necessary resources are reserved for the test set. The test set is launched
without user intervention and run in sequence with the input you provide in advance.

l You can schedule the execution of Functional tests or Functional test sets in the Timeslots module.
If there are currently available hosts for your test, you can also use the Execution Grid to arrange for
tests to run immediately. For details, see "How to Run Tests in ALM" on page 490.

l Functional tests run on testing hosts that are configured in Lab Resources in ALM or Lab
Management. To run tests in a Functional test set, youmust have testing hosts available to your
project. For more information about testing hosts, see "Testing Hosts Overview" on page 322.

l When you schedule a test, an appropriate testing host is reserved for your test and that host cannot
be reserved for another test unless another appropriate host can be found for your test.

l ALMmanages host allocation dynamically. If the testing host reserved for your test becomes
unavailable before your test can be run, ALM is able to automatically reshuffle the remaining testing
hosts and, if possible, reallocate another suitable testing host for your test. For more details, see
"Host Allocation" on page 627.

Functional test sets are a key component in ALM's Continuous Delivery solution. They facilitate an
automated, end-to-end deployment and testing framework that makes application development more
efficient, reliable, and quick. For more information about how Functional test sets can be used as part
of this process, see "Deploying and Testing your Application in ALM" on page 492.

Run Tests Using Default Test Sets
Tests in Default test sets are run using client-side execution. You control the test directly from your
local computer. You can run Default test sets manually or automatically in ALM.

To run tests in Default test sets manually:
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l UseHP Sprinter. Provides enhanced functionality to assist you in themanual testing process.

ALM Editions:Sprinter functionality is not available with Performance Center Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find
out what edition of ALM you are using, ask your ALM site administrator.

l Use Manual Runner. If you don't use Sprinter, you can run tests manually usingManual Runner.
When you run a test manually, you follow the test steps and perform operations on the application
under test. You pass or fail each step, depending on whether the actual application results match the
expected output.

To run tests in Default test sets automatically:

l You can run tests automatically from your local machine usingAutomatic Runner.
l When you run an automated test automatically, ALM opens the selected testing tool automatically,
runs the test on your local machine or on remote hosts, and exports the results to ALM.

l You can also runmanual tests automatically. When you run amanual test automatically and specify
a remote host, ALM notifies a designated tester by email to run the test on the specified host.

For more details about running tests in ALM, see "How to Run Tests in ALM" on the next page.

Following test runs, you review and analyze test results. Your goal is to identify failed steps and
determine whether a defect has been detected in your application, or if the expected results of your test
need to be updated. You can validate test results regularly by viewing run data and by generating
reports and graphs. For details, see "Test Runs Overview" on page 668.

You can also set a test as a draft run to instruct ALM to ignore the run results. For details, see "Draft
Runs" below.

For task details, see "How to Run Tests in ALM" on the next page.

Draft Runs
Setting a test as a draft run instructs ALM to ignore the run results. When you set a test instance as a
draft run, the outcome of the run does not impact the execution status of the test, the status of the test
instance, or the coverage status. ALM also ignores draft runs when calculating the remaining number of
test instances to run, and when displaying results in coverage, progress, and live analysis graphs.

You can designate a test run as a draft before you perform the test. You can alsomark a test run as a
draft by modifying theDraft Run field at any time after the run. When you change theDraft Run value
for a run, ALM recalculates all relevant statistics, and updates relevant status fields. Graphs display
updated results.

Draft runs enable you to try tests while they are still in development, or after they have beenmodified.
For example, youmay want to test that each step description is formulated correctly, or try only a part
of a large test script.

Setting a test run as a draft requires the appropriate user permissions. For more information, refer to the
HP Application Lifecycle Management Administrator Guide.

For task details, see "How toWork with Draft Runs" on page 492.
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How to Run Tests in ALM
This task describes how to run tests in your project using the ALM Test Labmodule.

Note: This task is part of a higher-level task. For details, see "ALM Basic Flow" on page 22.

This task includes the following steps:

l "Create test sets" below
l "Run tests in a Functional test set" below
l "Run tests in a Default test set" below
l "Run Performance tests" on the next page
l "View and analyze test results" on the next page
l "Link to a defect" on the next page

1. Create test sets
Create and define test sets in the Test Labmodule. After you have created test sets, you can
assign test set folders to cycles defined in the releases tree in the Releases module.
For task details, see "How to Create Test Sets" on page 524.
To learnmore about the different types of test sets, see "Test Set Specification Overview" on
page 522.

2. Run tests in a Functional test set

ALM Editions: Functional test sets are available only for ALM Edition. For more information
about ALM editions and their functionality, see "ALM Editions" on page 115. To find out what
edition of ALM you are using, ask your ALM site administrator.

The tests in Functional test sets run using server-side execution. You can reserve resources for
running functional test sets to ensure that they are available for the duration of the run. To run tests
in a Functional test set, do one of the following:
l To schedule a test set run for the future, reserve a timeslot in the Timeslotsmodule. For more
details, see "How to Reserve Testing Timeslots in ALM" on page 632.

l To arrange for a test to run in a timeslot immediately, use theExecution Grid tab in the Test
Labmodule. For more details, see "How to Run Tests Automatically" on page 585.

3. Run tests in a Default test set
The tests in Default test sets run using client-side execution. You control and run the tests from
your machine by using the Test Labmodule. To run tests in a Default test set, do one of the
following:
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l Runmanual and automated tests manually, executing the test steps that you defined during
test planning. For task details, see "How to Run Tests Manually" on page 576.

l Arrange for manual and automated tests in a test set to run automatically. For task details, see
"How to Run Tests Automatically" on page 585.

4. Run Performance tests
Performance Center:You can run performance tests to create load on an application and test its
performance. For details, refer to theHP ALM Performance Center Guide.
You can reserve the resources required for running performance tests to ensure that they are
available for the duration of the test run.
l To schedule a performance test run for the future, reserve a timeslot in the Timeslotsmodule.
For more details, see "How to Reserve Testing Timeslots in ALM" on page 632.

l To arrange for a test to run in an a timeslot immediately, use theExecution Grid tab in the Test
Labmodule. For more details, see "How to Run Tests Automatically" on page 585.

ALM Editions: Performance test execution is available only for ALM Edition and
Performance Center Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM you are
using, ask your ALM site administrator.

5. View and analyze test results
After you run tests, review results to determine if the actual results match the expected test
results. For task details on viewing test results, see "How to View Test Runs" on page 668.
You can also analyze run data by creating graphs and reports. Do one of the following:
l View dynamic graphs of test set folders. In the test sets tree, select a test folder, and click
the Live Analysis tab. For task details on generating live analysis graphs, see "How to
Generate Live Analysis Graphs" on page 832.

l View test set data in a graph. On the Test Labmodulemenu, select Analysis > Graphs. For
task details on generating graphs, see "How to Generate a Graph" on page 736.

l Create a report of test set data. On the Test Labmodulemenu, select Analysis > Project
Report. For task details on creating reports, see "How to Create Project Reports" on page 776.

For details on additional analysis tools in ALM, see "How to Analyze Data in ALM" on page 718.

6. Link to a defect
If a defect has been detected, you can create a new defect and link it to the test set, test instance,
test run, or run step, or you can link it to an already-existing defect.
For user interface details, see "Linked Defects/Entities Page" on page 710.
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How to Workwith Draft Runs
This task describes how to set test runs as draft runs. You can set a test run as a draft in the following
ways:

l Before a test run. You canmark a test that you are runningmanually as a draft run before
performing the test. In theManual Runner: Run Details page, set the value of theDraft Run field to
Y. For user interface details, see "Manual RunnerWizard" on page 580.

l After a test run. You canmark any test run as a draft by modifying theDraft Run field for the run.
For details on accessing run details, see "How to View Test Runs" on page 668.

Deploying and Testing your Application in ALM

ALM Editions:Many of the tasks below include components available only for users with
ALM Edition. For more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site administrator.

ALM enables you to completely automate the complicated process of taking a build of an application
through deployment and testing. You can use ALM, in conjunction with the LabManagement features,
to schedule deployments and test sets to be run nightly or hourly. This deployment and testing is run
without user intervention and can be scheduled to run immediately following the completion of your
build. You can also arrange for your build to be deployed on a specific environment that you define, or
even integrate with HP Continuous Delivery Automation (CDA) to be deployed dynamically on a private
or public cloud.

ALM and LabManagement provide the testing components which allow your application team to
achieve a state of Continuous Delivery, where software can be developed, packaged, deployed, and
tested in an automated fashion, resulting in the ability to provide software reliably, efficiently, and with
great speed.

This section describes the different components ALM provides to facilitate end-to-end deployment and
testing.

l Create Automated Tests
l Create Test Sets
l Create Build Verification Suites
l Define AUT Environment Configuration
l Schedule Timeslots for your Deployments and Tests

1. Create Automated Tests
ALM provides several different types of automated tests for testing the functionality of your
application under test (AUT).
The twomain categories of test types are Functional and Performance:
l Functional tests are used to check that the application works as it should.
l Performance tests are used to check that the application can withstand load and demand.
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You create tests in the Testing > Test Planmodule. For task information, see "How to Create
Tests" on page 348.
For more information about the test types ALM provides and supports, see "Test Types" on
page 351.
Tomake sure you create a comprehensive set of tests, first see "Test Plan Overview" on
page 344.

2. Create Test Sets
ALM provides a container for your tests, called a Test Set. ALM provides test set types for each
type of automated test: Functional test sets and Performance test sets.
You can group your tests into test sets in different ways. You can group them in terms of features
and aspects in the application. Alternatively, you can create groups of tests that check positive
flow, and create groups of tests that check negative flow.
You create test sets in the Testing > Test Labmodule. For task information, see "How to Create
Test Sets" on page 524.
For more information about the test set types, see "Test Set Specification Overview" on page 522.

3. Create Build Verification Suites
ALM provides a way to bundle several test sets together, regardless of their type, to create a Build
Verification Suite. The build verification suite is used to check the overall status of your build.
A build verification suite may contain both Functional test sets and a single Performance test set.
You can createmultiple build verification suites to check the application at varying levels of
comprehensiveness. One large build verification suite can be created and scheduled to run every
night, and another build verification suite containing only the core test sets can be created and
scheduled to run every hour, or manually every time a build is produced.
You create build verification suites in the Testing > Build Verificationmodule. For task
information, see "How toWork with Build Verification Suites in ALM" on page 606.
For more information about build verification suites, see "Build Verification Overview" on
page 606.

4. Define AUT Environment Configuration
ALM provides a way to define a set of environment parameters that you can bundle with your build
configuration suites and test sets, called an AUT Environment Configuration.
Instead of defining and running several different tests that use the same logic but need different
environment parameters, you can simply bundle a set of environment parameters into an
AUT environment configuration. When you run your build verification configuration suites or
functional test sets, you can provide your AUT environment configuration, and ALM uses those
parameters to run your tests.
If your application environment is dynamic and changing, youmay want to use ALM and Lab
Management to link your AUT environment configurations to CDA. Linking the environment
parameters in your AUT environment configuration to CDA allows you to dynamically provision
and deploy your application environment using a private or public cloud.
You create AUT environment configurations in the Lab Resources > AUT Environments
module. For task information, see "How toWork with AUT Environments" on page 325.
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Formore information about AUT Environments, see "AUT Environments Overview" on page 324.
For more information about CDA servers, see theHP ALM LabManagement Guide.
For task information about managing CDA servers in LabManagement, see theHP ALM Lab
Management Guide. For more information about linking AUT environment configurations and
parameters to CDA in ALM, see "Link AUT Environments to CDA" on page 324 and "How toWork
with AUT Environments" on page 325.

5. Schedule Timeslots for your Deployments and Tests
ALM allows you to schedule deployment and testing of your application for the future using
Timeslots. ALM ensures that the testing resources required for your timeslot are reserved ahead of
time.
Instead of having tomanually run a set of tests after producing a build, ALM allows you to
automatically allocate resources and initiate provisioning, deployment, and testing of an
application in an environment. You can use timeslots to reserve resources for a build verification
suite or a test set run, and if you integrate CDA into your build verification suites, you can even
arrange for scheduled dynamic provisioning and deployment.
There are a few ways to schedule a run. The simplest is to schedule a test and allocate resources
in advance by creating a timeslot in the Testing > Timeslotsmodule. Alternatively, if the testing
resources are available, you can arrange for a run to be executed immediately.
For details about timeslot reservation, see "How to Reserve Testing Timeslots in ALM" on
page 632.
For task information about executing tests and test sets, see "How to Run Tests Automatically"
on page 585.
For task information about executing build verification suites, see "How toWork with Build
Verification Suites in ALM" on page 606.
For more information about timeslots, see "Reserving Timeslots Overview" on page 622.

The Test Lab Module User Interface
This section includes:

• Test LabModuleWindow 495
• Test LabModuleMenus and Buttons 497
• Test LabModule Icons 511
• Test LabModule Fields 513
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Test Lab ModuleWindow
This window enables you to create test sets and perform test runs.

To access On the ALM sidebar, under Testing, select Test Lab.

Important
information

The Test Labmodule enables you to create andmodify test sets in the test
sets tree.

ALM Editions: Functional and Performance test sets are available only
for ALM Edition.

Relevant tasks l "How to Create Test Sets" on page 524
l "How to Run Tests in ALM" on page 490

See also "Test Execution Overview" on page 488

Test Lab Module Common Elements
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Test Lab module
common UI elements>

l Test Lab fields. For field definitions, see "Test LabModule Fields" on
page 513.

l Test Lab menus and buttons. For command and button
descriptions, see "Test LabModuleMenus and Buttons" on page 497.

l Test Lab icons. For icon descriptions, see "Test LabModule Icons"
on page 511.

l ALM masthead, menus, and sidebar. For details, see "ALM
Common Areas" on page 32.

Test Sets Tab
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Filter
status bar>

Describes the filter currently applied to the tree. Located directly above the test sets
tree.
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UI Element Description

<Test sets
tree>

Located on the left side of the window, organizes and displays your test sets
hierarchically. A test set contains a subset of the tests in your project.

Note: You cannot move test sets within a folder. When you refresh the tree
view, test sets in a folder are alphabetized.

Select Test
Pane

Displays the Test Plan Tree tab and the Requirements Tree tab, enabling you to
select tests to add to the selected test set. For details, see "Select Tests Pane" on
page 544.

Available from:Execution Grid, Execution Flow. To display, click theSelect Tests
button.

Details tab Displays details of the currently selected test set or folder.

Note: For a test set folder, click theShow button to view additional information.

Execution
Grid tab

Displays test data in a grid. For details, see "Execution Grid Tab" on page 528.

Requested
Hosts tab

Displays the hosts requested for the currently selected test set.

The Requested Hosts tab is only available for server-side execution Functional test
sets.

For details, see "Requested Hosts Tab" on page 538.

Execution
Flow tab

Displays test data in a diagram. Enables you to specify conditions for test
execution. For details, see "" on page 554.

Automation
tab

Displays email notification rules andOn Failure instructions for the currently
selected test set. For details, see "Automation Tab" on page 541.

Attachments
tab

Lists attachments that provide additional information about the currently selected
test set. For details, see "Attachments Page" on page 72.

Linked
Defects tab

Lists the defects linked to the currently selected test set. For user interface details,
see "Linked Defects/Entities Page" on page 710.

History tab Lists changes made to the currently selected test set. For details, see "History Tab"
on page 68.

Description
tab

Describes the currently selected test set or test set folder.

Click in the text box to display a toolbar for formatting and spell checking the text.

Live
Analysis

A graphical representation of the test data related to the currently selected test set
folder. For details, see "Live Analysis Tab" on page 834.

Available from: Test set folder
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Test Lab Module Menus and Buttons
This section describes themenus and buttons available in the Test Labmodule.

To access On the ALM sidebar, under Testing, select Test Lab.

Relevant tasks "How to Run Tests in ALM" on page 490

See also l "Test Execution Overview" on page 488
l "Test LabModuleWindow" on page 495
l "Test LabModule Icons" on page 511

User interface elements are described below:

UI Element (A - Z) Menu Description

Add Time Dependency

to Flow

Adds a time dependency icon to the diagram.

To create a time dependency for a test, link the arrow
from the icon to a test in the Execution Flow. The
default time dependency is the ALM server's current
date and time. For details, see "" on page 554.

Available from: Execution Flow

Add to Favorites Favorites Opens the Add Favorite dialog box, enabling you to add
a favorite view to your private or the public folder. For
details, see "Add Favorite Dialog Box" on page 94.

Alerts Tests (Test
Sets tab >
Execution
Grid)

Opens the Alerts dialog box, enabling you to display
alerts for the test instance. For details, see "Alerts
Dialog Box" on page 88.

Available from: Execution Grid

Arrange Layout
Tests Arranges the tests in the Execution Flow diagram in a

hierarchical layout, enabling you to view relationships
between different tests.

Available from: Execution Flow

Assign to Cycle
Test Sets Enables you to assign a test set folder to a cycle. For

more details, see "Select Cycles Dialog Box" on
page 141.

Attachments
<right-click
menu>

Opens the Attachments page inside the Test Instance
Details dialog box, enabling you to add an attachment
to a test instance. For details, see "Attachments Page"
on page 72.

Available from: Execution Grid
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UI Element (A - Z) Menu Description

Clear Alerts Tests Clears displayed alerts for themodule. For details, see
"How to Use Alerts" on page 86.

Available from: Execution Grid

Clear Assigned Cycle Test Sets Clears the assigned cycle from the test set folder.

Clear Follow Up Flag l Edit (In
the Test
Runs
module

l Tests
(Test Lab
module >
Execution
Grid)

Clears the follow up flag for a selected test instance or
test run. For details, see "Flag For Follow UpDialog
Box" on page 89.

Clear Pinned Baseline Test Sets Clears the baseline that is pinned to the test set.

Note: Clearing a pinned test set deletes all test
runs from the test set.

Collapse View Collapses the folders in the test sets tree below the
selected folder.

Available from: Test Sets tab

Continue Manual Run l Tests
(Test Lab
module >
Execution
Grid/Flow)

l Test Runs
(Test
Runs
module)

Continues running the selected tests with the same
runner that was used the first time the test was run. For
details, see "How to Run Tests Manually" on page 576.

Copy to Clipboard Tests Copies the Execution Flow diagram to the clipboard as
a bitmap.

Copy URL/Paste Edit Copies a selected test set or test run and pastes its
URL as a link. The test set or test run itself is not
copied. Instead, you can paste the address into another
location, such as an email or a document. Clicking on
the link opens ALM and takes you to the test set or test
run. If you are not already logged in, ALM first prompts
for login details.
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UI Element (A - Z) Menu Description

Copy/Paste Edit Copies selected test sets or test set folders and pastes
them to another test set folder in the same project or in
another project.

When you paste test sets to another project, the Paste
Test Set Folders To Target Project dialog box opens.
For details, see "Paste Test Set Folders To Target
Project Dialog Box" on page 549.

Note:

l When copying test sets or test set folders, test
run information is not copied.

l To copy test sets or test set folders across
projects, both projects must use the same ALM
version and patch level.

Cut/Paste Edit Moves a selected test set or test set folder to a different
location in the test sets tree.

Tip: You can alsomove a test set or test set folder
to a new location in the test sets tree by dragging
it.

<toolbar> Performance Center: If you analyze a test run,
recalculate the SLA, or add the test run to a trend
report, the action is added to a data processing queue,
enabling you to see when the action will be performed.

Available from: Test Runs module

Delete
Edit Deletes a selected test set, test set folder, or test run.

You cannot delete theRoot folder, theUnattached
folder, or the default test set.

When deleting a test set folder, opens the Confirm
Delete Folder dialog box, enabling you to select one of
the following delete options:

l Delete folders only. Deletes the folder andmoves
all test sets to theUnattached folder. The
Unattached folder contains all test sets that are no
longer associated with a folder.

l Delete folders and test sets. Permanently deletes
the folder and all its subfolders and test sets.
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UI Element (A - Z) Menu Description

Details
Opens the corresponding Details dialog box, enabling
you to view and update details of the selected test set,
test instance, or test run.

For details, see:

l "Test Set Details Dialog Box " on page 547
l "Test Instance Details Dialog Box" on page 530
l "Run Details Dialog Box" on page 681

Edit Test
Performance Center:Opens the Performance Test
Designer, enabling you to design the selected
performance test. For details, refer to theHP ALM
Performance Center Guide.

Enable Manual Test Run
Confirmation

Tests Instructs ALM to display theManual Test Run dialog
box each time you runmanual tests. For details, see
"Manual Test Run Dialog Box" on page 579.

Available from: Execution Grid, Execution Flow

Expand All View Expands all folders in the test sets tree below the
selected folder.

Export l Test Sets
(Test Lab
module)

l Edit (Test
Runs
module)

Exports the data in the Test Runs tab as a text file,
Microsoft Excel worksheet, Microsoft Word document,
HTML document, or text document.

Filter View Enables you to filter and sort the runs in the test runs
grid. For more details, "Filter Dialog Box" on page 51.

Available from: Test Runs module

Find l Tests
(Test Lab
module >
Execution
Grid)

l Edit (Test
Runs
module)

Opens the Find dialog box, enabling you to search for a
test run in the test runs grid, or a test instance in the
Execution Grid. For details, see "Find Dialog Box" on
page 63.
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UI Element (A - Z) Menu Description

Find Folder/Test Set Edit Opens the Find dialog box, enabling you to search for
test sets and test set folders. For details, see "Find
Dialog Box" on page 63.

Note: If you have applied filters to the test sets
tree, ALM restricts the search to the test sets
currently displayed.

Find Test in Flow
<right-click
menu>

Opens the Find Test Instance dialog box, enabling you
to search for a test in the Execution Flow diagram.

A successful search opens the Find Results dialog

box. Click theKeep on Top button to display the
Find Results dialog box on top of all open windows.

To display a selected window on top of the Find

Results dialog box, click theNot on Top button .

Available from: Execution Flow

Fit in Window
<toolbar> Resizes the Execution Flow diagram to fit the window.

Click the arrow to select amagnification option.
Options include:

l Magnification level: 25%, 50%, 150%, 200%.
l Normal. Displays the diagram at 100%
magnification.

l Fit in Window. Displays the entire diagram in the
window.

l Custom Zoom. Opens the Custom Zoom dialog
box. Type a zoom level and click Zoom.

Available from: Execution Flow

Flag for Follow Up
l Tests
(Test Lab
module >
Execution
Grid)

l Edit (Test
Runs
module)

Opens the Flag for Follow Up dialog box, enabling you
to add or modify a follow up flag for a selected test
instance or test run. For details, see "Flag For Follow
UpDialog Box" on page 89.
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UI Element (A - Z) Menu Description

Generate Test
Configuration

<right-click
menu>

After upgrading from a previous version of Quality
Center, this dialog box enables you to create a test
configuration from an existing test instance.

Caution: Only use this option for migrating tests.
Do not use this option for new tests or tests that
have already beenmigrated.

For user interface details, see "Generate Test
Configuration Dialog Box" on page 438.

Available from: Execution Grid

Global Search <toolbar> A global search engine enabling you to search across
all or a specific ALMmodule. It includes the following
modules: Defects, Requirements, Tests, Test Sets,
and Analysis. For more details on how to install and
enable Global Search, see
https://hpln.hp.com/contentoffering/alm-global-search.

Go to Configuration in
Test Plan

Tests Opens the Test Planmodule and highlights the
selected test configuration in the Test Configurations
tab.

Available from: Execution Grid, Execution Flow

Go to Test in Test Plan Tests Opens the Test Planmodule and highlights the
selected test.

Available from: Execution Grid, Execution Flow

Go to Test Set Test Sets Opens the Go to Test Set dialog box, enabling you to
type a Test Set ID to find a specific test set in the test
sets tree.

To locate the Test Set ID for a test set, select the test
set in the test sets tree and click theDetails tab.

Go to Timeslot
<right-click
menu>

Opens the Timeslots module, displaying the timeslot
for the selected test run.

Available from: Test Runs module

ALM Editions: Timeslots are only available for
HP ALM Edition. For more information about ALM
editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you
are using, ask your ALM site administrator.
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UI Element (A - Z) Menu Description

Graphs Analysis Lists the graphs you can generate for Test Lab data.
Select a predefined graph, or launch the graph wizard.

For details on the predefined graph types, see "Entity
Graph Types" on page 739.

Grid Filters View Displays a grid filter box under each column name,
enabling you to define a filter condition for a column.

Type directly into the box, or click the box to display the
browse button, which opens the Select Filter Condition
dialog box. For details, see "Select Filter Condition
Dialog Box" on page 61.

Host Manager for
Default Test Sets

Test Sets Opens the Host Manager dialog box, enabling you to
define hosts for remote test execution within a Default
test set. For details, see "Host Manager Dialog Box (for
Default test sets only)" on page 589.

Host Manager for
Functional Test Sets

Test Sets Opens the Testing Hosts module, enabling you to
manage and define hosts for server-side Functional test
set execution. For details, see "Testing Hosts
Overview" on page 322.

Import External Test
Results

Test Sets Opens the Import External Test Results dialog box,
enabling you to import a results file generate from an
external tool to ALM.
For details, see "Import External Test Results Dialog
Box" on page 600.

Indicator Columns Tests Displays the following columns on the left-side of the

Execution Grid and test runs grid: . For details,
see "Test LabModule Icons" on page 511.

Last Run Report Tests Opens the Last Run Report pane, displaying results of
the last test run for the selected test.

You can also click theShow arrow to display the Last
Run Report pane.

Performance Center Edition: Opens the Last Run
Results pane.

Available from: Execution Grid

Last Run Report <toolbar> ALM Edition: For functional test sets, opens the
Execution Report page for the selected test set,
displaying the last Execution Report belonging to this
test set. For more details about the Execution report
page, see "Execution Report Page - Desktop Client" on
page 567.
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UI Element (A - Z) Menu Description

Live Analysis Analysis Lists options for displaying graphs in the Live Analysis
tab. Add or delete a graph, or configure its appearance.
For details on live analysis, see "Analysis Overview"
on page 718.

Available from: Live Analysis Tab

Most Recently Used Analysis Lists themost recently viewed reports and graphs in
ALM. Displays up to ten items.

New Folder
Test Sets Opens the New Test Set Folder dialog box, enabling

you to add a folder under a selected folder.

Syntax exceptions:A test set folder name cannot
include the following characters: \ ˆ *

New Test Set
Test Sets Opens the New Test Set dialog box, enabling you to

add a test set to a selected folder. For details, see
"New Test Set Dialog Box" on page 543.

Order Test Instances Tests Opens the Order Test Instances dialog box, enabling
you to change the execution order of the tests in the
Execution Grid or Execution Flow. For more details,
see "Order Test Instances Dialog Box" on page 591.

Available from: Execution Grid, Execution Flow

Organize Favorites Favorites Opens the Organize Favorites dialog box, enabling you
to organize the list of favorite views by changing
properties or deleting views. For details, see "Organize
Favorites Dialog Box" on page 95.

Available from: Test Sets tab

Performance Trending <toolbar> Performance Center:Opens My Performance Center,
displaying the Trend Reports feature. For details, refer
to theHP ALM Performance Center Guide.

Available from: Test Runs Module

Pin to Baseline Test Sets Opens the Select Baseline dialog box, enabling you to
pin the test set to a baseline. For more details, see
"Select a Baseline Page" on page 208.

Private Favorites Lists the favorite views that are accessible only to the
user who created them.
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UI Element (A - Z) Menu Description

Project Reports Analysis Lists the predefined project reports that you can
produce on test lab data. For details on the report types,
see "Predefined Project Reports" on page 779.

Selecting a report from the list generates a preview of
the report. The preview displays up to five entities per
report section. To generate the full report, in the upper
left corner of the preview, click the downward arrow
adjacent to theGenerate button and select the report
format to generate.

Public Favorites Lists the favorite views that are accessible to all users.

Purge Runs l Tests
Sets (Test
Lab
module >
Execution
Grid)

l Test Runs
(Test
Runs
module)

Opens the Purge Runs wizard, enabling you to delete
old test run results in your project. For details, see
"Purge Runs Wizard" on page 686.

Refresh Flow
Tests Refreshes the view to display themost up-to-date

information.

Available from: Execution Flow

Refresh/Refresh All
View Refreshes the view to display themost up-to-date

information.

Remove all Execution
Conditions

Tests Enables you to delete all execution conditions and time
dependencies in a selected test set.

If your test set includes both execution conditions and
time dependencies, opens the Remove All Execution
Conditions dialog box.

If your test set includes only execution conditions or
time dependencies, a confirm dialog box opens.

Available from: Execution Flow

Remove Execution
Condition

<right-click
menu>

Enables you to delete an execution condition for a
selected condition arrow.

Available from: Execution Flow

Remove Test Instances

from Test Set

Tests Removes the selected test instances from the test set.

Available from: Execution Grid, Execution Flow
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UI Element (A - Z) Menu Description

Remove Test's
Execution Conditions

<right-click
menu>

Enables you to delete all execution conditions for a
selected test instance.

Available from: Execution Flow

Remove Time
Dependency

<right-click
menu> Right-click a Time Dependency icon connected

to a test and chooseRemove Time Dependency to
remove the specified time dependency.

Available from: Execution Flow

Rename Edit Enables you to rename a test set or a test set folder.
You cannot rename theRoot folder, theUnattached
folder, or the default test set.

Replace l Tests
(Test Lab
module >
Execution
Grid)

l Edit (Test
Runs
module)

Opens the Replace dialog box, enabling you to replace
a field value in the grid. For details, see "Replace
Dialog Box" on page 65.

Reset Test Set Test Sets Opens the Confirm Reset Test Set dialog box, enabling
you to change the status of all the tests in the test set
toNo Run.

You can also instruct ALM to delete all the test run
results in the test set.
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UI Element (A - Z) Menu Description

Run
Tests If you select a manual test: Opens one of the

following to run the test:

l If Sprinter is installed on your local machine, Sprinter
opens. For details, see "HP Sprinter Overview" on
page 575.

ALM Editions:Sprinter functionality is not
available with Performance Center Edition. For
more information about ALM editions and their
functionality, see "ALM Editions" on page 115.
To find out what edition of ALM you are using,
ask your ALM site administrator.

l If Sprinter is not installed, theManual Runner dialog
box opens. For details, see "Manual RunnerWizard"
on page 580.

If you select two or more manual tests:Opens the
Manual Test Run dialog box. For details, see "Manual
Test Run Dialog Box" on page 579.

If you select automated tests:Opens the Automatic
Runner dialog box. For details, see "Automatic Runner
Dialog Box" on page 588.

Available from: Execution Grid, Execution Flow

Run
Test Sets Opens the Run <Entity> Dialog box, enabling you to

run the selected functional test instance. For details,
see "" on page 563.

Available from: Execution Grid

Run Screen
<right-click
menu>

Performance Center:Opens the Performance Test
Run screen, enabling you to view andmanage the test
run. For more information, refer to theHP ALM
Performance Center Guide.

Note:Only enabled when test run is in theRunning
state.

Available from: Test Runs module
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UI Element (A - Z) Menu Description

Run Test Set Test Sets For Default test sets:

l If the test set includes one or more automated tests,
opens the Automatic Runner dialog box to run the
currently selected test set. For details, see
"Automatic Runner Dialog Box" on page 588.

l If the test set includes manual tests only, opens the
Manual Test Run dialog box. For details, see
"Manual Test Run Dialog Box" on page 579.

For Functional test sets: Opens the Run
<Entity> Dialog box, enabling you to run the selected
functional test set. For details, see "" on page 563.

Run Test
<right-click
menu>

Performance Center:Enables you to run a selected
performance test. For more details on running
performance tests, refer to theHP ALM Performance
Center Guide.

Run with Sprinter Tests Opens Sprinter to run the selected tests. For details,
see "HP Sprinter Overview" on page 575.

ALM Editions:Sprinter functionality is not available
with Performance Center Edition. For more
information about ALM editions and their
functionality, see "ALM Editions" on page 115. To
find out what edition of ALM you are using, ask
your ALM site administrator.

Available from: Execution Grid

Run with Manual
Runner

Tests Runs amanual or automated test manually from the
Manual Runner dialog box. For details, see "Manual
RunnerWizard" on page 580.

Available from: Execution Grid, Execution Flow

Select Columns
l Tests
(Test Lab
module >
Execution
Grid)

l View
(Test
Runs
module)

Opens the Select Columns dialog box, enabling you to
determine which columns to display and set the order in
which the columns are displayed. For more details, see
"Select Columns/Select Fields Dialog Box" on page 77.
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UI Element (A - Z) Menu Description

Select Tests Test Sets Enables you to select tests to add to the currently
selected test set. Displays the following:

l Test Plan Tree tab. Add tests from the test plan tree
to a test set.

l Requirements Tree tab. Add tests covering
requirements from the requirements tree to a test
set.

For more details, see "Select Tests Pane" on page 544.

Available from: Execution Grid, Execution Flow

Send by Email
Test Runs Opens the Send E-mail dialog box, enabling you to

send a test run by email to recipients selected from a
list, or to the tester. For more details, see "Send E-mail
Dialog Box" on page 69.

Set Filter/Sort
l View
l Tests
(Executio
n Grid)

Enables you to set filter and sort options for the test
sets tree or Execution Grid.

Includes the following options:

l Set Filter/Sort. Opens the Filter dialog box, enabling
you to filter and sort tests.

l Clear Filter/Sort. Clears any filters or sorting that
you have applied.

For more details, see "Filter Dialog Box" on page 51.

Show Full Test Names Tests Displays full test names in the Execution Flow
diagram. By default, long names are truncated.

Available from: Execution Flow

Stop Run
<toolbar> Stops execution of the selected run.

Note: Only enabled when the selected run is in the
Initializing, Running, orStopping states.
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UI Element (A - Z) Menu Description

Switch to
Functional/Default Test

Set

<right-click
menu>

Switch to Functional/Default Test Set. Changes the
mode of execution of the selected test set. Toggles the
test set between Default and Functional.

l When switching a test set from Default to
Functional, each test instance in the test set is
converted.
l If a test instance had no value for the Planned
Host Name field, or the value does not match any
of the hosts in the Testing Hostsmodule, then
the Testing Host field is set to Automatch and the
purpose is set according to the test instance
type.

l If the value in the Planned Host name field
matches one of the hosts in the Testing Hosts
module, and that testing host has a purpose
whichmatches the test instance type, then that
testing host is allocated to the test instance.

l When switching a test set from Functional to
Default, ALM will remove the test set from any build
verification suite in which it appears. If the test had
started out as part of a Default test set, then the
Planned Host Name field is restored to its original
value.

Note:

l Some test instance types cannot be converted.
If you are changing from Default to Functional
and your test set includes tests which are not
supported, the conversion process is blocked
and you receive a warningmessage. Supported
test instances include business process, flow,
Quick Test Professional, Service Test, System
Test, and VAPI-XP.

l This button is disabled for users who do not
have permission to change the type of a test
set.

l You can select and change the type of multiple
test sets at once, but only if you select test sets
of a single type (either Functional or Default). If
you select multiple test sets of different test set
types you will be unable to switch the test set
type of the entire selection.
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UI Element (A - Z) Menu Description

Test Instance Details Tests Opens the Test Instance Details dialog box, enabling
you to view and update details of the selected test
instance. For details, see "Test Instance Details Dialog
Box" on page 530.

Available from: Execution Grid

Test Set Details
Test Sets Opens the Test Set Details dialog box, enabling you to

view and update details of the selected test set. For
details, see "Test Set Details Dialog Box " on
page 547.

Text Search Edit Opens the text search pane in the lower part of the Test
Labmodule window, enabling you to search for records
in predefined fields. For details, see "Text Search
Pane" on page 66.

Available from: Test Runs module

Update Selected <right-click
menu>

Opens the Update Selected dialog box, enabling you to
update a field value for multiple selected tests in the
grid. For more details, see "Update Selected Dialog
Box" on page 79.

Available from: Execution Grid tab

View Tests Lists options for selecting tests in the Execution Grid.
Options include:

l Select All
l Deselect All
l Invert Selection
Available from: Execution Grid tab

Zoom
Tests Changes themagnification level of the Execution Flow.

Options include:

Zoom In. Increases themagnification level so that you
can view a section of the Execution Flow more closely.

Zoom Out. Decreases themagnification level so that
you can view more of the Execution Flow.

Available from: Execution Flow

Test Lab Module Icons
This section describes the icons displayed in the Test Labmodule.

To access On the ALM sidebar, under Testing, select Test Lab.
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See also l "Test LabModuleMenus and Buttons" on
page 497

l "Test LabModuleWindow" on page 495

User interface elements are described below:

UI
Element

Description

<green asterisk>. The applicable tab is populated.

Alerts. Click to view alerts for the test instance or test run.

l Red alert. The alert is new.
l Gray alert. The alert has already been read.
For more details, see "Alerts Dialog Box" on page 88.

Assigned Test Set Folder. A test set folder that is assigned to a cycle.

Attachments. Click to view attachments for the specified test instance or test run.

Open an attachment by selecting it from the list. If there aremore than ten attachments,
click themore attachments link to view the list in theAttachments Page. For details,
see "Attachments Page" on page 72.

Follow Up Flags. Click to view follow up flags for the test instance or test run.

l Gray flag. The follow up flag is new.
l Red flag. The follow up date has arrived.
For more details, see "Flag For Follow UpDialog Box" on page 89.

Linked Defects. Click to view linked defects for the test instance or test run. For user
interface details, see "Linked Defects/Entities Page" on page 710.

Pinned Test Set. A test set that is pinned to a baseline. For concept details, see "Pinned
Test Sets" on page 179.

Test Set Folder. A folder for organizing test sets.

Functional Test Set. A functional test set in the test sets tree.

Performance Test Set. A performance test set in the test sets tree.

Default Test Set. A default test set in the test sets tree.

Time Dependency. Click tomodify the time dependency conditions of a test instance.
For more details, see "TimeDependency Page" on page 556.
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Test Lab Module Fields
This section describes the Test Labmodule fields.

To access On the ALM sidebar, under Testing, select Test Lab.

Important
information

l The Test Labmodule displays test planning, test configuration, and test execution
fields.
l Names of test planning fields displayed in the Test Labmodule have the prefix
Test: added. For more details on test planning fields, see "Test PlanModule
Fields" on page 366.

l Names of test configuration fields displayed in the Test Labmodule have the
prefix Configuration: added. For more details on test configuration fields, see
"Test Configurations Tab" on page 429.

l You can add user-defined fields and change the label of any of the Test Labmodule
fields. You can also customize project lists. For more details, see to theHP
Application Lifecycle Management Administrator Guide.

l You can use the Script Editor to restrict and dynamically change the Test Lab
module fields and values. For details, refer to theHP Application Lifecycle
Management Administrator Guide.

l When you select a columnwith a user name value, ALM displays a list with the
name and full name of each user. You can search for users, sort users, group
users by user group, and select users from the users list or a group tree. For more
information, see "Users List Dialog Box" on page 62.

l When the word "test" is used below, it might refer to a single test run, a test set
run, or a build verification suite run.

See also "Test LabModuleWindow" on page 495

The fields are described below:

UI Element (A - Z) Description

All Tests Passed Indicates whether the run completed successfully.

Y only if all test instance runs have a status of Passed.

Assigned to cycle The cycle to which the selected test set folder is assigned.

Average Vusers The average number of concurrently running Vusers during the test run.

Note: Available for Performance Center.

Baseline The baseline to which the test set is pinned.

Build verification
suite name

The name of the build verification suite.
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UI Element (A - Z) Description

Close Date The planned closing date for the test set.

Configuration: Name The name of the test configuration allocated to the selected test run.

Consume VUDs The number of VUDs used in the test run.

Note: Available for Performance Center.

Controller The Controller involved in the test run.

Note: Available for Performance Center.

Cycle end date The date on which the cycle to which the selected test set folder is
assigned ends.

Cycle start date The date on which the cycle to which the selected test set folder is
assigned starts.

Domain/Project The test instance's domain and project.

Draft Run Indicates whether the selected test run is a draft run. For more details, see
"Draft Runs" on page 489.

Default value:N

Duration The test run time, in seconds.

Note: You should not manually edit this field.

End Date The end date of the run.

Note: You should not manually edit this field.

End Time The end time of the run.

Environment The default environment on which the tests in the test set should run.
Environments are a combination of operating systems, browsers, and so
on, on which you test the application.

Note: Environments are defined using the ALM WebClient. After they
are defined, you can select them when editing a test set.

Exec Date The date on which the test was last executed.

Exec Time The time the test was last executed.

Host The name of themachine on which a test run was executed.
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UI Element (A - Z) Description

Involved Vusers The number of Vusers that were initialized at least once during the run.

Note: Available for Performance Center.

Iterations Business Process Testing:A description of the iterations defined for the
business process test or flow instance.

For business process tests:

l Configuration Based. The iterations are as defined in the
corresponding test configuration.

l Modified. A link indicating that the iterations have beenmanually edited
and no longer correspond to the test configuration. Click the link to
modify the iterations.

For flows:

l Undefined. A link indicating that no iterations are currently defined.
Click the link to specify iterations.

l <iterations>. A link indicating the total number of iterations defined for
the flow instance, and if specified, the range of iterations selected for the
run. Click the link tomodify the iterations.

Examples

2 Iterations

4 Iterations (2-3 Selected)

For user interface details onmodifying iterations, see theHP Business
Process Testing User Guide.

Load Generators The load generators involved in the test run.

Note: Available for Performance Center.

Max Vusers Themaximum number of concurrently running Vusers during the run.

Note: Available for Performance Center.

Modified The date and time of the last change to the test in the Execution Grid.

Open Date The planned opening date for the test set.

Default: The current database server date when the test set is created.

Operating System The operating system running on the host machine on which a test was
executed.

Default value: The operating system on your ALM client machine.
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UI Element (A - Z) Description

OS Build Number The build number of the operating system running on the host machine on
which a test was executed.

Default value: The operating system build number on your ALM client
machine.

OS Service Pack The operating system service pack installed on the host machine on which
a test was executed.

Default value: The operating system service pack on your ALM client
machine.

Planned Exec Date The date on which it was planned to execute the test.

Planned Exec Time The time at which it was planned to execute the test.

Planned Host Name The name or IP address of themachine to run the Default test.

Project ID The test's project ID.

Purpose The purposes available from the selected testing host or the purposes
required for a functional test. A single testing host can have either
Functional or Performance purposes.

The following Functional purposes are available:

l Automated Business Process Testing. A host on which Business
Process Testing is run.

l Unified Functional Testing (UFT). A host on which UFT is run.
l QA Inspect. A host on which QA Inspect is run.
l QTP. A host on which QuickTest Professional is run.
l Service Test Runtime. A host on which Service Test Runtime is run.
l Sprinter. A host on which Sprinter is run.
l System Test. A host on which a system test is run.
l VAPI XP. A host on which VAPI XP is run.
The following performance purposes are available:

l Controller. A host used tomanage a performance test. During a test
run, the Controller issues instructions to the load generators including
which scripts to run, how many Vusers to run per script, and when to
start and stop running them. There is only one Controller per test.

l Load generator. A host on which Vusers run during a test. There can be
any number of load generators for a given test.

l Data processor. A host used for processing and publishing data
gathered during a test run.

Remaining days in
cycle

The total number of days remaining in the cycle to which the selected test
set folder is assigned.
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UI Element (A - Z) Description

Remaining test
instances to run

The total number of test instances in the selected test set folder that have
not yet run.

Responsible Tester The user name of the person responsible for running the test.

When you run amanual test automatically from the Automatic Runner
dialog box, ALM notifies this user by email to run the test.

Run Details Lists details about the test instance, test set, or build verification suite run.

Run ID A unique numeric ID for the run, assigned automatically by ALM. This
number is automatically generated by the system when the run starts
executing.

You can click on the Run ID field in theExecution Report grid to navigate
to the test instance run in the Test Runsmodule.

Run Name The name of the test run. Fast_run indicates that ALM created this run
when a user changed theStatus field of the test instancemanually without
running the test.

The icon displayed indicates one of the following:

l The test type. For details, see "Test Types" on page 351.

l A manual test run with Sprinter . For details on Sprinter, see "HP
Sprinter Overview" on page 575.

Run Status In the Execution Report Page grid, indicates the status of a functional or
performance test run or test set run.

For a test set, indicates the status of the test set. Options include: Open,
Closed.

For a test instance or run, indicates the execution status of the run. Options
include: Blocked, Failed, N/A, No Run, Not Completed, Passed,
<User-defined>.

Note: Available for ALM Edition.

Start date The start date of the run.

Note: You should not manually edit this field.

Start time The start time of the run.

Note: You should not manually edit this field.
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UI Element (A - Z) Description

State Indicates progress of a load test run. The value of this field can be one of
the following:

l Initializing. The load test is starting.
l Running. The load test is running.
l Stopping. The load test is in the process of stopping.
l Run Failure. The load test has failed and has stopped.
l Finished. The load test completed successfully.
This is a read-only field.

Status (for a run
step)

Indicates execution status of a run step. Execution status can be one of the
following:

l Blocked. The step cannot run. For example, the test is running on a
remotemachine but cannot continue due to some environmental failure,
such as network problems or hardware failure.

l Failed. The step failed.
l N/A. The current status of the step is not applicable.
l No Run. The step has not been run.
l Not Completed. The step was not completed.
l Passed. The step was successful.
Business Process Testing:

l Ignored. The business component or flow was ignored because it did
not meet its defined run conditions.
The status of any steps related to this business component or flow is
automatically set toNo Run and the steps are skipped when you click
Next.

Note: This status cannot be chosen; it is set by Business Process
Testing during themanual run.

Also, this status is only available when runningmanually.
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UI Element (A - Z) Description

Status (for a test
instance, test set, or
build verification
suite run)

Indicates execution status of a test instance, test set, or build verification
suite run. Execution status can be one of the following:

l Blocked. One or more steps cannot run. For example, the test is running
on a remotemachine but cannot continue due to some environmental
failure, such as network problems or hardware failure.

l Failed. One or more steps in the run failed, and none have the status
Blocked.

l N/A. The current status is not applicable. No steps exist, or a step has
an execution status of N/A.

l No Run. No steps have been run.
l Not Completed. One or more steps were not completed or not run, and
none have the status Blocked or Failed.

l Passed. The run was successful. All the steps have an execution status
of Passed.

Target Cycle The cycle to which the test is assigned.

Temp Results
Directory Path

The path of the directory where the test results are temporarily stored.

Test The name of the test in the Test Planmodule associated with the selected
test run.

Test Set The name of the test set.

Test Set End Time The end time of the test set run.

Test Set ID A unique numeric ID for the test set, assigned automatically by ALM.

Test Set Start date The start date of the test set run.

Note: You should not manually edit this field.

Test Set Start time The start time of the test set run.

Note: You should not manually edit this field.

Test Set State The state of the test set. If a test set is stuck in a particular state, you can
change it.

Test Set: Name The name of the test set associated with the selected test run.

Test: Test Name The name of the test associated with the selected test run.

Tester The username of the person who last executed the test.

User Guide
Chapter 31: Introducing Test Execution

HP ALM (12.50) Page 519



UI Element (A - Z) Description

Testing Host The testing host assigned to the selected Functional test set test instance.
The testing host is taken from the project's host pool.

In theExecution Grid tab, you can specify a host for a particular test
instance by clicking the Testing Host field and using theSelect Testing
Host dialog box. For details, see "Select Testing Host Dialog Box" on
page 529.

In theRequested Hosts tab, you can specify a host by clicking theAdd
Automatch Host orAdd Specific Host buttons. For details, see
"Requested Hosts Tab" on page 538.

Time The time at which the test was last executed.

Timeslot ID The ID of the test run timeslot.

Topology ID The ID of the test run topology.

Topology Name The name of the test run topology.

Total test instances The total number of test instances in the selected test set folder.

Type The test type of the test. For more details, see "Test Types" on page 351.
This is a read-only field.
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Chapter 32: Test Set Specification
This chapter includes:

• Test Set Specification Overview 522
• How to Create Test Sets 524
• Test Sets User Interface 527
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Test Set Specification Overview
After you design tests in the Test Planmodule, you organize test execution by creating test sets in the
Test Labmodule. A test set contains a subset of the tests in your project designed to achieve specific
test goals.

ALM supports different types of test sets. The following table describes each test set type:

Test Set
Type Description

Performance For running unattended remote performance tests. You can add only performance
tests to this test set.

You arrange for a performance test to be executed from the server by scheduling a
timeslot. A timeslot contains a test set, the details of the remote hosts on which the
test set will run, and a time and duration for running the test set. For more details
about how to run a Performance test, see "How to Run Tests in ALM" on page 490.

For more details on timeslots, see "Reserving Timeslots Overview" on page 622.

ALM Editions: Performance test execution is available only for ALM Edition and
Performance Center Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

Default For running client-side, locally controlled and launched functional tests. You can add
bothmanual and automated functional tests to this test set.

You can arrange for default tests to be run in an ad hoc manner. For more details on
how to run default test sets, see "How to Run Tests in ALM" on page 490.
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Test Set
Type Description

Functional For running server-side, unattended functional tests.You can add only automated
functional tests to this test set.

You arrange for a functional test set to be executed from the server by scheduling a
timeslot. A timeslot contains a test set, the details of the testing hosts on which the
test set runs, and a time and duration for running the test set. For more details about
how to run a Functional test set, see "How to Run Tests in ALM" on page 490

Build verification suites are a key component in ALM's Continuous Delivery
solution. They facilitate an automated, end-to-end deployment and testing
framework that makes application development more efficient, reliable, and quick.
For more information about how build verification suites can be used as part of this
process, see "Deploying and Testing your Application in ALM" on page 492.

For more details on timeslots, see "Reserving Timeslots Overview" on page 622.

ALM Editions: Functional test sets available only for ALM Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on
page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

External Contains external type tests (EXTERNAL-TEST ). External type test sets are
read-only. You cannot create, modify, or run test sets directly from ALM. For more
details on external testing, see "Integrating External Tests Overview" on page 594.

When defining a test set, ALM adds instances of your selected tests to the test set. Each test instance
contains a defined test configuration. A test configuration enables you to run the same test under
different scenarios. For more details on test configurations, see "Test Configuration Overview" on
page 418.

A test sets tree enables you to organize your applicationmanagement process by grouping test sets in
folders and organizing them in different hierarchical levels.

To decide which test sets to create, consider the goals you defined at the beginning of the application
management process. Consider issues such as the current state of the application, and the addition or
modification of new features.
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Examples

Following are examples of general categories of test sets you can create:

Test Set Description

Sanity Checks the entire application at a basic level—focusing on breadth, rather than
depth—to verify that the application is functional and stable. This set includes
fundamental tests that contain positive checks, validating that the application is
functioning properly. For example, in theMercury Tours application, you could
test whether the application opens, and enables you to log in.

Regression Tests the system in amore in-depthmanner than a sanity set. This set can
include both positive and negative checks. Negative tests attempt to fail an
application to demonstrate that the application is not functioning properly.

Advanced Tests both breadth and depth. This set covers the entire application, and also
tests the application's advanced options. You can run this set when there is
ample time for testing.

Function Tests a subsystem of an application. This could be a single feature or a group of
features. For example, in theMercury Tours application, a function set could test
all activities related to booking a flight.

After you have created test sets, you assign test set folders to cycles defined in the releases tree in the
Releases module. A cycle represents a development andQA cycle based on the project timeline.

You assign remote hosts to functional or performance test instances in a test set. For details, see
"Testing Hosts Overview" on page 322.

For details on working with test sets, see "How to Create Test Sets" below.

How to Create Test Sets
This task describes how to create and define test sets in the Test Labmodule.

To learnmore about test sets, see "Test Set Specification Overview" on page 522.

Note: Higher-level task: This task is part of a higher-level task. For details, see "How to Run
Tests in ALM" on page 490.

This task includes the following steps:

l "Define test sets" on the next page
l "Assign test set folders to cycles" on the next page
l "Add tests to test sets" on page 526
l "Configure execution settings for a test instance" on page 526
l "Specify host criteria for a test instance in a Functional test set" on page 526
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l "Manage host requests for a Functional test set" on the next page
l "Set notification rules" on page 527
l "Set On Failure rules" on page 527
l "Request test result summary report" on page 527
l "Pin a test set to a baseline - optional" on page 527

1. Define test sets
Define a hierarchical framework for your test sets by creating a test sets tree that contains folders
and subfolders.
a. Open the Test Lab module. On the ALM sidebar, under Testing, select Test Lab.
b. Create folders. Right-click theRoot folder and select New Folder. To create a sub-folder,

right-click a folder and select New Folder.
c. Add test sets to folders. Right-click a folder and select New Test Set. For user interface

details, see "New Test Set Dialog Box" on page 543.
To learnmore about the different types of test sets, see "Test Set Specification Overview" on
page 522.

Example

Suppose you want to test new features added to Release 10.5 of theMercury Tours
application. Release 10.5 consists of four cycles, and you want to test the new features
for the release in Cycle 1, Cycle 2, and Cycle 4. Because the tests you need to run to test
the new features are the same for each of these cycles, you want to use the same test set
as a basis for testing new features in each of the cycles.
In the test sets tree, you can create the folder, Release 10.5, for the release. Under this
folder, you create the folder, Cycle 1, for the first cycle of the release. In theCycle 1
folder, you create a test set, New Features, containing the tests necessary to test new
features for the release. After you create this test set and add its tests, you can copy and
paste theCycle 1 folder and use it as a basis for the other cycles that test new features.

2. Assign test set folders to cycles
Assign test set folders to cycles defined in the releases tree in the Releases module.
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Right-click a test set folder and select Assign to Cycle. For user interface details on the Select
Cycles dialog box, see "Select Cycles Dialog Box" on page 141.

3. Add tests to test sets
In the Test Lab > Test Sets tab, select a test set and click theExecution Grid tab or the
Execution Flow tab. Then click theSelect Tests button. Add tests from the following tabs in the
Select Tests pane:
l Test Plan Tree. Add tests from the test plan tree to the test set.
l Requirements Tree. Add tests covering requirements from the requirements tree to the test
set.

For user interface details on the Select Tests pane, see "Select Tests Pane" on page 544.

4. Configure execution settings for a test instance

Note: This option is not available for Performance test sets.

You can view or set the test parameter values for amanual or automated test instance. You can
choose a remote host on which to run themanual or automatic test instance. You can also view
and edit the On Failure rules for an automated test instance.
a. In the Execution Grid or the Execution Flow, right-click a test and select Test Instance

Details.
b. In the Test Instance Details dialog box, click Execution Settings on the sidebar. For user

interface details on the Execution Settings view, see "Test Instance Details - Execution
Settings View" on page 535.

5. Specify host criteria for a test instance in a Functional test set

Note: This option is not available for Default test sets.

You allocate a testing host for a test by specifying criteria in a host reservation. You can reserve a
particular host from the project host pool. Alternatively, you can provide ALM with criteria from
which to dynamically select hosts from the host pool allocated to your project. Host criteria include
host purpose, location, and attributes.
a. Select a test instance.
b. In the Test Instance Details dialog box, choose a set of criteria from the options listed in the

Testing Host field.
For user interface details, see "Test Set Specification Overview" on page 522.
For details about testing hosts in ALM, andmanaging testing hosts in LabManagement, refer to
theHP ALM LabManagement Guide.

6. Manage host requests for a Functional test set

Note: This option is not available for Default test sets.

To alter the types of hosts you requested for an entire test set, use theRequested Hosts tab. You
canmodify, add, or delete host requests for the entire test set.
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Select a test set, and click theRequested Hosts tab. For user interface details, see "Requested
Hosts Tab" on page 538.

7. Set notification rules
Set notification rules to instruct ALM to send email to a specified user if selected events occur for
a test set.
You set notification rules in theAutomation tab, Notification area. For user interface details, see
"Automation Tab" on page 541.

8. Set On Failure rules
Set On Failure rules to define what action ALM takes in the event that an automated test in the test
set fails.
You set notification rules in theAutomation tab, in theOn Automated Test Failure area. For
user interface details, see "Automation Tab" on page 541.

9. Request test result summary report
You can request that a summary of test results is sent in an email to specified users when test set
execution completes.
Enter details in theAutomation tab, in theExecution Summary area. For user interface details,
see "Automation Tab" on page 541.

10. Pin a test set to a baseline - optional
You can pin a test set to a baseline to associate the test set with the versions of the tests stored in
a baseline you select.
l In the Test Labmodule, right-click a test set and select Pin to Baseline. For user interface
details on the Select Baseline dialog box, see "Select Baselines Dialog Box" on page 199.

l To clear a pinned baseline, right-click a test set and select Clear Pinned Baseline.
For concept details on pinned test sets, see "Pinned Test Sets" on page 179.

Test Sets User Interface
This section includes:

• Execution Grid Tab 528
• Select Testing Host Dialog Box 529
• Test Instance Details Dialog Box 530
• Test Instance Details - Runs View 532
• Test Instance Details - Execution Settings View 535
• Requested Hosts Tab 538
• Automation Tab 541
• New Test Set Dialog Box 543
• Select Tests Pane 544
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• Test Set Details Dialog Box 547
• On Test Failure Dialog Box 548
• Paste Test Set Folders To Target Project Dialog Box 549

Execution Grid Tab
This tab displays test instance data in a grid. Each line in the grid displays a separate record. You can
run and view tests in the Execution Grid.

To access In the Test Lab > Test Sets tab, select a test set and click theExecution Grid
tab.

Relevant
tasks

l "How to Create Test Sets" on page 524
l "How to Run Tests in ALM" on page 490

See also l "Test Set Specification Overview" on page 522
l "Test Execution Overview" on page 488
l "Test LabModuleWindow" on page 495

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Test Lab
module
common
UI
elements>

l Test Lab fields. For field definitions, see "Test LabModule Fields" on page 513.
l Test Lab menus and buttons. For command and button descriptions, see "Test
LabModuleMenus and Buttons" on page 497.

l Test Lab icons. For icon descriptions, see "Test LabModule Icons" on page 511.
l ALM masthead, menus, and sidebar. For details, see "ALM Common Areas" on
page 32.

<Indicator
columns>

Indicates that the specified test instance has attachments, linked defects, alerts, and
follow up flags. For more details, see "Test LabModule Icons" on page 511.

To display these columns, select Tests > Indicator Columns.

<Filter
status bar>

Describes the filter currently applied to the grid. Located directly above the grid.

<Select
Tests
pane>

Displays the Test Plan Tree tab and the Requirements Tree tab, enabling you to
select tests to add to the selected test set. For details, see "Select Tests Pane" on
page 544.
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UI Element Description

Criterion
Results

Displays the statuses of the criteria for the last run of the selected business process
test instance using a certain configuration.

To display this tab, select Tests > Last Run Result or click theShow arrow.

Note: Functionality related to test criteria is available only for business process
tests. For details, see theHP Business Process Testing User Guide.

Last Run
Report
pane

Displays the results of the last test run for the selected test instance. To display this
pane, select Tests > Last Run Report or click theShow arrow.

For a test run with Sprinter, also displays the Launch Sprinter Results Viewer
button, which opens and displays the report in the Sprinter Results Viewer. For
details, click the help button within the viewer.

ALM Editions:Sprinter functionality is not available with Performance Center
Edition. For more information about ALM editions and their functionality, see
"ALM Editions" on page 115. To find out what edition of ALM you are using, ask
your ALM site administrator.

For automated test instances, also includes one of the following:

l

Opens and displays results in LoadRunner Analysis. Available for the LR–
SCENARIO test type.

l

Opens and displays the report in Unified Functional Testing. Available for the
QUICKTEST_TEST test type.
The Launch Report button is enabled only if you have installed the Unified
Functional Testing Add-in from the HP Application Lifecycle Management Add-ins
page. For more details on installing add-ins, refer to theHP Application Lifecycle
Management Installation and UpgradeGuide.

l Collected System Info link. Opens the System Information dialog box. Displays
the collected system information, such as CPU, memory, and processes running
on themachine when the test is run. Available for the SYSTEM-TEST test type.

l Captured Desktop Image. Opens the captured image of themachine executing
the system test. Available for the SYSTEM-TEST test type.

Select Testing Host Dialog Box
This dialog box enables you to select a testing host to run a test in a Functional test set.

To
access

In the Test Labmodule > Test Sets tab, click the Execution Grid. Select a test set from
the grid. From within the grid, or from within the Test Instance Details dialog box, click
the adjacent down arrow of the Testing Host field.
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Relevant
tasks

"How to Run Tests in ALM" on page 490

See also "Test LabModule Fields" on page 513

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

Select
Host
Properties

Enables you to select a set of properties to determine the testing host requested for
this test instance. ALM provides the following property categories:

l Purpose. Testing hosts can have one or multiple purposes, based on the testing
tools installed on the host. For more information about available testing host
purposes, see theHP ALM LabManagement Guide.

l Attributes. Testing hosts can be defined with attributes relating to the host's
hardware or software specifications. Custom attributes can also be added from
within LabManagement. For details, see theHP ALM LabManagement Guide.

l Location. Testing hosts are created with a location property.

Host
match

Lists the number of available testing hosts that match the selected host properties.

<Host
Selection>

Enables you to select a testing host based on your criteria. ALM provides the following
ways to select a testing host:

l Automatch host. ALM will automatically allocate and reserve a host based on the
criteria provided in thePurpose, Location, andAttributes fields. For details, see
"Host Allocation" on page 627.

l Use host. You can reserve a specific host from the list of hosts that ALM found
based on the criteria provided in thePurpose, Location, andAttributes fields.

Test Instance Details Dialog Box
This dialog box enables you to view run details and results for a test instance. You can also view and
set test run configuration information.

To access In the Execution Grid or the Execution Flow, right-click a test and select Test
Instance Details.

Important
information

l If you edit the test information, the changes youmake are reflected in the
Execution Grid.

l You can change the label of any of the fields in the Details tab. You can also add
user-defined fields to the Details tab. For more information, refer to theHP
Application Lifecycle Management Administrator Guide.

Relevant
tasks

"How to View Test Runs" on page 668
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See also l "Test LabModule Fields" on page 513
l "Test Runs Overview" on page 668
l "System Tests Overview" on page 444

User interface elements are described below:

UI Element Description

Save. Saves the details.

First/Previous Next/Last Entity. Allows you to browse through the test
instances in the Execution Grid.

Available from: This element is only available when you open the Test
Instance Details dialog box from the Execution Grid.

Alerts. Opens the Alerts dialog box, enabling you to display alerts for the test
instance. For details, see "Alerts Dialog Box" on page 88.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Flag for Follow Up. Opens the Flag For Follow Up dialog box, enabling you
to define a follow up flag for the test instance. For more details, see "Flag For
Follow UpDialog Box" on page 89.

Details Displays run details of a test instance. For details on the available fields, see
"Test LabModule Fields" on page 513.

Runs Displays the results of all runs for the test instance. For details, see "Test
Instance Details - Runs View" on the next page.

Select a run and click theRun Details button to view detailed results for
the run.

Execution
Settings

Displays run configuration information for the test instance. For details, see
"Test Instance Details - Execution Settings View" on page 535.

Attachments Lists attachments that provide additional information about the currently
selected test instance. For more details, see "Attachments Page" on page 72.
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UI Element Description

Linked Defects Lists the defects linked to the currently selected test instance. You can view,
add, and remove defect links. For more details, see "Linked Defects/Entities
Page" on page 710.

History Lists changes made to the currently selected test instance. For more details,
see "History Tab" on page 68.

Test Instance Details - Runs View
This view enables you to compare the results of a test run with the results of previous runs. You can
view run details and step results for all the runs of a selected test instance.

To access In the Test Instance Details dialog box, click theRuns button on the sidebar.

Important
information

Default filter:By default, the grid is filtered to show test runs from the current
calendar month only, in reverse chronological order (most recent first). To clear this
filter, clear the value ThisMonth from theExec Date field. For more details on
filtering, see the "Select Filter Condition Dialog Box" on page 61.

Relevant
tasks

"How to View Test Runs" on page 668

See also "Test Instance Details Dialog Box" on page 530

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Delete. Deletes the selected runs from the grid.

Details. Opens the Run Details dialog box, enabling you to view and edit
additional details for the selected run. For more details, see "Run Details
Dialog Box" on page 681.

Refresh. Refreshes the grid so that it displays themost up-to-date runs
based on the filters you have selected.

Filter. Enables you to filter, sort, or group the run records. For more
details, see "Filter Dialog Box" on page 51.

Select Columns. Opens the Select Columns dialog box, enabling you to
determine which columns to display and set the order in which the
columns are displayed. For more details, see "Select Columns/Select
Fields Dialog Box" on page 77.

Send by Email. Opens the Send E-mail dialog box, enabling you to send
a selected test run by email to recipients selected from a list, or to the
tester. For more details, see "Send E-mail Dialog Box" on page 69.
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UI Element Description

Text Search. Opens the text search pane in the lower part of the dialog
box, enabling you to search for records in predefined fields. For more
details, see "Text Search Pane" on page 66.

Continue Manual Run. Resumes amanual test run. For more details,
see "How to Run Tests Manually" on page 576.

<Filter status bar> Describes the filter currently applied to the grid. Located directly above
the grid.

Showing <x> results. Indicates the number of records currently
displayed out of the total records.

Retrieve all <x> results. Click to display all records.

<Grid filter box> Located below the column names. Displays the filter that is currently
applied to a column. If the filter box is empty, no filter is currently applied
to the column.

Type directly into the box, or click the box to display the browse button,
which opens the Select Filter Condition dialog box. For more details, see
"Select Filter Condition Dialog Box" on page 61.

Comments Comments about the currently selected run.

Criterion Results Displays the statuses of the criteria for the last run of the selected
business process test instance using a certain configuration.

Business Process Testing: Functionality related to test criteria is
available only for business process tests. For details, see theHP
Business Process Testing User Guide.
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UI Element Description

Legend Displays the color coding used to indicate the execution status of the test
run instances.

A status can be one of the following:

l Blocked. One ormore steps in the test instance has an execution
status of Blocked.

l Failed. One ormore steps in the test instance has an execution status
of Failed, and none has an execution status of Blocked.

l No Run. All the steps in the test instance have an execution status of
No Run.

l Not Completed. One ormore steps in the test instance has an
execution status of Not Completed, and none has an execution
status of Blocked or Failed. Alternatively, steps in the test instance
have execution statuses of Passed andNo Run.

l N/A. The test instance has no steps, or one of its steps has an
execution status of N/A.

l Passed. All the steps in the test instance have an execution status of
Passed.

l <User-defined>. All the steps in the test instance have the same
customized, user-defined execution status.

Report Displays results and test step details of the selected run.

For automated test instances, also includes one of the following:

l

Opens and displays the results in LoadRunner Analysis. Available for
the LR-SCENARIO test type.

l

Opens and displays the report in UFT . Available for the GUI-TEST
test type.
The Launch Report button is only enabled if you have installed the
Unified Functional Testing Add-in from the HP Application Lifecycle
Management Add-ins page. For more details on installing add-ins, refer
to theHP Application Lifecycle Management Installation and Upgrade
Guide.

l Collected System Info link. Opens the System Information dialog
box. Displays the collected system information, such as CPU,
memory, and processes running on themachine when the test is run.
Available for the SYSTEM-TEST test type.

l Captured Desktop Image. Opens the captured image of themachine
executing the system test. Available for the SYSTEM-TEST test type.
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Test Instance Details - Execution Settings View
This view enables you to view or set the test parameter values for amanual test instance or an
automated test instance. You can also view and edit the On Failure rules for an automated test
instance.

To access In the Test Instance Details dialog box, click theExecution Settings button on the
sidebar.

Relevant
tasks

"How to View Test Runs" on page 668

See also "Test Instance Details Dialog Box" on page 530

This section contains the following topics: 

l "Parameters Tab" below
l "Automated Tab" on the next page
l "Run Events Tab" on the next page
l "Test Iterations Tab" on page 537
l "Data Tab" on page 538

Parameters Tab
This tab enables you to view or set actual parameter values for manual test instances. The Parameters
tab shows all the test parameters that are used in the test steps, including parameters of called tests
that have not already been assigned actual values. Actual values that you assign for parameters in the
test instance are used for all test runs of the test instance.

Business Process Testing: To view and edit additional parameters for business process test
instances, see "Test Iterations Tab" on page 537.

For more information, see "Test Parameters Overview" on page 394

User interface elements are described below:

UI Element (A - Z) Description

Select Columns. Opens the Select Columns dialog box, enabling you to
determine which columns to display and set the order in which the
columns are displayed. For more details, see "Select Columns/Select
Fields Dialog Box" on page 77.

Uses a parameter's default value as its actual value. Select a parameter
and click theCopy Default Values button.

Actual Value The value that is used for the parameter during the test run.

To add or modify the actual value, type the value in theActual Value
column.
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UI Element (A - Z) Description

Default Value The default value of the selected parameter.

Description A description of the parameter.

Parameter Name The parameter name.

Automated Tab
This tab enables you to set parameter values and other configuration options for automated test
instances.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A -
 Z)

Description

<Automated test
configuration
options>

Youmay be able to set additional configuration options, depending on the type
of automated test you are running. For details, refer to the user guide for your
automated test.

Parameter Value Displays the value of each parameter.

UnderValue, you can edit parameter values. Your changes are implemented in
the next test run.

Run Events Tab
This tab enables you to view and edit the On Failure rules for an automated test instance.

Important
information

If you change the failure rules, your changes are implemented in the next
test run.

See also To set default On Failure rules for a test set, see "Automation Tab" on
page 541.

User interface elements are described below:

UI Element (A -
 Z)

Description

Cleanup test
before rerun

Specifies the cleanup test ALM runs before each rerun of the selected test.

Maximum test
reruns

Specifies the number of times an automated test should be rerun upon failure.
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UI Element (A -
 Z)

Description

On failure Specifies the action for ALM to take when a test run fails. Options include:

l Do nothing.
l Stop the test set.

This option is not available for Functional test sets.

l Rerun the test. Runs the test again up to themaximum number of times, as
specified in theMaximum test reruns box.

Test Iterations Tab
This tab enables you to view and edit the run-time values for each parameter of each iteration of a
business process test instance.

Important information This tab is available for Business Process Testing only.

See also For task details, see theHP Business Process Testing User Guide.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A - Z) Description

Add Iteration. Adds an iteration for the entity (component, group, test, or
flow).

Delete Iteration. Deletes the selected iteration for the entity (component,
group, test, or flow).

Select Iterations. Opens the Select Iterations dialog box, which enables you
to select which of the defined iterations you want to run during the test run.
You can specify one, all, or a range of iterations.

Import/Export. Enables you to import component parameter values for
iterations from a .csv (comma separated value) file, and to save component
parameter values to a .csv file.
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UI Element (A - Z) Description

<values> Displays the actual value of the input parameter. You canmodify the value by
clicking the arrow in the relevant cell, which opens the Set Value dialog box.

If no value is specified, the default value for that parameter is used. If no
default value is specified, no value is displayed and the entity may not run
correctly.

Values are saved and compared as strings, but can be specified according to
different value types.

Test or flow parameters (parameters whose values are to be taken from the
business process test or flow), are shown in { } brackets. This instructs ALM
to treat the parameter as a parameter and not as a fixed value.

<parameter
columns>

Displays the names for each parameter in the displayed iteration.

Iteration #
columns/rows

Displays the current run-time values for each parameter in each iteration.

Parameter
Description

Displays the description for the parameter and its original source entity
(business component, test, or flow).

Parameter descriptions are initially entered in themodule in which they were
created (the Business Components module or the Test Planmodule), or in
UFT for automated components.

Value columns Displays the run-time value for each parameter in the displayed iteration.

Data Tab
This tab enables you to view dynamic data settings for business process and UFT test configurations.

Important
information

This tab is available for test configurations that access dynamic data. For details,
see "Data for Test Configurations" on page 419.

When accessing this tab from the Execution Settings View, some of the
information in this tab is read-only.

Requested Hosts Tab
This tab enables you tomanage which hosts are requested for a Functional test set execution.

To access l In the Test Labmodule > Test Sets tab, select a test set and click theRequested
Hosts tab.

l In theBuild Verificationmodule, select a build verification suite from the build
verification suite's tree, and click theRequested Hosts tab.
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Important
Information ALM Editions: Functional test sets are available only in ALM Edition. For more

information about ALM editions and their functionality, see "ALM Editions" on
page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

l This tab is available only for Functional test sets.
l Even if more than one test instance in a test set requires a particular host or type
of host, only one host request entry is created for each host or host type.

l If youmanually change the host requests, ALM places the selected test set or
build verification suite intomanual mode. If you add another test to the test set,
ALM will only add a new testing host for the new test instance if the already
existing host requests cannot cover the new test instance. To restore auto
mode, click theRestore Default button. For more details, see "Functional Test
Execution Overview" on page 558.

Relevant
tasks

"How to Create Test Sets" on page 524

See also l "Test Set Specification Overview" on page 522
l "Test LabModuleWindow" on page 495
l "Functional Test Execution Overview" on page 558

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Add Automatch Host. Opens the Select Automatch Host dialog box,
enabling you to add a new host request based on criteria you specify.
ALM will automatically allocate and reserve a testing host which fits the
criteria.

Note: You can block hosts from being included in the automatch
selection. For details, see theHP ALM LabManagement Guide.

Add Specific Host. Opens the Select Specific Testing Host dialog box,
enabling you to request a specific testing host. You can select from the
remaining available hosts in the host pool of the project.

Note: You canmake specific hosts available only to specific users.
For details, see theHP ALM LabManagement Guide.

Edit Host Request. Enables you to edit the selected host request.
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UI Element Description

Remove. Removes the selected host request.

Caution: If you remove a host request that is required for a specific
test instance, the test will not be able to run.

Restore Default.

l Resets the host requests to their default state. ALM will remove all
current host requests and create a default set of requests. One host
request will be created for each type of test in the test set.

l Restores the selected test set to auto mode. For more details, see
"Functional Test Execution Overview" on page 558.

Resolve Missing Hosts. Enables you to automatically generate the
remaining host requests if the current host requests are insufficient for
executing the selected test set. The requested hosts will be determined
based on the test instances in theExecution Grid.

Go to Host. Opens the Testing Hosts module, displaying the selected
host.

Available for:Specific hosts only.

Refresh All. Refreshes the grid so that it displays themost up-to-date
host requests based on the filters you have selected.

Set Filter/Sort. Enables you to filter, sort, or group the host requests.
For more details, see "Filter Dialog Box" on page 51.

<filter status bar> Describes the filter currently applied to the grid. Located directly above
the grid filter boxes.

Testing Host Displays the name of the host specified in the host request.

If the valueAutomatch is displayed in this field, it indicates that no
particular host was specified. ALM will automatically allocate and
reserve a host based on the criteria in thePurposes, Location,
Amount, andAttributes fields. For details about how ALM allocates
and reserves testing hosts, see "Host Allocation" on page 627.

Amount Displays the number of hosts specified in the host request.

Purposes Lists the purposes specified in the host request. For more details, see
"Test LabModule Fields" on page 513.

Location Displays the host location specified in the host request.

Attributes Lists the host attributes specified in the host request.
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UI Element Description

Messages Displays all messages related to host request validation.

Example:

If a test set cannot run because the requested hosts have not been
reserved, ALM will inform you that the tests cannot be run and
provide the reason.

Automation Tab
This tab enables you to set test set notification rules andOn Failure rules to define what action ALM
takes when selected events occur during a test set run. For example, you can arrange for ALM to send
email to specified users when a test fails, or to rerun a test upon failure.

To access In the Test Labmodule > Test Sets tab, select a test set and click theAutomation
tab.

Important
Information

The screen has different options depending on if you run a Functional test set using
server-side execution or a Default test set using the Automatic Runner.

Relevant
tasks

"How to Create Test Sets" on page 524

See also l "Test Set Specification Overview" on page 522
l "Test LabModuleWindow" on page 495

On Automated Test Failure Area
You can set On Failure rules for a test set to instruct ALM in the event that an automated test in the test
set fails.

User interface elements are described below:

UI Element Description

Rerun test Instructs ALM to rerun an automated test if it fails. If selected, the
following options are available:

l Maximum test reruns. Specifies the number of times an automated
test should be rerun upon failure.

l Cleanup test before rerun. Runs a cleanup test before each test
rerun.
Click the down arrow to select a cleanup test.
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UI Element Description

On final failure Specifies the action for ALM to take on the final failure of any test in the
test set. Includes the following options:

l Do nothing.
l Stop the test set.
l Rerun the test set. Runs the test set again up to themaximum
number of times as specified in theMaximum test set reruns box.

Available for: Default test sets only.

Maximum test set
reruns

The number of times a test set should be rerun on final failure of any test in
the test set.

Opens the On Test Failure dialog box, enabling you to change the default
failure rules for a test in the test set. For details, see "On Test Failure
Dialog Box " on page 548.

Notification Area
You can instruct ALM to send an email to a specified user if certain events occur.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Message area> The text for the email ALM sends to the specified user.

Send email Notifies a specified user if any of the selected events occur. Includes the
following options:

For Default test sets:

l Any test finishes with status "Failed".
l Environmental failure (network problems, hardware failure, etc.).
Environmental failure could include, for example, function calls not returning,
access violations, version incompatibility between application components, a
missing DLL, or inadequate permissions.

l All tests in the Automatic Runner that were run have finished.
For Functional test sets:

l Send email in the event of any test with status "Failed".
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UI Element Description

The user who should receive the email.

Enter a valid email address or user name. Alternatively, click the To button to
select users. The Select Recipients dialog box opens. Select the users or user
groups to which you want to send the email.

Note: For Functional test sets, the default e-mail sender is the timeslot
creator.

Execution Summary Area
You can instruct ALM to send a summary of test results in an email to specified users when test set
execution completes.

User interface elements are described below:

UI Element Description

Send summary of results
after test set execution

Sends a summary report of test results in an email to specified users
after test set execution is complete.

Opens the Select Columns dialog box, enabling you to specify which
test run fields are displayed in the execution summary.

Available for: Default test sets only.

Enter a valid email address or user name. Alternatively, click the To
button to select users.

New Test Set Dialog Box
This dialog box enables you to add a test set to a test set folder.

To access In the Test Labmodule > Test Sets tab, right-click a test set folder and select
New Test Set.

Important
information

You cannot add test sets directly to theRoot folder. Youmust first add a folder
to theRoot folder.

Relevant tasks "How to Create Test Sets" on page 524

See also l "Test Set Specification Overview" on page 522
l "Test LabModuleWindow" on page 495
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User interface elements are described below:

UI Element Description

Attachments Enables you to add attachments that provide additional information about the test
set. For more details, see "Attachments Page" on page 72.

Details Lists test set fields. Required fields are displayed in red. For details on the available
fields, see "Test LabModule Fields" on page 513.

Tip: Clicking in the Description field on this page displays a toolbar for
formatting and spell checking the text.

Name The name you assign to the new test set.

Syntax exceptions:A test set name cannot include the following characters: \ ^ , " *

Test Set
Folder

Displays the preselected folder name.

Type The test set type. Select the test set type that corresponds to the types of tests you
are grouping together. For more details, see "Test Set Specification Overview" on
page 522.

Select Tests Pane
This pane enables you to select tests for inclusion in a test set. ALM adds instances of the selected
tests to the test set. Each instance contains a defined test configuration.

To access In the Test Labmodule > Test Sets tab, select a test set and click theExecution
Grid tab or theExecution Flow tab. Then click theSelect Tests button.

Important
information

l You can include instances of the same test in different test sets or addmore than
one instance to the same test set.

l You cannot add external tests (EXTERNAL-TEST test type ) to a test set. For
more details on external tests, see "Integrating External Tests Overview" on
page 594.

l If you are adding a folder to the test set, only tests that match the current filter in
the Test Plan Tree tab or Requirements Tree tab are added.

l Performance Center:You can view and add performance tests to aPerformance
test set type only. For more details, see "New Test Set Dialog Box" on the
previous page.

Relevant
tasks

"How to Create Test Sets" on page 524

See also l "Test Set Specification Overview" on page 522
l "Test LabModuleWindow" on page 495
l "Test Configuration Overview" on page 418
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Test Plan Tree Tab
Displays the test plan tree, enabling you to select tests to add to the test set.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Add Tests to Test Set. Adds an instance of the selected test to the test set,
including any test configurations associated with the selected test.

Note:

l If any of the tests you are adding are already in the test set, the Create
Instance dialog box opens. It displays the test configurations that already
exist in the test set and how many instances there are. Select the test
configurations you still want to add to the test set and click Create.

l If you are adding tests to a Functional test set, you cannot add
Performance tests

Tip:

l You can also add tests by double-clicking or dragging a folder or test in the
tree to the Execution Grid or Execution Flow.

l To add selected configurations of a test to the test set, select the test
configurations from the Test Configurations pane. For more details, see
"Test Configurations Pane" on page 436.

Show Test Details. Opens the Test Details dialog box for the selected test in
read-only mode.

Go to Entity in Module Tree. Navigates to the location of the selected entity in
that entity's module, and highlights the entity.

Refresh All. Refreshes the tree to display themost up to date information.

Set Filter/Sort. Includes the following options:

l Set Filter/Sort. Opens the Filter dialog box, enabling you to filter and sort
tests.

l Clear Filter/Sort. Clears any filters or sorting that you have applied.
For more details, see "Filter Dialog Box" on page 51.

Find. Searches for a specific test in the tree.

Go to Test by ID. Opens theGo to Test dialog box, enabling you to locate the
test in the tree according to Test ID.
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UI Element Description

Show/Hide. Shows/hides the Test Configurations pane.

<Filter status
bar>

Describes the filter currently applied to the tree. Located directly above the tree.

Test
Configurations
pane

Enables you to add selected test configurations to the test set. For more details,
see "Test Configurations Pane" on page 436.

Requirements Tree Tab
Displays the requirements tree, enabling you to select tests covering requirements to add to the test
set.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

Includes the following options:

l Add Tests Covering Requirement. Adds all tests that cover a selected
requirement. The associated test configurations are added to the test set.

l Add Tests Covering Requirement and Children. Adds all tests that cover a
selected requirement and its children. The associated test configurations are added
to the test set.

Note: If any of the tests you are adding are already in the test set, the Create
Instance dialog box opens. It displays the test configurations that already exist in
the test set and how many instances there are. Select the test configurations you
still want to add to the test set and click Create.

Tip:

l You can also add tests by double-clicking or dragging a folder or requirement in
the tree to the Execution Grid or Execution Flow.

l To add selected tests that cover a selected requirement to the test set, select a
test from the Test Coverage pane.

Show Requirement Details. Opens the Requirement Details dialog box for the
selected requirement in read-only mode.

Go to Entity in Module Tree. Navigates to the selected entity's location in that
entity's module, and highlights the entity.

Refresh All. Refreshes the tree to display themost up to date information.
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UI
Element

Description

Set Filter/Sort. Includes the following options:

l Set Filter/Sort. Opens the Filter dialog box, enabling you to filter and sort tests.
l Clear Filter/Sort. Clears any filters or sorting that you have applied.
For more details, see "Filter Dialog Box" on page 51.

Find. Searches for a specific test in the tree.

Go to Requirement by ID. Opens theGo to Requirement dialog box, enabling you to
locate the requirement in the tree according to Requirement ID.

Show/Hide. Shows/hides the Test Coverage pane.

<Filter
status
bar>

Describes the filter currently applied to the tree. Located directly above the tree.

Test
Coverage
pane

Enables you to add selected tests that cover a selected requirement to the test set.

Select a test and click Add Test . The associated test configurations are added to
the test set.

Test Set Details Dialog Box
This dialog box enables you to view and update details of a test set.

To
access

In the Test Lab module > Test Sets tab, select a test set in the test sets tree and

click the Test Set Details button .

Relevant
tasks

"How to Create Test Sets" on page 524

See also "Test LabModuleWindow" on page 495

User interface elements are described below:

UI Element
(A - Z)

Description

Save. Saves the details.

Send by Email. Opens the Send E-mail dialog box, enabling you to send a test set
by email to recipients selected from a list. For more details, see "Send E-mail Dialog
Box" on page 69.
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UI Element
(A - Z)

Description

Check Spelling. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Details Displays details of the currently selected test set. Required fields are displayed in
red. For details on available fields, see "Test LabModule Fields" on page 513.

Attachments Lists attachments that provide additional information about the currently selected
test set. For details, see "Attachments Page" on page 72.

Linked
Defects

Lists the defects linked to the currently selected test set. For details, see "Linked
Defects/Entities Page" on page 710.

History Lists changes made to the currently selected test set. For details, see "History Tab"
on page 68.

On Test Failure Dialog Box
This dialog box enables you to change the default failure rules for tests in a test set. These rules
instruct ALM in the event that an automated test in the test set fails.

To access In the Automation tab, click theSettings per test button.

Important information This dialog box displays only automated tests in the test set.

Relevant tasks "How to Create Test Sets" on page 524

See also "Automation Tab" on page 541

User interface elements are described below:

UI Element Description

Resets the default failure rules according to the settings of a selected test. The
default failure rules are defined in theAutomation tab.

Clears the settings for a selected test.
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UI Element Description

Copy/Paste Settings. Copies the settings from one test to another.

Select a test and click theCopy Settings button. Select another test and click
thePaste Settings button.

Reruns Specifies the number of times an automated test should be rerun upon failure.

Select one or more tests in the grid and select a number in theReruns box on
the toolbar.

To specify the number of reruns for a specific test, you can also select the
number from theNumber of Reruns column.

Opens the Select Test dialog box, enabling you to select a cleanup test. ALM
runs the cleanup test before each rerun of the selected test.

Select one or more tests in the grid and click theCleanup Test button.

To select a cleanup test for a specific test in the test set, you can also click the
down arrow in theCleanup Test Before Rerun column.

Automated Test The Automated Test column displays all automated tests in the selected test
set.

Paste Test Set Folders To Target Project Dialog Box
This dialog box enables you to select the way in which test sets are copied from one project to another
project.

To access 1. In the source project, right-click a test set or a test set folder and select Copy.
2. Open the target project in a separate browser window.
3. In the target project, right-click a test set folder below which you want to insert

the copied test set or test set folder, and select Paste.

Important
information

l Test run information is not copied.
l The source and target projects must use the same ALM version and patch level.

See also "Test LabModuleWindow" on page 495

User interface elements are described below:

UI Element Description

Copy Test Set
Folders and
link to
existing
related
entities

ALM copies the test sets or test set folders and pastes them into the target project.
The copied test sets or test set folders are linked to existing test resources and
called tests with the same name and path. If a related test resource or a test does
not exist in the target project, ALM copies it to the target project.
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UI Element Description

Copy Test Set
Folders and
related
entities

ALM copies the test sets or test set folders along with the related test resources
and called tests, and pastes them into the target project. If a related test resource
or a called test already exists in the target project, the copied related test resource
or called test is renamed to resolve the duplicate name.

Copy Test Set
Folders
without
copying
related
entities

ALM copies the test sets or test set folders without copying the related test
resources or called tests, and pastes them into the target project. The copied items
are not linked to any related entities.
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Chapter 33: Test Run Schedules
This chapter includes:

• Test Run Schedules Overview 552
• How to Schedule Test Runs 552
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Test Run Schedules Overview
You can control the execution of test instances in a test set. Using the Execution Flow tab of the Test
Labmodule, you can specify a date and time, and set conditions for executing a test instance. A
condition is based on the results of another specified test instance in the Execution Flow. By setting
conditions, you can instruct the Test Labmodule to postpone execution of the current test instance
until the other specified test instance has either finished running or passed. You can also set the
sequence in which to execute the test instances.

For task details, see "How to Schedule Test Runs" below.

How to Schedule Test Runs
This task describes how to schedule test runs in the Execution Flow tab.

To learnmore about scheduling test run, see "Test Run Schedules Overview" above.

Note: This task is part of a higher-level task. For details, see "How to Run Tests in ALM" on
page 490.

This task includes the following steps:

l "Display a test set" below
l "Schedule a test run" below
l "View the execution flow diagram" below

1. Display a test set
In the Test Labmodule, select a test set from the test lab tree. Click theExecution Flow tab. For
user interface details, see "" on page 554.

2. Schedule a test run
a. In the Execution Flow tab, right-click a test instance and choose Test Run Schedule. The

Run Schedule dialog box opens.
b. In the Execution Conditions tab, specify the execution conditions for the test instance. For

user interface details, see "Execution Condition Page" on page 555.
c. In the Run Schedule dialog box, click the Time Dependency tab. Specify the date and time

for running each test instance. For user interface details, see "TimeDependency Page" on
page 556.

Example

You can determine that test_2 will run only if test_1 passed, and test_3 will run only if
test_2 passed. test_1 is scheduled to run at 9:00 AM.

3. View the execution flow diagram
You can change the way the Execution Flow is displayed. This includes zooming in and out of the
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diagram, rearranging the tests in a hierarchical layout, refreshing the diagram, and displaying full
test names in the diagram. You can also copy the diagram to the Clipboard.
For user interface details on themenus and buttons available in the Execution Flow tab, see "Test
LabModuleMenus and Buttons" on page 497.
For user interface details on the various elements in the Execution Flow diagram, see "" on the
next page.

Example

The scheduled test run is displayed in the Execution Flow tab.

Test Run Schedules User Interface
This section includes:

• 554
• Execution Condition Page 555
• TimeDependency Page 556
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Execution Flow Tab

This tab displays test data in a diagram. You use the Execution Flow to control the way your test
instances are executed. You can specify when and under what conditions you want a test to be
executed.

To access In the Test Labmodule > Test Sets tab, select a test set and click theExecution
Flow tab.

Relevant
tasks

l "How to Schedule Test Runs" on page 552
l "How to Run Tests in ALM" on page 490

See also l "Test Run Schedules Overview" on page 552
l "Test Execution Overview" on page 488
l "Test LabModuleWindow" on page 495

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Test Lab
module menus
and buttons>

For details on themenu options and toolbar buttons available in the Test Lab
module, see "Test LabModuleMenus and Buttons" on page 497.

<Test Lab
module icons>

For details on the icons available in the Test Labmodule, see "Test LabModule
Icons" on page 511.

<Execution Flow
diagram area>

Displays the test instances with conditions in a diagram.

l A blue line arrow indicates that the test instance is to be
executed after the previous test instance, with no conditions.

l A green line arrow indicates that the test instance is to be
executed only if the previous test instance has status Passed.

l A black line arrow indicates that the test instance is to be
executed only if the previous test instance has finished running.

l When a test instance is time-dependent, a TimeDependency icon is
added to the diagram.

<Select Tests
pane>

Displays the Test Plan Tree tab and the Requirements Tree tab, enabling you
to select tests to add to the selected test set. For details, see "Select Tests
Pane" on page 544.
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Execution Condition Page
This page enables you to specify under what conditions you want a test instance to be executed.

To access Use one of the following in the Execution Flow tab:

l Right-click a test instance and choose Test Run Schedule. The Run Schedule
dialog box opens and displays the Execution Conditions tab.

l Right-click a condition arrow and chooseExecution Condition. The Execution
Condition dialog box opens.

Important
information

Tip: You can also add a condition directly in the Execution Flow. Click a test
icon (not the test name) and drag the arrow to another test. By default, the
condition is set to Finished. To change the condition, double-click the condition
arrow and select Passed.

Relevant
tasks

"How to Schedule Test Runs" on page 552

See also l "Time Dependency Page" on the next page
l "Test Run Schedules Overview" on page 552

User interface elements are described below:

UI
Element

Description.

New Execution Condition. Opens the New Execution Condition dialog box,
enabling you to define a new execution condition.

Available from: The Run Schedule dialog box > Execution Conditions tab.

Edit Execution Condition. Opens the Execution Condition dialog box, enabling you
to edit an execution condition.

Available from: The Run Schedule dialog box > Execution Conditions tab.

Delete Execution Condition. Deletes a selected execution condition.

Available from: The Run Schedule dialog box > Execution Conditions tab.

Test runs
only if

The execution conditions of the specified test instance.

Test The test instance on which you want the current test to be dependent.

User Guide
Chapter 33: Test Run Schedules

HP ALM (12.50) Page 555



UI
Element

Description.

is Specifies the execution condition. It includes the following options:

Finished. Executes the current test instance only after the specified test instance has
finished executing.

Passed. Executes the current test instance only if the specified test instance has
finished executing and has passed.

Comments Comments regarding the condition.

Click in the text box to display a toolbar for formatting and spell checking the text.

Available from: The Execution Condition dialog box.

Time Dependency Page
This page enables you to specify when you want a test to be executed.

To access Use one of the following in the Execution Flow tab:

l Right-click a test instance and choose Test Run Schedule. Click the Time
Dependency tab.

l Right-click the Time Dependency icon connected to a test instance. The
TimeDependency dialog box opens.

Important
information

Tip: You can schedule the test run date and time by clicking theAdd Time

Dependency To Flow button, and linking the arrow from the icon to a test
instance. Double-click the icon to set the time in the TimeDependency dialog
box.

Relevant
tasks

"How to Schedule Test Runs" on page 552

See also l "Execution Condition Page" on the previous page
l "Test Run Schedules Overview" on page 552

User interface elements are described below:

UI Element Description.

Run at any time The test runs at a non-specific time.

Run at specified time The test runs at a specific time. You can specify the following:

l Date. Indicates the date for running the test instance.
l Time. Indicates the time for running the test instance.
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Chapter 34: Functional Test Execution
This chapter includes:

• Functional Test Execution Overview 558
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Functional Test Execution Overview

ALM Editions: Functional test execution is available only for users with ALM Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site administrator.

You can run server-side Functional and Performance tests from HP Application Lifecycle Management
(ALM). Server-side tests run on remote testing hosts. A testing host is any machine registered with
LabManagement on which a testing tool has been installed.

The following workflow diagram illustrates how functional test set execution occurs in ALM:

You can use ALM to run server-side tests immediately, or you can reserve resources for a test
execution in the future.

For functional tests, you can run an entire test set, or run specific test instances from a test set.

Server-side tests are a key component in ALM's Continuous Delivery solution. They can be bundled
into a build verification suite, making them part of an automated, end-to-end deployment and testing
framework that makes application development more efficient, reliable, and quick. For more information
about the build verification suites and the Continuous Delivery process, see "Deploying and Testing
your Application in ALM" on page 492.

Testing Host Properties
Test instances added to a functional test set have a Testing Host property field in theExecution Grid.
You can use this field to require that the testing host used to execute the selected test instance has
certain properties. ALM enables you to define the following properties: Purpose, Attributes, and
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Location. For more information, see "Select Testing Host Dialog Box" on page 529.

ALM adds the required hosts for the test instance to the grid of theRequested Hosts tab.

Requested Hosts
When ALM executes a server-side test or test set, it uses the testing hosts in theRequested Hosts
tab (found in Testing > Test Lab). You can view, modify, add, or delete the testing hosts reserved for
the selected test set in theRequested Hosts tab.

Caution: ALM adds host requests to the grid regardless of whether or not such a host exists in the
testing host pool. If the grid includes a request for a host that is not in the testing pool, the test set
becomes invalid.

ALMmanages testing host requests in two different modes:

l Auto mode.
In ALM's default auto mode, each time you add a test instance to a test set, ALM checks if the host
requested by this new test instance (whether it is a specific host or an automatch host) was already
requested for the selected test set. If the new test instance contains a host request which does not
already exist in theRequested Hosts grid, ALM automatically adds a new testing host to the test
set. If the grid already contains the host being requested for the new test instance, no new hosts are
added.

For example, if the test set already contains a host request for a host in London with a VAPI-
XP purpose, and you add a new test instance which requires an automatch host with a VAPI-
XP purpose, ALM adds a new host request to the grid for the automatch host. Even though the
London host request technically covers the new automatch host, they are not the same, so ALM
adds a new automatch host request to the grid.

l Custom mode.
Youmay decide tomanually edit the hosts being requested for a selected test set. For example, you
may have only one testing host available in your pool and it can cover a few different test instances.
In that case, youmodify the hosts in theRequested Hosts tab and arrange for only a single host.
Once youmake a change in the grid, ALM puts the test set into custom mode.
In custommode, ALM automatically adds new host requests for additional test instances only when
it is necessary tomaintain the validity of the test set. This is the case when the added test instance
cannot possibly be satisfied by the already existing host requests for that test set.

For example, if the test set already contains a host request for an automatch host with a VAPI-
XP purpose, and you add a new test instance which requires a host in London with a VAPI-
XP purpose,ALM adds a host request for the new test instance because the first automatch
host request does not necessarily cover the London host request.
But if your test set already contains a host request for a host in London with a VAPI-XP purpose,
and you add a new test instance which requires an automatch host with a VAPI-XP purpose,
ALM does not add a new host request to the grid. The London host request suffices for the new
test instance, therefore ALM does not add a new host request.
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HP ALM Lab Service
When executing a server-side test, ALMwith the HP ALM Lab Service agent installed on the assigned
testing host and requests that the test be run. The Lab Service agent exports the test results back to
ALM.

For more information about Lab Service, see theHP ALM LabManagement Guide.

Execution Report
When you run a functional or performance test set, theExecution Report page opens, keeping you
updated with the status of your test execution. You can also view the Execution Report page from the
Test Runs module. For details, see "Execution Report Page - Desktop Client" on page 567.

How to Run Functional Tests

ALM Editions: Functional test execution is available only for users with ALM Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site administrator.

This task describes how to run server-side functional tests and test sets. To learnmore about running
functional tests, see "Functional Test Execution Overview" on page 558.

Note: This task is part of a higher-level task. For details, see "Deploying and Testing your
Application in ALM" on page 492.

This task includes the following steps:

l "Prerequisites" below
l "Run Functional tests immediately" below
l "Schedule Functional tests for the future" on the next page
l "Results" on the next page

1. Prerequisites
l Set up testing hosts for server-side test execution. Before running server-side tests, you
must set up and register testing host machines for the remote execution of the tests included in
your Functional test sets. For information on setting up testing hosts for server-side tests, see
theHP ALM LabManagement Guide.

l Create automated tests and Functional test sets. Use the Test Planmodule to create
automated tests and the Test Labmodule to define and fill Functional test sets with your
automated tests. For details, see "How to Create Tests" on page 348 and "How to Create Test
Sets" on page 524.

2. Run Functional tests immediately
You can arrange for the tests in a Functional test set to run immediately on a remote testing host.
In the Test Labmodule > Test Sets tab, do one of the following:
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l To run selected Functional tests, select a test set in the Test Set tree. Click theExecution
Grid tab, select one or more tests and click theRun button.

l To run all the tests in a Functional test set, select a Functional test set and click theRun Test
Set button.

In addition, if your system is integrated with HP Continuous Delivery Automation (CDA), you can
instruct ALM to provisionmachines and deploy your build packages on a dynamic environment.
For more information on the integration between ALM andCDA, see "How toWork with
AUT Environments" on page 325.
For user interface details, see "" on page 563.

3. Schedule Functional tests for the future
You can arrange for the tests in a Functional test set to run in the future using timeslots. By
scheduling a timeslot, you reserve the testing resources needed to run your test in advance.
For details, see "How to Reserve Testing Timeslots in ALM" on page 632.
For user interface details, see " Timeslot Reservation Dialog Box" on page 647.

4. Results
For Functional tests and test set runs, ALM generates an Execution Report. The Execution Report
page provides general details about the run, overall information per test, as well as drilled-down run
information for each individual test within the test set. For user interface details, see "Execution
Report Page - Desktop Client" on page 567.
After the test execution is complete, you can view a summary of test results in the Test Runs
module. When you run a test set, the test set run is immediately displayed in the Test Set Runs
tab. When a test instance completes, it is displayed in the Test Runs tab.
For more details on viewing test results, see "How to View Test Runs" on page 668.

Troubleshooting Functional Testing
l If the testing hosts being requested for a test set exceed the limits of the available testing hosts in
the host pool of your project, the test set becomes invalid. A message will be displayed in the
Messages panel (found in theRequested Hosts tab) indicating that the test set cannot be executed
due to lack of testing resources.
Workaround: You can addmore testing hosts to your host pool, or combine requested hosts in the
Requested Hosts tab.

l In theRequested Hosts tab, if you remove a host request that is required for the test set, the test
set becomes invalid. A message is displayed in theMessages panel indicating that the test set
cannot be executed due to lack of testing resources.
Workaround:
l Click Resolve Missing Hosts. ALM automatically adds the required testing hosts to the grid in
theRequested Hosts tab.

l Click Restore Defaults. ALM automatically resets the test set to auto mode, and adds the
required testing hosts to the grid in theRequested Hosts tab.

User Guide
Chapter 34: Functional Test Execution

HP ALM (12.50) Page 561



Functional Test Execution User Interface
This section includes:

• 563
• Suggested Duration Dialog Box 566
• Execution Report Page - Desktop Client 567
• Execution Report Page -WebClient 570
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Run <Entity> Dialog Box

This dialog box enables you to run Functional andPerformance tests, test sets, and build verification
suites.

To access For test sets, go to the Test Labmodule > Test Sets tab. Use one of the following
methods:

l To run all the tests in a functional test set, select a functional test set and click the
Run Test Set button.

l To run a specific functional or performance test, select a test set and click the
Execution Grid tab orExecution Flow tab. Select a test and click theRun
button.

For build verification suites, go to theBuild Verificationmodule. Select a build
verification suite and click theRun Build Verification Suite button.

Important
information

This dialog box is used to allocate ad-hoc timeslots for Functional/Performance tests,
test sets, and build verification suites. Whenever the generic term "test" is used
below, it refers to a Functional/Performance test, test set, or build verification suite.

ALM Editions:Performance tests are available only in Performance Center
Edition. Functional test sets are available only for ALM Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on
page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Relevant
tasks

l "How to Run Tests in ALM" on page 490
l "How to Run Functional Tests" on page 560

See also l "Test Execution Overview" on page 488
l "Automatic Test Execution Overview" on page 585
l "Test LabModuleWindow" on page 495

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Select timeslot Select New orReserved.

l New. Allows you to create a new timeslot. If the current resources are
insufficient for the selected test, you are unable to reserve a timeslot to run
the test.

l Reserved. Allows you to run a test in a reservedmanual timeslot that has
been assigned to your test or has not been assigned to any test. If there are
no timeslots available, you are unable to schedule your test.
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UI Element Description

<Reserved
Timeslots Grid>

Displayed when you use a Reserved timeslot.

This grid includes the details of manual non-autostart timeslots which are
currently reserved by you or another user, but are not yet assigned to another
test.

The Status field in the grid can have the following values:

l Recommended. This timeslot is recommended because it was originally
created by you and it is linked to the selected test entity.

l OK. You can run your test in this timeslot.
l Update needed. This timeslot is available, but it does not have sufficient
resources for your run. If you choose to run your test in that timeslot, ALM
automatically allocates the necessary resources.

Note: Even if you reserved a timeslot in the Timeslots module, it may not
appear in the grid. Some possible reasons include:

l The timeslot is not open yet.
l The timeslot is running (it was configured to start automatically instead
of manually).

l The timeslot does not have the required resources, and due to
concurrent timeslots, it cannot be updated with more resources.

l The timeslot was not configured with a duration long enough to run the
selected test entity, and it cannot be prolonged.

l The timeslot was linked to another test by mistake.
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UI Element Description

Timeslot
Properties

Duration. The amount of time, in hours andminutes, that you need the

resources reserved. Click theSuggested Duration icon to open the
Suggested Duration dialog box. For details, see "Suggested Duration Dialog
Box" on the next page.

Automatically Extend Timeslot. If enabled, the testing timeslot will be
automatically extended if tests are still running when the timeslot is about to
end. For the timeslot to extend successfully, the necessary testing resources
must be available in the timeslot extension. For more information, see
"Extending Timeslot Reservations" on page 625.

Requested Resources. The resources being requested for this test.

Vusers. The number of Vusers being allocated.

Note: Only for performance tests. For more details, see " Timeslot
Reservation Dialog Box" on page 647.

VUDs. The number of requested VUDs Vusers for the test rather than regular
Vusers.

Note: Only for performance tests. For more details, see " Timeslot
Reservation Dialog Box" on page 647.

Post Run. The action to be taken when the test run is complete.

Note: Only for performance tests. For more details, see " Timeslot
Reservation Dialog Box" on page 647.

AUT Env. Configuration. Select an AUT environment configuration to be
used for the test. For more information, see "How toWork with
AUT Environments" on page 325.

Deployment. If you select a CDA-linked AUT environment configuration,
deployment details are displayed here. For more details about
CDA deployment, see "How toWork with AUT Environments" on page 325.

Note:When running a Functional test set or a Performance test from the
Run <Entity> dialog box, you can only use a deployed environment.

Calculate Availability. Calculates the availability of the resources required
for running the test and checks whether a new timeslot can be created.

Availability
results

Displays the results of the availability verification. If your timeslot cannot be
reserved, the reason will be displayed.

Uses the hosts reserved by the selected timeslot and runs the test.
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Suggested Duration Dialog Box
This dialog box enables you to use the recorded durations of previous server-side executions to get a
suggested duration for your current run.

To access Click theSuggested Duration icon in the following dialog boxes:

l Timeslot Reservation dialog box. For details, see " Timeslot Reservation
Dialog Box" on page 647.

l Run <Entity> dialog box. For details, see "" on page 563.

Important
information

l ALM uses data from previous server-side executions to suggest a duration for your
run. ALM can only suggest a duration if you have at least one previous execution of
the selected test set or build verification suite.

l ALM suggests a duration based on a certain amount of previous durations.
l Executions are recorded only if they reach a state of Finished.
l This feature is available for all build verification suite runs functional test set
runs. ALM provides no suggested duration for individual test instance runs.

Relevant
tasks

l "How to Run Tests in ALM" on page 490
l "How to Run Functional Tests" on page 560

See also l "Test Execution Overview" on page 488
l "Automatic Test Execution Overview" on page 585
l "Test LabModuleWindow" on page 495

User interface elements are described below:

UI Element Description

Longest
previous
duration

Enables you to use the duration of the longest recorded execution of the selected
run.

Select this option if it is essential for the selected run to complete and there are not
many other important tests in need of resources.

Most frequent
duration

Enables you to use the duration used by the 90th percentile of recorded executions
of the selected run. Only 10 percent of runs had longer durations.

Select this option tomaximize efficient usage of testing resources.

Suggested
Duration

The duration ALM suggests based on the option you selected. Click OK to apply
this duration to your run.
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UI Element Description

Shortest
Duration

Displays the shortest duration possible for this run type.

The shortest duration possible for each run type is as follows:

l Maintenance timeslot: 5minutes
l Functional test set: 15minutes
l Build verification suite: 30minutes
l Performance test: 30minutes

Execution Report Page - Desktop Client
This page enables you to view the current state of Functional tests, test sets, and build verification
suite runs.

Note: If you have Internet Explorer 10 or later, the Execution Report appears in the ALM Web
Client. For details, see "Execution Report Page -WebClient" on page 570.

To access The Execution Report automatically appears when you run a Functional test or test
set, or a build verification suite.

There are also several ways you can view the Execution Report after or during a run:

l You can view the Execution Report for a test set run or build verification suite run
from the Test Runsmodule. Select test set or build verification suite run and click

theShow Report button .
l You can view the Execution Report for a test set run from theExecution Grid tab
in the Test Labmodule. Select a test and click the Last Run Report button.

l You can view the Execution report for a build verification suite from the Build
Verificationmodule. Select a build verification suite and click the Last Run
Report button.

Important
information

The Execution Report provides general details about the run, overall information per
test set, as well as drilled-down run information for each individual test within the run.

The Execution Report is available only for Functional test and test set runs, and build
verification suite runs.

ALM Editions: The Execution Report page is available only in ALM Edition. For
more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.
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Relevant
tasks

l "How toWork with AUT Environments" on page 325
l "How to Run Tests in ALM" on page 490
l "How to Run Functional Tests" on page 560

See also l "Test LabModule Fields" on page 513
l "Test LabModuleWindow" on page 495

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Enables you to stop all tests in the run.

Opens the event log. For more information, see theHP ALM LabManagement
Guide.

AutoRefresh. Automatically refreshes the run data at the selected interval.

Refreshes the run data.

Opens the help topic for the Execution Report page.

<Run details
section>

Contains the details of the run. The details include the following:

l The name of the run.
l The name of the user who executed the run.
l The time the run started and ended.
l The current state of the run.
l The ID of the run.

Environment
Details

Note: This section is visible only when an AUT environment configuration
was used for the selected run.

Displays the AUT Environment details and state. You can click AUT Details to
see a drilldown view of the AUT Environment details and CDA topology. You
can click Build information for further details about the selected build.

For more information about Deployment details, see "How toWork with
AUT Environments" on page 325.

Execution
Details

Details about the test sets or test instances included in the run.

Stop Selected Run. Enables you to stop the selected run.
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UI Element Description

Run Screen. For Performance test runs, opens the Performance Test Run
screen, enabling you to view andmanage the test run. For more information,
refer to theHP ALM Performance Center Guide.

Note: Only enabled when the test run is in theRunning state.

<Execution
Report Grid>

Displays a list of the tests or test sets contained in this run. For field definitions
see "Test LabModule Fields" on page 513.

Sorting a column alphabetically
To sort a column alphabetically, click the drop-down arrow that appears when
you hover over the right corner of a column heading. You can also add or
remove columns from the grid by checking and unchecking them here.

Filtering a column
To filter a column, type a filter string into the text box, or click on the arrow
below the column heading.
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UI Element Description

Run Details Displays the Run Details field in a large space.

Execution Report Page - Web Client
The Execution Report automatically appears when you run a functional test or test set, or a build
verification suite. You run these tests from the ALM Desktop Client, but the report appears in the
ALM WebClient if you have Internet Explorer 10 or later.

Note: If you have Internet Explorer 9 or below, the Execution Report appears in the ALM Desktop
Client. For details, see "Execution Report Page - Desktop Client" on page 567.

What are the parts of the Execution Report?
Here is an example of an Execution Report for a build verification suite:

The top of the report shows the overall status of the build verification suite. In this example, there are
nine tests being run. The first four tests have passed, the fifth test is running, and the other four tests
have not started.

The lower section of the report shows details about the individual tests that comprise the build
verification suite. Each test set is shown, with the status of the tests in the test set.
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What can I do using the Execution Report?
Using the Execution Report, you can:

l View the current state of the test runs:
Click one of the test sets to show its tests, then expand the specific test to see its details:

l Stop specific tests, or stop all tests:
l To stop the currently running test, hover on the test and click Stop Run.
l To stop the currently running test and all tests that have not yet run, click Stop All.

l Filter the tests you want to view:
Click the arrow next toAll, and select the tests you want to view.

l View specific information, such as AUT parameters, build details, and event logs:
l If your test set includes AUT parameters, click AUT to view the parameters.
l If your build verification suite links your environment configurations to CDA (HP Continuous
Delivery Automation) servers to automate your deployment schemas, the lower section of the
report includes an entry with the CDA details. Click Build Information to see the CDA build
details. Click Link to CDA server to link to the CDA server.

l To view event logs, click Event Log.
l Link to the test runs in the ALM Desktop Client.

l In the top of the report , click theRun ID to go to that run in the grid of the Build Verification Suite
Runs tab in the Testing > Test Runsmodule (for a Build Verification Suite) or the Test Set Runs
tab in the Testing > Test Runsmodule (for a Functional test).

l When you expand a specific test, click theRun ID to go to that run in the grid of the Test Runs
tab in the Testing > Test Runsmodule.
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Default Test Execution Overview
You can run client-side automatic andmanual tests and test sets from HP Application Lifecycle
Management (ALM) regardless of which version of ALM you have.

You can runmanual tests from aDefault test set in ALM using Sprinter or theManual Runner. For more
information about manual test execution in ALM, see "Manual Test Execution" below.

You can run automatic tests from aDefault test set in ALM using the Automatic Runner. For more
information about automatic test execution in ALM, see "Automatic Test Execution" on page 584.

Manual Test Execution
This section includes:

• Manual Test Execution Overview 575
• HP Sprinter Overview 575
• How to Run Tests Manually 576
• Manual Test Execution User Interface 578
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Manual Test Execution Overview
When you run tests in a Default test set manually, you follow the test steps and perform operations on
the application under test. You pass or fail each step, depending on whether the actual application
results match the expected output. You can run bothmanual and automated tests manually.

The following workflow diagram illustrates how functional test set execution occurs in ALM:

You can execute tests more than once in the same set. Each execution is considered a new test run.
You can also resume amanual test run that was paused during execution.

If you decide tomodify test steps during a test run, you can choose to save themodifications in the
original test and in the test instance. Alternatively, you can save them for the current test run only.

After test execution is complete, you can view a summary of results for all test runs, and view more
detailed results for each test instance.

You run tests manually in ALM using HP Sprinter, HP's solution for manual testing. For details, see
"HP Sprinter Overview" below.

If you are not working with Sprinter, you run tests manually usingManual Runner.

For task details, see "How to Run Tests Manually" on the next page.

HPSprinter Overview
You run tests manually from HP Application Lifecycle Management (ALM) using HP Sprinter. Sprinter
provides advanced functionality and tools to assist you in themanual testing process. Sprinter is fully
integrated with ALM, enabling you to get themaximum benefit from both solutions.
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l ALM Editions:Sprinter functionality is not available with Performance Center Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find
out what edition of ALM you are using, ask your ALM site administrator.

l If you are not working with Sprinter, you can run tests manually with theManual Runner.

Manual testing often requires that you leave your testing application to accomplish tasks related to your
test. For example, youmay need to use graphic software to take a screen capture of your application,
youmay want to record amovie of the application during the test, and you need to switch to your defect
tracking software to report defects.

Sprinter addresses these needs of themanual testing process, and enables you to accomplish these
tasks without disrupting your test flow. With Sprinter, you can also perform many of the repetitive and
tedious tasks of manual testing automatically. Sprinter includes many tools to help you detect and
submit defects. These features ensure that you can perform all the tasks necessary for your manual
test with minimum interruptions to your testing work.

With Sprinter you can:

l create and annotate screen captures
l capturemovies of your run
l record and runmacros on your test application
l automatically enter data into fields in your application
l automatically include the list of your steps or user actions in any defect you submit
l replicate your user actions onmultiple machines with different configurations
For full details on installing and working with Sprinter, refer to the HP Sprinter Readme and the HP
Sprinter User Guide, available on the HP Application Lifecycle Management Add-ins page. You can
access the Add-ins page in ALM from Help > Add-ins.

For details on customizing ALM default settings for Sprinter, see theHP Application Lifecycle
Management Administrator Guide.

To run tests manually in ALM using Sprinter, see "How to Run Tests Manually" below.

How to Run Tests Manually
This task describes how to run tests manually.

To learnmore about running tests manually, see "Manual Test Execution Overview" on the previous
page.

Note:

l This task is part of a higher-level task. For details, see "How to Run Tests in ALM" on page 490.
l ALM Editions:Sprinter functionality described in this section is not available with Performance
Center Edition. For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.
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This task includes the following steps:

l "Prerequisites" below
l "Run tests with Sprinter" below
l "Run tests from theManual Runner dialog box" below
l "Edit test steps during a test run" on the next page
l "Resume amanual test run" on the next page
l "Results" on the next page

1. Prerequisites
For enhanced functionality and a variety of tools to assist in themanual testing process, run tests
with HP Sprinter. To learnmore about Sprinter, see "HP Sprinter Overview" on page 575.
To run tests with Sprinter, youmust install Sprinter on your client machine. To download and
install Sprinter, select Help > Add-ins to open the HP Application Lifecycle Management Add-ins
page.

2. Run tests with Sprinter
If Sprinter is installed on your computer, you can run tests manually with Sprinter from the Test
Labmodule.
In the Test Labmodule, select a test set and click theExecution Grid tab.

l To run a single manual test, select the test and click theRun button .

l To run two or moremanual tests, select the tests. Click the drop-down arrow next to theRun
button and select Run with Sprinter.

For details on working with Sprinter, refer to theHP Sprinter User Guide, available on the HP
Application Lifecycle Management Add-ins page.

3. Run tests from the Manual Runner dialog box
If you are not working with Sprinter, you can run tests manually from theManual Runner dialog
box.
a. In the Test Labmodule > Test Sets tab, select a test set and click theExecution Grid tab or

Execution Flow tab. Select the tests, click the drop-down arrow next to theRun button,
and select Run with Manual Runner.
For user interface details on theManual Runner wizard, see "Manual RunnerWizard" on
page 580.
For user interface details on theManual Runner wizard for business process tests, see the
HP Business Process Testing User Guide.

b. Open the application being tested and execute the test steps. Follow the instructions detailed
in the test step descriptions.

c. Compare the actual results with the expected results. When performing the steps, decide
whether the application responds according to the expected results.

d. Assign a pass or fail status to each step, depending on whether the expected results match
the actual results.
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e. If a step fails, explain how the application actually responded. A test fails if one or more steps
fail.

4. Edit test steps during a test run
While executing a test using theManual Runner, you can add, delete, or modify test steps. After
you finish executing the test, you can save your design steps with the changes youmake.
Edit test steps during amanual run from theManual Runner: Step Details page. For user
interface details, see "Manual Runner: Step Details Page" on page 582.

5. Resume a manual test run
If a manual test run was paused during execution, you can continue the run at a later stage. This
continues the run using the same runner that was used the first time the test was run (Sprinter or
theManual Runner).
Use one of the following:
l In the Execution Grid tab or Execution Flow tab, select the test you want to resume running,
and select Tests > Continue Manual Run. Alternatively, click theRun arrow and choose
Continue Manual Run.

Note: This continues the last run of the selected test. If you want to resume running a
previous run, click the Test Instance Details button, click Runs on the sidebar, and select
the test run you want to resume. Click theContinue Manual Run button.

l In the Test Runsmodule > Test Runs tab, select the test run you want to resume and click the
Continue Manual Run button.

If you select multiple test instances in the Execution Grid, or multiple runs in the Test Runs tab, all
selected runs continue. If, however, the last test selected in the grid was run with Sprinter, only
that run continues.

6. Results
After test execution is complete, you can view a summary of test results in the followingmodules:
l Test Lab. The updated status for each test run is displayed in the Execution Grid. Results for
each test step appear in the Last Run Report pane. You can view more detailed results in the
Test Instance Details dialog box.

l Test Runs. The updated status for each test run in the project is displayed. You can generate
reports based on test execution details.

For more details on viewing test results, see "How to View Test Runs" on page 668.

Manual Test Execution User Interface
This section includes:

• Manual Test Run Dialog Box 579
• Manual RunnerWizard 580
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Manual Test Run Dialog Box

This dialog box enables you to select whether to run tests using Sprinter, theManual Runner, or the
Automatic Runner.

To access In the Test Labmodule > Test Sets tab, select a test set and use one of the following:

l To run an entire test set that contains only manual tests, click theRun Test Set
button.

l In theExecution Grid tab orExecution Flow tab, select two or moremanual tests
and click theRun button.

Relevant
tasks

"How to Run Tests Manually" on page 576

See also "Manual Test Execution Overview" on page 575

User interface elements are described below:

UI
Element

Description

Sprinter Opens Sprinter and runs the selected tests manually according to the order displayed
in the Execution Grid. For details on Sprinter, see the "HP Sprinter Overview" on
page 575.

This option is displayed only if Sprinter is installed on your computer.

ALM Editions:Sprinter functionality is not available with Performance Center
Edition. For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your
ALM site administrator.

Manual
Runner

Runs the selected tests manually from theManual Runner dialog box according to the
order displayed in the Execution Grid. For more details on theManual Runner, see
"Manual RunnerWizard" on the next page.

Automatic
Runner

Runs the selected tests automatically according to conditions defined in the Execution
Flow. For more details on running tests automatically, see "Automatic Runner Dialog
Box" on page 588.

Don't
show this
message
again

Instructs ALM to runmanual tests without first displaying this dialog box. To re-enable
this dialog box, select Tests > Enable Manual Test Run Confirmation.
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Manual Runner Wizard

This wizard enables you to run tests manually. You can run bothmanual and automated tests
manually.

To
access

In the Test Labmodule > Test Sets tab, select a test set and click theExecution Grid
tab orExecution Flow tab. Select one or more tests and select Tests > Run with
Manual Runner.

Relevant
tasks

"How to Run Tests in ALM" on page 490

Wizard
map

This wizard contains:

"Manual Runner: Run Details Page " below > "Manual Runner: Step Details Page" on
page 582

See also l "Test Execution Overview" on page 488
l "Manual Test Execution Overview" on page 575
l HP Business Process Testing User Guide

Manual Runner: Run Details Page

This wizard page enables you to review run details and run tests manually.

Important
information

l General information about this wizard is available here: "Manual Runner
Wizard" above.

l You can run a test instance as a draft run using theDraft Run field. For more
details, see "Draft Runs" on page 489.

l If you are running a business process test or flow, see also theHP Business
Process Testing User Guide.

Wizard map The "Manual RunnerWizard" above contains:

"Manual Runner: Run Details Page " above > "Manual Runner: Step Details
Page" on page 582

See also "Manual Test Execution Overview" on page 575
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User interface elements are described below:

UI Element Description

Starts the test run.

If the test you are running has parameters that have not been assigned actual
values, the Parameters of Test dialog box opens. Assign actual values for the
parameters. For details, see "Called Test Parameters/Parameters of Test Dialog
Box" on page 401.

Business Process Testing:Even if the business process test you are running
has parameters that have not been assigned actual values, the Parameters of
Test dialog box does not open. Instead, specify actual values in the Parameters
pane of theManual Runner: Step Details page.

Ends the test run. ALM saves the test run.

Cancels the test run.

If this test is being run as part of a test set, a confirmation dialog box opens. You
are prompted to choose if you want to cancel the run of the remaining tests. You
can save or discard the current test run by selecting or clearingSave the current
test run.

Attach to Run. Opens the Attachment page, enabling you to view and add
attachments to the test run. For details, see "Attachments Page" on page 72.

New Defect. Opens the New Defect dialog box, enabling you to add a defect to
the test run. For details, see "New Defect Dialog Box" on page 705. ALM
automatically creates a link between the test run and the new defect. For details,
see "Defect Linkage" on page 692.

To view linked defects for a selected test run, click theNew Defect arrow and
select Linked Defects.

Operating System Information. Opens the Operating System Information dialog
box. You can edit the following:

l Operating System. The operating system on themachine where you perform
your test steps. By default, the operating system on your ALM client machine is
displayed.

l OS Service Pack. The operating system service pack.
l OS Build Number. The operating system build number.

Run Details Displays information about the test run. Required fields are displayed in red. For
details on the available fields, see "Test LabModule Fields" on page 513.

Comments tab Comments for the current test run. Click Add Comment to add a comment.

Test Details Opens the Test Details dialog box, enabling you to view details about the test. For
more details, see "Test PlanModuleWindow" on page 354.
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Manual Runner: Step Details Page

This wizard page enables you to set the pass/fail status for each step, and add, delete, or modify steps
during the run. After you finish executing the test, you can save your design steps with the changes you
make.

Important
information

l General information about this wizard is available here: "Manual RunnerWizard"
on page 580.

l If youmodify test steps during a test run, you can choose to save the
modifications in the original test in the Test Planmodule and in the test instance in
the Test Labmodule. Alternatively, you can save them for the current test run only.

l The Test Labmodule enables you to update changes made to called tests in the
current test run only. The called tests are not affected. For more information on
called tests, see "Design Steps Tab/Design Step Details Dialog Box" on
page 408.

l If you are running a business process test, refer to theHP Business Process
Testing User Guide.

Wizard
map

The "Manual RunnerWizard" on page 580 contains:

"Manual Runner: Run Details Page " on page 580 > "Manual Runner: Step Details
Page" above

See also l "Manual Test Execution Overview" on page 575
l HP Business Process Testing User Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Add Step. A new step with a default step name is added to the test. You can type
details about the new step in theDescription box.

Not available for: Business process tests and flows

Delete Selected. Deletes the selected steps.

Not available for: Business process tests and flows

Pass Selected. Changes the status of selected test steps toPassed. To pass all
test steps at once, click thePass Selected arrow and select Pass All.

Fail Selected. Changes the status of selected test steps to Failed. To fail all test
steps at once, click the Fail Selected arrow and select Fail All.

Show Parameters. Opens the Parameters of Test Run dialog box, enabling you to
view the values of test parameters. For details, see "Parameters Tab/Parameters
Dialog Box" on page 396.
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UI Element Description

Attach to Step. Opens the Attachment page, enabling you to view and add
attachments to the test step. For details, see "Attachments Page" on page 72.

To add attachments to the entire test run, click theAttachments arrow and select
Attach to Run.

New Defect. Opens the New Defect dialog box, enabling you to add a defect to the
step. ALM automatically creates a link between the test step and the new defect. For
details, see "New Defect Dialog Box" on page 705 and "Defect Linkage" on page 692.

To view linked defects for a selected test step, click theNew Defect arrow and select
Linked Defects.

Keep on Top. Displays theManual Runner: Step Details dialog box on top of all
open windows.

To display selected windows on top of theManual Runner: Step Details dialog box,
click theNot on Top button.

Compact View. Opens the compact view display of this dialog box, enabling you to
conveniently read each test step and record the results.

To return to the steps grid, click theBack to Steps Grid button.

<Filter by> Filters the steps in the test according to theStatus column.

Not available for: Business process tests and flows

End Run. Ends the run.

If you added, deleted, or modified test steps during the run, a confirmation box opens.
Select one of the following:

l Yes. Saves your changes and updates the test in the Test Plan and Test Lab
modules.

l No. Saves your changes in the current test run only.

Previous Step. Jumps to the previous step.

Available for: ALMmanual tests in compact view, flows, and business process
tests

Next Step. Jumps to the next step.

Available for: ALMmanual tests in compact view, flows, and business process
tests

<Grid
indicators>

Indicates whether other objects are associated with the step.

l . An attachment is associated with the step.
l . Business Process Testing:A snapshot is associated with the step.
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UI Element Description

<Grid
fields>

View or edit details about the test steps. For details on the available fields, see "Test
LabModule Fields" on page 513.

Business Process Testing:When running a business process test or flow,
components, flows, groups, and iterations are also displayed in the grid in a
hierarchical, expandable tree.

Description A description of the selected test step.

Expected The expected result of the selected test step.

Actual The actual result of the selected test step.

Automatic Test Execution
This section includes:

• Automatic Test Execution Overview 585
• How to Run Tests Automatically 585
• How to Run Unified Functional Testing (UFT) GUI Tests 587
• Automatic Test Execution User Interface 587
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Automatic Test Execution Overview
You can run tests in a Default test set automatically from HP Application Lifecycle Management
(ALM). You can choose to run tests on your machine or on remote testing hosts. A testing host is any
machine connected to your network on which a testing tool has already been installed.

As opposed to Functional test sets, which use server-side execution and do not require user
intervention during test execution, Default test sets use client-side execution, where the user must
start andmanage test execution.

You can choose to run all of the tests in a test set, or specific tests, including both automated and
manual tests.

l When you run an automated test, ALM opens the selected testing tool automatically, runs the test
on your local machine or on remote hosts, and exports the results to ALM.

l When you run amanual test from the Automatic Runner dialog box and specify a remote host, ALM
notifies a designated tester by email to run the test on the specified host.

You can also run an automated system test to provide system information, capture a desktop image, or
restart a machine. For details on system tests, see "System Tests Overview" on page 444.

For task details, see "How to Run Tests Automatically" below.

How to Run Tests Automatically
This task describes how to run Default test sets automatically. To learnmore about running tests
automatically, see "Automatic Test Execution Overview" above.

Note: This task is part of a higher-level task. For details, see "How to Run Tests in ALM" on
page 490.

This task includes the following steps:

l "Prerequisites" below
l "Schedule and order test execution" on the next page
l "Run Default test sets automatically" on the next page
l "Results" on the next page

1. Prerequisites
l Set up hosts for remote test execution. Before running tests automatically, youmust set up
host computers for the remote execution of automated tests, and assign testers for the
execution of manual tests.

Note: For important information about running UFT GUI tests, see "How to Run Unified
Functional Testing (UFT) GUI Tests" on page 587.
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l Enable communication between ALM and the testing host.When running default test sets
on remote hosts, ALM communicates directly with the testing host to initiate the test. Refer to
the documentation for your required testing tool for more information about what ports must be
opened and what other security settings must be adjusted to enable this communication.

l Designate testers for running manual tests.When you run amanual test automatically and
specify a remote host, ALM notifies a designated tester by email to run the test. This
notification can be sent only if you have designated a tester for the test with a valid email
address.

To designate a tester, locate the test in the Execution Grid tab, and select a user in the
Responsible Tester column.

2. Schedule and order test execution
You can decide how and when tests are run using the followingmethods:
l Scheduling. You can specify the date and time, and set conditions for executing your tests.
For task details on scheduling Default test sets, see "How to Schedule Test Runs" on
page 552.

l Ordering. You can set the order in which you want your tests to be executed, using the Order
Test Instances dialog box. Use one of the following:
o In the Execution Flow, press the CTRL key and select two or more tests. Right-click a test

and select Order Test Instances.
o In the Execution Grid, select Tests > Order Test Instances.

For user interface details on the Order Test Instances dialog box, see "Order Test Instances
Dialog Box" on page 591.

3. Run Default test sets automatically
Runmanual and automated default tests automatically on your machine using the Automatic
Runner.
In the Test Labmodule > Test Sets tab, do one of the following:
l Select a Default test set that includes one or more automated tests and click theRun Test Set
button.

l To run selected tests, select a Default test set and click theExecution Grid tab orExecution
Flow tab. Select one or more automated tests and click theRun button.

l To run only manual tests, select the tests and click theRun button. In theManual Test Run
dialog box, select Automatic Runner and click OK.

To run the same test concurrently onmultiple remote hosts, addmultiple instances of the test to
your test set. For user interface details on adding test instances to test sets, see "Select Tests
Pane" on page 544.
For user interface details on the Automatic Runner, see "Automatic Runner Dialog Box" on
page 588.

4. Results
For Default test sets, you can view details about the automatic test execution after execution is
complete. In the Automatic Runner dialog box, select Run > View Execution Log. For user
interface details, see "Execution Log Dialog Box" on page 592.
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After the test execution is complete, you can view a summary of test results in the following
modules:
l Test Lab. The updated status for each test run is displayed in the Execution Grid. Results for
each test step appear in the Last Run Result pane. You can view more detailed results in the
Test Instance Details dialog box.

l Test Runs. The updated status for each test run in the project is displayed. You can generate
reports based on test execution details.

For more details on viewing test results, see "How to View Test Runs" on page 668.

How to Run Unified Functional Testing (UFT) GUI Tests

Note: HP Unified Functional Testing (UFT) comprises the product formerly known as HP
QuickTest Professional and the product known as HP Service Test.

l Functionality provided by QuickTest is now known as GUI testing in UFT.
l Functionality provided by Service Test is also known as API testing in UFT.

When running UFT GUI tests, consider the following:

l To enable ALM to runGUI tests on a remote host, open the relevant application on the remote host
and select the required option. For details, see theHP Unified Functional Testing User Guide.

l Before running aGUI test, ALM loads the UFT add-ins that are associated with the selected GUI
test. Youmust ensure that you run the GUI test on amachine on which the required UFT add-ins are
installed. For details on working with add-ins and associated add-in lists in UFT, refer to the
documentation and the relevant add-in documentation.

l When you runGUI tests from the Test Labmodule, they are automatically run in Fastmode. They
cannot be run inNormalmode.

l By default, ALM closes UFT at the end of a test set run. This ensures that the UFT license is
released at that point andmade available for other UFT users. To keep UFT open after a test set run,
you can edit theSUPPORT_TESTSET_END parameter in the Site Configuration tab in Site
Administration. For details, see theHP Application Lifecycle Management Administrator Guide.

Automatic Test Execution User Interface
This section includes:

• Automatic Runner Dialog Box 588
• Host Manager Dialog Box (for Default test sets only) 589
• Order Test Instances Dialog Box 591
• Execution Log Dialog Box 592
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Automatic Runner Dialog Box

This dialog box enables you to run tests from aDefault test set automatically. You can run an entire
test set or specific tests, including both automated andmanual tests.

To access In the Test Labmodule > Test Sets tab, use one of the followingmethods:

l Select a test set that includes one or more automated tests and click theRun Test
Set button.

l To run selected tests, select a test set and click theExecution Grid tab or
Execution Flow tab. Select one or more tests and click theRun button.

l To run only manual tests, select the tests and click theRun button. In theManual
Test Run dialog box, select Automatic Runner and click OK.

Important
information

l The Automatic Runner is used only for tests in Default test sets.
l For an automated test, ALM opens the selected testing tool automatically and runs
the test. Test execution commences only when the selected host becomes
available to run tests.

l For amanual test that you define to run on a remote host, ALM notifies a
designated tester by email to run the test on the specified host. This notification
can be sent only if you designate a tester for the test in theResponsible Tester
field in the Execution Grid.

l To run several test sets concurrently onmultiple remote hosts, open a new
Automatic Runner dialog box instance for each test set.

l For additional considerations when running UFT tests, see "How to Run Unified
Functional Testing (UFT) GUI Tests" on the previous page.

Relevant
tasks

"How to Run Tests in ALM" on page 490

See also l "Test Execution Overview" on page 488
l "Automatic Test Execution Overview" on page 585
l "Test LabModuleWindow" on page 495

User interface elements are described below:

UI
Element

Description

Run
Selected

Runs selected tests in the Automatic Runner dialog box.

Available from: Runmenu

Select All Selects all tests in the Automatic Runner dialog box.

Available from: Runmenu
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UI
Element

Description

Deselect
All

Clears selection of all tests in the Automatic Runner dialog box.

Available from: Runmenu

Invert
Selection

Selects or clears the selection of all tests in the Automatic Runner dialog box.

Available from: Runmenu

Run All Tests. Runs all the tests in the Automatic Runner dialog box.

Run Selected Tests. Runs the selected tests.

Stop the Run. Terminates text execution before it completes.

Stop All Runs. Terminates all tests that are running in the Automatic Runner dialog
box.

Run All
Tests
Locally

Executes all tests on your local machine.

Enable
Log

Creates an execution log file during the test run.

To view the execution log after text execution, select Run > View Execution Log.
For more details, see "Execution Log Dialog Box" on page 592.

Test Name The name of the test to be run.

Run on
Host

The host machine designated to remotely run the test.

To execute tests remotely, select a host machine for each test. Youmust first clear
theRun All Tests Locally check box.

Click theRun on Host grid box, and click the browse button. The Select Host dialog
box opens. Under <Any Host>, select a host or host group to run the test.

If you select a host group, ALM runs the test on the first available host in the group, not
on every host in the group.

Status Displays text execution progress.

Host Manager Dialog Box (for Default test sets only)

This dialog box enables you to create a list of available hosts for remote test execution within aDefault
test set. You can also organize hosts into groups to be used for a specific project.

To access In the Test Labmodule, Test Sets tab, select Test Sets > Host Manager.
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Important
information

If you specify a host group for remote test execution, ALM runs the test on the first
available host, and not on every host in the host group.

The Host Manager dialog box is used to arrange remote hosts only for Default test
sets.

Relevant
tasks

"How to Run Tests Automatically" on page 585

See also "Automatic Test Execution Overview" on page 585

User interface elements are described below:

UI Element Description

New Host. Opens the New Host dialog box, enabling you to add a host
to theHosts list.

Delete Host. Deletes a selected host from the Hosts list.

Add All on the Network. Includes the following options:

l Add All on the Network. ALM scans the Network Neighborhood
directory and inserts each host found into theHosts list.

l Synchronize Hosts in the Project with Hosts on Net.
Synchronizes the hosts in theHosts list with the hosts in the
Network Neighborhood directory. ALM adds hosts found in the
Network Neighborhood directory and deletes hosts that were not
found in the Network Neighborhood directory.

Name The name of the host.

Description A description of the selected host or group.

Adds hosts to a host group.

Select a group from theGroups list. Then select a host from the Hosts
list. To select multiple hosts, press the CTRL key and select the hosts.
Click theAdd Host to Host Group button.

To add all hosts to a host group, select a group from theGroups list and
click theAdd All Hosts to Host Group button.

Removes a host from a host group.

Select a group from theGroups list. Then select a host from the Hosts
in Group list and click theRemove Host From Host Group button.

To remove all hosts from a host group, select a group from theGroups
list and click theRemove All Hosts to Host Group button.

Groups The host groups for the project.

User Guide
Chapter 35: Default Test Execution

HP ALM (12.50) Page 590



UI Element Description

New Host Group. Opens the New Host Group dialog box, enabling
you to create a new host group.

Delete Host Group. Deletes a selected group from theGroups list.

Hosts The available hosts for the project.

Hosts in Group The hosts included in the selected group.

Order Test Instances Dialog Box

This dialog box enables you to change the execution order of the tests in the Execution Grid or
Execution Flow.

To access In the Test Labmodule, Test Sets tab, use one of the following:

l In the Execution Flow, press the CTRL key and select two or more tests. Right-
click a test and select Order Test Instances.

l In the Execution Grid, select Tests > Order Test Instances.

Important
information

l When determining the order for running tests, ALM first checks the Execution
Flow. The order you define in the Execution Grid is only used if there are no
conditions set in the Execution Flow.

l In the Execution Grid, ALM runs the tests according to the specified order, grouped
by host type. For example, if you have your tests ordered as test1, test2, and
test3, ALM runs test1 and test3 first if they are set to run on the same host,
followed by test2 on a different host.

Relevant
tasks

"How to Run Tests Automatically" on page 585

See also "Test Execution Overview" on page 488

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

Move Selected Up/Down. Enables you to set the execution order by moving the
selected test up or down in the list.

<Test
pane>

In the Execution Grid, displays the tests in the selected test set.

In the Execution Flow, displays the tests that you selected.

Select a test from the list and click the up or down arrow to change the position of the
test in the sequence. Alternatively, you can drag the tests up or down.
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Execution Log Dialog Box

This dialog box enables you to view details about Default tests executed by the Automatic Runner.

To access In the Automatic Runner dialog box, select Run > View Execution Log.

Important
information

You can view the Execution Log only if you selectedEnable Log in the Automatic
Runner dialog box before you executed the test.

Relevant
tasks

"How to Run Tests Automatically" on page 585

See also "Automatic Runner Dialog Box" on page 588

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Refreshes the details of a selected test.

<Test details
pane>

Displays execution details of the test selected in the Test box, including name, date
and time of run, and remote host.

<Results
pane>

Displays a description of the run. May indicate cause of run failure.

Database The project in which the executed tests are located.

Delete Deletes the execution log.

Available from: Logmenu

Exit Closes the Execution Log dialog box.

Available from: Logmenu

Host Filters the tests displayed by the selected host.

To filter, select a host and click theRefresh button.

Open Enables you to select another execution log to display.

Available from: Logmenu

Test The test for which execution details are displayed.

Test Set The test set in which the executed tests are located.

User name The user who ran the tests.
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Chapter 36: Integrating External Tests
This chapter includes:

• Integrating External Tests Overview 594
• How to Integrate Tests from Jenkins 596
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HP ALM (12.50) Page 593



Integrating External Tests Overview
ALM enhances your testing capabilities by enabling you to synch externally executed test results with
ALM. Automation tests executed by Jenkins or other testing frameworks will be integrated into ALM
along with the latest test runs, giving quality teams comprehensive quality coverage. When working
with Jenkins, this integration enhances the Continuous Testing process.

When synchronizing externally executed test results, ALM creates entities in the followingmodules:

Test
Plan
module

ALM creates an external type test (EXTERNAL-TEST ) for each test case specified in
the result file. The test details in ALM are created from the test case details defined in the
result file.

Notes:

l Each external type test links to its counterpart test in the external repository.
l External type tests cannot be addedmanually to the Test Plan Tree.

You can create requirements coverage by linking the tests to requirements in your project.

Test
Lab
module

ALM creates external type test sets for each test suite defined in the result file. Test
instances are created for each test case defined in the test suite. The status of each test
instance is updated according to the status in the result file.

Note: External type test sets are read-only. You cannot create, modify, or run test
sets directly from ALM.

Test
Runs
module

ALM creates run entities for each test case run specified in the result file. Errors and
details specified in the result file, can be viewed from the Report tab.

ALM provides twomethods for synchronizing external results with your ALM project:

Synchronizing
results from Jenkins

After you configure Jenkins to synch results with ALM, each time you run
a job from Jenkins, the external results are synchronized automatically
with ALM.

Synchronizing
results by external
testing tools

Whenworking with external testing tools, you synchronize an external
result file to ALM by manually importing the file to ALM.

Workflow for Integrating Results with ALM
The section describes the flow for integrating external results with ALM.

Integrating Results from Jenkins:

The following diagrams illustrates how to integrate Jenkins results with ALM:
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Generate External
Tests in ALM

Import tests from your external result file to ALM's Test Planmodule. ALM
generates tests (EXTERNAL-TEST test type ) and adds them to your
Test Plan Tree.

Manage
Requirements
Coverage

Create coverage by linking the external tests to requirements in your
project.

Configure Jenkins
to synch results
with ALM

Configure Jenkins to automatically synch the external result with ALM.

Run Tests Run a Jenkins job. When the job completes, it uploads the result file
automatically to ALM.

When running subsequent jobs, if the test entities already exist in ALM, then
it will only upload the new run entities.

Analyze Results Review and analyze test results from ALM.

ALM displays the uploaded test sets, test runs, and tests. ALM also
updates coverage created between the external tests and your
requirements.

Integrating Results from Other Tools:

The following diagrams illustrates how to integrate external results with ALM:

Generate
External Tests
in ALM

Import tests from your external result file to ALM's Test Planmodule. ALM
generates tests (EXTERNAL-TEST test type ) and adds them to your Test
Plan Tree.
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Manage
Requirements
Coverage

Create coverage by linking the external tests to requirements in your project.

Run Tests
Externally

Run tests using your external tool.

Import Results
to ALM

When the test run completes, you import the result file to ALM's Test Lab
module.

When importing subsequent result files, if the test entities already exist in ALM,
then it will only import the new run entities.

Analyze
Results

Review and analyze test results from ALM.

ALM displays the uploaded test sets, test runs, and tests. ALM also updates
coverage created between the external tests and your requirements.

For task details about integrating test results with ALM, see:

l "How to Integrate Tests from Jenkins" below
l "How to Integrate Tests from an External Tool" on the next page
l "How to View External Results in ALM" on page 598

How to Integrate Tests from Jenkins
This task describes how to integrate test results from Jenkins to ALM.

To learnmore about integrating external test results with ALM, see "Integrating External Tests
Overview" on page 594.

1. Import result file from Jenkins to the Test Plan module.
a. On the ALM sidebar, under Testing, select Test Plan.
b. Right-click a folder in the Test Plan Tree and select Generate Tests from External Test

Results. For user interface details, see "Generate Tests from External Test Results Dialog
Box" on page 600

Note: ALM supports the following XML formats: JUnit/XUnit, Nunit, and TestNG.

c. ALM adds the imported tests (EXTERNAL-TEST test type ) to your Test Plan Tree.
2. Create coverage between your imported tests and the requirements in your project.

You can create coverage from the Test Planmodule or from the Requirements module. For task
details, see "How to Create Coverage" on page 376.

3. Configure Jenkins to work with ALM.
For information on how to configure Jenkins to synch results with ALM, see HP Software Self-
solve knowledge base article KM01698877
(http://h20230.www2.hp.com/selfsolve/document/KM01698877).

4. Run the Jenkins job.
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Run your job from Jenkins. When the job completes, the results are synchronized automatically
with ALM.

5. View external test results in ALM.
For details, see "How to View External Results in ALM" on the next page.

How to Integrate Tests from an External Tool
This task describes how to integrate test results from an external tool to ALM.

Note: If you are working with Jenkins, see "How to Integrate Tests from Jenkins" on the previous
page.

To learnmore about integrating external test results with ALM, see "Integrating External Tests
Overview" on page 594.

1. Import result file from your external tool to the Test Plan module.
a. On the ALM sidebar, under Testing, select Test Plan.
b. Right-click a folder in the Test Plan Tree and select Generate Tests from External Test

Results. For user interface details, see "Generate Tests from External Test Results Dialog
Box" on page 600.

Note: ALM supports the following XML formats: JUnit/XUnit, Nunit, and TestNG.

c. ALM adds the tests (EXTERNAL-TEST test type ) to your Test Plan Tree.
2. Create coverage between your imported tests and the requirements in your project.

You can create coverage from the Test Planmodule or from the Requirements module. For task
details, see "How to Create Coverage" on page 376.

3. Run tests using your external tool.
4. Synchronize external results with ALM.

When the test run completes, perform the following steps:
a. On the ALM sidebar, under Testing, select Test Lab.
b. Under theRoot folder, select or create a folder.
c. Right-click the folder and select Import External Test Results. For user interface details,

see "Import External Test Results Dialog Box" on page 600.

Tip: Instead of synchronizing your results manually, you can use HP ALM REST API to
automate this process. For information on how to configure Jenkins to synch results with
ALM, see HP Software Self-solve knowledge base article KM01698878
(http://h20230.www2.hp.com/selfsolve/document/KM01698878).

5. View external test results in ALM.
For task details, see "How to View External Results in ALM" on the next page.
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How to View External Results in ALM
This task describes how to view external test results in ALM.

To learnmore about integrating external test results with ALM, see "Integrating External Tests
Overview" on page 594.

l View results in the Test Lab module.
a. On the ALM sidebar, under Testing, select Test Lab. Select a test set and click theExecution

Grid tab.
b. Select the relevant test set folder to displays the associated test instances in the grid. For more

details on the Execution Grid, see "Execution Grid Tab" on page 528.

l View results in the Test Runs module.
a. On the ALM sidebar, under Testing, select Test Runs. For more details on the Test Runs

module, see "Test Runs ModuleWindow" on page 672.
b. View the results of all the test runs in the Test Runs grid. The Report tab displays detailed

messages of a selected run.

When working with Jenkins, you can click to view the run
results from Jenkins.
When working with tools other than Jenkins, you can click

to open the file system and display the run results
and additional test data (for example, snapshots). This path is defined in the Importing External
Test Results dialog box. For more details, see "Import External Test Results Dialog Box" on
page 600.
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l View coverage of external test runs in the Requirements module.
a. In theRequirements module, select theRequirement Details view. Select a requirement and

click the Test Coverage tab.
b. View the external tests that are covering a selected requirement in the requirements tree. You

can also view a graphical representation of the run status of the tests in the coverage grid. For
more details on test coverage, see "Test Coverage Page" on page 385.

Integrating External Tests User Interface
This section includes:

• Generate Tests from External Test Results Dialog Box 600
• Import External Test Results Dialog Box 600
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Generate Tests fromExternal Test Results Dialog Box
This dialog box enables you to import your tests from an external file to your Test Plan Tree.

To access 1. On the ALM sidebar, under Testing, select Test Plan.
2. Right-click a folder in the Test Plan Tree and select Generate Tests from

External Test Results.

Relevant
tasks

l "How to Integrate Tests from Jenkins" on page 596
l "How to Integrate Tests from an External Tool" on page 597

See also "Integrating External Tests Overview" on page 594

User interface elements are described below:

UI Element Description

Upload Results File Select a results file.

Note: ALM supports the following XML formats: XUnit, JUnit,
NUnit, and TestNG.

Define Test Plan Target Specify a Test Plan folder for the imported tests.

Define Testing
Environments

Testing Framework. Select the testing framework used for creating
your tests.

Testing Tool. Select the testing tool used for running your tests.

Import External Test Results Dialog Box
This dialog box enables you to import a results file generate from an external tool to ALM.

To access 1. On the ALM sidebar, under Testing, select Test Lab.
2. Right-click a folder in the Test Set Tree and select Importing External Test

Results.

Important
information

If you are working with Jenkins, the results file is imported automatically to ALM. For
details, see "How to Integrate Tests from Jenkins" on page 596.

Relevant
tasks

"How to Integrate Tests from an External Tool" on page 597

See also "Integrating External Tests Overview" on page 594
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User interface elements are described below:

UI Element Description

Upload
Results File

Select a results file.

Note: ALM supports the following XML formats: JUnit/XUnit, Nunit, and
TestNG.

Define ALM
Targets

Test Lab. Specify a Test Lab folder for the imported test

Test Plan. Specify a Test Plan folder for the imported tests.

Define Testing
Environments

Testing Framework.Select the testing framework used for running your tests.

Testing Tool. Select the testing tool used for running your tests.

Optional
Settings

External Results Network Path.Specify a network path where additional test
data is stored (for example, snapshots).

External Build / Version Number. Specify a unique identifier for the imported
test runs. For example, a build number of the application that was tested.
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Chapter 37: Build Verification Suites
This chapter includes:

• Build Verification Overview 606
• How toWork with Build Verification Suites in ALM 606
• Build Verification User Interface 607
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Build Verification Overview
The Build Verificationmodule enables you to define a suite of automated functional test sets bundled
together with a single performance test (called a build verification suite). When run together, the build
verification suite checks the overall status of your build.

When defining a build verification suite, you can select an AUT environment configuration which
represents the build on which ALM checks the status. For more information about AUT environment
configuration, see "AUT Environments" on page 323.

If your system is integrated with HP Continuous Delivery Automation (CDA), you can instruct ALM to
provisionmachines and deploy the build on a dynamic environment. For more information on the
integration between ALM andCDA, see "How toWork with AUT Environments" on page 325.

Build verification suites are a key component in ALM's Continuous Delivery solution. They facilitate an
automated, end-to-end deployment and testing framework that makes application development more
efficient, reliable, and quick. For more information about how build verification suites can be used as
part of this process, see "Deploying and Testing your Application in ALM" on page 492.

For task details, see "How toWork with Build Verification Suites in ALM" below.

How to Workwith Build Verification Suites in ALM
This task describes how to create a build verification suite, which enables you to test the status of a
particular build of your application under test.

To learnmore about build verification, see "Build Verification Overview" above.

This task includes the following steps:

l Prerequisites
l Create a build verification suite
l Add Functional Test Sets and Performance Tests to the Suite
l Run the Suite
l View Test Results

1. Prerequisites
In the Test Labmodule, create the functional test sets that will be included in the build verification
suite. For more information about creating test sets, see "How to Create Test Sets" on page 524.
Create the performance test to be added to the build verification suite. For information about
creating performance tests, refer to theHP ALM Performance Center Guide.

Note: You can include existing functional test sets and performance tests in the build
verification suite. You do not need to create new ones specifically for this purpose.

2. Create a build verification suite
a. On the ALM sidebar, under Testing, select Build Verification.
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b. Click theBuild Verification Suites folder and on the toolbar click theNew Build
Verification Suite Folder button.

c. Click theNew Build Verification Suite button and enter a name for your build
verification suite. Click OK. The build verification suite is added to the tree.

3. Add Functional Test Sets and a Performance Test to the Suite
Add functional test sets to the suite from the Functional Test Sets tab. For user interface details,
see "Functional Test Sets Tab" on page 612.
Add a performance test to the suite from the Performance Test tab. For user interface details, see
"Performance Test Tab" on page 613.

4. Run the Suite
Use one of the followingmethods:
l Run the suite immediately. On the Build Verification Suites page toolbar, click Run. The Run
Build Verification Suite dialog box opens, enabling you to select immediate timeslot for the
suite. For user interface details, see "" on page 563.

l Run the suite at a specified time. Reserve a future timeslot for the suite to enable you to run
it at a later date. For more information, see "Reserving Timeslots" on page 621.

5. View Test Results
For each build verification suite that runs, ALM generates an Execution Report. The Execution
Report provides general details about the suite, overall information per test set, as well as drilled-
down run information for each individual test within the suite.
If you ran the suite from within the Build Verificationmodule via an ad-hoc timeslot, you can view
the Execution Report details in real time. Irrespective of whichmethod you use to run the suite,
you can access the report by clicking the Last Run Report button on the Build Verification Suites
page toolbar.
For user interface details, see "Execution Report Page - Desktop Client" on page 567.

Build Verification User Interface
This section includes:

• Build VerificationModuleWindow 608
• Build VerificationModuleMenus and Buttons 608
• Build VerificationModule Icons 610
• Build VerificationModule Fields 611
• Functional Test Sets Tab 612
• Performance Test Tab 613
• Build Verification Suite Details Dialog Box 615
• New Build Verification Suite Dialog Box 616
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• Build Verification Suite Test Set Details Dialog Box 617
• Test Sets Tree Pane 617

Build Verification ModuleWindow
This window enables you to create andmanage build verification suites.

To access On the ALM sidebar, under Testing, select Build Verification.

Relevant tasks "How toWork with Build Verification Suites in ALM" on page 606

See also "Build Verification Overview" on page 606

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Build Verification
module common UI
elements>

l Build Verification fields. For field definitions, see "Build Verification
Module Fields" on page 611.

l Build Verificationmenus and buttons. For command and button
descriptions, see "Build VerificationModuleMenus and Buttons"
below

l ALM masthead, menus, and sidebar. For details, see "ALM Common
Areas" on page 32.

<Build Verification
Suites Tree>

Contains a tree which enables you to organize your build verification
suites.

Details tab Displays details of the selected build verification suite. For details, see
"Build Verification Suite Details Dialog Box" on page 615.

Functional Test Sets
tab

Enables you to add functional test sets to the suite. For details, see
"Functional Test Sets Tab" on page 612.

Performance Test tab Enables you to add a single instance of a performance test to the suite.
For details, see "Performance Test Tab" on page 613.

Requested Hosts tab Displays requested hosts for selected test sets and enables you to edit
the host requests as required. For details, see "Requested Hosts Tab"
on page 538.

History tab Lists changes made to the currently selected build verification suite. For
details, see "History Tab" on page 68.

Build Verification Module Menus and Buttons
This section describes themenus and buttons available in the Build Verificationmodule.

To access On the ALM sidebar, under Testing, select Build Verification
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Relevant tasks "How toWork with Build Verification Suites in ALM" on page 606

See also "Build Verification Overview" on page 606

User interface elements are described below:

UI Elements
(A - Z) Menu Description

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a
favorite view to your private or the public folder. For details, see
"Add Favorite Dialog Box" on page 94.

Build
Verification
Suite Details

Build
Verification
Suites

Opens the Build Verification Suite Details dialog box, enabling
you to view and update details of the selected test set. For
details, see "Build Verification Suite Details Dialog Box" on
page 615.

Collapse View Collapses the folders in the tree below the selected folder.

Copy
URL/Paste

Build
Verification
Suites/Edit

Copies a selected suite and pastes its URL as a link. The suite
itself is not copied. Instead, you can paste the address into
another location, such as an email or a document. Clicking on
the link opens ALM and takes you to the suite. If you are not
already logged in, ALM first prompts for login details.

Cut/Paste Edit Moves a selected suite or folder to a different location in the
business verification suites tree.

Tip: You can also drag a suite to a new location in the test
sets tree.

Delete
Edit Deletes a selected suite or folder. You cannot delete theRoot

folder.

Expand All View Expands all folders in the tree below the selected folder.

Filter/Sort View Enables you to filter and sort the runs in the test runs grid. For
more details, "Filter Dialog Box" on page 51.

Go to Build
Verification

Suite

l Build
Verificatio
n Suites

l <right-
click
menu>

Opens the Go To Build Verification Suite dialog box, enabling
you to find a specific build verification suite by its ID.
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UI Elements
(A - Z) Menu Description

Last Run
Report

<right-click
menu>

Opens the Last Run Report pane, displaying results of the last
run for the selected build verification suite.

You can also click theShow arrow to display the Last Run
Report pane.

New Build
Verification
Suite Folder

Build
Verification
Suites

Opens the New Build Verification Suite Folder dialog box,
enabling you to add a folder to the build verification suites tree.

Syntax exceptions:A test set folder name cannot include the
following characters: \ ˆ *

New Build
Verification

Suite

Build
Verification
Suites

Opens the New Build Verification Suites dialog box, enabling
you to suite to a selected folder. For details, see "New Build
Verification Suite Dialog Box" on page 616.

Organize
Favorites

Favorites Opens the Organize Favorites dialog box, enabling you to
organize the list of favorite views by changing properties or
deleting views. For details, see "Organize Favorites Dialog Box"
on page 95.

Refresh/Refresh

All

View Refreshes the view to display themost up-to-date information.

Rename Edit Enables you to rename a suite or folder. You cannot rename the
Root folder.

Run
<right-click
menu>

Opens the Run <Entity> Dialog box, enabling you to run the
selected build verification suite. For details, see "" on page 563.

Update
Selected

Edit Opens the Update Selected dialog box, enabling you to update a
field value for multiple selected suites in the tree or grid. For
more details, see "Update Selected Dialog Box" on page 79.

Build Verification Module Icons
This section describes the icons displayed in the Test Labmodule.

To access On the ALM sidebar, under Testing, select Test Lab.

See also l "Test LabModuleMenus and Buttons" on
page 497

l "Test LabModuleWindow" on page 495
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User interface elements are described below:

UI
Element

Description

<green asterisk>. The applicable tab is populated.

Alerts. Click to view alerts for the test instance or test run.

l Red alert. The alert is new.
l Gray alert. The alert has already been read.
For more details, see "Alerts Dialog Box" on page 88.

Assigned Test Set Folder. A test set folder that is assigned to a cycle.

Attachments. Click to view attachments for the specified test instance or test run.

Open an attachment by selecting it from the list. If there aremore than ten attachments,
click themore attachments link to view the list in theAttachments Page. For details,
see "Attachments Page" on page 72.

Follow Up Flags. Click to view follow up flags for the test instance or test run.

l Gray flag. The follow up flag is new.
l Red flag. The follow up date has arrived.
For more details, see "Flag For Follow UpDialog Box" on page 89.

Linked Defects. Click to view linked defects for the test instance or test run. For user
interface details, see "Linked Defects/Entities Page" on page 710.

Pinned Test Set. A test set that is pinned to a baseline. For concept details, see "Pinned
Test Sets" on page 179.

Test Set Folder. A folder for organizing test sets.

Test Set. A test set in the test sets tree.

Time Dependency. Click tomodify the time dependency conditions of a test instance.
For more details, see "TimeDependency Page" on page 556.

Build Verification Module Fields
This section describes the Build Verificationmodule fields.

To access On the ALM sidebar, under Testing, select Build Verification.

See also "Build VerificationModuleWindow" on page 608

The fields are described below:
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UI Element Description

BVS ID The ID of the build verification suite.

Build Verification Suite Test Set
ID

The ID of the test set in the Build Verificationmodule.

Note: This is not the same ID as the Test Set ID in the
Test Labmodule.

Build Verification Suite Name The name of the build verification suite.

Build Verification Suite Test Set
Order

The place of the test set in the test set order.

Test Set Name The test set's name.

Created by The user who create the suite.

Creation date The date the suite was created.

Modified The date and time on which the suite was last modified.

Modified By The user who last modified the suite.

Functional Test Sets Tab
This tab enables you to add functional test sets to a build verification suite.

To
access

On the ALM sidebar, under Testing, select Build Verification. Select a build
verification suite from the tree, and then select the Functional Test Sets tab.

Relevant
tasks

"How toWork with Build Verification Suites in ALM" on page 606

See also "Build Verification Overview" on page 606

User interface elements are described below:

UI Element Description

Opens the Test Sets Tree dialog box on the right, enabling you to add test sets
to the build verification suite.

Note: Only functional test sets are displayed in the tree.

Build Verification Suite Test Set Details. Opens the Build Verification
Suite Test Set Details dialog box, displaying details of the selected test set.

Refresh. Refreshes the tab so that it displays themost up-to-date
information.
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UI Element Description

Set Filter/Sort: Enables you to filter the information displayed in the tab. For
more details on filtering, see "Filter Dialog Box" on page 51.

Select Columns. Opens the Select Columns dialog box, enabling you to
determine which fields to display in the tab and their order. For details, see
"Select Columns/Select Fields Dialog Box" on page 77.

Find. Searches the tab for values you specify in the Find box. For details, see
"Find Dialog Box" on page 63.

Go to Test Set. Goes to the selected test set in the Execution Grid tab in the
Test Labmodule.

Order Test Sets. Opens a dialog box which enables you to change the order
the test sets appear in the grid. You can change the order by using the arrow
buttons in the top right corner, or by dragging the test sets to the desired place
in the order.

Test Set Name Lists the test sets attached to the selected build verification suite.

Performance Test Tab
This dialog box enables you to add a performance test to a build verification suite.

To access On the ALM sidebar, under Testing, select Build Verification. Select a build
verification suite from the tree, then select thePerformance Test tab.

Important
information

You do not have to link a performance test to a build verification suite in order for the
suite to be valid.

Relevant
tasks

"How toWork with Build Verification Suites in ALM" on page 606

See also "Build Verification Overview" on page 606

User Guide
Chapter 37: Build Verification Suites

HP ALM (12.50) Page 613



User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements Description

Select a
test
instance

Enables you to link a performance test to a build verification suite.

By default, there is no linked test, and the selection appears as none.

In order to link a performance test to a suite, an instance of the test must be included in
a test set. To link the test, click none. A window displaying the Test Lab tree opens.
Navigate to the performance test to link and click OK.

When you link a test, the test name appears by the selection. To select a different test,
click the test name and change the test as necessary.

Note: If youmake changes to the linked test (in the Performance Test Designer),
the timeslot is updated automatically, and you do not need to relink the test
manually. Bear in mind that changing a linked test might affect the validity of the
timeslot.

Version Control:You cannot link a test that is checked out.

Vusers Displays the number of Vusers/VUDs that are defined in the linked test.

To use VUDs instead of Vusers or vice versa, click Vusers/VUDs and change the
selection.

To add additional Vusers/VUDs, click Add More.

Note: The sum of all Vusers/VUDs reserved for the requested timeslot and other
timeslots must not exceed the limits specified in the project settings (Lab Settings
> Project Settings), andmust not exceed the number of Vusers/VUDs specified in
the license.

For more information about VUDs, refer to theHP ALM LabManagement Guide.
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UI
Elements Description

Post Run Enables you to define the action to be taken when the performance test run is complete:

l Do not collate results. Frees themachines immediately after the performance test
ends. When the run has finished, the run results are left on the load generators. You
can analyze the results at a later stage from the Results tab.

l Collate.When the run has finished, the run results are collected from all the load
generators.

Note: To prevent loss of or inaccessibility to run data, select this option so that
the results are collected immediately upon completion of the test run.

l Collate and Analyze.When the run has finished, the run results are collected and
analyzed. Data analysis requires some time, depending on the size of the results file.
If there is no timeslot available to include the data analysis, then select theCollate
option instead, and run late Analysis when a data processor becomes available. You
run late Analysis from the Results tab.

Default value:Collate. Click Collate to change the selection.

Available for:Performance Test timeslots only, and only when a performance test has
been linked to the timeslot.

Build Verification Suite Details Dialog Box
This dialog box enables you to view and update details for a build verification suite.

To
access

In the Testing > Build Verificationmodule, select a build verification suite and click

theBuild Verification Suite Details button .

Relevant
tasks

"How toWork with Build Verification Suites in ALM" on page 606

See also "Build Verification Overview" on page 606

User interface elements are described below:

UI Elements Description

Details Displays the suite's details. Required fields are displayed in red. For details on
available fields, see "Build VerificationModule Fields" on page 611.

Functional
Test Sets

Enables you to add functional test sets to a build verification suite. For details, see
"Functional Test Sets Tab" on page 612.

Performance
Test

Enables you to add a performance test to a build verification suite. For details, see
"Performance Test Tab" on page 613.
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UI Elements Description

Requested
Hosts

Displays the hosts which have been requested for the tests in the suite, and enables
you to edit the host requests as required. For details, see "Requested Hosts Tab" on
page 538.

History Lists changes made to the currently selected build verification suite. For details, see
"History Tab" on page 68.

New Build Verification Suite Dialog Box
This dialog box enables you to create a build verification suite.

To access On the ALM sidebar, Under Testing, select Build Verification. Then click New Build

Verification Suite .

Relevant
tasks

"How toWork with Build Verification Suites in ALM" on page 606

See also "Build Verification Overview" on page 606

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure how to check the spelling.

Field Search. Enables you to search for a specified field name. Supports wildcard
search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Build
Verification
Suite Name

The name for the new suite.

Tip: Give the suite ameaningful name. This can be derived from the purpose
of the build you are checking. For example: ABC Application - Staging Build.

Details Required fields aremarked with an asterisk (*) and are displayed in red. For details
on the available host fields, see "Build VerificationModule Fields" on page 611.
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Build Verification Suite Test Set Details Dialog Box
This dialog box enables you to view the details of a build verification suite Functional test set.

To
access

In the Testing > Build Verificationmodule, select a build verification suite. In the
Functional Test Sets tab, select a test set and click Build Verification Suite Test Set

Details .

Relevant
tasks

"How toWork with Build Verification Suites in ALM" on page 606

See also "Build Verification Overview" on page 606

User interface elements are described below:

UI
Elements

Description

Details Displays a read-only version of the test set's details. Required fields are displayed in
red. For details on available fields, see "Build VerificationModule Fields" on page 611.

Test Sets Tree Pane
This pane enables you to select functional test sets for inclusion in a build verification suite.

To access In theBuild Verificationmodule, select a build verification suite. In the Functional
Test Sets tab, click theSelect Test Sets button.

Important
information

l You can includemultiple functional test sets in the build verification suite.
l The test sets will run in the order in which you add them.

Relevant
tasks

l "How to Create Test Sets" on page 524
l "How toWork with Build Verification Suites in ALM" on page 606

See also l "Test Set Specification Overview" on page 522
l "Build Verification Overview" on page 606
l "Functional Test Execution Overview" on page 558

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

Add Test set. Adds the selected test set to the build verification suite.

Tip: You can also add test sets by double-clicking or dragging a folder or test set in
the tree to the Functional Test Sets grid.
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UI
Element

Description

Show Test Set Details. Opens the Test Set Details dialog box for the selected test set
in read-only mode.

Go to Test Set in Module Tree. Navigates to the selected test set's location in the
Test Labmodule, and highlights the test set.

Refresh All. Refreshes the tree to display themost up to date information.

Set Filter/Sort. Includes the following options:

l Set Filter/Sort. Opens the Filter dialog box, enabling you to filter and sort test sets.
l Clear Filter/Sort. Clears any filters or sorting that you have applied.
For more details, see "Filter Dialog Box" on page 51.

Find. Searches for a specific test set in the tree.

Go to Test setby ID. Opens theGo to Test dialog box, enabling you to locate the test
set in the tree according to Test Set ID.

<Filter
status
bar>

Describes the filter currently applied to the tree. Located directly above the tree.

<Test Set
Tree>

Enables you to select a test set and add it to the selected build verification suite.

Select a test set and click Add Test Set . The selected functional test set is
added to the Functional Test Sets grid of the build verification suite.
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Chapter 38: Reserving Timeslots
This chapter includes:

• Reserving Timeslots Overview 622
• How to Reserve Testing Timeslots in ALM 632
• Reserving Timeslots User Interface 633
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Reserving Timeslots Overview
When running tests, or performingmaintenance on host machines (administrators only), the resources
needed for these tasks must be available, andmust fall within the project and license limits. ALM's
timeslots feature enables you to reserve resources in advance to ensure that the required resources are
available when you are ready to perform these tasks.

ALM reserves timeslots automatically: 

l Whenworking with Performance Center projects, ALM itself also reserves resources needed for
data processing tasks.

l When certain host operations are executed, maintenance timeslots are automatically created.
Timeslots are a key component in ALM's Continuous Delivery solution. They facilitate an automated,
end-to-end deployment and testing framework that makes application development more efficient,
reliable, and quick. For more information about how timeslots can be used as part of this process, see
"Deploying and Testing your Application in ALM" on page 492.

This section includes:

• Types of Timeslot Reservations 623
• Automatic Timeslots 624
• Extending Timeslot Reservations 625
• Modifying Timeslot Reservations 626
• Understanding Timeslot Failure 626
• Host Allocation 627
• Example of Allocating and Reshuffling Hosts 628
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Types of Timeslot Reservations
Timeslots can be reserved for immediate use or they can be reserved in advance for future use. This
section describes these two types of timeslot reservations.

Immediate Timeslot Reservations
Scheduling an immediate timeslot reserves resources for a task at hand.

l Administration: If you want to perform administrative tasks on particular hosts, such as installing
patches, when you start the task—and provided that the hosts are currently available—ALM
automatically reserves the requested hosts in amaintenance timeslot so that the hosts cannot be
used for any other purpose for the duration of your task.

l Testing:When you execute a test using server-side execution (such as from within a functional test
set), before the test starts to run, you specify the time and resources you need for the test. ALM
checks if the required resources are currently available for the required amount of time. If the
resources are not available, you cannot run the test at that time and need to try again later.

Example

When running a performance test, ALM checks if the required number of hosts and Vusers
exceeds the license/project limits. If the limits are exceeded, you will not be able to run the test.
When running a functional test set which includes a VAPI-XP test instance, ALM checks if
there is a currently available testing host with the VAPI-XP purpose assigned. If there is no
VAPI-XP testing host, you will not be able to run the test.

l Data Processing:Whenworking with Performance Center projects, tasks such as test result
analysis, SLA status publication, and trending are performed on a data processor host. ALM
estimates how long a data processor host is needed for the task at hand. As soon as a data
processor becomes available for this task, an immediate timeslot reservation is automatically made.

Advance Timeslot Reservations
If you know which testing resources you need for running a test, or you know the hosts on which you
need to perform maintenance, you can reserve the resources for your test in advance for a specified
amount of time.

When reserving resources for a testing timeslot, there are three types of timeslot reservations:

l Functional Test Set. Enables you to reserve the resources needed for running a single functional
test set containing several automatic test instances. The tests are executed consecutively.

l Performance Test. Enables you to reserve the resources needed for running a single instance of a
performance test.

l Build Verification Suite. Enables you to reserve the resources needed for running several
functional test sets together with a single instance of a performance test with the purpose of
checking the overall status of your build. The tests in the test set are executed consecutively,
followed by the single performance test. This type of timeslot reservation enables you to integrate
your system with HP Continuous Delivery Automation (CDA) for provisioning, deployment, and so
on. For more information, see "Build Verification" on page 603.
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When reserving a testing timeslot, you can request either specific hosts or automatch hosts. That is,
you can specify the exact hosts which will run your test or test set, and if those hosts are available,
ALM reserves them for you. Alternatively, you can request automatch hosts, which allows ALM to
allocate any available host with properties that match your selected criteria.

When you add a test instance to a test set in the Test Labmodule, ALM automatically allocates
automatch hosts to the test instance based on the test type. You can use the Test Labmodule's
Requested Hosts tab to change the testing host allocation before reserving the timeslot. Alternatively,
you can change the allocation as part of the timeslot reservation.

For performance test timeslots, youmust select at least one Controller and one load generator. For
more details, see theHP ALM Performance Center Guide.

For functional test set andmaintenance timeslots, youmust select at least one host.

A timeslot can be reserved successfully only if all of the requested resources are available.

Tip: All users in your project can use the timeslot that you have reserved.

It is important to note that many conditions and changes in the system can affect host allocation, and
can cause a shuffling around of the hosts. For more details about host allocation and examples of
resource shuffling, see "Host Allocation" on page 627.

Automatic Timeslots
Some tests might require a lot of time andmany resources. The Timeslot feature enables you to
reserve these resources when resources aremore readily available, and/or when youmight not be
available to run the test manually. This allows for maximum resource usage because your resources
can then be used around the clock.

Example

Suppose a project has a total of eight hosts for allocation and the employees assigned to the
project work a standard 09:00-17:00 day. The hours between 09:00 and 17:00 are peak hours for
host usage, during which time all the hosts are usually reserved for testing, data processing, and
maintenance tasks. Because of this, theremay be periods during the day that employees cannot
perform tasks because there are no available hosts. In contrast, the non-standard work hours pass
with very little host resource usage.

To extend host resource usage, employees might come in early or stay late to run tests, but this only
extends the peak usage by one or two hours at the beginning and end of the day.

Reserving timeslots during non-standard work hours and setting the tests to run during these timeslots
allows for maximum resource usage.

Best Practices for Reserving Automatic Timeslots

This section describes some best practices to follow when reserving an automatic timeslot:
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l Where possible, run the test manually first to get an indication as to how long it takes for the test to
run. This information can assist you when selecting the timeslot duration.

l The following suggestions apply to running automatic Performance tests:

Note:When a performance test is added to a Build Verification Suite timeslot, the performance
test runs only after all included functional tests have completed running.

l Always ensure that the Scheduler is set to stop as soon as all the Vusers have stopped running.
This allows more time for post-run actions during the duration of the timeslot. For details on
setting test options, refer to theHP ALM Performance Center Guide.

l If you want to analyze the test results straight after the run, take into account that the analysis
process can take a long time, so be sure to reserve enough time for this operation.

l If you want to perform auto-collate and analyze operations at the end of the run, you should take
the time required for these operations into account when reserving the timeslot.

Note: To prevent loss of run data, it is recommended, whenever possible, to collate the
results immediately after the run finishes. If your timeslot ends before result collation is
completed, collation continues as it does not require reserved resources.

l 15minutes before the end of a timeslot, ALM automatically stops the test run. Fiveminutes
before the end of the timeslot, even if all the Vusers have not yet finished running, ALM aborts the
run. To ensure that the test ends properly as designed, make sure that you reservemore time
than defined in the test schedule.

Extending Timeslot Reservations
Theremay be times when you do not allocate enough time for a test set to finish. For example, when
running a test set for the first time, youmay be unsure how long the tests will take to complete. You can
extend timeslots to allow your tests to finish running.

To extend a timeslot, all necessary testing resources must be available during the extension time. If
any of the testing resources are reserved for a different timeslot immediately following yours, you
cannot extend the timeslot and tests stop without completing properly.

There is onemethod for prolonging Functional and BVS tests and a different method for prolonging
Performance tests.

Extending Functional Test and Build Verification Suite Timeslot
Reservations

Functional test sets and build verification suites (BVS) are extended using theAutomatically Extend
Timeslot (Auto-Extend) option. If Auto-Extend is enabled, a functional test set or BVS that reaches
the end of its timeslot before all tests complete will have its timeslot automatically extended so that the
tests can finish.

Auto-Extend is enabled on a per-timeslot basis. You enable Auto-Extend either when reserving a
timeslot from the Timeslot Reservation Dialog Box or when running a test set from the Run <Entity>
Dialog Box. For more information, see " Timeslot Reservation Dialog Box" on page 647 and "" on
page 563.
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Note:

l Timeslots are extended 5minutes before the end of the timeslot.
l If a test set finishes early and a timeslot is split, the Auto-Extend setting for the initial timeslot is
copied to the new, split timeslot.

l Auto-Extend attempts can be seen in the Execution Report Event Log for a test set.

You can configure both the number of minutes by which to extend timeslots and themaximum number
of times a timeslot can be extended. These settings are controlled on a per-project basis. To configure
Auto-Extend settings for a project: Open Lab Management > Project Settingsmodule > Details tab
for your desired project. See theHP ALM LabManagement Guide for more information.

Extending Performance Test Timeslot Reservations

A performance test is extendedmanually while the test is running. If you see that a performance test
will reach the end of its timeslot before it completes, you can enter a number of minutes to extend the
timeslot. For more information, see theHP ALM Performance Center Guide.

Note: For performance tests, if the Vusers are in the process of stopping gradually, the system will
prolong the timeslot automatically for 15minutes, provided the resources are still available.

Modifying Timeslot Reservations
When youmodify an open timeslot, depending on themodification, the timeslot might split into two
separate timeslots.

A timeslot splits when:

l You stop a run and select to keep the reserved resources for the remaining time (for performance
test timeslots only).

l The run ends more than 30minutes before the timeslot ends (for performance test timeslots that are
not "NEW" ad-hoc timeslots).

l Youmodify an open timeslot that is not active, i.e., no tests are currently running.

Note:When a performance test is running, the timeslot can bemodified from within the tests' Test
Run Page only. Changes that can bemade include: prolonging a timeslot, adding Vusers, and
adding hosts. For more information, refer to theHP ALM Performance Center Guide.

Understanding Timeslot Failure
Timeslots can be reserved successfully only when all the requested resources are available for the
requested duration of time.

Many factors render a timeslot invalid. Such factors include:

l Changes to the ALM licenses (This does not affect maintenance timeslots)
l Resources become unavailable
l A test linked to a timeslot becomes invalid
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In some cases, such as where there is a conflict between hosts, the system can perform a reshuffle of
hosts to try to rectify the situation and revalidate the timeslot. For more information, see "Host
Allocation" below. Other factors, such as test invalidation, can be correctedmanually.

Tip: You can configure the system to alert you by email when a timeslot becomes invalid. The
alert provides details about the cause of the failure. For details on configuring timeslot alerts, refer
to theHP ALM LabManagement Guide.

Host Allocation
When reserving a timeslot, the system calculates the availability of all the requested hosts and, in the
case of a Performance Test timeslot, Vusers. A timeslot can be reserved successfully only if all of the
requested hosts can be allocated, and in the case of a Performance Test timeslot, if all the requested
Vusers are available.

Note: Performance Testing. Youmust request at least one Controller and one LoadGenerator. If
you have linked a test to the timeslot, the hosts and Vusers defined in the test are automatically
requested for the timeslot.

Hosts are allocated as follows:

l A specific host defined in the Testing Host grid can be allocated for testing as long as it is available
and operational. A specific host can be allocated for maintenance even if it is non-operational.

Note: You canmake specific hosts available only to specific users. For details, see theHP
ALM LabManagement Guide.

l AnAutomatch host is matched up with a specific host that has the requested properties. A host is
allocated after the following criteria have been checked:
l LabManagement and ALM create a list of all the hosts in the host pool of the project that are
operational and available, and that match the requested properties of the automatch host.

l From this list of candidate hosts, the system allocates the host that best fits the requested
properties, taking into account the host priority, the number of pools the host belongs to, the
purposes assigned to the host, and the host's attributes. The hosts are then allocated in such a
way that other hosts with similar but also additional properties may still be available for allocation
to other test executions.

Note: You can block hosts from being included in the automatch selection. For details, see the
HP ALM LabManagement Guide.

It is important to note that many conditions and changes in the system can occur that can affect host
allocation. At such times, the system attempts to optimize the overall resource usage by reshuffling the
hosts that are available among the timeslots.

It is not always possible to shuffle the hosts appropriately. When this happens, a timeslot might
become partially allocated, and thus invalid. As soon as the requested host becomes available again
or another host can be allocated instead, the timeslot becomes valid again.
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Example

l If an allocated host becomes non-operational, then the system will try to find another host to
replace the non-operational host.

l In a version-enabled project, if a test is linked to an automatic timeslot and is checked out,
modified, and checked in again before the timeslot starts, the timeslot recalculates the
availability of the updated resources.

To view an example of how hosts are allocated, and how they are reshuffled when necessary, see
"Example of Allocating and Reshuffling Hosts" below.

Example of Allocating and Reshuffling Hosts
There aremany factors that can affect the allocation of hosts among timeslots. Consider the following
scenarios which illustrate how hosts are allocated among performance timeslots and how changes in
the available testing hosts can affect the host allocation. You will see that LabManagement attempts
to optimize the overall resource usage by reshuffling the hosts that are available among the timeslots.

Assume the following hosts belong to the host pool of the project:

Host Properties

Host1 Controller

Host2 Controller + LoadGenerator

Host3 LoadGenerator with the following property:

l Priority = 1_Lowest

Host4 LoadGenerator with the following properties:

l Citrix. The host can run scripts based on Citrix protocols.
l Priority = 9_Highest

At 07:00 am, John reserves the following timeslot:

Timeslot Reserved at Reserved for Requested Resources, Properties

TS1 07:00 08:00am - 10:00am 1Controller, Any

1 LoadGenerator, Any

John submits the request. The system allocates Host1 as the Controller, leaving Host2 available to
serve as either load generator or Controller in other timeslots. Additionally, the system allocates Host4
as the load generator, since it has higher priority than both Host2 and Host3. The following hosts are
allocated successfully:

Requested Hosts Allocated Hosts

1 Controller, Any Host1

1 LoadGenerator, Any Host4
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At 07:30 am, Sue submits the following timeslot reservation:

Timeslot Reserved at Reserved for Requested Resources, Properties

TS2 07:30 09:00am - 11:00am

Autostart

1 Controller, Any

1 LoadGenerator, Citrix

Because Host4 is the only Citrix load generator, the system checks if it can allocate a different load
generator to John's timeslot so that Host4 can be allocated to Sue's timeslot instead.

The necessary hosts are available, so the following reshuffle occurs:

l Host3 is allocated to John; Host4 is allocated to Sue
l John's Controller, Host1 remains allocated to John; Host2, also a Controller, (not yet allocated), is
allocated to Sue

Sue successfully submits the request. The new host allocation looks as follows:

Timeslot Requested Hosts Allocated Hosts

TS1 1Controller, Any

1 LoadGenerator, Any

Host1

Host3 (replaced Host4)

TS2 1 Controller, Any

1 LoadGenerator, Citrix

Host2

Host4
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Note: Host allocation works on a "first-come, first-served" basis. Since John reserved Host4 first,
if there had been no other host to allocate to his timeslot, Host4 would have remained allocated to
John, and Sue would not have been able to reserve her timeslot successfully.

At 07:45am, Peter reserves the following timeslot:

Timeslot Reserved at Reserved for Requested Resources, Properties

TS3 07:45 10:00am - 12:00pm 1Controller, Host2

1 LoadGenerator, Any

Peter is specifically requesting Host2 for his Controller, and any load generator. The system checks if
the requested hosts can be allocated, taking into consideration requests and timing of the other
timeslots:

l To allocate Host2 to Peter's timeslot, it must be available by 10:00.
l Sue is willing to have any Controller.
l John's timeslot will end at 10:00 and free resources.
The following reshuffle occurs so that all the timeslots can be accommodated:
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l Sue's timeslot gives up Host2, and is allocated Host1 instead; Host4 (Citrix) remains allocated to
Sue's timeslot

l Host2 is allocated to John's timeslot; Host3 remains allocated to John's timeslot
l Host2 and Host3 can then be allocated to Peter's timeslot because John's timeslot will be finished
by 10:00 when Peter's starts.

Peter successfully submits his request. The new host allocation looks as follows:

Timeslot Requested Hosts Allocated Hosts

TS1 1Controller, Any

1 LoadGenerator, Any

Host2

Host3

TS2 1 Controller, Any

1 LoadGenerator, Citrix

Host1

Host4

TS3 1 Controller, Host2

1 LoadGenerator, Any

Host2

Host3

Note: If John and Peter's timeslots had overlapped, Host2 would not have been available for part
of Peter's timeslot. In this case, the reshuffle would not have been possible and Peter would not
have been able to reserve his timeslot successfully.
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Now let's say at 07:55 Host2 becomes non-operational. As a result, TS1 takes back Host1, and starts
at 08:00. It follows from the information above, that TS2 and TS3 both become invalid as their
resources have become partially allocated.

Then, at 09:05, Host2 becomes operational again. It is allocated to TS2, and TS2 starts, though five
minutes late, but still during the specified retries period. (For details about configuring retries, refer to
theHP ALM LabManagement Guide.)

At 11:00, TS3 remains invalid (partially allocated) and is unable to start because Host2 is still being
used by TS2.

How to Reserve Testing Timeslots in ALM
This task describes how to reserve resources for running tests.

Note:

l This task is part of higher-level tasks. For details, see "Deploying and Testing your Application
in ALM" on page 492.

l Product Feature Movie. To view amovie that demonstrates how to reserve timeslots, select
Help > Movies in the ALMmain window.

To learnmore about timeslot reservations, see "Reserving Timeslots Overview" on page 622.

1. Prerequisites
Ensure that there is a host pool defined and allocated to the project. For information about
managing host pools in LabManagement, see theHP ALM LabManagement Guide.
If you want to run a particular test during the timeslot, ensure that an instance of that test is
included in a test set.
For Performance tests, make sure that at least one of the hosts in the host pool can be designated
as a Controller, and that Host, Vuser, and Concurrent Run limits are defined in the project
settings.

2. Create a timeslot
a. On the ALM sidebar, under Testing, select Timeslots.

b. On the Timeslots toolbar, click New Timeslot .
c. Enter the details of the timeslot and select resources. For user interface details, see "

Timeslot Reservation Dialog Box" on page 647.

3. Verify availability of requested resources
Do one of the following:
l (Recommended) Click Calculate Availability. The system checks the availability of the
requested resources. The results of this calculation are displayed in the Timeslot Status tab
and graphically on the resource availability timeline.

User Guide
Chapter 38: Reserving Timeslots

HP ALM (12.50) Page 632



The availability timeline displays all timeslots when the requested hosts can be reserved. Even
if the requested hosts cannot be reserved for the selected timeslot, they may be available at
other times.
If the timeslot cannot be reserved, consider the reasons displayed in the Timeslot Status tab
when reselecting your resources. If the timeslot can be reserved, you can click Submit to save
the timeslot.

l Click Submit. The system calculates the availability of the requested resources during the
selected timeslot. If all of the resources are available, the Timeslot Reservation dialog box
closes and the timeslot is reserved and displayed in the Timeslots module. If the timeslot
cannot be reserved, the reasons are displayed in the Timeslot Status tab.

Reserving Timeslots User Interface
This section includes:

• Timeslots ModuleWindow 634
• Timeslots ModuleMenus and Buttons 639
• Timeslots Module Fields 643
• Timeslots Module Icons 646
• Timeslot Reservation Dialog Box 647
• Select Specific Hosts Dialog Box 655
• Timeslot Reservation: Data Processing Dialog Box 656
• Select Controller Dialog Box 658
• Select Automatch LoadGenerators/Edit Hosts Dialog Box 660
• Select Specific LoadGenerators/Hosts Dialog Box 661
• Time ZoneOptions Dialog Box 662
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Timeslots ModuleWindow
This module enables you to reserve timeslots for running Functional and Performance test sets and
tests or performingmaintenance tasks.

Themodule contains the following views: Calendar View, Grid View.

You select a view from theViewmenu.

Calendar View
This view enables you to view the timeslots in a calendar view.The Calendar view is time-oriented. It
allows you to view your timeslots scheduled for the same day, and to get a visual indication of
overlapping timeslots.

Grid View
Enables you to view timeslots in a flat, non-hierarchical view. Each line in the grid displays a separate
timeslot. This view is useful for filtering the timeslots and for viewing the details of multiple timeslots
simultaneously.

To access Use one of the following:

l Maintenance timeslots: On the Lab Management sidebar, under Lab
Resources, select Timeslots.

l Testing timeslots:On the ALM sidebar, under Testing, select Timeslots.

Important
information

l The Calendar andGrid views display different types of information about the
timeslots. To view full details about a particular timeslot, open the timeslot in the
Timeslot Reservation dialog box. For details, see:
l " Timeslot Reservation Dialog Box" on page 647
l HP ALM LabManagement Guide

Relevant
tasks

"How to Reserve Testing Timeslots in ALM" on page 632

See also "Reserving Timeslots Overview" on page 622
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Main Timeslots Area
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A-
Z)

Description

<Timeslots
module
common UI
elements>

l Timeslot menus and buttons. For command and button descriptions, see
"Timeslots ModuleMenus and Buttons" on page 639.

l Timeslot fields. For field definitions, see "Timeslots Module Fields" on
page 643.

l Timeslot icons. For icon descriptions, see "Timeslots Module Icons" on
page 646.

l ALM masthead, menus, and sidebar. For details, see "ALM Common
Areas" on page 32.

<Calendar> Displays the reserved timeslots in your projects in calendar form.

The timeslots in the calendar view are color-coded as follows:

l Performance timeslots

l Functional timeslots

l Build Verification Suite timeslots

l Maintenance timeslots

l Testing timeslots reserved in other projects

l Data processing timeslots (Performance Center projects only)
Available from:Calendar view only

<Date
navigator>

Enables you to select the day/week to display in themain calendar grid.

<grid filters> Located under each column name. Displays the filter that is currently applied to
a column. If the filter box is empty, no filter is currently applied to the column.

Type directly into the box, or click the box to display theBrowse button which
opens the Select Filter Condition dialog box. For more details, see the "Select
Filter Condition Dialog Box" on page 61.

Available from:Grid view only

Description tab Describes the currently selected timeslot.

Available from:Grid view only

Event Log tab Displays a log of events related to the currently selected timeslot. For details,
refer to theHP ALM LabManagement Guide.

Available from:Grid view only
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UI Elements (A-
Z)

Description

History tab Lists changes made to the currently selected timeslot. For more details, see
"History Tab" on page 68.

Available from:Grid view only

Host Allocation
tab

Displays the temporary allocation of the hosts for the selected timeslot. For
more details, see the "Host Allocation Tab" below below.

Note:

l Calendar view: Located on right of calendar, when a timeslot is selected in
the calendar.

l Grid view: Located in the information panel.

My Timeslots
for Today

Displays open and future timeslots that you reserved for the current day in the
current project.

Available from:Calendar view only

Status tab Displays the status and validity of the selected timeslot.

Available from:Grid view only

Summary tab Displays a summary of the timeslot selected in the calendar. For more details,
see the "Summary Tab" on the next page below.

Available from:Calendar view only, when a timeslot is selected in the
calendar.

Timeslots grid Displays the timeslots in your projects in a grid.

Available from:Grid view only

Host Allocation Tab
This tab displays the allocation of hosts for the selected timeslot. For future timeslots, the host
allocation is a temporary allocation.

Important
information

If an allocated host becomes unavailable, the system attempts to replace the
allocated host with another host with similar properties. If no host is available, the
timeslot becomes partially allocated and is rendered invalid.

l Calendar view: Located on right of calendar, when a timeslot is selected in the
calendar.

l Grid view: Located in Information panel.
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User interface elements are described below:

UI
Elements

Description

Requested Displays the requested hosts, including the requested properties.

Actual Displays the specific hosts allocated for the timeslot.

May display the following in place of specific host names:

l Not Allocated. Requested host(s) could not be allocated.
l Allocated (Deleted). The allocated host was deleted after the timeslot start time.
l From another pool. The host belongs to a host pool in another project to which you
do not have access.

Summary Tab
This tab displays a summary of the timeslot details.

User interface elements are described below in alphabetical order :

UI Elements
(A – Z)

Description

AUT env.
configuration

The set of environment parameters allocated to the timeslot, orNot Connected
indication.

Click the link to go to the AUT environment in the AUT Environments module.

Build
Verification
Suite

A link containing the name of the build verification suite associated with the
timeslot, orNot Connected indication.

Click the link to go to the build verification suite in the Build Verificationmodule.

Available for:Build Verification Suite timeslots only.

Created by The user who created the timeslot.

Description Displays a description of the timeslot.

Duration The duration of the timeslot (in minutes).

Also displays the duration of the timeslot in HH:MM format in parentheses.

End time The end time of the timeslot.

Hosts The number of hosts requested for the timeslot.

Last modified
by

The user who last modified the timeslot.
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UI Elements
(A – Z)

Description

Maintenance
state

The state of themaintenance timeslot.

Available for:Maintenance timeslots only.

Name The name of the timeslot.

Performance
Test

The name of the performance test linked to the timeslot.

Available for:Performance Test timeslots only.

Post-run
action

The post-run action specified for the linked performance test.

Available for:Performance Test timeslots only.

Priority
modified

The date and time that the priority of the timeslot was modified.

Processing
state

The state of the data processing timeslot.

Available for:Data processing timeslots only.

Project The project in which the timeslot was created.

Realized
environment
name

After linking to CDA, the name of the actual environment for the timeslot.

Available for:Build Verification Suite timeslots only.

Run ID Link containing the ID of the run associated with the timeslot.

Click the link to go to the run in the Test Runs module > Build Verification Suite
Runs tab.

Available for:All testing timeslots, and when an entity is linked to the timeslot.

Run state The run state of the entity linked to the timeslot.

Available for: Testing timeslots only, and when an entity is linked to the timeslot.

Start How the timeslot is started:

Manually. The timeslot reservation reserves testing resources only.

Automatically. The linked tests or test sets automatically start running at the
start of the timeslot, without any manual intervention.

Start time The start time of the timeslot.

Test set The name of the test set associated with the timeslot.

Available for: Testing timeslots only.

Timeslot ID The timeslot ID.
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UI Elements
(A – Z)

Description

Topology
action

Topological deployment, provisioning and deprovisioning actions defined for the
timeslot.

Example:

Provision and deploy, deprovision at end

Available for:Build Verification Suite timeslots only.

Validity The validity of the timeslot:

l Valid. The timeslot is valid.
l Failed. The timeslot failed:

l Because resources unexpectedly became unavailable
l Because of a change in license definitions
l Because of changes in project settings
l In the case of a testing timeslot, due to changes such as the validity of a
test, a test set, an AUT environment configuration, or a build verification
suite

Vusers The number of Vusers requested for the timeslot.

Available for:Performance Test timeslots only.

Timeslots Module Menus and Buttons
The section describes themenus and buttons available in the Timeslots module.

To access Use one of the following:

l Maintenance timeslots: On the Lab Management sidebar, under Lab
Resources, select Timeslots.

l Testing timeslots:On the ALM sidebar, under Testing, select Timeslots.

Important
information

Somemenu commands and buttons are not available in all timeslot views.

Relevant tasks "How to Reserve Testing Timeslots in ALM" on page 632

See also "Reserving Timeslots Overview" on page 622
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User interface elements are described below :

UI Elements
(A-Z)

Menu Description

Abort and
Free
resources

Edit and
<right-
click
menu>

Aborts the current timeslot and frees the reserved resources.

For testing timeslots, if a test, test set, or build verification suite is
running, the run is aborted.

Notes for aborting and freeing testing timeslots:

l You can perform this operation from LabManagement or from the
project where the timeslot was reserved only.

l If an entity (test, test set, build verification suite) is running, you
must haveAbort andEdit permissions to perform this operation. If
there is no test running, then you need only haveEdit permissions
to perform this operation.

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view
to your private or the public folder. For details, see the "Add Favorite
Dialog Box" on page 94.

Available from:Grid view only

Calendar
View

View When selected, the timeslots are displayed in the Calendar view.

Canned
Filters

None Enables you to filter the timeslots as follows:

l All accessible projects. Displays all timeslots from all of your
projects.

l Mine (This project). Displays all of the timeslots that you created
in this project.

l My Failed (This project). Displays all of the timeslots that you
created in this project that have failed.

l Mine (All projects). Displays all of the timeslots that you created
in all of your projects.

l My Failed (All projects). Displays all of the timeslots that you
created in all of your projects that have failed.

Copy URL Timeslots
and
<right-
click
menu>

Copies the selected timeslot. The timeslot itself is not copied. Instead,
you can paste the address into another location, such as an email or a
document. Clicking the link opens ALM and takes you to the timeslot
file or folder. If you are not already logged in, ALM first prompts for
login details.

Copy/Paste Edit and
<right-
click
menu>

Copies the selected timeslot within the same project.
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UI Elements
(A-Z)

Menu Description

Delete
Edit and
<right-
click
menu>

Deletes the selected timeslot.

Note:You can only delete future timeslot reservations in the current
project.

Note for Administrator:You can also delete future testing timeslots
from LabManagement.

Export Timeslots
and
<right-
click
menu>

Opens the Export Grid Data dialog box, enabling you to export the
resources in the grid as a text file, Microsoft Excel worksheet,
Microsoft Word document, or HTML document.

Choose one of the following options:

l Export All. Exports all resources in the grid.
l Export Selected. Exports selected resources in the grid.
Available from:Grid view only

Find
View Opens the Find dialog box, enabling you to search for a timeslot in the

module. For details about search options, see the "Find Dialog Box" on
page 63.

Available from:Grid view only

Go To

Timeslot

Timeslots Opens the Go To Timeslot dialog box, enabling you to find a specific
timeslot by its ID.

Go To
Timeslot in
Calendar/Grid

View

Right-
click
menu

l Calendar view:Goes to the selected timeslot in the Grid view.
l Grid view:Goes to the selected timeslot in the Calendar view.
Note: Toolbar button available in Calendar view only.

Grid Filters View and
<right-
click
menu>

Enables you filter the data according to an entry in the filter box. For
details about filtering options, see the "Select Filter Condition Dialog
Box" on page 61.

Available from:Grid view only

Grid View View When selected, the timeslots are displayed in the Grid view.

Information
Panel

View and
<right-
click
menu>

Shows/Hides the Information Panel in the lower area of themodule.

Available from:Grid view only
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UI Elements
(A-Z)

Menu Description

New Timeslot Timeslot
and
<right-
click
menu>

Enables you to reserve a new timeslot.

Available from:Right-click menu in calendar view only.

Organize
Favorites

Favorites Organizes your favorite views. For details, see the "Organize
Favorites Dialog Box" on page 95.

Available from:Grid view only

Private Favorites Lists the favorite views that are accessible only to the user who
created them.

Available from:Grid view only

Public Favorites Lists the favorite views that are accessible to all users.

Available from:Grid view only

Refresh All View Refreshes the grid so that it displays themost up-to-date information.

Select

Columns

View Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For more details, see
the "Select Columns/Select Fields Dialog Box" on page 77.

For details about the Timeslot module fields, see "Timeslots Module
Fields" on the next page.

Available from:Grid view only

Send by E-

mail

Timeslots
and
<right-
click
menu>

Opens the Send E-mail dialog box, enabling you to send timeslot
details to recipients selected from a list or to the user who reserved the
timeslot. For more details, see the "Send E-mail Dialog Box" on
page 69.

Set Filter/Sort View Enables you to filter and sort the timeslots. Any currently applied filters
or sorting orders are displayed below the toolbar. For more details, see
the "Filter Dialog Box" on page 51.

Note: In the Calendar view you can filter the timeslots only.

Show
Timeslot
Details

View Displays theSummary andHost Allocation tabs (to the right of the
calendar grid) which contain details about the selected timeslot.

Available from:Calendar view only
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UI Elements
(A-Z)

Menu Description

Time Zone
Options

Tools Opens the Time ZoneOptions dialog box, enabling you to display an
additional time zone in the Timeslots calendar view. For details, see
"Time ZoneOptions Dialog Box" on page 662.

Available from:Calendar view only

Timeslot

Details

Timeslot
and
<right-
click
menu>

Opens the Timeslot Reservation dialog box, enabling you to view and
modify details of the selected timeslot.

For details, see:

l " Timeslot Reservation Dialog Box" on page 647
l HP ALM LabManagement Guide
Note: In some cases, you can only view, and not modify, the timeslot.
For example, you cannot modify past timeslots.

Displays the current day only on the calendar.

Available from:Calendar view only

Displays the date selected in the date selector.

Available from:Calendar view only

Displays the 5-day work week around the date selected in the date
selector.

Available from:Calendar view only

Displays the full week around the date selected in the date selector.

Available from:Calendar view only

Timeslots Module Fields
This section describes the fields in the Timeslots module.

UI
Elements

Description

Additional
Requested
Vusers

The number of Vusers requested for a Performance Test timeslot in addition to those
defined in the linked performance test.

Auto-
Extend

Indicates whether or not the timeslot will be automatically extended if the timeslot
ends before tests are completed.

Autostart
Enabled

Y indicates that the linked entity/entites will start running when the timeslot starts.
You enable autostart by setting the timeslot to start automatically.

Note: Formaintenance timeslots, this field is empty.
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UI
Elements

Description

Build
Verification
Suite ID

The ID of the build verification suite linked to the timeslot.

Build
Verification
Suite Name

The name of the build verification suite linked to the timeslot.

Consume
VUDs

Y indicates that the timeslot will use/used Vusers from the VUDs license.

Created The date and time the timeslot was reserved.

Created By The user who reserved the timeslot.

Description A description of the timeslot.

Duration in
Minutes

The duration of the timeslot in minutes.

Note: This field displays the duration in HH:MM format in parentheses.

End Time The date and time the timeslot is due to end/ended.

Is Active Y indicates an active operation currently occurring in the scope of the timeslot.

Examples:

l A performance test is running.
l A host is rebooting.
Note:You cannot edit an active timeslot.

Modified The date and time on which the timeslot details were last modified.

Modified
By

The user who last modified the timeslot details.

Name The timeslot's name.

Post Run
Action

The action taken after the test completes its run.

Project
Name

The name of the project to which the timeslot belongs.

Requested
Hosts

The number of hosts requested for the timeslot.

Run ID The ID of the run created in the context of the timeslot.

Server End
Time

The date and time that the timeslot is due to end/ended, in terms of the server's time
zone.
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UI
Elements

Description

Server
Start Time

The date and time that the timeslot is due to start/started, in terms of the server's time
zone.

Start Time The date and time that the timeslot is due to start/started.

State The state of the timeslot.

Testing timeslot states:

l None. No entity is linked to the timeslot.
l Not Started. An entity is linked to the timeslot but has not started running.
l <Run states>. Run and post-run states.
Maintenance and data processing timeslot states:

l Active. An operation is running during the timeslot.
l Inactive. No operation is running during the timeslot.

Test ID The ID of the test linked to the timeslot.

Test
Instance ID

The ID of the test instance linked to the timeslot.

Test Name The name of the test linked to the timeslot.

Note: If a test that is linked to a timeslot is deleted, this affects the timeslot.

Test Set ID The ID of the test set linked to the timeslot.

Test Set
Name

The name of the test set linked to the timeslot.

Test
Validity

Indicates whether a linked test set is valid.

Test
Validity

The validity of the test linked to the timeslot.

Timeslot ID The ID of the timeslot.

Timeslot
Type

The type of timeslot: performance testing, maintenance, or data processing.

Timeslot
Validity

The validity of the timeslot based on allocation of resources.

l Y. Indicates that the timeslot is valid, and that all resources were allocated as
requested.

l N. Indicates that a valid timeslot became invalid, due to license, resource, or test
validation issues. In this state, the timeslot is partially allocated. For more
details, see "Understanding Timeslot Failure" on page 626.
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UI
Elements

Description

Total
Vusers

The total number of Vusers reserved for the timeslot.

Vusers
from Test

The number of Vusers defined in the linked performance test.

Timeslots Module Icons
This section describes the icons available in the Timeslots module.

To
access

Use one of the following:

l Maintenance timeslots: On the Lab Management sidebar, under Lab Resources,
select Timeslots.

l Testing timeslots:On the ALM sidebar, under Testing, select Timeslots.

See also "Timeslots ModuleWindow" on page 634

The icons are described below:

UI Elements Description

Indicates a valid timeslot.

Indicates a partially allocated (invalid) timeslot.

Indicates an active timeslot.
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Timeslot Reservation Dialog Box
This dialog box enables you to reserve a testing timeslot and view details of a reserved testing timeslot.

To access l New Testing Timeslot Reservation:
On the ALM sidebar, under Testing, select Timeslots. Then use one of the
following:
l On the Timeslots toolbar, click theNew Timeslot button.
l Calendar view only: Double-click anywhere on the calendar, or right-click
the target time and select New Timeslot.

l Existing Timeslot Reservation:
From Lab Management:On the sidebar, under Lab Resources, select
Timeslots.
From ALM:On the sidebar, under Testing, select Timeslots.
Then use one of the following:
l Grid View: Right-click a testing timeslot and select Timeslot Details.
l Calendar view only: Right-click a testing timeslot (blue, orange, or green)
and select Timeslot Details.

Important
information

l Use this dialog box to reserve or view a testing timeslot.
l Formaintenance timeslots, seeHP ALM LabManagement Guide.
l For data processing timeslots, see "Timeslot Reservation: Data Processing
Dialog Box" on page 656.

Relevant tasks "How to Reserve Testing Timeslots in ALM" on page 632

See also "Reserving Timeslots Overview" on page 622

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Run Choose the type of timeslot to reserve:

l Performance Test. Reserves resources for running a single instance
of a performance test.

l Functional Test Set. Reserves resources for running an entire
functional test set.

l Build Verification Suite. Reserves resources for running a collection
of functional test sets as well as single performance tests, as defined
in the Build Verificationmodule. For more information, see "Build
Verification" on page 603.
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UI Elements Description

Start Choose themethod for executing linked tests or test sets:

l Manually. The timeslot reservation reserves testing resources only.
Youmanually execute the linked test or test sets from the Test Lab
module. For more information on running tests manually, see "Test
Execution Overview" on page 488.

l Automatically. The linked tests or test sets automatically start running
at the start of the timeslot, without any manual intervention. Setting the
test to start automatically enables autostart for the timeslot.

Note: To set autostart retry settings, refer to "Timeslot Settings
Page" inHP ALM LabManagement Guide.

Version Control: The last checked-in version of a test always runs, even
if you have the test checked out at the start of the timeslot. In version-
enabled projects, if a test scheduled to autostart contains scripts that are
checked out, the autostart fails.

Name A descriptive name for the timeslot.

Select a test instance Enables you to link a performance test to the timeslot.

By default, there is no linked test, and the selection appears as none.

You do not have to link a test to the timeslot. However, linking a test gives
you the option of running the test automatically without your manual
intervention. For details, see "Automatic Timeslots" on page 624.

In order to link a performance test to the timeslot, an instance of the test
must be included in a test set. To link the test, click none. A window
displaying the Test Lab tree opens. Navigate to the performance test to
link and click OK.

Note: If youmake changes to the linked test (in the Performance
Test Designer), the timeslot is updated automatically, and you do not
need to relink the test manually. Bear in mind that changing a linked
test might affect the validity of the timeslot.

Version Control:You cannot link a test that is checked out.

Available for:Performance Test timeslots only.
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UI Elements Description

Select a test set Enables you to link a functional test set to the timeslot.

By default, there is no linked test set, and the selection appears as none.

You do not have to link a test set to the timeslot. However, linking a test
set gives you the option of running the test set automatically without your
manual intervention. For details, see "Automatic Timeslots" on page 624.

To select a test set, click none. A window displaying the Test Lab tree
opens. Navigate to the functional test set to link to the timeslot and click
OK.

Note: If youmake changes to the linked test set, the timeslot is
updated automatically, and you do not need to relink the test set
manually. Bear in mind that changing a linked test set might affect the
validity of the timeslot.

Available for: Functional Test Set timeslots only.

Select a build
verification suite

Enables you to link a build verification suite to the timeslot.

By default, there is no linked suite, and the selection appears as none.

You do not have to link a suite to the timeslot. However, linking a suite
gives you the option of running the suite automatically without your
manual intervention. For details, see "Automatic Timeslots" on page 624.

To link a build verification suite, click none. A window displaying the Build
Verification tree opens. Navigate to the build verification suite to link and
click OK.

Note: If youmake changes to the build verification suite, the timeslot
is updated automatically, and you do not need to relink the suite
manually. Bear in mind that changing a build verification suite might
affect the validity of the timeslot.

Version Control:You cannot link a build verification suite that contains
tests that are checked out.

Available for:Build Verification Suite timeslots only.

Test Displays the name and status of a performance test that has been linked
to the timeslot.

To link a different test to the timeslot, click the test name. A window
displaying the Test Lab tree opens. Navigate to the performance test to
link and click OK. To unlink the test, click Clear.

For more information regarding linking performance tests to timeslots, see
Select a test instance above.

Available for:Performance Test timeslots only, and only when a
performance test has been linked to the timeslot.
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UI Elements Description

Vusers Displays the number of Vusers that are defined in the linked test.

To add additional Vusers, click the number field.

Note: The sum of all Vusers reserved for the requested timeslot and
other timeslots must not exceed the limits specified in the project
settings (Lab Settings > Project Settings), andmust not exceed
the number of Vusers specified in the license.

Available for:Performance Test timeslots only, and only when a
performance test has been linked to the timeslot.

VUDs Displays the number of VUDs that are defined in the linked test.

Note: The sum of all VUDs reserved for the requested timeslot and
other timeslots must not exceed the limits specified in the project
settings (Lab Settings > Project Settings), andmust not exceed
the number of VUDs specified in the license.

For more information about VUDs, refer to theHP ALM LabManagement
Guide.

Available for:Performance Test timeslots only, and only when a
performance test has been linked to the timeslot.

Post Run Enables you to define the action to be taken when the performance test
run is complete:

l Collate.When the run has finished, the run results are collected from
all the load generators.

Note: To prevent loss of or inaccessibility to run data, select this
option so that the results are collected immediately upon
completion of the test run.

l Collate and Analyze.When the run has finished, the run results are
collected and analyzed. Data analysis requires some time, depending
on the size of the results file. If there is no timeslot available to include
the data analysis, then select theCollate option instead, and run late
Analysis when a data processor becomes available. You run late
Analysis from the Results tab.

l Do not collate results. Frees themachines immediately after the
performance test ends. When the run has finished, the run results are
left on the load generators. You can analyze the results at a later stage
from the Results tab.

Default value:Collate. Click Collate to change the selection.

Available for:Performance Test timeslots only, and only when a
performance test has been linked to the timeslot.
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UI Elements Description

Test Set Displays the name and status of a functional test set that has been linked
to the timeslot.

To link a different test set to the timeslot, click the test set name. A
window displaying the Test Lab tree opens. Navigate to the test set to link
and click OK. To unlink the test set, click Clear.

For more information regarding linking test sets to timeslots, see Select a
test set above.

Available for: Functional Test Set timeslots only

Build Verification
Suite

Displays the name and status of a build verification suite that has been
linked to the timeslot.

To link a different suite to the timeslot, click the suite's name. A window
displaying the Build Verification Suite tree opens. Navigate to the suite to
link and click OK. To unlink the suite, click Clear.

For more information regarding linking suites to timeslots, see Select a
build verification suite above.

Available for:Build Verification Suite timeslots only, and only when a
suite has been linked to the timeslot.

AUT Env.
Configuration

Enables you to select an AUT environment configuration for the timeslot.

By default, there is no configuration selected, and the selection appears
as none.

To link an AUT Environment Configuration, click the [none] link. A
window displaying the AUT Environments tree opens. Navigate to the
AUT environment configuration to add and click OK.

For more information regarding AUT Environments, see "How toWork
with AUT Environments" on page 325.

Available for:All timeslots types, but only when an entity has been
linked to the timeslot.
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UI Elements Description

Deployment When your system is integrated with HP Continuous Delivery Automation
(CDA), these options enable you to select deployment actions for the
application under test. For more information on the integration between
AUT environment configuration and CDA, see "How toWork with
AUT Environments" on page 325.

ALM provides the following options for deployment:

l Provision and deploy. Allocates machines on which to deploy the
application under test, and prepares the required image so that the
application can be installed. That is, the operating system, database
server and all required software are installed based on
CDA parameters. Following provisioning, the application under test
itself is installed.

l Redeploy. Deploys and runs the application under test environment on
machines that have already been provisioned.

l Use deployed environment. Uses an existing installation to run the
test.

When you select an option, the environment name appears in blue. Click
the name to change the selection.

Note:

l When deciding which option to select, bear in mind that the
provisioning and deployment actions can be very time consuming.
For routine testing, it is advisable to select Use Deployed.

l You can arrange for an environment to be deployed and available
for your run. Schedule a build verification suite or test set to run for
the entire day, and select the environment you want to use.

Deprovisioning When your system is integrated with HP Continuous Delivery Automation
(CDA), these options enable you to select the action to be taken after an
environment has been deployed. For more information on the integration
between AUT environment configuration and CDA, see "How toWork
with AUT Environments" on page 325.

ALM provides the following options for deprovisioning:

l Leave environment deployed. Leaves the AUT environment
deployed indefinitely. The deployed environment can be used for future
tests.

l Deprovision at end. After the tests have completed running, the
environment is undeployed and themachines are deprovisioned,
freeing them up for other use.
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UI Elements Description

Duration The duration of the timeslot, in hours andminutes.

Click theSuggested Duration icon to open the Suggested Duration
dialog box. For details, see "Suggested Duration Dialog Box" on
page 566.

Note: A timeslot can be reserved for aminimum of 15minutes and
maximum of 480 hours (20 days).

Start Time The date and time (in hours andminutes) that the timeslot starts.

End Time The date and time (in hours andminutes) that the timeslot ends.

Automatically Extend
Timeslot

If enabled, the testing timeslot will be automatically extended if tests are
still running when the timeslot is about to end. For the timeslot to extend
successfully, the necessary testing resources must be available in the
timeslot extension. For more information, see "Extending Timeslot
Reservations" on page 625.

Available for: Functional test sets and Build Verification Suites.

Opens the Select Automatch LoadGenerators/Edit Hosts dialog box,
enabling you to select automatch load generators/hosts with specific
properties for the timeslot. For more details, see "Select Automatch Load
Generators/Edit Hosts Dialog Box" on page 660.

Note: Performance Test timeslots must include at least one load
generator (automatch or specific), and Functional Test Set or Build
Verification Suite timeslots must include at least one host (automatch
or specific).

Available for: For new, open, or future testing timeslots

Opens the Select Specific Hosts dialog box or Select Specific Load
Generator/Host dialog box, enabling you to select specific load
generators/hosts for the timeslot. For more details, see "Select Specific
Hosts Dialog Box" on page 655 and "Select Specific Load
Generators/Hosts Dialog Box" on page 661.

Note: Performance Test timeslots must include at least one load
generator (automatch or specific), and Functional Test Set or Build
Verification Suite timeslots must include at least one host (automatch
or specific).

Available for: new, open, or future testing timeslots

Enables you to edit the selected host request.
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UI Elements Description

Remove. Removes selected load generators/hosts.

Note: Performance Test timeslots:You can change the selected
Controller, but you cannot delete it.

Set Start Time as Now. Selects the current time in the resource
availability chart.

Note: A timeslot whose start time is set to the current time opens
immediately upon submitting the reservation.

Calculates the availability of the requested resources for the selected
timeslot. The results are displayed graphically on the resource availability
chart, and amessage is displayed in the Timeslot Status tab.

The availability timeline displays all timeslots when the requested hosts
can be reserved. Even if the requested hosts cannot be reserved for the
selected timeslot, they may be available at other times.

<Message bar> Located at the top of the dialog box. Displays messages and warnings
about the timeslot.

Available for:Existing timeslots only.

<Resource
availability timeline>

Displays the availability of requested resources on a timeline:

l Availability not calculated. Displayed on the timeline before you
calculate the availability of the requested resources for a new timeslot,
or whenmodifying a timeslot.
This is not displayed for Data Processing timeslots.

l Start Times. Indicates available start times for the timeslot, when
the requested resources are available.

l Insufficient Resources. Indicates that not all the requested
resources are available at the start times indicated on the timeline.

l Unknown. Displayed before calculating the availability of the
requested resources for the timeslot.

l License/Project Limit. Indicates license or project limit issues at
the start times indicated on the timeline.
Example.More hosts requested than available in the license limit.

l Unavailable Resource. Indicates that a requested resource is not
available at the start times indicated on the timeline.

ID The ID of the timeslot.
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UI Elements Description

Requested Hosts grid Displays the resources requested for the timeslot.

For Performance Test timeslots, an automatch Controller is selected by
default. You can change this by browsing for a specific Controller.

Note: Resources that are defined as part of a linked entity's creation
(such as resources that are requested for a functional test set in the
Test Labmodule's Required Hosts tab) are automatically displayed in
the grid. These pre-selected resources are indicated by an asterisk.

Timeslot Status tab Displays the status of the timeslot reservation.

For details about timeslot failure, see "Understanding Timeslot Failure" on
page 626.

Description tab Describes the currently selected timeslot.

Tip: Right-clicking in this area displays a toolbar for formatting and
spell checking the text.

Additional Details tab Displays additional details related to the timeslot.

Available for:Existing timeslots only.

Event Log tab Displays a log of events related to the timeslot. For details, refer to theHP
ALM LabManagement Guide.

Available for: Existing timeslots only.

Select Specific Hosts Dialog Box
This dialog box enables you to reserve specific hosts for a timeslot.

To access 1. On the ALM sidebar, under Lab Resources, select
Timeslots.

2. On the toolbar, click theNew Timeslot button.
3. Above the Requested Hosts grid, click

.

Relevant tasks HP ALM LabManagement Guide

See also "Reserving Timeslots Overview" on page 622
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Refresh All. Refreshes the grid so that it displays themost up-to-date list of hosts
based on the filters you have selected.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For more details, see the "Select
Columns/Select Fields Dialog Box" on page 77.

For details about the Host fields, refer to theHP ALM LabManagement Guide.

Filter/Sort. Enables you to filter and sort the hosts in the grid. Any currently applied
filters or sorting orders are displayed below the toolbar. For details about filtering
options, see the "Filter Dialog Box" on page 51.

View
menu

Enables you to:

l Show/hide the grid filters
l Show/hide the Summary panel which displays the selected hosts
l Filter/sort and the grid
l Refresh the grid
l Select columns to view in the grid

<Hosts
grid>

Displays the hosts available for the reservation.

Tip: To select multiple hosts, hold down the CTRL button on your keyboard while
selecting hosts in the list.

Selected
pane

Displays the hosts selected in the grid.

Timeslot Reservation: Data Processing Dialog Box
This dialog box enables you to view the details of an open or past data processing timeslot.

To access From Lab Management:On the sidebar, under Lab Resources, select
Timeslots.

From ALM:On the sidebar, under Testing, select Timeslots.

Then use one of the following:

l Grid view: Right-click a timeslot of typeData Processing and select
Timeslot Details.

l Calendar view only: Right-click a data processing (lilac) timeslot and select
Timeslot Details.
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Important
information

l Use this dialog box to view the details of a current or past data processing
timeslot.

l For testing timeslots, see " Timeslot Reservation Dialog Box" on page 647.
l Formaintenance timeslots, seeHP ALM LabManagement Guide.
l Data Processing timeslots are available only for Performance Tests.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Run Indicates that the timeslot is a data processing type.

Note: This field is disabled and the selection cannot be changed.

Start Indicates that the data processing tasks are performed automatically.

Note: This field is disabled and the selection cannot be changed.

Name A descriptive name for the timeslot. The name is given to the timeslot according to
data processing task at hand.

Duration The duration of the data processing timeslot, in hours andminutes.

Note: A duration of a data processing timeslot is determined internally by the
system, depending on the processing task at hand.

Start Time The date and time (in hours andminutes) that the timeslot started.

End Time The date and time (in hours andminutes) that the timeslot ended or is scheduled to
end.

<Message
bar>

Located at the top of the dialog box. Displays messages and warnings about the
timeslot.

Available for:Existing timeslots only.

User Guide
Chapter 38: Reserving Timeslots

HP ALM (12.50) Page 657



UI Elements Description

<Resource
availability
timeline>

Displays the availability of requested resources on a timeline:

l Availability not calculated. Displayed on the timeline before you calculate the
availability of the requested resources for a new timeslot, or whenmodifying a
timeslot.

l Start Times. Indicates suggested start times for the timeslots, when the
requested resources are available.

l Insufficient Resources. Indicates that not all the requested resources are
available at the start times indicated on the timeline.

l License/Project Limit. Indicates license or project limit issues at the start
times indicated on the timeline. For example, more hosts requested than
available in the license limit.

l Unknown. Displayed before calculating the availability of the requested
resources for the timeslot.

l Unavailable Resource. Indicates that a requested resource is not
available at the start times indicated on the timeline.

Requested
Hosts grid

Displays the data processor host reserved for the timeslot.

Note: The data-processor host is selected automatically by the system.

Timeslot
Status tab

Displays the status of the timeslot reservation.

For details about timeslot failure, see "Understanding Timeslot Failure" on
page 626.

Description
tab

Describes the currently selected timeslot.

Tip: Right-clicking in this area displays amenu for formatting and spell
checking the text.

Additional
Details tab

Displays additional details related to the timeslot.

Available for:Existing timeslots only.

Event Log tab Displays a log of events related to the timeslot. For details, refer to theHP ALM
LabManagement Guide.

Available for:Existing timeslots only.

Select Controller Dialog Box
This dialog box enables you to select a Controller for a performance testing timeslot.
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To access 1. On the ALM sidebar, under Testing, select Timeslots.

2. On the toolbar, click New Timeslot .
3. In the upper left corner of the dialog box, select Run > Performance Test.
4. In theRequested Hosts grid, click theController's Properties column, and

click the gray box that appears.

Important
information

If you select a Controller host that has multiple purposes (C+LG+DP), it is
recommended to dedicate the host for Controller functionality, and not to select it for
other functionality as well, to avoid performance issues during runtime.

This dialog box is available for performance testing timeslots only.

Relevant
tasks

"How to Reserve Testing Timeslots in ALM" on page 632

See also "Reserving Timeslots Overview" on page 622

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Refresh All. Refreshes the grid so that it displays themost up-to-date list of
Controller hosts based on the filters you have selected.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For more details, see the "Select
Columns/Select Fields Dialog Box" on page 77.

For details about the host fields, refer to theHP ALM LabManagement Guide.

Filter/Sort. Enables you to filter and sort the Controller hosts in the grid. Any
currently applied filters or sorting orders are displayed below the toolbar. For details
about filtering options, see the "Filter Dialog Box" on page 51.

<Host grid> Lists all the specific Controller hosts.

Note: Enabled whenSpecific is selected.

Select a
Controller
for the
timeslot

l Automatch. Enables the system to allocate an available Controller for the
timeslot.

l Specific. Enables you to select a specific Controller for the timeslot.

Reserve as
C + LG

Allows the selected host to serve both as a Controller and as a load generator.

Note: This option is not recommended. The Controller host should be dedicated
for Controller functionality, and it is recommended not to run Vusers on this host.
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Select Automatch Load Generators/Edit Hosts Dialog Box
This dialog box enables you to select automatch load generators for a Performance Test timeslot, or
automatch hosts for Functional test Set or Build Verification Suite timeslots.

To access 1. On the ALM sidebar, under Lab Resources, select Timeslots.
2. On the toolbar, click theNew Timeslot button.
3. In theRequested Hosts grid, click Add Automatch LG (for Performance Test

timeslots), orAdd Automatch Hosts (for Functional Test Set or Build
Verification Suite timeslots).

Important
information

Specific load generators/hosts matching the automatch load generators'/hosts'
properties are allocated in place of the automatch load generators/hosts.

Relevant
tasks

"How to Reserve Testing Timeslots in ALM" on page 632

See also "Reserving Timeslots Overview" on page 622

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Reserve <xx> load
generators/hosts...

The number of automatch load generators/hosts to reserve for the timeslot.

Note: Performance Testing timeslots: The total number of hosts
(Controller + load generators) reserved for the timeslot may not exceed
the Performance Center host and host pool limits of the project, as
defined in the project's settings. For more details, refer to theHP ALM
LabManagement Guide.

Tip: To select multiple automatch load generators/hosts with the same
properties, you can do one of the following:

l In theReserve <xx> box, enter 1, and select the relevant properties.
Repeat this for the other automatch load generators/hosts. If you do
this five times, for example, then five identical automatch load
generators/hosts are displayed in the Requested Hosts grid.

l In theReserve <xx> box enter the number of automatch load
generators/hosts you want to select with the same properties. For
example, enter 5. One entry is displayed in the Requested Hosts grid,
representing all five automatch load generators/hosts.
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UI Elements Description

<Load
Generator/Host
Properties>

Enables you to specify properties for the requested automatch load
generators/hosts:

l Purpose. The purpose of the host, depending on the type of tests that are
linked to the timeslot.
Available from:Edit Hosts dialog box.

l Location. The location of the load generators/hosts. To find a specific

location, enter the value in the Find box, and click .
l Host Attributes. Load generator/host attributes.
The list of attributes can be customized. For details, refer to theHP ALM
Performance Center Guide.

Note: If no properties are specified, any available load generators/hosts
are allocated.

Select Specific Load Generators/Hosts Dialog Box
This dialog box enables you to reserve specific load generators/hosts for a testing timeslot.

To access 1. On the ALM sidebar, under Lab Resources, select Timeslots.

2. On the toolbar, click New Timeslot .
3. In theRequested Hosts grid, click Add Specific LG (for Performance Test

timeslots), orAdd Specific Hosts (for Functional Test Set or Build Verification
Suite timeslots).

Important
information

l To avoid a timeslot becoming partially allocated in the case that a specific load
generator/host unexpectedly becomes unavailable, it is recommended to rather
reserve automatch load generators/hosts. For details about selecting automatch
load generators/hosts, see "Select Automatch LoadGenerators/Edit Hosts Dialog
Box" on the previous page.

l This dialog box is available for testing timeslots only.

Relevant
tasks

"How to Reserve Testing Timeslots in ALM" on page 632

See also "Reserving Timeslots Overview" on page 622

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Refresh All. Refreshes the grid so that it displays themost up-to-date list of load
generators/hosts based on the filters you have selected.
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UI
Elements

Description

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For more details, see "Select
Columns/Select Fields Dialog Box" on page 77.

For field details, refer to theHP ALM LabManagement Guide.

Filter/Sort. Enables you to filter and sort the load generators/hosts in the grid. Any
currently applied filters or sorting orders are displayed below the toolbar. For details
about filtering options, see "Filter Dialog Box" on page 51.

View menu Enables you to:

l Show/hide the grid filters
l Show/hide the Summary panel which displays the selected load generators
l Filter/sort and the grid
l Refresh the grid
l Select columns to view in the grid

<Specific
load
generators
grid>

Displays the specific load generators/hosts available for the reservation.

Tip: To select multiple hosts, hold down the CTRL button on your keyboard while
selecting load generators in the list.

Selected
pane

Displays the load generators/hosts selected in the grid.

Time Zone Options Dialog Box
This dialog box enables you to display an additional time zone in the Timeslots module calendar view.

To access In the Timeslots module, in calendar view, select Tools > Time Zone Options.

Available from:Calendar view only

Important
information

Displaying an additional time zone is useful if you are located in a different time
zone to the ALM server or other users.

The default time displayed on the calendar is based on the time of the local client
machine.

See also "Reserving Timeslots Overview" on page 622
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User interface elements are described below:

UI Elements Description

Show additional time
zone

When selected, enables you to select an additional time zone to display in
the calendar view.

Time zone label The label by which to display the additional time zone in the calendar view.

Available:When Show additional time zone is selected.
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Chapter 39: Viewing Test Runs
This chapter includes:

• Test Runs Overview 668
• How to View Test Runs 668
• Test Runs User Interface 671

HP ALM (12.50) Page 667



Test Runs Overview
After running tests, you can view the results in the Test Runsmodule in HP Application Lifecycle
Management (ALM). The Test Runsmodule contains tabs which let you study the results of test
instance runs, test set runs, and build verification suite runs.

ALM Editions: The Test Set Runs andBuild Verification Suite Runs tabs are available only for
ALM Edition. For more information about ALM editions and their functionality, see "ALM Editions"
on page 115. To find out what edition of ALM you are using, ask your ALM site administrator.

In the Test Runs tab, you can view the results of test executions.

l Manual test results consist of the overall pass/fail status of a test and the pass/fail status of each
step in a test run.

l The results available for automatic tests vary depending on the test type.
These results help you determine whether a defect was detected in your application. In some cases,
youmay decide that a step failed because the expected results are no longer valid and need to be
updated.

Following the execution of manual and automated tests, you can view results and general information
for a test run. You can view test run details, compare the results of themost recent test run with
previous runs, manage attachments, view and edit test run configuration information, manage linked
defects, and view a history of test run changes.

You can also view and compare the results of all runs in your project displayed in a grid. You can then
filter the grid to display only those runs that meet the criteria that you define.

In the Test Set Runs andBuild Verification Suite Runs tabs, you can view the results of functional
test set and build verification suite executions. You can also stop a functional test set or build
verification suite run, or go to a specific functional test set or build verification suite.

In addition, you can analyze the progress of a test set or of overall test execution in your project by
periodically generating execution reports and graphs. For details, see "How to Analyze Data in ALM" on
page 718.

For related task details, see "How to View Test Runs" below.

How to View Test Runs
This task describes how to view test run results. To learnmore about test results, see "Test Runs
Overview" above.

Note: This task is part of a higher-level task. For details, see "How to Run Tests in ALM" on
page 490.

User Guide
Chapter 39: Viewing Test Runs

HP ALM (12.50) Page 668



This task includes the following steps:

l "View results for a test instance run" below
l "View results for a Functional test set run" below
l "View results for a build verification suite run" below
l "Manage linked defects" on the next page
l "Purge test runs - optional" on the next page

View results for a test instance run
After running a test, you can analyze the execution results to determine which steps succeeded and
which tests failed.

1. On the ALM sidebar, under Testing, select Test Runs. Go to the Test Runs tab. For user
interface details on the Test Runs tab, see "Test Runs ModuleWindow" on page 672.
Filter and sort the grid to display only those runs that meet your criteria. For example, you can
define filters to display:
l Tests that are currently running
l Failed runs
l Runs executed this month
For user interface details on filtering data, see "Filter Dialog Box" on page 51.

2. Select a test run and click Details to view detailed run results. For user interface details on the
Run Details dialog box, see "Run Details Dialog Box" on page 681.

View results for a Functional test set run

ALM Editions: The Test Set Runs tab is available only for ALM Edition. For more information
about ALM editions and their functionality, see "ALM Editions" on page 115. To find out what
edition of ALM you are using, ask your ALM site administrator.

After running a test set, you can analyze the test set results to determine which tests in a test set
failed, and which steps caused the failure.

1. On the ALM sidebar, under Testing, select Test Runs. Go to the Test Set Runs tab. For user
interface details on the Test Set Runs tab, see "Test Runs ModuleWindow" on page 672.

2. To see the execution report of a test set run, select the run and click Show Report. To see a soft
copy of an executed run, select the run and click Export Run. You can also see the execution
report of a test set run by clicking the Last Run Report button in theExecution Grid tab in the
Test Labmodule.
For more information on the execution report, see "Execution Report Page - Desktop Client" on
page 567.

For user interface details on the Test Runs tab, see "Test Runs ModuleWindow" on page 672.

View results for a build verification suite run

ALM Editions: TheBuild Verification Suite Runs tab is available only for ALM Edition. For more
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information about ALM editions and their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site administrator.

After running a build verification suite, you can analyze the build verification suite results to determine
which test runs in a build verification suite failed, and which steps caused the failure.

1. On the ALM sidebar, under Testing, select Test Runs. Go to theBuild Verification Suite Runs
tab. For user interface details on the Build Verification Suite Runs tab, see "Test Runs Module
Window" on page 672.

2. To see the execution report of a build verification suite run, select the run and click Show Report.
To see a soft copy of an executed run, select the run and click Export Run. You can also see the
execution report of a build verification suite run by clicking the Last Run Report button in the
Build Verification module.
For more information on the execution report, see "Execution Report Page - Desktop Client" on
page 567.

For user interface details on the Test Runs Module, see "Test Runs ModuleWindow" on page 672.

Manage linked defects
You can view, add, and remove defect links for test runs and test run steps. In the Test Details dialog
box, the Run Details dialog box, or the Run Step Details dialog box, click the Linked Defects button on
the sidebar.

l For user interface details on linking defects, see "Linked Defects/Entities Page" on page 710.
l For user interface details on the Test Details dialog box, see "Test Instance Details Dialog Box" on
page 530.

l For user interface details on the Run Details dialog box, see "Run Details Dialog Box" on page 681.
l For user interface details on the Run Step Details dialog box, see "Run Step Details Dialog Box" on
page 684.

Purge test runs - optional
You can delete old runs from your project.

Select a run and then click theDelete button.

Note:

l You can only use purge runs for test runs, not test set or build verification suite runs.
l You cannot delete test runs which are part of a currently running test set run or build verification
suite run.

l If you delete a test set run or build verification suite run, the underlying test runs will be deleted.
Similarly, if you delete a build verification suite run, the underlying test set runs will be deleted.

Alternatively, the Purge Runs wizard enables you to select one or more runs to delete. Use one of the
following:
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l In the Test Lab > Test Sets tab, select Test Sets > Purge Runs.
l In the Test Runs > Test Runs tab, select Test Runs > Purge Runs.
For user interface details on the Purge Runs wizard, see "Purge Runs Wizard" on page 686.

Test Runs User Interface
This section includes:

• Test Runs ModuleWindow 672
• Test Runs ModuleMenus and Buttons 675
• Test Runs Module Fields 678
• RunDetails Dialog Box 681
• Run Step Details Dialog Box 684
• Test Set/BVS RunDetails Dialog Box 685
• Purge Runs Wizard 686
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Test Runs ModuleWindow
This module enables you to view the results of test runs, test set runs, and build verification suite runs.

To access On the ALM sidebar, under Testing, select Test Runs. Select one of the following
tabs.

l Test Runs. Enables you to view your test runs.
l Test Set Runs. Enables you to view your Functional test set runs.
l Build Verification Suite Runs. Enables you to view your build verification suite
runs.

Important
information ALM Editions: Formore information about ALM editions and their functionality,

see "ALM Editions" on page 115. To find out what edition of ALM you are using,
ask your ALM site administrator.

The Test Set Runs andBuild Verification Suite Runs tabs are available only for
ALM Edition.

Relevant
tasks

"How to View Test Runs" on page 668

See also "Test Runs Overview" on page 668

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Test Runs
tab

Displays the test runs.

Test Set
Runs tab

Displays the Functional test set runs.

Test runs are also displayed as test set runs in the Test Set Runs tab.

Build
Verification
Suite Runs
tab

Displays the build verification suite runs.

<Test Runs
module
common
UI
elements>

l Test Runs module fields. For field definitions, see "Test Runs Module Fields" on
page 678.

l Test Runs module menus and buttons. For command and button descriptions,
see "Test Runs ModuleMenus and Buttons" on page 675.

l ALM masthead, menus, and sidebar. For details, see "ALM Common Areas" on
page 32.
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UI Element Description

<Legend> Displays the test run status categories and their corresponding color.

Available from: Test Runs tab.

<Filter
status bar>

Describes the filter currently applied to the grid. Located directly above the grid.

Showing <x> results. Indicates the number of records currently displayed out of the
total records.

Retrieve all <x> results. Click to display all records.

<Grid
filters>

Displays a grid filter box under each column name, enabling you to define a filter
condition for a column.

Type directly into the box, or click the box to display the browse button, which opens
the Select Filter Condition dialog box. For more details, see "Select Filter Condition
Dialog Box" on page 61.

Show/Hide. Displays or hides additional tabs in the lower pane of the window.

Comments Comments about the currently selected run.

Click in the text box to display a toolbar for formatting and spell checking the text.

Available from: Test Runs tab.
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UI Element Description

Report
(Test Runs
tab)

Displays results and details of the selected run.

l For a test run with Sprinter, also displays the LaunchSprinter Results Viewer
button, which opens and displays the report in the Sprinter Results Viewer. For
details, click the help button within the viewer.

ALM Editions:Sprinter functionality is not available with Performance Center
Edition. For more information about ALM editions and their functionality, see
"ALM Editions" on page 115. To find out what edition of ALM you are using,
ask your ALM site administrator.

l For automated test instances, also includes one of the following:

l Opens and displays the results in LoadRunner Analysis.
Available for the LR-SCENARIO test type.

l Opens and displays the report in UFT . Available for the
GUI-TEST test type.

The Launch Report button is only enabled if you have installed the Unified
Functional Testing Add-in from the HP Application Lifecycle Management Add-
ins page. For more details on installing add-ins, refer to theHP Application
Lifecycle Management Installation and UpgradeGuide.

l Collected System Info link. Opens the System Information dialog box.
Displays the collected system information, such as CPU, memory, and
processes running on themachine when the test is run. Available for the
SYSTEM-TEST test type.

l Captured Desktop Image. Opens the captured image of themachine
executing the system test. Available for the SYSTEM-TEST test type.

l For external type tests (EXTERNAL-TEST), also displays the following links:

l Opens Jenkins and displays the run
results.

l Opens the file system and
displays the run results and additional test data (for example, snapshots). This
path is defined in the Importing External Test Results dialog box. For more
details, see "Import External Test Results Dialog Box" on page 600.

For more details on external testing, see "Integrating External Tests Overview" on
page 594.
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UI Element Description

Results Displays the results of the last test criteria run for the selected run.

Business Process Testing: Functionality related to test criteria is available only for
business process tests. For details, see theHP Business Process Testing User
Guide.

Available from: Test Runs tab.

History Lists changes made to the currently selected run. For details, see "History Tab" on
page 68.

Available from: Test Runs tab.

Event Log Displays a list of the events that were logged during the selected run. For details, see
theHP ALM LabManagement Guide.

Available from: Test Set Runs tab.

Results Enables you tomanage result files generated during the selected test run.

Available from: Test Runs tab.

Test Runs Module Menus and Buttons
This section describes themenus and buttons available in the Test Runs module.

To access On the ALM sidebar, under Testing, select Test Runs.

Important
information ALM Editions: The Test Set Runs andBuild Verification Suite Runs tab are

avaialble only in ALM Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

Relevant
tasks

"How to View Test Runs" on page 668

See also "Test Runs Overview" on page 668

Commonmenus and toolbars of the Test Runs module are described below:

UI Elements (A-Z) Where Description

Add to Favorites Favorites Opens the Add Favorite dialog box, enabling you to add a
favorite view to your private or the public folder. For
details, see the "Add Favorite Dialog Box" on page 94.
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UI Elements (A-Z) Where Description

Copy URL
Test Runs
and <right-
click
menu>

Copies a selected run and pastes its URL as a link. The
test run itself is not copied. Instead, you can paste the
address into another location, such as an email or a
document. Clicking the link opens up ALM and takes you
to the run file or folder. If you are not already logged in,
ALM first prompts for login details.

Delete
Edit and
<right-click
menu>

Deletes the selected run or runs.

Note: Only enabled when the selected run is not in
one of the active states.

<toolbar>

Test Runs
tab only

If you analyze a test run after it has run, recalculate the
SLA, or add the run to a trend report, the action is added
to a data processing queue. Adding the action to the
queue enables you to see when the action will be
performed.

Available for: Performance Center

Export Edit (Test
Runs tab)
 and <right-
click
menu>

Opens the Export All Grid Data dialog box, enabling you
to export the runs in the grid as a text file, Microsoft Excel
worksheet, Microsoft Word document, or HTML
document.

Select one of the following options:

l All. Exports all runs in the grid.
l Selected. Exports selected runs in the grid.

Export Report
<toolbar> Creates a soft copy of the selected run report.

Find
View Opens the Find dialog box, enabling you to search runs in

themodule. For details about search options, see the
"Find Dialog Box" on page 63.

<toolbar>

Test Runs
tab

Opens the Test Labmodule, displaying the selected test
instance in theExecution Grid.

Go to Run
Runs Opens the Go ToRun dialog box, enabling you to find a

specific run by its ID number. You can only go to runs
that are in the current filter.

Go to Timeslot
<right-click
menu>

Opens the Timeslots module, displaying the timeslot for
the selected run.
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UI Elements (A-Z) Where Description

Go to Test
Set/Build
Verification Suite

<toolbar>

Test Set
Runs tab
and Build
Verification
Suite Runs
tab

Opens the Test Labmodule, displaying the test set or
build verification suite for the selected run.

Grid Filters View and
<right-click
menu>

Enables you to filter the data according to an entry in the
filter box. For details about filtering options, see the
"Select Filter Condition Dialog Box" on page 61.

Information Panel View and
<right-click
menu>

Shows/Hides the Information Panel in the lower area of
themodule window.

Organize Favorites Favorites Opens the Organize Favorites dialog box, enabling you to
organize the list of favorite views by changing properties
or deleting views. For details, see the "Organize
Favorites Dialog Box" on page 95.

<toolbar>

Test Runs
tab only

Enables you to create trend reports in order to identify
performance improvements and regressions. For more
information about trending, seeHP ALM Performance
Center Guide.

Available for: Performance Center

Private Favorites Lists the favorite views that are accessible only to the
user who created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All
View Refreshes the grid so that it displays themost up-to-date

information.

Run Details
Runs and
<right-click
menu>

Opens the Run Details dialog box, enabling you to view
and edit details of the selected run.

Run Screen
<right-click
menu>

Test Runs
tab only

Opens the Performance Test Run screen, enabling you to
view andmanage the test run. For more information, refer
to theHP ALM Performance Center Guide.

Note: Only enabled when the test run is in the
Running state.
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UI Elements (A-Z) Where Description

Select Columns
View Opens the Select Columns dialog box, enabling you to

determine which fields to display in the grid and their
order. For more details, see the "Select Columns/Select
Fields Dialog Box" on page 77.

For details about the test run fields, see "Test LabModule
Fields" on page 513.

Set Filter/Sort
View Enables you to filter and sort the runs in the grid. Any

currently applied filters or sorting orders are displayed
below the toolbar. For details, see "Filter Dialog Box" on
page 51.

Show Report
<toolbar>

Test Set
Runs and
Build
Verification
Suite Runs
tabs only

Shows an execution report of the selected run. For more
information, see "Execution Report Page - Desktop
Client" on page 567.

Stop Run
<toolbar> Stops execution of the selected run.

Note: Only enabled when the selected run is in the
Initializing, Running, orStopping states.

Test Runs Module Fields
This section describes the Test Runs module fields.

To access On the ALM sidebar, under Testing, select Test Runs.

Important
information

The Test Runs tab is available in all editions, but the Test Set Runs andBuild
Verification Suite Runs tabs are available only for ALM Edition. Some of the fields
below are available only in the Test Set Runs and Build Verification Suite Runs tabs.

See also "Test Runs ModuleWindow" on page 672

The fields are described below:

UI Element (A - Z) Description

Build verification
suite name

The name of the build verification suite.

Completed
Successfully

Indicates whether the selected run completed with a status of Passed.
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UI Element (A - Z) Description

Configuration: Name The name of the test configuration allocated to the selected test run.

Draft Run Indicates whether the selected test run is a draft run. For more details, see
"Draft Runs" on page 489.

Default value:N

Duration The test run time, in seconds.

Note: You should not manually edit this field.

End Date The end date of the run.

Note: You should not manually edit this field.

Environment The default environment on which the tests in the test set run.
Environments are a combination of operating systems, browsers, and so
on, on which you test the application.

Note: Environments are defined using the ALM WebClient. After they
are defined, you can select them in the Test Runs module.

Exec Date The date on which the test was last executed.

Exec Time The time the test was last executed.

External Build /
Version Number

Indicates unique identifier for the imported test runs. For example, a build
number of the application that was tested.

Available for:EXTERNAL-TEST test type

External Results
Network Path

Indicates the network path where additional test data is stored (for
example, attachments).

Available for:EXTERNAL-TEST test type

Host The name of themachine on which a test run was executed.
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UI Element (A - Z) Description

Iterations Status Business Process Testing:

In the Manual Runner dialog box: A rich text field in which you can enter
comments about the status of each iteration.

In the Test Instance Details dialog box: The statuses of the test
iterations in a bar format. The bar is divided into colors that represent the
statuses of the runs and the number represents the number of iterations
with each status.

Legend:

l Passed. Green
l Failed. Red
l Blocked. White
l Not Completed. Purple
l No Run. Orange
l N/A. Yellow
See also: "Legend " on page 534

Jenkins Job Name The name of the Jenkins job uploaded that uploaded the run results to ALM.

Available for:EXTERNAL-TEST test type

Jenkins Run Results
URL

The URL for displaying the build from Jenkins.

Available for:EXTERNAL-TEST test type

Run ID A unique numeric ID for the run, assigned automatically by ALM. This
number is automatically generated by the system when the run starts
executing.

You can click on the Run ID field in theExecution Report grid to navigate
to the test instance run in the Test Runs tab.

Run Name The name of the test run. Fast_run indicates that ALM created this run
when a user changed theStatus field of the test instancemanually without
running the test.

The icon displayed indicates one of the following:

l The test type. For details, see "Test Types" on page 351.

l A manual test run with Sprinter . For details on Sprinter, see "HP
Sprinter Overview" on page 575.

Start time The start time of the run.

Note: You should not manually edit this field.
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UI Element (A - Z) Description

State Indicates progress of a run. Possible values are: Initializing, Running,
Stopping, Run Failure, Finished. This is a read-only field.

Status (for a test
instance, test set, or
build verification
suite run)

Indicates execution status of a test instance, test set, or build verification
suite run. Execution status can be one of the following:

l Blocked. One or more steps cannot run. For example, the test is running
on a remotemachine but cannot continue due to some environmental
failure, such as network problems or hardware failure.

l Failed. One or more steps in the run failed, and none have the status
Blocked.

l N/A. The current status is not applicable. No steps exist, or a step has
an execution status of N/A.

l No Run. No steps have been run.
l Not Completed. One or more steps were not completed or not run, and
none have the status Blocked or Failed.

l Passed. The run was successful. All the steps have an execution status
of Passed.

Test Set The name of the test set.

Test Set: Name The name of the test set associated with the selected test run.

Test: Test Name The name of the test associated with the selected test run.

Tester The username of the person running the test.

Run Details Dialog Box
This dialog box displays test and step details for a test run.

To access In Testing > Test Runs, click Test Runs. Select a run and click Run

Details .

Important
information

The buttons and options available may vary according to test type or runner.

Relevant tasks "How to View Test Runs" on page 668

See also l "Test LabModule Fields" on page 513
l "Test Runs Overview" on page 668
l "Run Step Details Dialog Box" on page 684
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User interface elements are described below:

UI Element Description

Save. Saves the details.

First/Previous Next/Last Entity. Allows you to browse through the runs in
the grid.

Flag for Follow Up. Opens the Flag for Follow Up dialog box, enabling you to
define a follow up flag for the run. For more details, see "Flag For Follow Up
Dialog Box" on page 89.

Send by Email. Opens the Send E-mail dialog box, enabling you to send a
run by email to recipients selected from a list. For more details, see "Send E-
mail Dialog Box" on page 69.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Details Displays details of the run. For details on the available fields, see "Test Lab
Module Fields" on page 513.

Click in theComments box to display a toolbar for formatting and spell
checking the text.
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UI Element Description

Report Displays results and test step details of the run.

l For automated test instances, also includes one of the following:

l Opens and displays the results in LoadRunner
Analysis. Available for the LR-SCENARIO test type.

l Opens and displays the report in UFT . Available
for the GUI-TEST test type.

The Launch Report button is only enabled if you have installed the Unified
Functional Testing Add-in from the HP Application Lifecycle
Management Add-ins page. For more details on installing add-ins, refer to
theHP Application Lifecycle Management Installation and Upgrade
Guide.

l Collected System Info link. Opens the System Information dialog
box. Displays the collected system information, such as CPU,
memory, and processes running on themachine when the test is run.
Available for the SYSTEM-TEST test type.

l Captured Desktop Image. Opens the captured image of themachine
executing the system test. Available for the SYSTEM-TEST test type.

l For external type tests (EXTERNAL-TEST), also displays the following
links:

l Opens Jenkins and displays the
run results.

l Opens the file system and
displays the run results and additional test data (for example,
snapshots). This path is defined in the Importing External Test Results
dialog box. For more details, see "Import External Test Results Dialog
Box" on page 600.

For more details on external testing, see "Integrating External Tests
Overview" on page 594.

Results Performance Center:Enables you tomanage result files generated during
the selected test run

Note: This tab is only available from the Test Runs tab.

Event Log Displays a list of the events that were logged during the selected run. For
details, see theHP ALM LabManagement Guide.
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UI Element Description

Steps Displays test step details and results for the run. To view detailed results for

the step, select a step from the grid and click theDetails button. For
more details, see "Run Step Details Dialog Box" below.

Note: Not available for runs of some test types and runners.

Attachments Lists attachments that provide additional information about the run. For
details, see "Attachments Page" on page 72.

Parameters Displays themanual test parameters that are used in the test steps. For
details on the available fields, see "Test LabModule Fields" on page 513 and
"Test PlanModule Fields" on page 366.

Linked Defects Lists the defects linked to the run. You can view, add, and remove defect
links. For more details, see "Linked Defects/Entities Page" on page 710.

History Displays a list of changes made to the run. For more details, see "History
Tab" on page 68.

Criterion Results Displays the results of the last test criteria run for the selected business
process test.

Business Process Testing: Functionality related to test criteria is available
only for business process tests. For details, see theHP Business Process
Testing User Guide.

Iterations Displays the status of each iteration for the selected business process test.

Business Process Testing: Functionality related to iterations is available
only for business process tests. For details, see theHP Business Process
Testing User Guide.

Run Step Details Dialog Box
This dialog box displays test step details for the run.

To access In the Run Details dialog box—Steps view, select a step and click Details

.

Important
information

This dialog box is not available for Sprinter runs.

Relevant tasks "How to View Test Runs" on page 668

See also l "Test LabModule Fields" on page 513
l "Test Runs Overview" on page 668
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User interface elements are described below:

UI Element Description

First/Previous Next/Last Entity. Allows you to browse through the steps in
the run.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Details Displays details of the step. For details on the available fields, see the "Test
LabModule Fields" on page 513.

Click in theDescription box to display a toolbar for formatting and spell
checking the text.

Click the other tabs to view additional details of the step, such as expected
results, actual results, and run conditions.

Attachments Lists attachments that provide additional information about the step. For
details, see "Attachments Page" on page 72.

Linked Defects Lists the defects linked to the step. You can view, add, and remove defect
links. For more details, see "Linked Defects/Entities Page" on page 710.

Test Set/BVS Run Details Dialog Box
This dialog box displays details for a test set run or build verification suite run.

To access In Testing > Test Runs, click on Test Set Runs or Build Verification Suite Runs.

Select a run and click .

Relevant
tasks

"How to View Test Runs" on page 668

See also l "Test LabModule Fields" on page 513
l "Test Runs Overview" on page 668
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User interface elements are described below:

UI Element Description

Save. Saves the details.

First/Previous Next/Last Entity. Allows you to browse through the runs in
the grid.

Send by Email. Opens the Send E-mail dialog box, enabling you to send a
run by email to recipients selected from a list. For more details, see "Send E-
mail Dialog Box" on page 69.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Details Displays details of the test set run or build verification suite run. For details on
the available fields, see "Test LabModule Fields" on page 513.

Event Log Displays a list of the events that were logged during the selected run. For
details, see theHP ALM LabManagement Guide.

Purge RunsWizard
This wizard enables you to delete old test run results in your project.

To
access

Use one of the following:

l In the Test Lab > Test Sets tab, select Test Sets > Purge Runs.
l In the Test Runs > Test Runs tab, select Test Runs > Purge Runs.

Relevant
tasks

"How to Create Test Sets" on page 524

Wizard
map

This wizard contains:

"Select Test Sets to Purge Page" on the next page > "Choose Type of Purge Page" on
the next page > "Confirm Purge Request Page" on page 688

See also l "Test Runs Overview" on page 668
l "Test LabModuleWindow" on page 495
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Select Test Sets to Purge Page

This wizard page enables you to select test sets to purge.

Important
information

General information about this wizard is available in "Purge Runs Wizard" on the
previous page.

Wizard map The "Purge Runs Wizard" on the previous page contains:

"Select Test Sets to Purge Page" above > "Choose Type of Purge Page" below >
"Confirm Purge Request Page" on the next page

See also "Test Runs Overview" on page 668

User interface elements are described below:

UI Element
(A - Z)

Description

Moves selected test sets betweenAvailable Test Sets andSelected Test Sets.

Tip: You can also drag the test set names between panes or double-click a test
sets name tomove it across to the other pane.

Moves all test sets betweenAvailable Test Sets andSelected Test Sets.

Available
Test Sets

Lists all test sets in your project that are not currently selected to purge.

Selected
Test Sets

Lists the test sets that you have selected to purge.

Choose Type of Purge Page

This wizard page enables you to select the purge type and define the purge conditions.

Important
information

General information about this wizard is available in "Purge Runs Wizard" on the
previous page.

Wizard map The "Purge Runs Wizard" on the previous page contains:

"Select Test Sets to Purge Page" above > "Choose Type of Purge Page" above >
"Confirm Purge Request Page" on the next page

See also "Test Runs Overview" on page 668
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User interface elements are described below:

UI Element (A - Z) Description

Delete Includes the following options:

Runs. Deletes test run results.

Run Steps Only. Deletes run steps but keeps the overall run details.

From runs older than The time before which you want to delete the data from the selected run.

Number of runs per
test to keep

The number of test run results to keep for each test.

Purge draft runs only Purges only runs marked as Draft Run. For details on draft runs, see
"Draft Runs" on page 489.

Confirm Purge Request Page

This wizard page enables you to review a summary of your request and confirm the purge.

Important
information

General information about this wizard is available in "Purge Runs Wizard" on
page 686.

Wizard
map

The "Purge Runs Wizard" on page 686 contains:

"Select Test Sets to Purge Page" on the previous page > "Choose Type of Purge
Page" on the previous page > "Confirm Purge Request Page" above

See also "Test Runs Overview" on page 668

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Request details area> Summarizes the deletions you chose tomake.

Finish Deletes the test run results according to your selections.
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Chapter 40: Defect Tracking 
This chapter includes:

• Defect Tracking Overview 692
• How to Track Defects in ALM 693
• How to Search for Defects 695
• How to Link Defects 696
• Defect User Interface 696
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Defect Tracking Overview
Locating and repairing application defects efficiently is essential to the development process. Using the
HP Application Lifecycle Management (ALM) Defects module, you can report design flaws in your
application and track data derived from defect records during all stages of the applicationmanagement
process.

You use the Defects module to:

l Create application defects for an ALM project.
l Track defects until application developers and testers determine that the defects are resolved.
Defect records inform members of the application development and quality assurance teams of new
defects discovered by other members. As youmonitor the progress of defect repair, you update the
information in your project.

You can share defects across multiple ALM projects. You share and synchronize defects using the HP
ALM Synchronizer. For more information, see theHP ALM Synchronizer User Guide, available from
the Adds-ins Page.

ALM Editions:Sharing defects across multiple ALM projects is available for ALM Edition only. For
more information about ALM editions and their functionality, see "ALM Editions" on page 115. To
find out what edition of ALM you are using, ask your ALM site administrator.

This section also includes "Defect Linkage" below.

For task details about working with defects, see "How to Track Defects in ALM" on the next page.

Defect Linkage
You can link a defect to the following ALM entities: requirements, tests, test sets, business process
tests, flows, test instances, runs, run steps, and other defects.

Examples of when defect linkage is useful include:

l A new test is created specifically for a defect. By creating a link between the test and the defect, you
can determine if the test should be run based on the status of the defect.

l During amanual test run, if you add a defect, ALM automatically creates a link between the test run
and the new defect.

You can link defects directly to other defects or entities. When you add a defect link to an entity, ALM
adds a direct link to the entity and indirect links to related entities.

Indirect linkage is a one-directional flow; ALM indirectly links higher-level related entities only.
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The diagram below shows the indirect links that ALM creates if a defect is linked to a run step.

To learnmore about defects, see "Defect Tracking Overview" on the previous page.

For task details, see "How to Link Defects" on page 696.

Example
If you link a defect to a run:

l The defect is indirectly linked to the run, the run's test instance, the test set, and the test.
l If the corresponding test is covered by a requirement, an indirect link is also added to the
requirement.

l The defect is not indirectly linked to the run's steps, because the run steps are lower-level
related entities.

Note: Only direct links to defects from an entity can be deleted.

How to Track Defects in ALM
This task describes how to track application defects during the development process.

To learnmore about defects, see "Defect Tracking Overview" on the previous page.

Note:

Higher-level task: This task is part of a higher-level task. For details, see "ALM Basic Flow" on
page 22.

This task includes the following steps:

l "Create defects" on the next page
l "Import defects - optional" on the next page
l "Link defects and other entities" on the next page
l "Search for defects" on the next page
l "Assign, repair, and update defects" on the next page
l "Analyze defects" on page 695
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1. Create defects
a. On the ALM sidebar, select Defects.
b. Click New Defect in the Defects grid toolbar to open the New Defect dialog box. For user

interface details on the New Defect dialog box, see "New Defect Dialog Box" on page 705.

Tip: Creating a defect can be an ongoing process that may require switching between the
New Defect dialog box, other ALMmodules, and possibly the browser itself.

To switch to another module while creating a defect, click Closewithout submitting the
defect. To return to the defect you are creating, click New Defect from the Defects
module again. ALM retains the data so you can continue working on the same defect.

If you want to start work on a different defect, click theClear All Fields button to
clear the retained data.

c. In the New Defect dialog box, fill in the fields.

2. Import defects - optional
In addition to creating defects directly in ALM, you can also import defects to your ALM project
fromMicrosoft Excel. To import defects, youmust first install the appropriate add-in. For more
information, see "Data Import fromMicrosoft Word andMicrosoft Excel " on page 26.

3. Link defects and other entities
You can link defects to requirements, tests, test sets, test instances, runs, run steps, business
process tests, flows, and other defects.
For task details on how to link defects, see "How to Link Defects" on page 696.

4. Search for defects
In the Defects module, you can search for defects from:
l The Defects grid, for example, to find defects related to a specific issue, or to modify a specific
defect.

l The New Defect dialog box, for example, to avoid creating duplicate defects.
For task details on how to search for defects, see "How to Search for Defects" on the next page.

5. Assign, repair, and update defects
Periodically review defects in the project, decide which ones to fix, andmodify defect statuses,
target releases, target cycles, and other fields accordingly.

In the Defects module, select a defect in the Defects grid and click theDefect Details
button. In the Defect Details dialog box, fill in the fields. For user interface details on the Defect
Details dialog box, see the "Defect Details Dialog Box" on page 707.
Among other tasks, you can:
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l Change the status of defects that are candidates to be fixed toOpen, and assign the defects to
members of the development team.

l In the Target Release and Target Cycle fields, assign the open defects to the releases and
cycles in which they are targeted to be fixed.

l Fix the open defects. This involves identifying the cause of the defects, modifying and
rebuilding the application, and rerunning your tests. For example, if a defect does not recur, you
can assign to the defect the status Closed. If a defect is detected again, you can reassign to
the defect the status Open. When a defect is repaired, you can assign it the status Fixed.

6. Analyze defects
Analyze defect data by generating reports and graphs.
Use one of the following:
l View defect data in a graph. On the Defects modulemenu, select Analysis > Graphs. For
task details on generating graphs, see the "How to Generate a Graph" on page 736.

l Create a report of defect data. On the Defects modulemenu, select Analysis > Project
Report. For task details on creating reports, see "How to Create Project Reports" on page 776.

For task details on additional analysis tools in ALM, see the "How to Analyze Data in ALM" on
page 718.

How to Search for Defects
This task describes how to search for defects using the Similar Defects Dialog Box/Pane. You can
search for defects at any time from the Defects grid, for example, to find defects related to a specific
issue, or to modify a specific defect.

When creating a new defect, you can search for similar defects, for example, to avoid creating
duplicate defects.

To watch amovie on how to check for duplicate defects, refer to this section in the ALMOnline Help.

For user interface details on the Similar Defects Dialog Box/Pane, see "Similar Defects Dialog
Box/Pane" on page 708. 

1. Display the defect
Display the defect for which you want to find similar defects by doing one of the following:
l Select a defect from the Defects grid.
l While creating a new defect in the New Defect dialog box, enter descriptive information in the
Summary andDescription fields.

2. Start the search

Click the Find Similar Defects button.
l Select Find Similar Defects to find defects similar to the current defect.
l Select Find Similar Text to find defects whose summary or description is similar to a
specified text string.
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How to Link Defects
The following steps describe how to link defects to ALM entities (requirements, tests, test sets, test
instances, runs, run steps and other defects).

For user interface details on the Linked Defects/Entities page, see the "Linked Defects/Entities Page"
on page 710.

1. Link the defect
From themodule of the entity to which you want to link a defect, select the Linked Defects or
Linked Entities page, and do one of the following:
l Add new defect:Create the defect to which to link.
l Select existing defect:Select an existing defect to which to link.

Tip: From the Defects module, you can link defects and requirements to defects.

2. View results
You can view the linked entity from the corresponding defect, and you can view the linked defect
from the corresponding entity.

In grid views, when an entity is linked to a defect, ALM adds the Linked Defects icon to the
entity.

Defect User Interface
This section includes:

• Defects ModuleWindow 697
• Defects ModuleMenus and Buttons 698
• Defects Module Icons 702
• Defects Module Fields 703
• New Defect Dialog Box 705
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• Defect Details Dialog Box 707
• Similar Defects Dialog Box/Pane 708
• Linked Defects/Entities Page 710
• Defects to Link Dialog Box 712
• Select Requirements Dialog Box 713

Defects ModuleWindow
This window enables you to define andmaintain ALM defects. ALM organizes and displays defect data
in the Defects grid.

To access On the ALM sidebar, select Defects.

Relevant tasks "How to Track Defects in ALM" on page 693

See also "Defect Tracking Overview" on page 692

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Defects
module
common UI
elements>

l Defect fields. For field definitions, see "Defects Module Fields" on page 703.
l Defect menus and buttons. For command and button descriptions, see
"Defects ModuleMenus and Buttons" on the next page.

l Defect icons. For icon descriptions, see "Defects Module Icons" on page 702.
l ALM masthead, menus, and sidebar. For details, see "ALM Common
Areas" on page 32.

<filter status
bar>

Describes the filter currently applied to the grid. Located directly under the
toolbar.

l Showing <x> results. Indicates the number of records currently displayed out
of the total records.

l Retrieve all <x> results. Click to display all records.

<grid filters> Displays a grid filter box under each column name, enabling you to define a filter
condition for a column.

Type directly into the box, or click the box to display the browse button, which
opens the Select Filter Condition dialog box. For user interface details, see
"Select Filter Condition Dialog Box" on page 61.

<similar
defects pane>

Enables you to check for similar defects from the Defects grid. For user interface
details, see "Similar Defects Dialog Box/Pane" on page 708.

Available: After selecting the Find Similar Defects button in the Defects
grid.
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UI Element Description

Description tab Describes the currently selected defect.

Click in theDescription orComments text boxes in this tab to display a toolbar
for formatting and spell checking the text.

Attachments
tab

Lists attachments that provide additional information about the currently selected
defect. For user interface details, see "Attachments Page" on page 72.

Linked Entities
tab

Lists the defects and other entities linked to the currently selected defect. For
user interface details, see "Linked Defects/Entities Page" on page 710.

History tab Lists changes made to the currently selected defect. For user interface details,
see "History Tab" on page 68.

Defects Module Menus and Buttons
This section describes themenus and buttons available in the Defects module.

To access On the ALM sidebar, select Defects.

Important
information

Tip: You can access the Defects menu bar from the Defects module by
pressing the shortcut key ALT.

Relevant tasks "How to Track Defects in ALM" on page 693

See also l "Defects Module Icons" on page 702
l "Defect Tracking Overview" on page 692
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User interface elements are described below:

UI Element Menu Description

New Defect Defects Opens the Create New Defect dialog box, enabling you to add a
defect, or continue editing a defect that you started to add. For user
interface details, see "New Defect Dialog Box" on page 705.

Tip: Creating a defect can be an ongoing process that may
require switching between the New Defect dialog box, other
ALMmodules, and possibly the browser itself.

To switch to another module while creating a defect, click
Closewithout submitting the defect. To return to the defect you
are creating, click New Defect from the Defects module again.
ALM retains the data so you can continue working on the same
defect.

If you want to start work on a different defect, click theClear

All Fields button to clear the retained data.

Go to Defect Defects Opens the Go ToDefect dialog box, enabling you to find a specific
defect by Defect ID.

Send by E-mail Defects Opens the Send E-mail dialog box, enabling you to send a defect by
email to recipients selected from a list. For user interface details,
see "Send E-mail Dialog Box" on page 69.

Defect Details Defects Opens the Defect Details dialog box, displaying the details of the
selected defect. For user interface details, see "Defect Details
Dialog Box" on page 707.

Export Defects Opens the Export Grid Data dialog box, enabling you to export the
defects in a grid as a text file, Microsoft Excel worksheet, Microsoft
Word document, or HTML document.

Select one of the following options:

l All. Exports all defects in the grid.
l Selected. Exports selected defects in the grid.

Copy/Paste Edit Copies selected defects within the same project or across projects.

Note: To copy defects across projects, both projects must use
the same ALM version and patch level. Copying defects works
only when no groupings are applied.
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UI Element Menu Description

Copy
URL/Paste

Edit Copies a selected defect and pastes its URL as a link. The defect
itself is not copied. Instead, you can paste the address into another
location, such as an email or a document. Clicking the link opens
ALM and takes you to the defect. If you are not already logged in,
ALM first prompts for login details.

Delete
Edit Deletes the selected defect. When you delete a defect, ALM does

not reuse the Defect ID.

Select All Edit Selects all defects in the grid.

Invert Selection Edit Unselects all previously selected defects in the grid and selects all
previously unselected defects.

Find Edit Opens the Find dialog box, enabling you to search for a defect in the
Defects module. For user interface details, see "Find Dialog Box" on
page 63.

Find Next Edit Searches for the next item in the Defects grid that meets the
previously-defined search criteria.

Replace Edit Opens the Replace dialog box, enabling you to replace a field value.
For user interface details, see "Replace Dialog Box" on page 65.

Update
Selected

Edit Opens the Update Selected dialog box, enabling you to update a
field value for multiple selected defects in the grid. For user interface
details, see "Update Selected Dialog Box" on page 79.

Text Search Edit Opens the text search pane in the lower part of the Defects module
window, enabling you to search for records in predefined fields. For
user interface details, see "Text Search Pane" on page 66.

Find Similar

Defects

Edit Search keywords in theSummary andDescription fields for
defects similar to the selected defect. Similar defects are displayed
according to the percentage of similarity in the pane at the bottom of
the window. For user interface details, see the "Similar Defects
Dialog Box/Pane" on page 708.

Find Similar
Text

Edit Search keywords in theSummary andDescription fields for
defects similar to a text string. For user interface details, see the
"Similar Defects Dialog Box/Pane" on page 708.

Alerts Edit Opens the Alerts dialog box, enabling you to display alerts for the
defect. For user interface details, see "Alerts Dialog Box" on
page 88.

Clear Alerts Edit Clears displayed alerts for themodule. For user interface details,
see "How to Use Alerts" on page 86.
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UI Element Menu Description

Flag for Follow

Up

Edit Opens the Flag For Follow Up dialog box, enabling you to define a
follow up flag for the selected defect. For user interface details, see
"Flag For Follow UpDialog Box" on page 89.

Pin/Unpin
<toolbar> Pins or unpins the defect.

Available from: Defect Grid, Defect Details.

For details, see "Pinned Items Overview" on page 98.

Clear Follow
Up Flag

Edit Clears a follow up flag of a selected defect. For concept details, see
"Follow Up Flags Overview" on page 85.

Set Default
Values

Edit Opens the Set Default Values dialog box, enabling you to set default
values for certain defect fields. For user interface details, see "Set
Default Values Dialog Box" on page 80

Clear Default
Values

Edit Removes default values set using the Set Default Values dialog
box. No defaults are available when creating new defects.

Grid Filters View Displays a grid filter box under each column name, enabling you to
define a filter condition for a column.

Type directly into the box, or click the box to display the browse
button, which opens the Select Filter Condition dialog box. For more
details, see "Select Filter Condition Dialog Box" on page 61.

Indicator
Columns

View Display indicators on the left-side of the Defects grid. For user
interface details, see "Defects Module Icons" on the next page.

Information
Panel

View Displays information panel tabs on the bottom of the Defects grid.
For more details, see "Defects ModuleWindow" on page 697.

Filter/Sort
View Enables you to filter and sort the defects in the grid. Any currently

applied filters or sorting orders are displayed below the toolbar. For
user interface details, see "Filter Dialog Box" on page 51.

Refresh All
View Refreshes the Defects grid so that it displays themost up-to-date

defects based on the filters you have selected.

Select Columns View Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For user interface
details, see "Select Columns/Select Fields Dialog Box" on page 77.

Attachments <toolbar> Opens the Attachments page, enabling you to view attachments for,
and add attachments to, the selected defect. For user interface
details, see "Attachments Page" on page 72.

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite
view to your private or the public folder. For user interface details,
see "Add Favorite Dialog Box" on page 94.
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UI Element Menu Description

Organize
Favorites

Favorites Organizes your favorite views. For user interface details, "Organize
Favorites Dialog Box" on page 95.

Private Favorites Lists the favorite views that are accessible only to the user who
created them.

Public Favorites Lists the favorite views that are accessible to all users.

Project Reports Analysis Lists the predefined project reports you can produce on defects data.
For details on the report types, see "Predefined Project Reports" on
page 779.

Selecting a report from the list generates a preview of the report. The
preview displays up to five entities per report section. To generate
the full report, in the upper left corner of the preview, click the
downward arrow adjacent to theGenerate button and select the
report format to generate.

Graphs Analysis Lists the graphs you can generate for defects data. Select a
predefined graph, or launch the graph wizard.

For details on the predefined graph types, see "Entity Graph Types"
on page 739.

Most Recently
Used

Analysis Lists themost recently viewed reports and graphs in ALM. Displays
up to ten items.

Global Search <toolbar> A global search engine enabling you to search across all or a specific
ALMmodule. It includes the followingmodules: Defects,
Requirements, Tests, Test Sets, and Analysis. For more details on
how to install and enable Global Search, see
https://hpln.hp.com/contentoffering/alm-global-search.

Defects Module Icons
This section describes the icons available in the Defects module.

To access On the ALM sidebar, select Defects.

Relevant tasks "How to Track Defects in ALM" on page 693

See also l "Defect Tracking Overview" on page 692
l "Defects ModuleMenus and Buttons" on
page 698

l "Defects Module Fields" on the next page
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The icons are described below:

UI
Element

Description

<green asterisk>. The applicable tab is populated.

Alerts. Click to view alerts for the defect.

l Red alert. The alert is new.
l Gray alert. The alert has already been read.
For user interface details, see "Alerts Dialog Box" on page 88.

Attachments. Click to view attachments for the specified defect.

Open an attachment by selecting it from the list. If there aremore than ten attachments,
click themore attachments link to view the list in theAttachments Page. For details,
see "Attachments Page" on page 72.

Follow Up Flags. Click to view follow up flags for the defect.

l Gray flag. The follow up flag is new.
l Red flag. The follow up date has arrived.
For user interface details, see "Flag For Follow UpDialog Box" on page 89.

Linked Entities. Click to view linked entities for the defect in the Defect Details dialog
box. For user interface details, see "Linked Defects/Entities Page" on page 710.

Defects Module Fields
This section describes the Defects module fields.

To access On the ALM sidebar, select Defects.

Important
information

l You can add user-defined fields and change the label of any of the fields in the
Defects module. You can also customize project lists. For details, see theHP
Application Lifecycle Management Administrator Guide.

l You can use the Script Editor to restrict and dynamically change the fields and
values in the Defects module. For details, see theHP Application Lifecycle
Management Administrator Guide.

l When you select a defects columnwith a user name value (including user-defined
fields), ALM displays a list with the name and full name of each user. You can
search for users, sort users, group users by user group, and select users from the
users list or a group tree. For user interface details, see "Users List Dialog Box" on
page 62.

Relevant
tasks

"How to Track Defects in ALM" on page 693
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See also l "Defect Tracking Overview" on page 692
l "Defects ModuleMenus and Buttons" on page 698
l "Defects ModuleWindow" on page 697

User interface elements are described below:

UI Element
(A - Z)

Description

Actual Fix
Time

The actual number of days needed to fix the defect. If this field is left blank, ALM
automatically calculates the Actual Fix Time as Closing Date–Detected on Date.

Assigned To The user name of the person who is assigned to fix the defect.

Closed in
Version

The application version in which the defect was closed.

Closing Date The date on which the defect was closed.

Comments Comments about the defect. To add a new comment, click theAdd Comment
button. A new section is added to the Comments box, displaying your user name
and the database's current date.

Defect ID A unique numeric ID for the defect, assigned automatically by ALM. The Defect ID
is read-only.

Description Describes the defect in detail.

Detected By The user name of the person who submitted the defect.

Detected in
Cycle

The cycle in which the defect was detected.

When assigning a defect to a cycle in theDetected in Cycle field, ALM
automatically assigns its release to theDetected in Release field.

Detected in
Release

The release in which the defect was detected.

Detected in
Version

The application version in which the defect was detected.

Detected on
Date

The date on which the defect was detected.

Default: The current database server date.

Detected on
Environment

The environment on which the defect was detected. Environments are a
combination of operating systems, browsers, and so on, on which you test the
application.

Note: Environments are defined using the ALM WebClient. After they are
defined, you can select them when reporting a defect.
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UI Element
(A - Z)

Description

Estimated
Fix Time

The estimated number of days required for fixing the defect.

Modified The date and time when this defect was last changed.

Planned
Closing
Version

The version in which the defect is planned to be fixed.

Priority The priority of the defect, ranging from low priority (level 1) to urgent priority
(level 5).

Project The name of the project where the defect occurs.

Reproducible Whether the defect can be recreated under the same conditions by which it was
detected.

Default: Y

Severity The severity of the defect, ranging from low (level 1) to urgent (level 5).

Status The current status of the defect. Defect status can be one of the following: Closed,
Fixed, New, Open, Rejected, Reopen.

Default: New

Subject The subject folder.

Summary A brief summary of the defect.

Target Cycle The cycle in which the defect is targeted to be fixed.

When assigning a defect to a cycle in the Target Cycle field, ALM automatically
assigns its release to the Target Release field.

Target
Release

The release in which the defect is targeted to be closed.

New Defect Dialog Box
This dialog box enables you to create defects.

To access Use one of the following:

l From the Defects module, click .

l From any module, on themasthead, click and select New Defect.
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Important
information

Tip: You can set default values for certain defect fields. For user interface
details, see "Set Default Values Dialog Box" on page 80.

Relevant
tasks

"How to Track Defects in ALM" on page 693

See also "Defect Tracking Overview" on page 692

User interface elements are described below:

UI Element Description

Clear All Fields. Clears the data.

Tip: Creating a defect can be an ongoing process that may require
switching between the New Defect dialog box, other ALMmodules, and
possibly the browser itself.

To switch to another module while creating a defect, click Close
without submitting the defect. To return to the defect you are creating,
click New Defect from the Defects module again. ALM retains the data
so you can continue working on the same defect.

If you want to start work on a different defect, click theClear All Fields

button to clear the retained data.

Find Similar Defect. Opens the Similar Defects dialog box, enabling you to
find:

l Defects similar to the new defect.
l Defects similar to a text string.
For user interface details, see "Similar Defects Dialog Box/Pane" on
page 708.

Check Spelling. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Use Default Values. Fills in certain fields with default values, as specified
in the Set Default Values dialog box. For user interface details, see "Set
Default Values Dialog Box" on page 80.

Set Default Values. Enables you to specify default values for certain fields
using the Set Default Values dialog box. For user interface details, see "Set
Default Values Dialog Box" on page 80.
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UI Element Description

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Details Lists the defect fields. For details on defect fields, see "Defects Module
Fields" on page 703.

Attachments Enables you to add attachments that provide additional information about
the new defect. For user interface details, see "Attachments Page" on
page 72.

Defect Details Dialog Box
This dialog box enables you to update defect details, add attachments, view defect history, and link to
other defects. You can also view other entities that are linked to the defect.

To access Right-click a defect in the Defects grid and select Defect Details.

Relevant tasks "How to Track Defects in ALM" on page 693

See also l "Defect Tracking Overview" on page 692
l "Defects Module Fields" on page 703

User interface elements are described below:

UI Element Description

Save. Saves the details.

First/Previous/Next/Last Entity. Allows you to browse through the defects.

Go to Defect. Opens theGo ToDefect dialog box, enabling you to find a
specific defect by Defect ID. You can only go to defects that are in the current
filter. After specifying the defect ID, click one of the following:

l Open Details. Opens the defect in the Defects Details dialog box.
l Show in Grid. Highlights the defect in the Defects grid, after you close the
Defects Details dialog box.

Flag for Follow Up. Opens the Flag For Follow Up dialog box, enabling you
to define a follow up flag for selected defects. For user interface details, see
"Flag For Follow UpDialog Box" on page 89.

Alerts. Opens the Alerts dialog box, enabling you to display alerts for the
defect. For user interface details, see "Alerts Dialog Box" on page 88.

Available when: The selected defect has an alert associated with it.
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UI Element Description

Standard Defect Report. Select one of the following reports:

l Execution Report. Displays detailed information about the linked test run.
Available: If the defect is linked to a test run.

l Standard Defect Report. A standard defect report for the selected defect.

Send by E-mail. Opens the Send E-mail dialog box, enabling you to send a
defect by email to recipients selected from a list. For user interface details,
see "Send E-mail Dialog Box" on page 69.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure the way ALM checks spelling.

Field Search. Enables you to search for a specified field name. Supports
wildcard search with asterisk "*" and questionmark "?".

For example: a*b returns acb and adefb; a?b returns acb

Details Lists the defect fields. For details on defect fields, see "Defects Module
Fields" on page 703.

Attachments Lists attachments that provide additional information about the currently
selected defect. For user interface details, see "Attachments Page" on
page 72.

Linked Entities Lists the entities linked to the currently selected defect. For user interface
details, see "Linked Defects/Entities Page" on page 710.

History Lists changes made to the currently selected defect. For user interface
details, see "History Tab" on page 68.

Similar Defects Dialog Box/Pane
The Similar Defects dialog box enables you to check for similar defects before submitting a new defect.
The Similar Defects pane enables you to check for similar defects at any time from the Defects grid.

To access In the Defects grid or the New Defect dialog box, select a defect and click the Find

Similar Defects button.

Select either Find Similar Defects or Find Similar Text.
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Important
information

l Checking for similar defects is done by comparing a selected defect with other
defects in your project or by comparing defects to a text string.

l When performing a Find Similar operation, results are displayed with themost
likely candidates on top. If no similar defects are found, amessage is displayed.

Relevant
tasks

"How to Search for Defects" on page 695

See also "Defect Tracking Overview" on page 692

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

Search
for:

Text string to find.

Letter case does not affect the results.

The following are ignored:

l articles (a, an, the);
l coordinate conjunctions (and, but, for, nor, or);
l boolean operators (and, or, not, if, then);
l wildcards (?, *, [ ])

Proximity
%

When searching for similar text, ALM limits the results of defects found to those with a
minimum similarity according to this percentage.

Default: ALM returns defects with a similarity of at least 25 percent.

Search Start search.

Select columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For user interface details, see "Select
Columns/Select Fields Dialog Box" on page 77.

Searchable Fields. The fields used to find similar defects. The fields are read-only.

Go To. Locates the selected defect in the Defects grid.

<defects> List of similar defects. For details of the fields displayed for the similar defects, see
"Defects Module Fields" on page 703.

Item The number of the current defect in relation to the total number of similar defects found.

Example: Item 2 of 10
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Linked Defects/Entities Page
This page enables you to define andmaintain links to defects from defects and other entities.

To access Use one of the following:

l From the Defects module: On the Defect Details dialog box sidebar, select
Linked Entities. Click theDefects tab for linked defects or theOthers tab for
linked entities that are not defects.

l From other modules and dialog boxes:Click Linked Defects on the sidebar or
the Linked Defects tab.

Important
information

l You can link defects to the following ALM entities: requirements, business, tests,
test sets, business process tests, flows, test instances, runs, run steps, and other
defects.

l From within the Defects module, you can link to other defects.
l To link a defect to other ALM entities, go to themodule or Details dialog box for
that entity.

Relevant
tasks

"How to Link Defects" on page 696

See also "Defect Tracking Overview" on page 692

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

First/Previous/Next/Last Entity. Allows you to browse through the entities.

Available from: Linked Defects tab.

Add and Link Defect. Opens the New Defect dialog box, enabling you to add
a defect link by submitting a new defect. For user interface details, see "New
Defect Dialog Box" on page 705.

Available from: All modules except the Defects module.

Link Existing Defect. Enables you to add a link to an existing defect:

l By ID. In the Link Existing Defect dialog box, select a defect by typing the
defect ID.

l Select. In the Defects to Link dialog box, select a defect from the grid. For
user interface details, see "Defects to Link Dialog Box" on page 712.
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UI Element Description

Link From Requirement. Enables you to add a link to an existing
requirement:

l By ID. In the Link Existing Requirement dialog box, select a requirement
by typing the requirement ID.

l Select. In the Select Requirements dialog box, select a requirement from
the grid. For user interface details, see "Select Requirements Dialog Box"
on page 713.

Available from: This page's Others tab in the Defects module.

Remove Link. Removes the selected link.

Refresh All. Refreshes the list of linked defects or entities so that it displays
themost up-to-date defects based on the filters you have selected.

Filter/Sort. Enables you to filter and sort the list of linked defects and entities.
Any currently applied filters or sorting orders are displayed below the toolbar.
For user interface details, see "Filter Dialog Box" on page 51.

Select Columns. Opens the Select Columns dialog box, enabling you to
determine which fields to display in the grid and their order. For user interface
details, see "Select Columns/Select Fields Dialog Box" on page 77.

Defect Details. Opens the Defect Details dialog box, displaying the details of
the selected defect. For user interface details, see "Defect Details Dialog
Box" on page 707.

l Go To Defect. Opens the Defects Details dialog box for the linked defect.
l Go To 'Linked By' Entity. Opens the Details dialog box for the entity
linked to the defect.

Type of Link Select an option:

l Direct links. Displays direct links only.
l All links. Displays all links.
For information about direct and indirect links, see "Defect Tracking
Overview" on page 692.

Available from: All modules except the Defects module.

Show Links for Determines which links to display:

l Current Req Links. Defect links added to the current requirement only.
l Including Children's Links. Defect links added to the current
requirement and its children.

Available from:Requirements module
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UI Element Description

<filter status bar> Describes the filters currently applied to the grid. Located directly above the
grid filter boxes.

<Defects module
fields>

For user interface details, see "Defects Module Fields" on page 703.

<grid filters> Displays a grid filter box under each column name, enabling you to define a
filter condition for a column.

Type directly into the box, or click the box to display the browse button, which
opens the Select Filter Condition dialog box. For user interface details, see
"Select Filter Condition Dialog Box" on page 61.

Created By The user name of the person who created the link.

Creation Date The date on which the link was created.

Link Comment Enables you to add comments about the link.

Link ID A unique numeric ID for the link, assigned automatically by ALM. The Link ID
is read-only.

Link Type A value of the Link Type customized list. For more information on lists, see
theHP Application Lifecycle Management Administrator Guide .

Linked By Status The current status of the linked entity.

Linked Entity ID A unique numeric ID for the linked entity, assigned automatically by ALM. The
Linked Entity ID is read-only.

Linked Entity
Name

The linked entity name. For example, the requirement name.

Linked Entity
Type

The linked entity type (for example: step, test, test set).

Defects A list of defects linked to the current defect.

Others A list of other entities linked to the current defect.

Defects to Link Dialog Box
This dialog box enables you to link defects to other defects in the Defects module.

To
access

Open the Defect Details dialog box for a defect, click the Linked Entities tab and then

theDefects tab. Click Link Existing Defect and then select Select.

Relevant
tasks

"How to Link Defects" on page 696

See also "Defect Linkage" on page 692
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Refresh. Refreshes the list of defects.

Filter/Sort. Enables you to filter the data according to the criteria that you choose.
For more details, see "Filter Dialog Box" on page 51.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the data grid, and their order. For user interface details, see
"Select Columns/Select Fields Dialog Box" on page 77.

Search. Opens the Similar Defects dialog box, enabling you to find defects similar to
a text string. For user interface details, see "Similar Defects Dialog Box/Pane" on
page 708.

<filter
status bar>

Describes the filter currently applied to the grid. Located directly above the grid filter
boxes.

<grid
filters>

Displays a grid filter box under each column name, enabling you to define a filter
condition for a column.

Type directly into the box, or click the box to display the browse button, which opens
the Select Filter Condition dialog box. For user interface details, see "Select Filter
Condition Dialog Box" on page 61.

Available from:Model Grid view

<defects> Displays the defects in the Defects module in a data grid.

Description Displays the summary, description and comments for the selected defect in the data
grid.

Select Requirements Dialog Box
This dialog box enables you to link requirements to defects in the Defects module.

To
access

Open the Defect Details dialog box for a defect, click the Linked Entities tab and then

theOthers tab. Click Link From Requirement and then click Select.

Relevant
tasks

"How to Link Defects" on page 696

See also "Defect Linkage" on page 692

User Guide
Chapter 40: Defect Tracking 

HP ALM (12.50) Page 713



User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Show Requirement Details. Opens the Requirement Details dialog box for the
requirement selected in the tree.

Refresh. Refreshes the requirements tree so that it displays themost up-to-date
information.

Filter/Sort. Enables you to filter the data according to the criteria that you choose.
For more details, see "Filter Dialog Box" on page 51.

<Find box> Enter the name of the requirement you want to search for and click the Find
button.

Find. Searches the requirements tree for the value you specify in the Find box.

Go to Entity by ID. Opens theGo to Requirement dialog box, enabling you to
locate the requirement in the tree according to Requirement ID.

<requirements
tree>

Displays the requirements tree in the Requirements module.

Expand the tree and select a requirement. You can assignmore than one
requirement to a defect.

Clears the assigned requirement from the defect.
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Chapter 41: Introducing Analysis
This chapter includes:

• Analysis Overview 718
• How to Analyze Data in ALM 718
• Dashboard User Interface 719
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Analysis Overview
HP Application Lifecycle Management (ALM) provides you with analysis tools enabling you to analyze
and display ALM data in various formats.

Dashboard Modules
In the Dashboardmodules, you analyze ALM data by creating graphs, project reports, and Excel
reports. You can also create dashboard pages that display multiple graphs side-by-side.

Dashboard contains the followingmodules:

l Analysis Viewmodule. Contains the analysis tree in which you organize all of your analysis items.
Analysis items can be any of the following analysis types: graphs, project reports, and Excel
reports.
Users with the required administrator permissions also have access to the Analysis Menus tab. This
tab enables you tomanage the analysis items that are generated from within the Analysis menu in
specific modules, such as Requirements and Test Lab.

l Dashboard Viewmodule. Contains the dashboard tree in which you organize dashboard pages. In
dashboard pages you arrangemultiple graphs that you created in the analysis tree, and display
them in a single view.

Additional Analysis Tools
l Live Analysis graphs. Enables you to create and display a dynamic graphic representation of data
related to test plans and test sets. For more details, see "Live Analysis Graphs" on page 831.

For task details, see "How to Analyze Data in ALM" below.

Note: Run step information of runs executed in Sprinter are not included in any of the reporting
tools.

How to Analyze Data in ALM
This task describes how to analyze data in ALM using various analysis tools.

To learnmore about data analysis, see "Analysis Overview" above.

Note: This task is part of a higher-level task. For details, see "ALM Basic Flow" on page 22.

This task includes the following steps:

l "Generate a graph (including business view graphs)" on the next page
l "Generate a dashboard page" on the next page
l "Generate a project report" on the next page
l "Generate an Excel report" on the next page
l "Generate a Business View Excel report" on the next page
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l "Manage analysis items and dashboard pages" below
l "Generate a Live Analysis graph" below

Generate a graph (including business view graphs)
l View selected data in a graph format. For task details, see "How to Generate a Graph" on page 736.
l View selected Project Planning and Tracking data in a graph format. For task details, see "How to
Generate a PPT Graph" on page 768.

Generate a dashboard page
Group together selected graphs and view them in a single display.

For task details, see "How to Generate a Dashboard Page" on page 738.

Generate a project report
Produce a project report of selected data.

For task details, see "How to Create Project Reports" on page 776.

Generate an Excel report
Extract data from the project database with SQL queries, and format the data in Microsoft Excel.

For task details, see "How to Generate an Excel Report" on page 796.

Generate a Business View Excel report
In Microsoft Excel, extract data from the project database with DQL queries and format the data.

For task details, see "How to Generate a Business View Excel Report" on page 810.

Manage analysis items and dashboard pages
Organize analysis items and dashboard pages in the analysis and dashboard trees. Create folders,
move, copy, rename, and delete items.

For user interface details, see "Analysis View Menus and Buttons" on page 722.

Generate a Live Analysis graph
Live Analysis graphs enable you to create and display dynamic graphs related to test plan subjects and
test sets.

For task details, see "How to Generate Live Analysis Graphs" on page 832.

Dashboard User Interface
This section includes:

• Analysis View Window 720
• Dashboard View Window 721
• Analysis View Menus and Buttons 722
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• Dashboard View Menus and Buttons 727
• Dashboard Icons 728
• Details Tab 729
• Share Analysis Item Dialog Box 730

Analysis ViewWindow
This window enables you to create, manage and view analysis items. Analysis items include graphs,
project reports, and Excel reports.

To access On the ALM sidebar, underDashboard, select Analysis View.

Relevant tasks "How to Analyze Data in ALM" on page 718

See also "Analysis Overview" on page 718

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Analysis
View tab

Contains a tree which enables you to organize your analysis items under private
and public root folders.

l Analysis items that you create in a public folder are accessible to all users.
l Analysis items that you create in a private folder are accessible only to the user
that created them.

Note:

l Analysis items in public folders may show different results for different
users, depending on the data hiding definitions for the user group. For
more information on data permissions, refer to theHP Application
Lifecycle Management Administrator Guide.

l You cannot move analysis items within a folder. When you refresh the
tree view, folder items are alphabetized.

Analysis
Menus tab

Enables you to view andmanage the behavior of analysis items that are generated
from within modules, such as Requirements and Test Plan.

Analysis items are listed according to themodules in which they appear.

Available for:Users with the required administrator permissions only.

<Analysis
View
common UI
elements>

l Analysis View menus and buttons. For command and button descriptions,
see "Analysis View Menus and Buttons" on page 722.

l Dashboard icons. For icon descriptions, see "Dashboard Icons" on page 728.
l ALM masthead, menus, and sidebar. For details, see "ALM Common Areas"
on page 32.
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UI Element Description

Details tab Displays details of the selected analysis item or folder. For more details, see
"Details Tab" on page 729.

Configuration
tab

Enables you to configure the selected analysis item. For user interface details,
see:

l Graphs: "Configuration Tab/Window - Graphs" on page 744
l Project reports: "Configuration Tab - Project Reports" on page 784
l Excel reports: "Configuration Tab - Excel Reports" on page 799
l Business View Excel reports: "Configuration Tab - Business View Excel
Reports" on page 814

View tab Displays the selected graph. For user interface details, see "View Tab -
Graphs/GraphWindow" on page 749.

Note: Project reports and Excel reports are viewed in external applications,
such as Microsoft Excel andWord.

Dashboard ViewWindow
This window enables you to create, manage, and view dashboard pages.

To access On the ALM sidebar, underDashboard, select Dashboard View.

Relevant tasks "How to Generate a Dashboard Page" on page 738

See also "Analysis Overview" on page 718

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Dashboard
View
common UI
elements>

l Dashboard View menus and buttons. For command and button descriptions,
see "Dashboard View Menus and Buttons" on page 727.

l Dashboard icons. For icon descriptions, see "Dashboard Icons" on page 728.
l ALM masthead, menus, and sidebar. For details, see "ALM Common Areas"
on page 32.
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UI Element Description

<dashboard
tree>

Organizes dashboard pages under public and private root folders.

l Dashboard pages that you create in a public folder are accessible to all users.
l Dashboard pages that you create in a private folder are accessible only to the
user that created them.

l Public dashboard pages can include only public graphs.

Note:

l Dashboard pages in public folders may show different results for different
users, depending on the data hiding definitions for the user group. For more
information on data permissions, refer to theHP Application Lifecycle
Management Administrator Guide.

l You cannot move dashboard pages within a folder. When you refresh the
tree view, dashboard pages in a folder are alphabetized.

Details tab Displays details of the selected dashboard page or folder. For more details, see
"Details Tab" on page 729.

Configuration
tab

Enables you to configure the selected dashboard page. For user interface details,
see "Configuration Tab - Dashboard Pages" on page 753.

View tab Displays the selected dashboard page. For user interface details, see "View Tab –
Dashboard Pages" on page 754.

Analysis View Menus and Buttons
This section describes themenus and buttons available in the Analysis View module.

To access On the ALM sidebar, underDashboard, select Analysis View.

Important
information

Tip: You can access themenu bar from the Analysis View module by
pressing the shortcut key ALT.

Relevant tasks "How to Analyze Data in ALM" on page 718

See also l "Dashboard Icons" on page 728
l "Analysis View Window" on page 720
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User interface elements are described below:

UI Element (A -
 Z)

Menu Description

Copy URL/Paste Edit Copies a selected analysis item or folder and pastes its URL as a
link. The item itself is not copied. Instead, you can paste the
address into another location, such as an email or a document.
Clicking the link opens ALM and takes you to the item. If you are
not already logged in, ALM first prompts for login details.

Note: Not available in the Analysis Menus tab.

Copy/Paste Edit Copies selected analysis items or folders within the same project or
across projects.

Note: You can copy a project report to another project under
the following conditions:

l The name, type, and category of project templates used by
the report are the same in both projects.

l The report is not based on a baseline.
l All entities covered in the report are defined in the target
project.

Cut/Paste Edit Moves selected analysis items or folders to a different location in
the tree.

When youmove an analysis item from a public folder to a private
folder, it is removed from public dashboard pages in which it is
included.

Tip: You can alsomove an analysis item by dragging it to a
new location in the tree.

Delete
Edit Deletes selected analysis items or folders. You cannot delete the

root folders.

Note:

l Deleting a folder deletes all the items included in it.
l Deleting a graph removes it from dashboard pages that
contain it.

l When you delete graphs or project reports from the Analysis
Menus tab, youmust log out and then log in again in order
for the graph/report to be removed.

Expand/Collapse View Expands/collapses all the nodes under the selected folder.
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UI Element (A -
 Z)

Menu Description

Export Excel
Report
Definition

Edit Enables you to export the selected Excel report definition to an
XML file. You can then import the Excel report definition to another
project.

Note: Not available in the Analysis Menus tab.

Global Search <toolbar> A global search engine enabling you to search across all or a
specific ALMmodule. It includes the followingmodules: Defects,
Requirements, Tests, Test Sets, and Analysis. For more details on
how to install and enable Global Search, see
https://hpln.hp.com/contentoffering/alm-global-search.

Analysis Generates the selected analysis item.

Graphs: The results are displayed in the View tab. If the View tab
is already selected, the analysis item is refreshed with themost up-
to-date data.

Project Reports and Excel Reports: The results are displayed in
an external application.

Graph Wizard Analysis Opens the graph wizard, enabling you to create and configure a
graph. For more details, see "GraphWizard" on page 755.

Import Excel
Report
Definition

Edit Enables you to import an Excel report definition that was previously
exported to an XML file. The report definition is added to the
selected analysis tree folder.

Note: Not available in the Analysis Menus tab.

New Business
View Excel
Report

Analysis Opens the New Business View Excel Report dialog box, enabling
you to create a new business view Excel report in the analysis tree.

New Business
View Graph

Analysis Opens the New Business View Graph dialog box, enabling you to
create a new business view graph in the analysis tree.

New Excel
Report

Analysis Opens the New Excel Report dialog box, enabling you to create a
new Excel report in the analysis tree. For more details, see "New
Excel Report Dialog Box" on page 806.

Note: Not available in the Analysis Menus tab.
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UI Element (A -
 Z)

Menu Description

New Folder
Analysis Opens the New Folder dialog box, enabling you to add a folder

under a selected folder in the analysis tree.

Folders you create under thePrivate root folder are available to the
owner only. Folders you create under thePublic root folder are
available to all users.

Syntax exceptions: The folder name cannot exceed 255
characters, and cannot include the following characters: \ ^ *

Note: Not available in the Analysis Menus tab.

New Graph Analysis Opens the New Graph dialog box, enabling you to create a new
graph in the analysis tree. For more details, see "New Graph Dialog
Box" on page 761.

New Item
Toolbar Enables you to launch the graph wizard, or add a new graph,

business view graph, project report, Excel report, or business view
Excel report, to the analysis tree.

Note:

l Excel reports are not available in the Analysis Menus tab.
l When adding a new graph or project report in the Analysis
Menus tab, youmust log out and then log in again in order to
view the added graph/report.

New Project
Report

Analysis Opens the New Project Report dialog box, enabling you to create a
new project report in the analysis tree. For more details, see "New
Project Report Dialog Box" on page 791.

New Release
Analysis >
Release
Scorecard

Analysis Opens the New Graph dialog box, enabling you to create a new
Release Scorecard graph in the analysis tree. For more details, see
"New Graph Dialog Box" on page 761.

ALM Editions:Functionality related to PPT is available forALM
Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what
edition of ALM you are using, ask your ALM site administrator.
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UI Element (A -
 Z)

Menu Description

New Release
Analysis > KPI
Over Time Graph

Analysis Opens the New Graph dialog box, enabling you to create a new KPI
Over Time graph in the analysis tree. For more details, see "New
Graph Dialog Box" on page 761.

ALM Editions:Functionality related to PPT is available forALM
Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what
edition of ALM you are using, ask your ALM site administrator.

New Release
Analysis > KPI
Breakdown
Graph

Analysis Opens the New Graph dialog box, enabling you to create a new KPI
Breakdown graph in the analysis tree. For more details, see "New
Graph Dialog Box" on page 761.

ALM Editions:Functionality related to PPT is available forALM
Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what
edition of ALM you are using, ask your ALM site administrator.

New Release
Analysis > KPI
Breakdown Over
Time Graph

Analysis Opens the New Graph dialog box, enabling you to create a new KPI
BreakdownOver Time graph in the analysis tree. For more details,
see "New Graph Dialog Box" on page 761.

ALM Editions:Functionality related to PPT is available forALM
Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what
edition of ALM you are using, ask your ALM site administrator.

Refresh
View Refreshes the analysis tree so that it displays themost up-to-date

information.

Rename Edit Enables you to rename the selected analysis item or folder.

Share Analysis
Item

Edit Enables others to view the selected graph or project report outside
ALM. For more details, see "Share Analysis Item Dialog Box" on
page 730.

Available from:Graphs, Project Reports

Note: Not available in the Analysis Menus tab.
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Dashboard View Menus and Buttons
This section describes themenus and buttons available in the Dashboard View module.

To access On the ALM sidebar, underDashboard, select Dashboard View.

Important
information

Tip: You can access themenu bar from the Dashboard View module by
pressing the shortcut key ALT.

Relevant tasks "How to Generate a Dashboard Page" on page 738

See also l "Dashboard Icons" on the next page
l "Dashboard View Window " on page 721

User interface elements are described below:

UI Element (A -
 Z)

Menu Description

Copy URL/Paste Edit Copies a selected dashboard page or folder and pastes its URL as
a link. The item itself is not copied. Instead, you can paste the
address into another location, such as an email or a document.
Clicking the link opens ALM and takes you to the item. If you are
not already logged in, ALM first prompts for login details.

Copy/Paste Edit Copies selected dashboard pages or folders within the same
project or across projects.

When you paste a dashboard page, you choose how ALM copies
the graphs included in the dashboard page.

Cut/Paste Edit Moves selected dashboard pages or folders to a different location
in the tree.

When youmove a dashboard page from a private folder to a public
folder, ALM removes any private graphs from the dashboard page.

Tip: You can alsomove a dashboard page by dragging it to a
new location in the tree.

Delete
Edit Deletes selected dashboard pages or folders. You cannot delete

the root folders.

Note: Deleting a folder deletes all the items included in it.

Expand/Collapse View Expands/collapses all the nodes under the selected folder.
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UI Element (A -
 Z)

Menu Description

Export Dashboard Saves the selected dashboard page as a PDF file, enabling you to
print the dashboard page.

The following options are available:

Dashboard Page Layout. The dashboard page is saved in its
original format.

One Item Per Page Layout. Each graph on the dashboard page
is saved on a separate page.

Available from:View tab

Dashboard Generates the selected dashboard page, and displays it in the
View tab.

If the View tab is already selected, the dashboard page is
refreshed with themost up-to-date data.

New Folder
Dashboard Opens the New Folder dialog box, enabling you to add a folder

under a selected folder in the dashboard tree.

Folders you create under thePrivate root folder are available to
the owner only. Folders you create under thePublic root folder are
available to all users.

Syntax exceptions: The folder name cannot exceed 255
characters, and cannot include the following characters: \ ^ *

New Page
Dashboard Opens the New Dashboard Page dialog box, enabling you to

create a new dashboard page. For more details, see "New
Dashboard Page Dialog Box" on page 763.

Refresh
View Refreshes the dashboard tree so that it displays themost up-to-

date information.

Rename Edit Enables you to rename the selected dashboard page or folder.

Dashboard Icons
This section describes the icons displayed in the Dashboardmodules.

To access On the ALM sidebar, underDashboard, select Analysis View orDashboard
View.

Relevant
tasks

"How to Analyze Data in ALM" on page 718
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User interface elements are described below:

UI
Element

Description

Analysis Folder. A folder for organizing analysis items or dashboard pages.

Dashboard Page. A dashboard page in the dashboard tree.

Excel Report. An Excel report in the analysis tree.

Business View Excel Report. A business view Excel report in the analysis tree.

Graph. A graph in the analysis tree.

Business View Graph. A business view graph in the analysis tree.

KPI Breakdown Graph. A project planning and tracking (PPT) graph in the analysis
tree.

KPI Breakdown Progress Graph. A project planning and tracking (PPT) graph in the
analysis tree.

KPI Progress Graph. A project planning and tracking (PPT) graph in the analysis tree.

Project Report. A project report in the analysis tree.

Release Scorecard Graph. A project planning and tracking (PPT) graph in the analysis
tree.

Details Tab
This tab displays details of the selected analysis item, dashboard page, or folder.

To access On the ALM sidebar, underDashboard, select Analysis View orDashboard
View, and select an item or folder.

Important
information

l You can edit theName and Title fields. Other fields in this dialog box are read-
only.

l Clicking in theDescription field in this tab displays a toolbar for formatting
and spell checking the text.

Relevant tasks "How to Analyze Data in ALM" on page 718

See also "Analysis View Window" on page 720
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User interface elements are described below:

UI
Elements

Description

Entity The data set sampled by the analysis item.

Available from:Analysis items

Type The analysis item type.

Available from:Analysis items

Sub Type The type of graph.

Name The tree display name of the analysis item, dashboard page, or folder.

In graphs, the default title displayed above the graph.

Last
Modified

The date and time on which the analysis item or dashboard page was last modified.

Modified By The user who last modified the analysis item or dashboard page.

Owner/Page
Owner

The user that created the analysis item, dashboard page, or folder. Permissions to
modify public items may be limited to the owner only.

Title The title displayed in the header of the dashboard page.

Available from:Dashboard pages

Share Analysis ItemDialog Box
This dialog box enables you to share a graph or a project report for viewing outside ALM client.

To access In the analysis tree, right-click a graph or project report, and select Share
Analysis Item.

Important
information

l You can adjust the width and height of a graph by adding the&width=xx or
&height=xx attributes to the end of the URL.

l This option is not available in the Analysis Menus tab.

Relevant tasks l "How to Generate a Graph" on page 736
l "How to Create Project Reports" on page 776

See also "Analysis View Window" on page 720
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User interface elements are described below:

UI Element Description

Copy Analysis Item
URL (Authentication
Required)

Copies a URL of the selected graph or report to the clipboard.

You are required to enter an ALM user name and password to view the
graph or report.

Copy Analysis Item
Public URL

Copies a URL of the selected graph or report to the clipboard.

No authentication is required.

Reset Analysis Item
Public URL

If you previously selectedCopy Analysis Item Public URL, selecting
this option blocks access to the public read-only version of the selected
graph or report.

User Guide
Chapter 41: Introducing Analysis

HP ALM (12.50) Page 731



Page 732HP ALM (12.50)

User Guide
Chapter 41: Introducing Analysis



Chapter 42: Graphs and Dashboard Pages
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• Graphs and Dashboard Pages Overview 734
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• Graphs and Dashboard Pages User Interface 743
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Graphs and Dashboard Pages Overview
HP Application Lifecycle Management (ALM) graphs help you analyze and view the relationships
between different types of data.

You can create the following types of graphs in ALM:

l Business View Graphs. A graph based on a business view represents either a single entity or
multiple entities, and reflects business value information only. For more information about business
view graphs, see "Business View Graphs Overview" on the next page.

l Entity Graphs. Each graph is based on a single entity only, such as requirements or defects, and
enables you to view any of the entity's attributes.
When creating an Entity graph, you can use several graph types. For more information on available
types, see "Entity Graph Types" on page 739.
When viewing Entity graphs, you can drill down to the records represented by each bar or segment.

After you have created graphs in the Analysis View module, you can select and arrangemultiple
graphs, and view them side-by-side in a dashboard page.

You can create graphs that include data frommultiple ALM projects.

Creating Graphs
The following table lists the various options for creating graphs:

Option Description Available From Graph Types

Predefined Enable you to quickly analyze data related to a
specific module. Predefined graphs display data
from the existingmodule filter.

You can save predefined graphs in the Analysis
View module for future reference.

l Business
Components
module

l Defects
module

l Requirement
s module

l Test Lab
module

l Test Plan
module

Entity

Analysis
View
module

Enables you to filter data, set various
configurations, and organize the graphs in
folders.

Analysis View
module

l Entity
l Business
View
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Option Description Available From Graph Types

Graph
Wizard

Guides you through the stages of creating and
configuring a graph.

l Analysis
View module

l Business
Components
module

l Defects
module

l Requirement
s module

l Test Lab
module

l Test Plan
module

l Entity
l Business
View (from
Analysis View
module only)

ALM Editions:Cross-project graphs are not available for Quality Center Enterprise Edition or
Performance Center Edition. For more information about ALM editions and their functionality, see
"ALM Editions" on page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

For related tasks, see "How to Generate a Graph" on the next page and "How to Generate a Dashboard
Page" on page 738.

Business View Graphs Overview
A business view is a data layer that exists on top of the database and which reflects only those project
entity fields that represent information that is useful from a business perspective.

Example

A business view based on the Baselines entity could contain theName, Description, and
Baseline ID fields. This is because these fields convey information that could be of importance to
the graph consumer who needs to understand baseline information from a business perspective
only. By the same logic, the same business view would not include theAttachment andAuto
complete type fields, as they are of little business significance.

Business views can be based on single entities, such anBaselines orDefects, while others can
represent more complex relationships between entities, such as Defects With Linked Requirements.

The advantage of creating graphs based on business views is that it ensures a standardization across
the graphs. Different graphs based on the same business view reflect a common frame of reference.
This provides genuine business value to the graphs' consumer, thereby making themmoremeaningful.
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In addition to the pre-defined business views, additional views can be created in Project
Customization. For more information, refer to theHP Application Lifecycle Management Administrator
Guide.

Business View graphs are always the Summary graph type.

By default, Business View graphs display 100MB of data. You can change this setting by modifying the
MAX_GRAPH_RESULT_DATA_TABLE_VOLUME parameter in the Site Configuration tab. For
more information, refer to theHP Application Lifecycle Management Administrator Guide.

How to Generate a Graph
This task describes how to analyze data in ALM using graphs.

To learnmore about graphs, see "Graphs and Dashboard Pages Overview" on page 734.

This section contains:

l "Create a graph" below
l "Configure a graph" on the next page
l "View a graph" on the next page
l "Edit graph categories" on the next page
l "Entity graphs: Drill down to graph data" on the next page
l "Share a graph outside ALM" on page 738
l "Create a dashboard page" on page 738

1. Create a graph
Use one of the following:
l Launch the Graph Wizard
TheGraphWizard guides you through the steps involved in creating a Business View or an
Entity graph and configuring its settings. You launch the graph wizard either from the Analysis
View module, or while working in one of the other ALMmodules.
In the Analysis View module. On the ALM sidebar, underDashboard, select Analysis
View, right-click a folder, and select Graph Wizard. You use this method to create Business
View and Entity graphs.
In other modules. In the Requirements, Business Components, Test Plan, Test Lab, or
Defects module, select Analysis > Graphs > Graph Wizard. This method creates Entity
graphs only.
For user interface details, see "GraphWizard" on page 755.

l Entity graphs: Create a predefined graph
While working in the Requirements, Business Components, Test Plan, Test Lab, or Defects
module, generate an impromptu graph to analyze themodule data.
In any of the abovemodules, select Analysis > Graphs and select one of the predefined
graphs. For user interface details, see "View Tab - Graphs/GraphWindow" on page 749.

l Create a graph in the Analysis View module
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i. Open the Analysis View module. On the ALM sidebar, underDashboard, select
Analysis View.

ii. Add a folder to the analysis tree. Right-click a folder under the Private or Public root
folder, and select New Folder.

iii. Create a new graph. Right-click a folder, and select the graph type. For entity graphs,
select New Graph, and for business view graphs select New Business View Graph.
Fill in the fields in the New Graph dialog box or New Business View Graph dialog box
respectively.
For New Graph dialog box user interface details, see "New Graph Dialog Box" on
page 761.

2. Configure a graph
Configure graph settings, such as data filtering, grouping, and x-axis values.
Click theConfiguration tab. For user interface details, see "Configuration Tab/Window - Graphs"
on page 744.
Available from:Analysis View module

3. View a graph
Use one of the following:
l In the Analysis View module. Click theView tab.
l In other modules. From themodulemenu, select Analysis > Most Recently Used and
select a recently used graph. The selected graph opens in the Analysis View module.

For user interface details, see "View Tab - Graphs/GraphWindow" on page 749.

4. Edit graph categories
You can group together values in the grouped-by or x-axis field, and display the combined data as
a single category.

a. In the View tab or graph window, click theEdit Categories arrow , and select one of the
available options.

b. Create or change existing categories. For user interface details, see "Edit <Type> Categories
Dialog Box" on page 764.

Example

Suppose thePriority field is selected in the graphGrouped By field, and thePriority
field has five values: Low, Medium, High, Very High, and Urgent. Youmight combine the
values Medium and High into a category Important, and the values Very High and
Urgent into a category Critical. The graph would then display data divided into three
categories: Low, Important, and Critical.

5. Entity graphs: Drill down to graph data
In bar and pie charts, you can drill down to the records represented by a selected bar or segment,
and view details of individual records.
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ALM Editions:Cross-project graphs are not supported in Quality Center Enterprise Edition.
For more information about ALM editions and their functionality, see "ALM Editions" on
page 115. To find out what edition of ALM you are using, ask your ALM site administrator.

a. In the View tab or graph window, click a segment or bar in the graph.
b. If the segment or bar represents records frommultiple projects, the Project Selection dialog

box opens. Select a project.
c. If you selected to view data from another project, or if the segment or bar represents records

from only another project, the project opens in a separate browser window. If applicable, you
are prompted to log in. The records are displayed in the relevant ALMmodule.

d. If the segment or bar represents records from only the current project, or if you selected to
view data from the current project, the records are displayed in the Drill DownResults dialog
box. For user interface details, see "Drill DownResults Dialog Box" on page 766.

6. Share a graph outside ALM
Allow ALM users or others to view read-only versions of graphs outside ALM.
a. In the analysis tree, right-click a graph, and select Share Analysis Item.
b. In the Share Analysis Item dialog box, select a share option. For details of the options, see

"Share Analysis Item Dialog Box" on page 730.
A URL of the selected graph is copied to the clipboard.

c. Paste the URL in a website or email.
d. Click the URL to open a read-only version of the graph in aWeb browser. Each time you

access the graph, after set intervals, it displays themost up-to-date information.

Note: You can change the frequency at which graph data is updated by adding and
configuring theGRAPH_RESULT_LIFESPAN site configuration parameter. For more
details, refer to theHP Application Lifecycle Management Administrator Guide.

Available from: Analysis View module

7. Create a dashboard page
View several graphs together in a dashboard page. For task details, see "How to Generate a
Dashboard Page" below.

How to Generate a Dashboard Page
This task describes how to generate a dashboard page in which you can arrangemultiple graphs in a
single view.

To watch amovie on how to generate a dashboard page, refer to this section in the ALMOnline Help.
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This task includes the following steps:

l "Prerequisites" below
l "Create a dashboard page" below
l "Configure a dashboard page" below
l "View a dashboard page" below

1. Prerequisites
Graphs are defined in the Analysis View module. For task details on how to create graphs, see
"How to Generate a Graph" on page 736.

2. Create a dashboard page
Add a dashboard page to a folder in the dashboard tree.
a. Open the Dashboard View module. On the ALM sidebar, underDashboard, select

Dashboard View.
b. Add a folder to the dashboard tree. Right-click a folder under the Private or Public root

folder, and select New Folder.
c. Create a new dashboard page. Right-click a folder, and select New Page. Type a name for

the dashboard page. For user interface details, see "New Dashboard Page Dialog Box" on
page 763.

d. Click theDetails tab, and add a description of the dashboard page. For user interface details,
see "Details Tab" on page 729.

3. Configure a dashboard page
Arrange the graphs you want to include on a dashboard page.
In the Dashboard View module, select a dashboard page, and click theConfiguration tab. For
user interface details, see "Configuration Tab - Dashboard Pages" on page 753.

4. View a dashboard page
Generate and view dashboard pages.
In the Dashboard View module, select a dashboard page, and click theView tab. For user
interface details, see "View Tab – Dashboard Pages" on page 754.

Entity Graph Types
ALM enables you to generate graphs for requirements, tests, test instances, test runs, defects, and
business components. For each entity, different graph types are available.

This section includes:

l "Requirements Graphs " on the next page
l "Test Plan Graphs" on the next page
l "Test LabGraphs" on page 741
l "Defects Graphs" on page 742
l "Business Component Module Graphs" on page 742
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Requirements Graphs
You can generate the following graphs for requirements:

Graph Description

Requirements
Coverage
Graph

Shows how many requirements are currently in an ALM project, according to their
test coverage status.

Note:

l Available from the Requirements module only.
l The CoverageGraph is a specific type of the Requirements Summary
Graph. If you select a different x-axis value, a regular Summary Graph is
displayed.

Requirements
Progress
Graph

Shows how many requirements accumulated in an ALM project at specific points
during a period of time.

Specify the time interval displayed along the x-axis, and the requirement
information by which ALM groups the data. Specify whether you want to view the
number of requirements or the change in the number of requirements.

Requirements
Summary
Graph

Shows how many requirements are currently in an ALM project.

Specify the type of data displayed along the x-axis, and the requirement
information by which ALM groups the data.

Requirements
Trend Graph

Shows the history of changes to specific requirement fields in an ALM project, for
each time interval displayed.

Specify the field for which you want to view the number of changes, and the time
period for which you want to view data.

Each status change is only recorded once for the purpose of this graph. For
example, if a field was changed from Not Completed to Passed to Not
Completed, the Not Completed status change will only be recorded once in this
graph.

Test Plan Graphs
You can generate the following graphs for tests:

Graph Description

Test Plan
Progress
Graph

Shows how many tests accumulated in an ALM project at specific points during a
period of time.

Specify the time interval displayed along the x-axis and the test plan information by
which ALM groups the data. Specify whether you want to view the number of tests or
the change in the number of tests.
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Graph Description

Test Plan
Summary
Graph

Shows how many tests are currently in an ALM project.

Specify the type of data displayed along the x-axis, and the test plan information by
which ALM groups the data.

Test Plan
Trend
Graph

Shows the history of changes to specific Test Plan fields in an ALM project, for each
time interval displayed.

Specify the field for which you want to view the number of changes, and the time period
for which you want to view data.

Each status change is only recorded once for the purpose of this graph. For example, if
a field was changed from Ready to Repair to Ready, the Ready status change will only
be recorded once in this graph.

Test Lab Graphs
You can generate the following graphs for test instances and runs:

Test Set Graphs

Graph Description

Test Set
Progress
Graph

Shows how many tests accumulated in test sets at specific points during a period of
time.

Specify the time interval displayed along the x-axis, and the test information by which
ALM groups the data. Specify whether you want to view the number of tests or the
change in the number of tests.

Note: If you create the graph in the Test Labmodule, you can choose whether to
include only the current test set or all test sets.

Test Set
Summary
Graph

Shows how many tests in an ALM project belong to test sets.

Specify the type of data displayed along the x-axis, and the test plan and test in test set
information by which ALM groups the data.

Note: If you create the graph in the Test Labmodule, you can choose whether to
include only the current test set or all test sets.

Test Run Graphs

Graph Description

Test Run Summary Graph Shows the status of runs in the project, grouped by Tester.
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Defects Graphs
You can generate the following graphs for defects:

Graph Description

Defects
Age
Graph

Shows the lifetime of defects in an ALM project. The lifetime of a defect begins when it
is reported, and ends when it is closed.

Specify the defect information by which ALM groups the data, and the data displayed
along the y-axis. Specify the time interval that you want to use to divide the data.

The age of aClosed defect is the difference between the date on which it was reported
and the date on which it was closed. After a defect is closed, its age remains static.

Defects
Progress
Graph

Shows the accumulation of defects in an ALM project, or the estimated/actual amount
of time taken to fix these defects, at specific points during a period of time.

Specify the time interval displayed along the x-axis, the defect information by which
ALM groups the data, and the data displayed along the y-axis. Specify whether you
want to view the number of defects or the change in the number of defects.

Defects
Summary
Graph

Shows a summary of the number of defects in an ALM project, or the estimated/actual
amount of time taken to fix these defects.

Specify the type of data displayed along the x-axis, the type of data displayed along the
y-axis, and the defect information by which ALM groups the data.

Defects
Trend
Graph

Shows the history of changes to specific defect fields in an ALM project, for each time
interval displayed.

Specify the field for which you want to view the number of changes, and the time period
for which you want to view data. Each priority change is only recorded once for the
purpose of this graph. For example, if a field was changed from Urgent to Very High to
Urgent, the Urgent priority change will only be recorded once in this graph.

Business Component Module Graphs
You can generate the following graphs for business components:

Graph Description

Components
Summary - Group by
'Status' Graph

Shows how many components are currently in the ALM project. The
number of components is displayed according to the criteria that you
specify.

Specify the type of data displayed along the x-axis, and the test plan
information by which ALM groups the data. By default, the graph appears
as a bar chart.
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Graph Description

Components
Progress - Group by
'Status'

Shows the history of changes to specific component fields in a ALM
project, at each point during a period of time.

Specify the field for which you want to view the number of changes, and
the time period for which you want to view data. The graph can be viewed
as a bar chart only.

Components Trend -
Group by 'Status'

Shows the history of changes to specific component fields in a ALM
project, at each point during a period of time.

Specify the field for which you want to view the number of changes, and
the time period for which you want to view data. The graph can be viewed
as a bar chart only.

Graphs and Dashboard Pages User Interface
This section includes:

• Configuration Tab/Window - Graphs 744
• View Tab - Graphs/GraphWindow 749
• Configuration Tab - Dashboard Pages 753
• View Tab – Dashboard Pages 754
• GraphWizard 755
• New Graph Dialog Box 761
• Select Business View Dialog Box 762
• New Dashboard Page Dialog Box 763
• Select Projects Dialog Box 763
• Edit <Type> Categories Dialog Box 764
• Graph Appearance Dialog Box 765
• Drill DownResults Dialog Box 766
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Configuration Tab/Window - Graphs
The Configuration tab in the Analysis View module and the graph configuration window in the project
reports' Configuration tab enable you to select data to be included in a graph.

ALM Editions:Cross-project graphs are not supported in Quality Center Enterprise Edition. For
more information about ALM editions and their functionality, see "ALM Editions" on page 115. To
find out what edition of ALM you are using, ask your ALM site administrator.

To access Configuration tab:

Use one of the following:

l In the Analysis View module, select a graph, and click theConfiguration tab.
l If you have the required administrator permissions, in the Analysis View module's
Analysis Menus tab, select a graph and click theConfiguration tab.

Configuration window:

1. On the ALM sidebar, underDashboard, select Analysis View.
2. Expand the analysis tree and select a project report.
3. In the project report, select a section node.
4. In the Graph Selection area, select a graph and click Configure.

Important
information

The available configuration options depend on the graph type.

Relevant
tasks

l "How to Generate a Graph" on page 736
l "How to Analyze Data in ALM" on page 718

See also l "Graphs and Dashboard Pages Overview" on page 734
l "Analysis View Window" on page 720

User interface elements are described below:

UI Element Graph Type Description

Business View Business
View

Enables you to select a business view on which to base the
graph. Click the browse button next to the box, and select the
desired business view from the list and click OK.
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UI Element Graph Type Description

Period Entity
(progress and
trend graphs
only)

The time period covered by the graph. Select a time period
from the drop-down list:

l Custom. A time period between any two dates. Set the
start and end dates.

l Week/Month/Quarter/Year. A fixed time period any time
in the past. Use the arrows to jump to the next or previous
period, or set the start or end date of the period in the drop-
down calendars.

l Last. A time period ending at the current date. Select a
time unit (day, week, month, quarter, or year) and set the
number of time units you want to cover in the graph.

l All days. Includes all time periods from the beginning of
the project until the current date.

Age Grouping Entity
(Defects only)

You can group all defects older than a certain period (for
example, older than six months) in one column, and all
defects more recent than that period in a second column.
Alternatively, you can group the defects by all available
periods.

l Select a period to group the defects in two columns.
l Select No grouping to view all of the available periods.

Resolution Entity
(progress and
trend graphs
only)

The time interval at which data is grouped on the x-axis.

Display Options Entity
(progress
graphs only)

l Select Raw Data to view the number of requirements,
tests, or defects over the period of time you selected.

l Select Changes over Time to view the change in the
number of requirements, tests, or defects over the period
of time you selected. Each record begins at 0.

Y-Axis l Business
View

l Entity
(summary
and age
graphs
only)

Select the data that displays on the y-axis.

l Select Count to display the total number of items (for
example, a count of open defects).

l Business View graphs. Select Count Distinct and choose
a field to display distinct values for that field.

l Select Sum of and choose a numerical field. For example,
in Defects graphs, chooseEstimated Fix Time to display
the estimated time required for fixing the defects. Choose
Actual Fix Time to display the actual time spent on fixing
the defects.
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UI Element Graph Type Description

X-Axis l Business
View

l Entity
(summary
graphs
only)

The information displayed along the x-axis of the graph.

Tip: In cross-project graphs, select QC Projects to
display the data by project.

Grouped By l Business
View

l Entity

Select a field to determine the information by which ALM
groups data in the graph. You can group the data only by
string or list fields.

Tip: For cross-project graphs, select QC Projects to
group the data by project.

Progress or Trends graphs: If you set a filter on the same
field as theGroup By field, groups in the graphs may include
values that you filtered out. This is because in progress and
trend graphs the filter operates on current values, while
groupings operate on historical values. For example, say the
Group By field in a Defects graph is set toStatus, and the
current filter includes all defects whose status is Open.
When the graph is generated, all previous statuses of the
open defects, such as Rejected, will appear in the graph
even if Rejectedwas not included in the filter.

Show 'Not
Covered' parents

Entity
(Requirements
only)

Choose whether to include parent requirements with a Not
Covered status.

Show full path Entity
(summary
graphs only)

In summary graphs, if you select Subject, Plan: Subject,
Test: Subject, or Test Set: Name in theX-Axis field, ALM
displays the full path of the test subject folder.
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UI Element Graph Type Description

Filter State Enables you to set dynamic filter conditions for graphs that
are generated from within the Analysis menu in specific
modules.

l Custom. Enables you to define a customized filter in the
Analysis Menus tab.

l Special filters. The following predefined filtering options
are provided:

Note:When adding a graph to an Analysis Menu of a
different module type from the new graph, youmust
use theCustom filter type. Selecting a special filter
results in the graph being generated with no filter at all.
For example, if you add a Defects graph to the
Requirements Analysis Menu, and select the
Context filtering option, ALM ignores the selection
and generates the graph with no filter at all.

l Context. Filters information according to the filter that
is currently selected in themodule.

l Selected. Includes information for the currently
selected entity in themodule only.

Note: In the Test Labmodule, the selected entity
is the selected test run instance, and not the
selected test set.

l Selected with Children. For hierarchical entities,
includes information for the selected parent entity as
well as child entities.

l Current Entity Based. Includes information for the
currently focused item in themodule. You use this
option to generate a graph in the Test Labmodule on
the test set level.

Available from:Analysis Menus tab only. Youmust have
the required administrator permissions to view this tab.

Entity Set Filter. Enables you to filter the data according to the
criteria you choose. For details, see "Select Filter Condition
Dialog Box" on page 61.

The current filter is displayed in the filter box.

Note: Setting the filter to the same field as theGrouped
By field, may cause historical data to appear in the
graph.
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UI Element Graph Type Description

l Business
View

l Entity

Clear Filter. Clears the current filter.

Business
View

Copy/Paste Filter Settings. Enables you to copy and paste
filter settings from one Business View graph to another.

This is useful for reproducing complex filters in several
graphs.

Note: You can perform this action only if the following
conditions aremet:

l The source and the target graphs must contain fields
with the same technical names.

l The target graph does not contain more fields than the
source graph, though it may contain less.

<field filter table> Business
View

Enables you to filter data for Business View graphs.

l Field name. Lists the fields in the business view.
l criteria. Enables you to define filter criteria for each field.
l OR. An optional column that appears when you define a
filter condition for a field. Enables you to define additional
filters for that field.

Note: Filter criteria for dates and strings must be
preceded by an equals sign.

l Business
View

l Entity

Opens the Select Projects dialog box, enabling you to change
the list of projects in the Cross Project Selection grid. For
details, see "Select Projects Dialog Box" on page 763.

Available from: Configuration tab (not available in the
Analysis Menus tab)
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UI Element Graph Type Description

Project Selection l Business
View

l Entity

Projects included in the graph.

To change the list of projects included in the graph, click the
Select Projects button.

Note:

Whenworking with Entity graphs, be aware of the
following:

l Every time you add or remove projects in your graph,
ALM updates the fields in the Filter dialog box and the
drop-down lists of the following boxes: X-Axis, Y-
Axis andGrouped By. The lists contain only fields
that are identical in all the selected projects. Identical
fields are fields that have the same field name, label
and data type. For more information on customizing
fields, see theHP Application Lifecycle Management
Administrator Guide.

l If you defined a filter condition using a field that
becomes unavailable, that condition is removed.

l If you selected a field in theX-Axis, Y-Axis and
Grouped By boxes that becomes unavailable, the
first field in the drop-down list is selected.

Available from: Configuration tab (not available in the
Analysis Menus tab)

View Tab - Graphs/Graph Window
The View tab enables you to view saved graphs in the Analysis View module, and analyze the graph
data.

The graph window in the Requirements, Business Components, Test Plan, Test Lab, and Defects
modules enables you to view predefined graphs to analyze data during your work in thosemodules.

User Guide
Chapter 42: Graphs and Dashboard Pages

HP ALM (12.50) Page 749



To
access

View tab:

Use one of the following:

l In the Analysis View module, select a graph, and click theView tab.
l If you have the required administrator permissions, in the Analysis View module's
Analysis Menus tab, select a graph and click theView tab.

l In the Requirements, Test Plan, Test Lab, Defects, or Business Components
module, chooseAnalysis >Most Recently Used, and select a graph.

Graph window:

Use one of the following:

l In the Requirements, Test Plan, Test Lab, Defects, or Business Components
module, chooseAnalysis > Graphs, and select a graph type.

l In the Analysis View module, select a project report in the analysis tree. In the project
report, select a section node and in the Graph Selection area click View.

Relevant
tasks

l "How to Generate a Graph" on page 736
l "How to Analyze Data in ALM" on page 718

See also l "Graphs and Dashboard Pages Overview" on page 734
l "Analysis View Window" on page 720

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Generate. Refreshes the graph so that it displays themost up-to-date
information.

Bar Chart. In summary, trend and age graphs, switches the chart format
to a bar chart.

Pie Chart. In summary graphs, switches the chart format to a pie chart.

In pie charts, the x-axis categories are displayed as pie segments. The y-
axis quantities are represented by the size of the segments.

Note: Pie charts do not display the Grouped By field.

Line Chart. In progress graphs, switches the chart format to a line chart.

Data Grid. The grid creates amatrix of the graph's x-axis andGrouped
By categories. A Total row is added that displays the total of each
Grouped By category. Available in all graph types.
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UI Element Description

Show/Hide Total Values. In progress graphs, shows/hides a <total>
category to the graph, representing the sum of of all the other Grouped By
categories.

Tip: After showing the <total> category, click its label in the legend
to hide the category.

Scroll to the Left/Right. Scrolls the graph to the left or right. These
buttons are enabled when the Zoom In and ZoomOut buttons are in use.

Show All. Restores the graph to its normal size. This button is enabled
when the Zoom In and ZoomOut buttons are in use.

Zoom In/Out. Changes themagnification of the graph.

Save Graph Image. When viewing a graph as a bar, pie chart, or line
chart, saves the graph image. You can select from a variety of graphic file
formats.

Save Graph Data. When viewing a data grid, saves the graph data. You
can save the data as an Excel spreadsheet, aWord file, an HTML
document, or a text file.

Set Graph Appearance. Opens theGraph Appearance dialog box,
enabling you to customize the graph title, graph color, and graph display.
For more details, see "Graph Appearance Dialog Box" on page 765.

Copy Graph to Clipboard. Includes the following options:

l Copy Graph (Color). Copies the graph in color to the Clipboard.
l Copy Graph (Monochrome). Copies the graph inmonochrome to the
Clipboard.

l Copy Full Screen Graph (Color). Copies the graph in color to the
Clipboard, enlarged to fit full screen.

l Copy Full Screen Graph (Monochrome). Copies the graph in
monochrome to the Clipboard, enlarged to fit full screen.

Print Graph. Includes the following options:

l Print Graph (Color). Prints the graph in color. This is the default
button option.

l Print Graph (Monochrome). Prints the graph inmonochrome.
l Print Graph and Details (Color). Prints the graph and its description
in color.

l Print Graph and Details (Monochrome). Prints the graph and its
description in monochrome.
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UI Element Description

Edit Categories. Enables you to combineX-Axis andGrouped By field
values into categories. The following options are available:

l Edit X-Axis Categories. Opens the Edit X Axis Categories dialog
box, enabling you to display combined x-axis values as a single
category in the graph. This option is available only for summary graphs
and Requirements Coverage graphs. This is the default button option.
For details, see "Edit <Type> Categories Dialog Box" on page 764.

l Reset X-Axis Categories. Removes combined categories of x-axis
values, and resets the graph display.

l Edit Group by Categories. Opens the Edit 'Group By' Categories
dialog box, enabling you to display combined grouped-by values as a
single category in the graph. For details, see "Edit <Type> Categories
Dialog Box" on page 764.

l Reset Group by Categories. Removes combined categories of
grouped-by values, and resets the graph display.

For more details, see "Edit <Type> Categories Dialog Box" on page 764.

Full Screen. Opens the graph in a new window andmaximizes its
display.

Note: The toolbar remains visible in full-screenmode.

Tip: To return to the standard view, click theClose button in the top-
right corner of the window.

Available from:View tab

In the graph window, opens the New Graph dialog box, enabling you to
save the graph to a folder in the Analysis View module.

Available from:Graph window

<graph area> You can perform the following actions in the graph area:

l In bar or pie charts, to further analyze the data, drill down to the graph's
data by clicking on a segment in the graph.

l Right-click an area in the chart to change its color.
l Hover over a bar or segment to view a tooltip containing the area's
category, x-axis, and y-axis values.

<graph title> Click a graph title to change the graph's titles and appearance. For user
interface details, see "Graph Appearance Dialog Box" on page 765.
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UI Element Description

<legend> In line or bar charts, displays the chart categories and their corresponding
color.

You can perform the following actions in the legend box:

l In progress and trend graphs, click a category checkbox to show or
hide the category in the graph.

l Right-click a category to change its color.

Configuration Tab - Dashboard Pages
This tab enables you to design a dashboard page by selecting and arranging graphs on the page.

To access 1. On the ALM sidebar, underDashboard, select Dashboard
View.

2. Expand the dashboard tree, and select a dashboard page.
3. Click theConfiguration tab.

Important information In public dashboard pages you can include only public graphs.

Relevant tasks l "How to Generate a Dashboard Page" on page 738
l "How to Analyze Data in ALM" on page 718

See also l "Graphs and Dashboard Pages Overview" on page 734
l "Analysis View Window" on page 720

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<configuration
pane>

Contains placeholders representing graphs selected for the current dashboard
page.

Rearrange the graphs on the page:

l Drag the placeholders to new positions.
l Expand or reduce the placeholders.

Note: Themaximum number of graphs that a dashboard page can display is
limited by theDASHBOARD_
PAGE_ITEM_LIMIT site parameter. For more information, refer to theHP
Application Lifecycle Management Administrator Guide.

Expand.Maximizes the size of the graph to cover a whole row.

Contract. Reduces the size of the graph to cover half a row.

Remove. Removes the graph from the dashboard page.
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UI Element Description

Graphs Tree
pane

This pane displays graphs in the analysis tree.

Expand the tree and drag graphs to the configuration pane.

Add Graph to Dashboard Page. Adds the selected graph to the configuration
pane. A placeholder representing the graph is created in the next vacant row.

Show Entity Details. Opens the Details dialog box for the selected entity in read-
only mode.

Go to Entity in Module Tree. Navigates to the selected entity's location in that
entity's module, and highlights the entity.

Refresh. Refreshes the graph tree so that it includes themost up-to-date
information.

View Tab –Dashboard Pages
This tab enables you to view a dashboard page, and drill down to the graph data.

To access 1. On the ALM sidebar, underDashboard, select Dashboard View.
2. Expand the dashboard tree, and select a dashboard page.
3. Click theView tab.

Important
information

The View tab displays two rows of the dashboard page. Use the vertical scroll bar
to scroll up or down the dashboard page.

Relevant
tasks

l "How to Generate a Dashboard Page" on page 738
l "How to Analyze Data in ALM" on page 718

See also l "Graphs and Dashboard Pages Overview" on page 734
l "Analysis View Window" on page 720

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Export to PDF. Enables you to save the dashboard page as a PDF file.

Generate All Graphs in Page/Generate Graph. Refreshes all the graphs on the
page, or the selected graph, so that they display themost up-to-date information.
ALM updates the Last Generated time and date.
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UI Element Description

View Page in Full Screen. Displays the dashboard page in full-screenmode.

View Graph in Full Screen. Displays the graph in full-screenmode. You can use
the toolbar buttons to adjust the graph's display, save or print the graph. The
adjustments youmake to the graph's display are reset when you regenerate the
graph. For more details on viewing the graph, see "View Tab - Graphs/Graph
Window" on page 749.

Tip: To return to the standard view, click theClose button, located in the upper-
right corner of the page.

Go To Graph in Analysis Tree. Navigates to the selected graph in the analysis
tree, enabling you to configure the graph data, or change the graph viewing settings.

<chart area> In bar or pie charts, drill down to the graph's data by clicking on a segment in the
graph.

<legend> In bar or pie charts, displays the chart categories and their corresponding color.

Graph Wizard
This wizard enables you to create and configure a new graph in the Analysis View module.

To
access

Use one of the following:

l On themenu of the Requirements, Test Plan, Test Lab, or Defects module, select
Analysis > Graphs > Graph Wizard.

l On the ALM sidebar, underDashboard, select Analysis View, and select Analysis
> Graph Wizard.

l On the ALM sidebar, underDashboard, select Analysis View. Expand the analysis
tree and select a project report. In the project report, select a section node and in the
Graph Selection area click New.

Relevant
tasks

l "How to Generate a Graph" on page 736
l "How to Analyze Data in ALM" on page 718

Wizard
map

This wizard contains:

"Select Graph Type Page" on the next page > "Select Business View Page" on the next
page > "Select Entity Type Page" on page 757 > "Select Projects Page" on page 757 >
("Select Test Set Option Page" on page 758) > "Select Filter Page" on page 759 >
"Select Graph Attributes Page" on page 760 > ("Select Coverage Page" on page 761)

See also l "Graphs and Dashboard Pages Overview" on page 734
l "Analysis View Window" on page 720
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Select Graph Type Page

This wizard page enables you to select the type of graph to create.

Important
information

General information about this wizard is available here: "GraphWizard" on the
previous page.

Available from:Analysis View module.

Wizard
map

The "GraphWizard" on the previous page contains:

"Select Graph Type Page" above > "Select Business View Page" below > "Select
Entity Type Page" on the next page > "Select Projects Page" on the next page >
"Select Test Set Option Page" on page 758 > "Select Filter Page" on page 759 >
"Select Graph Attributes Page" on page 760 > "Select Coverage Page" on page 761

User interface elements are described below:

UI
Element

Description

Graph
Type

The type of graph that you want to create:

Business View Graph. Based on a business view, which is defined in project
customization. For more information about business view graphs, see "Graphs and
Dashboard Pages Overview" on page 734.

Entity Graph. Based on a specific entity. For the entity you select, different graph types
are available.

Select Business View Page

This wizard page enables you to select the business view on which to base the graph.

Important
information

l General information about this wizard is available here: "GraphWizard" on the
previous page.

l Available only if you selectedBusiness View Graph in the "Select Graph Type
Page" above.

Wizard
map

The "GraphWizard" on the previous page contains:

"Select Graph Type Page" above> Select Business View > "Select Entity Type
Page" on the next page > "Select Projects Page" on the next page > "Select Test Set
Option Page" on page 758 > "Select Filter Page" on page 759 > "Select Graph
Attributes Page" on page 760 > "Select Coverage Page" on page 761

User interface elements are described below:

UI Element Description

Business Views tree Lists the business views available for selection.
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Select Entity Type Page

This wizard page enables you to set the entity and type.

Important
information

l General information about this wizard is available here: "GraphWizard" on
page 755.

l When the wizard is launched from the Analysis View module, this page is only
available if you selectedEntity Graph in the "Select Graph Type Page" on the
previous page.

Wizard
map

The "GraphWizard" on page 755 contains:

"Select Graph Type Page" on the previous page > "Select Business View Page" on
the previous page > "Select Entity Type Page" above > "Select Projects Page" below
> "Select Test Set Option Page" on the next page > "Select Filter Page" on page 759
> "Select Graph Attributes Page" on page 760 > "Select Coverage Page" on page 761

User interface elements are described below:

UI Element Description

Entity The ALM entity covered by the graph.

Note: Applicable only if you launched the graph wizard from the Analysis View
module.

Graph Type The type of graph that you want to create. The available types of graph depend on the
graph. For a description of the available graph types, see "Entity Graph Types" on
page 739.

Description Describes the selected entity/graph type.

Select Projects Page

This wizard page enables you to select the projects that are included in the graph.

Important
information

General information about this wizard is available here: "GraphWizard" on page 755.

ALM Editions:Not available in Quality Center Enterprise Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on
page 115. To find out what edition of ALM you are using, ask your ALM site
administrator.

Wizard
map

The "GraphWizard" on page 755 contains:

"Select Graph Type Page" on the previous page > "Select Business View Page" on
the previous page > "Select Entity Type Page" above > "Select Projects Page" above
> "Select Test Set Option Page" on the next page > "Select Filter Page" on page 759
> "Select Graph Attributes Page" on page 760 > "Select Coverage Page" on page 761
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User interface elements are described below:

UI Element Description

Use Current
Project

Includes only the current project in the graph.

Use
Selected
Projects

Includes the projects listed in the project grid in the graph. To change the selection of
the projects, click theSelect button.

Opens the Select Projects dialog box, enabling you to change the projects in the
projects grid. For details, see "Select Projects Dialog Box" on page 763.

Select Test Set Option Page

This wizard page enables you to choose which test sets are included in the graph.

Important
information

General information about this wizard is available here: "GraphWizard" on page 755.

Available from: Test Labmodule

Wizard
map

The "GraphWizard" on page 755 contains:

"Select Graph Type Page" on page 756 > "Select Business View Page" on page 756
> "Select Entity Type Page" on the previous page > "Select Projects Page" on the
previous page >"Select Test Set Option Page" above > "Select Filter Page" on the
next page > "Select Graph Attributes Page" on page 760 > "Select Coverage Page"
on page 761

User interface elements are described below:

UI Element Description

Show Current Test Set Includes only the current test set in the graph.

Show all Test Sets Includes all test sets in the graph.
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Select Filter Page

This wizard page enables you to set the filter that is applied to the graph data.

Important
information

l General information about this wizard is available here: "GraphWizard" on
page 755.

l If your graph includes multiple projects, you can filter using only fields that are in all
the selected projects.

ALM Editions: Includingmultiple projects in graphs is not available for Quality
Center Enterprise Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM
you are using, ask your ALM site administrator.

l Progress or Trends graphs: If you set a filter on the same field as theGroup By
field, groups in the graphs may include values that you filtered out. This is because
in progress and trend graphs the filter operates on current values, while groupings
operate on historical values. For example, say theGroup By field in a Defects
graph is set toStatus, and the current filter includes all defects whose status is
Open.When the graph is generated, all previous statuses of the open defects,
such as Rejected, will appear in the graph even if Rejectedwas not included in the
filter.

Wizard
map

The "GraphWizard" on page 755 contains:

"Select Graph Type Page" on page 756 > "Select Business View Page" on page 756
> "Select Entity Type Page" on page 757 > "Select Projects Page" on page 757 >
"Select Test Set Option Page" on the previous page > "Select Filter Page" above >
"Select Graph Attributes Page" on the next page > "Select Coverage Page" on
page 761

User interface elements are described below:

UI
Element

Description

Use
current
filter

Available if you launched the graph wizard from the Requirements, Test Plan, Test Lab,
or Defects modules. Uses the current filter applied to the data.

Do not
use a
filter

Includes all records of the selected entity.

Define a
new
filter

Enables you to define a new filter or cross-filter. Click the Filter button to open the Filter
dialog box, and define the filter. For user interface details, see "Select Filter Condition
Dialog Box" on page 61.
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Select Graph Attributes Page

This wizard page enables you to set theGroup By andX-Axis attributes in the graph.

Important
information

General information about this wizard is available here: "GraphWizard" on page 755.

Wizard
map

The "GraphWizard" on page 755 contains:

"Select Graph Type Page" on page 756 > "Select Business View Page" on page 756
> "Select Entity Type Page" on page 757 > "Select Projects Page" on page 757 >
"Select Test Set Option Page" on page 758 > "Select Filter Page" on the previous
page > "Select Graph Attributes Page" above > "Select Coverage Page" on the next
page

User interface elements are described below:

UI
Element

Description

Group
By field

The field by which you want data to be grouped in the graph. For progress and trend
graphs, you can only select a field for which history is enabled. For more information on
enabling history for a field, refer to theHP Application Lifecycle Management
Administrator Guide.

If your graph includes multiple projects, you can only select from fields that are in all the
selected projects. To group the data by project, select theQC Project value.

Progress or Trends graphs: If you set a filter on the same field as theGroup By field,
groups in the graphs may include values that you filtered out. This is because in progress
and trend graphs the filter operates on current values, while groupings operate on
historical values. For example, say theGroup By field in a Defects graph is set to
Status, and the current filter includes all defects whose status is Open.When the graph
is generated, all previous statuses of the open defects, such as Rejected, will appear in
the graph even if Rejectedwas not included in the filter.

ALM Editions: Includingmultiple projects in graphs is not available for Quality
Center Enterprise Edition. For more information about ALM editions and their
functionality, see "ALM Editions" on page 115. To find out what edition of ALM you
are using, ask your ALM site administrator.

X-axis
field

If you are creating a summary graph, the field that you want to use for the x-axis.

If your graph includes multiple projects, you can only select from fields that are in all the
selected projects. To list the projects along the x-axis, select theQC Project value.

ALM Editions: Includingmultiple projects in graphs is not available for Quality Center
Enterprise Edition. For more information about ALM editions and their functionality,
see "ALM Editions" on page 115. To find out what edition of ALM you are using, ask
your ALM site administrator.

User Guide
Chapter 42: Graphs and Dashboard Pages

HP ALM (12.50) Page 760



Select Coverage Page

This wizard page enables you to choose whether to display requirements with no coverage.

Important
information

l General information about this wizard is available here: "GraphWizard" on
page 755.

l For details on requirements coverage, see "Requirement and Test Coverage
Overview" on page 376.

Available from:Requirements graphs.

Wizard
map

The "GraphWizard" on page 755 contains:

"Select Graph Type Page" on page 756 > "Select Business View Page" on page 756
> "Select Entity Type Page" on page 757 > "Select Projects Page" on page 757 >
"Select Test Set Option Page" on page 758 > "Select Filter Page" on page 759 >
"Select Graph Attributes Page" on the previous page > "Select Coverage Page"
above

User interface elements are described below:

UI Element Description

Do not show 'Not Covered'
Parents

Excludes parent requirements with a 'Not Covered' status from
the graph.

Show 'Not Covered' Parents Includes all requirements in the graph.

New Graph Dialog Box
This dialog box enables you to add a new Entity graph to the analysis tree.

To access 1. On the ALM sidebar, underDashboard, select Analysis View.
2. Right-click the folder under which you want to add a graph, and select New

Graph.

Important
information

Graphs you create under private folders are available to the owner only. Graphs you
create under public folders are available to all users.

Relevant
tasks

l "How to Generate a Graph" on page 736
l "How to Generate a PPT Graph" on page 768
l "How to Analyze Data in ALM" on page 718

See also l "Graphs and Dashboard Pages Overview" on page 734
l "PPT Graphs Overview " on page 768
l "Analysis View Window" on page 720
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User interface elements are described below:

UI
Element

Description

Entity The ALM entity covered by the graph.

Note: This field is not available for the project planning and tracking (PPT) graph
type.

Graph
Type

The type of graph you want to create. For details, see "Entity Graph Types" on
page 739.

Note: This field is not available for the project planning and tracking (PPT) graph
type.

Graph
Name

The graph's display name in the analysis tree. By default, the Graph Name is used as
the graph's title.

Select Business View Dialog Box
This dialog box enables you to select the business view on which to base the business view graph or
the business view Excel report.

To access 1. In the Analysis View module, select a business view graph, click the
Configuration tab, and click the browse button next to the Business View box.

2. If the HP ALM Business Views Microsoft Excel add-in is installed, click Add or
New Report in the HP ALM tab in Excel.

Important
information

From ALM, you can only select one business view. In Excel, you can select multiple
business views using the SHIFT or CTRL keys.

Relevant
tasks

l "How to Generate a Graph" on page 736
l "How to Generate a PPT Graph" on page 768
l "How to Analyze Data in ALM" on page 718

See also l "Graphs and Dashboard Pages Overview" on page 734
l "PPT Graphs Overview " on page 768
l "Analysis View Window" on page 720

User interface elements are described below:

UI Element Description

Filter The filter for the business views. For example, typing Defect causes only defect-
related business views to be displayed.

Description The description of the select business view.
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New Dashboard Page Dialog Box
This dialog box enables you to add a new dashboard page to the dashboard tree.

To access 1. On the ALM sidebar, underDashboard, select Dashboard View.
2. Right-click the folder under which you want to add a page, and select New

Page.

Important
information

Dashboard pages you create under private folders are available to the owner only.
Dashboard pages you create under public folders are available to all users.

Relevant
tasks

"How to Generate a Dashboard Page" on page 738

See also "Graphs and Dashboard Pages Overview" on page 734

User interface elements are described below:

UI Element Description

Dashboard
Page Name

The dashboard page display name in the dashboard tree. By default, the Dashboard
Page Name is displayed as the dashboard page's title.

Syntax exceptions: A dashboard page name cannot exceed 255 characters, and
cannot include the following characters: \ ^ *

Select Projects Dialog Box
This dialog box enables you to select projects that are included in cross-project graphs.

ALM Editions: This dialog box is not available for Quality Center Enterprise Edition. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site administrator.

To access l In the graph wizard:Proceed to the Select Projects dialog box, and click the
Select button.

l In the graph Configuration tab:Click theSelect Projects button.

Important
information

l You can select only projects in which you are listed as a user.
l You can change themaximum number of projects that ALM allows you to include
in a graph, by setting thePROJECT_SELECTION_MAX_PROJECTS site
parameter. For more information, refer to theHP Application Lifecycle
Management Administrator Guide

Relevant
tasks

"How to Generate a Graph" on page 736
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User interface elements are described below:

UI Element Description

Removes the selected project from the grid.

Note: You cannot remove a project if it is the only project in the grid.

Domain/Project A list of projects and their domains selected to be included in the graph.

Projects Tree A list of domains and projects in which you are listed as a user.

Add. Adds the selected project or domain to the grid. If you selected a domain,
all the domain's projects are added to the grid.

Tip: Drag or double-click a project or domain to add it to the grid.

Edit <Type> Categories Dialog Box
The Edit Group By Categories dialog box enables you to group together values of the field selected in
theGrouped By field, and display the combined data as one category.

The Edit X Axis Categories dialog box enables you to group together values of the field selected in the
X-axis field, and display the combined data as one category.

To access
On the View tab or graph window toolbar, click Edit Categories .

Important
information

The Edit X Axis Categories dialog box is available only for summary graphs and
Requirements Coverage graphs.

Relevant tasks "How to Generate a Graph" on page 736

User interface elements are described below:

UI Element Description

Opens the New Category dialog box, enabling you to create a new category.

In theCategory Name box, type a name for the category.

To choose which field values are included in the category, select field values and
click the arrow buttons (> and <) to move them betweenAvailable groups and
Groups in new category. Click the double arrow buttons (>> and <<) to move all
the field values from one list to the other. You can also drag field values between
lists. You cannot include a field value in more than one category.

Opens the Edit Category dialog box, enabling you to edit the selected category.

Deletes the selected category.
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UI Element Description

Deletes all categories.

# The number of the category.

Name The name of the category.

Expression The values included in the category.

Graph Appearance Dialog Box
This dialog box enables you to change a graph's titles and appearance. For a bar chart, you can specify
the display parameters for the bars. For a line chart, you can specify the display parameters for the
lines.

To access
On the View tab or graph window toolbar, click Set Graph Appearance or click
the graph title.

Relevant
tasks

"How to Generate a Graph" on page 736

"How to Generate Live Analysis Graphs" on page 832

User interface elements are described below:

UI Element Description

Titles tab Enables you to change the titles of the graph, the y-axis, or the x-axis.

Font. Enables you to change a title's font or color.

Reset Titles. Enables you to restore the original titles.

Note: For a pie chart, you can only change the title of the graph.

Appearance
tab

Enables you to set the default format of your graph, modify the orientation of the
labels at the base of the graph (for a bar chart and a line chart only), determine the
format in which dates are displayed on the x-axis, display the graph with a 3D effect,
or change the colors of the various components in your graph.

Bar
Parameters
tab

In bar charts, enables you to specify whether you want the values for each bar to be
displayed. You can also adjust the bar width. If you specify that the values of each
bar are to be displayed, you can change the data that is displayed for each bar, or its
position relative to the bar.

Line
Parameters
tab

In line charts, enables you to specify whether you want the line frame to be
displayed.
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Drill Down Results Dialog Box
This dialog box enables you to view the records that constitute a graph bar or segment.

To access Click a bar or segment on the graph.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

<Segment
parameters>

Located above the data grid, displays parameters of the selected graph area, and the
number of records displayed.

<Data grid> A list of the records that are included in the selected graph area.

To open a particular record, double-click a record. The <Module> Details dialog box
opens, enabling you to view or edit the record. Use the navigation buttons to browse
through the drill down results.

Export. Opens the Export Grid Data dialog box, enabling you to export the records
as a text file, Microsoft Excel worksheet, Microsoft Word document, or HTML
document.

Select one of the following options:

l All. Exports all records in the grid.
l Selected. Exports selected records in the grid.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the data grid, and their order. For more details, see "Select
Columns/Select Fields Dialog Box" on page 77.
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Chapter 43: Project Planning and Tracking
(PPT) Graphs
This chapter includes:

• PPT Graphs Overview 768
• How to Generate a PPT Graph 768
• PPT Graphs User Interface 769

HP ALM (12.50) Page 767



PPT Graphs Overview
Whenworking with PPT, you can create and customize graphs in the Analysis View module, relating to
KPI data in the Releases module. Creating graphs in the Analysis View module enables you to filter the
data, set various configurations, and organize the graphs in folders.

When viewing graphs, you can drill down to the records represented by each bar or segment.

After you have created graphs in the Analysis View module, you can select and arrangemultiple
graphs, and view them side-by-side in a dashboard page.

ALM Editions: Functionality related to PPT is available with ALM Edition only. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site administrator.

For related tasks, see "How to Generate a PPT Graph" below and "How to Generate a Dashboard
Page" on page 738.

How to Generate a PPT Graph
This task describes how to generate PPT data in ALM using graphs.

ALM Editions: Functionality related to PPT is available with ALM Edition only. For more
information about ALM editions and their functionality, see "ALM Editions" on page 115. To find out
what edition of ALM you are using, ask your ALM site administrator.

This task includes the following steps:

l "Prerequisites" below
l "Create a graph in Analysis View" below
l "Configure a graph" on the next page
l "View a graph" on the next page
l "Share a graph outside ALM" on the next page
l "Create a dashboard page" on the next page

1. Prerequisites
UnderManagement, select Releases. Define a release, release scope items, milestones, and
KPIs. For task details, see "How toWork with PPT" on page 146.

2. Create a graph in Analysis View
Create a graph in the Analysis View module.
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a. Open the Analysis View module. On the ALM sidebar, underDashboard, select Analysis
View.

b. Add a folder to the analysis tree. Right-click a folder under the Private or Public root folder,
and select New Folder.

c. Create a new graph. Right-click a folder. Select New Release Analysis and choose a PPT
graph. The New Graph dialog box opens. Enter the graph name and click OK.

3. Configure a graph
In the Analysis View module, select a graph, and click theConfiguration tab. For user interface
details, see "Configuration Tab - PPT Graphs" on the next page.

4. View a graph
Select a graph in the analysis tree, and click theView tab. For user interface details, see "View
Tab - PPT Graphs" on page 772.

5. Share a graph outside ALM
Allow ALM users or others to view read-only versions of graphs outside ALM. For task details, see
"How to Generate a Graph" on page 736.

6. Create a dashboard page
View several graphs together in a dashboard page. For task details, see "How to Generate a
Dashboard Page" on page 738.

PPT Graphs User Interface
This section includes:

• Configuration Tab - PPT Graphs 770
• View Tab - PPT Graphs 772
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Configuration Tab - PPT Graphs
This tab enables you to select project planning and tracking (PPT) data to be included in a graph, and
set graph display options.

To access 1. On the ALM sidebar, underDashboard, select Analysis View.
2. Expand the analysis tree, and select a PPT graph.
3. Click theConfiguration tab.

Important
information

l The available configuration options depend on the graph type.

ALM Editions: Functionality related to PPT is available with ALM Edition only.
For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your
ALM site administrator.

Relevant
tasks

l "How to Generate a PPT Graph" on page 768
l "How to Analyze Data in ALM" on page 718

See also l "PPT Graphs Overview " on page 768
l "PPT Releases Overview" on page 146
l "Analysis View Window" on page 720

Configuring KPI Graphs

Important information Some fields are not available in all graphs.

User interface elements are described below:

UI Element
(A - Z)

Description

Aggregation
Function

The aggregation function used in grouping the data by time resolution. Possible
values are last, average,max, andmin.

Breakdown Select a field to determine the information by which ALM groups data in the graph.

Data
updated to

Displays data results based on selected date.

KPI The KPI name.

Milestone Themilestone name.

Period The time period for which you want to view data.
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UI Element
(A - Z)

Description

Release The release name.

Resolution The time resolution of the data. Possible values are day, week,month, year, auto
select (the server determines the optimal time resolution).

Scope Item The scope item name.

Show Last
Result

Displays data results based on last run date.

Configuring Scorecard Graph
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element (A - Z) Description

Sets the order in which row or column names appear in scorecard
table.

Moves selects fields betweenRows andColumns.

Set Filter/Sort. Enables you to narrow and sort theMilestone,
Scope Item, orKPI data according to your chosen criteria. For more
details on filtering, see "Filter Dialog Box" on page 51.

Clear Filter. Clears the defined filter.

Restores default filter definitions.

Columns Lists columns that are currently displayed in the scorecard table.

Data Updated to Displays data results based on selected date.

Display Planned KPI
Target

Displays the acceptable threshold value for each KPI in thePlanned
column of the scorecard table.

Note: ThePlanned column is displayed only when this option is
enabled.

Group Scope Items by
Field

Groups according to a specified scope item field.

Release The release name.

Rows Lists rows that are currently displayed in the scorecard table.

Show Last Results Displays data results based on last run date.
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View Tab - PPT Graphs
This tab enables you to view project planning and tracking (PPT) graphs.

To access 1. On the ALM sidebar, underDashboard, select Analysis View.
2. Expand the analysis tree, and select a PPT graph.
3. Click theView tab.

Important
information

l The available view options depend on the graph type.

ALM Editions: Functionality related to PPT is available with ALM Edition only.
For more information about ALM editions and their functionality, see "ALM
Editions" on page 115. To find out what edition of ALM you are using, ask your
ALM site administrator.

Relevant
tasks

l "How to Generate a PPT Graph" on page 768
l "How to Analyze Data in ALM" on page 718

See also l "PPT Graphs Overview " on page 768
l "PPT Releases Overview" on page 146
l "Analysis View Window" on page 720

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element
(A - Z)

Description

Generate. Refreshes the graph so that it displays themost up-to-date information.

Bar Chart. Switches the chart format to a bar chart.

Pie Chart. Switches the chart format to a pie chart.

In pie charts, the x-axis categories are displayed as pie segments. The y-axis
quantities are represented by the size of the segments.

Note: Pie charts do not display the Grouped By field.

Line Chart. Switches the chart format to a line chart.

Data Grid. The grid creates amatrix of the graph's x-axis andGrouped By
categories. A Total row is added that displays the total of eachGrouped By
category.
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UI Element
(A - Z)

Description

Show/Hide Total Values. Shows/hides a <total> category to the graph,
representing the sum of all the other Grouped By categories.

Tip: After showing the <total> category, click its label in the legend to hide the
category.

Scroll to the Left/Right. Scrolls the graph to the left or right. These buttons are
enabled when the Zoom In and ZoomOut buttons are in use.

Show All. Restores the graph to its normal size. This button is enabled when the
Zoom In and ZoomOut buttons are in use.

Zoom In/Out. Changes themagnification of the graph.

Save Graph Image. Saves the graph image. You can select from a variety of
graphic file formats.

Save Graph Data. When viewing a data grid, saves the graph data. You can save
the data as an Excel spreadsheet, aWord file, an HTML document, or a text file.

Set Graph Appearance. Opens theGraph Appearance dialog box, enabling you to
customize the graph title, graph color, and graph display. For more details, see
"Graph Appearance Dialog Box" on page 765.

Copy Graph to Clipboard. Includes the following options:

l Copy Graph (Color). Copies the graph in color to the Clipboard.
l Copy Graph (Monochrome). Copies the graph inmonochrome to the Clipboard.
l Copy Full Screen Graph (Color). Copies the graph in color to the Clipboard,
enlarged to fit full screen.

l Copy Full Screen Graph (Monochrome). Copies the graph inmonochrome to
the Clipboard, enlarged to fit full screen.

Print Graph. Includes the following options:

l Print Graph (Color). Prints the graph in color. This is the default button option.
l Print Graph (Monochrome). Prints the graph inmonochrome.
l Print Graph and Details (Color). Prints the graph and its description in color.
l Print Graph and Details (Monochrome). Prints the graph and its description in
monochrome.

User Guide
Chapter 43: Project Planning and Tracking (PPT) Graphs

HP ALM (12.50) Page 773



UI Element
(A - Z)

Description

Full Screen. Opens the graph in a new window andmaximizes its display.

Note: The toolbar remains visible in full-screenmode.

Tip: To return to the standard view, click theClose button in the top-right
corner of the window.

<graph
area>

You can perform the following actions in the graph area:

l Hover over a graph segment to view a tooltip containing additional information.
l Click theBreak Over Time link to drill down to the graph's data and show
specific points during a period of time. Opens a breakdown over time graph. For
more details, see "BreakdownOver TimeGraph" on page 171.

Available from:View tab - KPI Breakdown

<KPI cell> You can perform the following actions in a KPI cell:

l Click a KPI cell to display a graph representation of this cell. For more details,
see "KPI Drill DownGraph" on page 168.

l Hover over a KPI cell to view a tooltip containing the KPI's threshold values.
Available from:View tab - Release Scorecard

<legend> Displays the chart categories and their corresponding color. Click a category to
show or hide the category in the graph.
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Chapter 44: Project Reports
This chapter includes:

• Project Reports Overview 776
• How to Create Project Reports 776
• How to Create a Custom Report Template 778
• Predefined Project Reports 779
• Project Reports User Interface 783
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Project Reports Overview
Project reports enable you to design and generate comprehensive reports containing information from
your HP Application Lifecycle Management (ALM) project.

In a project report, you define sections and sub-sections, each listing records of a specified ALM entity.
You can choose to display data of a selected baseline.

To each report section, you assign a template that determines the fields and layout of the section. You
also assign document and style templates that determine the overall report appearance.

Note: Report templates aremanaged in Project Customization. For more details, refer to theHP
Application Lifecycle Management Administrator Guide.

You can generate project reports in HTML, Microsoft Word, or PDF formats.

For details on creating project reports, see "How to Create Project Reports" below.

How to Create Project Reports
This task describes how to create project reports.

To learnmore about project reports, see "Project Reports Overview" above.

This task includes the following steps:

l "Create a project report" below
l "Define sections" below
l "Configure document-level settings" on the next page
l "Configure sections" on the next page
l "Preview a template report" on page 778
l "Generate a template report" on page 778
l "Share a report outside ALM" on page 778

1. Create a project report
a. Open the Analysis View module. On the ALM sidebar, underDashboard, select Analysis

View.
b. Add a folder to the analysis tree. Right-click a folder under the Private or Public root folder,

and select New Folder.
c. Create a new project report. Right-click a folder, and select New Project Report. Fill in the

New Project Report dialog box.

2. Define sections
a. Select a project report. In the Analysis View module, select a project report, and click the

Configuration tab.
b. Add a section. Right-click theDocument root node, and select Add Report Section.
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Select an ALM entity to include in the report.
c. Add a sub-section. You can add a sub-section of related information. For example, add a

sub-section of defects linked to requirements, or a sub-section of defect attachments.
Each section can havemultiple sub-sections and, where applicable, you can add further sub-
sections to sub-sections.
Right-click a section in the report tree, and select Add Report Section.

Note: You can add sub-sections only to sections that are assigned a full-page template.
For more details on full-page templates, refer to theHP Application Lifecycle
Management Administrator Guide.

3. Configure document-level settings
At theDocument root level, you assign templates and define settings that apply to the overall
design and content of the project report.
a. In the Configuration tab, select theDocument root node. For user interface details, see

"Configuration Tab - Project Reports" on page 784.
b. Set the document output format.
c. Assign document, style and history templates, or keep the default templates. For details on

the template types, refer to theHP Application Lifecycle Management Administrator Guide.

d. Click Edit Document Field Values to type values for custom fields in areas such as the
title page, headers and footers, as defined in the document template.

e. To create a baseline report, select Select a Baseline, and select a baseline.
To create a baseline report, all report sections must support baselines.

f. Select Embed Text and Image Attachments, to embed text and image attachments in the
report.
To display attachments, youmust add attachment sub-sections to the report.

Note: If you do not select this option, links to text and image attachments are inserted in
the report, that open the files in a separate window. ALM opens themost up-to-date
version of the attachments and if they have changed since the report was first generated,
the information displayedmay contradict other information contained in the report.

g. Select Auto-Update Table of contents to instruct ALM to update table of contents entries in
the report output.
To display a table of contents, the document templatemust include a TOC field.

4. Configure sections
a. In the Configuration tab, select a section or sub-section in the report tree. For user interface

details, see "Configuration Tab - Project Reports" on page 784.
b. Optionally, rename the section title.
c. Assign a project template, or keep the default template.

Note: Depending on your user group permissions, you can assign a custom template. For
details on creating a custom template, see "How to Create a Custom Report Template"
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on the next page.

d. Define a data filter, where applicable, to define the records that are included in the section.
e. For top-level sections that include entities that are listed hierarchically (for example,

requirements, tests), select whether records are ordered hierarchically in the report.
f. Add existing graphs to the report, or create new graphs directly in the report.

5. Preview a template report
Click Preview to display a preview of your report.
A preview contains up to five records of each section in the report. The preview is displayed in the
output format you selected for theDocument root node.

6. Generate a template report
Click Generate. The report generation process begins.
When the report generation is complete, it is displayed in the output format you selected for the
Document root node.
The report is saved on the client machine, under the following directory:
%Temp%\TD_80\<ALM_PATH>\<Project_id>\Reports
Where <Project_id> is a string representing your ALM project.

7. Share a report outside ALM
Allow ALM users or others to view read-only versions of reports outside ALM.
a. In the analysis tree, right-click a report, and select Share Analysis Item.
b. In the Share Analysis Item dialog box, select a share option. For details of the options, see

"Share Analysis Item Dialog Box" on page 730.
A URL of the selected report is copied to the clipboard.

c. Paste the URL in a website or email.
d. Click the URL to open a read-only version of the report in aWeb browser. Each time you

access the report, after set intervals, it displays themost up-to-date information.

Note: You can change the frequency at which report data is updated by adding and
configuring theREPORT_RESULT_LIFESPAN site configuration parameter. For more
details, refer to theHP Application Lifecycle Management Administrator Guide

Available from:Analysis View module

How to Create a CustomReport Template
This task describes how to create a custom template for your personal use. Depending on your user
group permissions, you can assign custom templates to report sections and sub-sections.

l "Create a copy of an existing report template" on the next page
l "Create a new custom report template" on the next page
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Create a copy of an existing report template

1. In the report tree, select a report section, and click theDownload Template button next to the
project or custom template that you want to modify. A copy of the template is saved on your
computer file system, and opens inMicrosoft Word.

2. Modify the template in Microsoft Word using commands in the Template Creator tab. For details
on the Template Creator tab, refer to theHP Application Lifecycle Management Administrator
Guide.

3. Save and close the template file.
4. To assign the new custom template to a report section, select a report section. Then select

Custom Template or click Upload Custom Template , and select the template file.

Create a new custom report template
1. In the report tree, select a report section for which you want to create a custom template.
2. Click Template Creator. Microsoft Word opens with the Template Creator tab. Design a new

template file for the selected report section. For details on working with the Template Creator, refer
to theHP Application Lifecycle Management Administrator Guide.

3. Save and close the template file.
4. To assign the new custom template to a report section, select a report section. Then select

Custom Template or click Upload Custom Template , and select the template file.

Predefined Project Reports
The following predefined reports are available in the Requirements, Test Plan, Test Lab, Defects, and
Business Components modules.

Note:

l If you have the required administrator permissions, you can configure the predefined reports in
the Analysis View module's Analysis Menus tab. You can also add reports or delete predefined
reports.

l By default, predefined project reports do not display filter information. To include filter
information, edit the current template to include theSection Filter field, or create a new
template for the report where this field is included. For more information, refer to theHP
Application Lifecycle Management Administrator Guide.

This section includes:

l "Requirements Module Reports" on the next page
l "Test PlanModule Reports" on the next page
l "Test LabModule Reports" on page 781
l "Defects Module Reports" on page 782
l "Business Component Module Reports" on page 783
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Requirements Module Reports
The following reports are available for the Requirements module:

Report Description

Standard
Requirement Report

Lists the requirements that appear in the current requirements view.

Tabular Report Displays the requirements that appear in the current requirements view, in a
grid format.

Note: The tabular report does not display the hierarchy and nesting of
child requirements.

Requirements with
Coverage Tests

Lists the requirements that appear in the current requirements view, with
their test coverage information.

Requirements with
Coverage Tests and
steps

Lists the requirements that appear in the current requirements view, with
their test coverage information. It also displays the test steps for each tests
coverage.

Requirements with
Linked Defects

Lists the requirements that appear in the current requirements view, with
their linked defects.

Requirements with
Traceability

Lists the requirements that appear in the current requirements view, with
their associated traced to and traced from requirements.

Report Selected Lists the requirements currently selected in the requirements tree or grid.

Report Selected with
Children

Lists the requirements currently selected in the requirements tree or grid,
including child requirements.

Test Plan Module Reports
The following reports are available for the Test Planmodule:

Report Description

Standard Test
Planning Report

Lists the tests in the current test plan view.

Subject Tree
Report

Lists the tests in the current test plan view by subject.

Tests with
Design Steps

Lists the tests that appear in the current test plan view, including their design
steps.
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Report Description

Tests with
Covered
Requirements

Lists the tests that appear in the current test plan view, with their requirement
coverage information.

Tests with
Linked Defects

Lists the tests that appear in the current test plan view, with their linked defects.

Report Selected Lists the tests currently selected in the test plan tree or grid.

Business
Process Tests
with Component
Steps

Lists the relevant parameter values for all the flows, groups, iterations,
components, andmanual steps in the selected business process test. This
report can be used to: 

l Run business process tests manually from a printout.
l As a detailed report for auditing.

Business
Process Tests
with Component
Steps and
Component
Details

Lists the relevant parameter values for all the flows, groups, iterations,
components, andmanual steps in the selected business process test, including
component details and snapshots. This report can be used to.

l Run business process tests manually from a printout.
l As a detailed report for auditing.

Business
Process Tests
with Script

Lists all the business process tests and flows currently in the ALM project,
including some detail fields, the test or flow descriptions, and the components
included in each test or flow. This report also includes information about groups,
iterations, On Failure status, and contents of flows inside business process
tests.

Test Lab Module Reports
The following reports are available for the Test Labmodule:

Test Set Reports

Report Description

Current Test Set Lists the tests that appear in the current test set.

Cross Test Set Lists the test sets that appear in the Test Sets list, without listing
their tests.

Test Set Hierarchy with
Tests

Lists the test sets hierarchically, as well as the status of each of
the test sets.

Cross Test Set with Tests Lists the test sets that appear in the Test Sets list, including their
tests.
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Report Description

Current Test Set with Failed
Test Runs

Lists tests from the current test set, with "Failed" test run status.

Cross Test Set with Failed
Test Runs

Lists tests from all test sets, with "Failed" test run status.

Execution Notification Lists the tests that are displayed in the current test set with the
results of their last test run.

Report Selected Displays an execution report of the test instances currently
selected in the execution grid.

Test Run Reports

Report Description

Cross Run Lists the runs matching the current filter in the Test Runs module.

Cross Run with
Steps

Lists the runs matching the current filter in the Test Runs module with their
run steps.

Runs by Test Lists the runs in the Test Runs module under their tests.

Runs by Test Set Lists the runs in the Test Runs module under their test sets and tests.

Report Selected Displays a runs report of the test runs currently selected in the Test Runs
module.

Defects Module Reports
The following reports are available for the Defects module:

Report Description

Standard Defect Report Lists the defects that appear in the defects grid.

Tabular Report Displays the defects that appear in the defects grid, in a grid
format.

Note: The tabular report does not display the
descriptions and comments for the defects.

Defects with Linked Tests and
Runs

Lists the defects with their linked tests and test run results.

Fixed or Rejected Defects Lists defects with "fixed" or "rejected" status.

Fixed or Rejected Defects
Detected by Current User

Lists defects with "fixed" or "rejected" status that were
detected by the current user.
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Report Description

Opened Defects Assigned to
Current User

List defects with "open" status that are assigned to the
current user.

Report Selected Lists defects currently selected in the defects grid.

Business Component Module Reports
The following reports are available for the Business Components module:

Report Description

Standard
Component
Report

Lists all the components currently in the ALM project, including all detail fields, the
component descriptions, history, and whether it includes a snapshot.

Component
Hierarchy
Report

Lists the components currently in the ALM project, including all detail fields and
the component descriptions. Obsolete components and component requests are
not shown in this report.

Components
with Steps

Lists all the components currently in the ALM project, including some detail fields,
the component descriptions, and each component's steps.

Components
Used By

Lists all the components currently in the ALM project, including some detail fields,
the component descriptions, and the business process tests and flows that use
each component.

Components
with
Application
Area

Lists all the components currently in the ALM project, including some detail fields,
the component descriptions, and the application area (if any) used by each
component.

Report
Selected

Lists components currently selected in the tree.

Project Reports User Interface
This section includes:

• Configuration Tab - Project Reports 784
• New Project Report Dialog Box 791
• AddReport Section Dialog Box 791
• Edit Document Template Field Values Dialog Box 792
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Configuration Tab - Project Reports
This tab enables you to define document-level settings, and configure report sections.

To access Use one of the following:

l In the Analysis View module, select a project report, and click theConfiguration
tab.

l If you have the required administrator permissions, in the Analysis View module's
Analysis Menus tab, select a project report and click theConfiguration tab.

Important
information

The available configuration options depend on the selected section in the report tree.

Relevant
tasks

l "How to Create Project Reports" on page 776
l "How to Analyze Data in ALM" on page 718

See also l "Project Reports Overview" on page 776
l "Analysis View Window" on page 720

Configuration Tab Common Elements
User interface elements are described below. (Unlabeled elements are described in angle brackets)

UI Element Description

Add Report Section. Opens the Add Report Section dialog box, enabling
you to add a section to the report. For user interface details, see Add Report
Section.

Note:

l You can add a sub-section only to sections that are assigned full-
page templates.

l Where applicable, you can add additional layers of sub-sections to
sub-sections.

l At each level you can includemultiple sub-sections.

Delete Report Section. Deletes the selected section.

Note:When you delete a section, all its sub-sections are deleted too.
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UI Element Description

Move Up/Move Down. Enables you tomove the selected report section
higher or lower in the project report.

Note: The selected sectionmoves in relation to sections on the same
level.

Generates a preview of the report that includes the first five records of each
of the report sections.

The preview is generated in the selected report output format.

Generates the report in the selected report output format.

Opens Microsoft Word with the Template Creator tab, enabling you to design
a custom template file.

After creating a custom template, assign it to a report section in theCustom
Template field.

Note: To enable the Template Creator, youmust first allow macros in
Microsoft Word. InWord, click theOffice Button, and then clickWord
Options. Select Trust Center > Trust Center Settings >Macro
Settings. Select Enable all macros.

Enables you to download the report locally to your computer as a .zip file.
The file includes all attachments contained in the report.

Note: For reports in HTML format, youmust extract all the files from the
zipped folder before opening them.

Tip: This format should be used for emailing reports to users who do not
have access to ALM.

<report section
tree>

Displays the sections and sub-sections included in the report. The
Document root node contains settings that apply to the overall report design
and content.

Document Output Options Area
You can define the file format in which the report is generated.

Important information l Available from:Document root node.
l In the Analysis Menus tab, this option is disabled and set to
HTML.
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User interface elements are described below:

UI
Element

Description

HTML Displays the report in aWeb browser.

Docx Displays the report in Microsoft Word 2007 or later.

Doc Displays the report in Microsoft Word 2003.

PDF Displays the report in PDF readers.

Note: The PDF report cannot be displayed when working inWindows 8 or 8.1 with
Adobe Reader 9.1 installed. In this configuration, install the xi version of the Adobe
Reader to view the report.

Document Templates Area

Important information Available from:Document root node.

You can define which template is assigned to the report.

User interface elements are described below:

UI
Element

Description

Document
Template

Defines fields on the title page, headers and footers, page orientation, and other
document layout settings.

Style
Template

Defines formatting (for example, tables, headings, and paragraph) applied toMicrosoft
Word styles. The Style template styles override those defined in the templates used in
the report sections.

History
Template

Defines the style in which history information is displayed in report sections.

No
Template

Generates a report section without a template and renders its subsections
immediately.

This option is useful when you want to link a parent section to a sub-section.

For example, if your report contains aRequirements and aCoverage Tests section,
you can add aRequirement Coverage section in between them that uses theNo
Template option. When the report is generated, tests will appear immediately below
the requirement that they are covering without any intermediate section.

Edit Document Field Values. Opens the Edit Document Template Field Values
dialog box, enabling you to type values for fields in areas such as the title page,
headers and footers, as defined in the document template. For user interface details,
see "Edit Document Template Field Values Dialog Box" on page 792.
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Document Additional Options Area

Important information Available from:Document root node.

User interface elements are described below:

UI Element Description

Auto-Update
Table of
contents

Instructs ALM to update table of contents entries in the report output.

Note:

l To display a table of contents, the document templatemust include a TOC
field.

l If this option is not selected, and if you selected the Doc or Docx output
format, you canmanually update the table of contents in Microsoft Word
after the report is generated.

Embed Text
and Image
Attachments

Embeds plain text and image attachments in the report.

Other attachment types (for example, document or video files) are always
displayed as links.

Note:

l To display attachments, youmust add attachment sub-sections to the
report.

l If this option is not selected, links to plain text and image attachments are
inserted in the report, that open the files in a separate window.

l To access the links, you use the REST API. Using the REST API requires
REST authentication, unless the report was generated using a public REST
URL.

l ALM opens themost up-to-date version of the attachments and if they have
changed since the report was first generated, the information displayedmay
contradict other information contained in the report.

Select a
Baseline

Select this option to generate a report of a selected baseline data.

Clear this option to include current data in your report.

Note:

l You can create a baseline report only if all sections and sub-sections of the
report support baselines.

l Selecting this option disables the ability to add graphs to the report.
l This option is disabled in the Analysis Menus tab.
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Report Section Details Area

Important information Available from: Section nodes

User interface elements are described below:

UI Element Description

Name The name of the section title in the report.

Entity The ALM entity that is included in the section.

Relationship
Type

Describes the relationship between the entity in the selected section and the entity
in the parent section.

Template Details Area
You can define which template is assigned to the currently selected section of the report. A template
can be either in a full-page or tabular layout. You can only add sub-sections to sections that are
assigned full-page templates. For more details on report templates, refer toHP Application Lifecycle
Management Administrator Guide.

Filter Area

Important information Available from: Section nodes

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element

Description

Filter
State

Enables you to set filter conditions for reports that are generated from within the Analysis
menu in specific modules.

l Custom. Enables you define a customized filter in the Analysis Menus tab.
l Special filters. The following predefined filtering options are provided:

Note:When adding sections to a report that lists a different entity type to the
module from which the report is generated, youmust use theCustom filter type.
Selecting a special filter results in the section being excluded from the report. For
example, if you add a Defects section to theStandard Requirement Report,
and select theContext filtering option, the added section will not appear in the
generated report.

l Context. Filters information according to the filter that is currently selected in the
module.

l Selected. Includes information for the currently selected entity in themodule only.

Note: In the Test Labmodule, the selected entity is the selected test run
instance, and not the selected test set.

l Selected with Children. For hierarchical entities, includes information for the
selected parent entity as well as child entities.

l Current Entity Based. Includes information for the currently focused item in the
module. You use this option to generate a report in the Test Labmodule on the test
set level.

Available from:Analysis Menus tab. Youmust have the required administrator
permissions to view this tab.

Set Filter/Sort. Enables you to filter and sort the data according to the criteria you
choose. For details, see "Select Filter Condition Dialog Box" on page 61.

Clear Filter. Clears all filters and sorting priorities.

<filter
box>

Displays the current selection.
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Graph Selection Area
You can add existing graphs to the report, or create new graphs directly in the report.

Important
information

l Available from: Section nodes

Note: You cannot add a graph to a sub-section of a report.

l If you selected theSelect a Baseline option in the Document Additional Options
area, this option is not available.

l Permissions to create graphs are based on the public state of the report. If the
report is private, youmust have permission tomanage private graphs. If the report
is public, youmust have permission to create, modify, and delete graphs.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Opens theGraphs Tree pane on the right side of the Graph Selection area. The pane
displays graphs in the analysis tree. Expand the tree and drag graphs to the graph
list.

Opens the GraphWizard, enabling you to create graphs directly in the report. For
user interface details, see "GraphWizard" on page 755.

Note: You cannot create KPI graphs using this method.

Opens the graph configuration window, enabling you to define axis data and set
filter options. For user interface details, see "Configuration Tab/Window - Graphs"
on page 744.

Opens the View Graph window, enabling you to view the selected graph and to set
graph display options. For user interface details, see "View Tab - Graphs/Graph
Window" on page 749.

Move Up/Move Down. Enables you tomove the selected graph higher or lower in
the graph list.

<graph list> Lists the graphs that are included in the report.

Special Properties Area

Important
information

Available from: Top-level sections that contain entities that are listed
hierarchically in ALM (for example, requirements, test folders).

User interface elements are described below:

UI Element Description

Keep Hierarchical Instructs ALM to list records in hierarchical order in the report.
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New Project Report Dialog Box
This dialog box enables you to add a new project report to the analysis tree.

To access 1. On the ALM sidebar, underDashboard, select Analysis View.
2. Right-click the folder under which you want to add a report, and select New

Project Report.

Important
information

Reports you create under private folders are available to the owner only. Reports
you create under public folders are available to all users.

Relevant
tasks

l "How to Create Project Reports" on page 776
l "How to Analyze Data in ALM" on page 718

See also l "Project Reports Overview" on page 776
l "Analysis View Window" on page 720

User interface elements are described below:

UI Element Description

Project
Report Name

The report's display name in the analysis tree and in the report title.

Syntax exceptions: The report name cannot exceed 255 characters, and cannot
include the following characters: \ ^ *

Add Report Section Dialog Box
This dialog box enables you to add a new section to a project report.

To access In a project report, right-click the root node or a section node, and select Add
Report Section.

Important
information

You can add a sub-section only to sections that are assigned a full-page
template.

Relevant tasks l "How to Create Project Reports" on page 776
l "How to Analyze Data in ALM" on page 718

See also l "Project Reports Overview" on page 776
l "Analysis View Window" on page 720

User interface elements are described below:

UI Element Description

Type The entity that is included in the new section. For sub-sections, the available types
depend on the entity in the parent section.
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UI Element Description

Relationship Describes the relationship between the entity in the new section and the entity in the
parent section.

Available from:Section nodes

Name The name of the new section. This field is used as the section title in the report.

Edit Document Template Field Values Dialog Box
This dialog box enables you to type actual values for custommerge fields as defined in the assigned
document template.

To access In a template report, select theDocument root node, and click Edit Document

Field Values .

Relevant
tasks

"How to Create Project Reports" on page 776

See also l "Project Reports Overview" on page 776
l "Analysis View Window" on page 720

User interface elements are described below:

UI Element Description

Field Names A list of the custommerge fields defined in the assigned document template.

Field Value The text that is displayed in the report in place of the selected field.
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Chapter 45: Excel Reports
This chapter includes:

• Excel Reports Overview 794
• How to Generate an Excel Report 796
• Excel Reports User Interface 798
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Excel Reports Overview
From ALM 12.00, you cannot create Excel reports. You can view and edit existing Excel reports from
previous versions of ALM.

Note: You can enable the ability to create Excel Reports by configuring theENABLE_CREATE_
LEGACY_EXCEL_REPORT site configuration parameter. For more information, refer to theHP
Application Lifecycle Management Administrator Guide.

Performance Center Edition:Excel reports are not available for Performance Center entities.

You can export HP Application Lifecycle Management (ALM) data toMicrosoft Excel. This enables you
to analyze your data using any of the capabilities available in Excel. An Excel report consists of a set of
data defined by SQL queries on the project database. You can also run a Visual Basic script on the
extracted data to process and analyze the data.

Example

Create a pivot table to summarize Defects module data, such as to display in tabular format the
number of defects assigned to different users with different statuses.

You can also create a report with parameters. This enables you to create amore flexible report that you
only need to create once but can be used in a number of different contexts.

Caution: Users who belong to groups that have data-hiding filters, are able to access the
restricted data through Excel reports. To overcome this, you can exclude user groups from
performing Excel report tasks. For more information on user groups and permissions, refer to the
HP Application Lifecycle Management Administrator Guide.

For task details, see "How to Generate an Excel Report" on page 796.

This section also includes:

l "Protecting the Database" on the next page
l "Parameters in SQLQueries" on the next page
l "Guidelines for Creating a Post-Processing Script" on page 796
For task details, see "How to Generate an Excel Report" on page 796.
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Protecting the Database
To ensure the integrity of the database, you should run only queries that extract data from the project
database. You should not run queries that alter the project database by adding, modifying, or deleting
database records.

By default, to ensure that your queries are valid and do not alter the project database, ALM checks that
the following conditions are fulfilled:

l The query starts with the commandSELECT.
l The query contains only one SQL statement.
l The query does not contain any of the following commands (except in comments): INSERT,
DELETE, UPDATE, DROP, CREATE, COMMIT, ROLLBACK, ALTER, EXEC, EXECUTE,
MERGE, GRANT, REVOKE, SET, INTO, or TRUNCATE.

You can customize whether this verification is performed, and how it is performed, using theSQL_
QUERY_VALIDATION_ENABLED andSQL_QUERY_VALIDATION_BLACK_LIST parameters in
Site Administration.

You can also customize themaximum number of records that can be retrieved from the database and
themaximum length of time that ALM waits for an SQL query for an Excel report to be executed, using
theREPORT_QUERY_RECORDS_LIMIT andREPORT_QUERY_TIMEOUT parameters in Site
Administration.

For more information on setting parameters, see theHP Application Lifecycle Management
Administrator Guide.

Parameters in SQL Queries
You can include parameters in the SQL queries for your Excel reports. For each query parameter, you
can assign a default value. When you generate the report, you are prompted to enter the value of the
parameter, or confirm the default value. Alternatively, you can choose to always use the default value,
without being prompted by ALM each time you generate the report.

For example, suppose you want to create a report that displays a graph of the number of requirements
added to your project over a period of time. Youmight want to run the report several times, each time for
a different period of time. You can avoid the need to createmultiple reports by creating a single report
with query parameters for the start date and end date of the period. Each time you generate the report,
you are prompted to enter the start and end dates for the period.

You first add query parameters to the parameters list. You can add global parameters that are
accessible to all queries in a report, or you can add parameters that can only be used in particular
queries. After you add parameters to the parameters list, you insert parameters into the query.

Caution:

l You cannot use parameters for SQL identifiers, such as a table name or a column name.
l Parameter values cannot include an SQL statement.
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Guidelines for Creating a Post-Processing Script
Whenwriting a post-processing script, consider the following guidelines:

l Your post-processing script must contain a sub-procedure namedQC_PostProcessing. This
procedure serves as the entry point to your script. This procedure cannot return a value and cannot
take any arguments.

l Before you can work with the report data in Excel, youmust first define the range containing the
report data. You define this range in two steps:
l You first define the worksheet containing the report data by creating a worksheet object
containing the data. For example, if the worksheet is named Query1, you can use the statement
Set MainWorksheet = ActiveWorkbook.Worksheets("Query1").

l After you define the worksheet containing the report data, you define the range containing the
data by creating a range object containing the data. For example, if you defined the worksheet
object with name MainWorksheet, you can use the statement Set DataRange =
MainWorksheet.UsedRange.

After you define this range, you canmanipulate the data contained in it using Visual Basic code.
l Before you run a post-processing script, youmust configure your Microsoft Excel security settings
so that Excel can run the script.
Office 2010: In Excel, click theMicrosoft Office Button, and then click Excel Options. Select Trust
Center > Trust Center Settings >Macro Settings. Select Trust access to the VBA project
object model. Close Excel.

Caution: Enablingmacros in Excel allows access to coreMicrosoft Visual Basic objects,
methods and properties, and represents a potential security hazard.

How to Generate an Excel Report
This task describes how to analyze data in ALM using Excel reports.

Tip: The ALM DemoProject contains sample Excel reports. You can use the SQL queries and
post-processing scripts in those reports as a basis for developing your own queries and scripts.

To learnmore about Excel reports, see "Excel Reports Overview" on page 794.

This task includes the following steps:

l "Prerequisites" on the next page
l "Add an Excel report to the analysis tree" on the next page
l "Create an SQL query" on the next page
l "Create a post-processing script" on the next page
l "Generate an Excel report" on the next page
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1. Prerequisites
To verify supported versions of Microsoft Excel, refer to theHP Application Lifecycle
Management Readme.

2. Add an Excel report to the analysis tree
Add an Excel report to a folder in the analysis tree.
a. Open the Analysis View module. On the ALM sidebar, underDashboard, select Analysis

View.
b. Add a folder to the analysis tree. Right-click a folder under the Private or Public root folder,

and select New Folder.
c. Create a new Excel report. Right-click a folder, and select New Excel Report. Enter a

name for the Excel report in the New Excel Report dialog box.

3. Create an SQL query
Define the project data that you want to include in the report. You define this data by creating SQL
queries. You can createmultiple queries in an Excel report. When you generate the report, the
results of each query are displayed in separate Excel worksheets.
a. Open the Query Builder. In the Configuration tab, click theQuery tab, and click Query

Builder. For user interface details, see "Excel Report Query Builder Dialog Box" on page 801.
b. Write an SQL query. Type a query in the SQL editor.
c. Add ALM entities to an SQL query. Select ALM entities in the Entities pane.
d. Define parameters in an SQL query. Use parameters in SQL queries tomodify the results

of an Excel report, based on parameter values that you enter. In the Query Builder dialog box,
use the buttons in the Query Parameters tab.

4. Create a post-processing script
You can create a Visual Basic script to run after the data is exported to Excel. You use this script
to manipulate the data in Excel.
For example, you can present requirements data in Excel as a pivot table, you could perform
calculations on defects data to calculate the average time an open defect takes to be fixed, or you
could create a graph based on exported data.
In the Configuration tab, click thePost-processing tab. Write a Visual Basic script. For user
interface details, see "Post-processing Tab" on page 804.

5. Generate an Excel report
Generating an Excel report extracts the data you specified in the SQL queries from the project
database, saves the data in an Excel workbook, and runs the post-processing script.
a. In the Configuration tab, click theGeneration Settings tab. Set options for running an Excel

report. For user interface details, see "Generation Settings Tab" on page 805.
b. Click Generate.
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Excel Reports User Interface
This section includes:

• Configuration Tab - Excel Reports 799
• Query Tab 799
• Excel Report Query Builder Dialog Box 801
• Post-processing Tab 804
• Generation Settings Tab 805
• New Excel Report Dialog Box 806
• New Query Parameter/Edit Query Parameter Dialog Box 806
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Configuration Tab - Excel Reports
This tab contains tabs that enable you to configure Excel reports.

To access 1. On the ALM sidebar, underDashboard, select Analysis
View.

2. Expand the analysis tree, and select an Excel report.
3. Click theConfiguration tab.

Relevant tasks l "How to Generate an Excel Report" on page 796
l "How to Analyze Data in ALM" on page 718

See also l "Excel Reports Overview" on page 794
l "Analysis View Window" on page 720

User interface elements are described below:

UI Element Description

Query tab Enables you to write an SQL query that defines the data that is exported to Excel. For
more details, see "Query Tab" below.

Post-
processing
tab

Enables you to write a Visual Basic script that runs in Excel after the report data is
exported to Excel. For more details, see "Post-processing Tab" on page 804.

Generation
Settings
tab

Enables you to set options for running the Excel report. For more details, see
"Generation Settings Tab" on page 805.

Query Tab
This tab enables you to create an SQL script that defines the data that is exported to Excel.

To access 1. On the ALM sidebar, underDashboard, select Analysis View.
2. Expand the analysis tree and select an Excel report.
3. Under the Configuration tab, click theQuery tab.

Important
information

l To ensure the integrity of the database, you should run only queries that extract
data from the project database. For more details, see "Protecting the Database" on
page 795.

l The query builder provides enhanced functionality for creating SQL queries. For
more details, see "Excel Report Query Builder Dialog Box" on page 801.
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Relevant
tasks

l "How to Generate an Excel Report" on page 796
l "How to Analyze Data in ALM" on page 718

See also l "Excel Reports Overview" on page 794
l "Analysis View Window" on page 720

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Generate. Generates the Excel report.

Query Builder. Opens the Excel Report Query Builder dialog box, offering
extended functionality for creating SQL queries, including testing the query and
adding parameters to the query. For more details, see "Excel Report Query
Builder Dialog Box" on the next page.

Add Query. Enables you to create a new query. A new tab is added to the query
builder with the default nameQuery<number>.

When you generate the report, the results of each query are displayed in separate
Excel worksheets.

Delete. Deletes the selected query.

Rename Query. Enables you to rename the current query.

Note: The Excel worksheet containing the data extracted by the query will
have the same name as the query.

Database Type. Displays the type of database used for your project database.

Youmust write the SQL query using the syntax used by the project database
type.

Find. Searches the query for text that you entered in the find box.

Tip: Click the Find button again to find the next occurrence of the text.

<Query
Parameters
grid>

Contains a list of parameters available for use in the queries.

Note: To add and edit query parameters, work in the Excel Report Query
Builder. For more details, see "Excel Report Query Builder Dialog Box" on
the next page.
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UI Element Description

<SQL pane> Contains the SQL query that defines the data set that is extracted to the Excel
report.

Syntax exception: The @ and \ characters have a special meaning and are not
read literally when running SQL queries on the project database. If you want these
characters to be read literally, you should replace @with \@ and \with \\. For
example, if you want the statement
SELECT * FROM BUG WHERE BUG.BG_SUMMARY = `@parameter@' to be run
literally on the ALM database, type SELECT * FROM BUG WHERE BUG.BG_
SUMMARY = `\@parameter\@'.

Excel Report Query Builder Dialog Box
This dialog box enables you to create an SQL query.

To access 1. On the ALM sidebar, underDashboard, select Analysis View.
2. Expand the analysis tree and select an Excel report.
3. Under the Configuration tab, click theQuery tab, and then click theQuery

Builder button.

Important
information

l To ensure the integrity of the database, you should run only queries that extract
data from the project database. For more details, see "Protecting the Database" on
page 795.

l You can include parameters in SQL queries. For more details, see "Parameters in
SQLQueries" on page 795.

Relevant
tasks

"How to Generate an Excel Report" on page 796

See also l "Excel Reports Overview" on page 794
l "Parameters in SQLQueries" on page 795
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SQL Editor Area
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Add Query. Enables you to create a new query. A new tab is added to the query
builder with the default nameQuery<number>.

When you generate the report, the results of each query are displayed in separate
Excel worksheets.

Delete. Deletes the selected query.

Rename Query. Enables you to rename the current query.

Note: The Excel worksheet containing the data extracted by the query will have
the same name as the query.

Test Query. Displays the first ten results of the query in the Query Results tab. If
your query contains parameters, ALM uses the default values for the parameters.

Run Query. Displays results of the query in the Query Results tab. If your query
contains parameters, ALM prompts you for values.

Database Type. Displays the type of database used for your project database.

Youmust write the SQL query using the syntax used by the project database type.

Find. Searches the query for text that you entered in the find box.

Tip: Click the Find button again to find the next occurrence of the text.

<SQL
editor>

Contains the SQL query that defines the data set that is extracted to the Excel
report.

Note: Separate project entities with commas.

Syntax exception: The @ and \ characters have a special meaning and are not read
literally when running SQL queries on the project database. If you want these
characters to be read literally, you should replace @ by \@ and \ by \\. For example,
if you want the statement
SELECT * FROM BUG WHERE BUG.BG_SUMMARY = `@parameter@' to be run literally
on the ALM database, type SELECT * FROM BUG WHERE BUG.BG_SUMMARY =
`\@parameter\@'.Contains the SQL query that defines the data set that is used for
the Excel report.

Copy/Paste Copies selected text from one place in the SQL editor to another.

Available from:Query editor right-click menu
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UI Element Description

Cut/Paste Moves selected text from one place in the SQL editor to another.

Available from:Query editor right-click menu

Entities Pane
Contains a list of ALM database fields and entities that you can add to the query.

User interface elements are described below:

UI Element Description

Add Entity to Query. Adds the selected project entity to the SQL query. The
entity is inserted at the cursor position.

To add a project entity with the column alias defined by the entity title, click the
Add Entity to Query arrow and select Add Entity to Query with Entity Title as
Alias.

Available from:Entities pane

Entities View. Enables you to view fields and entities in the Entities pane by their
name, their database column name, or both.

Available from:Entities pane

Query Parameters Tab
Contains a list of parameters available for use in the queries.

User interface elements are described below:

UI
Element

Description

Add Parameter to Query. Adds the selected parameter to the SQL query. The
parameter is added at the cursor position.

Note: For a parameter representing a text value, youmust manually add single
quotes (') around the parameter in the SQL pane. For example, if the SQL pane
contains the phrase WHERE BUG.BG_DETECTED_BY = @name@, youmust replace the
text @name@ with '@name@'.

Available from:Query Parameters tab

New Query Parameter. Opens the New Query Parameter dialog box, enabling you to
add a parameter to the parameters grid. For more details, see "New Query
Parameter/Edit Query Parameter Dialog Box" on page 806.

Available from:Query Parameters tab
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UI
Element

Description

Edit Query Parameter. Opens the Edit Query Parameter dialog box, enabling you to edit
the selected parameter. For more details, see "New Query Parameter/Edit Query
Parameter Dialog Box" on page 806.

Available from:Query Parameters tab

Delete Query Parameter. Deletes the selected parameter from the parameters grid.

Caution: If you delete a parameter that is in use in a report query, queries containing
the parameter will not be valid.

Available from:Query Parameters tab

Query Results Tab
Displays preview results of an SQL query.

Post-processing Tab
This tab enables you to create a Visual Basic script that runs after the extracted data is exported to
Excel.

To access 1. On the ALM sidebar, underDashboard, select Analysis View.
2. Expand the analysis tree and select an Excel report.
3. Under the Configuration tab, click thePost-processing tab.

Important
information

Whenwriting a post-processing script, consider important guidelines. For more
details, see "Guidelines for Creating a Post-Processing Script" on page 796.

Relevant
tasks

l "How to Generate an Excel Report" on page 796
l "How to Analyze Data in ALM" on page 718

See also l "Excel Reports Overview" on page 794
l "Analysis View Window" on page 720

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Generate. Generates the Excel report

Find. Searches the post-processing script for text that you entered in the find box.

Tip: Click the Find button again to find the next occurrence of the text.
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UI Element Description

Run post-
processing

Instructs ALM to run the post-processing script after the data is exported to Excel.
Clear this option if you do not want to run the script when you generate the report.

<script
editor box>

Contains the Visual Basic script that runs in Excel after the report data is exported
to Excel.

Tip: Base the script on the template script already displayed in the Script Editor
box.

Generation Settings Tab
This tab enables you to define settings for generating the Excel report.

To access 1. On the ALM sidebar, underDashboard, select Analysis
View.

2. Expand the analysis tree and select an Excel report.
3. Under the Configuration tab, click theGeneration

Settings tab.

Relevant tasks l "How to Generate an Excel Report" on page 796
l "How to Analyze Data in ALM" on page 718

See also l "Excel Reports Overview" on page 794
l "Analysis View Window" on page 720

User interface elements are described below:

UI Element Description

Generate. Generates the Excel report.

If the status of the report is Not Ready, a warning displays.

If the report query contains parameters, the Report Parameters dialog box opens.
Type the parameter values in theValue column.

The report is saved in the location you define. If you selected Launch report in
Excel, Excel opens and displays the report. If not, a confirmationmessage displays.

Launch
report in
Excel

Instructs ALM to open the report in Excel after the report is generated. If this option is
not selected, you can load the saved report in Excel at a later stage.
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UI Element Description

Status Informs other users whether the report is ready to be generated. The following options
are available for the report status:

l Ready. Indicates that the report is ready to be generated.
l Not Ready. Indicates that the report is not ready to be generated. If a user tries to
generate a report with this status, a warningmessage displays.

Save report
as

The location and name of the Excel file to which the data is exported.

Tip: Click the browse button to select a folder.

New Excel Report Dialog Box
This dialog box enables you to add a new Excel report to the analysis tree.

To access 1. On the ALM sidebar, underDashboard, select Analysis View.
2. Right-click the folder under which you want to add a report, and select New

Excel Report.

Important
information

Excel reports you create under private folders are available to the owner only. Excel
reports you create under public folders are available to all users.

Relevant
tasks

l "How to Generate an Excel Report" on page 796
l "How to Analyze Data in ALM" on page 718

See also l "Excel Reports Overview" on page 794
l "Analysis View Window" on page 720

User interface elements are described below:

UI Element Description

Excel Report
Name

The report's display name in the analysis tree.

Syntax exceptions: The report name cannot exceed 255 characters, and cannot
include the following characters: \ ^ *

New Query Parameter/Edit Query Parameter Dialog Box
This dialog box enables you to edit or create a new query parameter.

To access 1. In an Excel report, under the Configuration tab, click theQuery tab, and then
click theQuery Builder button.

2. In the Query Parameters tab, right-click and select New Parameter orEdit
Parameter.
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Relevant
tasks

"How to Generate an Excel Report" on page 796

See also "Parameters in SQLQueries" on page 795

User interface elements are described below:

UI Element Description

Parameter
Name

The parameter name.

Note: If you rename a parameter, the change is automatically applied to the
parameter wherever it is used in the SQL query.

Syntax exception:A parameter name cannot include special characters, except the
underscore character.

Default
Value

The value that the parameter uses by default.

Hide On
Run

Instructs ALM to use the default value every time you generate the report. Clear this
option if you want to be prompted to keep or change the default value when you
generate the report.

Global
Parameter

Indicates that the parameter is available to all queries in the current Excel report.

Description An extended description of the parameter.
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Chapter 46: Business View Excel Reports
This chapter includes:

• Business View Excel Reports Overview 810
• How to Generate a Business View Excel Report 810
• Business Views Excel Reports User Interface 813
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Business View Excel Reports Overview
A business view is a data layer that exists on top of the database and which reflects only those project
entity fields that represent information that is useful from a business perspective.

For example, a business view based on the Baselines entity could contain theName, Description,
andBaseline ID fields. This is because these fields convey information that could be of importance to
the consumer who needs to understand baseline information from a business perspective only. By the
same logic, the same business view would not include theAttachment andAuto complete type
fields, as they are of little business significance.

Business views can be based on single entities, such as Baselines orDefects, while others can
represent more complex relationships between entities, such as Defects With Linked Requirements.

In addition to the pre-defined business views, additional views can be created in Project
Customization. For more information, refer to theHP Application Lifecycle Management Administrator
Guide.

You can create andmodify Business View Excel reports in Microsoft Excel. This enables you to
analyze your data using any of the capabilities available in Excel, and then upload the report to ALM.

Business View Excel reports can be created using data frommultiple projects.

For task details, see "How to Generate a Business View Excel Report" below.

How to Generate a Business View Excel Report
This task describes how to analyze data in ALM using Business View Excel reports.

To learnmore about business view Excel reports, see "Business View Excel Reports Overview"
above.

This task includes the following steps:

l "Prerequisites" on the next page
l "Log in to ALM fromMicrosoft Excel" on the next page
l "Add a Business View Excel report to the analysis tree" on the next page
l "Create a Business View Excel report" on the next page
l "Configure the Business View Excel report" on page 812
l "Import the Business View Excel report to ALM" on page 812
l "Generate a Business View Excel report" on page 813
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1. Prerequisites
To verify supported versions of Microsoft Excel, refer to theHP Application Lifecycle
Management Readme.

Note: In Microsoft Excel 2013, you can only open one Business View Excel report at a time.

Install the HP ALM Business Views Microsoft Excel add-in from the HP Application Lifecycle
Management Add-ins page. You can access the Add-ins page in ALM from Help > Add-ins.

Note: If you do not install the HP ALM Business Views Microsoft Excel add-in from the Add-
ins page, you are prompted to install the add-in when creating a business view excel report in
the Analysis module.

Installing via the Add-ins page allows you to install for only yourself or for all users on the
machine. Installing from the Analysis module installs only for yourself.
To install for all users, youmust have administrator permissions.

2. Log in to ALM from Microsoft Excel
If you access Microsoft Excel directly, and not through ALM, youmust log in to ALM from
Microsoft Excel.
a. OpenMicrosoft Excel.
b. Open the Login screen. In the HP ALM tab, click Login.
c. Enter the login information. Select Standard Authentication orExternal Authentication.

i. ForStandard Authentication, enter the ALM server URL, Login Name, and Password,
and click Authenticate.

ii. ForExternal Authentication, enter the web server URL and click External
Authentication.

d. Select the project. Enter the Domain and Project, and click Login.

3. Add a Business View Excel report to the analysis tree
Add a Business View Excel report to a folder in the analysis tree.
a. Open the Analysis View module. On the ALM sidebar, underDashboard, select Analysis

View.
b. Add a folder to the analysis tree. Right-click a folder under the Private or Public root folder,

and select New Folder.
c. Create a new Excel report. Right-click a folder, and select New Business View Excel

Report. Enter a name for the Business View Excel report in the New Business View Excel
Report dialog box.

Note: If there is a newer version of the HP ALM Business Views Microsoft Excel add-in,
a dialog box appears to update the add-in on your machine.

4. Create a Business View Excel report
Create the Business View Excel report in Excel.

User Guide
Chapter 46: Business View Excel Reports

HP ALM (12.50) Page 811



a. Open Excel. In ALM's Analysis module, in the Configuration tab, click New Excel. Excel
opens with the HP ALM tab on the ribbon. For user interface details, see "HP ALM Tab -
Microsoft Excel" on page 814.

b. Open the Add Worksheet dialog box. In the HP ALM tab, click Add to add business view
Excel worksheets in the same Excel book, or click New Report to add business view Excel
worksheets in a new Excel book.

c. Select the business views. Select the business view and click OK. To select multiple
business views, use the SHIFT or CTRL keys. The new business view Excel worksheets are
added and theWorksheet Configuration pane becomes active.

5. Configure the Business View Excel report
Configure the Business View Excel report in Excel.
a. Select the fields to be included in the report. In the Fields tab of theWorksheet

Configuration pane, select the fields to be removed from the report. To select multiple fields,
use the SHIFT or CTRL keys. For user interface details, see "Worksheet Configuration Pane -
Fields Tab" on page 817.

b. Filter the data to be included in the report. In the Filter tab of theWorksheet Configuration
pane, select the fields to be filtered and enter the filter criteria. For user interface details, see
"Worksheet Configuration Pane - Filter Tab" on page 819.

Note: You cannot filter based onmemo (CLOB) fields.

c. Sort the report. In the Sort tab of theWorksheet Configuration pane, select the fields by
which the report is sorted and set the sorting criteria. For user interface details, see
"Worksheet Configuration Pane - Sorting Tab" on page 821.

Note: You cannot sort onmemo (CLOB) fields.

d. Select the projects to be included in the report. In the Advanced tab of theWorksheet
Configuration pane, select Include domain and project name and select the projects to
include in the report. For user interface details, see "Worksheet Configuration Pane -
Advanced Tab" on page 823.

e. Edit the query. In the Advanced tab of theWorksheet Configuration pane, click Edit Query
to configure the report by directly editing the DQL query. For user interface details, see "Edit
Query Dialog Box" on page 825.

Note: If you edit the query, the other tabs of theWorksheet Configuration pane are
disabled and all selection, sorting, and filtering of fields are done directly in the
DQL query.

6. Import the Business View Excel report to ALM
You can upload the Business View Excel report directly to ALM from Excel. In Excel, click the
arrow under theSave button and select Save to ALM. For details, see "Save Business View
Excel Report Dialog Box" on page 828.
Alternatively, you can save the report as a file in Excel and upload it later to ALM. To upload the
file in ALM:
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a. In Excel, click the arrow under theSave button and select Save to file. In the search window,
navigate to the desired location, enter the desired file name, and click Save.

b. In the Configuration tab in ALM's Analysis module, click .
c. Select the Business View Excel report. In the search window, navigate to the desired file

and click Open. The selected file name is shown in the File name field.

7. Generate a Business View Excel report
Generating a Business View Excel report refreshes all the data, saves the Excel file, and opens it
in Excel.

a. In theAnalysis view in ALM, click .
b. In the Configuration tab, click Generate.
c. Save the Business View Excel report. In the search window, navigate to the desired

location to save the report and click Save. The report is saved and opens in Excel.

Business Views Excel Reports User Interface
This section includes:

• Configuration Tab - Business View Excel Reports 814
• HP ALM Tab - Microsoft Excel 814
• Worksheet Configuration Pane - Fields Tab 817
• Worksheet Configuration Pane - Filter Tab 819
• Worksheet Configuration Pane - Sorting Tab 821
• Worksheet Configuration Pane - Advanced Tab 823
• Edit Query Dialog Box 825
• Select Projects Dialog Box 827
• Business View Options Dialog Box 827
• Save Business View Excel Report Dialog Box 828
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Configuration Tab - Business View Excel Reports
This tab enables you to open Excel to configure and generate Business View Excel reports.

To access 1. On the ALM sidebar, underDashboard, select Analysis
View.

2. Expand the analysis tree, and select a Business View Excel
report.

3. Click theConfiguration tab.

Relevant tasks "How to Generate a Business View Excel Report" on page 810

See also "Business View Excel Reports Overview" on page 810

User interface elements are described below:

UI Element Description

Generates the selected Business View Excel report in Excel.

Opens Excel to create a new Business View Excel report.

Installs or uninstalls the Business View Excel add-in in Excel.

Note: This install only installs the add-in for the specific user, not for
all users.

Upload Excel Report
File

Enables you to upload a Business View Excel report to ALM.

HP ALM Tab - Microsoft Excel
This tab enables you to create and configure Business View Excel reports.
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To access 1. On the ALM sidebar, underDashboard, select Analysis
View.

2. Expand the analysis tree, and select a Business View Excel
report.

3. Click theConfiguration tab.
4. Click New Excel. Microsoft Excel opens.
5. Click theHP ALM tab.

Relevant tasks "How to Generate a Business View Excel Report" on page 810

User interface elements are described below:

UI Element Description

Login. Opens the login screen to log in to ALM.

Logout. Logs out of ALM.

Switch Project. Opens the login screen to switch to another project in the
same ALM session.

Add. Opens the AddWorksheet dialog box to create a new worksheet for each
selected business view.

Show Configuration. Toggles theWorksheet Configuration pane.

Auto Refresh. Automatically refreshes the active worksheet each time its
configuration is changed.

Row Limit. Sets themaximum number of rows shown in each Business View
worksheet.

Note: Set the value to zero to retrieve all rows.

Refresh. Refreshes the current worksheet.
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UI Element Description

Refresh All. Refreshes all worksheets.

New Report. Opens the AddWorksheet dialog box to create a new worksheet
for each selected business view in a new Excel workbook.

Open. Opens a business view Excel workbook from a file or from the ALM
Analysis View tree.

Save. Saves the current Business View Excel workbook to a file or to the ALM
Analysis View tree.

Options. Opens the HP ALM Addin Options dialog box. See "Business View
Options Dialog Box" on page 827 for details.

Help. Opens the HP Application Lifecycle Management Help for the add-in.

Note: The help opens only when you are logged in to ALM.
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Worksheet Configuration Pane - Fields Tab
The worksheet configuration pane enables you to configure the Business View Excel report.

To access 1. In the HP ALM tab in Excel, click Add orNew Report.
2. Select the business view and click OK.
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Important
information

l To hide theWorksheet Configuration pane, click theShow Configuration button.
Clicking the button again reopens theWorksheet Configuration pane.

l If you click in the Excel worksheet outside the actual report, theWorksheet
Configuration pane closes. Click in the report to reopen the pane.

l To change the order of the columns in the report, drag and drop the columns in the
Excel table.

Relevant
tasks

"How to Generate a Business View Excel Report" on page 810

See also "HP ALM Tab - Microsoft Excel" on page 814

The Fields tab of the worksheet configuration pane enables you to select the fields to be included in the
report. User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Move Right. Moves the selected fields in the <Business View> fields column
to theSelected fields column.

Move All Right. Moves all fields in the <Business View> fields column to the
Selected fields column.

Move Left. Moves the selected fields in theSelected fields column to the
<Business View> fields column.

Move All Left. Moves all fields in theSelected fields column to the
<Business View> fields column.

<Business
View> Fields

List of the Report Headings that are not included in theSelected fields column.

Selected fields List of the Report Headings that are included in the report.
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Worksheet Configuration Pane - Filter Tab
The worksheet configuration pane enables you to configure the Business View Excel report.

To access 1. In the HP ALM tab in Excel, click Add orNew Report.
2. Select the business view and click OK.
3. Select the Filter tab.
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Important
information

l To hide theWorksheet Configuration pane, click theShow Configuration button.
Clicking the button again reopens theWorksheet Configuration pane.

l If you click in the Excel worksheet outside the actual report, theWorksheet
Configuration pane closes. Click in the report to reopen the pane.

Relevant
tasks

"How to Generate a Business View Excel Report" on page 810

See also "HP ALM Tab - Microsoft Excel" on page 814

The Filter tab of the worksheet configuration pane enables you to filter the data to be included in the
report. User interface elements are described below:

UI
Element

Description

Clear Filter. Clears the filter settings defined in the Filter tab.

Copy Filter Settings. Copies the filter settings to the Clipboard.

Paste Filter Settings. Pastes the filter settings from the Clipboard.

Criteria Click to set the filter criteria for the specific field. TheSelect Filter Condition dialog
box opens.

Field
Name

Alphabetical list of the Report Headings.
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Worksheet Configuration Pane - Sorting Tab
The worksheet configuration pane enables you to configure the Business View Excel report.

To access 1. In the HP ALM tab in Excel, click Add orNew Report.
2. Select the business view and click OK.
3. Select theSorting tab.
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Important
information

l To hide theWorksheet Configuration pane, click theShow Configuration button.
Clicking the button again reopens theWorksheet Configuration pane.

l If you click in the Excel worksheet outside the actual report, theWorksheet
Configuration pane closes. Click in the report to reopen the pane.

Relevant
tasks

"How to Generate a Business View Excel Report" on page 810

See also "HP ALM Tab - Microsoft Excel" on page 814

TheSorting tab of the worksheet configuration pane enables you to sort the report. User interface
elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Move Right. Moves the selected fields in the <Business View> fields
column to theSorted fields column.

Move All Right. Moves all fields in the <Business View> fields column to
theSorted fields column.

Move Left. Moves the selected fields in theSorted fields column to the
<Business View> fields column.

Move All Left. Moves all fields in theSorted fields column to the <Business
View> fields column.

Sort Ascending. Sorts the selected Report Headings in ascending order.

Sort Descending. Sorts the selected Report Headings in descending order.

Move Up. Moves the selected Report Headings higher in the list of sorted
fields.

Move Down. Moves the selected Report Headings lower in the list of sorted
fields.

<Business
View> Fields

List of the Report Headings that are not included in theSorted fields column.

Sorted fields List of the Report Headings that are included in the sort for the report.
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Worksheet Configuration Pane - Advanced Tab
The worksheet configuration pane enables you to configure the Business Views Microsoft Excel
Report, and to select the projects to include in the report.

To access 1. In the HP ALM tab in Excel, click Add orNew Report.
2. Select the business view and click OK.
3. Select theAdvanced tab.
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Important
information

l To hide theWorksheet Configuration pane, click theShow Configuration button.
Clicking the button again reopens theWorksheet Configuration pane.

l If you click in the Excel worksheet outside the actual report, theWorksheet
Configuration pane closes. Click in the report to reopen the pane.

Relevant
tasks

"How to Generate a Business View Excel Report" on page 810

See also "HP ALM Tab - Microsoft Excel" on page 814

TheAdvanced tab of the worksheet configuration pane enables you to configure the report by directly
editing the DQL query, and to select the projects to include in the report. User interface elements are
described below:

UI Element Description

Dataset
Query

The DQL query used to create the report.

Edit Query Click to edit the DQL query. TheEdit Query dialog box opens. For more
information, see "Edit Query Dialog Box" on the next page.

Use current
project only

Select if only the current project is to be included in the Business Views Microsoft
Excel Report.

Include
domain and
project name

Select to show the domain and project name in the Business Views Microsoft
Excel Report.

Domain The domains included in the Business Views Microsoft Excel Report.

Project The projects included in the Business Views Microsoft Excel Report.

Select
Projects

Click to select projects to include in the Business Views Microsoft Excel Report.
TheSelect Projects dialog box opens. For more information, see "Select Projects
Dialog Box" on page 827.
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Edit Query Dialog Box
The Edit Query dialog box enables you to configure the Business View Excel report.

To access 1. In the HP ALM tab in Excel, click Add orNew Report.
2. Select the business view and click OK.
3. In the Advanced tab of the theWorksheet Configuration pane, click Edit

Query.

Relevant tasks "How to Generate a Business View Excel Report" on page 810

See also "Worksheet Configuration Pane - Advanced Tab" on page 823

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Generates a preview of the data that is returned by the business view query.

Validates the query. The following checks are performed:

l That the DQL syntax is correct.
l That the query contains only fields from selected entities.

Deletes the selected business view from the query.

Main pane Displays a <business view> dialog box for every business view that has been
added to the query, as well as defined relationships between business views.
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UI Element Description

<business view>
dialog box

Appears in theMain pane after you add a business view to the query. The
dialog box displays all available fields within the business view. Use the
checkboxes to select fields to add to the view.

Default:All fields are included in the query. The checkboxes appear
unchecked.

Model pane Displays available business views.

To add a business view to the query, select it and click Add . Alternatively,
you can add business views by dragging them to theMain pane.

Note: Business views are listed alphabetically according to their Labels,
with their technical names in brackets.

<selected fields
grid>

Enables you to define filter criteria for business view fields.

To add a field to the grid, in the <business view> dialog box in theMain pane,
use the checkboxes to select the desired fields.

Tip: You can use theAlias column to change a field's label.

DQL Query
Builder

Displays the business view query.

The query updates automatically as you add entities and define relationships.

You can create and edit a view by entering the query directly in the DQLQuery
Builder.

Query Results
pane

Appears when you click Preview. Displays the following information:

l Query Results. Valid views only. Displays a preview of the view.
l Query Messages. Invalid views only. Displays messages detailing
problems with the view. Place the cursor over themessage text to view a
tooltip displaying the full message.
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Select Projects Dialog Box
The Select Projects dialog box enables you to select the projects to include in the Business Views
Microsoft Excel Report.

To
access

1. In the HP ALM tab in Excel, click Add orNew Report.
2. Select the business view and click OK.
3. In the Advanced tab of the theWorksheet Configuration pane, unselect Use

current project only and click Select Projects.

Relevant
tasks

"How to Generate a Business View Excel Report" on page 810

See also "Worksheet Configuration Pane - Advanced Tab" on page 823

User interface elements are described below:

UI Element Description

Removes the selected project from the list of domains and projects in theMain
pane.

Main pane Displays a list of domains and projects to be included in the Business Views
Microsoft Excel Report.

Projects Tree
pane

Displays available projects.

To add a project to the report, select it and click Add . Alternatively, you
can add projects by dragging them to theMain pane.

Business View Options Dialog Box
This dialog box enables you to set the options for the Business View Excel report.
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To access In the HP ALM tab in Excel, click Options.

Relevant tasks "How to Generate a Business View Excel Report" on page 810

See also "HP ALM Tab - Microsoft Excel" on page 814

User interface elements are described below:

UI Element Description

Enable logging Click to create a log of all activity that occurs while creating the Excel report.

Log file path The location of the log file. Click the browse button to select a path to the log file.

Save Business View Excel Report Dialog Box
This dialog box enables you to save the Business View Excel report to the ALM Analysis View tree.
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To access On the HP ALM tab in Excel, click the arrow under theSave button and select Save
to ALM.

Relevant
tasks

"How to Generate a Business View Excel Report" on page 810

See also "HP ALM Tab - Microsoft Excel" on page 814

User interface elements are described below:

UI Element Description

Business View
Excel Report Name

The name for the new report.

New Folder Creates a folder in the ALM Analysis View tree. TheNew Analysis Item
Folder dialog box opens. Enter the folder name and click OK.

Select Folder The folder in which the report is stored.
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Chapter 47: Live Analysis Graphs
This chapter includes:

• Live Analysis Graphs Overview 832
• How to Generate Live Analysis Graphs 832
• Live Analysis Graphs User Interface 833
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Live Analysis Graphs Overview
Live analysis enables you to create and display dynamic charts illustrating:

l Test subject data in the Test Planmodule.
l Test set folder data in the Test Labmodule.
l Business component subject folders in the Business Components module.
In eachmodule you can create up to two live analysis graphs.

Live Analysis graphs differ from the graphs described in "Graphs and Dashboard Pages" on page 733 in
that you do not have to re-generate a graph to view data that has changed. In addition, the layout and
settings of the graph are preserved for all the folders in the samemodule. This enables you to view the
same graphical analysis of different folders without the need to redesign the graphs.

For task details, see "How to Generate Live Analysis Graphs" below.

How to Generate Live Analysis Graphs
This task describes how to create and view auto-generated graphs for test subjects, test sets, and
business components.

To learnmore about Excel reports, see "Live Analysis Graphs Overview" above.

To watch amovie on how to generate live analysis graphs, refer to this section in the ALMOnline Help.

This task includes the following steps:

l "Prerequisites" below
l "Create Live Analysis graphs" below
l "View Live Analysis graphs" below

1. Prerequisites
For test plan Live Analysis graphs, test subject folders are defined in the Test Planmodule.
For test lab Live Analysis graphs, test set folders are defined in the Test Labmodule.
For business component Live Analysis graphs, component subject folders are defined in the
Business Components module.

2. Create Live Analysis graphs
a. On the sidebar, under Testing, select Test Plan, Test Lab, orBusiness Components.
b. Select a folder in themodule tree.
c. Click the Live Analysis tab.
d. Click theAdd Graph link in the pane in which you want to display a graph. Follow the wizard

to design a live analysis graph. For user interface details, see "Live Analysis GraphWizard"
on page 835.

3. View Live Analysis graphs
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You can change the way a Live Analysis graph is displayed. This includes maximizing the graph to
full-screen view, changing the graph appearance, and drilling down to the graph data.
a. On the sidebar, under Testing, select Test Plan, Test Lab, orBusiness Components.
b. Select a folder in themodule tree.
c. Click the Live Analysis tab. For user interface details, see "Live Analysis Tab" on the next

page.

Live Analysis Graphs User Interface
This section includes:

• Live Analysis Tab 834
• Live Analysis GraphWizard 835
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Live Analysis Tab
This tab enables you to create and display Live Analysis graphs for test subjects, test set folders, and
business component subjects.

To access 1. On the ALM sidebar, under Testing, select Test Plan, Test Lab, or Business
Components.

2. Select a folder in themodule tree, and click the Live Analysis tab.

Important
information

l The Live Analysis graphs that you create are unique for your user login. Each
project user can create Live Analysis graphs which will be visible only to that user
but will not be visible to other users.

l Live Analysis graphs represent only nodes that are located directly below the
selected folder. They do not include tests, test sets, or business components
located at a lower hierarchical level in child folders of the selected folder.

l The data displayed in the graph reflects the filters that you have set for themodule.

Relevant
tasks

"How to Generate Live Analysis Graphs" on page 832

See also "Live Analysis GraphWizard" on the next page

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Element

Description

Add
Graph

Launches the Live Analysis GraphWizard, enabling you to design a Live Analysis
graph. For user interface details, see "Live Analysis GraphWizard" on the next page.

View Graph in Full Screen.Maximizes the current graph to full-screen view.

Tip: To return to the normal view, click theClose button.

Set Graph Appearance. Opens theGraph Appearance dialog box, enabling you to
change the current graph's title, color, and display. For more details, see "Graph
Appearance Dialog Box" on page 765.

Delete Graph. Removes the current Live Analysis graph from the Live Analysis tab.

Note: If you have two Live Analysis graphs displayed for a folder and you want to
create a new graph, youmust first delete one of the existing graphs.
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UI
Element

Description

<graph
area>

You can perform the following actions in the chart area:

Drill Down. To further analyze your data, click a bar or segment in the graph. The Drill
DownResults dialog box opens. For user interface details, see "Drill DownResults
Dialog Box" on page 766.

Set Colors. To change the graph colors, right-click a bar or line. In the Color dialog box
that opens, select the new color from one of the color palettes.

<legend> Displays the chart categories and their corresponding color.

Set Colors. Right-click a category to change its color. In the Color dialog box that
opens, select the new color from one of the color palettes.

Live Analysis Graph Wizard
This wizard enables you to create Live Analysis graphs for test subjects, test set folders, and business
component subjects.

To access 1. On the ALM sidebar, under Testing, select Test Plan, Test Lab, or Business
Components.

2. Select a folder in themodule tree, and click the Live Analysis tab.
3. Click theAdd Graph link in the pane in which you want to display the graph.

Important
information

After you define the data that you want to display, the graphs are automatically
updated each time the data changes in the tests or test sets in the folder for which
you created the graph.

Relevant
tasks

"How to Generate Live Analysis Graphs" on page 832

Wizard
map

This wizard contains:

"Select Graph Type Page" below > "Select Graph Attributes Page " on the next page

See also "Live Analysis Tab" on the previous page

Select Graph Type Page

This wizard page enables you to select the Live Analysis graph type.

Important
information

General information about this wizard is available here: "Live Analysis Graph
Wizard" above.

Wizard map The "Live Analysis GraphWizard" above contains:

"Select Graph Type Page" above > "Select Graph Attributes Page " on the
next page
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User interface elements are described below:

UI Element Description

Description A description of the selected graph type.

Entity The ALM entity covered by the graph.

Graph Type Select the type of graph that you want to display:

Summary Graph. Shows the number of tests in a test subject, the number of tests in
test sets in a folder, or the number of components in a business component subject.

Progress Graph. Shows how many tests accumulated in a test subject, in the test
sets in a folder, or components in a business component subject, at specific points
during a period of time.

Trend Graph. In the Test Planmodule, shows the history of changes to specific Test
Plan fields in the selected test subject folder, for each time interval displayed. In the
Business Components module, shows the history of changes to specific Business
Components fields in a project, at each point during a period of time.

Select Graph Attributes Page

This wizard page enables you to set attributes for the Live Analysis graph.

Important
information

General information about this wizard is available here: "Live Analysis Graph
Wizard" on the previous page.

Wizard map The "Live Analysis GraphWizard" on the previous page contains:

"Select Graph Type Page" on the previous page > "Select Graph Attributes Page
" above

User interface elements are described below:

UI
Element

Description

Group
By field

The field by which tests or components are grouped in the graph.

Note: For progress graphs, you can select only fields for which history has been
enabled. For more information on enabling history for a field, refer to theHP
Application Lifecycle Management Administrator Guide.

X-axis
field

In summary graphs, the field whose values are displayed along the x-axis.
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Send Us Feedback
Canwemake this User Guide better?

Tell us how: SW-Doc@hp.com
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